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About this Manual (W446): 
This manual describes the operation of the CX-Programmer and consists of the following three parts. 

• Part 1: CX-Programmer 
This part describes the CX-Programmer software that is a PLC 
Programming Device, and also provides the overall precautions and the 
version upgrades information. 

• Part 2: CX-Server PLC Tools 
This part describes the CX-Server PLC Tools software, which is a 
collection of the following components: 
PLC Memory, IO Table, PLC Setup, Data Trace/Time Chart Monitor, PLC 
Error, Memory Card, PLC-Clock, and CX-Net Network Configuration 
(including Data Link Editor and Routing Table). 

• Part 3: CX-Server Runtime 
This part describes the CX-Server software that is a communications 
middleware. 

Note: References within each part are references to the pages or chapters within that part. 

 

Related Manual 
For details on the function block functions and ST programming, refer to the CX-Programmer Operation 
Manual Function Blocks and Structured Text (Cat. No. W447). 

For details on the SFC programming functions, refer to the CX-Programmer Operation Manual SFC (Cat. 
No. W469). 

For details on procedures for installing the CX-Programmer from the CX-One FA Integrated Tool Package, 
refer to the CX-One Setup Manual provided with CX-One. 

Cat. No. Model Manual name Contents 

W463 CXONE-AL@@D-V4/ 
LT@@@-V4 

CX-One Setup Manual Installation and overview of CX-One FA 
Integrated Tool Package. 

 

 WARNING: Failure to read and understand the information provided in this manual may 
result in personal injury or death, damage to the product, or product failure. 
Please read each chapter in its entirety and be sure you understand the 
information provided in the chapter and related chapters before attempting 
any of the procedures or operations given. 
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Terms and Conditions Agreement 
 

 WARRANTY • The warranty period for the Software is one year from the date of 
purchase, unless otherwise specifically agreed. 

• If the User discovers defect of the Software (substantial non-conformity 
with the manual), and return it to OMRON within the above warranty 
period, OMRON will replace the Software without charge by offering 
media or download from OMRON’s website. And if the User discovers 
defect of media which is attributable to OMRON and return it to OMRON 
within the above warranty period, OMRON will replace defective media 
without charge. If OMRON is unable to replace defective media or correct 
the Software, the liability of OMRON and the User’s remedy shall be 
limited to the refund of the license fee paid to OMRON for the Software. 

 
 LIMITATION OF 

LIABILITY 
• THE ABOVE WARRANTY SHALL CONSTITUTE THE USER’S SOLE 
AND EXCLUSIVE REMEDIES AGAINST OMRON AND THERE ARE NO 
OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO, WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR PARTICULAR PURPOSE. IN NO EVENT, OMRON WILL BE 
LIABLE FOR ANY LOST PROFITS OR OTHER INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF USE OF 
THE SOFTWARE. 

• OMRON SHALL HAVE NO LIABILITY FOR DEFECT OF THE 
SOFTWARE BASED ON MODIFICATION OR ALTERNATION TO THE 
SOFTWARE BY THE USER OR ANY THIRD PARTY. OMRON SHALL 
NOT BE RESPONSIBLE AND/OR LIABLE FOR ANY LOSS, DAMAGE, 
OR EXPENSES DIRECTLY OR INDIRECTLY RESULTING FROM THE 
INFECTION OF OMRON PRODUCTS, ANY SOFTWARE INSTALLED 
THEREON OR ANY COMPUTER EQUIPMENT, COMPUTER 
PROGRAMS, NETWORKS, DATABASES OR OTHER PROPRIETARY 
MATERIAL CONNECTED THERETO BY DISTRIBUTED DENIAL OF 
SERVICE ATTACK, COMPUTER VIRUSES, OTHER 
TECHNOLOGICALLY HARMFUL MATERIAL AND/OR UNAUTHORIZED 
ACCESS. 

• OMRON SHALL HAVE NO LIABILITY FOR SOFTWARE DEVELOPED 
BY THE USER OR ANY THIRD PARTY BASED ON THE SOFTWARE 
OR ANY CONSEQUENCE THEREOF. 

 
 APPLICABLE 

CONDITIONS 
USER SHALL NOT USE THE SOFTWARE FOR THE PURPOSE THAT IS 
NOT PROVIDED IN THE ATTACHED USER MANUAL. 
 

 CHANGE IN 
SPECIFICATION 

The software specifications and accessories may be changed at any time 
based on improvements and other reasons. 
 

 ERRORS AND 
OMISSIONS 

The information in this manual has been carefully checked and is believed 
to be accurate; however, no responsibility is assumed for clerical, 
typographical, or proofreading errors, or omissions. 
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Precautions  

Intended Audience 
 This manual is intended for the following personnel, who must also have 

knowledge of electrical systems (an electrical engineer or the equivalent). 
• Personnel in charge of installing FA systems. 
• Personnel in charge of designing FA systems. 
• Personnel in charge of managing FA systems and facilities. 

General Precautions 
 The user must operate the product according to the performance 

specifications described in the operation manuals. 
Before using the product under conditions which are not described in the 
manual or applying the product to nuclear control systems, railroad 
systems, aviation systems, vehicles, combustion systems, medical 
equipment, amusement machines, safety equipment, and other systems, 
machines, and equipment that may have a serious influence on lives and 
property if used improperly, consult your OMRON representative.  
Make sure that the ratings and performance characteristics of the product 
are sufficient for the systems, machines, and equipment, and be sure to 
provide the systems, machines, and equipment with double safety 
mechanisms. 
This manual provides information for programming and operating the Unit. 
Be sure to read this manual before attempting to use the Unit and keep this 
manual close at hand for reference during operation. 

WARNING It is extremely important that a PLC and all PLC Units be used for the 
specified purpose and under the specified conditions, especially in 
applications that can directly or indirectly affect human life. You must 
consult with your OMRON representative before applying a PLC System to 
the above-mentioned applications. 

Safety Precautions 

WARNING Confirm safety sufficiently before transferring I/O memory area status from 
the CX-Programmer to the PLC. The devices connected to Output Units 
may malfunction, regardless of the operating mode of the CPU Unit. 
Caution is required in respect to the following functions.  
• Transferring from the CX-Programmer to real I/O (CIO Area) in the CPU 

Unit using the PLC Memory window. 
• Transferring from file memory to real I/O (CIO Area) in the CPU Unit 

using the Memory Card window. 
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WARNING 
Observe the following precautions when using the PLC Backup Tool. 
• Sufficiently check the data that is selected for restoring before performing 

the next step. If the correct data is not restored, unexpected operation 
may occur in the controlled system after the data is restored. 

• Some Special I/O Units and CPU Bus Units operate with parameters that 
are stored in the CPU Unit. If one of these Units is selected for backup, 
restrictions will be displayed in the Comments Area of the Backup from 
PLC Dialog Box. Confirm the restrictions, and always select the Special 
I/O Unit or CPU Bus Unit together with the CPU Unit when backing up or 
restoring data. If the data from both Units is not backed up or restored 
together, unexpected operation may occur in the controlled system. 

• If there are any backup restrictions for the Units to which data is being 
restored, the restrictions will be displayed in the Comments Area of the 
Backup from PLC Dialog Box. Confirm the restrictions, and always take 
the required measures. If required measures are not taken, unexpected 
operation may occur in the controlled system after the data is restored. 

• Forced status can be backed up, but it cannot be restored. If you 
restored data that contained forced status, use the CX-Programmer after 
restoring the data to force-set or force-reset bits as required. If required 
bits are not force-set or force-reset, differences in the forced status in 
memory may cause unexpected operation of the controlled system.  

• Confirm that stopping PLC operation will not create any problems before 
restoring data during PLC operation. If the PLC stops at an unanticipated 
time, unexpected operation may occur in the controlled system. 

• Always turn the power supply to the PLC OFF and then ON after 
restoring data. If the power supply is not turned OFF and then ON, 
memory in the PLC may not be updated to the restored data, which may 
cause unexpected operation of the controlled system. 

 

WARNING 
To prevent computer viruses, install antivirus software on a computer 
where you use this software. Make sure to keep the antivirus software 
updated. 

 

WARNING 
Keep your computer's OS updated to avoid security risks caused by a 
vulnerability in the OS. 

 

WARNING 
Always use the highest version of this software to add new features, 
increase operability, and enhance security. 

 

WARNING 
Manage usernames and passwords for this software carefully to protect 
them from unauthorized uses. 

 

WARNING 
Set up a firewall (E.g., disabling unused communication ports, limiting 
communication hosts, etc.) on a network for a control system and devices 
to separate them from other IT networks. Make sure to connect to the 
control system inside the firewall. 

 

WARNING 
Use a virtual private network (VPN) for remote access to a control system 
and devices from this software. 
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Caution Observe the following precaution when specifying a symbol or word 
address for an array variable index in a ladder program or when specifying 
a symbol for an array variable index in an ST program. 

When using a symbol or address to indirectly specify the element number 
of an array variable, be sure that the resulting address is not outside the 
memory area that contains the first word in the array. For example, use a 
symbol comparison instruction or an IF statement to ensure that processing 
is performed only when the memory area is not exceeded. If an element 
number that exceeds the memory area is specified, data in another 
memory area will be read or written, possibly resulting in unexpected 
operation. 

 

Caution Observe the following precaution when specifying a symbol or word 
address for an offset in a ladder program. 

When using a symbol or address to indirectly specify an offset for a 
memory address, be sure that the resulting address is not outside the 
memory area that contains original address. For example, use a symbol 
comparison instruction to ensure that processing is performed only when 
the memory area is not exceeded. If the final address (i.e., the original 
address plus the specified offset) exceeds the memory area, data in 
another memory area will be read or written, possibly resulting in 
unexpected operation. 
 

 

Caution Confirm safety at the destination node before transferring a program to 
another node or changing contents of the I/O memory area. Doing either of 
these without confirming safety may result in injury. 

 

Caution Execute online edit only after confirming that no adverse effects will be 
caused by extending the cycle time. Otherwise, the input signals may not 
be readable. 

 

Caution If synchronous unit operation is being used, perform online editing only 
after confirming that an increased synchronous processing time will not 
affect the operation of the main and slave axes. 

 

Caution Confirm safety sufficiently before monitoring power flow and present value 
status in the Ladder Section window or when monitoring present values in 
the Watch window. If force-set/reset or set/reset operations are 
inadvertently performed by pressing short-cut keys, the devices connected 
to Output Units may malfunction, regardless of the operating mode of the 
CPU Unit. 

 

Caution Caution is required when connecting peripheral devices, such as a 
personal computer, to the PLC when Units with non-isolated power 
supplies, such as the CS1W-CLK12/CLK52(-V1), that are connected to an 
external power supply are mounted to the PLC. If the 24-V side is grounded 
on the external power supply, a short will be created if the 0-V side of the 
peripheral device is grounded. When connecting peripheral devices, either 
ground the 0-V side of the external power supply or do not ground the 
external power supply at all. 
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Application Precaution 
 Observe the following precautions when using the CX-Programmer. 

• Observe the following precautions before starting the CX-Programmer. 
• Exit all applications not directly related to the CX-Programmer. 

Particularly exit any software such as screen savers, virus checkers, 
email or other communications software, and schedulers or other 
applications that start up periodically or automatically. 

• Disable sharing hard disks, printers, or other devices with other 
computers on any network. 

• With some notebook computers, the RS-232C port is allocated to a 
modem or an infrared port by default. Follow the instructions in 
documentation for your computer and enable using the RS-232C port 
as a normal serial port. 

• With some notebook computers, the default settings for saving 
energy do not supply the rated power to the RS-232C, USB and 
Ethernet port. There may be both Windows settings for saving 
energy, as well as setting for specific computer utilities and BIOS. 
Following the instructions in documentation for your computer, 
disable all energy saving settings. 

 • Do not turn OFF the power supply to the PLC or disconnect the 
connecting cable while the CX-Programmer is online with the PLC. The 
computer may malfunction. 

• With the CS/CJ-series PLCs, when creating an AUTOEXEC.IOM file 
from the CX-Programmer to automatically transfer data at startup, set the 
first write address to D20000 and be sure that the size of data written 
does not exceed the size of the DM Area. When the data file is read from 
the Memory Card at startup, data will be written in the CPU Unit starting 
at D20000 even if another address was set when the AUTOEXEC.IOM 
file was created. Also, if the DM Area is exceeded (which is possible 
when the CX-Programmer is used), the remaining data will be written to 
the EM Area. Refer to information on file operations in the CS/CJ-series 
Programming Manual for details. 

• Confirm that no adverse effect will occur in the system before attempting 
any of the following. Not doing so may result in an unexpected operation. 

Changing the operating mode of the PLC. 
• Force-setting/force-resetting any bit in memory. 
• Changing the present value of any word or any set value in memory. 
• Check the user program for proper execution before actually running it 

on the Unit. Not checking the program may result in an unexpected 
operation. 

• Precaution on Using Comparison Instructions:  
When using indirect DM/EM addresses on comparison instructions 
operands or using string comparison instructions, the top portion of the 
comparison instruction will be displayed in yellow when it is being 
monitored. At that time the power flow will not be monitored to the right of 
such comparison instructions. The contact and coil status, and present 
values of operands in special instructions will be displayed normally. 
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 • The user program and parameter area data in CS1-H CPU Units is 
backed up in the built-in flash memory. The BKUP indicator will light on 
the front of the CPU Unit when the backup operation is in progress. Do 
not turn OFF the power supply to the CPU Unit when the BKUP indicator 
is lit. The data will not be backed up if power is turned OFF. 
To display the status of writing to flash memory on the CX-Programmer, 
place a checkmark by Display dialog to show PLC Memory Backup 
Status on the PLC properties and then select Windows | PLC Memory 
Backup Status from the Windows menu.  

 
 • Precaution in Changing the PLC Type 

On the CX-Programmer, you can change the PLC (device) type or CPU 
type. When these are changed, however, only the data for the ladder 
program and the symbol tables are changed. The following data will be 
initialized and must be reset. 
• PLC Setup 
• Expansion instructions 
• I/O tables 
• PLC memory 
Particularly the PLC Setup has a large impact on PLC system operation. 
Be careful to reset all require settings after changing the PLC type. 
If expansion instruction allocations are not reset, program errors could 
occur, preventing the PLC from running. Always restore the expansion 
instruction allocates to the previous settings after changing the PLC 
type. 
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 Observe the following precautions when using the CX-Net. 

• Do not change the operating mode of the CPU Unit without first 
confirming that operation of the controlled system will not be affect. 

• Do not run the user program on the PLC until its operation has been 
checked sufficiently. 

• The data link mode (manual setting or automatic setting) and data link 
method are determined according to the data link setting in the startup 
node. In the startup node, set a data link table in the case of manual 
setting and data link automatic setting parameters in the case of 
automatic setting. If the settings are incorrect, the data link will not start. 

• Check the following items before starting data links. If incorrect data link 
tables or parameters are set, injury may result due to unexpected 
operation of the system. Even if the correct data link tables and 
parameters have been set, do not start or stop data links before verifying 
that there will be no adverse influence on the system. 

(1) Manually Set Data Links 
Check the data link tables in each node participating in the data link to 
see that they are correct. 
Be sure that data link tables are deleted from nodes that are not 
participating in the data links. 

(2) Automatically Set Data Links 
Be sure that the correct DM parameters have been set in the data link 
startup node. 

• CPU Bus Units will be automatically restarted when routing tables are 
transferred from a Programming Device to the CPU Unit. Resetting is 
required to use the new tables. Confirm that restarting the CPU Bus 
Units will not adversely affect system operation before transferring 
routing tables. 

• When Special I/O Unit or CPU Unit settings are performed in the I/O 
Table Window and then transferred from the PLC Memory Window, the 
following warning will be displayed if the allocated DM Area/CIO Area 
addresses set for Special I/O Units or CPU Bus Units in the I/O Table 
Window on the computer overlap with the PLC data table addresses. 

 Unless the CPU Bus Unit or Special I/O Unit settings have been 
previously transferred to the CPU Unit and the allocated DM Area/CIO 
Area data in the PLC data table for Special I/O Units or CPU Bus Units is 
to be overwritten, always click the No Button, shift the address, and 
repeat the transfer procedure.  

• CPU Bus Unit and Special I/O Unit settings are not checked for logical 
consistency. Be very careful of the logical consisting of the overall 
settings when making any setting that affects other settings, e.g., settings 
that enable or disable other settings. Transfer the Special I/O Unit or 
CPU Bus Unit settings to the PLC and then start operation, being aware 
that any logical inconsistencies may produce unexpected operation. 

• For example, if one setting selects either user settings or default settings 
and is set to use the default settings, it will not automatically change to 
enable user settings even if the related user settings are made. To use 
the user settings, they will have to be enabled manually and specifically 
in the setting that selects either user settings or default settings. 
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Unit Versions of CS/CJ/CP-series CPU Units 

Unit Versions 
A “unit version” has been introduced to manage CPU Units in the CS/CJ/CP 
Series according to differences in functionality accompanying Unit upgrades. 
This applies to the CJ2H, CJ2M, CS1-H, CJ1-H, CJ1M, CS1D, CP2E, CP1H, 
CP1L, CP1L-E and CP1E CPU Units. 

Notation of Unit Versions on Products 
The unit version is given to the right of the lot number on the nameplate of 
the products for which unit versions are being managed, as shown below. 

Unit version

Example for unit version 3.0

CS1H-CPU67H

CPU UNIT

Lot No. 040715 0000  Ver.3.0

OMRON Corporation MADE IN JAPAN

Produce nameplateCS/CJ/CP-series CPU Unit

Lot No.

 
• CS1-H, CJ1-H, and CJ1M CPU Units (except for low-end models) 

manufactured on or before November 4, 2003 do not have a unit version 
given on the CPU Unit (i.e., the location for the unit version shown above is 
blank).  

• The unit version of the CJ1-H-R CPU Units begins at version 4.0. 
• The unit version of the CS1-H, CJ1-H, and CJ1M CPU Units, as well as the 

CS1D CPU Units for Single-CPU Systems, begins at version 2.0. 
• The unit version of the CS1D CPU Units for Duplex-CPU Systems begins 

at version 1.1. 
• The unit version of the CP1H/CP1L/CP1L-E/CP1E CPU Units begins at 

version 1.0, except for the CP1H-Y@@@@-@, for which the unit version 
begins at version 1.1. 

• CPU Units for which a unit version is not given are called Pre-Ver. @.@ 
CPU Units, such as Pre-Ver. 2.0 CPU Units and Pre-Ver. 1.1 CPU Units. 

Confirming Unit Versions  
with Support Software 

CX-Programmer version 4.0 can be used to confirm the unit version using 
one of the following two methods. 
• Using the PLC Information 
• Using the Unit Manufacturing Information (This method can be used for 

Special I/O Units and CPU Bus Units as well.) 

Note CX-Programmer version 3.3 or lower cannot be used to confirm unit versions. 

PLC Information 

• If you know the device type and CPU type, select them in the Change PLC 
Dialog Box, go online, and select PLC - Edit - Information from the menus.  

• If you don’t know the device type and CPU type, but are connected directly 
to the CPU Unit on a serial line, select PLC - Auto Online to go online, and 
then select PLC - Edit - Information from the menus. 

In either case, the following PLC Information Dialog Box will be displayed.  
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Unit version 

 
Use the above display to confirm the unit version of the CPU Unit.  

Unit Manufacturing Information 

In the IO Table Window, right-click and select Unit Manufacturing 
information - CPU Unit. 

 
The following Unit Manufacturing information Dialog Box will be displayed  
 

Unit version 

  
Use the above display to confirm the unit version of the CPU Unit connected 
online.  
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Using the Unit Version Labels 
The following unit version labels are provided with the CPU Unit.  

 

 
These labels can be attached to the front of previous CPU Units to 
differentiate between CPU Units of different unit versions.  

Unit Version Notation 
In this manual, the unit version of a CPU Unit is given as shown in the 
following table. 

Product nameplate 
 
 
 
 
 
 
 
 
Meaning 

CPU Units on which no unit version is 
given 

Lot No. XXXXXX XXXX

OMRON Corporation    MADE IN JAPAN

 

Units on which a version is given  
(Ver. @.@) 

 

Lot No. XXXXXX XXXX     Ver.@.@ 

 

 
Designating individual 
CPU Units (e.g., the 
CS1H-CPU67H) 

Pre-Ver. 2.0 CS1-H CPU Units CS1H-CPU67H CPU Unit Ver. @.@  

Designating groups of 
CPU Units (e.g., the 
CS1-H CPU Units) 

Pre-Ver. 2.0 CS1-H CPU Units CS1-H CPU Units Ver. @.@ 

Designating an entire 
series of CPU Units 
(e.g., the CS-series 
CPU Units) 

Pre-Ver. 2.0 CS-series CPU Units CS-series CPU Units Ver. @.@ 
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Function Support by Unit Version 

CS1-H CPU Units (CS1@-CPU@@H)  

Function Unit version 

 Pre-Ver. 2.0 CPU 
Units 

CPU Units Ver. 2.0 or 
later 

Downloading and Uploading Individual Tasks --- OK 

Improved Read Protection Using Passwords --- OK 

Write Protection from FINS Commands Sent to CPU Units via 

Networks 

--- OK 

Online Network Connections without I/O Tables --- OK 

Communications through a Maximum of 8 Network Levels --- OK 

Connecting Online to PLCs via NS-series PTs OK from lot number 
030201 

OK 

Setting First Slot Words OK for up to 8 groups OK for up to 64 groups 

Automatic Transfers at Power ON without a Parameter File --- OK 

Automatic Detection of I/O Allocation Method for Automatic 

Transfer at Power ON 

--- --- 

Operation Start/End Times --- OK 

New 
Application 
Instructions 

MILH, MILR, MILC --- OK 

=DT, <>DT, <DT, <=DT, >DT, >=DT --- OK 

BCMP2 --- OK 

GRY OK from lot number 
030201 

OK 

TPO --- OK 

DSW, TKY, HKY, MTR, 7SEG --- OK 

EXPLT, EGATR, ESATR, ECHRD, ECHWR --- OK 

Reading/Writing CPU Bus Units with IORD/IOWR OK from lot number 
030418 

OK 

PRV2 --- --- 
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CS1D CPU Units 

Function CS1D CPU Units for Duplex-CPU  
Systems (CS1D-CPU@@H and CS1D-

CPU@@HA) 

CS1D CPU Units 
for Single-CPU 

Systems  
(CS1D-CPU@@S 

and CS1D-
CPU@@SA) 

 Pre-Ver. 1.1 CPU 
Units 

CPU Unit Ver. 1.1  CPU Unit Ver. 2.0 
or later 

Functions 
unique to 
CS1D CPU 
Units 

Duplex CPU Units OK OK --- 

Online Unit Replacement OK OK OK 

Duplex Power Supply Units OK OK OK 

Duplex Controller Link Units OK OK OK 

Duplex Ethernet Units --- OK OK 

Downloading and Uploading Individual Tasks --- --- OK 

Improved Read Protection Using Passwords --- --- OK 

Write Protection from FINS Commands Sent 

to CPU Units via Networks 

--- --- OK 

Online Network Connections without I/O 

Tables 

--- --- OK 

Communications through a Maximum of 8 

Network Levels 

--- --- OK 

Connecting Online to PLCs via NS-series 

PTs 

--- --- OK 

Setting First Slot Words --- --- OK for up to 64 
groups 

Automatic Transfers at Power ON without a 

Parameter File 

--- --- OK 

Automatic Detection of I/O Allocation Method 

for Automatic Transfer at Power ON 

--- --- --- 

Operation Start/End Times --- OK OK 

New 
Application 
Instructions 

MILH, MILR, MILC --- --- OK 

=DT, <>DT, <DT, <=DT, >DT, 
>=DT 

--- --- OK 

BCMP2 --- --- OK 

GRY --- --- OK 

TPO --- --- OK 

DSW, TKY, HKY, MTR, 7SEG --- --- OK 

EXPLT, EGATR, ESATR, 
ECHRD, ECHWR 

--- --- OK 

Reading/Writing CPU Bus 
Units with IORD/IOWR 

--- --- OK 

PRV2 --- --- --- 
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CJ1-H/CJ1M CPU Units 

Function CJ1-H CPU Units CJ1M CPU Units 

(CJ1H-CPU@@H-R) 
(CJ1@-CPU@@H) 
(CJ1G-CPU@@P) 

CJ1M-CPU12/13/22/23 CJ1M-
CPU11/21 

 Pre-Ver. 2.0 
CPU Units 

 CPU Units 
Ver. 2.0 

 Pre-Ver. 2.0 
CPU Units 

 CPU Units 
Ver. 2.0 

 CPU Units 
Ver. 2.0 or 

later 

Downloading and Uploading 
Individual Tasks 

--- OK --- OK OK 

Improved Read Protection 
Using Passwords 

--- OK --- OK OK 

Write Protection from FINS 
Commands Sent to CPU Units 
via Networks 

--- OK --- OK OK 

Online Network Connections 
without I/O Tables 

OK, but only if 
I/O table 
allocation at 
power ON is set 

OK OK, but only if 
I/O table 
allocation at 
power ON is set 

OK OK 

Communications through a 
Maximum of 8 Network Levels 

OK for up to 8 
groups 

OK for up to 64 
groups 

OK for up to 8 
groups 

OK for up to 64 
groups 

OK for up to 64 
groups 

Connecting Online to PLCs via 
NS-series PTs 

OK from lot 
number 030201 

OK OK from lot 
number 030201 

OK OK 

Setting First Slot Words --- OK --- OK OK 

Automatic Transfers at Power 
ON without a Parameter File 

--- OK --- OK OK 

Automatic Detection of I/O 
Allocation Method for 
Automatic Transfer at Power 
ON 

--- OK --- OK OK 

Operation Start/End Times --- OK --- OK OK 

New 
Application 
Instructions 

MILH, MILR, 
MILC 

--- OK --- OK OK 

=DT, <>DT, <DT, 
<=DT, >DT, 
>=DT 

--- OK --- OK OK 

BCMP2 --- OK OK OK OK 

GRY OK from lot 
number 030201 

OK OK from lot 
number 030201 

OK OK 

TPO --- OK --- OK OK 

DSW, TKY, HKY, 
MTR, 7SEG 

--- OK --- OK OK 

EXPLT, EGATR, 
ESATR, ECHRD, 
ECHWR 

--- OK --- OK OK 

Reading/Writing 
CPU Bus Units 
with IORD/IOWR 

--- OK --- OK OK 

PRV2 --- --- --- OK, but only for 
models with 
built-in I/O  

OK, but only for 
models with 
built-in I/O  
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Functions Supported by Unit Version 3.0 or Later 

CS1-H CPU Units (CS1@-CPU@@H) 
Function Unit version 

Pre-Ver. 2.0, Ver. 
2.0 

Ver. 3.0 Ver. 4.0 
(See note.) 

Function blocks (supported for CX-Programmer Ver. 
5.0 or higher) 

--- OK OK 

Serial Gateway (converting FINS commands to 
CompoWay/F commands at the built-in serial port) 

--- OK OK 

Comment memory (in internal flash memory) --- OK OK 

Expanded simple backup data --- OK OK 

New 
application 
instructions 

TXDU(256), RXDU(255) (support 
no-protocol communications with 
Serial Communications Units with 
unit version 1.2 or later) 

--- OK OK 

Model conversion instructions: 
XFERC(565), DISTC(566), 
COLLC(567), MOVBC(568),  
BCNTC(621) 

--- OK OK 

Special function block instructions: 
GETID(286) 

--- OK OK 

Additional 
instruction 
functions 

TXD(235) and RXD(236) 
instructions (support no-protocol 
communications with Serial 
Communications Boards with unit 
version 1.2 or later) 

--- OK OK 

New 
application 
instructions  

ASCII conversion instructions 
(NUMBER-TO-ASCII and ASCII-
TO- NUMBER) 
Text File Write (TWRIT) 

--- --- OK 

Improved 
function block 
(FB) functions 

Online editing of function blocks --- --- OK 

Input-output variables are 
supported. 
(Input-output variables can be 
specified in arrays.) 

--- --- OK 

The STRING data type and text-
string processing functions are 
supported in ST language. 

--- --- OK 

Using ST language programming in tasks  --- --- OK with CX-
Programmer Ver. 7.2 
or higher 

Using SFC programming in tasks  --- --- OK with CX-
Programmer Ver. 7.2 
or higher 

 
Note:   CX-Programmer version 7.0 or higher is required to use functions added for unit version 

4.0. Additional functions are supported if CX-Programmer version 7.2 or higher is used. 
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CS1D CPU Units 
Function Unit type 

CS1D-CPU@@H CS1D-CPU@@HA 

Function blocks (supported for CX-Programmer Ver. 
5.0 or higher) 

--- OK 

Serial Gateway (converting FINS commands to 
CompoWay/F commands at the built-in serial port) 

--- --- 

Comment memory (in internal flash memory) --- OK 

Expanded simple backup data --- OK 

New 
application 
instructions 

TXDU(256), RXDU(255) (support 
no-protocol communications with 
Serial Communications Units with 
unit version 1.2 or later) 

--- --- 

Model conversion instructions: 
XFERC(565), DISTC(566), 
COLLC(567), MOVBC(568),  
BCNTC(621) 

--- --- 

Special function block instructions: 
GETID(286) 

--- OK 

Additional 
instruction 
functions 

TXD(235) and RXD(236) 
instructions (support no-protocol 
communications with Serial 
Communications Boards with unit 
version 1.2 or later) 

--- --- 

New 
application 
instructions  

ASCII conversion instructions 
(NUMBER-TO-ASCII and ASCII-
TO- NUMBER) 
Text File Write (TWRIT) 

--- OK 

Improved 
function block 
(FB) functions 

Online editing of function blocks --- OK 

Input-output variables are 
supported. 
(Input-output variables can be 
specified in arrays.) 

--- OK 

The STRING data type and text-
string processing functions are 
supported in ST language. 

--- OK 

Using ST language programming in tasks  --- OK 

Using SFC programming in tasks  --- OK 

 

Note:  CX-Programmer version 9.7 or higher is required to use functions for CS1D-CPU@@HA.
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Function Unit type 

CS1D-CPU@@S CS1D-CPU@@SA 

Function blocks (supported for CX-Programmer Ver. 
5.0 or higher) 

--- OK 

Serial Gateway (converting FINS commands to 
CompoWay/F commands at the built-in serial port) 

--- --- 

Comment memory (in internal flash memory) --- OK 

Expanded simple backup data --- OK 

New 
application 
instructions 

TXDU(256), RXDU(255) (support 
no-protocol communications with 
Serial Communications Units with 
unit version 1.2 or later) 

--- OK 

Model conversion instructions: 
XFERC(565), DISTC(566), 
COLLC(567), MOVBC(568),  
BCNTC(621) 

--- --- 

Special function block instructions: 
GETID(286) 

--- OK 

Additional 
instruction 
functions 

TXD(235) and RXD(236) 
instructions (support no-protocol 
communications with Serial 
Communications Boards with unit 
version 1.2 or later) 

--- OK 

New 
application 
instructions  

ASCII conversion instructions 
(NUMBER-TO-ASCII and ASCII-
TO- NUMBER) 
Text File Write (TWRIT) 

--- OK 

Improved 
function block 
(FB) functions 

Online editing of function blocks --- OK 

Input-output variables are 
supported. 
(Input-output variables can be 
specified in arrays.) 

--- OK 

The STRING data type and text-
string processing functions are 
supported in ST language. 

--- OK 

Using ST language programming in tasks  --- OK 

Using SFC programming in tasks  --- OK 

 

Note:  CX-Programmer version 9.7 or higher is required to use functions for CS1D-CPU@@SA.  
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CJ1-H/CJ1M CPU Units (CJ1@-CPU@@H, CJ1M-CPU@@) 
Function Unit version 

Pre-Ver. 2.0,  
Ver. 2.0 

Ver. 3.0 Ver. 4.0 
(See note.) 

Function blocks (supported for CX-Programmer Ver. 
5.0 or higher) 

--- OK OK 

Serial Gateway (converting FINS commands to 
CompoWay/F commands at the built-in serial port) 

--- OK OK 

Comment memory (in internal flash memory) --- OK OK 

Expanded simple backup data --- OK OK 

Additional 
instruction 
functions 

PRV(881) and PRV2(883) 
instructions: Added high-frequency 
calculation methods for calculating 
pulse frequency. (CJ1M CPU Units 
only) 

--- OK OK 

New 
application 
instructions 

TXDU(256), RXDU(255) (support 
no-protocol communications with 
Serial Communications Units with 
unit version 1.2 or later) 

--- OK OK 

Model conversion instructions: 
XFERC(565), DISTC(566), 
COLLC(567), MOVBC(568),  

BCNTC(621) 

--- OK OK 

Special function block instructions: 
GETID(286) 

--- OK OK 

Additional 
instruction 
functions 

TXD(235) and RXD(236) 
instructions (support no-protocol 
communications with Serial 
Communications Boards with unit 
version 1.2 or later) 

--- OK OK 

New 
application 
instructions  

ASCII conversion instructions 
(NUMBER-To-ASCII and ASCII-
TO NUMBER) 

--- --- OK 

Improved 
function block 
(FB) functions 

Online editing of function blocks --- --- OK 

Input-output variables are 
supported. (Input-output variables 
can be specified in arrays.) 

--- --- OK 

The STRING data type and text-
string processing functions are 
supported in ST language. 

--- --- OK 

Using ST language programming in tasks  --- --- OK with CX-
Programmer Ver. 7.2 
or higher 

Using SFC programming in tasks  --- --- OK with CX-
Programmer Ver. 7.2 
or higher 

 
Note: CX-Programmer version 7.0 or higher is required to use functions added for unit version 

4.0. Additional functions are supported if CX-Programmer version 7.2 or higher is used. 
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Functions Supported for Unit Version 4.1 or Later 
CX-Programmer version 9.6 or higher must be used to enable using the 
functions added for unit version 4.1. 

CS1-H CPU Units 

CPU Units CS1-H CPU Units 

Models CS1@-CPU@@H 

Unit version 

Function 

Unit version 4.1 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 
 

CS1D CPU Units 

CPU Units CS1D-H CPU Units 

Models CS1D-CPU@@H 

CS1D-CPU@@HA 

Unit version 

Function 

Unit version 1.4 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 

 
CPU Units CS1D-S CPU Units 

Models CS1D-CPU@@S 

CS1D-CPU@@SA 

Unit version 

Function 

Unit version 2.1 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 

 

CJ1M CPU Units 

Unit version 4.1 is not supported. 

CJ1-H CPU Units 

CPU Units CJ1-H CPU Units 

Models CS1G-CPU@@P 

Unit version 

Function 

Unit version 4.1 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 
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Functions Supported by Unit Version for CJ2 CPU Units (CJ2H-CPU6@-EIP, CJ2H-
CPU6@) 

Functions Added for Unit Version 1.6 
Network variables are now available in CJ2H-CPU6@. 
CX-Programmer version 9.81 or higher is required to use functions added for 
unit version 1.6. 
 

Functions Added for Unit Version 1.5 
CX-Programmer version 9.6 or higher is required to use functions added for 
unit version 1.5. 
CPU Units CJ2H CPU Units 

Models CJ2H-CPU6@-EIP 
CJ2H-CPU6@ 

Unit version 

Function 

Unit version 1.5 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 

 

Functions Added for Unit Version 1.3 
CX-Programmer version 9.1 or higher is required to use functions added for 
unit version 1.3. 
CPU Units CJ2H CPU Units 

Models CJ2H-CPU6@-EIP 
CJ2H-CPU6@ 

Unit version 

Function 

Unit version 1.3 

Special instructions for 
specific CPU Bus Units 

CJ1W-NC281/NC481/NC881 
Position Control Units:  
PCU HIGH-SPEED POSITIONING 
(NCDMV(218)) 

Supported. 

CJ1W-NC281/NC481/NC881 
Position Control Units:  
PCU POSITIONING TRIGGER 
(NCDTR(219)) 

Supported. 

New special 
instructions 

SIGNED AREA RANGE COMPARE 
(ZCPS(117)) 

Supported. 

DOUBLE SIGNED AREA RANGE 
COMPARE (ZCPSL(118)) 

Supported. 

 

Unit Version 1.2 or Later 
CX-Programmer version 8.3 or higher must be used to enable using the 
functions added for unit version 1.2. 
Unit CJ2H CPU Unit 

Model CJ2H-CPU6@-EIP 
CJ2H-CPU6@ 

Unit version 

Item 

Unit version 1.2 

EM Area force-setting/resetting  Supported. 
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Unit Version 1.1 or Later 
CX-Programmer version 8.1 or higher must be used to enable using the 
functions added for unit version 1.1. 
Unit CJ2H CPU Unit 

Model CJ2H-CPU6@-EIP 
CJ2H-CPU6@ 

Unit version 

Item 

Unit version 1.1 Unit version 1.0 

High-speed interrupt function 
Decreased overhead time for interrupt tasks 
Minimum interval setting of 0.1 ms for Scheduled 
Interrupt Task 

Supported. Not supported. 

Changing the minimum cycle time setting in 
MONITOR mode 

Supported. Not supported. 

Synchronous unit operation Supported. Not supported. 

Unit Version 1.0 
All functions that are supported by unit version 4.0 or later of the CJ1 CPU 
Units are supported by unit version 1.0 of the CJ2 CPU Units.  
CX-Programmer version 8.0 or higher must be used to enable using unit 
version 1.0 of the CJ2 CPU Units. 
 

Functions Supported by Unit Version for CJ2M CPU Units 

Functions Added for Unit Version 2.2 
Network variables are now available in CJ2M-CPU1@. 
CX-Programmer version 9.81 or higher is required to use functions added for 
unit version 2.2. 

Functions Added for Unit Version 2.1 
CX-Programmer version 9.6 or higher must be used to enable using the 
following function added for unit version 2.1. 

• Read protection using extended passwords 

Functions Added for Unit Version 2.0 
CX-Programmer version 9.12 or higher is required to use the following 
function added for unit version 2.0. 

• Support of the CJ2M-MD211/212 Pulse I/O Modules. 

Functions Added for Unit Version 1.0 
The functions supported by unit versions 1.0 to 1.3 of the CJ2H CPU Units 
are supported except for the following functions from unit version 1.1. 

• High-speed interrupt function 
• Synchronous unit operation 
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Functions Supported by Unit Version for CP-series CPU Units 

CP1H CPU Units 

Functions Added for Unit Version 1.3 
CX-Programmer version 9.6 or higher is required to use functions added for 
unit version 1.3. 
CPU Units CP1H CPU Units 

Models CP1H-X@@@@-@ 
CP1H-XA@@@@-@ 
CP1H-Y@@@@-@ 

Unit version 

Function 

Unit version 1.3 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 

 

Functions Supported by Unit Version 1.0 and 1.1 
Functionality is the same as that for CS/CJ-series CPU Units with unit version 
3.0. The functionality added for CS/CJ-series CPU Unit unit version 4.0 is not 
supported.  

• CX-Programmer version 6.11 or higher is required to use CP1H-X@@@@-
@/XA@@@@-@ with unit version 1.1 or 1.0. 

• CX-Programmer version 6.20 or higher is required to use CP1H-Y@@@@-
@ with unit version 1.1. 
CPU Unit CP1H CPU Unit 

Model CP1H-@@@@-@ 
CP1H-XA@@@@-@ (See note 1.) 

CP1H-Y@@@@-@ 
(See note 2.) 

Unit version 

Function 

Ver. 1.1 or 
later 

Ver. 1.0 Ver. 1.1 

Pulse 
outputs 

Allocated built-
in I/O terminals 

4 axes at  
100 kHz 

2 axes at 100 kHz 

2 axes at 30 kHz 

2 axes 100 kHz 

Special pulse 
output terminals 

None 2 axes at 1 kHz 

 
Note 1. The unit version for the CP1H-X@@@@-@/XA@@@@-@ begins at 1.0. 

2. The unit version for the CP1H-X@@@@-@ begins at 1.1. 

3. CX-Programmer version 7.11 or higher is required to use CP1L CPU Units with unit 
version 1.0.  
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CP1L CPU Units 

Functions Added for Unit Version 1.1 
CX-Programmer version 9.6 or higher is required to use functions added for 
unit version 1.1. 
CPU Units CP1L CPU Units 

Models CP1L-M@@@@-@ 
CP1L-L@@@@-@ 

CP1L-EM@@@@-@ 
CP1L-EL@@@@-@ 

Unit version 

Function 

Unit version 1.1 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 

Functions Supported for Unit Version 1.0 
The supported functions are the same as for the CS/CJ-series CPU Units 
with unit version 3.0. 
The functions added for CS/CJ-series CPU Units with unit version 4.0 or later 
are not supported. 

• CX-Programmer version 7.11 or higher is required to use CP1L-M/L CPU 
Units with unit version 1.0. 

• CX-Programmer version 7.3 or higher is required to use CP1L–L10 CPU 
Units with unit version 1.0. 

• CX-Programmer version 9.4 or higher is required to use CP1L-EL/EM CPU 
Units with unit version 1.0. 

CP1E CPU Units 

Functions Added for Unit Version 1.3 
CX-Programmer version 9.6 or higher is required to use functions added for 
unit version 1.3. 
CPU Units CP1E CPU Units 

Models CP1E-E@@D@-A 
CP1E-N@@D@-@ 

Unit version 

Function 

Unit version 1.3 
or later 

Other unit 
versions 

Read protection using extended passwords Supported. --- 

Functions Supported for Unit Versions 1.0 and 1.1 
The supported functions are the same as for the CS/CJ-series CPU Units 
with unit version 3.0. 
The functions added for CS/CJ-series CPU Units with unit version 4.0 or later 
are not supported. 

• CX-Programmer version 9.1 or higher is required to use CP1E CPU Units 
with unit version 1.1. 

• CX-Programmer version 8.2 or higher is required to use CP1E CPU Units 
with unit version 1.0. 
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Unit Versions and Programming Devices 
CX-Programmer version 4.0 or higher must be used to enable using the 
functions added for CPU Unit Ver. 2.0. The following tables show the 
relationship between unit versions and CX-Programmer versions. 

Unit Versions and Programming Devices for CJ2 CPU Units 
CPU Unit Functions Required Programming Device 

CX-Programmer 
Ver. 
8.0 

Ver. 
8.1 

Ver. 
8.2 

Ver. 
8.3 

Ver. 
9.1 

Ver. 
9.12 

Ver. 
9.6 

Ver. 9.81 or 
higher 

CJ2H-CPU6@-EIP 
Unit version 1.0 

Functions for unit 
version 1.0 

       

CJ2H-CPU6@-EIP 
Unit version 1.1 

Functions added for 
unit version 1.1 

Δ Δ       

CJ2H-CPU6@ 
Unit version 1.1 

Functions added for 
unit version 1.1 

Δ Δ       

CJ2H-CPU6@-EIP 
Unit version 1.2 

Functions added for 
unit version 1.2 

Δ Δ Δ Δ     

CJ2H-CPU6@ 
Unit version 1.2 

Functions added for 
unit version 1.2 

Δ Δ Δ Δ     

CJ2H-CPU6@-EIP 
Unit version 1.3 

Functions added for 
unit version 1.3 

Δ Δ Δ Δ     

CJ2H-CPU6@ 
Unit version 1.3 

Functions added for 
unit version 1.3 

Δ Δ Δ Δ     

CJ2H-CPU6@-EIP 
Unit version 1.5 

Functions added for 
unit version 1.5 

Δ Δ Δ Δ Δ Δ   

CJ2H-CPU6@ 
Unit version 1.5 

Functions added for 
unit version 1.5 

Δ Δ Δ Δ Δ Δ   

CJ2H-CPU6@-EIP 
Unit version 1.6 

Functions added for 
unit version 1.6 

Δ Δ Δ Δ Δ Δ Δ  

CJ2H-CPU6@ 
Unit version 1.6 

Functions added for 
unit version 1.6 

Δ Δ Δ Δ Δ Δ Δ  

CJ2M-CPU@@ 
Unit version 1.0 

Functions for unit 
version 1.0 

× × × ×     

CJ2M-CPU@@ 

Unit version 2.0 
Functions for unit 
version 2.0 

× × × × Δ    

CJ2M-CPU@@ 
Unit version 2.1 

Functions for unit 
version 2.1 

× × × × Δ Δ   

CJ2M-CPU@@ 
Unit version 2.2 

Functions added for 
unit version 2.2 

× × × × Δ Δ Δ  

×: Cannot be used, Δ: Can be used except for new functions added for unit versions, : Can be used  
Note 1. It is not necessary to upgrade the version of the CX-Programmer if functionality that was 

enhanced for the upgrade of the CPU Unit will not be used. 

2. CX-Programmer version 8.1 or higher is required to use the functions added for unit 
version 1.1. The high-speed interrupt function and changing the minimum cycle time 
setting in MONITOR mode, however, are also supported by CX-Programmer version 
8.02. 

3. A Programming Console cannot be used with a CJ2H CPU Unit. 
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Unit Versions and Programming Devices for CPU Units Other Than CJ2 CPU Units 
CPU Unit Functions Required Programming Device 

CX-Programmer 
Ver. 
3.3 

Ver. 
4.0 

Ver. 5.0 
Ver. 6.0 

Ver. 
7.0 

Ver. 
7.2 

Ver. 8.0 Ver. 9.6 Ver. 9.7 or 
higher 

CS/CJ Series CPU 
Units, Unit Ver. 4.1 

Functions added for 
unit version 4.1 

Δ Δ Δ Δ Δ Δ   

CS/CJ Series CPU 
Units, Unit Ver. 4.0 

Functions added for 
unit version 4.0 

Δ Δ Δ    
(See 
note 4.) 

  

CS/CJ Series CPU 
Units, Unit Ver. 3.0 

Functions added for 
unit version 3.0 

Δ Δ       

CS/CJ Series CPU 
Units, Unit Ver. 2.0 

Functions added for 
unit version 2.0 

Δ        

CS1D CPU Units for 
Single-CPU Systems, 
Unit Ver. 4.0 

Functions added for 
unit version 4.0 

× Δ Δ Δ Δ Δ Δ  

CS1D CPU Units for 
Single-CPU Systems, 
Unit Ver. 2.1 

Functions added for 
unit version 2.1 

× Δ Δ Δ Δ Δ   

CS1D CPU Units for 
Single-CPU Systems, 
Unit Ver. 2.0 

Functions added for 
unit version 2.0 

×        

CS1D CPU Units for 
Duplex-CPU Systems, 
Unit Ver.4.0 

Functions added for 
unit version 4.0 

× × × × × × ×  

CS1D CPU Units for 
Duplex-CPU Systems, 
Unit Ver.1.4 

Functions added for 
unit version 1.4 

Δ Δ Δ Δ Δ Δ   

CS1D CPU Units for 
Duplex-CPU Systems, 
Unit Ver.1.1 

Functions added for 
unit version 1.1 

Δ        

×: Cannot be used, Δ: Can be used except for new functions added for unit versions, : Can be used 
Note 1. As shown above, there is no need to upgrade to CX-Programmer version 4.0 as long as 

the functions added for unit version 2.0 or unit version 1.1 are not used. 

2. CX-Programmer version 7.0 or higher is required to use functions added for unit version 
4.0. Additional functions are supported if CX-Programmer version 7.2 or higher is used. 

3. Unit version 4.2 of the CJ1H-CPU6@-R is supported only by CX-Programmer version 8.0 or higher. 

4. CX-Programmer version 8.0 or higher is required to use unit version 4.2 of the CJ1H-CPU6@-R.  

 

Unit Versions of CP1-series CPU Units and Programming Devices 
CPU Unit Model Unit 

version 
CX-Programmer version 

Ver. 6.11 Ver. 6.20 Ver. 7.11 Ver. 8.2  Ver. 9.4 Ver. 9.6 
or higher 

CP1H CPU Units CP1H-X@@@@-@ 

CP1H-XA@@@@-@ 

Ver. 1.3 Δ Δ Δ Δ Δ  

Ver. 1.1       
Ver. 1.0       

CP1H-Y@@@@-@ Ver. 1.3 × Δ Δ Δ Δ  

Ver. 1.1 ×      

CP1L CPU Units CP1L-M@@@@-@ 

CP1L-L@@@@-@ 

Ver. 1.1 × × Δ Δ Δ  

Ver. 1.0 × ×     

CP1L-EM@@@@-@ 

CP1L-EL@@@@-@ 

Ver. 1.1 × × × × Δ  

Ver. 1.0 × × × ×   

CP1E CPU Units CP1E-E@@D@-A 

CP1E-N@@D@-@ 

Ver. 1.3 × × × Δ Δ  

Ver. 1.0 × × ×    
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×: Cannot be used, Δ: Can be used except for new functions added for unit versions, : Can be used 
Note 1. Functionality of CP1H CPU Units with unit version 1.0 or 1.0 and CP1L CPU Units with 

unit version 1.0 is the same as that for CS/CJ-series CPU Units with unit version 3.0. 
The functionality added for CS/CJ-series CPU Unit unit version 4.0 is not supported. 

2. There is no need to upgrade to CX-Programmer as long as the upgraded functionality is 
not used.  

 

Unit Versions of CP2-series CPU Units and Programming Devices 
CPU Unit Model Unit 

version 
CX-Programmer version 

Ver. 9.71 Ver. 9.72 or higher 

CP2E CPU Units CP2E-E@@DR-A Ver. 1.0 ×  

CP2E-S@@D@-@ Ver. 1.0 ×  

CP2E-N@@D@-@ Ver. 1.0 ×  

 

Device Type Setting 
The unit version does not affect the setting made for the device type on the 
CX-Programmer. Select the device type as shown in the following table 
regardless of the unit version of the CPU Unit.  

 Series CPU Unit group CPU Unit model Device type setting on  
CX-Programmer 

CS Series CS1-H CPU Units CS1G-CPU@@H  CS1G-H 

CS1H-CPU@@H  CS1H-H 

CS1D CPU Units for Duplex-CPU Systems  CS1D-CPU@@H CS1D-H (or CS1H-H) 

CS1D CPU Units for Single-CPU Systems CS1D-CPU@@S CS1D-S  

CJ Series CJ2H CPU Units CJ2H-CPU6@(-EIP) CJ2H 

CJ2M CPU Units CJ2M-CPU@@ CJ2M 

CJ1-H CPU Units CJ1G-CPU@@H 
CJ1G- CPU@@P 

CJ1G-H 

CJ1H-CPU@@H–R 
CJ1H-CPU@@H 

CJ1M CPU Units CJ1M-CPU@@ CJ1M 

CP Series CP1H CPU Units CP1H-X@@@@-@ 
CP1H-XA@@@@-@ 
CP1H-Y@@@@-@ 

CP1H  

CP1L CPU Units CP1L-M@@@@-@ 
CP1L-L@@@@-@ 

CP1L 

CP1L-E CPU Units CP1L-EM@@@@-@ 
CP1L-EL@@@@-@ 

CP1L-E 

CP1E CPU Units CP1E-E@@D@-A 
CP1E-N@@D@-@ 

CP1E 

CP2E CPU Units CP2E-E@@DR-A  

CP2E-S@@D@-@ 

CP2E 

CP2E-N CPU Units CP2E-N@@D@-@ CP2E-N 
 
Note Device types not supported by the CX-Programmer version that is being used will not be 

displayed on the pull-down list of the Device type Field.  
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Troubleshooting Problems with Unit Versions on the CX-Programmer 
Problem Cause Solution 

 

 

After the above message is displayed, a 
compiling error will be displayed on the 
Compile Tab Page in the Output Window. 

An attempt was made using CX-
Programmer version 4.0 or higher 
to download a program containing 
instructions supported only by 
CPU Units Ver. 2.0 or later to a 
Pre-Ver. 2.0 CPU Units. 

Check the program or change the 
CPU Unit being downloaded to a 
CPU Unit Ver. 2.0 or later. 

 

An attempt was made using CX-
Programmer version 4.0 or higher 
to download a program containing 
instructions supported only by 
CPU Units Ver. 2.0 or later to a 
Pre-Ver. 2.0 CPU Units. 

Check the settings in the PLC 
Setup or change the CPU Unit 
being downloaded to a CPU Unit 
Ver. 2.0 or later. 

"????" is displayed in a program 
transferred from the PLC to the CX-
Programmer.  

CX-Programmer version 3.3 or 
lower was used to upload a 
program containing instructions 
supported only by CPU Units Ver. 
2.0 or later from a CPU Unit Ver. 
2.0 or later. 

The new instructions cannot be 
uploaded using CX-Programmer 
version 3.3 or lower. Use CX-
Programmer version 4.0 or higher. 

 

The above error is displayed when a 
project file is read. 

An attempt was made to read a 
project file for an unsupported unit 
version. 

Click the Yes Button to initialize 
unsupported settings and read the 
file. Click the No Button to cancel 
reading the project file. 

 

The above warning is displayed when 
going online. 

An attempt was made to go online 
with an earlier version of a CPU 
Unit for a project file that contains 
an extended read protection 
setting that is supported only by a 
newer version of the CPU Unit. 

Change the protection setting in 
the PLC Properties Dialog Box. 
Or, replace the CPU Unit with 
which you need to go online with 
a higher version of CPU Unit. 
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Notice 
OMRON products are manufactured for use according to proper procedures by a qualified operator and 
only for the purposes described in this manual. 

The following conventions are used to indicate and classify precautions in this manual. Always heed the 
information provided in them. Failure to heed precautions can result in injury to people or damage to the 
product. 

DANGER  Indicates an imminently hazardous situation which, if not avoided, will result in 
death or serious injury. Additionally, there may be severe property damage. 

WARNING  Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury. Additionally, there may be severe property damage. 

Caution Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury, or property damage. 

 

 

OMRON Product References 
All OMRON products are capitalized in this manual. The word “Unit” is also capitalized when it refers to 
an OMRON product, regardless of whether or not it appears in the proper name of the product. 

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for 
anything else. 
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Visual Aids 
The following headings appear in the left column of the manual to help you locate different types of 
information. 

Indicates information of particular interest for efficient and convenient operation of the product. 

1, 2, 3… Indicates lists of one sort or another, such as procedures, checklists etc. 

 
Represents a shortcut on the Toolbar to one of the options available on the menu of the same 
window. 
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About this Part 
This part describes the CX-Programmer application and its ability to create and maintain programs for use 
with OMRON SYSMAC CS/CJ/CP, CV and C PLCs. It does not provide detailed information concerning 
the PLCs themselves, for this information the commercial manual for the device must be consulted. 

This part contains the following chapters: 

• Precautions. This portion describes general precautions for using the CX-Programmer (including 
CX-Server PLC Tools). 

• Version Upgrade Information. This portion describes the changes that have been made from version 
3.0 to version 3.1 of the CX-Programmer. 

• Chapter 1 Technical Specifications. This chapter describes the CX-Programmer software in general 
terms and also provides details of the operating environment and minimum configuration necessary 
for the satisfactory operation of CX-Programmer. 

• Chapter 2 Quick Start Guide. This chapter describes the basic features of CX-Programmer together 
with a simple tutorial for familiarization purposes. 

• Chapter 3 Project Reference. This describes the features common to two or more parts of CX-
Programmer. 

• Chapter 4 Reference. This chapter introduces the features contained in the Project workspace and 
discusses their associated commands and features. 

• Chapter 5 Advanced Topics. This chapter discusses the more advanced topics in relation to CX-
Programmer. 

• Appendix A Toolbars and Keyboard Shortcuts. This appendix summarizes the toolbar and keyboard 
shortcuts available from CX-Programmer. 

A Glossary of Terms and Index are also provided. 
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Version 9.81 Upgrade Information 
Functionality Improved from Version 9.72 to 9.81 

 Compatible Models 
The following unit version of CPU Units are supported. 
CJ2H-CPU@@(-EIP) Ver.1.6, CJ2M-CPU@@ Ver.2.2 

 Support for communication method 
Secure Comm communication via CS1W-EIP21S or CJ1W-EIP21S is supported. 

 Supported Project files 
The password protected file format (extension cxps) for CX-Programmer project files 
is supported. 
The password protected file format (extension cxfs) for function block library files is 
supported. 

 Enhanced Security Functions of PLC Backup Tool 
A new function is added to check whether the backup file has been tampered or not 
when restoring the data using the PLC Backup Tool. 
 

Version 9.72 Upgrade Information 
Functionality Improved from Version 9.70 to 9.72 

 Compatible PLC Models 
The CP1E-E/S CPU Units are supported. Select the CP2E as the PLC model. 
The CP2E-N CPU Units are supported. Select the CP2E-N as the PLC model. 
 

Version 9.70 Upgrade Information 
Functionality Improved from Version 9.61 to 9.70 

 Compatible PLC Models 
The CS1D-CPU@@HA CPU Units are supported. Select the CS1D-H as the PLC 
model. 
The CS1D-CPU@@SA CPU Units are supported. Select the CS1D-S as the PLC 
model. 
 

Version 9.61 Upgrade Information 
Functionality Improved from Version 9.6 to 9.61 

 Support for Windows 10 
Windows 10 is now supported. 

 Read Protection with Passwords 
Improvements were made in protection with password entry. 
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Version 9.6 Upgrade Information 
Functionality Improved from Version 9.5 to 9.6 

 Compatible PLC Models 
The following unit versions of CPU Units are supported. Read protection with 
extended passwords has been enabled.  
CJ2H unit version 1.5, CJ2M unit version 2.1, CS1G-H unit version 4.1, CS1H-H unit 
version 4.1, CJ1G-H unit version 4.1, CS1D-H unit version 1.4, CS1D-S unit version 
2.1, CP1H unit version 1.3, CP1L unit version 1.1, CP1L-L unit version 1.1, and CP1E 
unit version 1.3 

 Read Protection with Passwords 
Read protection using longer passwords was added. Read protection with extended 
passwords provides stronger protection for the design assets of the user. 
 

Version 9.5 Upgrade Information 
Functionality Improved from Version 9.4 to 9.5 

 Automatic Online Connection 
You can narrow down Controller models by series when you select the Controller to 
connect to in for an automatic online connection (direct connection) with CX-
Programmer version 9.51 or higher. 

 Supported Units 
The CJ-series CJ1W-ECT21 EtherCAT Slave Unit is now supported with CX-
Programmer version 9.54 or higher. 

 Supported Operating Systems 
The CX-Programmer will now run on Windows 8. 
 

Version 9.4 Upgrade Information 
Functionality Improved from Version 9.3 to 9.4 

 Compatible PLC Models 
The CP1L-EM/CP1L-EL CPU Units are supported. Select the CP1L-E as the PLC model. 

 

Version 9.3 Upgrade Information 
Functionality Improved from Version 9.2 to 9.3 

 Changed ST Editor View 
• Added the indication of line numbers on the ST Editor View. And you can also 

specify a line number to jump there. 
• Functions and registered Symbols are selectable from Word Lists. 
• When you press the Tab key while the start function of a Control Statement is 

selected, you can enter the frame of the Control Statement very easily. 
• Red wavy lines indicate ST syntax errors in a program. No programming check is 

required. 

Smart input on FB Ladder View 
You can use the Smart Input Mode on the FB Ladder View in the same way as on the 
Task Ladder View. 
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Version 9.2 Upgrade Information 
Functionality Improved from Version 9.1 to 9.2 

 Improvements on Structures 
For the CJ2 CPU Units, the available range of structures is expanded. 

• Structures (structure variables, structure member variables, and structure array 
variables) are made available in ST (Structured Text) programs and SFC 
(Sequential Function Chart) programs. 

• In automatic memory allocation, you can use structure variables. 
• You can register and use structure variables as an external variable of FB (Function 

Block) ladder and ST. 

 Improvements on TIMER/COUNTER type variables 
For the CJ2 CPU Units, the available range of TIMER/COUNTER type variables is 
expanded. 
• The TIMER/COUNTER type variables are made available in ST programs and SFC 

programs*. You can use the timer/counter completion flag and the timer/counter 
present values in ST programs. 

• In the ST program, you can start and stop the timers/counters. 
• You can register and use TIMER/COUNTER type variables as an external variable 

of FB. 
* The TIMER/COUNTER type variables cannot be used on the SFC chart view or Sub-chart view. 

 Improvements on Symbol Table Data Exchange with CX-Designer 
You can copy & paste structure variables from CX-Programmer to CX-Designer when 
the structure variables are used as a network variable in the CJ2 CPU Units. 

 

Version 9.1 Upgrade Information 
Functionality Improved from Version 9.0 to 9.1 

 Compatible PLC Models* 
The CJ2M CPU Units with unit version 2.0 are supported. 
The CJ2M-MD211/212 Pulse I/O Modules are available. 

 Improvements on Ethernet Connections* 
With a CP1E-N30/40/60 or CP1E-NA CPU Unit, Ethernet connections are made 
available using a CP1W-CIF41 Ethernet Option Board with unit version 2.0. 

* Functionality improved in version 9.12 over version 9.10. 

 Compatible PLC Models 
The CJ2M CPU Units are supported. Select the CJ2M as the PLC model. 
CJ2H CPU Units with unit version 1.3 are supported. 

 Improvements to Memory View Function 
When the CJ2M is selected as the PLC model, function block area usage is displayed. 

 Improvements for Host Link (SYSMAC WAY) Connections 
When the CP1E is selected as the PLC model, the network type can be set to 
SYSMAC WAY. 
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Version 9.0 Upgrade Information 
Functionality Improved from Version 8.3 to 9.0  

 Compatible PLC Models 
The CX-Programmer also supports CP1E-NA20 CPU Units (20-point CPU Units).  
CP1E-N/E CPU Units with 10, 14, and 60 I/O points are supported. 

 Supported Operating Systems  
The CX-Programmer will run on Windows 7.  

 Improvements to Memory View Function 
When the CP1E is selected as the PLC model, Program Area usage is displayed. 

 Improvements for Host Link (SYSMAC WAY) Connections 
When the CJ2H is selected as the PLC model, the network type can be set to 
SYSMAC WAY. 

 Data Structures Supported as Symbol Data Types  
Previous version (version 8.3)  New version (version 9.0) 

Data structures are not supported.  CJ2 CPU Units now support data structures as 
symbol data types.   

 Enhanced Program Input Functions  
Previous version (version 8.3)  New version (version 9.0) 

The input mode cannot be changed.  A Smart Input Mode is supported that automatically 
displays suggested instructions and addresses.  
The input mode can be changed from a menu or 
a tool bar.  

When copying circuits to create similar rungs 
with different addresses, the addresses must be 
input again.  

The Address Incremental Copy function can be 
used to easily create copies of similar circuit 
structures with offset addresses.  

 Enhanced User Interface for Menu and Option Settings  
Previous version (version 8.3)  New version (version 9.0) 

The display configuration for menus and options 
cannot be changed.  

Switching to Smart Style Mode is now possible 
for the menu and option setting style.  
Smart Style is the same type of menu and option 
setting function as the one supported in CX-
Programmer for CP1E.  
Either the previous Classic Mode or the new 
Smart Style Mode can be selected for the menus 
and options by selecting Tools - Options and 
then setting the Menu/Options Style on the 
General Tab Page.  


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 Changes to Search/Replace Dialog Boxes  
Previous version (version 8.3)  New version (version 9.0) 

Searches can be performed only in the entire 
PLC or in the data in the current view.  

"Programs" has been added to the search range.  

The setting for the item to be searched for was 
very detailed and included bit addresses, 
address, values (constants/numbers), 
mnemonics, symbols, and I/O comments.  

Searched objects have been grouped into 
addresses, symbol names, and all (text strings).  

Replacements can be performed only in the 
entire PLC or in the data in the current view.  

"Programs" has been added to the replacement 
range.  
Also, the selected circuits can be set as the 
replacement range.  

The setting for the item to be replaced was very 
detailed and included bit addresses, address, 
values (constants/numbers), mnemonics, 
symbols, and I/O comments.  

Searched objects have been grouped into 
addresses, symbol names, mnemonics, and 
comments.  



Previous Version Upgrade Information 
 
Refer to the APPENDIX D Previous Version Upgrade Information for the version 
upgrading before version 8.3. 
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CHAPTER 1 
Technical Specifications 

This chapter describes the CX-Programmer software in general terms and provides details of the operating 
environment and minimum configuration necessary for the satisfactory operation of CX-Programmer. 

CX-Programmer Software 
CX-Programmer is a PLC programming tool for the creation, testing and maintenance of programs associated 
with OMRON CS/CJ/CP-series PLCs, CV-series PLCs and C-series PLCs. It provides facilities for the support 
of PLC device and address information and for communications with OMRON PLCs and their supported 
network types. 

CX-Programmer operates on IBM compatible personal computers with Pentium or better central processors, 
including Pentium II. It runs in a Microsoft Windows environment. 

About this Manual 
This User Manual acts as a reference for CX-Programmer by describing its various concepts and abilities, and 
by leading the user through the basics of CX-Programmer programming. It also provides a detailed reference for 
all of the CX-Programmer functions. 

Separate OMRON manuals describe the PLC programming structure and instruction set in detail. A separate 
OMRON manual describes the common features to PLC programming used by software other than CX-
Programmer. 

 
CX-Programmer comes with a context sensitive on-line help system which is designed to 
complement this manual and to provide a quick reference at any point while using CX-
Programmer when the manual is not to hand. This general help system uses a fast ‘hypertext 
system’ which allows progressively more information about any topic to be obtained by 
selecting keywords within the descriptive text. 

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows, and 
knows how to: 

♦ Use the keyboard and mouse. 
♦ Select options from Microsoft Windows menus. 
♦ Operate dialog boxes. 
♦ Locate, open and save data files. 
♦ Edit, cut and paste text. 
♦ Use the Microsoft Windows desktop environment. 
If Microsoft Windows has not been used before, it is recommended that the reader spends some time working 
with it using the Microsoft documentation before using CX-Programmer. 

This manual also assumes that a working knowledge of OMRON PLC devices has been obtained. 

CX-Programmer Features 
CX-Programmer is a support tool for the programming of OMRON PLCs and for maintenance of their device 
settings. It supersedes the OMRON applications SYSWIN and SYSMAC-CPT. 

The following list describes important features that were present in CX-Programmer 2.1. 

♦ Support for new PLCs – Full support has been added for the, CS1G-H, CS1H-H and CJ1G, CJ1G-H, CJ1H-
H series PLCs and the D/S Gateway PLC (CPM2*-S*). 

♦ Flash ROM backup – Flash ROM backup is supported for the PLCs incorporating this feature. 
♦ Find and Replace – Enhanced and extended Find and Replace functionality. The GUI has been enhanced to 

include the scope of the search i.e. whether the Section, Global symbol and/or the Local symbol will be 
affected by the search. 

♦ Upload/Download – The Upload/Download functionality has been updated to include the CV/CVM1, 
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CS1/CJ1, CJ1H/H-H and CS1G/H-H PLCs to avoid searching section markers on the initial dialog Upload. 
♦ The range of the Send/Recv instruction has been extended to include the PLCs CS1/CJ1, CS1G/H-H and 

CJ1G/H-H  
♦ Operation – The levels of operation have been extended to include Junior, Demo and Trial versions of the 

product. 
♦ Symbol Sorting – The symbol sort for number data types has been enhanced and is now sorted separately 

from other data types in the symbol table view. 
♦ Direct import file range extended to include CPT, SP1 and COD files. 
 

Version 3.0 of CX-Programmer offers the following enhancements. 

♦ Support for new PLCs – Full support has been added for the, CJ1M, and CS1D series PLCs. 
♦ Changed the sizes and positions of dialogs for editing Contact/Coil/Instruction, Find and Replace, and 

Commented Rung. 
♦ Auto Online, Work Online Simulator - Enhanced the online functionality making it easier to connect to 

PLCs and debug programs. 
♦ Combine and Split rungs - The combine and split functions have been added making it easy to add and 

divide rungs. 
♦ Watch Window - The watch window has been enhanced to enable addresses to be entered directly on the 

watch sheet.  
♦ Key Mapping - The data of Keyboard Mapping can be saved to a file (*.mac) and loaded into a CX-

Programmer. 
♦ Section/Rung Manager - A function to edit a structure of Program is supported. Sections, Rungs and 

comments can be edited on this dialog. 
♦ I/O Comment view - A View to edit comments of addresses is now supported. 
 
CX-Programmer supports the following PLCs. 

Series Model CPU Types 

CP-Series CP1H X, XA, Y 

CP1L M, L 

CP1L-E EM, EL 

CP1E E, N, NA 

CP2E E, S 

CP2E-N N 

CJ-Series CJ1G CPU 44, CPU 45 

CJ-Series CJ1G-H CPU 42, CPU 43, CPU 44, CPU 45 

CJ-Series CJ2H CPU 64, CPU 65, CPU 66, CPU 67, CPU 68,  
CPU64-EIP, CPU65-EIP, CPU66-EIP, CPU67-EIP, CPU68-EIP 

CJ2M CPU11, CPU12, CPU13, CPU14, CPU15, CPU31, CPU32, CPU33, 
CPU34, CPU35 

CJ-Series CJ1H-H CPU64-R, CPU65-R, CPU66-R, CPU67-R, CPU 65, CPU 66, CPU 67 

CJ-Series CJ1M CPU 11, CPU 12, CPU 13, CPU 21, CPU 22, CPU 23 

CS-Series CS1G  
CS1G-H 

CPU 42, CPU 43, CPU 44, CPU 45 

CS-Series CS1H 
CS1H-H 

CPU 63, CPU 64, CPU 65, CPU 66, CPU 67 

CS-Series CS1D-H CPU 65, CPU 67, CPU67A, CPU68A 

CS1D-S CPU 42, CPU 44, CPU 65, CPU 67, CPU44A, CPU67A 

CV-Series CV1000 CPU 01 

CV-Series CV2000 CPU 01 

CV-Series CV500 CPU 01 

CV-Series CVM1 CPU 01, CPU 11 
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Series Model CPU Types 

CV-Series CVM1-V2 CPU 01, CPU 11, CPU 21 

C-Series C1000H CPU 01 

C-Series C2000H CPU 01 

C-Series C200H CPU 01, CPU 02, CPU 03, CPU 11, CPU 21, CPU 22, CPU 23, CPU 31 

C-Series C200HE CPU 11, CPU 32, CPU 42 

C-Series C200HE-Z CPU 11, CPU 32, CPU 42 

C-Series C200HG CPU 33, CPU 43, CPU 53, CPU 63 

C-Series C200HG-Z CPU 33, CPU 43, CPU 53, CPU 63 

C-Series C200HS CPU 01, CPU 03, CPU 21, CPU 23, CPU 31, CPU 33 

C-Series C200HX CPU 34, CPU 44, CPU 54, CPU 64 

C-Series C200HX-Z CPU 34, CPU 44, CPU 54, CPU 64, CPU 65, CPU 85 

C-Series CPM1 
(CPM1A) 

CPU 10, CPU 20, CPU 30, CPU 40 

C-Series CPM2* 
CPM2*-S* 

– 

C-Series CQM1 CPU 11, CPU 21, CPU 41, CPU 42, CPU 43, CPU 44, CPU 45 

C-Series CQM1H CPU 11, CPU 21, CPU 51, CPU 61 

NSJ-Series NSJ G5D (Used for the NSJ5-TQ0*-G5D, NSJ5-SQ0*-G5D, NSJ8-TV0*-G5D, 
NSJ10-TV0*-G5D, and NSJ12-TS0*-G5D) 

FQM-Series FQM-CM FQM1-CM001/002 

FQM-MMA FQM1-MMA21/22 

FQM-MMP FQM1-MMP21/22 

IDSC – – 

SRM1 SRM1 C01, C02 

SRM1 SRM1-V2 C01, C02 

Note: The CVM1-V1 PLC for types CPU01 and CPU11 cannot be specifically selected. Use the non 
V2 types. 

Refer to the CX-Server PLC Tools User Manual for information regarding available communication types. 

System Requirements 

System Requirements 
Refer to the CX-One Setup Manual (Cat. No. W463) for the system requirements to install the CX-
Programmer on a computer. 

Memory Capacity 
The required RAM depends on the size of the programs that are created. For each Kstep of PLC 
programming, approximately 2 Mbytes of available RAM is required. If more than one PLC is 
registered in a project, the total RAM for the programs for all of the PLCs is required. 

Examples: 
Program size Recommended available memory 

30 Ksteps or less       60 Mbytes min. 

120 Ksteps or less       240 Mbytes min. 

400 Ksteps or less       800 Mbytes min. 
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Functional Restrictions for Windows Vista or later OS 
The following functional restrictions exist when running the CX-Programmer on Windows Vista or later 
OS. 

• Online connections to PLCs on Controller Link networks are not possible through a Controller Link 
Support Board when Controller Link is selected as the network type. 

• Online connections to PLCs on SYSMAC LINK networks are not possible through a SYSMAC LINK 
Support Board when SYSMAC LINK is selected as the network type. 

• Online connections to PLCs on SYSMAC NET networks are not possible through a SYSMAC NET 
Support Board when SYSMAC NET is selected as the network type. 

• Online connections to CS1 Boards in computers are not possible when "CS1 board" is selected as the 
network type. 

• Online connections to SYSMAC Boards in computers are not possible when "SYSMAC Board" is 
selected as the network type. 

• Online connections to PLCs on the network are not possible when FinsGateway is selected as the 
network type. 
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Installing and Uninstalling the Software 

Software That Must Be Installed 
The CX-Programmer is available on the CX-One FA Integrated Tool Package. 

Refer to the CX-One Setup Manual (W463, provided with the CX-One) for the installation procedure for the 
CX-One. 

Cat. No. Model Manual name Contents 
W463 CXONE-AL@@D-V4/ 

LT@@@-V4 
CX-One Setup 
Manual 

An overview of the CX-One FA Integrated Tool 
Package and the CX-One installation procedure 

Help and How to Access it 
CX-Programmer comes with a detailed context-sensitive help system. At any time while using the software, it is 
possible to get help on the particular point that is currently being worked on, or on general aspects of CX-
Programmer. This system is intended to complement the manual, by providing an on-line reference to specific 
functions of the software. The manual is designed to provide tutorial information and discuss the various 
facilities offered by CX-Programmer. 

♦ Help topics (available from the Help menu); 
♦ Instruction Reference (available from the Help menu and from the instruction entry dialog); 
♦ Context sensitive help; 
♦ About (available from the Help menu); 
♦ Status Bar. 

Help Topics 
Select the Help Topics option on the Help menu. The Help system provides a standard look-up dialog under the 
Contents tab showing the contents of the CX-Programmer Help file. Double-click on an item to read the 
associated information. 

Index 
Use the following procedure to retrieve on-line help from the Index tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Topics option from the Help menu. 

 2. Select the Index tab. 

 3. Enter a text query into the first step field. The second step field is refreshed according to 
the query entered in the first step field. 

 4. Select an entry in the second step field and select the Display pushbutton, or double-click 
on the index entry. 

 5. If an entry is linked to two or more topics, the names of the topics are displayed in the 
Topics Found dialog. Select a topic and choose the Display pushbutton or double-click on 
the topic. 

Find 
Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Topics option from the Help menu. 

 2. Select the Find tab. 

 3. Enter a text query into the first step field. The second step field is refreshed according to 
the query entered in the first step field. Previous text queries can be retrieved by selecting 
from the drop-down list in the first step field. 

 4. Select a word that matches the query – some words may be automatically selected. More 
than one word can be selected by pressing Shift and selecting another word to extend the 
selection or by pressing Ctrl and selecting another word to add to the selection. The third 
step field is refreshed according to the word or words selected. The number of topics 
found is shown at the bottom of the dialog. 
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 5. Select a topic from the third step field and select the Display pushbutton, or double-click 
on the topic from the third step field. Select the Clear pushbutton to restart the Find 
operation. 

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. Refer to 
Microsoft Windows documentation for further information. 

Instruction Reference 
CX-Programmer supports additional help for CS/CJ/CP-series PLCs, CV-series PLCs and C-series PLCs. All 
valid instructions relating to PLC programming can be retrieved by selecting Instruction Reference from the 
Help menu, followed by either CS/CJ/CP-Series, CV-Series or C-Series. Individual help topics are displayed. 

Keyboard Mapping Reference 
CX-Programmer supports a function to customize the keyboard mapping, and provides default keyboard 
mapping files for CX-Programmer, SYSWIN and SYSMAC Support Software. A list of each keyboard mapping 
file is displayed. 

Note: Guidance can be displayed for CX-Programmer functions for SYSMAC Support Software 
operations, SYSWIN operations, and GPPQ operations by selecting Function Key Guidance 
from the View menu. The CX-Programmer shortcut key allocations for all keys can be 
displayed by selecting Information Window from the View menu. 

Context Sensitive Help 
CX-Programmer supports the use of context sensitive help. The relevant on-line help topic is provided 
automatically by selecting the current area of the display responsible for carrying out those actions. Select the F1 
function key to retrieve context sensitive help. Some dialogs include a Help pushbutton when F1 cannot be 
accessed. 

 
It is also possible to retrieve context sensitive help by selecting the Help button from the 
toolbar and selecting an area of the display to retrieve help. 

About CX-Programmer 
 

CX-Programmer includes an About button accessible from the toolbar. The About CX-
Programmer dialog supplies technical reference information about the application such as 
version and copyright information. It also contains essential version number information that 
is required for obtaining technical support. 

Status Bar 
The status bar is displayed at the bottom of many of the CX-Programmer display and tool windows. It provides 
several helpful pieces of information while programming: 

♦ Instant Help. A brief message appears in the status bar as menu commands and buttons are selected. 
♦ On-line Status. This shows the on-line or off-line status of the PLC. If connection to a PLC is lost, the status 

bar will indicate this by flashing. 
♦ Network and Node number. This shows the network number and the node number of the current PLC, 

which the cursor is pointing at. When connected to a simulator, Simulator will be displayed instead. 
♦ PLC Operating Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are 

also displayed here. 
♦ Connected PLC and CPU Type. The currently connected PLC and associated CPU can always be 

referenced in the status bar. 
♦ PLC Cycle Time. This shows the current cycle time of the PLC when connected. 
♦ Cursor Position. This shows the position of the cursor within the program. 
♦ On-line Edit Buffer Size. This shows the size remaining in the on-line edit buffer when connected to a PLC 

and editing on-line. 
♦ PLC memory backup. This shows the status of the PLC memory backup. 
The CX-Programmer status bar can be enabled and disabled by selecting the Status Bar option from the View 
menu. 
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Technical Support 
If the installation instructions for this application have been followed (refer to Chapter 1 - Technical 
Specifications), no difficulties should be encountered. However, if there is a problem, contact Customer Services. 

If a problem occurs, check that it does not relate to a fault outside CX-Programmer, for instance, with CX-
Server components. Check the following: 

♦ The computer is working correctly. 
♦ The PLC is working correctly. 
♦ The communications system is set up correctly. 
♦ The errors are cleared in the PLC. 
When Customer Services need to be contacted, keep the following details to hand. A clear and concise 
description of the problem is required, together with the exact text of any error messages. 

Note: Use the About dialog to obtain the version number of the application (the four-fielded version 
listed against the ‘CX-P.exe’ entry in the bottom list). 

 

Customer Services Request Form 

Version number of CX-Programmer:  
Serial number of the software:  
Operating system and version number:  
Language of operating system:  
PLC type, model and CPU details:  
Type of communications in use:  
Serial  
SYSMAC LINK  
SYSMAC NET  
Controller Link  
Ethernet  
Toolbus  

Nature of the problem:  

Steps taken to reproduce problem:  

Other comments:  

 
Refer to the CX-Server PLC Tools User Manual for support details regarding CX-Server components.
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CHAPTER 2 
Quick Start Guide 

This chapter describes the basic features of CX-Programmer together with a simple tutorial for familiarization 
purposes; detail is to be found in Chapter 3 - Project Reference and Chapter 4 - Reference. 

 
As this chapter proceeds, important concepts about CX-Programmer are introduced by this 
symbol. 

Starting CX-Programmer 

 
CX-Programmer is activated from the Start button in the Microsoft Windows taskbar. Once 
activated, CX-Programmer is displayed. 

 

 

CX-Programmer provides the facility to create a project file in which as many PLCs as required can be included. 
For each PLC, ladder program(s), addressing and network details, pre-set PLC memory, IO table, expansion 
instructions (if applicable) and programming symbols can be defined. 

Licensing 
CX-Programmer uses a license number system in order to activate the program in one of four modes of 
operation. The license number for the mode of operation purchased is shown on the CD case. 

Junior Mode 
To use CX-Programmer in Junior mode, a license number is required. Using this mode provides full 
functionality but restricts programming to the CP1H, CP1L, CP1L-E, CP1E, CP2E, CP2E-N, CPM1 (CPM1A), 
CPM2*, SRM1 and SRM1-V2 PLCs only. 

Trial Mode 
A license number is required to run CX-Programmer in Trial mode. Full functionality is provided is this mode 
but operation is restricted to 30 days from the time installation. 

Demo Mode 
Full system operation is provided but projects can not be saved or printed. 



PART 1: CX-Programmer 
CHAPTER 2 – Quick Start Guide OMRON 
 
 

CX-Programmer _Page 10  

Full Version 
To access the Full Version of CX-Programmer, the appropriate license number must be entered. 

The license number may be input at the time of installation or later. To enter an upgrade license number or re-
enter the existing number after installation, follow these steps: 

1, 2, 3… 1. Start CX-Programmer, as described above. 

 
2. Click the help button in the toolbar or from the Help menu select the About CX-

Programmer option. 
 3. In the ‘About CX-Programmer’ dialog click the License button. 

 4. A dialog is displayed that allows a new license number to be entered. Read the warning 
message, enter the appropriate license number and click OK. 

 5. When a correct license number is entered, CX-Programmer must be restarted to gain full 
functionality. 

Introducing CX-Programmer Projects 

 
The information within a CX-Programmer project consists of ladder program(s), operands, 
required PLC memory contents, IO tables, expansion instructions (if applicable) and symbols. 
Each CX-Programmer project file is separate and is a single document. 

CX-Programmer can only open a single project at a time. However, it is possible to deal with 
many project files by using CX-Programmer at once. 

A CX- Programmer project has a .CXP, .CXPS or .CXT file extension. (Normally the .CXP 
file is used, and is a compressed version of the .CXT file). 

Once the project itself is created the desired PLC and symbol information can be defined. For a full discussion 
of PLCs, refer to the CX-Server - PLC Tools User Manual. 

The CX-Programmer Environment 

 
This chapter describes how to manipulate the different views of the main window. Use this 
chapter to develop an understanding with the layout of CX-Programmer and to customize it 
according to specific requirements. 
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The views available are controlled via the options supplied by the View menu. 

 The project workspace. Select the Toggle Project Workspace button from the toolbar to 
activate this view. Deselect the Toggle Project Workspace button from the toolbar to 
deactivate this view. 

 
The Output window. Select the Toggle Output Window button from the toolbar to activate 
this view. Deselect the Toggle Output Window button from the toolbar to deactivate this 
view. 

 
The Watch window. Select the Toggle Watch Window button from the toolbar to activate this 
view. Deselect the Toggle Watch Window button from the toolbar to deactivate this view. 

 
The Cross Reference Report. Select the Cross Reference Report button from the toolbar to 
activate this view. 

 
The local symbol table. Select the View Local Symbols button from the toolbar to activate this 
view. 

 The Diagram Workspace. Select the View Diagram button from the toolbar to activate this 
view. 

 
The Mnemonics view. Select the View Mnemonics button from the toolbar to activate this 
view. 

 
The Address Reference tool. Select the Show Address Reference Tool button from the toolbar 
to activate this view. 

 
The I/O Comment view. Select the I/O Comment view button from the toolbar to activate this 
view. 

 
The Properties dialog. Select the Show Properties button from the toolbar to activate this 
view. 

 
The Monitor in HEX. Select the Monitor in HEX button from the toolbar to activate this 
function. 

 All windows in the CX-Programmer main window can be minimized, maximized or closed. 
Refer to standard Microsoft Windows documentation for further information. 

Each window has an associated context menu obtained by clicking the right-mouse button. These options show 
the functions relevant to the point where the right-mouse button was pressed. 

The status bar displays instant help, Network and Node numbers of current PLC, PLC on-line status, PLC mode, 
connected PLC and PLC type, PLC cycle time, on-line edit buffer size and current cursor position depending on 
which view is displayed. 

To exit CX-Programmer, select Exit from the File menu. 

Refer to Chapter 3 - Project Reference for further information. 

Project Workspace 
 

The project workspace displays the project as a hierarchical tree structure showing related 
PLC and program details. Select the Toggle Project Workspace button from the toolbar to 
activate this view. Deselect the Toggle Project Workspace button from the toolbar to 
deactivate this view. 
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A description of each object in the hierarchy and their associated context menus is provided as follows: 

 
PLC. Refer to the CX-Server PLC Tools User Manual for details. 

 
Global Symbol Table. Refer to Chapter –2 Introducing Symbols and the Symbol Table for 
details. 

 
IO Table. Refer to the CX-Server PLC Tools User Manual for details. 

 
PLC Settings. Refer to the CX-Server PLC Tools User Manual for details. 

 
Memory Card. Refer to the CX-Server PLC Tools User Manual for details. The Memory Card 
object can only be selected when the PLC is on-line. 

 
Error Log. Refer to the CX-Server PLC Tools User Manual for details. The Error Log object 
can only be selected when the PLC is on-line. 

 PLC Memory. Refer to the CX-Server PLC Tools User Manual for details. 

 
Program. Refer to Chapter –2 Using CX-Programmer for details. 

 
Local Symbol Table. Refer to Chapter –2 Introducing Symbols and the Symbol Table for 
details. 

 
Sections. Refer to Chapter – 3 Program Sections. 

  Collapse/Expand. The hierarchy can be collapsed or expanded to show either a partial view or 
full view of the project workspace tree. 

Diagram Workspace 
The Diagram Workspace can display a Ladder program, the symbol table of that program, the Mnemonics view 
and the I/O Comment view. The details displayed depend upon the selection made in the project workspace. 

When a new project is created or a new PLC added to a project, an empty Ladder program is automatically 
displayed on the right-hand side to the project workspace. The symbol table, the Mnemonics view and the I/O 
Comment view must be explicitly selected to be displayed. All views can be opened at the same time and can be 
selected via options associated with the Window menu. 

The Ladder program graphically represents the PLC power flow from left to right and the program sequence 
from top to bottom. 

PLC program instructions can be entered as a graphical representation in Ladder form. Programs can be created, 
edited and monitored in this view. 

 
Follow the examples provided to develop an understanding of the Diagram Workspace. 

 
Select the View Diagram button from the toolbar. The Ladder program window is displayed 
in the Diagram Workspace. 
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The following items are standard features of the Ladder program area: 

♦ Cursor. A rectangular block showing the current position within the rung. The location of the cursor is 
displayed in the status bar. 

♦ Rung. A logical unit of a ladder program. A rung can encompass one or more rows and columns. All rungs 
are numbered. 

♦ Bus-bars. The left bus-bar provides a graphical representation of the power supply bus-bar. The right bus-
bar contains the output region: to align objects to the right bus-bar. The right bus-bar is selectable for 
display. If shown, the ladder rungs are justified so that the outputs of the rungs are organized along it. 

♦ Grid Dots. Dots that display at the connection points of each cell. To display the grid, select the Grid 
button from the toolbar. 

♦ Rung Margin Area. The area to the left of the Left bus-bar. The rung number and step number for each rung 
are shown here (rung number on the left). 

♦ Automatic Error Detection. A bar is displayed to the left of the currently selected rung area. As elements 
and instructions are added to the rung, the additions are automatically checked to see if they are valid. The 
color of the bar indicates the validity of the program: red highlights an error, whilst green indicates a correct 
entry. In addition, elements of the text on the ladder are drawn in this error color if a problem exists. 

The color and display preferences of the above features can be amended by selecting Options from the Tools 
menu. 

More than one element in a rung can be selected by pressing the mouse button down on an element and, keeping 
the left-mouse button depressed, dragging a highlight over other elements in the rung. Selected elements can 
then be moved as a block. 

The global/local, name, address/value, and I/O comment fields for the symbol at the cursor position can be 
displayed in the symbol bar below the Ladder Section window (CX-Programmer Ver. 4.0 or later). Enable this 
function by selecting Show symbol bar in the Diagrams Tab in the Options Dialog Box of the Tools Menu (the 
default setting is ON: display). Therefore, while increasing the program display density, the text in particularly 
long I/O comments can be checked, thereby improving the readability of the program. 

Mnemonics View 
The Mnemonics view is a formatted editor for programming in mnemonic instructions. This view is made up of 
a table of six columns containing the rung number, step number, instruction, operands, value and comment. 

Mnemonic instructions are a ‘low-level’ view of a PLC program, whilst ladder is higher. Since the ladder 
program is just a higher-level representation of the mnemonic instructions, it is possible to type in mnemonics 
and see the ladder program update.  
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Select the View Mnemonics button from the toolbar. The Mnemonics view is displayed in the 
Diagram Workspace. 

 

1, 2, 3… 1. To program in mnemonics, open the mnemonic view and place the cursor on the desired 
instruction. 

 2. Press ENTER – this will enter the editing mode. 

 3. Edit or type the new instruction lines. A mnemonic instruction consists of an instruction 
name followed by a set of operands separated by spaces (e.g. ‘MOV #1 A2’). 

 4. Either press ENTER to move to the next line, or press ‘down’ or ‘up’ on the keyboard to 
move to another line – the updated line is still kept.  
The newly entered information is separated out over the columns in the table. 

 5. When finished with editing, press ‘Esc’ to come out of editing mode. 

 
Whilst entering a program in the mnemonics view, the ladder view shows the instructions in the new rung as 
statement list. Once enough instructions have been entered to enable its drawing in ladder format it is redrawn. 

Instructions can be transferred to and from the Mnemonics view using the standard Microsoft Windows Cut or 
Copy and paste functions. For example, it is possible to paste a large amount of program from a text editor. 
Refer to Chapter 3 - Project Reference for further information. 

Introducing Symbols and the Symbol Table 
PLC addresses, which are used as operands in a PLC program, can be assigned a symbolic name and/or a 
comment for the purpose of reference during programming. An address with a name or comment is known as a 
Symbol. 

A symbol table is an editable list of symbol definitions – the names, addresses and comments. This list also 
provides information on the following: 

♦ Rack location. If the address is contained within the PLC IO table, this shows the address’ rack location. 
♦ Usage. If the address is contained within the PLC IO table, this shows the physical hardware type (i.e. 

‘Input’ or ‘Output’) that is mapped to the address. If no hardware is mapped, ‘Work’ is shown, meaning that 
the symbol is for general use. 

It is possible to indicate the physical format of the data that is stored at an address. This additional data typing 
facility enables CX-Programmer to check whether the address is used consistently within programs. In the 
symbol tables, an icon is shown next to a symbol that indicates its data type. The Data Type set is as follows: 
 

Data Type Data Type Description Icon 

BOOL Address of a binary bit - a logical Boolean on or off state. This type is typically used for 
contacts or coils. 

 

CHANNEL This is a special data type, for backward compatibility. It is an address (non-bit) to data 
of any type (unsigned or signed, one or more words), so can be used in place of any of 
the above data-types except NUMBER and BOOL. The data type is weak, and so 
checking is limited (e.g. CX-Programmer cannot check if the address is being used for 
BCD or binary values). 

 

DINT Address of a signed, double binary word. 
 

INT Address of a signed, single binary word.  
LINT Address of a signed, quad binary word. 
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NUMBER A literal numeric value - not an address. The value can be signed, or floating point. 
NUMBERs are used for any literal value or for timer/counter identifiers (for TIM/CNT, 
only unsigned integer values are allowed). 
Floating point values are only suitable within IEEE REAL type operands. 
 
Note: When used as BCD number operands, the value is treated as if it were entered in 
decimal with a ‘#’ on the front. E.g. using a NUMBER ‘1234’ is equivalent to typing 
‘#1234’ as the operand, so that the decimal interpretation is made of the value.  
The value of a NUMBER data type is assumed to be decimal, unless it is prefixed with 
'#' for a hexadecimal value. 
 
Note: NUMBERs entered in hexadecimal are converted to decimal for BCD operands 
(e.g. a NUMBER defined as ‘#10’ will appear as ‘#16’ for a BCD operand). 

 

REAL Address of a double word floating point value (IEEE format - use the UDINT type for 
the BCD, FDIV format).  

LREAL Address of a long word floating point value (IEEE format - use the ULINT type for the 
BCD format).  

UDINT Address of an unsigned, double binary word.  
UDINT_BCD Address of an unsigned, double BCD word.  
UINT Address of an unsigned, single binary word.  
UINT_BCD Address of an unsigned, single BCD word  
ULINT Address of an unsigned, quad binary word. 

 
ULINT_BCD Address of an unsigned, quad BCD word.  
WORD Address of a bit string of 16 bits. 

 
DWORD Address of a bit string of 32 bits.  
LWORD Address of a bit string of 64 bits.  
TIMER Used for a timer number, Timer Completion Flag, or timer present value.  

Note: TIMERs can be used only for CJ2 CPU Units with unit version 1.0 or later and 
only with CX-Programmer version 8.3.  

 

COUNTER Used for a counter number, Counter Completion Flag, or counter present value.  
Note: COUNTERs can be used only for CJ2 CPU Units with unit version 1.0 or later 
and only with CX-Programmer version 8.3.  

 

STRING The data is handled as character strings. The size can be set between 1 and 255 
characters.  

STRUCT User-defined data type. 
Note: STRUCTs can be used only for CJ2 CPU Units and only with CX-Programmer 
version 9.0 or higher. 

 

 
Each program within a PLC has a ‘local’ symbol table that consists of symbols that are for use specifically in 
that program. Each PLC within a project has a ‘global’ symbol table that consists of symbols that can be used in 
any of its programs. When a PLC is added to a project, its global symbol table is filled with a pre-set list of 
symbols, dependant upon PLC type. 

Each symbol name must be unique within its table. However, it is possible to use the same name in a local and a 
global table – in this case, the local symbol takes precedence over the global symbol of the same name. 
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The symbol table allows these names to be entered and edited directly. Each symbol name 
must be unique. Use the following procedure to activate the symbol tables. 

1, 2, 3… 

 

1. Double-click on the symbol table object beneath the PLC in the project workspace. The 
global (i.e. PLC’s) symbol table is displayed containing global symbols.  

 

 

 Double-click on the symbol table object beneath a program in the project. The program’s local 
symbol table is displayed. 

 

 

Using CX-Programmer 

 
This chapter contains an example tutorial and also describes basic procedures that should be 
considered before performing any programming task on the computer and preparing ladder 
programs with CX-Programmer, and how to use the various tools to improve productivity. 
CX-Programmer offers many methods of working with its tools: in general, instructions are 
given for using the toolbar icon in the first instance. 

The following tutorial has been based on a CS1H PLC. The choice of PLC made here affects a number of other 
parameters that may need to be set up. For example, the CV-series requires setting up the IO table, and using the 
Settings object in the Project hierarchy to establish specific PLC characteristics. 

When planning a PLC programming project, various items need to be considered and set up within CX-
Programmer before beginning to lay down program instructions. For example, it is important for CX-
Programmer to know the model and configuration of the PLC to be programmed, so that it can establish the 
correct program checking and communications for that PLC. Programming should be targeted at the PLC that is 
to be used. It is possible to change the PLC type at any time - the program(s) are then converted. However, since 
the conversion may not be perfect, it is best to set the correct PLC type at the beginning. 

 
Before programming, it is recommended that a checklist of the important program aspects be 
constructed, including its structure and PLC parameters. To start a new project in CX-
Programmer, follow these steps in addition to the basic procedure outlined in your PLC 
programming manual: 
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Step Include 

Determine PLC essential parameters PLC series, PLC type, CPU (where applicable), 
communications interface, choice of editor and project type. 

Determine allocation of PLC memory Where applicable. For example, C-series PLCs require 
working out the balance required between program memory 
and expansion data memory. 

Determine PLC setup parameters PLC configuration data. 

Create appropriate IO Table List all related IO devices and addresses. Some C-series 
PLCs do not support this function. 

Decide how to input and edit the program CX-Programmer offers two languages: ladder and mnemonic. 
A mixture may be used. 
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Starting a New Project 
Once the project requirements have been worked out on paper, the first step is to create a project and define the 
device entries for that project. A project can have multiple PLCs. CS/CJ/CP-series PLCs are multi-tasking and 
can therefore have more than one program associated with them in the project; CV-series PLCs and C-series 
PLCs can only have one program associated with the device. 

Note:  To create a new project using only SFC or ST, use CX-Programmer Ver. 7.2 or higher. Select 
Tools – Options and set the Default Program Type in new PLC: on the PLCs Tab Page to SFC 
or ST to create an SFC or ST program from the beginning, instead of a ladder program. 

 

 
Use the following procedure to create a new project. 

1, 2, 3… 

 

1. Select the New button from the toolbar. 
2. Define the device entries for the project. Refer to the CX-Server PLC Tools User Manual 

for further information. For this tutorial, set the PLC type as CS1H with CPU type 
CPU67. 

 
3. Save the project. Select the Save Project button from the toolbar. The Save CX-

Programmer File dialog is displayed. 
 4. Type a valid file name in the File Name field. Select the Save pushbutton to save the new 

project. Select the Cancel pushbutton to abort the operation. 
When a new PLC is added to a project, the following empty tables are created: 

♦ Empty local symbol table; 
♦ Global symbol table containing pre-set symbols; 
♦ IO Table; 
♦ PLC Memory data; 
♦ PLC Settings data. 

The project workspace is populated with the contents of the newly created project and a Ladder program is 
displayed in the Diagram Workspace ready for programming to begin. 

A description of each object in the project hierarchy is provided in Chapter 4 - Reference. 

Within the Ladder program, the current position is indicated by a highlighted rectangular block, known as the 
cursor. Using the mouse or the arrow keys, the cursor can be positioned at any point within the diagram. An 
element can be placed at the current cursor position by either selecting it from the Insert menu, selecting it from 
the toolbar or by pressing its assigned shortcut key. An element can be placed in any empty grid position, or 
may overwrite a horizontal element. 



PART 1: CX-Programmer 
OMRON CHAPTER 2 – Quick Start Guide 
 
 

  CX-Programmer _Page 19 

Inserting Programs  
CS/CJ-series PLCs 
ST or SFC can be selected as the program language when inserting programs. 

When using CS/CJ-series PLCs, however, the CPU Unit of the PLC being used must be unit version 4.0 or 
higher. 

Right-click Program in the project workspace to display the pop-up menu and select Insert Program – Ladder, 
Insert Program – Structured Text, or Insert Program – SFC.  

 

Note: Setting Default Programs When Creating New Projects 
The default program type is automatically set to ladder program for new projects. If a CS/CJ-
series PLC is being used with CX-Programmer Ver. 7.2 or higher, the default program type 
for new projects can be changed to ST or SFC. Select Tools – Options and on the PLCs Tab 
Page of the Options Dialog Box, select one of the following three program types. 

• Ladder 
• ST 
• SFC 

 
PLCs Other Than CS/CJ-series PLCs 

There is no sub-menu for selecting the programming language under the Insert Program option. 

Right-click the program in the project workspace to display the pop-up menu. Select Insert Program. 

Task Allocations of Programs 
Task and program types depend on the PLC type, defined in the program properties. 

Use the following procedure to change properties for a program at any time. 

1, 2, 3… 1. Click on the Program object in the project workspace. 

 
2. Select the Show Properties button from the toolbar. The Program Properties dialog is 

displayed. 
 3. Select a Task type setting from the Task Type field. Since this program is written for a 

cyclic task, set this to ‘Cyclic Task 00’. The icon to the left of the program name changes 
to reflect the task type, and the task number is shown on the right of the program name. 

 4. Set the Operation Start setting so the program starts on PLC start-up. 

Note:  Programs that have their tasks assignment set to “unassigned” are effectively excluded from 
the project. This means that the program will not be compiled or downloaded to the PLC. 
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Writing a Program 

 
The following program sequences a set of traffic lights. The sequence is a standard British 
sequence of the following order: 

• Red light only; 
• Red and Amber lights together; 
• Green light only; 
• Amber light only. 

 Writing a ladder program consists of: 
• Creating symbols; 
• Creating the ladder program; 
• Compiling (automatically checking) the program; 
• Transferring the program to and from a PLC; 
• Comparing the program with the PLC program; 
• Monitoring the program during execution; 
• Performing an on-line edit (if necessary). 

Creating Symbols 
An important step in creating a Ladder Program is the definition of those PLC data areas that are to be 
referenced by the program. It is possible to skip this step, and use addresses directly within the program. It is 
better, however, to create symbolic names for the addresses so that the programs become more readable and 
maintainable. 

Use the following procedure to create symbols. 

1, 2, 3… 

 

1. Click in the Diagram Window and select the View Local Symbols button from the 
toolbar. 

 
2. Select the New Symbol button from the toolbar. The Insert Symbol dialog is displayed. 

 3. Enter ‘AmberLight’ in the Name field. 

 4. Set the Address or value field to ’10.01’. 

 5. Leave the Data type field set to ‘BOOL’ to indicate a bit (binary) value. 

 6. Type ‘Prepare to go / stop’ in the Comment field. 

 7. Select the OK pushbutton to proceed. 

 
Repeat this procedure for each of the other entries in the following table: 

Name Address Data Type Comment 

RedLight 10.00 BOOL Stop. 

GreenLight 10.02 BOOL Go. 

RedLightTimer 1 NUMBER Timer for the red light period. 

AmberLightTimer 2 NUMBER Timer for the amber light period. 

GreenLightTimer 3 NUMBER Timer for the green light period. 

AmberOnlyTimer 4 NUMBER Timer for the amber only period. 

RedTimerDone T0001 BOOL  

AmberTimerDone T0002 BOOL  

GreenTimerDone T0003 BOOL  

AmberOnlyTimerDone T0004 BOOL  

TimeInterval 48 NUMBER Speed at which the sequence works (ticks). 

 
Note: It is important to use the standard form of addresses in CX-Programmer. Depending upon 

their defined type, addresses may have two components – a channel and a bit number. In the 
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above example, the symbol ‘RedLight’ is defined as type ‘BOOL’. Entering the address ‘10’ 
is interpreted by CX-Programmer as ‘0.10’. If it had been intended as bit zero at address 50, it 
would have been necessary to enter it as ‘5000’ or (more easily) ‘50.00’. 

Note: Symbols of NUMBER type have been used to indicate the timer numbers used in the PLC. 
Whilst it is possible to type numbers directly into the program ‘TIM’ instruction operands, it is 
more readable to define symbols that can have a name and comment. CX-Programmer allows 
numbers to be defined as symbols, as well as addresses. 

Note: It is possible to create symbols whilst creating the PLC programs – when entering ladder 
contact/coil and instruction information. It is not necessary to use the symbol table to create 
symbols. 

Creating a Ladder Program 
A PLC can be programmed using either the Ladder or Mnemonic programming languages. The Ladder program 
is created in the Diagram View of the Diagram Window. 

Use the following procedure to create a ladder program. 

1, 2, 3… 1. Ensure the Ladder program is displayed in the Diagram Workspace. 

 
2. Give the rung a comment by using the Properties box (move the cursor to the rung 

margin and access the properties box from the context menu.  
 Note: A rung comment placeholder can be inserted into the compiled code (if the Include 

Comment Instructions property of the PLC is set), and the comment itself can then be 
saved to a file or file-card. All comments are saved in the project file. 

 
3. Place a New Closed Contact at the start of the rung – select the New Closed Contact 

button from the toolbar and click in the top left cell. The New Closed Contact dialog is 
displayed. 

 4. Enter or select ‘AmberOnlyTimerDone’ from the combo and select the OK pushbutton. 
When a comment dialog is displayed, select the OK pushbutton again.  
Note that the rung margin now shows a red mark down its side. This is to indicate that the 
rung is incomplete – the marker bar shows whenever the rung has an error. 

 
5. Place an Instruction by selecting the New PLC Instruction button from the toolbar and 

clicking next to the Contact. The New Instruction dialog is displayed. 
 6. Enter the instruction ‘TIM’ and the two operands, ‘RedLightTimer’ and ‘TimeInterval’, in 

the edit box with a space between each word. 
 Note: The value of the symbol ‘RedLightTimer’ is used for the operand – the number ‘1’. 

In CX-Programmer, it is necessary to use a NUMBER for the first operand of a TIM/CNT 
instruction. It is not allowed to use a timer/counter address (i.e. T001 is not allowed). 

 7. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a 
comment dialog is displayed, select the OK pushbutton again.  
Note that the rung margin no longer shows a red mark down its side. There is no error 
within the rung.  

 
8. Give the instruction a comment by using the Properties box (place the cursor over the 

instruction title and bring up the properties). Enter the text ‘Red light on only’ and press 
return. 

 
9. Place a New Contact at the start of the next rung. (Either like before, or by moving the 

cursor to the start of the rung and using the Insert/Contact/Normally Open menu 
command, or by pressing the shortcut key displayed for that menu command – usually 
‘C’). The New Contact dialog is displayed. 

 10. Enter or select ‘RedTimerDone’ from the combo and select the OK pushbutton. When a 
comment dialog is displayed, select the OK pushbutton again. 

 
11. Place an instruction next to the Contact and display the New Instruction dialog. (Either 

like before, or by using the Insert/Instruction menu command, or by pressing the shortcut 
key for that command – usually ‘I’). Enter the instruction ‘TIM’ and the two operands, 
‘AmberLightTimer’ and ‘TimeInterval’, in the Instruction edit box. 

 12. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a 
comment dialog is displayed, select the OK pushbutton again. 
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13. Give the instruction a comment of ‘Red and amber lights on together’. 

 
14. Place a New Contact at the start of the next rung to display the New Contact dialog. 

 15. Select ‘AmberTimerDone’ from the combo and select the OK pushbutton. When a 
comment dialog is displayed, select the OK pushbutton again. 

 
16. Place an instruction next to the Contact and display the New Instruction dialog. Enter the 

instruction ‘TIM’ and the two operands ‘GreenLightTimer’ and ‘TimeInterval’ in the edit 
box. When a comment dialog is displayed, select the OK pushbutton again. 

 17. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a 
comment dialog is displayed, select the OK pushbutton again. 

 
18. Give the instruction the comment ‘Green light on only’. 

 
19. Place a New Contact at the start of the next rung to display the New Contact dialog. 

 20. Select ‘GreenTimerDone’ from the combo and select the OK pushbutton. When a 
comment dialog is displayed, select the OK pushbutton again. 

 
21. Place an instruction next to the Contact and display the New Instruction dialog.  Enter the 

instruction ’TIM’ and the two operands ‘AmberOnlyTimer’ and ‘TimeInterval’ in the 
edit box. 

 22. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a 
comment dialog is displayed, select the OK pushbutton again. 

 
23. Give the instruction a comment of ‘Amber light on only’. 

The Ladder Program should resemble that illustrated (depending upon the display options chosen). 

 

Use the following procedure to place an output for each of the traffic lights into the program. 

1, 2, 3… 1. Ensure the Ladder program is displayed in the Diagram Workspace. 
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2. Place a New Contact at the start of the next rung and assign it to symbol ‘RedTimerDone’ 

(select the symbol name from the combo on the New Contact dialog. 

 
3. Place a New Closed Contact to the right of the Red and Amber Timer and assign it to 

symbol ‘GreenTimerDone’. 

 
4. Place a Coil by selecting the New Coil button from the toolbar next to the Green Light 

Timer. Select ‘RedLight’ from the combo and select the OK pushbutton. 

 
5. On the next rung below, place a contact to the left. Assign it to use ‘AmberTimerDone’. 

 
6. To the right of the contact, place a closed contact, and assign it to ‘GreenTimerDone’. 

 
7. To the right of the second contact, place a coil and assign it to ‘RedLight’. 

 
8. On the next rung, place a contact on the left, and assign it to ‘AmberTimerDone’. 

 
9. To the right of the contact, place a closed contact and assign it to ‘GreenTimerDone’. 

 
10. To the right of the second contact, place a coil and assign it to ‘AmberLight’. 

 11. Press return when the selected cell is on the right of the rung. This will create a new line. 

 
12. Below the left ‘AmberTimerDone’ contact (but on the same rung), place a New Closed 

Contact and assign it to the symbol ‘RedTimerDone’. 

 
13. Place a new Vertical by selecting the New Vertical button from the toolbar between the 

‘GreenTimerDone’ Contact and the ‘AmberLight’ Coil. Connect this to the 
‘RedTimerDone’ by placing New Horizontal connections to join to the Vertical by 
selecting the New Horizontal button from the toolbar. 

Note: Connecting lines can be drawn by clicking the Line Connect Mode button  and 
then clicking the starting point and dragging to the end point. Connecting lines can also be 

deleted by dragging after clicking the Line Delete Mode button . A line can also be drawn 
by dragging on a line that is not connected on one end.  

 
14. Place a New Contact at the start of the next rung and assign it to symbol 

‘GreenTimerDone’ via the New Contact dialog. 

 
15. Place a Coil next to the contact and assign it to symbol ‘GreenLight’. 

 

The output rungs of the Ladder program should resemble those shown below. 

 

 

Instructions on the right side of rungs can now also be displayed horizontally (CX-Programmer Ver. 4.0 or later). 
Enable this function by selecting Tools – Options, and then selecting Show output instructions horizontally in 
the Diagrams Tab Page (the default setting is OFF: previously used vertical display). By using the horizontal 
display mode, the number of instruction rungs that can be printed and displayed on one screen is increased, 
improving the readability of the program. At the same time, the number of printed pages can be reduced. 
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Use the following procedure to examine the ladder program. 

1, 2, 3… 1. Ensure the Ladder program is displayed in the Diagram Workspace. 

 
2. Switch to symbol table by selecting the View Local Symbols button from the toolbar. 

Open the Address Reference Tool by selecting the Show Address Reference Tool button 
from the toolbar. 

 3. Examine each symbol’s usage in the program by selecting a symbol whilst displaying the 
Address Reference Tool, or moving around the diagram with the cursor. 

The Ladder Program can also be viewed and edited in Mnemonics view. Block Programs can be entered in 
either Mnemonics view or by showing a rung in statement list within the ladder editor. 

 
Select the View Mnemonics button from the toolbar to display the Mnemonics view. To enter 
mnemonics directly into the ladder editor, select Show as Statement List for the relevant 
rung. 

Compiling the Program 
The program undergoes continual verification during its creation and any subsequent editing; this applies to both 
on-line and offline programming. Errors appear in red in the ladder diagram. If a rung contains an error, a red 
line appears down the left-hand side of the Ladder rung. This can happen, for example, when the element has 
been placed on the diagram window but has not been assigned a symbol or address. 

Use the following procedure to compile the program. 

1, 2, 3… 

 

1. To list any errors in the program, select the Compile Program button from the toolbar. 
The output (for example, compilation progress or error details) is displayed in the Compile 
tab of the Output Window. 

Downloading the Program to a PLC 
The project contains details of the type and model of the PLC for which the program is intended. Before a 
program can be downloaded, this information should be reviewed to ensure that it is correct and that it matches 
the PLC actually being used. The appropriate communications interface type should also be selected for the 
connected PLC. Other parameters, for example PLC Setup may need to be specified before connecting to the 
PLC and running a program. Refer to Chapter 4 - Reference and to the CX-Server PLC Tools User Manual 
concerning the definition of the project’s IO Table, PLC Settings, Memory Card and Error Log. 

Use the following procedure to transfer the program to the PLC. 

1, 2, 3… 

 

1. Save the current project by selecting the Save Project button from the toolbar. If the 
project has not been saved before, the Save CX-Programmer File dialog is displayed. 
Enter a file name in the File name field and select the Save pushbutton to complete the 
save operation. 

 
2. Connect to the PLC by selecting the Work On-line button from the toolbar. A 

confirmation dialog is displayed: select the Yes pushbutton to connect. Since ordinary 
editing is not allowed when on-line, the program becomes grayed. 

 3. Select the program object in the project workspace. 

 
4. Set the PLC operating mode to Program by selecting the Program Mode button from the 

toolbar. If this step is ignored, CX-Programmer automatically places the PLC in this 
mode. 

 
5. Select the Download button from the toolbar. The Download Options dialog is displayed. 

 6. Set the Programs field and select the OK pushbutton. 

Programs can be downloaded to CS/CJ-series CPU Unit Ver. 2.0 or later, and downloading by task (program) 
instead of the whole user program is possible (CX-Programmer Ver. 4.0 or later). Select Partial Transfer – 
Task Transfer to PLC from the PLC Menu, and download a specified single task or multiple tasks. This 
function enhances the efficiency of program development by multiple personnel. Particularly, by downloading 
to the PLC by task (program), only the parts to be changed are reflected in the PLC, resulting in fewer working 
errors. 
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Uploading the Program from a PLC 
Use the following procedure to transfer the program from the PLC. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Upload button from the toolbar. The Upload Options dialog is displayed. 

 3. Set the Programs field and select the OK pushbutton. 

Comparing the Project Programs with the PLC Programs 
A project program can be compared with the program in the PLC. Use the following procedure to compare the 
project program and the program on the PLC. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Compare with PLC button from the toolbar. The Compare Options dialog is 

displayed. 
 3. Set the Programs field and select the OK pushbutton. The Compare dialog is displayed. 

Details regarding comparisons between computer and PLC programs are displayed in the Compile tab of the 
Output Window. 

 

Offline Program Verification 
Program verification is possible offline between the current project and a closed project file. (Select Compare 
Program from the File menu and select the file to be compared.) The results of verification can be saved to a 
file in CSV format. 

Two methods can be used to display the comparison results.  

• Overview display: Program lists are displayed of the compare programs.  

• Mnemonic display: The specified program is displayed in mnemonic form with differences displayed in color.  

The comparison results are displayed by section and mnemonic, including added or omitted instructions. You 
can also jump from the mnemonic comparison results to the corresponding position in ladder view. The 
comparison results can be saved in a file by selecting Save As from the File menu in the Compare Result 
dialog box. If the file is saved from the overview display, the comparison results for all programs will be saved 
in CSV format. If the file is saved from the mnemonic display, the comparison results for the currently displayed 
program will be saved in CSV format. 

The following abbreviations will be displayed between program addresses and mnemonics and will be saved in 
the CSV file.  
*: Mismatch, D: Difference, M: Moved, N: Missing 

Monitoring a Program During Execution 
Once the program has been downloaded, it can be monitored in the Diagram Workspace (which acts a mimic 
display) during execution. When CX-Programmer goes on-line to a PLC, the Toggle PLC Monitoring button 
also toggles on and starts to monitor the program. If the program is not monitored, use the following procedure 
to monitor the program. 
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1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Toggle PLC Monitoring button from the toolbar. 
3. As the program executes, data and power-flow can be followed in the Ladder program; 

for example, connections are selected and values are incremented. 

Note: Individual PLC data elements can be monitored via the Watch Window. This window allows 
monitoring of addresses from multiple PLCs at the same time. 

Note: The values are monitored in a format according to the data-type of the symbol that is being 
used for the operand, or the data-type of the instruction operand itself. To always monitor in a 
single, hexadecimal format, turn on the Monitor In Hex option from the toolbar. 

On-line Edit 
Although the downloaded program has been grayed to prevent direct editing, the Ladder program can be 
amended by explicitly selecting the On-line Edit feature. 

It is usual to have the PLC operating in Monitor mode while using on-line editing functions. On-line editing is 
not possible in Run mode.  

Use the following procedure to edit the program on-line. 

1, 2, 3… 1. Select the rungs to be edited by dragging the mouse and selecting the required rungs. 

 
2. Select the Compare with PLC button from the toolbar to ensure that the edited area is 

the same as in the PLC. 

 
3. Select the On-line Edit Rungs button from the toolbar. The background to the rung 

changes to show that it is now an editable area. The rungs outside this area cannot be 
altered but elements can be copied from these rungs into the editable rungs. 

 4. Edit the rungs as appropriate. 

 
5. Select the Go to online-edit rung to go back to the top of the on-line editing rung. 

 
6. When satisfied with the results, select the Send On-line edit Changes button from the 

toolbar. The editing is checked and transferred to the PLC. 

 
7. Once these changes have been ‘sent’ to the PLC, the editable area becomes read-only 

once more. The on-line edit can be cancelled at any point prior to committing the 
changes by selecting the Cancel On-line Edit button from the toolbar. 

Note 1: A symbol address or type cannot be edited on-line. 
Note 2: I/O comments can be changed during online editing in Ladder diagram view, in the Symbol 

Table, or in I/O Comment View. If I/O comments have been changed when online editing is 
ended, a confirmation message will appear asking if the symbol table file should be transferred 
to file memory in a CS-, CJ-, CP-, CVM1, or CV-series PLC or to the I/O comment area in the 
allocated UM (user memory) in a C-series PLC.  

 If the changes in a symbol table or program comment are not transferred in online editing, a 
confirmation message will appear in the following timing. Be sure to transfer the changed 
item: 
 - At the end of connection with the PLC 
 - When the Transfer from PLC is executed after online editing 

 Symbol table names and addresses cannot be changed during online editing.  
 I/O comments with symbol names cannot be transferred to the I/O comment area in UM (User 

Memory) in C-series PLCs. 

Attaching Comments 
An attached comment is a comment associated with an element of a program (i.e. contact, coil or instruction). 
The comment is entered through the Properties dialog box of the element by selecting the Properties option 
from the context menu of the item. 

When a comment has been entered against an element, a circle will appear at the top-right corner of the element. 
This circle contains a number that uniquely identifies the comment within the rung. The comment itself will 
appear to the right of the circle for output instructions (subject to the chosen ladder-information options), or it 
will appear in the Rung’s Annotation List. 
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Summary 
 

 
In this chapter, the programmer has been introduced to the following concepts: 
• Starting the CX-Programmer application. 
• CX-Programmer and projects. The CX-Programmer environment, including the project 

workspace, Diagram Workspace, Mnemonics view and symbol tables. 
• Getting started with CX-Programmer. 
• Setting up a Ladder program. 
• Writing a Ladder program. 

 

Note: You can switch to the Smart Style Mode to use Smart Menus. This is the same mode as the 
one supported by the CX-Programmer for CP1E. Select Tools - Options and then set the 
Menu/Options Style on the General Tab Page to display in the Smart Style Mode (CX-
Programmer version 9.0 or higher).  
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CHAPTER 3 
Project Reference 

This chapter describes the different views available; the features common to the objects displayed in the Project 
Window and standard Microsoft Windows procedures that are also common to these components. 

Project Workspace 

 
The project workspace displays the project as a hierarchical tree structure showing related 
PLC and program details. Select the Toggle Project Workspace button from the toolbar to 
display the project workspace and remove the project workspace from the display. 

 

A description of each object in the Project Tree Workspace and their associated context sensitive menus is 
provided in Chapter 4 - Reference. 

Double clicking on an object opens it either in the Diagram Workspace or in a new window. Selecting an object 
and clicking the right-mouse button displays the associated context sensitive menu. 

  The hierarchy can be collapsed or expanded to show either a partial view or full view of the 
project tree. 

More than one Ladder Diagram symbol table or Mnemonics View can be displayed. Select the appropriate 
window from the list of open windows from the Window menu. 

Program Sections 
For the easier management of large programs, a program can be divided into a number of definable, named 
sections. A section is like a chapter in a book – the PLC scans the sections in order. 

A list of the sections in a program is displayed in the project workspace under the program name. There is also a 
section list view showing the Start and End steps, which can be opened in the workspace window by clicking on 
a program name. 

It is possible to reorder and/or rename the sections from this list or from the project workspace. It is important to 
remember however that when reordering or deleting sections, keep the ’END’ section at the end of the program. 

Program sections can be reordered using the mouse to drag and drop sections up or down in the section list. 
When using the keyboard, the 'Move Up' or 'Move Down' commands from the context menu of a section on the 
project workspace are used. 

Sections in a specific program can also be used to store frequently used algorithms that can then be copied to 
other programs, using a section as a kind of library. 
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Use the following procedures to insert, rename, move or delete a section in a program. 

1, 2, 3… 1. Inserting a new program section 

 (a) Select the program name in the Project tree. 

 (b) Click the Insert pushbutton in the toolbar or from the Insert menu select Section. 
The new section will be added to the bottom of the section list before the ‘END’ 
section. 

 Note that if previous sections have been renamed the new section will be named 
Section1, if not, it will be given the next section number. 

 2. Renaming a program section  

 
(a) Select the section to be renamed and click the right mouse button. From the context 

menu select Properties. 
 (b) In the Properties dialog enter the new name for the section and then close the 

dialog. The new section name will be displayed in the section list. 
 3. Moving a program section  

 (a) Select the program section to be moved, and from the Edit menu select Cut. Move 
to the location of the program (the program item on the project workspace) for the 
section to be placed, and select Paste from the Edit menu. Then using the mouse 
drag and drop the section in the appropriate position in the section list. 

 (b) Instead of using the Edit commands, it is possible to drag and drop the section. Drag 
the section to the program item where it is required. 

 Note that when the section is dropped, it will reposition its self immediately below the 
cursor. To drag a section to the top of the list, it must be dropped on the program item 
itself. 
A section may be moved to another program, or just within the same program, in which 
case it changes the execution sequence of the sections. 

 (b) When using the keyboard the 'Move Up' or 'Move Down' commands from the 
context menu of a section in the project workspace are used. Each command will 
move the selected section up or down one position at a time. 

 4. Copying a program section  

 (a) Select the section to be copied, and from the Edit menu select Copy. Move to the 
location of the program (the program item on the project workspace) for the copy to 
be placed, and select Paste from the edit menu. 
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 (b) Instead of using the Edit commands, it is possible to drag and drop the section in a 
similar way to moving it. However, if the ‘Ctrl’ key is held down before dropping 
the section (on the program item), then a copy operation will take place. 

 5. Replacing a program section  

 (a) To replace a section, copy or move the required section on top of the one to be 
replaced. A confirmation is then requested. 

 6. Deleting a program section  

 (a) Select the section to be deleted, and from the Edit menu select Delete. 

Section/Rung Manager 
CX-Programmer allows all six functions described above to be done from the Section/Rung Manager dialog 
for sections and commented rungs of the programs. 

  
Use the following procedure to edit the section and rung comments on the Section/Rung Manager dialog. 

1, 2, 3… 

 

1. Select the Section/Rung Manager button from the toolbar. 

 2. Select the program to be edited from the Program field. 

 3. All sections in the selected program are displayed on the Section field. The rung 
numbers and the rung comments of the selected section are displayed on the Rung 
Comment field. 

 4. Use the buttons on the right to edit rungs (i.e. Insert, Cut, Copy, Paste, and Delete). To 
edit the rung comment, select the rung and press the Edit Comment button. 

 5. Change the rung comment using the Edit Rung Comment dialog. Press the Enter key to 
close the dialog and to reflect the changes. To create a new paragraph, use the key 
combination Ctrl+Enter. 

 6. Select the section/s and use the buttons on the right of the dialog to edit them (i.e. Insert, 
Cut, Copy, Paste, and Delete). To edit the section name and/or comments, press the 
Rename button. 

 7. Change the section name and/or the comment using the Rename Section dialog. Press 
the Enter key to close the dialog and to reflect the changes. To create a new paragraph, 
use the key combination Ctrl+Enter. 

By selecting Section/Rung Manager from the Program Menu, the rung comment data can be read (imported) 
from the project in the personal computer, and operations can be performed to move the data up and down (CX-
Programmer Ver. 4.0 or later). This function allows rung comments to be allocated to a program all at once after 
uploading the program under the following conditions, even if there is no comment file (COMMENTS.CMT) in 
the Memory Card/EM file memory.  
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1) When uploading programs from a C-series PLC or other CPU Unit that cannot record rung comments. 

2) When uploading programs from a CS/CJ/CP-series, CVM1/CV-series, or C200HX/HG/HE-ZE CPU Unit. 
When the uploaded programs are changed in the actual CPU Unit using functions such as online editing, the 
position of the rung comment can be edited.  

Downloading/Uploading 
CX-Programmer can also use a PLC instruction to store the section markers in the PLC when the program is 
downloaded. This will allow CX-Programmer to upload a single section for online-editing. It will also allow 
CX-Programmer to upload the program complete with section breaks. 

A single program section may be uploaded for online-editing (reducing the transfer time to a minimum). 
However, it may not be downloaded since it is only a program segment. To download a program section, it is 
necessary to copy it into a complete program. 

Cross-Reference Report 
The Cross-Reference Report allows the symbol usage within different memory areas to be examined. It can be 
used for checking the values being set by instructions when the program is not behaving as expected. It can also 
allow the programmer to make efficient use of memory resources. 

 

Use the following procedure to generate a cross-reference report. 

1, 2, 3… 

 

1. Select the Cross-Reference Report button from the toolbar to open the Cross-Reference 
Report. 

2. Select a usage from the Report type field; either Detailed Usage, Usage Overview, Usage 
Overview with comments, Usage Overview Including Unused, Usage with Comments 
Including Unused, or Duplicate Usage Over Programs. 

 3. Select an area from the Memory Area field. When changing options, reselect from the 
Memory Area field to refresh the report. 

 4. Select the Generate pushbutton to activate the report. In addition to the address report 
information, the amount of free program memory in the PLC is displayed in the Free UM 
field. The total program memory size of the PLC is displayed in the Total UM field. 

The Detailed Usage option within the Report type field displays information about the usage of any address 
used within the PLC program(s). The program name, step number, instruction type, the start address of the 
operand and symbol details relating to each usage are shown. 

The Usage Overview option within the Report type field displays an overall summary of the usage for the 
selected memory area, showing only the addresses that are in use. For each used address, a usage count is 
displayed. The ‘D’ symbol denotes that the address has a symbol assigned to it. 

The Usage Overview Including Unused option within the Report type field displays the usage overview of the 
memory area, including addresses that are not used. 

The cross reference function usage list can be displayed with I/O comments and the list can also be printed (CX-
Programmer Ver. 4.0 or later). Therefore, the user can check what the addresses mean when checking the 
number of times the addresses have been used. This reduces the labor required for programming/debugging. 
This function can also be used to jump to the position of the rungs being used.  
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By moving the cursor to an address in the ladder diagram and selecting Check usage including unused, the usage 
list (with comments) can be displayed starting with the selected address (CX-Programmer Ver. 4.0 or later). 
This function enables the cross references to be checked for the address directly from the ladder display instead 
of from the cross reference report. 

By selecting Duplicate usage in programs in the cross reference report function, a list can be checked for any 
bits/words that have been allocated an address already being used by another task (see note; CX-Programmer 
Ver. 4.0 or later). This function can be used to easily check whether the same address is being used by another 
task (programmer) when two or more programmers are creating multiple tasks.  
Note: Cyclic tasks only (interrupt tasks not included).  

A cross-reference report can be printed. Use the following procedure to print a cross-reference report. 

1, 2, 3… 

 

1. Select the Cross-Reference Report button from the toolbar to open the Cross-Reference 
Report. 

2. Generate an appropriate cross-reference report. 
 3. Select the Print pushbutton. A standard Microsoft Windows Print dialog defines printer 

settings and allows print parameters to be entered. 

Address Reference Tool  
The Address Reference Tool shows how and where a PLC address is used within the program set of a PLC. 

 

Use the following procedure to use the Address Reference Tool. 

1, 2, 3… 1. Open a Ladder program by double-clicking the program object in the project workspace. 

 2. Select a cell in the Ladder program. 

 
3. Select the Address Reference Tool button from the toolbar. The Address Reference 

Tool window is displayed in the Diagram Workspace. The Address Reference Tool 
displays a list of references made to the address selected in the Ladder program. 

 4. With the Address Reference Tool still open, another selection can be made in the Ladder 
program; the Address Reference Tool is refreshed accordingly. 

The Address Reference Tool is displayed in front of other windows. Only one Address Reference Tool can be 
opened at a time. The window can be ‘docked’ within the main CX-Programmer window. 

Note: It may be necessary to show the address reference tool in order to use the commands Go to 
Next Output, Go to Next Input and Go to Next Address Reference, depending upon the 
diagram options chosen (see page 32). 
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Output Window 

 
The Output window is usually displayed at the foot of the main window. Select the Toggle 
Output Window button from the toolbar to display the Output window. Select the Toggle 
Output Window button from the toolbar or press an ESC key to remove the Output window 
from the display. 

The Output Window has three different views: 

♦ Compile. The Compile tab displays the output produced from program compilation. Selecting an error 
highlights the source of the problem in the Ladder Diagram. The Compile tab also displays other 
information, for example, warnings and connection messages. 

♦ Find Report. The Find Report tab displays the output produced from a search of project files for a particular 
entry. Refer to Chapter – 3 Finding and Replacing. 

♦ Transfer. The Transfer tab view displays the results of file or program loading. 

 

To clear the view, select Clear from the context sensitive menu. 

To go to the source of errors indicated in the Compile or Find Report tabs, double-click the message in the 
output window. It is also possible to use the Next Reference command from the Edit menu – this jumps to the 
location of the next message on the output window, whichever tab is on show. The location jumped to is 
highlighted in the Diagram Workspace. Note that is possible to quickly move through the location of the 
messages by continually using the Next Reference command. 

Note: Whenever compilations, PLC conversions, find reports, or file loading is displayed on the 
Output window, it automatically opens to show the results even if the window is closed. To 
close the Output window, simply press the ESC key. 

Watch Window 
The Watch window allows the contents of specified PLC addresses in more than one PLC to be monitored at the 
same time. The Watch window is usually displayed at the foot of the main window. It displays the value of the 
contents of PLC memory during program execution. The watch window also supports drag and drop enabling 
elements from the ladder view or the symbol table to be dropped on to the watch window. Watched items can 
also be added directly on the sheets or via a dialog box, and can be grouped into different sheets. 

 

Use the following procedure to use the Watch window. 

1, 2, 3… 

 

1. Open the Watch window by selecting the Toggle Watch Window button from the 
toolbar View – Windows option. 

2. Enter an address directly in the Address column on the watch sheet. Press the Enter key 
to set the address. Press Esc to cancel the address. 
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 3. The PLC name, the symbol name, and/or the data type/format may be selected on the 
Edit Dialog. To display this dialog, double-click on the cell of the Watch window, or 
select Edit from the context sensitive menu. Select the Browse pushbutton to locate a 
symbol, if required. 

 Note that a local symbol may be entered by typing in the program and symbol name, 
separated by a '.' character (this symbol 'path' is also shown in the watch window for local 
symbols). 

 4. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to 
abort the operation. 

The PLC name is added to the Watch window. During program execution, the changing value of this address is 
displayed. Values can be set in this window to a specific value to test program execution. Watch items can be 
monitored either on the Watch window (for any number of watch items) or on the Set New Value dialog (for one 
watch item). On the Set New Value dialog, the value can be monitored in Binary number (except for data type: 
BOOL/ASCII and area type TIM/CNT). Each bit can be Force Set/Reset/Cancel and Set/Reset. 

Array Variable Monitoring 
To monitor an array variable in the Watch Window, it is possible to register the variable by dragging/dropping it 
directly from the symbol table to the Watch Window. All elements of the array variable can be monitored in the 
Watch Window. 

 

Displaying PVs of Addresses in the Watch Window Sheet in Binary 
The watch sheet includes a column that allows the PVs of addresses to always be displayed in binary regardless 
of the settings specified in Data Type/Format. 16 BIT (Binary, Channel) can also be selected from the Data 
Type/Format Options, allowing values to be displayed in binary, even if the Binary column is hidden (except in 
the Timer/Counter Areas). (CX-Programmer Ver. 4.0 or later.) 

Changing the PVs for DM/EM Areas in Bit Units 
While online, when the binary display is selected in the Set New Value dialog that is displayed when the address 
in the watch window is clicked, the DM/EM Area data can be changed into PVs in bit units (CX-Programmer 
Ver. 4.0 or later). 

Pause Monitoring 
When pause monitoring is taking place, items in the watch window are monitored as normal until the trigger 
point is reached or the user triggers manually. At this time, the monitoring is stopped and the value field of all 
items within the watch window is cleared. When either monitoring or pause monitoring is re-started, the value 
field of all the items within the watch window is refreshed with the current value. 

Dragging and Dropping Items 
Symbols, ladder elements and symbol tables (from the project tree view) may be dragged and dropped into the 
watch window. These items may be dragged individually or in block form. It is not possible to drag elements 
into the watch window from the mnemonic editor, or entire sections from the project tree view. Items may not 
be dragged from the watch window i.e. it is only a drag and drop target and not a source. 
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It is not possible to view items that are of a Number type. Items that are of a Number type and are dropped into 
the watch window will not be displayed and an error message for each item is displayed in the transfer output 
window. 

Pasting Items 
Pasting items into the watch window is similar to the drag and drop mechanism. The items that may be pasted 
are symbols, ladder elements and symbol tables (from the project tree view). 

It is not possible to view items that are of a Number type. Items that are of a Number type and are pasted into 
the watch window will not be displayed and an error message for each item in the transfer output window. 

Items can be cut or copied within the watch window (i.e. cut or copy items to another sheet). 

Differential Monitoring 
It is possible to initiate differential monitoring from the PLC | Monitor option or from the watch window via a 
pop-up menu item. This will display a dialog where the user may select the type of transition trigger required for 
the currently selected item in the watch window. The dialog will then show a count of how many times this 
transition has occurred until the user closes the dialog. 

This facility is only available when the PLC for the currently selected item is in run or monitor mode. 

Options and Preferences  
A number of options and preferences can be set by selecting Options from the Tools menu. 

 

Note: You can switch to the Smart Style Mode in the Options Dialog Box. This is the same mode as 
the one supported by the CX-Programmer for CP1E. Select Tools - Options and then set the 
Menu/Options Style on the General Tab Page to display in the Smart Style Mode (CX-
Programmer version 9.0 or higher).  
The differences between Smart Style Mode and Classic Mode are given below. *1  
Classic Style  Smart Style  

Diagrams Tab Page*2  Diagrams Tab Page plus the advanced settings accessed from that page  

PLCs Tab Page  PLCs Tab Page plus the advanced settings accessed from that page  

Symbols Tab Page  Symbols Tab Page plus the advanced settings accessed from that page  

Appearance Tab Page  Appearance Tab Page plus the advanced settings accessed from that 
page  

Ladder Information Tab Page  Diagrams Tab Page plus the ladder display settings accessed from that 
page  

General Tab Page  General Tab Page plus the advanced settings accessed from that page  

SFC Tab Page  SFC Tab Page plus the advanced settings accessed from that page  
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*1: The following settings are not supported in Smart Style Mode.  
- Show rung and step number option (Nothing is gained by switching the display.)  
- Show rung dividers option (Nothing is gained by switching the display.)    
- Show grid by default option (Can be selected from main menu.)  
- Show rung annotation lists option (Can be selected from main menu.)  
- Show Right Bus bar option (Nothing is gained by switching the display.)    
- Offline Edit Mode  
- Symbol filtering (Covered by Smart Input Mode.)    
- Program/section comments (Can be selected from main menu.)    

*2: The Ladder Information parameters for Classic Mode can be set under Diagrams and Ladder 
Display under Diagrams in Smart Style Mode.  

 

Diagrams 
The Diagrams tab allows settings to be applied to the Diagram Workspace upon entry to CX-Programmer. 

Use the following procedure to change the settings applied to the Diagram Workspace. 

1, 2, 3… 1. Select the Diagrams tab within the Options dialog. 

 2. Set the Show rung and step numbers to view the rung and step numbers at the left of the 
ladder display, in the rung margin. Deselecting gives a smaller rung margin. 

 3. Setting the Show rung dividers will draw a line at the bottom of each rung, showing its 
boundary. 

 4. Setting the Show grid by default will place a dot pattern around each cell on the ladder 
diagram. This pattern can aid element placement, but may be removed for a clearer 
display. 

 5. If the Show rung annotation lists is set then the list of comments that are within the rung 
(both attached comments associated with particular elements within the rung, and 
unattached comments) will be listed below the rung comment. Note that this option can 
be quickly changed via the View Rung Annotations button on the toolbar. 

 6. Setting the Allow Address Referencing without Window option allows use of the Go to 
Input, Go to Output, Go to Next Address Reference and Go to Previous Jump Point 
commands when the address reference tool is not on show. If this option is not set, then 
the tool must be visible to use these commands. Note that when address referencing is 
active, a small delay may be experienced when moving around a diagram, depending 
upon the size of the PLC program. 

 7. Setting the Show actual I/O bit in XY will change the prefix of addresses ‘I:’ and ‘Q:’, 
which are mapped to either an input unit or an output unit, to ‘X:’ and ‘Y:’. 

 8. Setting Check duplicated output and TIM/CNT No. executes a check for an output and 
timer/counter, whether the address is already used in the program or not. The result may 
be displayed on the Output window.  
Note that addresses used as SET and RESET instructions will not be checked, since these 
are frequently used in pair. 

 9. Setting Synchronize ladder and mnemonic cursors allows the position of the cursor in the 
mnemonic view to move to the same step number as the cursor in the ladder view moves. 

 10. Selecting Tools – Options, and then selecting Show output instructions horizontally in 
the Diagrams Tab Page (the default setting is OFF: previously used vertical display) 
enables special instructions (except intermediate instructions) to be displayed 
horizontally (CX-Programmer Ver. 4.0 or later). By using the horizontal display mode, 
the number of instruction rungs that can be printed and displayed on one screen is 
increased, improving the readability of the program. At the same time, the number of 
printed pages can be reduced. 
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 11. Selecting Show symbol bar in the Diagrams Tab in the Options Dialog Box of the Tools 
Menu (the default setting is ON: display) enables the global/local, name, address/value, 
and comment fields for the variable at the cursor position to be displayed in the symbol 
bar below the Ladder Section window (CX-Programmer Ver. 4.0 or later). This increases 
the program display density, while allowing the text in particularly long comments to be 
checked, thereby improving the readability of the program. 

 12. When you select the Validate inserting of null line option, a blank line is automatically 
inserted at the end of the circuit being edited. With this function, you can easily add a 
branch circuit. 

 13. When you select the Validate inserting of connecting line option, a connecting line is 
automatically inserted when an OUT instruction or a special instruction is entered. You 
don't have to enter connecting lines for branch circuits. 

 14. View to show when split – enables two different views to be shown within the editing 
window. It is possible to choose to see a part of the editing in mnemonic mode and the 
other in ladder, or to see the local symbol table of the program in one view. 

 15. Setting the Show right bus-bar will show the right bus-bar with the ladder rungs justified 
to fill the space between the left and right bus-bars. The output instructions will appear 
aligned along the right bus-bar, as long as the rung can be drawn within the number of 
cells to the right bus-bar. If the Expands to Widest Rung option is chosen, then the right 
bus-bar position for a section is automatically set to the widest rung in the program 
section. Note that this may result in slower performance on a large section when editing 
or adding rungs, since if a rung is expanded beyond the current width, the section will be 
reformatted. 

 If no right bus-bar is shown, the rungs are justified to the left, minimizing space. 

 16. Setting Show in simple dialog mode allows Contact, Coil or Instruction dialogs to open 
in small sizes. The Show with comment dialog option allows dialogs to display for 
entering comments in simple dialog mode. 

 17. Symbol filtering sets the target data of symbol filtering for the specified text string when 
inputting instruction operands.  
Name: Searches symbol names only.  
Comment: Searches I/O comments only. 
Both: Searches both symbol names and I/O comments. 

 18. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply 
pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton 
to abort the operation. 

PLCs 
The PLC tab provides a default PLC and CPU which appears when adding a new PLC to a project. 

Use the following procedure to change PLC preferences. 

1, 2, 3… 1. Select the PLC tab within the Options dialog. 

 2. Set the Confirm all operations affecting the PLC setting to receive a confirmation 
message for computer to PLC communications.  
If a checkmark is placed in the Prohibit the online operations until the PC and PLC data 
matches checkbox on the PLCs Tab Page that appears when Tools—Options is selected, 
an Online Action Dialog Box to select either verifying or transferring data will be 
displayed. Depending on the selection, before going online, the program will be verified 
between the CX-Programmer and the PLC, the program will be transferred to the PLC, 
or the program will be transferred from the PLC. Refer to Programming On-line in 
Chapter 4 of PART 1 for details. 

 3. Select Tools − Options and Confirm all operations affecting the PLC in the PLCs Tab 
Page (the default setting is OFF: no confirmation) to prevent going offline unprepared 
when the CPU Unit is still in forced set/reset status (CX-Programmer Ver. 4.0 or later). 
After forced setting/resetting of a bit online, a dialog box is displayed when status returns 
to offline to allow the forced set/reset status of addresses to be displayed. The forced 
set/reset status can also be cancelled.  
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 4. Select the default PLC from the PLC Type field. When set CX-Programmer will show a 
confirmation dialog when an operation being carried out may affect the running of a 
PLC. 

 5. Select the default CPU from the CPU field. When a new PLC is created, these details 
will be used to initialize it. A PLC type and CPU combination may be selected, or the 
Use Current PLC button can be pressed, to set the details to that of the currently selected 
PLC in the project. 

 6. Set the Use Section marker instruction option to select whether, by default for a new 
PLC, section divisions are to be downloaded or not. If set, an extra instruction is hidden 
in the program for each section division. This allows upload options such as the upload 
of a single section. It also allows the section structure to be retained upon upload. If the 
option is turned off for a PLC, then the section structure will not be downloaded, and 
upload will not retain the structure. 
Note that this option can be enabled / disabled per PLC in the PLC properties dialog. 

 7. The Use Comments instruction option determines, by default for a new PLC, whether 
program comments (rung comments and annotations) are to include a CMT instruction in 
the PLC. CMT instructions are used during upload so that comments in a comment file 
can be linked back to the program properly. If this is not set for a PLC then it is not 
possible to upload comments, but compiled programs will be smaller since CMT 
instructions are not generated.  
Note that certain PLC types do not have CMT instructions, and this option will have no 
effect for those PLCs. 
Note that this option can be enabled / disabled per PLC in the PLC properties dialog. 

 8. Set the Default Program Type in new PLC option to set the default program type when 
creating new projects. The program type can be one of the following three options:  
Ladder, ST, or SFC. 

 9. Set the Automatically Transfer Program to Simulator option to allow program to be 
transferred automatically after on-line to the Simulator. 

 10. Set the Continuous Step Interval option to set the time for continuous step execution of 
individual steps by the Simulator. The setting range is 0 to 1000 × 100 ms (i.e., 0.0 to 
100.0 s) and the default is 500 ms (i.e., 0.5 s).  

 11. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply 
pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton 
to abort the operation. 

Symbols 
The Symbols tab allows settings to be applied to the symbol table during a work session. Use the following 
procedure to change Symbol preferences. 

1, 2, 3… 1. Select the Symbols tab within the Options dialog. 

 2. Check the Confirm changes in linked global symbols setting to ensure a confirmation 
dialog is displayed before changes are applied to global symbols. 

 3. Check the Paste rungs to another PLC with unaddressed symbols option to allow rungs 
to paste to another program with symbols unaddressed. The symbols will need to be 
addressed after copying to another program. 

 4. If you select the Changes the check code of the STRUCT Symbols option when using 
STRUCT symbols in the communication with a specific EtherNet/IP device, the check 
code generation method of structure variables is changed from the RA method set by 
default to the OMRON method. This option is valid only when network structure 
variables are used. Normally, this option is not selected. 

 5. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply 
pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton 
to abort the operation. 
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Auto Generation 
The Automatically generate symbol names option determines whether ‘unnamed’ symbols (i.e. symbols that are 
created with an address and comment but no name) are automatically assigned symbol names using the 
“AutoGen_” prefix, or whether the symbol name is just left blank. 

When the option is checked on the following rules apply: 

1. When an ‘unnamed’ symbol is created it will automatically be assigned a name, based on the address (e.g. 
an ‘unnamed’ symbol with address 7.15 will be called “AutoGen_7_15”). 

2. When the option is checked on it will be possible to reference “AutoGen_” symbols like any other symbols 
(Hence, using Find/Replace, Watch Window etc). 

Appearance 
The Appearance tab allows the colors and font displayed within the CX-Programmer environment to be 
customized. 

Use the following procedure to change preferences associated with the CX-Programmer appearance. 

1, 2, 3… 1. Select the Appearance tab within the Options dialog. 

 2. Select the item to be changed from the Item field, or select the item to change in the 
sample diagram. 

 3. Select the color to be applied to the item. The Foreground and Background Color may be 
changed by clicking on the example color box, or using the 'Custom...' button. A sample 
of the result is displayed in the Sample field. Note that many items do not have both a 
foreground and background color. 

 4. Check the default option in order to use a suitable system color. These colors will change 
according to the ‘Appearance’ display settings of Windows. 

 

Click the Reset All button to reset all the colors back to the system defaults. 

Click the Ladder Font button to set the font used for the entire display of ladder programming windows, 
including rungs that are being shown in statement list in the ladder window. When a font is selected, the ladder 
display re-scales to use the new font. 

Click the Mnemonic Font button to set the font used for the entire display of mnemonic programming windows. 

Click the ST Font button to set the font used for the entire display of  the Structured Text programming window.  

Click the SFC Font button to set the font used for the entire display of  the SFC programming window. 

The Cell Width slider allows the width of the cells to be changed on the ladder window, giving more or less 
space for text to be displayed. Depending upon the typical size of symbol names, it may be necessary to change 
the horizontal size of the ladder cells to show them better. At its minimum setting, only a few characters are 
shown in a line, but a large number of cells can shown. 
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Click the OK pushbutton to apply the settings and close the dialog. Select the Apply pushbutton to change the 
settings but remain in the dialog. Select the Cancel pushbutton to abort the operation. 

Ladder Information 
The elements of a ladder display - contacts, coils, instructions and instruction operands - can display a 
configurable set of information. The more information is displayed, the larger each cell of a ladder diagram 
becomes. Ideally, only the necessary information should be shown so that the maximum number of cells can be 
seen on the screen. 

The name and comment parts of the operand information can be individually shown or hidden using the Show 
checkboxes. 

 

Name 
When this option is selected it is possible to set the number of lines to be shown for a symbol name, and whether 
they are shown above or below the element (i.e. above or below a contact or coil). 

Address 
The If name empty option will only show the address of an operand if there is no symbol attached to the 
address, or if the symbol is unnamed. The After name option shows the address after the name, separated by a 
comma. The Above and Below options show the address on a separate line, above or below the element 
respectively. 

Comment 
When this option is selected it is possible to set the number of lines to be shown for a comment, and whether 
they are shown above or below the element (i.e. above or below a contact or coil). 

Instructions 
A range of options are given to determine the information and format of data within instructions. 

The Show data with option allows a choice of where monitoring data will be shown within the operand box of 
an instruction. It can be shown below the name, address or comment of the symbol. It can also share the line of 
the name, address or comment, so that the monitoring data is shown before the information on the same line. 
This allows the size of the instruction box to be minimized. 

Show on right for output instructions 
A range of information can be shown on the right of output instructions (i.e. coils and right-hand instructions 
such as 'MOV'). 

The Symbol Comment of the symbol used within the operand can be shown. If this option is set, the comment is 
no longer shown inside an output instruction or coil cell. 
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The Attached Comment (comment property of the instruction element on the diagram) can be shown. 

The Instruction Description (shorthand description of the instruction, the same as that shown in the Instruction 
dialog) can be shown. 

The Operand Description (shorthand description of the operand purpose, the same as that shown in the 
Instruction dialog) can be shown. 

Special instructions (except intermediate instructions) can also be displayed horizontally (CX-Programmer Ver. 
4.0 or later). Enable this function by selecting Tools – Options, and then selecting Show output instructions 
horizontally in the Diagrams Tab Page (the default setting is OFF: previously used vertical display). By using 
the horizontal display mode, the number of instruction rungs that can be printed and displayed on one screen is 
increased, improving the readability of the program. At the same time, the number of printed pages can be 
reduced. 

Note that it may not be possible to fit all of the requested information on the right of the instruction - the height 
of a cell is not determined by these choices. The 'Attached comment' is always shown first (i.e. highest priority), 
followed by the 'Symbol Comment' and then the descriptions. 

Show Program/Section Comments 
When the Show option is checked, every first rung in a section will show the Program Comments and Section 
Comments at the top of the ladder program. Double-click the comments to edit them. 
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General 
The General tab provides settings that allow the CX-Programmer environment to be customized. 

 
Use the following procedure to change the environment of CX-Programmer. 

1, 2, 3… 1. Select the General tab within the Options dialog. 

 2. Select the IME auto start option to use 2byte coded characters, if installed. 

 3. The Window Environment options to set the window style when project is created or 
opened.  

 (a) Set the position of windows and the toolbar to be displayed when the project is 
started in the Position (Window/Toolbar) area. 
When the Previous position check box is not selected (default): 
  The arrangement of the windows and the toolbar saved on your computer is 
  applied. 
When the Previous position check box is selected: 
  When an existing project is opened, the CX-Programmer windows and toolbar  
  will be displayed in the same arrangement as last time the project is saved. 

 (b) Set whether to show or hide each window in the Show area. When the Previous 
window environment option is selected, CX-Programmer will open a project using 
the settings of last saved. 

 (c) When the Show ladder only option is selected, the project will be opened with only 
the ladder view, all the other windows will be hidden. 

 (d) When the Show Window option is selected, a window to show when a project is 
opened can be set. The selections of windows are Workspace, Output, Watch, and 
Address Reference Tool. 

 4. You can select the menu and option setting style from two options in the Menu/Options 
Style area. One is the Classic Mode, which is the conventional style. The other is the 
Smart Style Mode where the frequently used functions are arranged in a convenient 
manner.  
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 5. Select Do not normalize rungs at compile for program verification to prevent 
verification errors due to normalization of rungs. 
When verifying CX-Programmer project files with programs in the PLC, if redundant 
mnemonic codes that were written using the previous support software or CX-
Programmer are present in the PLC, a verification error may occur for the same program 
because the CX-Programmer normalizes redundant rungs in the project files when 
compiling programs. Select this option to prevent this type of error. 

Note: Normalization deletes redundant rungs from a ladder program and creates the proper 
mnemonics. 

 6. Set the Max. No. of Windows option to limit the number of windows to open.  
FB library storage folder: 
Set the default folder shown in the Select Function Block Library File Dialog Box (select 
the function block, right-click, and select Insert Function Block – From File.) 

 7. Click the Advanced Button to set the following operations. 
- Do not hierarchize Row/Column Edit of the pop-up menu option 
You can set whether to hierarchize the pop-up menu on the ladder view. 
When this check box is selected, the Row/Column Edit menu items (i.e. Insert Row, 
Insert Rung Column, Delete Row, and Delete Rung Column) are displayed without being 
hierarchized.  
When this check box is not selected, the Row/Column Edit menu items are hierarchized. 
- Search include the symbol tables option 
You can set whether to include symbol tables in the search scope when “PLC” or 
“Program” is selected as the scope in the find/replace operations. 
When this check box is selected, the symbol tables are always searched regardless of the 
cursor position when the search operation starts. 
When this check box is not selected, the symbol tables are searched only when the cursor 
is placed in a symbol table when the search operation starts. 

 8. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply 
pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton 
to abort the operation. 

 

SFC 
It is possible to set the display settings for the SFC diagram editor. 

For details, refer to the CX-Programmer Operation Manual SFC (Cat. No. W469). 

Magnification 
The magnification level (i.e. zoom) of the Diagram view can be adjusted to display more or less information as 
required. If the diagram is zoomed out then the font becomes smaller and more diagram elements can be seen. 

Use the following procedure to set magnification levels. 

1, 2, 3… 1. Open the Diagram Workspace. 

 
2. Select the Zoom In button or the Zoom Out button from the toolbar to change the 

Diagram Workspace. 

 
3. Select the Zoom to Fit button to change the size of the program width to the length of 

the Diagram view. 

Finding and Replacing 
CX-Programmer provides facilities for finding references to particular text, and replacing text with other text. 
There are also powerful replacement options, such as moving a range of addresses to another starting point. The 
Search and Replace functionality consists of two dialogs, depending on which operation is being executed. The 
Find dialog is opened from the EDIT | Find menu option or the key combination Ctrl+F. The Replace dialog is 
opened from the EDIT | Replace menu option or by pressing Ctrl+H. 

It is possible to find and replace text from various places: the project workspace, diagram workspace (ladder or 
mnemonic views), a symbol table, and an I/O Comment view. 
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When using the Find and Replace feature from the project workspace, the operation searches the chosen object, 
including any objects within it. For example, when finding text from a program within the project workspace, 
the local symbol table for that program is also searched. When beginning a search from the project object itself, 
everything within the project is searched. 

It is also possible to limit the search to a single program window, symbol table, or I/O Comment view by 
beginning the search when the relevant ladder, symbol table, or I/O comment window is active. 

When Change All is selected from the Edit menu option, the Change All dialog to replace Addresses within 
the PLC will be opened. Enter the Find what and Replace with text as described in Using Find and Replace in 
this chapter, the replacement of the text will be applied throughout the entire PLC. 
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Rules for Finding 
Symbols may only have their details replaced when in the symbol table. An attempt to replace a symbol name or 
address whilst in the Ladder View will result in the generation of a new contact that will appear in error. Symbol 
comments may only be replaced whilst in the Symbol Table, and so the option to replace comments are not 
allowed by disabling the replace buttons. 

When doing a text search information will only be found in a step, regardless of whether it is being filtered from 
the view or not. For example in the Symbol Name is not being displayed but the symbol is found to have a 
match, the symbol will still be highlighted. 

Tree searching is the same as a normal search, in so much as the same rules are applied to Address, Value and 
Text searching as if carried out in a single view. For each branch of the tree the following search criteria is 
applied. 

♦ Find in Project: finds occurrences in all PLC’s, Symbol Tables and Programs. 

♦ Find in PLC: finds occurrences in all Symbol Tables and Programs. 

♦ Find in Global Symbol Table: finds occurrences in this Global Symbol Table only. 

♦ Find in Program: finds occurrences in Local Symbol Table and all Sections. 

♦ Find in Local Symbol Table: finds occurrences in this Local Symbol Table. 

♦ Find in Section: finds occurrences in this Section. 

♦ Find in area: finds occurrences in I/O Comment view. 

Other find features supported include: Multi-byte character sets (MBCS), Multiple instances in a rung, 
Statement List (SL) – as standard Ladder View and while online to a PLC. 

Find 
The Find dialog allows various types of search to be carried out inside a window, from the project workspace 
and while online to a PLC. Select How to Input pushbutton to show examples.  

 

Use the following procedure to execute a find. 

1, 2, 3… 1. Select an object in the project workspace to begin the search. 

 
2. Select the Find button from the toolbar or select the Find option from the Edit menu. 

 3. Select the required Look At entry from the drop-down list. This allows a choice to be 
made of the type of item being searched/replaced. The choices are as follows: 

 Addresses – searches for addresses within program operands and symbols. This will not 
find values set into operands (such as ‘&’ or ‘#’ operands), but will find TIM/CNT 
numbers (by setting a T/C address). 

 Symbol Names – searches for names of program symbols (local and global). 

 All (strings) – searches all the search targets, including addresses, constants, numbers, 
mnemonics, variable names, I/O comments, rung comments, and other comments. (CX-
Programmer Ver. 4.0 or later.) 
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 4. Enter the text or item to be found in the Find What field. 
The pull-down list on the Find What field can be used to enter the contents used for 
previous find operations. 

 5. Select the search criteria from the available options. 
Note: By deselecting Include symbol table, the symbol table can be omitted from a 
search and the search range will include the ladder program only. This omits 
unnecessary searches of symbol tables, thereby shortening the search time. (CX-
Programmer Ver. 4.0 or later.) 

 6. Select either the PLC, Program, or Current view to set the scope of the search. Click 
Find Next to begin the search. This displays the match found, and where in the string the 
it was found. The view also changes to where the result is located. Select Cancel to abort 
the operation. 

 7. Click Report instead to produce a report of all occurrences of the search. Once this 
report is generated, shown on the ‘Find Report’ tab of the output window, it is possible to 
move to a particular occurrence by double-clicking the report line. 

 Note: During a search matches are described by a context descriptor string above the 
lower scope box. The information contained in this string will include Step, Operand, 
and Step Mnemonic information. 

 

Using Find and Replace 
Type of search 
The search takes place within programs and symbol tables, depending upon the currently selected item on the 
Project Workspace or the currently selected window. If for example the focus is on the Project Workspace when 
the search is started then all searchable items within the workspace will be searched in tree order. When the 
search is started from a section, or from the tree set at either section or symbol table level then only that item 
will be searched. If the search is started at program level then only the local symbol table and the sections 
relating to that program level then only the local symbol table and the sections relating to that program are 
searched. When the search is started at PLC level then global, local and all sections will be searched. If the 
search is started at the project level than all PLCs and their global and local symbol tables and sections will be 
searched. 

Note that if search is started when the focus is on the I/O Comment view, the search will occur only on this view. 
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Finding and Replacing Text 
This applies to the 'Look At:' choices of 'Address', 'Symbol Names', 'All(strings)'. Select How to Input 
pushbutton to show examples. 

 
1. Select the Replace button from the toolbar or press Ctrl+H to open the Replace dialog. 

 2. In the Look At: field select the area to be searched. Select either 'Address', 'Symbol 
Names', 'Mnemonics' or 'Comments'. 

 3. In the Find what field, enter the text to be searched for. 

 4. In the Replacement field, enter the replacement text. 
The pull-down list on the Find What field can be used to enter the contents used for 
previous find operations, and the pull-down list on the Replace with field can be used to 
enter the contents used for previous replace operations. 

 5. Select either PLC, Program or Current view to set the scope of the find and replace. 
Click Find Next to find and display the next assurance of the match, click Replace to 
replace the match or Replace All to replace all matches. 

Replacing only in the Selected Rungs 
Select one or more rungs and then select Replace from the Edit Menu.    

Selected will be automatically selected.  

Note: The first click of the Replace button can also be used to find the next occurrence. Two clicks 
will find the next occurrence and perform the replace. 

Normally, a match will only be found if text within the item matches exactly what is being searched for. Note, 
however, a 'wildcard' can be used of '*' to search for partial matches. The '*' wildcard indicates that any 
following characters are to be ignored in a single word when searching for a match. Note that the wildcard 
operates on each word separately. e.g. to search for mnemonic lines for the ‘MOV(0221)’ instruction where the 
second operand is D1, the following search can be made – “MOV* D1”. 

In addition, it is possible to search for 'Whole Word Only' - a match will only be found if an entire word matches 
the text typed. If this option is not selected, then a match will be found if a word contains the text typed, and any 
text may be in front or behind the 'Find What' text in the same word. For this search a match will normally be 
found regardless of case. If an exact match is required, select the 'Match case' option. 

Wild Card Searching 
A wildcard can be used in the search and replacement text. This will have the effect of using the text that the 
corresponding wildcard in the find string became. e.g. Using a ‘Find what’ of ‘ab*’ and a replace of ‘tr*’ will 
change ‘about’ into ‘trout’ and ‘abort’ into ‘trort’. 

Mnemonics Searching 
The Mnemonic search is the same as the normal text search, except it can be used to retrieve almost any 
information about the symbol or step it may be contained in (except rung comments). A Mnemonic search is 
able to retrieve all the information of Address, Value and Symbol Name searches. Matches found using a 
Mnemonic search though will only display information in the Mnemonic line of an Instruction Step, and will not 
track to the exact operand that the match may belong in. 

The entire line of mnemonic is search so it is possible to specify any string that may occur in a mnemonic, e.g. 
an instruction followed by an operand. 

Rung Comment Searching 
Rung Comments are treated the same as any other text based search, but can not be accessed in the symbol table. 

Finding and Replacing Addresses 
This search and replace operates the same as for the Text but applies only to the 'Look At' choice of 'Bit 
Addresses' and 'Addresses'. 

The choice of 'Bit Addresses' is only available when searching and replacing for only addresses of BOOL type. 
No period is needed when entering the addresses in the 'Find What' field in this case. e.g. ‘1000’ will search for 
address '10.00’ only. 
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For the choice of 'Addresses', type in the address or addresses which are to be found in the 'Find What' field. A 
range of addresses may be input by using a dash ('-' or minus) between two addresses. e.g. 'A100-A200' will find 
addresses 'A100' 'A110' and 'A200'. 

When a CHANNEL address has been entered, a choice of 'Include BOOLs' is available. If this is checked, then 
bit addresses within the channel will also be matched. e.g. If a 'find' of A100 is input, and 'Include BOOLs' is 
selected, then addresses 'A100', 'A100.00' and 'A100.15' will be matched. 

Moving Addresses:  It is possible to move a range of addresses. To do this, enter a range in the 'Find What' 
field, and enter a new start address for the start of the range in the 'Replace' field. Note that a dash must be 
included at the end of the 'Replace' field, indicating that a new range is given. e.g. 'Find What' of 'A100-A200' 
and 'Replace With' of 'B100-' will move the range of addresses 'A100-A200' inclusive to a new start address of 
'B100'. 'A100' will move to 'B100', and 'A101' will move to 'B101' etc. If the 'Include BOOLs' option is selected, 
then bit addresses will be moved along with channel addresses (e.g. 'A100.0' will move to 'B100.0' etc), 
otherwise bit addresses will not be affected. 

Finding and Replacing Values 
This search and replace operates the same as for Text but applies only to the 'Look At' choice of 'Values'. 

When operating on values, it is necessary to choose whether floating point or integer numbers are to be 
manipulated. Numbers used in program operands are either floating point or integer type. e.g. Numbers used in 
TIM/CNT instructions to indicate the timer/counter are integers. Any operand value starting '+', '-' or containing 
a decimal point is a floating point value. A value beginning in ‘#’ is a hexadecimal integer value. 

Note: BCD operands are shown in the programming windows with a ‘#’ on the front, but are 
decimal values. When searching for a value in the find dialog, a ‘#’ prefix means hexadecimal. 
Therefore, a find of ‘#10’ will actually match a BCD operand of ‘#16’. A replacement of 
‘#10’ will actually show as ‘#16’ back in the program display for a BCD operand. 

It is possible to move a range of integers to a new starting point, using the same method as 'Moving Addresses'. 

Changing TIM/CNT Operands 
It is possible to change the first operand of a TIM/CNT instruction easily, at the same time as changing the 
address used for its status bit. To do this, use the ‘Address’ look-at type, and type in the address of the status 
bit/s to operate on (e.g. T0001). This will also find the first operand of a timer/counter instruction (e.g. If T0001 
is looked for, then ‘1’ will also be found in the TIM instructions). 

Therefore, it is possible to change a range of TIM numbers to another offset. 

Finding and Replacing Symbols 
It is possible to perform a replace on 'Symbol Names' within a program, but this only updates the program, so 
that the new name is inserted as the operand. The replacement within the program does not affect the underlying 
symbol definition. 

When a symbol name is updated in the symbol table, the programs using the symbol will also be updated to use 
the new name. 

Note: It is not possible to change the definition of a symbol from within a program. i.e. A symbol's 
comment or name cannot be changed unless the replace is happening within the symbol table. 

Switching between NO and NC Contacts  
Contacts for a specified address can be switched between normally open (NO) and normally closed (NC), either 
individually or collectively.  

1. Select Invert Open/Closed Bit from the Edit Menu.  

2. Select PLC, Program, or Current View in the Scope Field.  

3. In the Invert Open/Close Bit in PLC Input Box, enter the address for which contacts are to be switched 
between normally open and normally closed.  

4. Click the Find Next Button to search for the next occurrence.  
Click the Replace Button to switch the contact that was found between normally open and normally closed.  

Click the Replace All Button to switch all contacts for the specified address between normally open and 
normally closed.  



PART 1: CX-Programmer 
CHAPTER 3 – Project Reference OMRON 
 
 

CX-Programmer _Page 50  

Improvements to Global Replacement Operation 
Changes between normally open contacts and normally closed contacts can be performed for specified addresses 
using the Change All operation.  

If Change All is selected from the Edit menu and a checkmark is placed in the checkbox for Invert open/close 
bit before performing a global replacement for the PLC, all specified operands that are normally open contacts 
will be changed to normally closed contacts and all normally closed contacts will be changed to normally open 
contacts.  

Note: If the check box for symbols (including I/O comments) is cleared before an address is replaced 
globally, the symbols table and I/O comments will not be changed and only addresses in the 
ladder program will be changed. If the check box for symbols (including I/O comments) is 
selected before an address is replaced globally, the replacement operation will be the same as 
the previous version of the software (version 3.0). 

Finding and Replacing Symbols in the I/O Comment View 
Symbol comments can be searched and replaced on the I/O Comment view. Use the I/O Comment view to 
replace comments of TIM/CNT instructions (for both BOOL and CHANNEL types) and to update those 
changes to all symbol tables and programs. 

F3 Searching 
When the search dialog is closed search is possible using the F3 key. The same search criteria is used except that 
the search will never progress beyond the scope of the focus. Hence, a single view focus will never open another 
view whereas if the scope is a program level then the search will continue for the scope covered by that of a 
normal search. 

Note:  Mnemonic searches do not require an asterisk * or parentheses () with function codes input 
after the mnemonic search target (CX-Programmer Ver. 4.0 or later). 

Properties 
Each window or object in CX-Programmer has associated Properties that can be displayed. The method of 
displaying the tool is the same. 

The following Properties are available: 

♦ Project; 
♦ PLC; 
♦ Program; 
♦ Section. 

 

 
A Pin feature is available for all Properties. Select the Pin button from the Properties dialog to 
keep the dialog on top of other windows. 

Use the following procedure to view properties. 

1, 2, 3… 1. Select the required object from the project workspace. 

 2. Select the Show Properties button from the toolbar. The Properties dialog is displayed. 

If another object or window is selected whilst a Properties dialog is open, the dialog changes appearance to 
reflect the properties for the newly selected item or area. 

Project Properties 
The Project Properties dialog allows the name of the project to be altered and a link to an external CX-Server 
file to be created. 

Use the following procedure to view project properties. 

1, 2, 3… 1. Select the Project object in the project workspace. 

 
2. Select the Show Properties button from the toolbar. The Project Properties dialog is 

displayed. 
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 3. Enter a name for the project in the Name field. 

 4. Select the New File pushbutton. The Create New CX-Server File dialog is displayed. 
Enter the file name in the File name field and select the OK pushbutton. The dialog closes 
and the CX-Server file name is now displayed in the Path field of the General tab in the 
Project Properties dialog. 

 5. To remove the link, select the Unlink pushbutton. 

 6. Apply a project comment in the Comments tab. 

 7. Select the Close button from the title bar to close the Project Properties dialog. 

CX-Programmer supports a mechanism for sharing symbol definitions with other, compliant applications. This 
could allow, for example, the symbols declared within CX-Programmer to be linked to a SCADA package so 
that the definitions and changes of addresses are synchronized. 

Note: The sharing is not active – changes in the shared symbols are not instantly broadcast to the 
other applications. 

A CX-Server file is used as the medium for transferring symbol definitions between applications. Refer to 
Chapter 5 - Advanced Topics for details regarding linking symbols to CX-Server components. 

PLC Properties 
The PLC Properties dialog allows a PLC’s settings to be configured and connected. Its connections can also be 
verified. 

Use the following procedure to view PLC properties. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Work On-line button from the toolbar to connect to the PLC. 

 
3. Select the Show Properties button from the toolbar. The PLC Properties dialog is 

displayed. 
 4. Select the Verify pushbutton to test the connection between PLC and computer against 

the information supplied in the Name and Type field. Select the OK pushbutton in the 
displayed confirmation dialog. 

 5. The PLC operating mode can be changed from within the PLC Properties dialog. Select 
the appropriate Mode setting and select the Yes pushbutton to confirm the operation. 
Select the No pushbutton to abort the operation. 

 6. Select the Close button from the title bar to close the PLC Properties dialog. 

Program Properties 
The Program Properties dialog allows a PLC name to be entered or amended and for tasking PLCs, allows their 
tasking type to be defined (CS/CJ/CP-series PLCs only). The icon to the left of the project workspace changes 
according to the task type selected. Cyclic tasks represent the main program. The task can also be set to start on 
start-up of the PLC. 

Use the following procedure to change properties for a program at any time. 

1, 2, 3… 1. Click on the Program object in the project workspace. 

 
2. Select the Show Properties button from the toolbar. The Program Properties dialog is 

displayed. 
 3. Select a Task type setting from the Task Type field. The icon to the left of the program 

name changes to reflect the task type. 
 4. Set the Operation Start setting so the program starts on PLC start-up. 

 5. Select the Close button from the title bar to close the PLC Properties dialog. 

Using Microsoft Windows Features in CX-Programmer 
Standard Microsoft Windows procedures can be used within the CX-Programmer environment. 
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Opening and Saving Projects 
Maintaining project files on disk is achieved in the same way as in other Microsoft Windows applications. 
Various types of file are used for CX-Programmer projects: 

♦ ‘.CXP’. The project file itself; 
♦ ‘.OPT’. A file containing the preferences for the project; 
♦ ‘.BAK’. A backup copy of the project file; 
♦ ‘.CXT’. A text-based format supported by CX-Programmer for both opening and saving. The .CXT file 

format is used for file conversions. 
♦ ‘.CXPS’. A Password-encrypted project file; 
♦ ‘.MAC’. A file containing the keyboard mapping made on the Keyboard Mapping (Shortcut Keys) dialog. 
♦ ‘.CXO’. A file containing the settings made on the Options dialog and the Watch window. 
Opening and saving operations are similar to other Microsoft Windows applications; however, each time an existing 
project is opened it is recompiled (a progress marker is displayed during this loading and compilation process). 

Note:  LSS, project files require conversion to the correct format and must be imported via the File 
Conversion tool; refer to Chapter 5 - Advanced Topics for further information. 

1, 2, 3… 

 

1. Select the Open button from the toolbar. The Open CX-Programmer File dialog is 
displayed. 

2. Choose the file type that is to be imported in the Files of type field. 
 3. Select the file that is to be opened from the File name field, or type in the name. Note that 

the file type is determined by the suffix (i.e. the part of the name following the ‘.’). 
 4. Select the Open pushbutton to open the file. A progress indicator is displayed as the 

program(s) associated with the project are compiled. 
 5. Recently opened files can be opened directly from the File menu. 

 6. Select the Close command from the file menu to close an existing open project. 

 
Select the Save Project button from the toolbar to save the project. This should be performed 
on a regular basis. Select the Save As option from the File menu to save an existing project 
with another name. 

Note:  A project file (.CXPS file) cannot be opened on CX-Programmer version 9.80 or lower. 

SYSWIN/CVSS/SSS/CPT File Loading 
SYSWIN, CVSS, SSS, CPT project and library files can be directly opened from within CX-Programmer, by 
choosing the file types of ‘.SWP’ or ‘.SWL’, ‘.COD’, ‘.SP1’ and ‘.CPT’ respectively in the ‘File Open’ dialog. 
In each case, a ‘.CXT’ file is created in the same location as the original file, and CX-Programmer opens this. 

It is not possible to save a CX-Programmer project as a SYSWIN, CVSS, SSS or CPT file. 

Printing Project Details 
Periodic hard copy printing may be necessary during project development. CX-Programmer provides printouts 
of the following items: 

♦ Ladder programs; 
♦ Global symbol tables; 
♦ Local symbol tables; 
♦ Cross Reference Tables; 
♦ Cross Reference Reports; 
♦ I/O Comment View; 
♦ Function block programs. 
Use the following procedure to print project details. 

1, 2, 3… 1. Select Page Setup from the File menu. 

 2. Select the Margins tab and enter the desired top, bottom and edge margins in the Top 
field, Bottom field, Left field, Right field, Header field and Footer field. 
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 3. Select the Header or Footer tab. Enter text in the Left, Center and Right fields. 
Predefined text can be entered by selecting the Insert Field pushbutton – Date, Time, 
Title, Filename, Page Number, etc. 

 4. Select the Pen and Paper tab and select the Set Font pushbutton to select the desired 
font in which the header and footer are to be printed. 

 5. Select the Print Setup pushbutton to correctly set up printer settings. Refer to the 
associated Printers Operating Manual for further information. 

 6. Select the Print Utility Settings tab and select the Print Utility Settings pushbutton to 
set the layout for printing ladder programs and Cross Reference Table. Press Help 
pushbutton on the Print Layout Settings dialog for more information. 

 7. Select the OK pushbutton and close the Print Layout Settings dialog. 

 8. Select the OK pushbutton of the Page Setup dialog to continue. 

 
9. Select the Print Preview button from the toolbar, if required. The Preview dialog is 

displayed. The Target Print Rung dialog is displayed when ladder programs are print 
previewed or printed. Select the number of rungs to print/print preview. 

 The following functions can be accessed. 
Select the Next Page pushbutton or Prev Page pushbutton to navigate through the 
pages of the printout. 
Select the Two Page pushbutton to view two pages of the printout at once. This 
pushbutton then changes to the One Page pushbutton to revert. 
Select the Zoom In or Zoom Out pushbuttons to magnify or expand the view of the printout. 
Select the Close pushbutton to close the dialog. 

 
10. Select the Print button from the toolbar. A standard Microsoft Windows Print dialog 

defines printer settings and allows print parameters to be entered. 

Note:  The following printing functions are supported. 

• Printing Ladder Programs as Shown on Screen 
 Sections of the ladder program can be printed separately as they are shown on the screen. Select to 

print the ladder screen in the page setting. The ladder screen can be printed as it is shown on the ladder 
screen. The program can also be printed at a slightly smaller size (Reduced size), or a slightly larger 
size (Enlarged size), instead of the standard size (Normal size). 

• Printing Word Address Cross-references 
 Printing with cross-reference information also includes the cross-reference of the word address. 

Therefore, by viewing the printed program, information that is equivalent to that from the CX-
Programmer’s cross-reference function can be obtained even if a CX-Programmer is not onsite. Print 
on A4, letter size, or bigger paper. 

Manipulating Views 
Each view in the main window (including the windows displayed when an object in the Project tree has been 
opened) has an associated context sensitive menu, displayed by clicking the right-mouse button. Certain 
common options on these menus control the positioning and display of the associated view. There are 
restrictions on the positioning of some windows. 

♦ Float. The selected window expands to full screen width. Select the Float option to expand the window. 
♦ Dock. Moves the window left, right, to the top, or to the bottom. Select the Dock option to return the view 

to its previous size. 
♦ Hide. All views can be hidden except the Diagram window (although all can be closed). Select the 

associated icon from the Toolbars option from the View menu to redisplay the view. 
♦ Expand All. Expands the project hierarchy to show all components. This option is only available from the 

project workspace context sensitive menu (i.e. ensure that a component has not been selected). 
Windows that have not been maximized display the following bar at the top or side of the window. Selecting 
these buttons allow the window to be moved or closed respectively. 
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Note:  The arrangement of windows and the toolbar can be returned to the initial state just after the 
installation of the CX-Programmer. 

Target Initialized Items 
CX-Programmer Window Position and size on the Windows desktop 
Project Workspace Window Window display position, size, and docking 

status Output Window 
Watch Window 
Address Reference Tool 
Window 
FB Instance Viewer 
Toolbar Customize settings (Show Tooltips, Cool Look, 

and Large Buttons), user-created toolbar, 
show/hide status, display position, and docking 
status 

Go to Commented Rung / 
Annotation Window 

Window display position and size 

 
 1. Select Reset Window Environment from the View menu and click the OK button to 

return to the initial state. 
 2. Click the OK button when a confirmation dialog box is displayed. 

 3. Restart the CX-Programmer. 

 4. The arrangement of windows and the toolbar has been returned to the initial state. 

 

Cut, Copy and Paste 
A variety of items can be copied and pasted to different locations in a project, between projects or even 
applications: 

Individual items can be copied, cut and pasted within, or between a Ladder program(s), Mnemonics view(s) and 
symbol tables: for example, text, contacts and coils. 

♦ Symbols. Individual symbol entries can be copied/moved between symbols tables (both global and local) or 
a whole table can be copied/moved to another program by selecting the table and then selecting the program 
to be copied. Symbol entries can also be copied or moved as text to another application. 

♦ Programs / Sections. A complete program or section can be copied to another PLC (or within the same 
PLC if multi-tasking) by selecting the program in the project workspace and then pasting it into the PLC. 
Individual aspects of a program can be copied by selecting an area from the Ladder Diagram and pasting 
into the Ladder Diagram of another program. When copying a program, the symbols used within it are also 
copied to the new location. If symbols of the same name are found in the local symbol table of the 
destination PLC / program, then they are left alone. Otherwise, the required symbols are added. 

♦ PLCs. A complete PLC definition can be copied in the project tree by selecting a PLC, selecting the project 
name and performing a paste operation (all associated components of the PLC, for example IO Table and 
Memory are copied). 

 Standard Microsoft Windows drag and drop procedures can also be applied. CX-Programmer 
automatically prevents invalid drag and drop operations by displaying a ‘No Entry’ icon. 

Use the following procedure to copy or move information within CX-Programmer. 

1, 2, 3… 1. Select an item, or items, in a window. More than one item can often be selected by 
pressing Shift and selecting another item to extend the selection, or by pressing Ctrl and 
selecting another item to add to the selection. 

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the 

toolbar to move the item. 
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 3. Select an area to move the items to (e.g. another window, or another place on the project 
workspace tree). 

 
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 

Drag and Drop 
In places where it is possible to perform a cut/copy/paste operation, it is usually possible to perform a drag/drop 
operation. Using the mouse, click on an item and hold the mouse button down. Drag the mouse to another 
location that is to receive the item, and release the mouse button. The item should be dropped. 

The effect of the drop operation is shown by the mouse cursor. If a ‘+’ is shown at the bottom of the cursor, then 
the drop will have the effect of duplicating the item being dragged. If not, then the item will be moved. 

 

Symbol References Drag/Drop 
It is possible to drag symbols from the symbol tables into the ladder window. This has the effect of setting an 
operand of an instruction on the ladder window. When dragging into an empty cell, it is possible to create a new 
contact or coil with the given symbol as the operand. To create a coil, hold down ‘Shift’ at the time of the drop, 
otherwise a contact will be created. 

It is possible to drag symbols into the watch window that will add references to them to the list of monitored 
addresses. A ladder element (contact/coil/instruction operand) may also be dropped into the watch window. 

Undoing and Redoing an Operation 
 

An item in the Diagram Workspace can be restored to an earlier state. Select the Undo button 
from the toolbar to undo the last action. Select the Redo button from the toolbar to re-apply an 
action. 

Note: The action of going on-line and offline to/from a PLC empties the memory of undo operations 
for that PLC, so that it is not possible to undo operations that were made previously. 

Deleting Items 
Most items within a project can be deleted – although restrictions apply when the PLC is on-line. A project 
cannot be deleted. The following rules apply to deleting an object: 

♦ If a PLC is deleted all associated items are deleted. Individual components (apart from the program(s)), for 
example an IO Table cannot be deleted separately. 

♦ A PLC cannot be deleted if it is currently opened for communications or if it is acting as a gateway PLC. 
♦ If a program is deleted, its associated (local) symbol table is deleted. 
♦ A global or local symbol table cannot be deleted except as part of a PLC deletion (both types of table) or 

program deletion (local symbols). 
♦ PLC pre-set symbols in the global symbol table cannot be deleted. Entries in the local symbol table can be 

deleted. 
♦ All entries in the Ladder program and Mnemonics view can be deleted (provided the PLC is offline). 
Use the following procedure to delete an object. 

1, 2, 3… 1. Select the object in the project workspace or items in the Diagram Workspace. 

 2. Select Delete from the context sensitive menu. A confirmation dialog is displayed when 
deleting PLCs and programs. 

 3. Select the Yes pushbutton to confirm the deletion. Select the No pushbutton to abort the 
operation. 

Renaming an Object 
A number of objects in the project file can be renamed (unless the PLC is on-line): 

♦ Project, Program, and Section. These can be renamed by simply typing a new name over the existing one 
in the project workspace tree. They can also be changed via their Properties dialog available from their 
context sensitive menu. 
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♦ PLC. The name of the PLC can be changed by entering a new name in the Change PLC dialog supplied by 
the CX-Server application, available from its context sensitive menu. Refer to the CX-Server PLC Tools 
User Manual for further information. 

♦ Individual objects including symbols. These names can be changed by displaying the appropriate Edit 
dialog. 

Note: CX-Server components, for example the IO Table, cannot be renamed. 

Field Descriptions 
The global and local symbols tables display information in tabular form. The fields are identified by column 
headers; these columns can be resized and information displayed according to preference. 

 

To resize column width, select the required field division and drag to the desired width. The tabulated 
information can also be sorted by selecting the appropriate field division. The manner in which the information 
is displayed can be altered by selecting the appropriate icon. 

 
Select the Large Icons button from the toolbar to display content as large icons. 

 
Select the Small Icons button from the toolbar to display content as small icons. 

 
Select the List button from the toolbar to display content as a list. 

 
Select the Details button from the toolbar to display content with associated details. 

Next Reference  
The Next Reference command works with the Output Window. It jumps the program display to the point 
referred to on the next line of the output window. 

The command works according to which tab the output window is showing (compile, find report or transfer). 

Go To 
The Go To options are available in Mnemonic and Ladder Diagram views and enable jumps to a required 
location in the program. 

 

 

Rung / Step Number 
It is possible to jump the display to show a particular location in a program or section. A location can be 
specified by either its rung or step number. 

The Go To dialog allows a choice of specifying the rung or step number. The range of valid rung or step 
numbers is shown. Use the key combination Ctrl+G to display this dialog. 

 



PART 1: CX-Programmer 
OMRON CHAPTER 3 – Project Reference 
 
 

  CX-Programmer _Page 57 

Note:  When the dialog has been accessed from a program level (i.e. when viewing the program 
section list, or from the program level on the project workspace), it is possible to jump to any 
point within the whole program. However, since rung numbering is per section, only steps 
may be used for referencing in this case. The step range will show the entire range within the 
program. 

The dialog also has a rung browse function, accessed from the Browse button. The browser lists the sections 
within the program and the commented rungs within each section. A rung may be chosen for viewing from this 
list. 

When the dialog Go To button is pressed, the requested location is brought into view. 

Commented Rung 
The Commented Rung dialog shows a list of rungs within sections that have been given comment properties. 
Use the shortcut key L to display this dialog. The first line of a rung’s comment is shown in a numbered list (the 
numbers start from 1 and do not indicate the rung number). 

A list of sections is given above (when the function is accessed from the program scope). 

 

When a rung is chosen, the program section is immediately shown at the chosen position. 

Note: The size of the Go to Commented Rung window displayed when Edit | Go to | Commented 
Rung is selected can be changed. 

Next Address Reference / Input / Output / Previous 
The address reference tool allows easy navigation to the location of other places in the program where an 
address has been used. These commands may be used when the address reference tool is on show, or even 
without it if the diagram options ‘Allow Address-Referencing without Window’ option is set. 

When the diagram cursor is above a contact (or coil), it is possible to jump directly to a coil (or contact) that is 
using the same address. Use the ‘Space’ key to jump to the next coil (or contact) and ‘Shift’ + ‘Space’ key to 
jump backwards. 

The Go to Next Address Reference command moves the selected line down one, so that the program shows the 
next reference of the current address. Use the shortcut key N to jump to the next address reference. 

The Go to Next Input command moves the selected line on the tool to the next line referring to an input 
instruction (e.g. contact). If an input is not found on lines below the currently selected reference, then the search 
will begin at the top of the list. 

The Go to Next Output command moves the selected line on the tool to the next line referring to an output 
instruction (e.g. coil, or 'MOV' instruction). If an output is not found on lines below the currently selected 
reference, then the search will begin at the top of the list. 

The navigation tool remembers a history of the places that have been jumped from - the Go to Previous Jump 
Point command moves back to the last point from which a jump was made from. Use the shortcut key B to jump 
to the previous jump point. 
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Select All 
Rather than selecting items in a window individually, it is possible to select the window and then Select All from 
the Edit menu. 

Toolbars – Viewing, Hiding and Customizing Toolbars 
The Customize dialog allows a set of toolbars to be chosen for display. It also allows new toolbars to be created. 
A full description of each toolbar is provided in Appendix A, Toolbars and Keystrokes.  

Use the following procedure to add or remove a toolbar from the CX-Programmer environment. 

 

1, 2, 3… 1. Select Toolbars from the View menu. From the Toolbars dialog select the Toolbars tab. 

 2. Select the toolbars from the Toolbars: field to be viewed the toolbar in the CX-
Programmer environment. Deselect the setting to remove the toolbar from the display. 

 3. Check the Show Tooltips setting to ON to display the tooltip associated with the toolbar 
buttons. 

 4. Check the Cool Look setting to ON to remove the box around each toolbar button. 

 5. Check the Large Buttons setting to ON to increase the size of the toolbar buttons. 

 6. Click the OK button to accept the settings or the Cancel button to abort the operation. 

Customizing a Toolbar 
Toolbars can be customized by dragging and dropping buttons from a selected category or from toolbar to 
toolbar. 

Use the following procedure to add, remove or move toolbar buttons. 
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1, 2, 3… 5. From the View menu select the Toolbars option, then from the Toolbars dialog select the 
Commands tab. 

 6. From the list of Categories select the type of buttons to be viewed. The buttons associated 
with that category are then displayed. 

 7. Click on the selected button and drag and drop it in the appropriate position in the selected 
toolbar. 

 8. To remove a button from a toolbar, select the category that contains the button to be 
removed then select the toolbar button and drag and drop it back to the button box. 

 9. To move a button from one toolbar to another, select the button to be moved then drag 
and drop it in position in the selected toolbar. 

Creating a New Toolbar 
New toolbars can be created and then customized by moving buttons from an existing toolbar or by adding 
buttons using the customizing feature. Toolbars created in this way can also be deleted. Note however that 
although all the buttons can be removed from a default toolbar, the toolbar itself can not be deleted. 

Use the following procedure to create or delete a customized toolbar. 

1, 2, 3… 1. Select Toolbar from the View menu. The Toolbars dialog is displayed. 

 2. Click the New button. This displays the New Toolbar dialog. 

 3. Enter a name for the new toolbar and click OK. The new toolbar will then be added to the 
list of toolbars and displayed on the screen. It can then be repositioned if necessary by 
dragging and dropping. 

 4. To move a button from an existing toolbar to the new one, select the button to be moved 
and drag and drop it in position in the new toolbar. 

 5. If a particular button is not visible click the Commands tab and from the list of Categories 
select the type of buttons to be viewed. 

 6. Click on the selected button and drag and drop it in position in the new toolbar. 

 7. To delete a customized toolbar select it from the list of toolbars and click the Delete 
button. 
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CHAPTER 4 
Reference 

This chapter introduces the objects contained in the project workspace and discusses their associated commands 
and features. 

The following components, which are available either from the project hierarchy or from main menu, form part 
of the CX-Server software. 

♦ PLC Memory. Refer to the Chapter on PLC Memory Components of the CX-Server PLC Tools User 
Manual; 

♦ IO Table. Refer to the Chapter on IO Table Component of the CX-Server PLC Tools User Manual; 
♦ PLC Settings. Refer to the Chapter on PLC Setup Component of the CX-Server PLC Tools User Manual; 
♦ Data Trace/Time Chart Monitor. Refer to the Chapter on Data Trace/Time Chart Monitor Component of the 

CX-Server PLC Tools User Manual; 
♦ Error Log. Refer to the Chapter on PLC Error Component of the CX-Server PLC Tools User Manual; 
♦ Clock. Refer to the CX-Server PLC Tools User Manual. 
♦ Memory Card. Refer to the Chapter on Memory Card Component of the CX-Server PLC Tools User 

Manual. 

PLCs and Projects 
A project file contains one or more PLCs that are (potentially) connected to the computer. These PLCs do not 
really have to be connected unless communications with them are to occur. A full description of the 
communications possibilities for C-series PLCs, CV-series PLCs and CS/CJ/CP-series PLCs is provided in the 
CX-Server PLC Tools User Manual. 

The PLCs selected also affect which setup procedures need to be performed. For example, the CV-series and 
CS/CJ-series require setting up the IO Table via the IO Table object in the project workspace and using the PLC 
settings object to establish specific PLC characteristics. 

Connection to the PLC requires the specification of the type of communications interface to be used to connect 
to the PLC. Two methods of communication are available: serial communications and network communications. 
Serial and network communications can be made using communication types although these are dependent upon 
the type of communicating PLC. 

Adding a PLC to the Project 
CX-Programmer supports multiple PLC and multiple program support. When a project is initially configured, it 
contains one PLC and one program. Additional PLCs and programs can be added. 

Use the following procedure to add a PLC to a project. 

1, 2, 3… 1. Select the Project object in the project workspace. 

 
2. From the Insert menu select PLC or right click on the project folder and select Insert 

PLC. The Change PLC dialog is displayed, part of the CX-Server application. 
3. Set up the PLC as required. Refer to the CX-Server PLC Tools User Manual for further 

information. 
The project workspace is updated with a new PLC entry plus its associated global symbol table, IO Table, 
Settings, Memory data and Program where applicable. An empty Ladder program is also displayed in the 
Diagram Workspace. 

The initial project, program and PLC settings are made whilst the PLC is offline. In order to test the program, 
examine memory or monitor PLC operations, communications must first be established with the PLC. Refer to 
Chapter - 4 Working On-line. 

Changing a PLC in a Project 
To change a PLC, double-click on the PLC object in the project workspace. The Change PLC dialog is 
displayed. Refer to the CX-Server PLC Tools User Manual for further information. 
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Programs written for one type of PLC may not be fully compatible with another type of PLC. In this event, CX-
Programmer attempts to change addresses and mnemonic instructions from the source PLC type to equivalent 
addresses and instructions on the new type of PLC. It is not possible to convert a program that contains errors. 
Any addresses and instructions that cannot be directly replaced are listed in the Compile tab of the Output 
window. Refer to Chapter 5 - Advanced Topics for further information. 

Deleting a PLC from the Project 
Use the following procedure to delete a PLC. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 2. Select Delete from the context sensitive menu. A confirmation dialog is displayed. 

 3. Select the Yes pushbutton to remove the PLC. Select the No pushbutton to abort the 
operation. 

When a PLC is deleted, all associated information including the Ladder program/s are deleted from the project. 

Symbols 
Traditionally, PLC programmers have used numbers and addresses for operands within their programs. Without 
further documentation, the program becomes very difficult to read and maintain, since addresses have no 
obvious meaning. 

Some packages have allowed the user to give comments to the addresses, so that the program has some readable 
documentation. CX-Programmer supports this feature. 

However, it is more powerful to use symbolic programming, where names are used instead of addresses. A 
symbol is a named variable that can have an address or number. The name of the symbol is then used during 
programming. This helps the readability and maintainability of the program. For example, it is possible to 
change the address of a symbol, which changes the program to use the new address automatically. 

Furthermore, CX-Programmer allows symbols to be defined for either a PLC or a program. This allows a 
programmer to keep the definitions of the symbols for a particular program private from other programs within 
the PLC. The symbols that are to be used in more than one program (global symbols) are then defined for the 
PLC. Program symbols (local symbols) are kept in a local symbol table. PLC symbols are kept in a global 
symbol table for the PLC. 

Data Types 
In addition to an address or number, a symbol has a data type. This describes the physical format of the data that 
is held within the symbol, including its size. 

Since a symbol’s format is known, CX-Programmer is able to monitor the contents of the symbol in the correct 
way. More importantly, CX-Programmer checks that the symbol is not used in an inappropriate manner. 

For example, a symbol can be defined with a data type of ‘UINT_BCD’, which means that the data within the 
address is unsigned, single word integer of BCD format. CX-Programmer checks that the symbol is used only 
for BCD type instructions, and issues a warning if it is not. 

The available data types are listed below An icon is associated with each type, which indicates the internal 
format of the type. The icon is shown in the symbol tables. 

 

Name Size Signed Format Notes 
BOOL 1 bit – Binary Address of a logical binary value (Bit). Used 

for contacts and coils. 

CHANNEL 
(See note 1.) 

1 or 
more 
words 

– Any Address of a non-bit value (i.e. a single 
word or longer value, unsigned or signed). 
This type is used for backward 
compatibility. If a non-bit address is given a 
comment, the resulting symbol is given a 
‘CHANNEL’ type. 

DINT 2 words Yes Binary Address of a double integer 
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Name Size Signed Format Notes 
INT 1 word Yes Binary Address of an integer 

LINT 4 words Yes Binary Address of a long integer 

NUMBER 
(See note 2.)  

– Yes Decimal A literal value - not an address. ‘NUMBER’ 
type symbols can be used for numeric 
operands which are usually prefixed with 
‘#’,‘&’, ‘+’ or ‘-‘. They can be used in BCD or 
binary instructions. For BCD usage, the 
value is treated as if entered in hex (e.g. the 
number ‘1234’ has the same effect as 
entering ‘#1234’ in the operand). 
A floating-point value can be entered (e.g. 
‘3.1416’). An engineering format number 
can be entered (e.g. ‘-1.1e4’). 
A decimal value is assumed. A 
hexadecimal value can be entered using a 
prefix of ‘#’. 

REAL 2 words Yes IEEE Address of a floating-point number. The 
format is the 32-bit IEEE format. For the 
special OMRON floating point format (FDIV 
instruction) use the UDINT_BCD type. 

LREAL 4 words Yes IEEE Address of a floating-point number. The 
format is the 64-bit IEEE format. 

UDINT 2 words No Binary Address of an unsigned double integer 

UDINT_BCD 
(See note 1.) 

2 words No BCD Address of an unsigned double BCD 
integer 

UINT 1 word No Binary Address of an unsigned integer 

UINT_BCD 
(See note 1.) 

1 word No BCD Address of an unsigned BCD integer 

ULINT 4 words No Binary Address of an unsigned long integer 

ULINT_BCD 
(See note 1.) 

4 words No BCD Address of an unsigned long BCD integer 

WORD 
(See note 3.) 

1 word --- Any Address of a bit string of 16 bits. 

DWORD 
(See note 3.) 

2 words --- Any Address of a bit string of 32 bits. 

LWORD 
(See note 3.) 

4 words --- Any Address of a bit string of 64 bits. 

TIMER 
(See note 5.) 

Used for a timer number, Timer Completion Flag, or timer present value.  
Note: TIMERs can be used only for CJ2 CPU Units with unit version 1.0 or later 
and only with CX-Programmer version 8.3.  

COUNTER 
(See note 5.) 

Used for a counter number, Counter Completion Flag, or counter present value.  
Note: COUNTERs can be used only for CJ2 CPU Units with unit version 1.0 or 
later and only with CX-Programmer version 8.3.  

STRING 
(See note 4.) 

256 
bytes 
(128 
words) 

--- ASCII The data is handled as character strings. 
The size can be set between 1 and 255 
characters. 

STRUCT 
(See note 5.) 

User-defined data type. 
Note: STRUCTs can be used only for CJ2 CPU Units and only with CX-
Programmer version 9.0 or higher. 

Note 1: When structured text is used in a task program, the UINT-BCD, UDINT_BCD, ULINT_BCD, 
and CHANNEL data types are handled as follows (CX-Programmer Ver. 7.2 only): 
• UINT BCD  → WORD 
• UDINT BCD → DWORD 
• ULINT BCD → LWORD 
• CHANNEL → WORD 

2: NUMBER cannot be used in ST programs. An error will occur in the program check if this 
data type is used. 
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3: CX-Programmer Ver. 5.0 or higher 
4:  This data type is supported only by CX-Programmer Ver. 7.2 (CX-One Ver. 2.1) or higher. 
5:  These data types cannot be used on the SFC chart view or Sub-chart view. 

Data Types and Timer/Counters 
Information for a timer/counter on a PLC consists of three parts – a status bit, a pre-set-value and the current 
value. Different data-types are used to refer to these different parts. These three parts can set to different 
comments, but to set the same comment for all three parts, use I/O Comment view to input a comment - Refer to 
I/O Comment View in Chapter 4 Reference for further information. When there is no comment in the symbol 
with a NUMBER or a UINT data-type, the comment of the symbol with a BOOL data-type will be shown on the 
right of the right-busbar instead. 

Note: When defining a timer number or counter number as a variable for PLCs other than CJ2 PLCs, 
use the previous method. (TIMER and COUNTER data types are supported only by CJ2 CPU 
Units.)  

Structure Symbols   

Specifying Structure Symbols   

A data structure is a user-defined data type that can contain more than one data type.  
Names can be assigned to the data types.  
(Supported only for CX-Programmer version 9.0 or higher and CJ2 CPU Units.)    

• Ladder Program Notation for and Inputting Structure Symbols  
In a Ladder Program, the structure symbol name and member name are separated by a period.  
Example: 
 
 
 

 
 

 

Note: If a member is also a data structure, another period is used to specify the member.    
 

Period 

abc . def . member1 

Structure name 

def 

Structure name 

Period 
Member name 

= Means “member 1 of def of abc.” 

 

Creating Data Types for Data Structures  

Use the following procedure to create a data type for data structures. 

• Inserting New Data Types for Data Structures  
1. Double-click the Data Types Icon in the project workspace.    
2.  Select Struct from the Insert Menu.  

The Edit Structure Dialog Box will be displayed.  
3. Input a name for the structure data type.    
4. Click the OK Button. The structure data type will be inserted into the data type view.  

• Inserting a New Member  
1. To insert a new member before a member, select the member.    
2.  Select Member from the Insert Menu.  

 abc. member1  

Structure name 

Period 

Member name 

= Means “member 1 of abc.” 
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The Edit Structure Dialog Box will be displayed.  
3. Input a name for the member.  

Select the data type of the new member.  
Set the array size to 0 if the new member is not an array.    
If the new member is an array, input the number of elements in the array.    

4. Click the OK Button. The member will be inserted.  

• Add a New Member  
1. To add a member as the last member of the structure data type, select the data structure or the 

member.    
2.  Select Member from the Add of Pop-up Menu.  

The Edit Structure Dialog Box will be displayed.  
3. Input a name for the member.  

Select the data type of the new member.  
Set the array size to 0 if the new member is not an array.    
If the new member is an array, input the number of elements in the array.    

4. Click the OK Button. The member will be added.  

• Registering Data Structure Symbols  
To insert a symbol into the symbol table, select a registered structure data type in data type view.    
Note: Data structure information will not be updated if you edit data structures in the symbol table and then 

download only the symbol table to the PLC. When you download a symbol table that contains data 
structures, always download the symbol table and the program together.  

Rules for Address Allocation to Structure Symbols  

When the first address is set for a structure symbol, addresses are automatically allocated in the 
order that the members are registered. 
If there are members with a BOOL data type, addresses are allocated as described below. Some 
addresses may not be used.    

• BOOL Members Mixed with Non-BOOL Members  
Addresses in different words are allocated to the members.     
Example:      
D0.0 is allocated to Member1 (BOOL) and D1 is allocated to the next member, Member2 
(INT).    

• Consecutive BOOL Members  
Bits in the same word are allocated to consecutive BOOL members.    
Example:   
D0.0 is allocated to Member1 (BOOL) and D0.1 is allocated to the next member, Member2 
(BOOL).    
If more than 16 consecutive bits are required, bits in the next word are allocated.    

• Non-consecutive BOOL Members  
Addresses in different words are allocated to the BOOL members.    
Example:     
D0.0 is allocated to Member1 (BOOL), D1 is allocated to Member2 (INT), and D2.0 is 
allocated to Member3 (BOOL).    

• BOOL Members That Are Arrays Next to BOOL Members That Are Not Arrays  
Addresses in different words are allocated to the members that are arrays and to the 
members that are not.  
Example:  
D0.0 is allocated to Member1 (BOOL) and bits starting with D1.0 are allocated to the next 
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member, Member2 (BOOL array).    
• Consecutive BOOL Array Members  

Addresses in different words are allocated to the BOOL members.    
Example:  
Bits starting with D0.0 are allocated to Member1 (BOOL array) and bits starting with D1.0 
are allocated to the next member, Member2 (BOOL array).    

Specifications of Structure Symbols  

Creating Data Types for Data Structures  

• Member Data Types  
The following data types can be used for members.  
BOOL, WORD, DWORD, LWORD, INT, DINT, LINT, UNIT, UDINT, ULINT, REAL, LREAL, 
and user-defined structure data types  

• Memory Areas That Can Be Allocated to Structure Symbols  
Addresses in the following memory areas can be allocated to structure symbols.  

• CIO 
• WR 
• HR 
• DM 
• EM 

In the symbol table, specify an address in one of the above areas as the first address of the data 
structure.    

• Symbol Tables in Which Structure Symbols Can Be Registered  
Structure symbols can be registered in the following symbol tables.  

• Global symbol table  
• Local symbol tables for ladder/ST/SFC*1 programs  
• Symbol (variable) tables for function blocks (internal variables, input-output variables, 

and external variables) 
   *1: Structure symbols cannot be used on the SFC chart view or Sub-chart view. 

Note: Structure symbols cannot be registered for the following items.    
• Input variables and output variables in symbol (variable) tables for function blocks 

• Size of Structure Symbols  
The maximum size of one structure symbol is as follows:    

• Internal variables: 32,000 words  
• Input-output variables: 2,048 words  

• Maximum Number of Structure Symbols  
The number of structure symbols that is created for one PLC must satisfy the following formula: 
Number of structure symbols + Number of members in those structure symbols ≤ 4,000  
Example: A data structure with three members must be counted as 4 elements in determining if the 
maximum number of data structures has been exceeded.    

• Nesting Levels for Data Structures within Data Structures  
A data structure can be used as the member of another data structure.  
Data structures can be nested to up to eight levels.    

• Subscripts of Data Structure Arrays  
Either constants or symbols*1 can be used as subscripts of data structure arrays.  
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Addresses and formulas cannot be used.    
*1: Symbols can be used only for the first data structure array.    

• Subscripts of Array Data Structures  
The subscripts must be constants.    
Symbols, addresses, and formulas cannot be used.    

Precautions for Data Structure Symbols  

• Character Restrictions for Structure Symbol Names, Structure Data Type Names, and 
Member Names  

• Character Strings That Would Be Confused with Area Specifications  
A, AC, AR, C, CF, CNT, D, DIFF, DM, DR, E, EM, E0_, E1_, E2_, E3_, E4_, E5_, 
E6_, E7_, E8_, E9_, EA_, EB_, EC_, ED_, EE_, EF_, E10_, E11_, E12_, E13_, E14_, 
E15_, E16_, E17_, E18_, E19_, E1A_, E1B_, E1C_, E1D_, E1E_, E1F_, FB, G, H, HR, 
IO, IR, L, LR, S, ST, T, TIM, TK, TN, TR, W, and S  

• Predefined Character Strings  
The following predefined character strings cannot be used. (These are not case 
sensitive.)    
BOOL, CHANNEL, COUNTER, DINT, DWORD, INT, LINT, LREAL, LWORD, 
NUMBER, REAL, STRING, TIMER, UDINT, UDINT_BCD, UINT, UINT_BCD, 
ULINT, ULINT_BCD, WORD, and STRUCT  

Errors will not occur in the following cases even though operation will not be normal.    
1. Using the Same Structure Symbol Name More Than Once    
The name of each structure symbol in one PLC must be unique.    
For example, do not register structure symbols with the same name as both a global symbol and a 
local symbol. Also, do not register structure symbols with the same name for two local symbols.    
2. Programs and Function Blocks with the Same Names as Structure Symbols or Members  
The name of a program or function block cannot be used as the name of a structure symbol or 
member in the same PLC.    

Specifying Arrays  
Variables can be specified as arrays with CX-Programmer Ver. 7.2 or higher (see note). 

Variables can be specified as any data type, excluding STRING and NUMBER. 

Note: Only one-dimensional arrays are possible with CX-Programmer. 
An array variable is specified if more than one variable of the same data type is being used and those variables 
are to be managed as a group. 

Perform the following procedure to specify an array variable. 

1. Enter the variable name in the New Variable or Edit Variable Dialog Box and click the Advance Settings 
Button. The Detailed Settings Dialog Box will be displayed. 

2. Check the Array Variable checkbox in the array settings field and enter the maximum number of elements.  

In ladder, ST, and SFC languages, the array variable name must be followed by the subscript in square brackets 
[ ].  

For example, the variable name “PV” with three maximum elements would be specified as PV[0], PV[1], and 
PV[2] in the instruction operand. 

Subscripts can be specified only by directly using numbers. Subscripts cannot be specified by using variables. 

Other Restrictions on the Usage of Structures 
When you use structures, there are following restrictions: 
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♦ When any structure definitions exist on the data type view, you cannot select the Function Block (Ladder) 
Generation menu item or the Reusable File | Save as... menu item in all sections. 

Using Subscripts with Array Variables on the CJ2, CP1E and CP2E 
When using a CJ2, CP1E and CP2E CPU Unit, the number of the element can be directly input using the 
subscript of an array variable in the ladder program. The number of the element can also be indirectly specified 
using a word address or symbol. The word address or symbol that indirectly specifies the number of the element 
is placed into brackets [ ] after the array variable name. 

The format to specify the subscript of an array variable is as follows: 

 A[B] 
Subscript: Element number, word address, 
symbol 
Array variable name 

 
The above example specifies the element that is offset from start address (A) by the value specified by the 
subscript (B) (see note) based on the data type of the array variable.  
An offset address cannot be used as an operand in an instruction for which immediate refreshing is specified. 

Note: When setting a subscript for an array variable, do not specify a subscript that would cause the 
resulting address to be outside of the memory area that contains the first word in the array. Be 
particularly careful when using a word address or symbol to specify the subscript. Depending 
on the size of the subscript, the resulting address may exceed the memory area, causing 
unexpected operation. 

Global Symbols 
The PLC global symbol table is initially filled with some pre-set symbols, which depend upon the PLC type. For 
example, the symbol ‘P_1s’ (1 second pulse) is created for many PLC types. All pre-set symbols have the prefix 
‘P_’ and they may not be removed or edited. 
A global symbol table contains the PLC’s symbols – these symbols can be referenced by any program in the 
PLC. Any unnamed symbols (IO comment - just addresses given a comment) are contained within the global 
table - they may not be placed in a local symbol table. 

Note: Global symbols are only global for a particular PLC. It is not possible to share symbol 
definitions between PLCs on the project workspace. 

Local Symbols 
These symbols are specific to a particular program, and cannot be referenced by any other. It is recommended 
that symbols are defined locally to a program unless the address is being used in multiple programs. This makes 
the project more manageable and maintainable. 

 
A program’s local symbol table is created empty. The local symbol table can be viewed by 
selecting the View Local Symbol button from the toolbar.  

It is possible to define a symbol at a local level with the same name as a symbol at global level. This is 
considered an override of the symbol definition. The program uses the symbol definition from its local level. 
This is a powerful feature, but can be achieved by mistake, so CX-Programmer issues a warning when 
validating symbols if this is done. 

Network Symbols 
Network symbols can be used to access I/O memory in the CPU Unit from external devices. 

When a tag is used from an external device (e.g., host, PT, or Programming Device) to access I/O memory (e.g., 
tag data links using EtherNet/IP networks), the tag accesses I/O memory using a network symbol. 

Network symbols are registered in the global symbol table. When the network symbol is registered, one of the 
following attributes is selected for the network symbol: Publication, Input, or Output. Network symbols can be 
used as global symbols when being used within a program in the PLC. Network symbols cannot be specified in 
the local symbol table.  
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Name Data 
type 

Address/value Network symbol 

Publication Input Output 
Names used in 
EtherNet/IP 
networks must be 
within 48 
characters in 
length. 

Sets the 
data type 
of the 
global 
symbol. 

Sets the 
address or 
value of the 
global symbol. 

Sets a 
network 
symbol that 
can be 
accessed 
from 
external 
devices. 

When “input” is 
selected, the 
symbol will be 
used as the input 
tag in the 
EtherNet/IP data 
link (cyclic 
communications). 

When “output” is 
selected, the 
symbol will be used 
as the output tag in 
the EtherNet/IP 
data link (cyclic 
communications). 

Note: Network symbols can only be used with a CJ2H-CPU6@-EIP/CJ2M-CPU3@ Ver.1.0,  
CJ2H-CPU6@ Ver.1.6 and CJ2M-CPU1@ Ver.2.2. In ladder diagrams, network symbols are 
displayed using icons. 

Copying and Pasting Symbols 
It is possible to cut, copy and paste symbols from one symbol table to another. It is also possible to move symbols 
between tables by using drag/drop. Note that pre-set symbols can not be removed, but they may be overridden. 

For advanced users, it is possible to paste symbols from another application into a symbol table. This can be 
done from any application that supports a text format – for example a spreadsheet. Refer to Chapter 5 - 
Advanced Topics for further information. 

Use the following procedure to copy or move symbols.  

1, 2, 3… 1. Select a symbol, or symbols in the symbol table. More than one symbol can be selected by 
pressing Shift and selecting another item to extend the selection or by pressing Ctrl and 
selecting another item to add to the selection. 

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the 

toolbar to move the item.  
 3. Select a symbol table to move the items. 

 
4. Select the Paste button from the toolbar to paste the symbol or symbols. A Paste 

operation can be performed several times without copying again.  

Note:  If a program or part of a program (i.e. selected rungs or sections) are copied between programs, 
then the symbols used within the program are copied to the new program. 

Validating Symbols 
The Validate Symbols can be selected from the context sensitive menu. When Validate Symbol (Selected Item) 
is selected, the symbol table, where the cursor is, will be checked. Validate Symbol (ALL) will check all the 
symbol tables in the PLC, where the cursor is.  

The option performs the following validation checks. 

1, 2, 3… 1. The data of each symbol in the selected symbol table outputs a warning message in the 
output window if any invalid symbols are found. 

 2. Each symbol for duplicate addresses, in the selected symbol table, and outputs a warning 
message (including the symbol names) in the output window if any are found. 

 3. To see if any symbols, in the selected local symbol table, are overriding symbols defined 
in the global symbol table and outputs a warning message in the output window if any are 
found. 

 4. To see if any duplicated symbol names are defined in the symbol tables, and if any are 
found they are output into the output window. 

 5. To see if any Auto-Allocated addresses have been created that do not have addresses 
assigned to them and if any are found they are output into the output window as an error. 

Delete Unused Symbols 
Any defined symbols in the symbol tables (both Global and Local) that are not used in the program, can be 
deleted by selecting Delete Unused Symbols from the menu. Select areas to delete symbols in the Select area to 
delete dialog. For symbols used in the Watch window, PLC Memory component, or Datatrace/Timechart 
Monitor component, will not be counted as used symbols. Therefore, these symbols will be deleted from the 
symbol tables. 
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Sharing Symbols with Other Applications 
Some OMRON applications may be able to share symbol definitions with other packages. CX-Programmer 
supports this feature. 

In order to allow sharing of symbols, it is necessary to link a CX-Server file with the project, which holds a copy 
of the desired symbols. This is set up using the Project Properties dialog. Once this is done, it is necessary to 
indicate which symbols are to be shared. Only global symbols may be linked with other applications. Refer to 
Chapter 5 - Advanced Topics for further information. 

Adding Symbols 
It is possible to add a symbol from several places – from the project workspace, within a symbol table or a 
program window. In each case, the Insert Symbol dialog is used. 

 

Use the following procedure to add a symbol. 

1, 2, 3… 

 

1. From the Insert menu select Symbol or right click on the symbols folder and select 
Insert Symbol. The New Symbol dialog is displayed. 

2. Enter a symbol name. 
 3. Enter an address or value in the Address or Value field. For a value (NUMBER data type 

symbol), type in a decimal value, or prefix the value with a ‘#’ for hexadecimal. A 
positive or negative floating point value may also be entered. Leave the field blank if the 
address is to be automatically allocated. 

 4. Select a data type in the Data Type field. For a numeric value rather than address, select 
the data type ‘Number’. 

 5. Enter a comment, if required, in the Comment field. 
To specify an array, click the Advanced Settings Button and specify the array in the 
Advance Settings Dialog box that is displayed. 

 6. For global symbols, indicate whether to share the symbol definition with the project’s 
linked CX-Server file by setting the Link the Definition to a CX-Server file field.  

 7. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton to abort the 
operation. 

Auto Generation of Symbols 
It is possible to create symbols without giving them a name, but certain restrictions apply: 

♦ This can only be done in the Global Symbol table. 
♦ An address and comment must be given. 
♦ The data type must be BOOL or CHANNEL. 

These are called unnamed symbols, and normally they would appear in the symbol table or ladder diagram with 
no name. 

However, an option is provided to automatically generate a symbol name for unnamed symbols. The 
Tools|Options|Symbols dialog contains a checkbox marked ‘Automatically Generate Symbol Names’. If this 
option is selected then names are automatically generated for unnamed symbols, and these names have a 
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standard format of AutoGen_[Address], where ‘Address’ is replaced with the symbol’s address. If two or more 
symbols of this type have the same address, a (Copy Of #) is suffixed, where # is a unique number. 

 

Find and Replace 
If the ‘Automatically Generate Symbol Name’ option is selected then the ‘unnamed’ symbols can be found in a 
Find and Replace operation that searches for Symbol Names. If the checkbox is left unchecked symbols will not 
be found in the Find or Replace. 

Copying and Pasting 
When copying ladder objects and pasting to another ladder, the results depend upon the ‘Automatically Generate 
Symbol Name’ checkbox. If it is checked, then the auto-generated symbol name is pasted (but without the 
address). If it is unchecked, then the address only is pasted. 

Data can be copied and pasted between CX-Programmer symbol tables and CX-Designer variable tables with 
CX-Programmer Ver. 7.2 (CX-One Ver. 2.1) or higher. With the CX-Programmer Ver. 9.2 or higher, structure 
variables can be copied from a symbol table on the CX-Programmer and pasted onto the CX-Designer when the 
structure variables are used as a network variable in the CJ2 CPU Units. 

Unnamed Symbols 
Unnamed symbols, like normal symbols, can be created in the Global Symbol Table, via the New Contact dialog 
(when a contact is entered on the Ladder) or via the Operand field of the Instruction dialog (when an Instruction 
is entered on the Ladder). 

Editing Symbols 
It is possible to edit symbols by double clicking symbols from the symbol table, or from an operand within a 
program. The dialog works in the same way as the Insert Symbol dialog. 

When a symbol’s address or comment is altered, the program or programs using it automatically use the new 
address and show the new comment. 

When a symbol is renamed, the program will automatically use the new name. If an override symbol is deleted, 
the program attaches to the global definition.  

When a symbol is deleted from the symbol table any operands that are currently linked to that symbol will be re-
linked to new symbols. The symbols are searched for using the order of precedence rule. If a new match is found 
then the operand will be linked to the new symbol. If however no match is found then the operand reverts to the 
physical address of the deleted symbol. 
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When copying symbol table data in CX-Programmer version 8.0 or higher, the items to be copied and the order 
of the data to be copied to the clipboard can be set. 

Procedure 
1. Select Tools – Options from the menu. 

2. Click the Symbols Tab and set the copy order and items to be copied in the Type and order of symbol 
attributes copied onto clipboard Field. 

 

Pasting Symbols with Errors 
In the following example only two of the Symbols are correct the others are not, attempting to insert all these 
Symbols into a symbol table will generate errors. 

AmberLight BOOL 10.01 - Correct Symbol 
AmberLight BOOL 10.01 - Duplicate Name 
AmberOnlyTimerDone BOOL T0004 - Correct Symbol 
GreenLight BOOL 999999 - Incorrect Address 
GreenTimerDone UNKNOWN  - Incorrect Type 

 
The following error dialog will be displayed if the above symbols are pasted into the symbol table. 
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Symbol 
Definition 

List of Symbols in Error 

Description of Error 

 

It is now possible to edit the Symbol entries to correct the errors. The new corrections will appear in the ‘New ?’ 
column or to mark them for deletion. 

Selecting OK will commit the Symbols, with changes, to the Symbol Table for checking and inserting. Selecting 
Cancel will delete all the symbols in the error. 

Removing Symbols 
Symbols may be removed by deleting them from the symbol table. 

Generally, when a symbol is removed, the program and programs using it then use the address or value of the 
removed symbol. 

The exception is for symbols with automatically allocated addresses – in these cases, the program shows the 
name of the removed symbol in the places where it was used. It is then easy to see where an address needs to be 
assigned in the program. 

If the removed symbol was an override of a global symbol, then the program uses the global symbol of the same 
name, which may have a different address or value. 

Automatic Allocation 
Automatic Allocation is a facility that enables symbols to be automatically assigned an address. This is useful 
for ‘work’ type symbols, where the actual address is not important, providing it is unique (i.e. it is not mapped to 
input or output hardware). To use this feature, it is necessary to set the memory ranges from which to allocate 
these addresses. Each PLC is set separately. 

The main features of auto allocation are: 

♦ Multiple address allocation areas 
♦ Prioritizing address allocation areas 
♦ Address allocation of symbols according to type 
♦ Consideration of addresses that have already been used 
♦ Different Auto allocation areas for each PLC 
♦ It is available to both global and local symbols 

Setting Up Automatic Allocation 
The PLC Automatic Memory Allocation dialog is opened from the toolbar by selecting PLC | Automatic 
Allocation. 
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Use the following procedure to apply automatic allocation. 

1, 2, 3… 1. Select (tick) the Enable automatic allocation for this PLC option. 
 A list of memory ranges may be entered for the PLC. The list is ordered, so that the first 

area in the list is allocated first. 
 2. Use the Add... button to add an area to the allocation list. A dialog is shown to input the 

details for the area: 
 3. Type in the Start address and Size (channels) to define the address range in the PLC for 

CX-Programmer to allocate from. 
 4. Choose one or more data types that are to be allocated in this area. By default, all 

applicable data types will be allocated from within this area. A restriction can be made, so 
that for example, a separate memory area can be set to allocate BOOLs and CHANNELs. 

 5. Use the Remove button to remove the selected allocation range from the list. 

 6. Use the Move Up and Move Down buttons to move a selected range up and down in the 
priority order for the PLC. 

Note: CJ2 CPU Units, we recommend that you use the required number of banks from the highest 
bank numbers for automatic allocation. 
• Either one or two automatic allocation areas can be set. If continuous, entire banks are 

specified, they are counted as one area. (For example, the addresses in E0_0 to E0_32767 
and E1_0 to E1_32767 are continuous, and so they could be set together as one area.) 

• To use force-setting/resetting, you must set words in the EM Area for which force-
setting/resetting is supported. 
With CJ2H CPU Units with unit version 1.2 or later or CJ2M Units, PLC - Memory 
Allocation - EM Memory Settings can be used to specify the EM Area banks for which bits 
can be force-set/reset. (The first bank is specified and force-setting/resetting bits is possible 
in that bank and all banks following it.) This is called the EM Area force-setting/resetting 
function. Refer to the note on page 14 of CX-Server PLC Tools for details.    

• Automatic allocation cannot be set if part of the EM Area is converted to trace memory or 
file memory using PLC - Memory Allocation - EM Memory Settings. 

Note: With CJ-series CJ2 CPU Units, an error will occur if an address within the range set as the 
reserved PLC memory area for automatic PLC address allocation is input directly. 
• The address will be displayed in red in the ladder view. 
• In the program check, a message will be displayed indicating that an error occurred 

because operand x is out of range. 

Note: The status of the EM Area is held when the power supply is turned back ON or the operating 
mode is changed. Be careful if you use BOOL data in the EM Area for inputs in the program. 

Allocation of Symbols 
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Symbols can be defined to use automatic allocation simply by leaving their addresses blank. CX-Programmer 
then allocates the symbol address during compilation. The actual address allocated is shown against the symbol, 
but the address is marked as ‘Auto’ to show that the address has not been assigned by the user. 

CX-Programmer allocates addresses within PLCs by trying to find space in the PLCs allocation areas (set as 
above). The areas are searched in order, and addresses are only allocated within a particular range if its data type 
is allowed within the range. 

If automatic allocation is changed for a PLC (an allocation area is changed, or an area is removed), then all 
automatically-allocated addresses for the PLC are reallocated. 

If automatic allocation is removed for the PLC (i.e. the Enable automatic allocation for this PLC option is 
removed), then any symbols that have been auto-allocated have their address removed. 

Adding and Editing Automatic Allocation Areas 
Selecting the Edit or Add button on the Automatic Allocation dialog opens the Memory Range dialog. This 
dialog is used to either edit an existing auto allocation area or add a new one. 

 
Enter the Start Address, the Size in channels (16 bit words) then select the Data types that can be allocated in 
that area. On pressing the OK button, the address range is checked for validity and an appropriate error message 
in a message box is displayed. On closing the message box the user is returned to this dialog and the first field 
that is considered to be in error. 

Note that it is not possible to select types until the restricted radio button has been selected otherwise the type 
selection list box is grayed out. The type selection list box is a multiple selection list box. 

To automatically allocate a structure, select the Restricted: radio button, and then select the STRUCT data type. 
To specify TIMER or COUNTER data type, also, select the Restricted: radiobutton. 

Limitations 
It is not possible to have bit types in an area that is only word addressable. 
The length of the address range must be less than or equal to the size of that memory area. 
It is not possible to have auto allocation areas that overlap other areas. 
The length of the address range must be greater than zero. 

Copying Auto Allocated Symbols 
When symbols are copied, any symbol with a fixed address is marked as being used if it occurs within an auto 
allocated area. Auto allocated symbols that are copied across from one PLC to another will be assigned new 
addresses within the auto allocation areas allowed on the PLC they are being transferred to. These symbols will 
be assigned in alphabetical order rather than the order that they are copied across. If they have been assigned an 
address by the PLC that they are being transferred from, they will not necessarily keep the same address. 

Instructions 
When contacts, coils, instructions and any symbols (auto allocated or not) are deleted, the address space they 
occupied is freed for use by other elements as and when they are entered. Existing symbols that are auto 
allocated but without an address are not updated and either needs to be re-entered or the auto allocation areas 
need to be edited. Automatically allocated symbols are only allocated addresses when they are first entered or 
when the auto allocation ranges are added/edited. 

Rules for Auto Allocation 
When the OK button is pressed and there are auto allocation areas to use, each of the programs is searched in 
the order it appears in the tree. Each program is searched first for contacts, coils and instructions with fixed 
addresses. If any of these fixed addresses are within an auto allocation area then those addresses are marked as 
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used and cannot be further auto allocated to other symbols. After this, non auto allocated symbols (symbols with 
fixed addresses) within each program are checked. If any of these fixed symbols are within an auto allocation 
area, then those symbol addresses are marked as used and cannot be further auto allocated to other symbols. 
Finally, auto allocated symbols are allocated an address from the remaining addresses in an auto allocation area, 
whether they already have an address or not. The symbols are allocated according to their alphabetical order in 
the symbol table. 

From then on, anytime that user enters a new contact, coil, instruction or symbol with a fixed address, then that 
address is immediately marked as being used if it occurs within an auto allocation area. Any symbols that the 
user enters that don’t have a fixed address are immediately auto allocated an address if available. The exception 
to this is if symbols are entered directly as operands in the instruction dialog. These symbols cannot be auto 
allocated. If these symbols are to be auto allocated they should entered either in the symbol table first, or by 
using the browse button on the instruction dialog. 

When a program is developed by several people, the contents of the symbol table edited by one person may be 
overwritten by another person. It is therefore possible that consistency may not be maintained when automatic 
address allocation is used. It is best to have only the person managing the entire program edit the automatic 
address allocation data, and to have that person distribute the symbol table to other people. In addition, have 
only that person transfer the symbol table to the PLC. 

Program Editing 
A number of procedures can be performed from within the Ladder program but it depends upon whether an 
instruction, contact, coil, or workspace has been selected. 

 
To view the Ladder program, select the View Diagram button from the toolbar.  

The following elements can be selected from the Diagram toolbar and placed directly into the 
Ladder program. 

 
New Open Contact. Once the Contact has been entered, the name or address for that contact 
needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further information. 

 
New Closed Contact. Once the Contact has been entered, the name or address for that contact 
needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further information. 

 
New Open Contact OR. Once the Contact has been entered, the name or address for that 
contact needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further 
information. 

 
New Closed Contact OR. Once the Contact has been entered, the name or address for that 
contact needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further 
information. 

 
Vertical. The New Vertical button from the toolbar connects elements in the Ladder program 
vertically. 

 
Horizontal. The New Horizontal button from the toolbar connects elements in the Ladder 
program horizontally. 

 
Note: Connecting lines can be drawn by clicking the Line Connect Mode button  and then clicking 

the starting point and dragging to the end point. Connecting lines can also be deleted by dragging 

after clicking the Line Delete Mode button . A line can also be drawn by dragging on a line 
that is not connected on one end.  

 
New Open Coil. Once the Coil has been entered, the name or address for that contact needs to 
be entered, refer to Chapter – 4 Contact and Coil Editing for further information. 

 
New Closed Coil. Once the Coil has been entered, the name or address for that contact needs 
to be entered, refer Chapter – 4 Contact and Coil Editing for further information. 

 
Instruction. Once the graphical instruction has been placed on the diagram, the actual 
instruction must be selected, refer to Chapter – 4 Contact and Coil Editing for further 
information. 
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 Note that both a rung and elements of a program can be given comments within the ladder 
display, by using Properties. 

 
Use the following procedure to create a Ladder program. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. From the Insert menu select the Program option to start a new program. A 

ladder editing window will open. 
 3. Select the Program object in the project workspace. Select the Program 

object once more so it becomes an editable field. Enter a name for the 
program. 

 4. Select one of the above objects from the Diagram toolbar and place on the 
Ladder program. The icon image remains selected until another element is 
clicked on the toolbar. 

 
5. Items can be individually selected by selecting the Selection Mode button 

from the toolbar. 
 6. Rungs can be selected by clicking the rung margin within the Ladder 

program. 
Some objects (excluding the rung and text comments, and the vertical and horizontals) have associated dialogs 
allowing address or instruction information to be entered. Double-click on the object to redisplay the Edit dialog, 
this is dependent upon the selection. 

The Auto Error Detection bar to the left of the rung indicates the validity of the entries. 

It is possible to design a network and get the geometry right before entering specific symbol or address 
information. 

 
A Grid can be toggled on or off using by selecting the Grid button from the toolbar. When the 
Grid is on, dots are displayed at the connection points of each cell in the program. 

Program steps (graphically represented) are entered in a row or ladder ‘rung’ between the left (power supply) 
and right (output) bus-bars. 

Additional rows and columns can be inserted into the Ladder program via the Insert Row option and Insert 
Column option from the context sensitive menu. Rows and columns can also be removed by selecting Delete 
Row option and Delete Column option from the context sensitive menu. 

By inserting Vertical Up or Vertical Down, rungs cannot be combined into one. To do this, select the rungs to be 
combined and select Combine from the context sensitive menu. When a rung needs to be divided, select Split 
from the context sensitive menu to divide the rung into two. 

Allowing ladder screen display only, and prohibiting program editing while offline is possible (CX-Programmer 
Ver. 4.0 or later). Select Read Only Mode from the Edit Menu to enable this function. 

After temporary editing of a specific rung (in temporary memory), the user can select to utilize (store) or delete 
(cancel) the editing results (CX-Programmer Ver. 4.0 or later). Select Read Only Mode – Start Edit from the 
Edit Menu, and then perform either of the following steps after editing. 

a) To apply the editing results, select Read Only Mode – Store from the Edit Menu. The edited contents will 
be reflected in the program. 

b) To not apply the editing results, select Read Only Mode – Cancel from the Edit Menu. The edited contents 
will be deleted. Therefore, after editing rungs and writing and recording temporary changes, the user can 
select to either apply or delete changes, enhancing program editing efficiency. (This function is similar to 
the SYSMAC Support Software store function.) 

Inserting a Program 
A program is set up when the project is initially configured. For CS/CJ/CP-series PLCs and CV-series PLCs, it 
is possible to add multiple programs. 

Use the following procedure to insert a program. 

1, 2, 3… 1. To insert a new program, select the PLC object in the project workspace. 
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2. From the Insert menu select the Program - Ladder, Structured Text or SFC option.  

An empty Ladder, ST or SFC program is placed in the Diagram Workspace. 

 
3. The task type associated with the program must be assigned (not for C-Series PLCs). 

Select the program object in the project workspace and select the Show Properties button 
from the toolbar. The Program Properties dialog is displayed. 

 4. From the General tab, select an option from the Task Type field. 

 5. Select the Close button from the title bar to close the Program Properties dialog. 

The project is updated, showing a new program inserted at the bottom of the hierarchy together with an empty 
local symbol table. Task types available are as follows (the icon is displayed next to the Program object in the 
project workspace, and the task number is shown in brackets to the right). 

 

Task Type Icon  Task Type Icon 
Unassigned   Scheduled Interrupt  

Interrupt Task   IO Interrupt  
Power Off   Cyclic Task  
Power On     

Contact and Coil Editing 
The Edit Contact dialog or Edit Coil dialog allows the name or address of the contact or coil to be entered or 
selected from a list of global and local symbols. The name or address can also be defined as a new symbol from 
this dialog and inserted into the local or global symbol table. 

The dialog can be displayed in two forms, either: simple dialog mode or detailed dialog mode. The default 
mode can be set in the Diagram tab in the Options dialog. To change the simple dialog mode to a detailed 
dialog mode, select Detail pushbutton.  

 
Use the following procedure to edit contacts or coils in simple dialog mode. 

1, 2, 3… 1. Double-click on the required contact in the Ladder program. The Edit Contact dialog or 
Edit Coil dialog is displayed. 

 2. Enter a name or address for the contact or coil. This can be typed in directly or selected 
from the field.  

Note: Check the Show with comment dialog option in the Diagram tab of the Options dialog 
to display a comment dialog. The dialog is displayed after the OK pushbutton is 
selected on the Contact or Coil dialog. 

 3. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to 
abort the operation. 

 

Note: When inputting contacts or coils using CX-Programmer Ver.5.0 or later, symbols can be filtered 
by symbol name and I/O comment and displayed in a list. When inputting contacts or coils, a text 
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string can be input to filter symbols for those with symbol names or I/O comments that contain the 
specified string. A list of the resulting symbols is displayed in address_comment or 
name_address_comment combinations in a drop-down list. The desired symbol can then be input 
by selecting it from the list. Use this function to increase input efficiency when inputting symbols 
or comments that have been input before. This function can be used in both Ladder Section 
Windows and the Function Block Editor. 

Example:  
Input temp in the Symbol/Address Input field. 

  
Click the  button on the right of the field to display the following drop-down list of all symbols 
and addresses that contain “temp” in either the symbol name or I/O comment. 
 

A list of all symbols/addresses that contain the
text string “temp” is displayed. 

 
For example, select the item at the bottom of the list temp_alarm02, W0.05, The lower part of a 
device A temperature error (70 degrees min) to simply input the symbol named temp_alarm02. 

 
 

Symbol Filtering Targets 
Target Symbol Table:  Provides the symbols/addresses registered in the global symbol 

table and the local symbol table for the current program.  
Note:  When a symbol with the same symbol name is registered 

in both the local symbol table and global symbol table, 
only the symbol registered in the local symbol table will 
be displayed in the drop-down list. 

Target Symbol (Data Type): The I/O Contact Dialog Box shows the contacts (i.e., BOOL 
type symbols). 

Target Data: Select Tools – Options, and select the target data for filtering 
text strings from the following options in the Symbol filtering 
field of the Diagrams Tab (the default is to filter (search) both 
symbol names and I/O comments.) 
• Name: Only symbol names are searched.  
• Comment: Only I/O comments are searched.  
• Both: Both symbol names and I/O comments are searched 

(default).  
 

Use the following procedure to edit contacts or coils in detailed dialog mode. 

1, 2, 3… 1. Double-click on the required contact in the Ladder program. The Edit Contact dialog or 
Edit Coil dialog is displayed. 

 2. Enter a name or address for the contact or coil. This can be typed in directly or selected 
from the field. Select the Edit Symbol pushbutton to amend an existing symbol if 
required. 

 To enter a symbol with an automatically allocated address, enter the name and leave the 
address empty. To enter an unnamed symbol, enter an address and a comment. 
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 3. The Differentiation status of the operand bit can be set to prevent it from being turned 
ON for more than one cycle after the execution condition goes from ON to OFF (Down) 
or OFF to ON (Up). Select the Up option for OFF to ON or the Down option for ON to 
OFF. 

 4. Select the Immediate Refresh option if the operand is to be updated as soon as the 
instruction has been executed. 

 5. When adding a new symbol, select Global to add a symbol to the PLCs symbol table. 
Select Link to the CX-Server file to share the symbol definition with other applications 
(named, global symbols only). 

 6. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to 
abort the operation. 

Note: The Differentiation option and Immediate Refresh setting can also be set from the contact or 
coil context sensitive menu by selecting the element in the Ladder program and clicking the 
right-mouse button. A symbol is placed in the Ladder program to indicate that these options 
have been set: ‘!’ for Immediate refresh, ‘^’ for Differentiate up; ‘v’ for Differentiate down. 

Invert (NOT)  
The Invert (NOT) setting allows the normal state of a contact or coil (open or closed) to be reversed. Select 
Invert (NOT) from the context sensitive menu, whilst the contact or coil is selected. 

Forced Bits 
The state of an address can be ‘forced’ regardless of its physical state. This is useful when testing certain 
conditions or rungs in the Ladder program. A bit can be forced on (value changed to 1) or forced off (value 
changed to 0), the value of the bit can also be cleared. The following rules apply: 

♦ Bit references that are read-only cannot be forced; 
♦ Word references may not be forced. 
Forcing is only allowed when the PLC is in Debug or Monitor mode (not Run mode). 
Use the following procedure to force bits. 

1, 2, 3… 1. Obtain the Ladder program and select the element to be forced. 

 2. Select Force from the context sensitive menu, followed by On, Off or Cancel. 

Select Force from the context sensitive menu, followed by Cancel All to cancel all forced bits so that current 
values are free to be changed by the PLC program. 

Once an element has been forced, a symbol is placed in the Ladder program to indicate that its status has been 
forced. 

♦ Set. Set is available from the contact or coil context sensitive menu. The bit can be set to 1 or 0 by selecting 
the Set option from the contact or coil context sensitive menu followed by Value, To 1 or To 0. 

♦ Differentiate. Differentiate is available from the contact or coil context sensitive menu, performing the 
same functions as that within the Edit Contact dialog. Select Differentiate from the context sensitive menu, 
followed by Up or Down. 

♦ Immediate. Immediate Refresh is available from the contact or coil context sensitive menu, performing the 
same functions as that within the Edit Contact dialog. Select Immediate Refresh from the context sensitive 
menu. 

♦ Differential Monitor. Differential Monitor is for bits that are not accessible for conventional monitoring 
(for instance, values changing too rapidly), but which can be monitored via the Differential Monitor dialog. 
The dialog permits the selection of a particular bit to monitor, whether it is monitored against its falling or 
rising edge, and whether sound should be used when the bit value changes. 
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Use the following procedure to apply the differential monitor. 

1, 2, 3… 1. Select the Program object in the project workspace to display the Ladder program in the 
Diagram Workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed: 

select the Yes pushbutton to connect to the PLC. 

 
3. Select the Run Mode button from the toolbar. Differential monitoring can only be 

accomplished in this PLC operating modes and Monitor mode. 
 4. Select the contact or coil to monitor. 

 
5. Select the Differential Monitor button from the toolbar. The Differential Monitor dialog 

is displayed. 
 6. The address associated with the contact or coil selection is displayed in the Address field. 

Select an Edge option. 
 7. Select the Sound setting to retrieve audio whilst monitoring. 

 8. Select the Start pushbutton to start monitoring. The Start pushbutton becomes a Stop 
pushbutton. 

 9. Select the Stop pushbutton to cancel monitoring. Select the Close pushbutton to exit the 
dialog. 

 
10. Select the Toggle PLC Monitoring button from the toolbar to stop monitoring. 

Instruction Editing 
The Edit Instruction dialog allows an instruction to be selected and entered into the Ladder program. 

The dialog can be displayed in two forms, either: simple dialog mode or detailed dialog mode. The default 
mode can be set in the Diagram tab in the Options dialog. To change the simple dialog mode to a detailed 
dialog mode, select Detail pushbutton.  

 
Use the following procedure to edit instructions in simple dialog mode. 

1, 2, 3… 1. Double-click on the instruction field in the Ladder program. The Edit Instruction dialog is 
displayed. 

 2. Enter an instruction, either by name or by number. When a correct number has been 
entered (of the correct number of digits for the PLC type), the instruction name is 
automatically substituted. To insert an instruction with immediate Refresh properties, 
apply an exclamation mark (‘!’) to the beginning of the instruction. To insert a 
differentiated instruction, apply a ‘@’ symbol to differentiate up or a ‘%’ symbol to 
differentiate down at the beginning of the instruction. When the Show with comment 
dialog option is selected in the Options dialog, a comment dialog will appear after 
entering an address or a symbol name. 

Note: Check the Show with comment dialog option in the Diagram tab of the Options dialog to 
display a comment dialog. The dialog is displayed after the OK pushbutton is selected 
on the Contact or Coil dialog. 

 3. Enter operands in the same text box with a space between the instruction and each 
operand (see below for more details about entering operands). 

 4. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to 
abort the operation. 
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Note: When inputting operands for special instructions using CX-Programmer version 5.0 or higher, 
symbols can be filtered using symbol names and I/O comments and displayed in a list. Click the 
Filter Symbol Button and enter a text string in the Filter Symbol Dialog Box to limit the search to 
symbols with symbol names or I/O comments that contain the specified text string. A list of these 
address_comment or name_address_comment combinations will be displayed in the drop-down list. 
Input the required item by selecting it from the list. Use this procedure to increase input efficiency 
when inputting symbols or comments that have been input before.  
This procedure can be used when inputting both programs and function block definitions. 

Example: 
1 Click the Filter Symbol Button. 

 
2 Enter a user-specified text string in the Symbol/Address Input field in the Filter Symbol Dialog 

Box.  
Example: Enter temp in the Symbol/Address Input field. 
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3 Click the  button to display the drop-down list. 
4 A list of all address_ comment followed by name_address_comment combinations with symbol 

names or I/O comments containing the specified text string will be displayed. 
 

 
Note:  If the drop-down list is displayed without any search item input in the Symbol/Address Input field, all 

symbols that can be used will be listed. 
 
5 Select one of the symbols from the drop-down list and click the Enter Key or the OK Button to 

input the selected symbol in the Symbol/Address Input field. 
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• When a symbol or address containing a symbol name is selected, the symbol is entered in the 
Symbol/Address Input field. 

• When an address_comment without a symbol name is selected, the address is entered in the 
Symbol/Address Input field. 

Symbol Filtering Targets 
Target Symbol Table:  Provides the symbols/addresses registered in the global symbol 

table and the local symbol table for the current program.  
Note:  When a symbol with the same symbol name is registered 

in both the local symbol table and global symbol table, 
only the symbol registered in the local symbol table will be 
displayed in the drop-down list. 

Target Symbol (Data Type): The target symbols are BOOL type ones for BOOL type operands 
and ones with data types other than BOOL for CHANNEL type 
operands.  
 

Target Data: Select Tools – Options, and select the target data for filtering text 
strings from the following options in the Symbol filtering field of 
the Diagrams Tab (the default is to filter (search) both symbol 
names and I/O comments.) 
• Name: Only symbol names are searched.  
• Comment: Only I/O comments are searched.  
• Both: Both symbol names and I/O comments are searched 

(default).  
 

Use the following procedure to edit instructions in detailed dialog mode. 

1, 2, 3… 1. Double-click on the instruction field in the Ladder program. The Edit Instruction dialog is 
displayed. 

 2. Enter an instruction, either by name or by number. When a correct number has been 
entered (of the correct number of digits for the PLC type), the instruction name is 
automatically substituted. To insert an instruction with Immediate Refresh properties, 
apply an exclamation mark (‘!’) to the beginning of the instruction. To insert a 
differentiated instruction, apply a ‘@’ symbol to differentiate up or a ‘%’ symbol to 
differentiate down at the beginning of the instruction. 

 Alternatively, click the Find Instruction pushbutton. The Find Instruction dialog is 
displayed providing a list of possible instructions. Those instructions not available for the 
selected PLC are displayed in brackets. Select an Instruction by using the Groups and 
Instruction fields and select the OK pushbutton to return to the Edit Instruction dialog. 

 The Availability pushbutton on the Find Instruction dialog displays the PLC Instruction 
Support dialog that lists all PLCs for which the selected instruction in the Find Instruction 
dialog is available. Select the Close pushbutton to remove the PLC Instruction Support 
dialog. 

 The Expansion Table pushbutton on the Edit Instruction dialog displays the Expansion 
Instruction Mapping dialog and is only available to certain PLCs. This dialog allows 
certain instructions to be assigned to an expansion slot. 

 Select an Expansion Slot, select an Instruction and select the Set pushbutton. To remove 
an instruction, select the Expansion Slot and select the Remove pushbutton. Alternatively, 
select the Set Defaults pushbutton to apply default instruction assignments. Select the 
OK pushbutton to return to the Edit Instruction dialog. 

 3. If required, use the Instruction Help button, which shows a help topic for the chosen 
instruction. 
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 4. Enter the instruction operands (see below). 

 5. Select the OK pushbutton from the Edit Instruction dialog to complete the operation. 
Select the Cancel pushbutton to abort the operation. 

Modifiers can be set for contact instructions (LD, AND, OR and NOT) – either differentiate up or differentiate 
down. Contact and coil instructions OUT and OUT NOT can be set to immediate update. The availability of 
modifiers depends upon the type of PLC being used. 

Non-differentiated instructions execute each time they are scanned, but differentiated instructions execute only 
once after their execution condition switches from OFF to ON or from ON to OFF. 

Entering Operands 
An instruction operand can either be entered as a symbol, address or literal value. When entering an operand in 
the detailed dialog mode, the dialog shows the valid address ranges and types of operands that are allowed. 

When entering an operand, a prefix character may be used to add a meaning: 

* An indirect address (the contents of the given address are used as the address to find the data). 
Can be used in front of a symbol name. 

# A hexadecimal value. Also used for operands that must take a BCD number. 

& A decimal or BCD-format number. 

+ or - A signed, decimal, floating point value. 

Note that a symbol can hold a value – the NUMBER data type is used. 

It is possible to search for a symbol from the operand box by pressing the ‘…’ button to its right (or by pressing 
F2). This presents a dialog that allows a symbol to be selected or created. 

Symbol Information 
Whenever CX-Programmer finds a symbol associated with the typed operand, (except number types) symbol 
information is displayed in this box. The name, address/value and comment are shown, together with the data 
type of the symbol and its scope, global or local. 

Specifying Address Offsets 
When using a CJ2, CP1E and CP2E CPU Unit, offsets can be set for addresses when specifying operand 
addresses for input conditions, output instructions, or special instructions in ladder diagrams. The offset is 
placed into brackets [ ] after the address being offset. The offset can be an integer or an address or symbol that 
specifies integer data. 
Offsets can be set be set for bit addresses and word addresses.  

The format to specify an offset is as follows: 
 A[B] 

Offset 

Address being offset 
 

The above example specifies that address (A) is offset by the value specified by the offset (B) (see note). If the 
address being offset is a bit address, then the offset specifies the number of bits. If the address being offset is a 
word address, then the offset specifies the number of words.  
An array variable that uses a word address or symbol to specify the subscript cannot be used as an operand in an 
instruction for which immediate refreshing is specified. 

Note: Observe the following precaution when specifying a symbol or word address for an offset in a 
ladder program. 
When using a symbol or address to indirectly specify an offset for a memory address, be sure 
that the resulting address is not outside the memory area that contains original address. For 
example, use a symbol comparison instruction to ensure that processing is performed only 
when the memory area is not exceeded. If the final address (i.e., the original address plus the 
specified offset) exceeds the memory area, data in another memory area will be read or written, 
possibly resulting in unexpected operation. 
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Address Incremental Copying  
Overview  
Address Incremental Copying makes it easy to make multiple copies of a ladder program section when the only 
differences between multiple program sections are the addresses. By specifying the offsets for the addresses in 
the copied program section, the specified number of program sections can be created with the addresses 
incremented.  
Symbol names and I/O comments will be created automatically.  

Operation  
In Ladder View, select the program section that is to be copied. Select Address Incremental Copy from the Edit 
Menu to display the dialog box. Input the data in the dialog box, and press the Paste Button. A program section 
will be created with the addresses incremented automatically, and it will be inserted in the next program location.  
 
Example  

In this example, two copies are made of the following program section, bit offset is set to 16, the word (CH) 
offset is set to 10, and then the program section is pasted.  

 
 

1, 2, 3… 1. Select the program section to be copied. *1 

 2. Select Address Incremental Copy from the Edit Menu. 
The Address Incremental Copy Dialog Box will be displayed.   

*1: If a function block is used in the selected section, this item cannot be selected from the 
menu. 

 3. In the Offset Field, input 16 in the Bit Box and 10 in the CH Box. 
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 4. Click the Paste Button. 
The addresses will be automatically incremented and the program section will be 
automatically pasted. The I/O comments will be automatically created.  
 

 

 
 

 

By default, symbol names and I/O comments are created automatically according to the following rules.  

Item Rule for automatic 
creation Contents Example 

Symbol name Increment the numbers 
found from tail. 

Symbol names are searched for numbers 
from the end and the first number that is 
found is incremented. If a number is not 
found, a serial number is added following 
an underscore character. 

If Name1_1 is found, then 
Name1_2 is automatically 
created. 

I/O comment Increment the numbers 
found from tail. 

I/O comments are searched for numbers 
from the end and the first number that is 
found is incremented. If a number is not 
found, a serial number is added following 
an underscore character.  

If Cmt1_1 is found, then 
Cmt1_2 is automatically 
created.  

To change the automatic generation rule from the default, click the Advanced Button in the Address Incremental 
Copy Dialog Box and change the setting as shown below.  

 

Switching Input Modes  
The following input modes are supported by CX-Programmer version 9.0 or higher. Programming is possible in 
either mode.  

♦ Classic Mode  
The Classic Mode is the input mode that is used in previous versions of CX-Programmer.  

♦ Smart Input Mode  
The Smart Input Mode can be used to automatically display candidates for instructions and addresses. 
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When you start to type a mnemonic, all instruction mnemonics that start with the characters that have been 
input will be displayed as candidates. Candidates will then be displayed for the operands.  Refer to 
Appendix C Smart Input Mode for the procedure to input instructions in Smart Input Mode.  

Input Mode  
The input mode can be switched from a tool bar or a menu.  

♦ Selection from an Icon on a Tool Bar  
♦ Selection from a Menu  

Select either Smart Input Mode or Classic Mode under Change Input Mode on the Tools Menu.  

Adding Comments to a Program 
It is recommended that commenting be used as part of good programming practice. When Show 
Program/Section Comments is selected on the Ladder Information tab of Options dialog, the comment of the 
program and section will be shown at the top of the ladder diagram view. Double-click the comments to edit. 

 
Comments should be added to rungs as they are written, so that it is easier to understand their 
functions when reviewing the program later. Select the Properties of the rung to apply a 
comment to a ladder rung. Select the Properties of a program element 
(contact/coil/instruction) to set a text comment to the element of the Ladder program. 

Text can be added as comments to the Ladder program either as notes that are not compiled or as rung 
comments that are compiled with the code (setting the Use Comment Instructions property of a PLC). Rung 
comments are typically used for introducing and explaining chapters of code. 

Comments can also be entered against symbol names and addresses via the elements associated edit or 
properties dialogs. Symbol comments are downloaded to the Memory Card, if one is present or to allocated EM 
memory. 

Note: Unlike the Ladder programs for most PLCs, the Ladder programs for CV-series PLCs show a 
step offset number for the rung comment (this is because this series has a rung comment 
instruction). 

I/O Comment View 
In the I/O Comment View, you can enter comments by addresses of selected area type. This view is for users 
who prefer to use addresses and comments when creating a ladder program. Therefore, for users who use 
symbols for ladder programming, Symbol Table will be preferable to enter comments. If there are any 
comments already defined in the symbol table, these will also be displayed in the I/O Comment view. When 
either I/O Comment or Symbol Table view, is edited, the changes will be reflected in the other view. This view 
can only be edited whilst offline. The pre-defined symbols will be grayed out and cannot be edited. 

 
Use the following procedure to edit the address comments on I/O Comment window. 

1, 2, 3… 

 

1. Open the I/O Comment view by selecting the I/O Comment button from the toolbar Edit 
option. 

 2. Select the appropriate memory area in which the comments are to be edited from the Area 
Type. 

 3. Enter an address in the Start Address and press Enter key. 
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 4. With the selected comment now highlighted click the right mouse button and select the 
appropriate function. i.e. Edit, Cut, Copy, Paste or Delete. To move to another comment 
field, enter the appropriate Start Address and press Enter or use the scroll function. 

 Note that when comments are deleted, symbol(s) defined without a name will also be 
deleted from the symbol table. For symbol(s) defined with a name on the symbol table, 
only comment will be deleted. 

 Note that when editing comments of TIM/CNT Instructions, use I/O Comment view in 
order to link comments for all BOOL, CHANNEL, and NUMBER type of TIM/CNT 
instructions. When TIM/CNT comments are entered in this view, the comments for all 
types of the TIM/CNT instruction will display the same comments. 

Setting Multiple I/O Comments for a Single Address 
Multiple I/O comments (up to 16) can be registered for a single address symbol. By selecting the comment 
group to be displayed from the multiple I/O comment groups (up to 16 groups), the I/O comments on the ladder 
diagram screen can be changed all at once. This function allows multilingual development of a single program 
or attachment of comments according to the development step.  

Block Programs 
CX-Programmer supports the ability to enter a rung in statement list format – useful for block programs. 

The statement list view of a rung can be used instead of the Mnemonics editor but does not support program 
monitoring. 

Use the following procedure to edit a rung in statement list format. 

1, 2, 3… 1. Select a rung. Choose the Show as Rung Statement List option from the context menu of 
the rung. 

 The rung is shown in statement list format. 
Move the cursor to a line on the list, and press ‘Enter’. It is then possible to edit the 
instructions. Move up and down with the cursor keys, and amend the text. 
There is no restriction on the length of a statement list program apart from that which 
Windows may apply. 

 2. Entries in the statement list block are compiled continuously and the rung may be shown 
in error (the error bar on the rung margin). 

 3. To complete the editing, press ‘Escape’ which will exit from editing mode. 

 4. It may be possible to show the rung back in ladder format. Choose the Show as Rung 
Ladder option to toggle back to ladder format. It may not be possible to show the 
instructions in a ladder form. 

Program Reusability 
Parts of the program (single or multiple rungs, or a single program section) can be saved as a file (.cxr: text file) 
by selecting File − Reusable File − Save As (CX-Programmer Ver. 4.0 or later). The file can then be read and 
inserted in a user-set location in the program of another project by selecting File − Reusable File − Add to 
Project. In the same way, specified variables in a symbol table can be saved as files, and then read and inserted 
in a symbol table of another project. Multiple reusable files can also be inserted all together in a specified order. 
The order used to insert multiple reusable files can also be saved in the list of reusable files added to the project. 
This allows the group of reusable files to be managed as a single unit of data.  

Compile 
When a program is completed, a full program check is performed and object code is produced. 

In addition to allowing the inclusion of multiple programs in a PLC, CX-Programmer also allows all programs 
to be compiled at the same time. Individual programs can also be selected and compiled separately. Use the 
following procedure to compile programs. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Compile PLC Programs button from the toolbar. Alternatively, select the 

Compile Program button from the toolbar to compile one program. 
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A dialog is displayed showing the compilation status. The results are shown in the Compile tab of the Output 
window. 

Note: For a CS/CJ/CP-series PLC, a check is made for duplicates of SBN, MCRO and BPRG 
numbers. 

The checks that are performed during compilation can be set by selecting Program Check Options option from 
the PLC menu. The Program Check Options dialog is displayed. 

It is possible to choose between three levels of checking (‘A’ is the most strict, ‘C’ is the least strict), or to 
define a custom set of checks. Select the appropriate Check Level setting. 

For the Custom setting, the Checks field is enabled, allowing each individual check to be set or cleared. The 
scroll bar reveals further checks. Select the OK pushbutton to complete the operation. Select the Cancel 
pushbutton to abort the operation. 

Note: When performing program checks for Pre-Ver. 2.0 CPU Units, select None from the Unit Ver. 
Pull-down list. 

 

Memory View Function  
The memory view function calculates and displays the amount of User Memory that is being used, the amount 
of User Memory that is still available, memory usage for function blocks, and other memory usage for the 
program that is open on the CX-Programmer. 

Note: Estimates are displayed if the memory view function is used when a compiling error occurs for 
the program. 

 
1, 2, 3… 

 

1. Select Memory View from the View Menu. One of the Memory View Dialog Boxes 
shown below will be displayed. Memory quantities are displayed in steps for CS, CJ, and 
CP-series CPU Units and in words for other CPU Units.  

 

 PLC Model Set to Anything Except the CP1E 
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  The following items are displayed. 

Used UM: The amount of User Memory that is used by the program. 

Free UM: The amount of User Memory that is still available for use. 

Total: The total capacity of the User Memory. 

 

 PLC Model Set to the CP1E 

 
 The following items are displayed. 

Program: The amount of User Memory that is used by the program. 

Symbol table: The amount of User Memory that is used by the symbol table. 

Row comments and 
annotations: 

The amount of User Memory that is used by row comments and 
annotations. 

Program index: The amount of User Memory that is used by the program index. 

Free UM: The amount of User Memory that is still available for use. 

Total: The total capacity of the User Memory. 

When Function Block Definitions or SFC Programs Are Created  
If function blocks or SFC programs are used, related usage is also displayed. 

 PLC Model Set to Any CS/CJ-series CPU Unit (Unit Version 3.0 or Later) Except the CJ2M, CP2E, 
CP2E-N and CP1L-E 

 
 Function Block Area 

Used memory: The size of the source code for function block definitions in function block 
source memory. 

Free memory: The size of function block source memory that is still available for use. 

Total: The total size of function block source memory. 
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Define #: The number of function block definitions added to the number of action 
programs, transition programs, and sub-charts in SFC programs. 

Note: The number of action programs, transition programs, and sub-charts 
will be displayed in parentheses (SFC: xx) if SFC programs are used. 

Unused #: The number of function blocks that can still be defined. 

Max. #: The maximum number of function block definitions. 

 

 PLC Model Set to CJ2M, CP2E, CP2E-N or CP1L-E 

 
Function Block Area 

Define #: The number of function block definitions added to the number of action 
programs, transition programs, and sub-charts in SFC programs. 

Note: The number of action programs, transition programs, and sub-charts 
will be displayed in parentheses (SFC: xx) if SFC programs are used. 

Instance #: The number of function block instances pasted in the program over the 
maximum number. 

Used FB 
Program Area: 

The number of steps used by function block definitions and instances in the 
FB Program Area over the FB Program Area capacity. (If the capacity of the 
FB Memory Area is exceeded, the User Memory is used for additional 
function block definitions and instances.) 

Note: The size of individual function block definitions can be displayed by 
right-clicking the function block and selecting Properties - Memory. 

Define #: The number of function block definitions added to the number of action 
programs, transition programs, and sub-charts in SFC programs. 

Note: The number of action programs, transition programs, and sub-charts 
will be displayed in parentheses (SFC: xx) if SFC programs are used. 

Used FB 
Source: 

The size of the source code for function block definitions in FB source 
memory over the capacity of the FB source memory. 

Note: The memory view function calculates User Memory usage from the 
program open on the computer. To display memory usage on the actual 
CPU Unit, upload the program from the CPU Unit so that the same 
program is in both the project and the actual CPU Unit and then use the 
memory view function. 
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Mnemonic Program Editing 
The mnemonic view of a program allows mnemonic instructions to be typed directly. This feature is for 
advanced users who wish to bypass the more structured programming available in the Ladder program. 

 
Select the View Mnemonics button from the toolbar. The Mnemonics view is displayed in the 
Diagram Workspace. 

 

Whenever mnemonic instructions are entered, the Ladder program of the program is updated. When a complete 
rung has been formed by the entered mnemonics, CX-Programmer normalizes the new mnemonics and redraws 
the rung. 

It is possible that during the entry of the mnemonics, the rung can not be drawn in ladder form. In this case, it is 
shown as a statement list box on the Ladder program. 

In order to enter a comment for a rung into the Mnemonics view, enter the character ‘`’ followed by the text. 
This type of comment must go at the start of a rung’s mnemonics. 

In order to enter a comment against a ladder element, enter a comment statement following it - enter the 
characters ‘//’ followed by the text. 

In order to enter a rung annotation (unattached comment), enter the instruction type ‘A’ followed by the text. 
This type of comment must be at the end of a rung’s mnemonics. 

Simulation 

Work Online to at Simulator 
A program can be monitored or debugged by using a simulator rather than connecting to a PLC. 

Use the following procedure to go on-line to a simulator. 

1, 2, 3… 1. Select the Program object in the project workspace to display the Ladder program in the 
Diagram Workspace. 

 
2. Select the Work Online Simulator button from the toolbar. The simulator starts and CX-

Programmer goes on-line. Transferring the program is started. 
 Note: When a program is on-line to a Simulator, the program will not be able to connect 

to a PLC and other programs will not be able to go on-line to this Simulator. 

 Note: CX-Simulator must be installed to operate this function. CX-Simulator is 
supported for CS/CJ/CP-series PLCs. If the gateway PLC is specified for the 
network type of the PLC, CX-Simulator cannot be used. 

 
 Select the Work Online Simulator button again to go offline with the Simulator.  

  Select the Exit Simulator option from the PLC menu to close the simulator. 

Simulator Function 
When the CX-One Ver 1.1 (CX-Programmer Ver. 6.1 and CX-Simulator Ver. 1.6) is being used, the Step Run, 
Continuous Step Run, Scan Run, and Set/Clear Break Point functions can be executed as CX-Programmer 
functions (see notes 1 and 2). These functions can also be used with the ladder programs and ST programs 
within function blocks. 
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Note 1: The CX-Simulator Ver. 1.6 (sold separately) must be installed in order to use these functions. 
Note 2: I/O break conditions cannot be set. 

Previously, it was necessary to start the CX-Simulator by selecting Work Online Simulator from the CX-
Programmer's PLC Menu, transfer the program to the CX-Simulator in the computer, and execute the debugging 
operation from the CX-Simulator’s debugging console. With the CX-Programmer Ver. 6.1, the debugging 
operation can be executed from the CX-Programmer’s toolbar. 

The display can be made to scroll automatically during Step Run or Continuous Step Run operation. Also, the 
break points can be displayed in a list and the display can be made to jump to a specified break point in the list. 

Procedure for Simulation Function Operation 
1, 2, 3… 1. Open the program that you want to debug. 

 2. Select View - Toolbars and select the Simulator Debug Option in the Toolbars Tab. 

 3. Select Work Online Simulator from the CX-Programmer's PLC Menu and transfer the 
program to the CX-Simulator in the computer. 

 Note: Steps 2 and 3 can be done in the opposite order. 

 The following icons will be displayed in the toolbar: 

 

Note: For details on the Step In and Step Out commands, refer to the CX-Programmer Ver. 6.1 
Operation Manual: Function Blocks (catalog number W447). For details on the Step Run, 
Continuous Step Run, Scan Run, and Set/Clear Break Point commands, refer to the CX-
Simulator Operation Manual (catalog number W366). 

 4. Each debugging operation can be executed by clicking the corresponding icon in the 
toolbar or selecting the corresponding menu command from the menu. 

Note: Set the duration of the step execution during Continuous Step Run operation by selecting 
Tools - Options - Continuous Step Interval in the CX-Programmer. 

Automatic Scrolling for Step Run Operation 
The Simulator can be set to automatically scroll the display to the paused point in the program when performing 
Step Run or Continuous Step Run operation. To set scrolling, select Tools - Simulation - Always Display 
Current Execution Point. 

Break Point List/Jump Function 
A break point is a point in the ladder program where execution is paused temporarily. With the CX-One Ver 1.1 
(CX-Programmer Ver. 6.1 and CX-Simulator Ver. 1.6), it is possible to list the break points set for the active 
project’s PLC and jump to a specified break point position in that list. 

1, 2, 3… 1. Select Tools - Simulation – Break Point List.  

 2. The Break Point List Dialog Box will be displayed. 

 3. Click the Jump, Delete, or Delete All Button to jump to a point in the list or delete break 
points. 

PLC-PT Integrated Simulation 
When using CX-Programmer Ver. 7.2 or higher (CX-One version 2.1 or higher),  the CX-Designer’s offline test 
function can be used to debug the interactive operation between a CS/CJ/CP/NSJ-series CPU Unit program and 
NS-series PT touch panel screen data. 

Note 1: The PLC – PT integrated simulation can operate only with the combination of a CS/CJ-series, 
CP-series, or NSJ-series PLC and an NS-series PT. 

2: This function cannot be used unless the CX-Designer and CX-Simulator are installed when 
the CX-One Integrated tool Package is installed. 
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Select Simulation – PLC-PT Integrated Simulation. It is also possible to select the CX-Programmer project’s 
first PLC in the project workspace, right-click to display the pop-up menu, and select PLC-PT Integrated 
Simulation. 

Note: The PLC-PT Simulation can also be started from the CX-Designer. Refer to the CX-Designer 
Operation Manual (Cat. No. V099) for details on starting the simulation program from the 
CX-Designer. 
When host of serial port A is not exist on CX-Designer project, the PLC-PT simulation does 
not work from the CX-Programmer. In this case, please start the PLC-PT Simulation from the 
CX-Designer. 

Note: This functionality is not supported for CP1E-E CPU Units and CP1L-L10 CPU Unit. 

PLC Error Simulator 
During simulation of ladder programs with CX-Programmer Ver. 7.2 or higher (CX-One version 2.1 or higher), 
fatal and non-fatal PLC errors can be generated in a special window to debug ladder program sections that detect 
errors. 

The error-processing programs can be debugged easily in a separate window. 

1. Connect the simulator online in the CX-Programmer, or start the integrated simulation. 

2. If the CX-Programmer is used, select Simulation – PLC Error Simulator to start the PLC error simulator 
program. 

3. The PLC Error Simulator Window will be displayed. Select the errors that you want to generate, and press 
the General Error Button or Clear Error Button to change the status. 

Note: When the simulator program is stopped, the errors generated up to that point will be cleared. 

Working On-line 

 
CX-Programmer permits the connection of the PLC to the computer through the project, and 
subsequent additional features once the PLC is on-line. Select the Work On-line button from 
the toolbar to connect to the PLC. 

Auto Online to a PLC 
When maintaining a PLC, CX-Programmer can start monitoring the program of the connected PLC with a 
toolbar button, after CX-Programmer is started. A PC must be connected to a PLC. 

Use the following procedure to go on-line to the PLC automatically. 

1, 2, 3… 

 

1. Select the Auto Online button from the toolbar. A dialog is displayed showing the PLC 
type and the network settings of the connected PLC, which CX-Programmer is searching. 
When CX-Programmer successfully finds the PLC information, it automatically goes on-
line and transfers all the data from the PLC, for example, programs, expansion function 
(if available), PLC settings, IO table (if available), symbol tables and comments. 

 2. Select the Select Serial Port option from the PLC Auto Online menu to change the serial 
port when Auto Online. The default serial port is set to COM1. 

 

Note: When the Auto Online connection is executed using CX-Programmer Ver.7.2 (CX-One Ver.2.1) or 
higher, the available personal computer serial ports are automatically detected (automatic detection 
of computer serial ports function). If a serial port than can be connected online is found, the 
automatic connection is made from that serial port. 

Auto Online - EtherNet/IP Node Online 
You can automatically and easily connect online to a PLC when using CJ2 CPU Units connected to nodes on an 
EtherNet/IP network. 

Connection Types 
♦ Connecting to the Target PLC When Connected to a PLC through a USB Cable 
♦ Connecting to the Target PLC through an Ethernet Port on a Computer 
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Note: When running the CX-Programmer on Windows XP (SP2 or higher), Windows Vista, or Windows 
7 and connecting online to a PLC via EtherNet/IP for the first time, the settings of the Windows 
Firewall will need to be changed. Refer to Appendix B EtherNet/IP Connections from Windows XP 
(SP2 or Higher), Windows Vista, or Windows 7 in Part 1: CX-Programmer for details on making 
the changes. 

Procedure 
1. Select Auto online - EtherNet/IP Node Online from the PLC Menu. Alternatively, click the EtherNet/IP 

Node Online Button on the toolbar. After doing either of these, the EtherNet/IP Node Online Dialog Box 
will be displayed. 

 

Set the connection path 
from the computer to the 
PLC. An image of the path 
for the connection type will 
be displayed on the right. 

Specify the IP address for 
the target PLC. The Browse 
Button can be used to 
select an IP address from a 
list if the exact IP address is 
not known. 

An image of the 
connection path to 
the PLC from the 
computer is 
displayed here. 

 
2. Select the connection type. 

♦ Connecting to the Target PLC Using a USB Cable: 
Select the USB Connection Option, and set the unit number of the EtherNet/IP Unit or the built-in 
EtherNet/IP port of the CJ2H-CPU6@-EIP or CJ2M-CPU3@ to which the USB cable is connected.  

Example: Using the Built-in EtherNet/IP Port of the CJ2H-CPU6@-EIP with a Unit Number of 0 

♦ Connecting from the Ethernet Port on a Computer to the Target PLC: 
Select the EtherNet/IP Connection Option. 

3. Enter the IP address of the target PLC in the IP Address Field in the Connecting PLC Area. 

Example: 192.168.250.1 (default IP address for the built-in EtherNet/IP port of the CJ2H-CPU6@-EIP) 

The Browse Button can be used to select a PLC from a list if the IP address of the PLC to be connected to is not 
known. 

4. Click the Connect Button to connect online to the target PLC. After connecting, it will be possible to 
download programs. 

Browsing the Network 
If the IP address of the PLC to be connected is not known, the target PLC can be selected from a list of 
connectable PLCs. 

1. Click the Browse Button in the Connecting PLC Area 
A list of PLCs on the EtherNet/IP network that can currently be connected to will be displayed in the 
EtherNet/IP Node List Dialog Box. 
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2. Select the PLC to connect to from the list. 
Select the PLC to connect to, and then click the OK Button. 

Route Path 
When saving a project that was created by connecting to an EtherNet/IP node, the route path to the target PLC 
can be saved. Saving the route path will allow an easier connection via the same route path the next time you 
need to connect. 

Auto Online – CP1/CP2 built-in Ethernet Online 
You can automatically and easily connect online to a PLC when using a CP1/CP2-series CPU Unit with a Built-
in Ethernet Port connected to an Ethernet network. 

Connection Types 
♦ Connecting to the Target PLC when connected directly to a PLC through an Ethernet Cable 
♦ Connecting to the Target PLC through an Ethernet network 

Procedure 
1. Select Auto online – CP1/CP2 built-in Ethernet Online from the PLC Menu. Alternatively, click the 

CP1/CP2 built-in Ethernet Online Button on the toolbar. After doing either of these, the CP1/CP2 
Ethernet Online Dialog Box will be displayed. 

 
2. Select the connection type. 

♦ Connecting to the Target PLC Using an Ethernet Cable: 
Select the Direct Connection Option, and set the Workstation Node Number.  This connection type uses 
9600 for the Port Number. 

♦ Connecting from the Ethernet Port on a Computer to the Target PLC: 
Select the Hub Connection Option, and set the Port Number and Workstation Node Number. 



PART 1: CX-Programmer 
CHAPTER 4 – Reference OMRON
 
  
 
 

CX-Programmer _Page 98  

3. Enter the IP address of the target PLC in the IP Address Field  

 In the Direct Connection, there is no need to set the IP address. CX-Programmer can be connected to the 
PLC even if the IP address setting is not the same between the PC and the PLC. 

Browsing is supported for the Hub Connection. The Browse Button can be used to select a PLC from a list 
of connectable PLCs. If you select a PLC by using the Browse Button, CX-Programmer can connected to 
the PLC even if the IP address setting is not the same between the PC and the PLC. 

4. Click the Connect Button to connect online to the target PLC. After connecting, it will be possible to 
download programs. 

Browsing the Network 
If the IP address of the PLC to be connected is not known, the target PLC can be selected from a list of 
connectable PLCs. 

1. Click the Browse Button.  
A list of PLCs on the Ethernet network will be displayed. 

2. Select the PLC from the list. 
Select the PLC to connect to, and then click the OK Button. 
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Connecting via Secure Comm Network 

Overview 
Secure Comm Network is a communication method complying with the Chinese Cyber Security Law to connect 
to PLCs. 

The connection is made using an Ethernet port on CS1W-EIP21S and CJ1W-EIP21S Units. 

User authentication by user name and password is required when connecting to a PLC using Secure Comm 
Network. 

To prevent incorrect operations, users can only perform online operations within the authority assigned to them. 

Precautions for Connecting Online via Secure Comm Network 
Supported OS: 
For Windows 10 version 1803 or later and Windows 11, it is possible to select Secure Comm in the Network 
Type Field. 

Setting Procedure 
Use the following procedure to go online with a PLC via Secure Comm Network. 

 

Mount a CS1W/CJ1W-EIP21S Unit on the target PLC. 

Connect the computer and the CS1W/CJ1W-EIP21S Unit with an Ethernet cable. 

Set the IP address of the computer to the same segment as the CS1W/CJ1W-EIP21S Unit manually. 

Connect online from the EIP21S User Management Tool to the CS1W/CJ1W-EIP21S Unit. 
(Refer to Setting User Authentication for details.) 

Set user management settings in the EIP21S User Management Tool. 
(Refer to Setting User Authentication for details.) 

Connect the CX-Programmer and the PLC using the secure communication (Secure Comm). 
(Refer to Setting User Authentication for details.) 

Connect the computer and the CPU Unit using a serial connection. 

Connect online from the CX-Programmer to the PLC via a serial connection. 

Create IO tables in the CX-Programmer. 

Set the parameters for the CS1W/CJ1W-EIP21S Unit. 

If several Communications Units are mounted on the CPU Unit, connect online from the CX-
Integrator to the PLC via a serial connection and create a routing table. 
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System Configuration (Example) 
An example of a system configuration to connect online from the CX-Programmer to a CJ1W-EIP21S Unit with 
an Ethernet cable using the secure communication (Secure Comm) is given below. 

 CX-Programmer 

Ethernet 
(Online connection using Secure Comm) 

CJ1W-EIP21S 
EIP21S 
User Management 
Tool 

Ethernet port 

 
To go online using the secure communication (Secure Comm), you must connect online from the EIP21S User 
Management Tool to the CJ1W-EIP21S Unit to set user management settings in advance. (Refer to Setting User 
Authentication for details.） 
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Connection Procedure 
The following shows the setting procedure when you select CJ2H as the Device Type. The system 
configuration is as shown in System Configuration (Example). 

1. Select CJ2H in the Device Type Field. 

 
2. Select Secure Comm in the Network Type Field. 

3. Click the Settings Button to the right of the Network Type Field. The Network Settings [Secure Comm] 
Dialog Box is displayed. 

 
4. Enter the IP address of the CJ1W-EIP21S Unit in the IP Address Field, and then click the OK Button. 

5. Click the OK Button in the Change PLC Dialog Box. 

6. Select Work Online from the PLC Menu. 

 

Operation Permission 
This limits the operations that each operator can use based on the authority of the operator. 

There are three levels of operation authority for CX-Programmer as given below (in order starting with the 
greatest level of authority). 

♦ Administrator 
♦ Designer 
♦ Operator 
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Applicable Online Operations for Each Level 
The applicable functions, authorities, and operation restrictions for each authority level are given below. 

: Supported 

Controller operation Authority 

Administrator Designer Operator 
Work Online    

Auto Online*1    

Changing Operating Mode    

Monitor (Monitoring, Differential Monitor, Pause)    

Force (On, Off, Cancel, Cancel All Forces)    

Set (On, Off, Value)    

Transfer To PLC    

 From PLC    *2 

 Compare with PLC    *2 

 Task Transfer to PLC    

 Task Transfer from PLC    *2 

 Compare task with PLC    *2 

Protection Set Password    

 Release Password    

Online Edit Ladder Task Changing program    

  Changing set timer/counter value    

 ST Task Changing program    

 SFC 
Task 

SFC Chart Changing program    

 Action Changing program    

 Transition Changing program    

 Function Block Changing program    

 Transfer FB Source    

 Transfer SFC Source    

Release Access Rights    

Release FB/SFC/ST Online Edit Access Rights    

Clear All Memory Areas    

Data Trace    

Time Chart Monitoring    

Information   Reading PLC Information    

Information   Reading PLC Manufacturing Details    

Information   Changing PLC name*3    

Reading/Resetting Cycle Time    

Monitoring Synchronous Operation Status*4    

*1: This function cannot be used when connected to a PLC via Secure Comm. 
*2: These operations cannot be performed during UM protection. 
*3: This function is available only for CJ2H/CJ2M. 
*4: CJ2H Unit with unit version 1.11 or later is required to execute this function. 
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IO table creation and edit Authority 

Administrator Designer Operator 
Transfer to PLC IO Table    

 SIO Unit Parameters    

Transfer from the PLC IO Table    

 SIO Unit Parameters    

Compare with PLC    

Create    

Verify Registered/Actual IO Table     

Delete    

Unit Profile information    

Dip Switch information    

Online Add Unit/Hot Swap*1    

Start Special Application Start with Settings Inherited   

Start only   

Unit Setup EIP21S Unit  Transfer [PC to Unit]    

  Transfer [Unit to PC]    

  Compare    

  Restart    

  Unit Manufacturing information    

  Unit Error Log    

 Other Units Transfer [PC to Unit]    

  Transfer [Unit to PC]    

  Compare    

  Restart    

  Unit Manufacturing information    

  Unit Error Log    

*1: This function is available only for CS1D. 
 

PLC system setup  Authority 

Administrator Designer Operator 
Transfer to PLC    

Transfer from PLC     

Verify    
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Memory Card operation Authority 

Administrator Designer Operator 
Format    

Program Area Transfer [Area to CF]    

 Transfer [CF to Area]    

CPU Bus Unit Area Transfer [Area to CF]    

 Transfer [CF to Area]    

IO Table Area Transfer [Area to CF]    

 Transfer [CF to Area]    

PLC Setup Area Transfer [Area to CF]    

 Transfer [CF to Area]    

Peripheral Device Area Transfer [Area to CF]    

 Transfer [CF to Area]    

Routing Table Area Transfer [Area to CF]    

 Transfer [CF to Area]    

IO Memory Area Transfer [Area to CF]    

 Transfer [CF to Area]    

 

Error log display Authority 

Administrator Designer Operator 
Reading Error Log    

Clear All Memory Areas    

 

Reading/Setting PLC clock Authority 

Administrator Designer Operator 
Obtaining time of PLC    

Synchronize Clock    

Set PLC Clock    

 

PLC Memory Window Authority 

Administrator Designer Operator 
Memory Tab Transfer To PLC    

 Transfer From PLC    

 Compare With PLC    

 Monitor    

 Force On/Off    

 Set On/Off    

Address Tab Force On/Off    

 Set Value    

 Forced Status Scan Force Status    

  Clear all Forced Addresses    
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EIP21S User Management Tool Authority 

Administrator Designer Operator 
Connect (After user registration)    

Display User List    

Account operation 
(User's own account) 

Add *1   

Delete    

Change User name    

Authority    

Password    

Account operation 
(Other user’s account ) 

Add    

Delete    

Change User name    

Authority    

Password    

Initialize User List    

Display Operation Log    

Export Operation Log    

Clear Operation Log    

*1: This operation can be performed only when a user authentication is not registered. 
 

PLC Backup Tool Authority 

Administrator Designer Operator 
Backup from PLC    

Restore to PLC    

Compare with PLC    
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Setting User Authentication 
The user authentication function enables managing users who can perform online operations using the secure 
communication (Secure Comm) through a CS1W-EIP21S or CJ1W-EIP21S Unit (hereinafter referred to as 
"EIP21S Unit") based on the user names and operation authorities registered in the EIP21S Unit in advance. 
When you try to go online with a PLC, you are asked to enter your user name and password. If the user name 
and password do not match the registered settings, you are not allowed to go online. When you input wrong 
password five times in a row, you are not allowed to connect online to the EIP21S Unit for ten minutes. 

First Connection to EIP21S Unit 
Perform the following procedure with the computer connected to the EIP21S Unit in which no user is registered 
with an Ethernet cable. 

1. Select OMRON - CX-One - CX-Programmer - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. 

The Administrator Registration Dialog Box is displayed. 

 
3. Enter a user name of an Administrator into the Username Field. Enter a string of 1 to 16 single-byte 

alphanumeric characters. 

4. Enter a password in the Password Field. Enter a string of 8 to 32 single-byte alphanumeric characters. 
Enter the same password in the confirmation field. 

5. Set password expiration days if necessary, and then click the OK Button. 

6. When the registration is completed, the following confirmation dialog box is displayed. Click the OK 
Button. 
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7. The User Authentication Dialog Box is displayed. 

 
8. Enter the user name and password of the Administrator that are registered in steps 3 and 4, and then click 

the OK Button. 

9. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 

 
 

Adding User 
Only users with the Administrator operation authority can add user accounts. 

1. Select Tools - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. The 

User Authentication Dialog Box is displayed. 

 
3. Enter the user name and password of the Administrator, and click the OK Button. 



PART 1: CX-Programmer 
CHAPTER 4 – Reference OMRON
 
  
 
 

CX-Programmer _Page 108  

4. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 

 
5. Click the Edit User List Button in the EIP21S User Management Tool Dialog Box for which user 

authentication was performed. 

 
6. The Edit User List Dialog Box is displayed. 

 
Click the + Button, and then enter a user name and password in the Username and Password Fields 
respectively. 

Click the combo box of the Operation Permission, select Administrator, Designer, or Operator. Set the 
Password expiration days if necessary, and then click the OK Button. 
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7. When the update is completed, the following confirmation dialog box is displayed. Click the OK Button. 

 
 

Changing Operation Authority 
Only users with the Administrator operation authority can change operation authority except for their own 
operation authority. 

1. Select Tools - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. The 

User Authentication Dialog Box is displayed. 

 
3. Enter the user name and password of the Administrator, and click the OK Button. 

4. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 
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5. Click the Edit User List Button in the EIP21S User Management Tool Dialog Box for which user 
authentication was performed. 

 
6. The Edit User List Dialog Box is displayed. 

 
Click the combo box of the Operation Permission of the user for whom to change operation authority, 
select Administrator, Designer, or Operator, and then click the OK Button. 

7. When the operation authority change is completed, the following confirmation dialog box is displayed. 
Click the OK Button. 
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Changing Password 
Users with any operation authority (Administrator, Designer, or Operator) can change their own password. 

1. Select Tools - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. The 

User Authentication Dialog Box is displayed. 

 
3. Enter the user name and password, and then click the OK Button. 

4. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 
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5. Click the Change Password Button in the EIP21S User Management Tool Dialog Box for which user 
authentication was performed. 

 
Note: After the password is changed, the communication with the CX-Programmer and PLC Backup 

Tool connected to the EIP21S Unit will be disconnected.  
Make sure that no application other than the EIP21S User Management Tool is connected to 
the EIP21S Unit before you change the password. 

 
6. The Password Change Dialog Box is displayed. 

 
7. Enter a new password in the Password Field. Enter the same password in the confirmation field, and then 

click the OK Button. 

8. When the password change is completed, the following confirmation dialog box is displayed. Click the OK 
Button. 

 
The online state will be canceled. Go online again, if necessary. 
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Displaying User List 
Only users with the Administrator or Designer operation authority can display a list of user names. 

1. Select Tools - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. The 

User Authentication Dialog Box is displayed. 

 
3. Enter the user name and password of the Administrator or Designer , and click the OK Button. 

4. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 
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5. Click the Display User List Button in the EIP21S User Management Tool Dialog Box for which user 
authentication was performed. 

 
6. The Display User List Dialog Box is displayed. 

 
A list of user names that are currently registered is shown. 
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Initializing User Authentication Setting 
Only users with the Administrator operation authority can initialize user authentication settings. 

1. Select Tools - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. The 

User Authentication Dialog Box is displayed. 

 
3. Enter the user name and password of the Administrator, and click the OK Button. 

4. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 
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5. Click the Edit User List Button in the EIP21S User Management Tool Dialog Box for which user 
authentication was performed. 

 
6. The Edit User List Dialog Box is displayed. 

  
7. Click the Initialize Button. The following confirmation dialog box is displayed. Click the OK Button. 

  
8. When the initialization is completed, the following confirmation dialog box is displayed. Click the OK 

Button. 

  
The online state will be canceled. When you go online again, perform the procedure explained in First 
connection to EIP21S Unit. 
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Operation Log 
The operation log function records the occurrence time, user name, IP address, operation code (contents of the 
operation), and operation result in an EIP21S Unit for important operations that are executed while the CX-One 
applications are online using the secure communication (Secure Comm). 

This allows you to check who performed what operations and when, so you can use the function to instruct 
countermeasures and to check illegal access when a problem occurs. 

This function is available only when the CX-Programmer is online with an EIP21S Unit using the secure 
communication (Secure Comm). Operation logs are not recorded when other connection methods are used. 

Displaying Operation Log 
Only users with the Administrator operation authority can display operation logs. 

1. Select Tools - EIP21S User Management Tool. 
The EIP21S User Management Tool is displayed. 

 
2. Enter the IP address of the EIP21S Unit in the IP Address Field, and then click the Connect Button. The 

User Authentication Dialog Box is displayed. 

 
3. Enter the user name and password of the Administrator, and click the OK Button. 
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4. When the user authentication is succeeded, the following confirmation dialog box is displayed. Click the 
OK Button. 

 
5. Click the Display Operation Log Button in the EIP21S User Management Tool Dialog Box for which 

user authentication was performed. 

 
6. The Operation Log List Dialog Box is displayed. 
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Operation Log Contents and Functions 

Item Description Remarks 
No. Displays the registration order of operation logs 

registered in the EIP21S Unit. 
 

Date Displays the time and date of the important 
operation. 

This is time and date information of the clock 
in the PLC obtained from the CPU Unit. The 
events are displayed in order of time and 
date by default. 

Username Displays the user name who executed the 
important operation. 

 

IP Address Displays the IP address of the computer that 
was connected online when the important 
operation was executed. 

 

Operation Code Displays the contents of the important operation.  

Result Displays the result of the important operation.  

Export Button Export the operation log. For details, refer to Exporting Operation Log 
described later. 

OK Button Close the Operation Log List Dialog Box.  

Note: The events are displayed in order of time and date by default. If you change the time of the 
PLC clock in the CPU Unit, the order of the events to be displayed based on the PLC clock 
will not match the order of registration of the events. 
To check the events in the order of registration, sort the No. column. 

 

Exporting Operation Log 
Perform the following procedure to export operation logs. Only users with the Administrator operation authority 
can export operation logs. 

1. In the Operation Log List Dialog Box, click the Export Button. 
The Export Dialog Box is displayed. 

 
2. Specify the directory and file name, and then click the Save Button. 

Operation logs are exported in the following format. 

Item Description 
Output  CSV (comma-separated) 

Display order Default (in order of time and date of occurrence) 

Character code UTF-8 with BOM 

Language English (regardless of the language of the CX-Programmer) 
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Clearing Operation Log 
Perform the following procedure to clear operation logs. Only users with the Administrator operation authority 
can clear operation logs. 

1. Click the Clear Operation Log Button in the EIP21S User Management Tool Dialog Box. 
The Clear Operation Log Confirmation Dialog Box is displayed. 

 
2. Click the OK Button. 

All operation logs will be cleared. At this time, Clear Important Operation Log is registered in the 
operation log list. 

3. When operation logs are cleared, the following confirmation dialog box is displayed. Click the OK Button. 

 

Note: Operation logs are not cleared even if the settings of the EIP21S Unit are initialized to the 
defaults. 
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User Authentication Timeout Observation Interval 
This function disconnects the communication with an EIP21S Unit as a communication error if there are no user 
operations of the CX-programmer within the time that is set as the Timeout observation interval in the EIP21S 
User Management Tool. When this function is executed, you must go offline and then go online again. 

This function is enabled only when the CX-Programmer or the EIP21S User Management Tool is online with an 
EIP21S Unit using the secure communication (Secure Comm). 

Setting Timeout Observation Interval 
Windows Administrator authorities are required to use this function. Perform the following procedure when 
offline with the EIP21S Unit. 

1. Select OMRON - CX-One - CX-Programmer from the Windows Start Menu, right-click the EIP21S 
User Management Tool, and select Run as administrator. 
The EIP21S User Management Tool is displayed. 

 
2. Select Tool - Environment Settings in the EIP21S User Management Tool Dialog Box. 

The Environment Settings Dialog Box is displayed. 
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3. Select the Observe user authentication timeout, and then set the Timeout observation interval. The 
setting range is from 1 to 360 minutes. 

4. Click the OK Button in the Environment Settings Dialog Box, and then click the Exit Button in the 
EIP21S User Management Tool Dialog Box. 

 

Setting User Management Data Write Time 
Perform the following procedure to set the write time for user authentication settings. 

1. Select Tool - Environment Settings in the EIP21S User Management Tool Dialog Box. 
The Environment Settings Dialog Box is displayed. 

 
2. Set the User management data write time. The setting range is from 1 to 60 seconds. 

Note: A timeout may occur when you are writing user authentication settings due to a delay in the 
communication path on the network. If you fail to edit a user list or change password, set a 
large value for the User management data write time. 

 

Restrictions on Online Connection via Secure Comm 
♦ When you try to go online with a PLC through an EIP21S Unit using the secure communication (Secure 

Comm), you are asked to enter your user name and password. If the user name and password do not match 
the registered settings, you are not allowed to go online. Manage the user name and password in case you 
forget them. When you forget your password, clear the authentication settings according to the 
troubleshooting procedure. Refer to the SYSMAC CS/CJ -series EtherNet/IP Units Operation Manual (Cat. 
No. W465) for details on the troubleshooting procedure. 

♦ If the IP Packet Filter is set to enable, communications with the devices connected through the EtherNet/IP 
ports for which the Packet Filter is used cannot be made. 

♦ Access beyond the network is not possible for connections between CX-One applications and an EIP21S 
Unit using the secure communication (Secure Comm). 

♦ Online connection using the secure communication (Secure Comm) is available with the following CX-One 
applications. 

• CX-Programmer 
• PLC Backup Tool 
• EIP21S User Management Tool 
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PLC Operating Mode 
 

The PLC can be set to one of four operating modes: Program, Debug (for CV-series PLCs only), Monitor and 
Run. 

♦ Program Mode. In this mode, the PLC does not execute its program/s. It is used to download programs/data. 
♦ Debug Mode. This mode is available on CV-series PLCs and enables basic debugging of user programs. 
♦ Monitor Mode. This mode allows a running program to be edited and monitored while connected during 

development. On-line editing must be performed in this mode. 
♦ Run Mode. This mode sets the PLC to execute the current program as a live operation. This mode is 

generally used for final testing, after a program has been thoroughly tested and debugged. CX-Programmer 
cannot write to the PLC while it is in this mode. 

Some software operations are possible only in certain modes. 

Use the following procedure to change the PLC operating mode. 

1, 2, 3… 1. Select the PLC object from the project workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed: 

select the Yes pushbutton to connect to the PLC. 

 
 

3. Select the Program Mode button, the Debug Mode button, the Monitor Mode button or 
the Run Mode button from the toolbar. 

Show in RungWrap 
Show in RungWrap allows you to monitor long rungs, which exceeds the right bus-bar, in the length of the 
initial position number of the right bus-bar.  

This function is used when CX-Programmer is on-line, or in the read-only mode. While online-editing rungs, the 
RungWrap will be released and after online-edit is finished, the rungs will be shown as RungWrap again. 

CX-Programmer should meet all the following conditions of monitoring rungs in RungWrap. 
♦ Show in RungWrap menu is toggled ON. 
♦ Show right bus-bar is checked ON (in Options dialog). 
♦ The number of Initial position (cells) is set to more than three (do not set Expands to widest rung) in 

Options dialog. 
♦ The length of rungs in the diagram is exceeding the right bus-bar. 
♦ CX-Programmer is online to a PLC or is in read-only mode. 
♦ The program is shown as Ladder diagram (not in Mnemonics view or shown as Statement List). 
♦ No error is found in the program. (Left bus-bar is not shown in red.) 
♦ The program is not online-editing. 

Note: When the right bus-bar is not displayed or the number of initial position of the right bus-bar is less 
than two, programs cannot be monitored in RungWrap. 

 
Use the following procedure to show the rungs in RungWrap. 

1, 2, 3… 1. Select the PLC object from the project workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed: 

select the Yes pushbutton to connect to the PLC. 

 
3. Select the Show in RungWrap button from the toolbar. The rungs are cut into the size of 

the right bus-bar and arranged to show long rungs in the view.  
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Programming On-line 
Once a program has been created and the project and PLC settings are satisfactory, the PLC can be connected to 
allow on-line operations to be performed. 

It is usual to have the PLC running in Monitor mode while using on-line editing functions. On-line editing is not 
possible in Run mode. 

Use the following procedure to program whilst on-line. 

1, 2, 3… 1. Select the PLC object in the project workplace. 

 
2. Select the Work On-line button from the toolbar (see note). A confirmation message is 

displayed: select the Yes pushbutton to connect to the PLC. The icon in the project 
workspace changes. The background color of the Ladder program changes to show that it 
is now an editable area. 

 
3. Select the On-line Edit Rungs button from the toolbar. The selected area is compared 

against the same area on the PLC to ensure that they are the same. On-line edit cannot 
continue until the versions are identical. More than one rung can be selected by keeping 
the left-mouse button depressed and dragging the mouse over the required rungs. 

 4. The background color of the selected rungs changes to show that it is now an editable 
area. Whilst surrounding rungs cannot be edited, they or individual items within these 
rungs, can be copied into the editable area. 

Note: If a checkmark has been placed by Prohibit the online operations until the PC and PLC data 
matches, the following Online Action dialog box will appear so that you can select either 
verifying or transferring data will be displayed. 

 
 • If Compare with PLC is selected, the program will be verified between the CX-

Programmer and the PLC before going online. 

• If Transfer from PLC is selected, the program will be uploaded from the PLC 
before going online.  

• If Transfer to PLC is selected, the program will be downloaded to the PLC before 
going online.  

 
On-line editing can now take place, as it would be accomplished offline. The final END instruction cannot be 
edited on-line. 
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Once normal editing is completed, select the Send On-line Edit Changes button from the 
toolbar. The changes are committed to the PLC. If the changes are successful, the edited area 
of the Ladder program returns to read-only mode. 

 
The on-line edit can be cancelled at any point prior to committing the changes by selecting the 
Cancel On-line Edit Changes button from the toolbar. The program is restored to prior to 
starting on-line editing. 

 
Select Go to on-line edit rung to go to the top of the on-line editing rung. 

Working on rungs while the PLC is connected, and being able to easily change the program is one of the 
quickest ways to complete and check a project. With the PLC running in Monitor mode it is possible to make 
changes as if the PLC were not connected. The difference is that once a rung has been completed, it can be 
downloaded to the PLC while the program is running. 

When performing on-line editing, all rungs must be complete and valid before they can be transferred, whereas 
in offline editing, an invalid rung and program can be saved at any time. 

After forced setting/resetting of a bit online, a dialog box is displayed when status returns to offline to allow the 
forced set/reset status of addresses to be displayed (CX-Programmer Ver. 4.0 or later). The forced set/reset 
status can also be cancelled. Enable this function by selecting Tools − Options and Check forced status after 
online connection in the PLCs Tab Page (the default setting is OFF: no confirmation). This function prevents 
going offline unprepared when the CPU Unit is still in forced set/reset status.  

Uploading Program/s from the PLC 
A program can be uploaded from the currently connected PLC into the open project. All associated program 
data (for example symbol details and IO table) are uploaded. 

Use the following procedure to transfer a program from the PLC. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; 

select the Yes pushbutton to connect to the PLC. 
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3. Select the Transfer from PLC button from the toolbar. A warning dialog is displayed 

indicating that the current program in the project is overwritten.  
The Upload Options dialog is displayed allowing individual components to be selected for 
transfer from the PLC, for example, programs, expansion functions (if available), memory 
allocation, settings, IO table and memory. 

 Note: It is possible to upload a single program or section for online-editing, if section 
markers have been included in the program. When a single section has been 
uploaded, it can only be online-edited, or copied to another, complete program. 

 Note: It is possible to load symbol definitions from the PLC, if it has a file-card 
(CS/CJ/CV PLCs), file memory or comment memory. Loading symbols from 
comment memory is for backward compatibility with the OMRON SSS package: 
the symbols contained in the memory will be unnamed, global symbols. 

 Note: When Start Auto Decompiling is checked CX-Programmer automatically starts to 
decompile after uploading the program from the PLC. 

 4. Set the settings as required and select the OK pushbutton. 

 5. The Uploading dialog indicates the success (or not) of the transfer operation. Any errors 
are written to the Error Log. Select the OK pushbutton to complete the operation. 

Downloading Programs to the PLC 
Programs can be downloaded to the PLC from the project when the PLC is in Program mode. If the PLC is not 
already in this mode, CX-Programmer changes the mode automatically. 

Use the following procedure to transfer a program to the PLC. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; 

select the Yes pushbutton to connect to the PLC. 

 
 Select the Transfer To PLC button from the toolbar. The Download Options dialog is 

displayed allowing the download of programs, settings and IO table individually or 
together. 

 Note: It is possible to save symbol definitions to the PLC, if it has a file-card (CS/CJ/CV 
PLCs), file memory or comment memory. Saving symbols to comment memory is 
for backward compatibility with the OMRON SSS package: only global symbols 
without names are downloaded. 

 3. Set the settings as required and select the OK pushbutton. The items that can be 
downloaded vary according to PLC series. 

The program is compiled and then a confirmation dialog is displayed. The Ladder program is out-out, 
preventing any further editing. The operating mode and the cycle time of the task are displayed in the status bar. 

It is not possible to download a single program or selection of programs to the PLC – all programs are 
downloaded together. However, any programs that have ‘unassigned’ tasks (set in the program properties) will 
not be included. 

Programs can be downloaded to CS/CJ-series PLCs Ver. 2.0 or later or CP-series PLCs, and downloading by 
task (program) instead of the whole user program is possible (CX-Programmer Ver. 4.0 or later). Select Partial 
Transfer – Task Transfer to PLC from the PLC Menu, and download a specified single task or multiple tasks. 
This function enhances the efficiency of program development by multiple personnel. Particularly, by 
downloading to the PLC by task (program), only the parts to be changed are reflected in the PLC, resulting in 
fewer working errors. 

Note: When the CX-Programmer version 5.0 is used to download projects with a CS/CJ-series CPU Unit 
with Ver. 3.0 or later or CP-series CPU Unit, I/O comments, symbol names, rung comments, and 
other data can be transferred either to the Memory Card, EM file memory, or comment memory 
(within CPU Unit’s flash memory). Therefore, even if a Memory Card or EM file memory is not 
available, the I/O comments, symbol names, rung comments, or other data can be stored in the CPU 
Unit’s comment memory. 

Note: This functionality is not supported for CP1E CPU Units. 
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The following option will be displayed for a CJ2 CPU Unit: Clear automatic allocation area and forced status. If 
this option is selected when downloading programs, all automatic allocation area data and forced status will be 
cleared. Select this option when it is necessary to change the automatic allocation area. 

Canceling the Program Transfer 
While transferring a program to or from a PLC it is possible to cancel the transfer by clicking the Cancel button. 
However depending on when the button is pressed different functionality will occur. 

If the Cancel button is pressed before or during the Memory Clear phase the memory clear will be completed 
but the data transfer will not take place. If the button is pressed during the Transfer phase the transfer will be 
stopped and the PLC memory will be cleared. The transfer will not be completed. 

Comparing Programs 
The project PLC program data can be compared with the data inside the PLC. 

The following comparisons may be performed, depending on PLC type: 

♦ Program step number and instructions; 
♦ PLC data; 
♦ Expansion Instruction Table (CQM1, C200HE, C200HG, C200HS and C200HX only); 
♦ UM allocation data (CQM1, C200HE, C200HG, C200HS and C200HX only). 
Use the following procedure to compare programs on the computer and on the PLC. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; 

select the Yes pushbutton to connect to the PLC. 

 3. Select the Compare with PLC button from the toolbar. The Compare Options dialog is 
displayed allowing comparisons of programs, settings and IO table individually or 
together. 

 4. Set the settings as required and select the OK pushbutton. The items that can be 
downloaded vary according to PLC series. 

Details regarding comparisons between computer and PLC programs are displayed in the Compare Result dialog 
box. 

The results of verification can be saved to a file in CSV format. 

Two methods can be used to display the comparison results.  

• Overview display: Program lists are displayed of the compare programs.  

• Mnemonic display: The specified program is displayed in mnemonic form with differences displayed in color.  

The comparison results are displayed by section and mnemonic, including added instructions. You can also 
jump from the mnemonic comparison results to the corresponding position in ladder view. The comparison 
results can be saved in a file by selecting Save As from the File menu in the Compare Result dialog box. If the 
file is saved from the overview display, the comparison results for all programs will be saved in CSV format. If 
the file is saved from the mnemonic display, the comparison results for the currently displayed program will be 
saved in CSV format. 

The following abbreviations will be displayed between program addresses and mnemonics and will be in the 
CSV file.  
*: Mismatch, D: Difference, M: Moved, N: Missing 

Transferring Programs, Symbols, Comments and Index to and from File/File-card 
It is possible to write a combination of program code, program comments and symbol definitions to a set of files. 
It is possible to read these files back. 

If a file-card can be attached directly to the computer (via a PCMCIA controller, for example), then it can be 
used as a disk device like a floppy drive, and files may be directly transferred with it. 
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1, 2, 3… 1. Select the PLC object in the project workspace. 

 2. Select the Transfer/To File or Transfer/From File options from the PLC menu. Or 
select Load Comment/Program or Save Comment/Program options from the File 
menu. A dialog is presented which allows the filename to be set or browsed. Choose 
whether to include Programs, Comments, Symbols or Index in the transfer on this 
dialog. 
For programs, a short Comment may also be given for inclusion in the file. 

Note: When loading comments, text within the program comments (for the project’s PLC) is 
overwritten. When loading symbols, the local and global symbols for the PLC and programs 
are first emptied. 

If the file-card cannot be attached directly to the computer 
When the file-card cannot be attached to the computer, it is possible to transfer comments and symbols to the 
PLC file-card directly using the Transfer to PLC option above. To write the program to the file-card, use the 
above steps to produce the program file on one of the computer’s disks. It is then possible to transfer the file 
between the disk drive and the file-card on a PLC using the CX-Server memory-card component – please refer 
to the CX-Server PLC Tools user-manual. 

Program Monitoring 
Program monitoring allows the power flow of a PLC program to be displayed whilst the PLC program is 
running. Power flow is displayed by a thick line across items in the Ladder program that currently have power 
flowing through them. 

Note: The data from several PLCs can be monitored at the same time. Ensure the program has been 
downloaded and the PLC mode set to Monitor. 

Use the following procedure to monitor a program. 

1, 2, 3… 1. Select the Program object in the project workspace to display the Ladder program in the 
Diagram Workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; 

select the Yes pushbutton to connect to the PLC. 

 
3. Select the Monitor Mode button or Run Mode button from the toolbar. Monitoring can 

only be accomplished in these PLC operating modes. 

 
4. Select the Toggle PLC Monitoring button from the toolbar to start monitoring power 

flow in the Ladder program. 

 
5. Select the Toggle PLC Monitoring button from the toolbar to stop monitoring. 

Note: The PLC Monitoring function can be activated whilst in Mnemonics view. 
The display format for the present values of operands of special instructions when monitoring 
on the Ladder Section Window can be selected from the following data types. The same 
display format must be used globally. To select the display format, click the desired button or 
select Monitoring Data Type from the View menu. 

• Decimal  

• Signed Decimal  

• Monitor in Hex  
 

The default display formats will be as follows if none of the above display formats is selected.  

 • Named symbol will be monitored in the symbol data type.  

 • Unnamed symbol will be monitored in the operand data type.  

• Two-word operations, such as for the MOVL instruction, will be monitored in 2-word 
hexadecimal.  
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• For present values displayed in formats other than hexadecimal, “D” is attached for 2-word 
data and “L” is attached for 4-word. 

Note: The user can confirm whether a task (program) is executing or stopped (CS/CJ/CP-series CPU 
Units only; CX-Programmer Ver. 4.0 or later). The following executing/stopped status is 
displayed for every task (see note) in the project space. 

Note:  Cyclic tasks only. Interrupt tasks not included. 
• Running: Indicated as READY (execution enabled) or RUN (executing status). 
• Stopped: Indicated as INI (not executing status) or WAIT (standby status). 

 
This function improves debugging efficiency when using multiple tasks. 
The background color of the Ladder Section Window for the task being executed can be specified by 
the user. 

Pause Monitoring 
Pause Monitoring is an online function that allows the normal monitoring display to be frozen at a point in time, 
so that the logic of a program can be examined. The pause can be triggered either manually or by a trigger 
condition. 

Note: Due to the speed at which a PLC operates and the slow speed of some network 
communications, a trigger condition on a PLC may not always be found, especially if the 
trigger condition is a transient and only occurs for brief moment in time. 

Use the following procedure to Pause monitor a program. 

1, 2, 3… 1. To enable pause monitoring, first select 'PLC Monitoring', so that monitoring is working 
normally. 

 2. Select a range of rungs that are of interest to monitor. This is necessary to allow the 
monitoring to be as fast as possible (the less values to monitor, the faster the data can be 
obtained through communication with the PLC). 

 
3. Select the 'Pause Upon Trigger' command. This will present a dialog allowing the choice 

of trigger. Select either Manually or Triggered. 
 Triggered: When the pause is triggered, a trigger condition is necessary. A trigger 

condition happens when the contents of an address reaches a certain value or makes a 
transition. 
It is possible to enter an address or a symbol name into the dialog, or browse for a symbol. 
Select the type of condition, supplying the value or transition type. 

 When the pause monitoring function is operating, the display outside the selected region is 
dimmed, and monitoring only occurs within the selected region. 

 
Manually: This option means that monitoring will only be paused when told to do so. 
Select ‘Manually’ in the dialog and press ‘OK’. Monitoring then begins. To operate the 
pause, wait until the monitoring screen is interesting, then select 'Pause' from the toolbar 
or from the PLC/Monitor menu. The monitoring function is paused (the 'Pause' button on 
the toolbar is shown as down). To resume monitoring, press the 'Pause' button again, and 
monitoring will resume, waiting for another trigger. 

If a condition is being used for pausing, the monitoring display will continue until the condition has been met, at 
which point the 'Pause' button will be shown as down and monitoring freezes. To resume monitoring, and wait 
for another instance of the condition, press 'Pause' again. Note that it is possible to manually pause the 
monitoring by pressing 'Pause' even when using the ‘Triggered’ type of condition. To resume full monitoring, 
press the 'Pause Upon Trigger' button again, so that it is shown as out. 

Stopping Pause Monitoring 
Pause monitoring may be stopped either by taking the PLC off-line, taking the PLC out of monitor or run mode, 
or by selecting pause monitoring again – This is effectively a toggle button. 

On stopping pause monitoring, the hatched areas are removed and the PLC is either taken off-line, returned to a 
normal on-line state or returned to normal monitoring or run mode. 

The trigger condition that has been set is remembered should it be required to restart pause monitoring again in 
the same session. 
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PLC Cycle Time 
The PLC Cycle Time dialog allows the PLC’s cycle times to be measured. The PLC Cycle Time is always 
displayed in the status bar. 

 

The minimum cycle time and the Change Button are displayed only for CJ2H CPU Units with unit version 1.1 
or later or CJ2M CPU Units. 

For certain CV-series PLCs if the ladder program contains Mark instructions, the PLC Cycle Time dialog 
permits the measurement between the Start Mark and Stop Mark instructions. 

Use the following procedure to measure PLC cycle time. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; 

select the Yes pushbutton to connect to the PLC. 
 3. Open the cycle time dialog using the Cycle Time command in the PLC/Edit menu. 

The mean, minimum and maximum cycle time is shown in the Cycle Time fields. 
Select the Reset button to empty the PLC’s history buffer for these fields – the values 
will then be calculated and updated by the PLC using the latest values only. 

 4. To measure the time to execute between two points in a program, enter the Start mark 
and stop mark numbers in the Start Mark # field and Stop Mark # field. Note that only 
certain PLCs have this feature. Also, MARK instructions must have been placed in the 
program/s and downloaded to the PLC. Select the Measure pushbutton – a measurement 
will then be taken and displayed in the Time field. Select the Abort pushbutton to cancel 
the measurement. 

 5. Select the Close pushbutton to complete the operation. 

Changing the Minimum Cycle Time Online 
With CJ2H CPU Units with unit version 1.1 or later or CJ2M CPU Units, the minimum cycle time can be 
changed to a specified value even during PLC operation in MONITOR Mode when the cycle time is set to 
“constant” in the cycle time settings in the Timings/Synchronous Tab Page in the PLC Setup. 
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1, 2, 3… 1. Click the Change Button in the PLC Cycle Time Dialog Box. The Constant Cycle Time 
Setting Dialog Box will be displayed so that you can set a minimum cycle time. 

 
 2. Change the minimum cycle time (ms). 

 3. Click the OK Button. The Constant Cycle Time Setting Dialog Box will be closed and 
the minimum cycle time will be updated. 

Note: The set value that is changed here will not be updated in the Timings/Synchronous Tab Page 
in the PLC Setup. To update the PLC Setup, transfer the PLC Setup to the personal computer. 

 

Monitoring Synchronous Unit Operation (CJ2H CPU Units with Unit Version 1.1 or 
Later) 

The operating status of synchronous unit operation can be monitored. The status of errors and warnings related 
to sending and receiving synchronous refresh data can be displayed, along with the maximum and present values 
for the synchronous processing time. This makes it possible to check whether synchronous unit operation is 
functioning correctly, to check whether operation is within the set range for the synchronous operation cycle, 
and to make adjustments. 

For details on the Synchronous Operation Status Window, refer to the CJ2 CPU Unit Software Manual (Cat. No. 
W473). 

1, 2, 3… 1. Select PLC – Edit – Synchronous Operation Status. 
The Synchronous Operation Status Dialog Box will be displayed to enable confirming the 
status of synchronous unit operation.  

 
 

PLC Program Assignments 
The Project PLC Program Assignments dialog lists all tasks and their associated program names for the selected 
PLC in the project. The list can then be printed. 
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Use the following procedure to print PLC program assignments. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 2. Select Program Assignments from the PLC menu. 

 3. Select the Print pushbutton to print the program assignments. 

 4. Select the Close pushbutton. 

PLC Information 
The PLC Information dialog displays information associated with the PLC device, including: 

♦ Device type; 
♦ Program memory (usable/size and whether protected); 
♦ Memory type; 
♦ File/memory card presence; 
♦ Data memory size; 
♦ Extension memory size; 
♦ IO memory size; 
♦ Timers/counters memory size. 

Note: Different PLC devices are capable of reporting different types of information. 
To access the PLC Information dialog, select Information from the PLC menu. Select the Close pushbutton to 
exit the PLC Information dialog. (Note that the PLC must be on line). 

Setting the PLC’s Clock 
When a PLC is on-line, its clock (if it has one) can be synchronized to the computer clock or the PLC clock can 
be set to a specific time.  

Use the following procedure to set the PLC’s clock. 

1, 2, 3… 1. Select the PLC object in the project workspace to display the Ladder program in the 
Diagram Workspace. 

 
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; 

select the Yes pushbutton to connect to the PLC. 

 3. If the PLC has a clock, the project workspace will show a PLC Clock icon. Double-click 
this to show the CX-Server clock dialog. 

Refer to the CX-Server PLC Tools User Manual for further information on setting the PLC clock. 

Applying a Password to the PLC 
The C-series PLCs and CS/CJ/CP-series PLCs support use of a single password to protect an individual PLC. 
The CV-series PLC supports two passwords that provide either system (overall) or partial protection (protecting 
specific programs on a PLC). For password information relating to a specific PLC, refer to that PLC’s user 
manual. 



PART 1: CX-Programmer 
OMRON  CHAPTER 4 – Reference  
 
 

  CX-Programmer _Page 133 

When enabled, the password is required every time the protected program or PLC is accessed. 
The password can be released if necessary, for example, if a new PLC is being created and details need to be 
uploaded from a protected PLC/program to be copied into the new PLC. 
Use the following procedure to apply a password to the PLC. This facility is only available when the PLC is on-
line. Note that for the C-Series PLCs this is done via FUN(49) and after the program is protected, select 
Protection Write Protect from the Transfer menu to set and release the protect. 

1, 2, 3… 1. Select the PLC object in the project workspace. 

 
2. Select the Show Properties button from the toolbar. The PLC Properties dialog is 

displayed. 
 3. Display the Protection tab of the PLC Properties dialog. 

 4. Enter a password; this has a maximum of eight characters for CS/CJ/CP-series PLCs or 
entered as an operand of FUN(49) instruction. 

 5. To release the password, delete the entry from this field. 

 6. Select the Close button from the title bar to close the dialog. 

 
7. Select the Set Password button from the toolbar to enable protection for the PLC. The Set 

Program Protection dialog is displayed. Select the items to apply protection to in the Items 
to Set field. Select the OK pushbutton to accept the settings or select the Cancel 
pushbutton to abort the operation. 

 
8. Select the Release Password button from the toolbar to disable protection for the PLC. 

The Release Program Protection dialog is displayed. Select the items to release protection 
to in the Items to Release field. Select the OK pushbutton to accept the settings or select 
the Cancel pushbutton to abort the operation. 

Refer to Chapter 5 - Advanced Topics for further information. 

Note: The user program, Parameter Area, and I/O Memory in the CPU Unit can be cleared to 
initialize the CPU Unit by selecting Clear All Memory Areas from the CX-Programmer's 
PLC menu or selecting Clear All Memory Areas from the Options menu of the PLC Errors 
dialog box. 

 These operations are possible even if a memory error has not occurred in the PLC (the same as 
they are for a Programming Console). 

Extended Protection Passwords 
With CX-Programmer version 9.6 or later, you can strengthen read protection for the newer unit versions of the 
CJ/CP/CS-Series PLCs. Password protection is described in Chapter 5 – Advanced Topics. 

Flash ROM Backup 
CX-Programmer supports the Monitoring function of Flash ROM Backup for the CS1x-H, CJ1x-H, or CP-Series 
of PLCs. When a backup is started for a CS1x-H, CJS1x-H, or CP1H PLC the Backup Monitor dialog is 
displayed automatically in online mode, when the option ‘Display Backup Monitor Dialog automatically’ is 
selected on the PLC Properties dialog. It can also be invoked manually from the View | Windows | PLC 
Memory Backup Status option. 

The dialog is an information only dialog (or modeless) thereby enabling other operations to be executed during 
the backup process. 

CX-Programmer always monitors the backup status while operating in online mode. 
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Title Bar This shows the name of the dialog and the name of the connected PLC. 

Warning 

 

In this example the PLC memory backup is in progress and the warning 
indicates that the PLC must not be powered off if the backup is to be 
successful. If the power is removed the memory will be cleared. 

Other warnings are: 
 Storing Program Area…. 
 WARNING: DO NOT POWER OFF PLC DURING BACKUP 
 Backing up Parameter Area…. 
 WARNING: DO NOT POWER OFF PLC DURING BACKUP  

Message 

 

Other messages are: 
 Clearing Program Area…. 
 Storing Program Area…. 
 Backup Complete…. 

Program Backup status These status bars show the progress of Clearing and Storing the program. 

Sectors are memory blocks within the PLC memory. The sector number 
information is only displayed when clearing the program and indicates the 
number of sectors to be cleared and the sector currently being cleared. 

Close Dialog when complete Checking this box will cause the Backup Monitor dialog to close when the 
backup is complete (default – unchecked). 

Displaying Backup status in Status Bar 
Displaying the Backup status indicator in the status bar, from the toolbar menu View|Windows|PLC Memory 
Backup Status: 

Whenever the connected PLC is backing up data to the Flash ROM, the backup status indicator will be 
displayed as follows: 

 

The indicator will flash during the backup operation. When the backup has been completed no indicator is 
displayed. 

Note: With the C-series PLCs, any of the following methods can be used for data transfer and 
verification with a ROM Writer.  

 • Using the CX-Programmer, transfer the program from the computer to the ROM Writer.  

 • Transfer to program from the ROM Writer to a CX-Programmer project. 

• Verify programs between CX-Programmer and ROM Writer. 

• Create Intel Hex format files from CX-Programmer programs. 

• Input from an Intel Hex format file to the CX-Programmer project.  
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Note:  The data transferred for each PLC is listed below. 
 

PLC Data 
C1000H/2000H Program, I/O tables, SYSMAC NET data link tables, battery error 

detection method 
C200H Program, I/O tables, Fixed DM, battery error detection method 
C200HS Program, I/O tables, PLC Setup, Expansion DM, expansion instructions 
CQM1, CQM1H Program, PLC Setup, expansion instructions 
C200HX/HG/HE (-Z)  Program, I/O tables, PLC Setup, Expansion DM, expansion instructions 

Data Trace/Time Chart Monitoring 
Once a program has been downloaded into a PLC and is being executed, the program and any associated data 
can be graphically traced providing an analytical tool for monitoring program performance. 

During the execution of a Data Trace, the PLC records the data values and holds them in an internal buffer. 
When the trace is complete, the values are uploaded from the PLC and displayed on the screen. 

 
Select the Data Trace button from the toolbar or Time Chart Monitoring from the PLC menu. 
Refer to the CX-Server PLC Tools User Manual for further information. 

CX-Net Network Configuration Tool 
The CX-Net Network Configuration tool provides procedures for establishing communications to PLCs for 
direct and gateway connections. It allows the creation and editing of local and network Routing Tables, and the 
creation and editing of Data Link Tables. 

To open the CX-Net Network Configuration tool, select Network Configuration Tool from the Tools menu. A 
temporary project file (CXP Project.cdm) will be created with the same PLC types in the CX-Programmer 
project. 

Refer to the CX-Server PLC Tools User Manual for further information. 

IO Table 
The IO table enables the map of racks and units needed by the PLC programs to be edited. It also allows the 
desired map to be compared with the actual map of the connected PLC when online. See the CX-Server PLC 
Tools User manual for details on editing the table. 

Some (usually smaller) PLCs do not have configurable IO, and so do not have an IO table. 

Once IO assignments have been made, affected addresses are shown prefixed in CX-Programmer’s program 
editors. An ‘I: ’ prefix indicates that the address is mapped to an input unit. A ‘Q: ’ prefix indicates that the 
address is mapped to an output unit. Select Show actual I/O bit in XY in the Diagrams tab of Options dialog to 
change the prefix to ‘X: ’ and ‘Y: ’. 
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CHAPTER 5 
Advanced Topics 

This chapter discusses features and topics associated with CX-Programmer for use by advanced programmers. 

Writing More Maintainable Programs 
CX-Programmer contains features that allow better-documented, more maintainable programs to be developed. 
The following paragraphs discuss the topics associated with those features. 

Symbols 
Symbols give readability to a program by adding a meaningful name and/or comment to an address or value. 

Symbols should be defined locally to a program and rarely at PLC global scope, unless it is necessary to share 
an address between a PLC’s programs. Keeping symbols local means that the symbol set for the program is as 
small and maintainable as possible, and stops modifications of one program from affecting others. Other 
benefits include the ability to easily cut/paste a program between PLCs or projects, keeping the correct symbol 
set. 

It is possible to override the definition of a global symbol at local level, by redefining the symbol at the local 
level. CX-Programmer gives a warning when performing a program check, but the practice is allowed. 

It may improve readability and maintainability by defining ‘work’ type addresses automatically. Any address 
that is automatically assigned is indicated as such each time it is used. The allocation of addresses is controlled 
at the PLC level – CX-Programmer ensures that all addresses are unique within the assigned address range.  

Data Types 
A symbol’s data type allows CX-Programmer to check correct usage of the address – for example, a symbol can 
indicate that an address is for Binary Coded Decimal encoded values. CX-Programmer checks that the address is 
not used incorrectly in binary instructions. 

Although the CHANNEL data type is available for symbols, it does not give protection against incorrect 
encoding usage. The CHANNEL data type is for use when the data within an address is of an indeterminate 
format. It can also be used to mark the start of an array. 

The NUMBER data-type makes it possible to create a symbol for a constant value, further helping readability. 

Copying Information between Projects 
CX-Programmer can only open a single project at a time. However, it is possible to copy parts of the project 
information to another project. To do this, it is necessary to have two CX-Programmer applications running at 
the same time. 

Data that can be copied includes the following: 

♦ PLCs; 
♦ Programs; 
♦ Symbol tables; 
♦ Symbols; 
♦ Parts of a Ladder program. 
It is thus possible to integrate programs and information from several projects. This is useful, for example, 
where each person on a team is responsible for writing a single program. The person responsible for integration 
can then copy each program produced, from its own project into a single PLC on the master project. 

Both cut/paste and drag/drop techniques can be used to copy data. For cut/paste, copy the data to the clipboard 
in one application, and paste into the other application. 

Note: When a program is pasted from one PLC type to another, it does not undergo program 
conversion. To correctly assemble programs from different PLC types, it is necessary to first 
change the PLC types of the source programs to the target type before copying. 
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Using CX-Programmer with Other Applications 
CX-Programmer can be utilized effectively with other applications within the Microsoft Windows environment. 

Converting Projects 
It is possible to convert data from other applications to CX-Programmer. A file conversion utility is provided 
with CX-Programmer that allows files from other packages to be converted to a CX-Programmer project. 

SYSWIN, CVSS, SSS and SYSMAC-CPT projects can all be converted to CX-Programmer projects. The 
simplest way to convert a project is to start CX-Programmer, select Open from the ‘File’ menu, change the 
‘Files of Type’ combo to point to the appropriate project type (e.g. ‘SYSWIN 3.x Project (*.SWP)’ for 
SYSWIN 3.x projects) and then navigate to the appropriate (SYSWIN) project to be converted.  

Alternatively, the following procedure can be followed to run the converter manually for other project types. 

1, 2, 3… 

 

1. Activate the File Conversion Utility from the Start pushbutton on the Microsoft Windows 
taskbar. 

2. Select Import from the File menu. The Select Import File dialog is displayed. 
 3. Choose the file type that is to be imported in the Files of type field. 

 4. Select the file that is to be converted from the File name field. 

 5. Select the Open pushbutton to open the file. Select the Cancel pushbutton to abort the 
operation. 

The conversion process begins. Depending upon the file type chosen, messages or choices may appear. Follow 
the instructions on the screen. 

A CX-Programmer project is created, usually with the same name as the original file, but with the file extension 
of ‘CXT’ (the text version of the CXP file type). This can be opened from within CX-Programmer as normal, 
ensuring that the Files of type field within the Open CX-Programmer File dialog is set to ‘CX-Programmer Text 
Files (*.cxt)’. 

It is possible to show details of the available converters by showing the File Conversion Utility’s About dialog. 
This lists the converters – details of a converter can be displayed by selecting the Info pushbutton, after first 
selecting a converter. 

Sharing Symbols 
CX-Programmer supports a mechanism for sharing symbol definitions with other, compliant applications. This 
could allow, for example, the symbols declared within CX-Programmer to be linked to a SCADA package so 
that the definitions and changes of addresses are synchronized. 

Note: The sharing is not active – changes in the shared symbols are not instantly broadcast to the 
other applications. 

A CX-Server file is used as the medium for transferring symbol definitions between applications. 

Use the following procedure as an example of how particular symbols are linked between CX-Programmer and 
a fictional SCADA application AppX. 

1, 2, 3… 1. In CX-Programmer, create a new CX-Server file through the Project Properties dialog. 
This ‘.CDM’ type file will hold the definitions of all linked symbols. Refer to Chapter 3 
Project Reference for further information. 

 2. For each symbol required to be shared, set its Link the definition to the CX-Server file 
setting. Only global, named symbols can be shared. 

 3. Save the project. At this time, the CX-Server file is created with a copy of the definitions 
of the shared symbols. 

 4. In AppX, a similar process is followed, linking the CX-Server file to its CX-Server project 
file. When the CX-Server project is then opened, the shared symbols are loaded into its 
symbol definitions. 

 5. Whenever linked symbols are changed within CX-Programmer and the project is saved, 
the CX-Server file is updated. When AppX opens its CX-Server project again, its 
definition of the changed symbols is updated. 
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Note: The linkage between CX-Programmer and another application operates both ways. It is 
possible for the other application to change the definitions of linked symbols, and to create 
them. When CX-Programmer opens its project again, the ‘.CDM’ file is checked for any 
changes made to the linked symbols within CX-Programmer. Optionally (depending upon the 
PLC Confirm Changes in Linked Global Symbols setting), each change is indicated and 
confirmed. Any new symbols present in the linked file are also read into the PLC’s global 
symbol table. 

CX-Programmer stores the necessary PLC definitions inside the CX-Server file as well as the linked symbols. 
Therefore, the other application also has a PLC object of the same name in order to share the information. 

Note: When the name of a linked symbol is changed, the link to it in the other application is lost. 
The name is used as the link between the definitions. The other application actually treats it as 
a new symbol. Similarly, if the PLC name is changed, the linkage to its symbols is lost. 

Importing and Exporting Symbols 
CX-Programmer has the ability to import and export symbol definitions to or from another package, such as a 
spreadsheet. The information is transferred in a text format, so it is also possible to use a word processor to 
define a set of symbols and use them within CX-Programmer. 

Exporting 
Use the following procedure to export a set of symbol definitions to a spreadsheet or word-processor: 

1, 2, 3… 1. Select a set of symbols in a symbol table, or select a complete symbol table from the 
project workspace. 

 2. Perform a copy operation. 

 3. Activate the other application. 

 4. Perform a paste operation (this may be done differently according to the application, but is 
generally done using the Paste command under the Edit menu). 

Note: For the paste to work successfully, it may be necessary to indicate to the other application 
what the format of the data is. See below for the format information. 

Importing 
Use the following procedure to import a set of symbol definitions from a spreadsheet or word-processor: 

1, 2, 3… 1. Select the information in the source application - ensure that it is of the correct format (see 
Information Format below). 

 2. Perform a copy operation. 

 3. Activate CX-Programmer. 

 4. Paste the information into the correct symbol table by either opening the table or pasting 
when a symbol table is selected in the project workspace. 

 
Note: If errors are encountered in the information when pasting symbols, a dialog is shown which 

allows the information to be modified. This dialog lists all symbols in the information that 
contain errors (i.e. Symbol with invalid names or invalid addresses). Each symbol may be 
modified or removed from the list before retrying the operation. 

Importing Network Symbols 
CSV files can be used to import network symbols created on the Network Configurator. The Network 
Configurator is the software application used to set data links in EtherNet/IP networks.  

Procedure: 
1. Select the symbol table and then select Insert – Import Network Variable from the menus.  

2. Select a network tag file that was saved from the Network Configurator. 

Information Format 
The information is in a tabbed format of text.  

Column Format 
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For supplying symbols complete with data-type, use format of 4 columns, which consists of  
  <Symbol Name> tab <Symbol Data-type> tab <Symbol Address> tab <Comment> 

The items in < > brackets are the data. e.g. A supplied piece of text such as: 
"Name BOOL 1.1 this is a comment" is valid (without the "). 

Each item should be on a new line. 

Note:  It is possible to have a blank address in this format, in which case the address will be 
automatically allocated by CX-Programmer. 

Spreadsheets 
When using a spreadsheet to create the data, use a table of the relevant number of columns and rows in the 
format above. Ensure that the host application is set to produce tabbed text when pasting (this maybe the 
default). 

Rules for Symbol Linking / Unlinking 
Order of Precedence 
Whenever an operation is performed that requires a symbol to be linked or re-linked there is an order of 
precedence that the symbol tables are searched in. The order of precedence of searching is as follows, 

♦ Search in the local symbol table. 
♦ Search in the global symbol table. 

Note:  Where symbols within the same table have the same address then the Symbol used will be 
determined by alphanumeric order. 

Inserting Symbols 
When a new symbol is added to a symbol table the ladder diagrams will be searched, looking for an address or 
symbol name to match using the order of precedence specified above. 

When a new symbol is created without an address and Auto Allocation has been enabled then a new address is 
allocated to the symbol. If however Auto Allocation has not been enabled then the symbol’s address is shown as 
N/A [Auto] and any operand that uses that symbol will be in error. 

Modification of symbols 
A symbol may be renamed in the symbol table. Following this the change in name is reflected to the ladder 
diagram for any operands that are linked to that symbol. Note that no change in the linkage occurs. 

A symbol may have its address modified in the symbol table. Any operands linked to this symbol will remain 
linked, however if there are ladder elements with physical addresses that match the symbols new address, these 
will now be linked to the symbol. 

Deleting Symbols 
When a symbol is deleted from the symbol table any operands that are currently linked to that symbol will be re-
linked to new symbols. The symbols are searched for using the order of precedence rule. If a new match is found 
then the operand will be linked to the new symbol. If however no new match is found then the operand reverts to 
the physical address of the deleted symbol. 

Entering Contact or Coils into Ladder Diagrams 
When a contact or coil is entered into a ladder diagram the user may enter an address, or symbol name.  

If an address is entered then the address is searched for in the symbol tables in the order of precedence. If a 
symbol with the address is found then it is linked to the contact. If an address is not found then the contact has a 
physical address. 

If the user enters a symbol name then the symbol tables are searched in order and if a symbol is found with the 
same name the contact is linked to that symbol. If no match is found in the symbol tables then a new symbol is 
created in the local symbol table and the contact is linked to the new symbol. A new symbol is not created for 
instruction operands, as it is not known what data type to create. 
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If an operand is linked to a symbol in the global symbol table, this link may be overridden by creating a new 
symbol in the local symbol table with either the same name or the same address. The operand will then be linked 
to the local symbol. 

Converting Programs between PLC Types 
It is possible to automatically convert a program written for one type of PLC into another. CX-Programmer 
attempts to change addresses and mnemonic instructions from the source PLC type to equivalent addresses and 
instructions on the new type of PLC. 

Use the following procedure to convert program to PLC types. 

1, 2, 3… 1. Double-click the PLC object in the project workspace. The Change PLC dialog is 
displayed, part of the CX-Server application. Change its CPU and PLC device to the new 
type. 

 2. A program check is performed to ensure there are no errors. It is not possible to convert a 
program that contains errors. 

 3. The programs are converted before replacing them. Any addresses and instructions that 
cannot be directly replaced are listed in the Compile tab of the Output window. 

 4. CX-Programmer displays a confirmation dialog to replace the old programs with the new. 
If there are conversion errors (listed in the output window), it is best to select the Cancel 
pushbutton to abort the conversion and change the original programs to remove the 
conversion problems. If the conversion is acceptable, select the OK pushbutton to replace 
the programs. 

CX-Programmer’s program conversion process is not capable of making all program adjustments automatically. 
If an instruction from the old PLC does not have a direct equivalent in the new PLC then CX-Programmer 
produces a warning that the conversion is not available. In addition, some addresses cannot be converted. 

Note: When a program is copied and pasted from one PLC type to another, it does not undergo 
program conversion. It is good practice to ensure that programs are already converted before 
copying them to another PLC (by first changing the source PLC type to the target PLC type). 

As a general rule, it is easier to convert upwards from C-series PLCs to CV-series PLCs to CS/CJ/CP-series 
PLCs. 

Applying a Password to the PLC Programs 
It is possible to apply protection to a PLC or the program(s) it contains. This protection stops CX-Programmer 
from uploading or comparing a program, and so provides commercial copyright security. It also stops unwanted 
editing of guarded programs. 

 
Generally all passwords are set on the Protection tab of the PLC Properties dialog and are 
activated or deactivated by selecting the corresponding Set Password button or Release 
Password button from the toolbar. 

The protection that is provided, and the mechanism for protection, depends upon the series of the PLC. 

Functions for CS/CJ-series CPU Unit Ver. 2.0 or Later, or CP-series CPU Unit with CX-
Programmer Ver. 4.0 or Later 

Note: The protection function of task(s) is not supported for CP1E and CP2E-series CPU Units. 
Password protection (reading/editing prohibited) can be set for a single user-set task or multiple tasks 
(programs). This function provides security and prevents the loss of intellectual property for specific tasks 
(programs).  

When a password is registered for the whole user program or individual tasks, the following optional settings 
can also be selected at the same time. 

(a) Allow/prohibit creation (backup) of the program file (.OBJ). This function prevents copying of user 
programs to Memory Cards. 

(b) Allow/prohibit program overwriting. Set the option in the PLC properties. This function uses a password 
to prohibit overwriting of the program by a third party. 
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Extended Protection Passwords (Option) 
With CX-Programmer version 9.6 or higher, you can increase the length of the protection passwords for UM 
read protection and task read protection to up to 16 characters if you use the following versions of PLC Units. 
You can select this option to strengthen security for program data and communications data in the PLC. (This 
function is called extended read protection.) The option is not displayed for PLCs that do not support it or in 
projects for unit versions that do not support it. 

 

Applicable PLCs and Unit Versions 

Model set on the CX-
Programmer 

Unit version 

CJ2H 1.5 or later 

CJ2M 2.1 or later 

CS1G-H 4.1 or later 

CS1H-H 4.1 or later 

CJ1G-H (See note.) 4.1 or later 

CS1D-H 1.4 or later 

CS1D-S 2.1 or later 

CP1H 1.3 or later 

CP1L 1.1 or later 

CP1L-E 1.1 or later 

CP1E 1.3 or later 

CP2E 1.0 or later 

CP2E-N 1.0 or later 

Note: This function is supported in only the CJ1G-CPU4@P PLCs. 
 

If the Extend protection password check box is selected on the CX-Programmer, you cannot execute the 
following operations for PLCs and unit versions other than those listed above. 

- Model conversions 

- Transfer to PLC 

- Transfer to PLC 

 
If the Extend protection password check box is selected on the CX-Programmer, you cannot transfer the 
program to the Simulator (including automatic program transfers to the PLC when going online). 

 

If extended read protection is enabled on a PLC, you cannot execute the following operations from CX-
Programmer version 9.5 or lower. 

- Transfer from PLC 

- Compare with PLC 

- Task Transfer to PLC 

- Task Transfer from PLC 

- Compare Task with PLC 

- Release Password 

- Online Edit 

- Changing timer/counter SVs 

 

 



PART 1: CX-Programmer 
OMRON CHAPTER 5 – Advanced Topics
  

  CX-Programmer _Page 143 

C-Series PLCs 
For certain C-series PLCs the password is embedded in the program using a specific ladder construct and is not 
specified on the PLC properties page. The password must be entered as four hexadecimal digits as shown below. 
Check the availability of password protection in the appropriate manual for the PLC. 

The program must first be set up with an open contact with the address ‘AR10.01’ applied. The password 
protection can then be applied. The password can be any four-digit number. To set the password, select the 
Protection tab within the PLC Properties dialog. The following example illustrates the functionality of the 
password protection, with the password of ‘1111’. 

 

When enabled, the password is required every time the program is accessed. To set and release the protection 
after the program is protected, select Protection Write Protect from the Transfer menu. 

CV-Series PLCs 
Two levels of password protection are provided for CV-series PLCs, ‘System protection password’ and ‘Partial 
protection password’, both of which are set on the PLC Properties dialog. 

The ‘System protection password’, specified as a four-digit hexadecimal value, provides overall protection for 
the whole of program memory. 

It is possible to protect several programs or chapters of programs using the ‘Partial protection password’. For 
each program that needs to be protected check the Protect program option and specify a range of steps on the 
protection tab of the Program Properties dialog. 

When setting or releasing the protection, it is possible to select the programs to affect in the Program Protection 
dialog. 

CS/CJ/CP-Series PLCs 
CS/CJ/CP-series PLCs support a single eight-digit alphanumeric System protection password option for all 
CS/CJ/CP-series PLCs. This provides read protection for the whole of program memory, accessed from the PLC 
Properties dialog. 

Task Protection 

Programs in CS/CJ-series Ver.2.0 or later versions can be read-protected in tasks.  

Set / release task read protection as follows. 

Input a password to the [Task read protection] box in the [Protection] tab of [PLC Properties]. Password is to be 
up to 8 alpha-numeric characters (A-Z, a-z, 0-9). Check on the [Task read protection] box in the [Protection] tab 
of [Program Properties] of each program to set programs to be the protection target.  

Go online and select [PLC | Transfer | To PLC] to transfer the programs including task-read protected tasks. The 
message asking if task read protection would be set to the PLC at program download is shown, and if "Yes" is 
selected, the program is transferred with the task read protection settings.  

Task read protection is released by inputting the set password in the dialog shown by selecting the [PLC | 
Protection | Release Password] menu. The confirmation dialog whether or not the task protection in the offline 
project in the PC is to be released. If [Yes] is pressed, the task protection of the offline project is also released 
(Only when the same password as the online PLC is set). 

Task read protection of the offline project can be set or released during offline. 

If the task read protection password is set, but the project is not task-read protected, a message to ask you to set 
the task read protection is displayed in the following cases. If you select “Yes”, the task read protection will be 
set. 

- When saving the project 
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- When downloading the program 

- When executing the Task Transfer to PLC 

- When exiting from the online status 

 

Set the password in the PLC Properties dialog 

1) When use extended read protection, select the External protection password check box. 

2) Select Set button 

 
3) In Protect Setup dialog box, enter the Password and Password (confirmation), and then select the Set button. 

 
Note: If the Extend protection password check box is selected, the passwords must contain a maximum of 16 alphanumeric 

characters. If the Extend protection password check box is not selected or not displayed, the passwords must contain a 
maximum of 8 alphanumeric characters. 
 

Note: Protection is not enabled unless passwords are set. Register passwords in the PLC properties. If task read protection is 
already set in the PLC, the extend protection password setting must be the same in both the PLC and CX-Programmer. 
Protection cannot be set if they are different. 

 
Note: For some PLC models and unit versions, if the password is incorrect five times in a row, a password cannot be entered 

for two hours. Refer to the relevant PLC manual for details. 
 
Note: A program file (.OBJ) that was saved with extended task read protection enabled cannot be opened on CX-Programmer 

version 9.5 or lower. 
♦ If you attempt to open a program file (.OBJ) with only a ladder program for which extended task read 

protection is enabled on CX-Programmer version 9.5 or lower, the following message will be displayed. 

 
♦ If you attempt to open a program file (.OBJ) that contains ST tasks, SFC tasks, or function blocks for which 

extended task read protection is enabled on CX-Programmer version 9.5 or lower, the UM read protection 
password entry dialog box will be displayed, but the OK button will not be enabled. 
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Saving a Project with Extended Read Protection Enabled 
The selected status of the Extend protection program check box on the CX-Programmer is saved in the project 
file. A project file (.CXP or .CXT file) that was saved while the Extend protection password check box is 
selected on the CX-Programmer cannot be opened on CX-Programmer version 9.5 or lower. 

A project file (.CXPS file) that was saved while the Extend protection password check box is selected on the 
CX-Programmer cannot be opened on CX-Programmer version 9.76 or lower. 
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CHAPTER 6 
Converting a C500/C120/C**P Program to CS/CJ/CP/CVM1 
Format 

This section describes the following functions, their operation, and relevant precautions. 

•  Backing up of programs and I/O memory data from C500/C120/C**P PLCs. 
• Restoring data from backup files to C500/C120/C**P PLCs. 
• Verifying programs and I/O memory data between C500/C120/C**P PLCs and backup files. 
• Converting C500/C120/C**P programs and I/O memory data to CS/CJ/CVM1 format. 
• Making host link communications settings for C500/C120/C**P PLCs. 

C500/C120/C**P Program Conversion 
It is possible to convert C500/C120/C**P programs to CS/CJ/CV-series programs. Also, it is possible to read 
programs and DM/HR area data from C500/C120/C**P PLCs to save in a file and write the saved programs and 
DM/HR areas data to C500/C120/C**P PLCs. 

C500/C120/C**P Program Conversion 
Programs can be read from C500/C120/C**P and converted to a CXT-format project file to be saved in a file. 

The source and destination devices are as follows: 

The source: C500/C120/C20/C28/C40/C60P 

The destination: CS1G-H/CJ1G-H/CS1H-H/CJ1H-H/CJ1H-H-R/CJ2H/CJ2M/CS1D-S/CS1D-
H/CJ1M/CP1H/CP1L/CP1L-E/CP1E/CP2E/CP2E-N/CVM1-V2 

Set the following Host Link communications settings and program conversion conditions, and then execute 
program conversion. 

A backup file (.c5b) is required to execute conversion. Refer to C500/C120/C**P Program Backup for 
information on how to create backup files. 

Host Link Communications Settings 
To make the host link communications settings for communications with the C500/C120/C**P, select Tools – 
C500/C120/CxxP Support – Host Link Comms Settings. The Host Link Comms Settings Dialog Box will be 
displayed. Make the Host Link Unit number, COM port settings, and response timeout settings. 

 

The following tables show the Units and Cables that can be connected to C500/C120/C**P. 

C500 and C120 PLCs: 

Unit Port on Unit Port on personal 
computer 

Network type  
(serial 

communications 
mode) 

Model 

CPU Unit Built-in peripheral 
port 

9-pin, D-sub male 
connector 

Host Link (SYSWAY) C200H-IP007 + 
CQM1-CIF02 

Host Link Unit C500: 
C500-LK203/LK201-V1 or 
C120-LK201-V1 

C120: C120-LK201-V1 

RS-232C port,  
25-pin, D-sub female 
connector 

9-pin, D-sub male 
connector 

Host Link (SYSWAY) XW2Z-200P-V/  
500P-V 
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C**P: 

Unit Port on Unit Port on personal computer 
Network type (serial 

communications 
mode) 

Model 

Host Link Unit 
C20-LK201-V1 

RS232-C port, 25-pin,  
D-sub, female connector 9-pin, D-sub, male connector Host Link (SYSWAY) XW2Z-200P-V/ 

500P-V 

 

Change Model 

Convert backed-up C500/C120/C**P programs or C500/C120/C**P program files (c5B extension) stored in the 
computer.  

Select Tools – C500/C120/CxxP Support – Change Model to display the Change Model Dialog Box.  
The following items can be set in the Change Model Dialog Box. 

• Backup File: Specify the program file to be converted. 
• Target File: Specify a file in which to save the converted program. 
• Conversion range: The program conversion range can be selected from the following. 

• Converts to the END instruction: Converts the program until the first END instruction appears. 
• Converts all program: Converts the program until the last instruction except for NOP appears. 

• Destination PLC/CPU: Specify the conversion destination PLC device. 

 
Saving The Mnemonics Text File Before Conversion: 

When converting models, programs prior to conversion can be saved as mnemonics text. Check the Save the 
mnemonics text file before conversion checkbox and click the OK Button in the Change Model Dialog Box.  
The program will be saved under the file name destination file name.txt in the same folder as the post-
conversion destination file. (If a file with the same name already exists, the mnemonic text file will be saved as a 
txt file with the same name with a number added.) 

Press the OK Button to start program conversion. 

The converted project file will be loaded if the conversion process has been completed correctly. If there are 
conversion warnings, they will be displayed in annotated comments (comments attached to instructions). 

C500/C120/C**P Program Backup 

C500/C120/C**P Data Backup 
Data from the UM (user program area) and DM/HR areas can be read from C500/C120/C**P PLCs and saved in 
a binary backup file (*.c5b). The areas to be saved are as follows. 

UM: All 

DM0 to DM511 

HR0 to HR31 

To execute backup, select PLC – Tools – C500/C120/CxxP Support – Backup to display the dialog box. 
Specify the target file and click the OK Button. The file will be backed up. 

C500/C120/C**P Data Restore 
Data in the UM and DM/HR areas of a C500/C120/C**P backup file (*.c5b) can be written to the UM and 
DM/HR areas of the PLC. 

To restore files, select Tools – C500/C120/C**P Support – Restore to PLC to display the dialog box. Specify 
the file to be restored and click the OK Button. 
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C500/C120/C**P Compare 
It is possible to compare UM and DM/HR area data saved in a file and data in a C500/C120/C**P PLC. Select 
Tools – C500/C120/CxxP Support – Compare PLC and File.  

C500/C120/C**P Operating Mode Change 
It is possible to change the operating mode of the connected PLC to RUN, MONITOR, or PROGRAM mode. 
Select Tools – C500/C120/CxxP Support – Operating Mode. 

Conversion Table for C500/C120/C**P Instructions  
When the PLC model is changed using the C500/C120/C**P utility, the programs are automatically converted. 
The instructions (mnemonics) and operands are converted so that they function the same way as before 
conversion. However, there are some exceptions. 

Refer to the Instruction Conversion Table below for the conversion details and the constants used in the 
operands. Refer to the Memory Area Conversion Table and Auxiliary Area Conversion Table for the memory 
addresses used in the operands. 

“CS/CJ Series” in the tables indicates the CJ2H, CS/CJ-H, CJ1M, CS1D, CP1, and CP2 PLCs. “CV Series” 
indicates CVM1-V2 PLCs. 

Before conversion After conversion 

C500 
/C120 C**P Example CS/CJ 

Series Example CV Series Example Remarks 

LD LD 0001 

Same as before 
conversion 

LD 000001 

Same as 
before 
conversion 

LD 000001 --- 

LD NOT LD NOT 0001 LD NOT 000001 LD NOT 000001 --- 

AND AND 0001 AND 000001 AND 000001 --- 

AND NOT AND NOT 0001 AND NOT 000001 AND NOT 000001 --- 

OR OR 0001 OR 000001 OR 000001 --- 

OR NOT OR NOT 0001 OR NOT 000001 OR NOT 000001 --- 

AND LD AND LD AND LD AND LD --- 

OR LD OR LD OR LD OR LD --- 

OUT OUT 0100 OUT 000100 OUT 000100 --- 

OUT NOT OUT NOT 0100 OUT NOT 000100 OUT NOT 000100 --- 

TIM TIM 00 #100 TIM 0000 #0100 TIM 0000 #0100 --- 

CNT CNT 10 #0003 CNT 0010 #0003 CNT 0010 #0003 --- 

NOP NOP NOP NOP --- 

END END END END --- 

IL IL IL IL --- 

ILC ILC ILC ILC --- 

JMP JMP JMP0 JMP0 

 

JMP #0000 - The following message will 
appear: 
“CONVERT_WARNING: 
The instruction specification 
is different. Check the 
instructions.” Check the 
specifications of CPU Unit 
after conversion. 
- These instructions do not 
have operands for the 
C500/C120/C**P. 
- For the CS/CJ-H PLCs, 
JMP and JME are 
converted to their 
corresponding instructions, 
JMP0 and JME0, 
respectively. 

- For the CV Series, a fixed 
value #0000 is added as an 
operand. 

JME JME JME0 JME0 JME #0000 

FAL (None) FAL 01 Same as before 
conversion 

FAL 01 #FFFF  FAL 001 #FFFF These instructions have 
only one operand for the 
C500/C120/C**P. After 
conversion, a fixed value of 
#FFFF is added as the 
second operand. 

FAL 
00 

FAL 00 FAL 0 FAL 0 #FFFF FAL 000 FAL 000 #FFFF 

FALS FALS 01 Same as before 
conversion 

FALS 01 #FFFF Same as 
before 
conversion 

FALS 001 #FFFF 

SFT SFT 00 01 SFT 0000 0001 SFT 0000 0001 --- 

KEEP KEEP 0000 KEEP 000000 KEEP 000000 --- 

CNTR CNTR 000 #1000 CNTR 0 #1000 CNTR 0000 #1000 --- 

DIFU DIFU 0000 DIFU 000000 DIFU 000000 --- 
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Before conversion After conversion 

C500 
/C120 C**P Example CS/CJ 

Series Example CV Series Example Remarks 

DIFD DIFD 0000 DIFD 000000 DIFD 000000 --- 

TIMH TIMH 002 #0150 TIMH 2 #0150 TIMH 0002 #0150 --- 

WSFT WSFT 01 02 WSFT #0000 0001 0002 WSFT #0000 0001 0002 - This instruction has only 
two operands for the 
C500/C120/C**P. After 
conversion, a fixed value of 
#0000 is added as the first 
operand. 
- After conversion, the first 
operand of the old 
instruction is moved to the 
second operand. 
- After conversion, the 
second operand of the old 
instruction is moved to the 
third operand. 

CMP CMP 00 #0012 CMP 0001 #0012 CMP 0001 #0012 --- 

MOV MOV #0100 05 MOV #0100 0005 MOV #0100 0005 --- 

MVN MVN #0100 05 MVN #0100 0005 MOV #0100 0005 --- 

BIN BIN 10 20 BIN 0010 0020 BIN 0010 0020 --- 

BCD BCD 10 20 BCD 0010 0020 BCD 0010 0020 --- 

ASL  ASL 01 ASL 0001 ASL 0001 --- 

ASR ASR 01 ASR 0001 ASR 0001 --- 

ROL ROL 01 ROL 0001 ROL 0001 --- 

ROR ROR 01 ROR 0001 ROR 0001 --- 

COM COM 00 COM 0000 COM 0000 --- 

ADD ADD 00 #1100 02 +BC +BC 0000 #1100 0002 +BC +BC 0000 #1100 0002 ADD is converted to its 
corresponding instruction, 
+BC. 

SUB SUB 00 #1100 02 -BC -BC 0000 #1100 0002 -BC -BC 0000 #1100 0002 SUB is converted to its 
corresponding instruction, -
BC. 

MUL  MUL 00 #1100 02 *B *B 0000 #1100 0002 *B *B 0000 #1100 0002 MUL is converted to its 
corresponding instruction, 
*B. 

DIV DIV 00 #1100 02 /B /B 0000 #1100 0002 /B /B 0000 #1100 0002 DIV is converted to its 
corresponding instruction, 
/B. 

ANDW ANDW 10 #1001 02 

Same as before 
conversion 

ANDW 0010 #1001 0002 

Same as 
before 
conversion 

ANDW 0010 #1001 0002 --- 

ORW ORW 10 #1001 02 ORW 0010 #1001 0002 ORW 0010 #1001 0002 --- 

XORW XORW 10 #1001 02 XORW 0010 #1001 0002 XORW 0010 #1001 0002 --- 

XNRW XNRW 10 #1001 02 XNRW 0010 #1001 0002 XNRW 0010 #1001 0002 --- 

INC INC 00 ++B ++B 0000 INC 0 For CS/CJ-H PLCs, INC is 
converted to its 
corresponding instruction, 
++B. 

DEC DEC 00 --B --B 0000 DEC 0 For CS/CJ-H PLCs, DEC is 
converted to its 
corresponding instruction, --
B. 

STC STC Same as before 
conversion 

STC STC --- 

CLC CLC CLC CLC --- 

FUN70  FUN70 #0003 01 10 XFERC XFERC #0003 0001 
0010 

XFER XFER #0003 0001 0010 - For CS/CJ-H PLCs, 
FUN70 is converted to its 
corresponding instruction, 
XFERC. 

- For the CV Series, FUN70 
is converted to its 
corresponding instruction, 
XFER. 

FUN71 FUN71 #1000 00 10 BSET BSET #1000 0000 0010 BSET BSET #1000 0000 0010 FUN71 is converted to its 
corresponding instruction, 
BSET. 

FUN72 FUN72 00 10 ROOT ROOT 0000 0010 ROOT ROOT 0000 0010 FUN72 is converted to its 
corresponding instruction, 
ROOT. 

FUN73 FUN73 00 10 XCHG XCHG 0000 0010 XCHG XCHG 0000 0010 FUN73 is converted to its 
corresponding instruction, 
XCHG. 

FUN74 FUN74 00 10 SLD SLD 0000 0010 SLD SLD 0000 0010 FUN74 is converted to its 
corresponding instruction, 
SLD. 
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Before conversion After conversion 

C500 
/C120 C**P Example CS/CJ 

Series Example CV Series Example Remarks 

FUN75 FUN75 00 10 SRD SRD 0000 0010 SRD SRD 0000 0010 FUN75 is converted to its 
corresponding instruction, 
SRD. 

FUN76 FUN76 00 #0021 10 MLPX MLPX 0000 #0021 0010 MLPX MLPX 0000 #0021 0010 FUN76 is converted to its 
corresponding instruction, 
MLPX. 

FUN77 FUN77 00 10 #0012 DMPX DMPX 0000 0010 #0012 DMPX DMPX 0000 0010 #0012 FUN77 is converted to its 
corresponding instruction, 
DMPX. 

FUN78  FUN78 00 #0013 10 SDEC SDEC 0000 #0013 0010 SDEC SDEC 0000 #0013 0010 FUN78 is converted to its 
corresponding instruction, 
SDEC. 

FUN79 FUN79 00 05 10 FDIV FDIV 0000 0005 0010 FDIV FDIV 0000 0005 0010 FUN79 is converted to its 
corresponding instruction, 
FDIV. 

FUN80 FUN80 #0010 05 #1010 DISTC DISTC #10 5 #1010 DIST DIST #0010 0005 #1010 - For CS/CJ-H PLCs, 
FUN80 is converted to its 
corresponding instruction, 
DISTC. 
- For the CV Series, FUN80 
is converted to its 
corresponding instruction, 
DIST. 

FUN81 FUN81 10 #10 20 COLLC COLLC 10 #0010 20 COLL COLL 0010 #0010 0020 - For CS/CJ-H PLCs, 
FUN81 is converted to its 
corresponding instruction, 
COLLC. 
- For the CV Series, FUN81 
is converted to its 
corresponding instruction, 
COLL. 

FUN82 FUN82 #6537 #1515 00  MOVBC MOVBC #6537 #1515 0 MOVB MOVB #6537 #1515 
0000 

- For CS/CJ-H PLCs, 
FUN82 is converted to its 
corresponding instruction, 
MOVBC. 
- For the CV Series, FUN82 
is converted to its 
corresponding instruction, 
MOVB. 

FUN83 FUN83 #0100 #0201 10 MOVD MOVD #100 #201 10 MOVD MOVD #0100 #0201 
0010 

FUN83 is converted to its 
corresponding instruction, 
MOVD. 

FUN84 FUN84 35 10 20 SFTR SFTR 35 10 20 SFTR SFTR 0035 0010 0020 FUN84 is converted to its 
corresponding instruction, 
SFTR. 

FUN85 FUN85 #1000 40 50 TCMP TCMP #1000 40 50 TCMP TCMP #1000 0040 0050 FUN85 is converted to its 
corresponding instruction, 
TCMP. 

FUN87 FUN87 #0050 10 05 IOWR IOWR 10 &0050 0005 WRIT WRIT #0050 0010 0005 - The following message will 
appear for CS/CJ-H PLCs: 
“CONVERT_WARNING: 
The instruction specification 
is different. Check the 
instructions.” Check the 
specifications of CPU Unit 
after conversion. 
- For CJ/CS-H PLCs, 
FUN87 is converted to its 
corresponding instruction, 
IOWR. 
- For CJ/CS-H PLCs, the 
first and second operands 
are interchanged. 
- For CS/CJ-H PLCs, the 
second operand is 
converted from BCD data 
(#0050) to unsigned 
decimal data (&0050). 

      - For the CV Series, FUN87 
is converted to its 
corresponding instruction, 
WRIT. 
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Before conversion After conversion 

C500 
/C120 C**P Example CS/CJ 

Series Example CV Series Example Remarks 

FUN88 FUN88 #0030 15 40 IORD IORD 40 15 &0030 READ READ #0030 0015 0040 - The following message will 
appear for CS/CJ-H PLCs: 
“CONVERT_WARNING: 
The instruction specification 
is different. Check the 
instructions.” Check the 
specifications of CPU Unit 
after conversion. 
- For CJ/CS-H PLCs, 
FUN88 is converted to its 
corresponding instruction, 
IORD. 
- For CJ/CS-H PLCs, the 
first and third operands are 
interchanged. 
- For CS/CJ-H PLCs, the 
third operand is converted 
from BCD data (#0030) to 
unsigned decimal data 
(&0030). 

      - For the CV Series, FUN88 
is converted to its 
corresponding instruction, 
READ. 

FUN90 FUN90 01 10 20 SEND SEND 1 10 20 SEND SEND 0001 0010 0020 - The following message will 
appear: 
“CONVERT_WARNING: 
The instruction specification 
is different. Check the 
instructions.” Check the 
specifications of CPU Unit 
after conversion. 

- FUN90 is converted to the 
corresponding instruction, 
SEND. 

FUN94 FUN94 02 WDT WDT &0020 WDT WDT #0020 - FUN94 is converted to the 
corresponding instruction, 
WDT. 
- In the instructions for 
C500/C120/C**P, the unit of 
the operands is 100 ms. 
After conversion, the unit is 
changed to 10 ms. 
- For CS/CJ-H PLCs, the 
operand is converted from 
NUMBER data (02) to 
unsigned decimal data 
(#0020). 

- For the CV Series, the 
operand is converted from 
NUMBER data (02) to BCD 
data (#0020). 

FUN97 FUN97 10 14 IORF IORF 10 14 IORF IORF 0010 0014 - FUN97 is converted to its 
corresponding instruction, 
IORF. 

FUN98 FUN98 01 10 20 RECV RECV 1 10 20 RECV RECV 0001 0010 0020 - The following message will 
appear: 
“CONVERT_WARNING: 
The instruction specification 
is different. Check the 
instructions.” Check the 
specifications of CPU Unit 
after conversion. 

- FUN98 is converted to its 
corresponding instruction, 
RECV. 

 FUN98 FUN98 10  - The following message will 
appear: 
“CONVERT_ERROR: The 
instruction is not supported 
in the target PLC. Check 
the instruction.” Check the 
specifications of CPU Unit 
after conversion. 
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Memory Area Conversion Table 
The memory addresses used in the operands are automatically converted. 

Memory area 
Before conversion After conversion 

C500/C120 C**P CS/CJ 
Series CV Series Remarks 

IR Area/SR Area 
(CIO Area) 00 to 63 00 to 04 0 to 63 

00 to 31: I/O Area 
32 to 57: IR Area 
58: PC Link Area (IR Area) 
59: Remote I/O Area (IR Area) 
58.00 to 63.07: AR Area 

Temporary Relay 
Area TR0 to TR7 TR0 to TR7 --- 

HR Area (Holding 
Area) HR00 to HR31 HR0 to 9 H0 to H31 1200 to 

1231 --- 

LR Area (Link 
Area) LR00 to LR31 (None) 1000 to 1031 --- 

Timer Area TIM0 to TIM127 TIM0 to 
TIM47 T0 to T127 --- 

Counter Area CNT0 to CNT127 CNT0 to 
CNT47 C0 to C127 --- 

Data Memory 
Area DM000 to DM511 DM0 to 

DM63 D0 to D511 --- 

Data Memory 
Area (indirect 
addressing) 

*DM000 to 
*DM511  *D0 to *D511 --- 

Hexadecimal 
constant  #0000 to #FFFF #0 to #FFFF 

See the Instruction Conversion 
Table. BCD constant  #0000 to #9999 #0 to #9999 

Decimal constant  #0000 to #9999 &0 to &65535 
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Auxiliary Area Conversion Table  
The addresses of the special auxiliary relays used in the operands are automatically converted as shown below. 

Name 
Before conversion After conversion 

C500/C120 C**P CS/CJ Series CV Series 

PC Link Level 1, Units 8 to 15 Run Flags 58.00 to 
58.07 

(None) 

Same as before conversion 

PC Link Level 1, Units 8 to 15 Error 
Flags 

58.08 to 
58.15 

Remote I/O Error Flags 59.00 to 
59.15 

SYSMAC NET Error Flag 60.03 

SYSMAC NET Run Flag 60.04 

SYSMAC NET Data Link Run Flag 60.05 

CPU-mounting Host Link Error Flag 60.08 

CPU-mounting Host Link Restart Bit 60.09 

Data Retention Flag (IOM Hold Bit) 60.12 A500.12 A0.12 

Rack-mounting Host Link Restart Bit 60.13 Same as before conversion 

Load-off control (Output OFF Bit) 60.15 A500.15 P_Output_Off_Bit A0.15 P_Output_Off_Bit 

1 FAL code 61.00 A400.00 

2 FAL code 61.01 A400.01 

4 FAL code 61.02 A400.02 

8 FAL code 61.03 A400.03 

1×10 FAL code 61.04 A400.04 

2×10 FAL code 61.05 A400.05 

4×10 FAL code 61.06 A400.06 

8×10 FAL code 61.07 A400.07 

Battery alarm flag (Battery Error Flag) 61.08 18.08 A402.04 P_Low_Battery 

Scan Time Error Flag 61.09 18.09 A401.08 P_Cycle_Time_Error 

I/O Verification Error Flag 61.10  A402.09 P_IO_Verify_Error 

High-speed Counter Hardware Reset 
Flag (ON for 1 scan only)  18.10 

Same as before conversion 
Rack-mounting Host Link Unit Error Flag 61.11 

 
Remote I/O Error Flag 61.12 A402.05 

Always ON Flag 61.13 18.13 CF113 P_On A500.13 P_On 

Always OFF Flag 61.14 
18.11 
18.12 
18.14 

CF114 P_Off A500.14 P_Off 

First Scan Flag (ON for 1 scan only) 61.15 18.15 A200.15 P_First_Cycle A500.15 P_First_Cycle_Task 

PC Link level 0, Units 0 to 7 Run Flags 62.00 to 
62.07 

 Same as before conversion 
PC Link level 0, Units 0 to 7 Error Flags 62.08 to 

62.15 

0.1-second clock pulse 63.00 19.00 CF100 P_0_1s A501.00 P_0_1s 

0.2-second clock pulse 63.01 19.01 CF101 P_0_2s A501.01 P_0_2s 

1.0-second clock pulse 63.02 19.02 CF102 P_1s A501.02 P_1s 

Error (ER) flag 63.03 19.03 CF003 P_ER A500.03 P_ER 

Carry (CY) Flag 63.04 19.04 CF004 P_CY A500.04 P_CY 

Greater Than (GR) Flag 63.05 19.05 CF005 P_GT A500.05 P_GT 

Equals (EQ) Flag 63.06 10.06 CF006 P_EQ A500.06 P_EQ 

Less Than (LE) Flag 63.07 19.07 CF007 P_LT A500.07 P_LT 
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APPENDIX A 
Toolbars and Keyboard Shortcuts 

The following tables summarize the toolbars and keyboard shortcuts available from CX-Programmer. The F1 
function key provides context help. 

It is possible to redefine the toolbars. It is also possible to drag/drop the toolbar buttons between toolbars, or 
drag buttons off the toolbars to remove them. To do this, hold down the ‘Alt’ key and drag the button. 

It is also possible to redefine the keyboard shortcuts. 

Standard Toolbar 
 

New – creates a new document. 

Open – opens an existing document. 

Save – saves the project. 

Compare – compare the current program to the program in a program file. 

Print – prints the active document. 

Print Preview – previews the printout of the document. 

Cut – cuts the selection and moves it to the Clipboard. 

Copy – copies the selection to the Clipboard. 

Paste – pastes the contents of the Clipboard at the insertion point. 

Undo – undoes the last action. 

Redo – redoes the previously undone action. 

Find – finds the specified text. 

Replace – replaces specified item text with different text. 

Change All – replaces specified address(es) with different address(es) in the PLC. 

About – displays program information. 

Context Help – displays help for clicked on buttons and menu items. 
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Diagram Toolbar 

 

Zoom Out – zooms out the display of the ladder editing window. 

Zoom To Fit – zooms the display to fit ladder program width into the window. 

Zoom In – zooms in the display of the ladder editing window. 

Zoom Reset – Reset the zoom display of the window. 

Grid – toggles the display of the diagram grid. 

Show Comments – toggles the symbol comments On and Off. 

Show Rung Annotations – toggles the rung annotation On and Off. 

Monitor in RungWrap – Wraps the rungs when monitoring. 

Show Program/Section Comments – shows comments on top of the ladder view. 

Multi-Interlock Map – shows the nesting of interlocks. 

Selection Mode – returns to normal mouse selection mode. 

New Contact – creates a new normally open contact. 

New Closed Contact – creates a new normally closed contact. 

New Contact OR – creates a new normally open OR contact. 

New Closed Contact OR – creates a new normally closed OR contact. 

New Vertical – creates a new vertical connection. 

New Horizontal – creates a new horizontal connection. 

New Coil – creates a new normally open coil. 

New Closed Coil – creates a new normally closed coil. 

New PLC Instruction – creates a new PLC instruction call. 

New Function Block Call – creates a new Function Block call in the program. 

New Function Block Parameter – creates a new Function Block parameter of a Function Block cell. 

Line Connect Mode – enables creating connection lines. 

Line Delete Mode – enables deleting lines. 

Insert Toolbar 

 

New PLC – inserts a new PLC into the project. 

New Program – inserts a new program into the PLC program list. 

Insert SFC Program – Creates a new SFC Program. 

Insert ST Program – Creates a new Structured Text Program. 

New Section – inserts a new section into program section list. 

New Symbol – inserts a new symbol into the symbol table. 

New Ladder Function Block – inserts a new Ladder Function Block 
into the Function Block list. 

New Structured Text Function Block – inserts a new Structured Text 
Function Block into the Function Block list. 

Function Block (ladder) generation − Generate Function Block 
(ladder) 
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Symbol Table Toolbar 
 

Large Icons – displays items using large icons. 

Small Icons – displays items using small icons. 

List – displays items as a list. 

Details – displays items as a report. 

Validate Symbols (Selected Item) – checks the current symbol table. 

Validate Symbols (All) – checks all symbol tables in the PLC. 

PLC Toolbar  

 
Work Online – toggles the connection to the selected PLC. 

Toggle PLC Mounting – toggles monitoring for this PLC. 

Work Online Simulator – toggles the connection to the Simulator. 

Auto Online – toggles the connection to the PLC automatically. 

Pause Upon Trigger – begins a pause monitoring operation. 

Pause – toggles monitoring On and Off. 

Transfer to PLC – writes program information into the PLC. 

Transfer from PLC – reads program information from the PLC. 

Compare with PLC – compares program information with the PLC. 

Task Transfer to PLC – writes individual tasks to the PLC. 

Task Transfer from PLC – reads individual tasks from the PLC. 

Compare Task with PLC – compares individual tasks with the PLC. 

Program Mode – switches the PLC into program operation mode. 

Debug Mode – switches the PLC into debug operation mode. 

Monitor Mode – switches the PLC into monitor operation mode. 

Run Mode – switches the PLC into run operation mode. 

Differential Monitor – monitors for a change in a bit. 

Data Trace – traces PLC memory contents. 

Set Password – sets password protection in the PLC. 

Release Password – releases password protection in the PLC. 
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SFC Toolbar 

 

Add Step – Add SFC Step. 

Add Subchart Step – Add SFC Subchart Step. 

Add Entry Step – Add SFC Entry Step. 

Add Return Step – Add SFC Return Step. 

Add Transition – Add SFC Transition. 

Add Divergence – Add SFC Divergence. 

Add Convergence – Add SFC Convergence. 

Add Simultaneous Divergence – Add SFC Simultaneous Sequence Divergence. 

Add Simultaneous Convergence – Add SFC Simultaneous Sequence Convergence.  

Add Connector – Add SFC Connector. 

Program Toolbar 
 

Toggle Monitor Window – toggles monitoring on the active window. 

Compile Program – performs a program check on the program. 

Compile PLC Programs – performs a program check on the PLC programs. 

Begins Online Edit – starts an online-edit operation on the selected rungs. 

Cancel Online-Edit – stops the online-edit, canceling any changes. 

Send Online Edit Changes – transfers the changes made in the online-edit. 

Go to Online Edit Rung – jumps to the top of the online-editing rung. 

Section/Rung Manager – shows a dialog to edit sections and rungs. 

Read Only Mode – sets the program to read-only mode.  

Start Edit (F2) – starts editing in read-only mode. 

Discard the Changes – discharges the changes. 

Store the Changes (Shift + F2) – stores the change.  
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Views Toolbar 

 

Toggle Project Workspace – toggles whether period workspace is on view. 

Toggle Output Window – toggles whether the output window is on view. 

Toggle Watch Window – toggles the watch window On and Off. 

Show Address Reference Tool – toggles the add. ref. tool On and Off. 

Show Properties – shows the item properties window. 

Cross Reference Report – shows the cross reference report window. 

View Local Symbols – shows the local symbol table for the program. 

View Diagram – shows the ladder representation of the program. 

View Mnemonics – shows the mnemonics representation of the program. 

I/O Comment – shows a view to edit comments of addresses. 

Monitor in Decimal – toggles whether monitoring values are shown in decimal. 

Signed Decimal – toggles whether monitoring values are shown in signed decimal. 

Monitor in Hex – toggles whether monitoring values are shown in signed decimal. 

Display Upper Layer – Displays upper layer of FB. 

Display Lower Layer – Displays lower layer of FB. 

Monitor FB Instance – Monitor FB Instance. 

 

ST Views Toolbar 

 

Decrease Line Indent – Decrease the indent of selected lines. 

Increase Line Indent – Increase the indent of selected lines. 

Comment Selection – Comment out the selected line. 

Uncomment Selection – Uncomment out the selected line. 

Toggle Bookmark – Toggle a bookmark on the current line. 

Previous Bookmark – Move the caret to the previous bookmark. 

Next Bookmark – Move the caret to the next bookmark. 

Clear Bookmark– Clear all bookmarks of current document. 
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Keyboard Shortcuts 
Using the Keyboard Mapping feature it is possible to reassign or add new keyboard keys used as short-cuts for 
any of the menu/ tool bar commands. It is also possible to assign several different keys to action a particular 
command. 

The default keyboard mapping can be changed to another major support software. 

Select Keyboard Mapping... from Tools menu and click Remap All button. A selection of support software to 
remap the keyboard will be displayed.  

Selection of support software: CX-Programmer, SYSMAC Support Software, SYSWIN, GPPQ (CX-
Programmer version 9.@ only) 

Default CX-Programmer Keyboard Mappings 
The CX-Programmer supports both the Classic Mode and the Smart Input Mode. 

Classic Mode  

Basic Operations 
Function Menu Shortcut keys 

Show Help Topics  [F1] 
Move cursor up Move cursor up [Up] 
Move cursor down Move cursor down [Down] 
Move cursor right Move cursor right [Right] 
Move cursor left Move cursor left [Left] 
Move cursor beginning of rung Move cursor beginning of rung [Home] 
Move cursor end of rung Move cursor end of rung [End] 
View project workspace [View] | [Window] | [Workspace] [Alt]+[1] 
View Output window [View] | [Window] | [Output] [Alt]+[2] 
View Watch window [View] | [Window] | [Watch] [Alt]+[3] 
View Address Reference Tool [View] | [Window] | [Address Reference Tool] [Alt]+[4] 
Show Rung Annotations [View] | [Show Rung Annotations] [Alt]+[A] 
Show Symbol Comments [View] | [Show Symbol Comments] [Alt]+[Y] 
Next docked window Next docked window [Alt]+[0] 
Previous docked window Previous docked window [Alt]+[Shift]+[0] 
Move next page Move next page [Page Down] 
Move previous page Move previous page [Page UP] 
Delete char/ladder on the left Delete char/ladder on the left [Back space] 
Cancel, quit or close function Cancel, quit or close function [Esc] 
Close Output window None [Esc] 
Select menu None [Alt]+[(underscored letter)] 
New project [File] | [New] [Ctrl]+[N] 
Open Project [File] | [Open] [Ctrl]+[O] 
Close project [File] | [Close] [Alt]+[F4] 
Save project [File] | [Save As...] [Ctrl]+[S] 
Print [File] | [Print] [Ctrl]+[P] 
Undo [Edit] | [Undo] [Ctrl]+[Z] 
Redo [Edit] | [Redo] [Ctrl]+[Y] 
Cut [Edit] | [Cut] [Shift]+[Del], [Ctrl]+[X] 
Copy [Edit] | [Copy] [Ctrl]+[C] 
Paste [Edit] | [Paste] [Ctrl]+[V] 
Delete [Edit] | [Delete] [Del] 
Select All [Edit] | [Select All] [Ctrl]+[A] 

Edit Program 
Function Menu Shortcut keys 

Edit instructions [Edit] | [Edit] [Enter] 
Delete a row [Edit] | [Delete Row] [Ctrl]+[Alt]+[Up] 
Delete a column [Edit] | [Delete Column] [Ctrl]+[Alt]+[Right] 
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Invert (NOT) contacts/coils [Edit] | [Invert (NOT)] [/] 
Immediate Refresh [Edit] | [Immediate Refresh] [!] 
Differentiate Up [Edit] | [Differentiate] | [Up] [@] 
Differentiate Down [Edit] | [Differentiate] | [Down] [%] 
Clear Differentiation [Edit] | [Differentiate] | [None] [Shift]+[0] 
Zoom in [View] | [Zoom in] [Alt]+[Right] 
Zoom out [View] | [Zoom Out] [Alt]+[Left] 
Zoom to Fit [View] | [Zoom to Fit] [Alt]+[Up] 
Show properties [View] | [Properties] [Alt]+[Enter] 
Insert Rung Below [Insert] | [Rung] | [Below] [R] 
Insert Rung Above [Insert] | [Rung] | [Above] [Shift]+[R] 
Insert Row [Insert] | [Row] [Ctrl]+[Alt]+[Down] 
Insert Column [Insert] | [Column] [Ctrl]+[Alt]+[Right] 
Insert Open Contact [Insert] | [Contact] | [Normally Open] [C] 
Insert Closed Contact [Insert] | [Contact] | [Normally Closed] [/] 
Insert Open Contact OR [Insert] | [Contact] | [Normally Open OR] [W] 
Insert Closed Contact OR [Insert] | [Contact] | [Normally Closed OR] [X] 
Insert Horizontal Right [Insert] | [Horizontal Right] [Ctrl]+[Right], [H], [-] 
Insert Horizontal Left [Insert] | [Horizontal Left] [Ctrl]+[Left] 
Insert Vertical Down [Insert] | [Vertical] | [Vertical Down] [Ctrl]+[Down], [V], [|] 
Insert Vertical Up [Insert] | [Vertical] | [Vertical Up] [Ctrl]+[Up], [U] 
Insert Open Coil [Insert] | [Coil] | [Normally Open] [O] 
Insert Closed Coil [Insert] | [Coil] | [Normally Closed] [Q] 
Insert Instruction [Insert] | [Instruction...] [I] 
Compile all PLC programs [PLC] | [Compile All PLC Programs] [F7] 
Compile program [Programs] | [Compile] [Ctrl]+[F7] 
Find [Edit] | [Find] [Ctrl]+[F] 
Replace [Edit] | [Replace] [Ctrl]+[H] 
Change All [Edit] | [Change All] [Ctrl]+[R] 
Go to Rung/Step [Edit] | [Go To] | [Rung /Step Number...] [Ctrl]+[G] 
Go to Rung Comment [Edit] | [Go To] | [Commented Rung] [L], [Alt]+[Shift]+[R] 
Go to next address reference [Edit] | [Go To] | [Next Address Reference] [N], [Alt]+[Shift]+[N] 
Go to Input [Edit] | [Go To] | [Next Input] [Space], [Alt]+[Shift]+[I] 
Go to Output [Edit] | [Go To] | [Next Output] [Space], [Alt]+[Shift]+[O] 
Go to Previous Jump Point [Edit] | [Go To] | [Previous Jump Point] [B], [Shift]+[Space], 

[Alt]+[Shift]+[B] 
Start Edit at Read Only Mode [Edit]|[Read Only Mode Edit]|[Start Edit] [F2] 
Store at Read Only Mode  [Edit]|[Read Only Mode Edit]|[Store] [Shift]|[F2] 

Find and Replace 
Function Menu Shortcut keys 

Find [Edit] | [Find] [Ctrl]+[F] 
Replace [Edit] | [Replace] [Ctrl]+[H] 
Change All [Edit] | [Change All] [Ctrl]+[R] 
Go to Rung/Step [Edit] | [Go To] | [Rung /Step Number...] [Ctrl]+[G] 
Go to Rung Comment [Edit] | [Go To] | [Commented Rung] [L], [Alt]+[Shift]+[R] 
Go to next address reference [Edit] | [Go To] | [Next Address Reference] [N], [Alt]+[Shift]+[N] 
Go to Input [Edit] | [Go To] | [Next Input] [Space], [Alt]+[Shift]+[I] 
Go to Output [Edit] | [Go To] | [Next Output] [Space], [Alt]+[Shift]+[O] 
Go to Previous Jump Point [Edit] | [Go To] | [Previous Jump Point] [B], [Shift]+[Space], 

[Alt]+[Shift]+[B] 

 

Online 
Function Menu Shortcut keys 

Work on-line [PLC] | [Work Online] [Ctrl]+[W] 
Work on-line to Simulator [PLC] | [Work Online Simulator] [Ctrl]+[Shift]+[W] 
Program mode [PLC] | [Operating Mode] | [Program] [Ctrl]+[1] 
Debug mode [PLC] | [Operating Mode] | [Debug] [Ctrl]+[2] 
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Monitor (PLC execution-mode) [PLC] | [Operating Mode] | [Monitor] [Ctrl]+[3] 
Run mode [PLC] | [Operating Mode] | [Run] [Ctrl]+[4] 
Monitoring (PLC level toggle) [PLC] | [Monitor] | [Monitoring] [Ctrl]+[M] 
Transfer to PLC [PLC] | [Transfer] | [To PLC...] [Ctrl]+[T] 
Transfer from PLC [PLC] | [Transfer] | [From PLC...] [Ctrl]+[Shift]+[T] 
Force on [PLC] | [Force] | [On] [Ctrl]+[J] 
Force off [PLC] | [Force] | [Off] [Ctrl]+[K] 
Cancel force [PLC] | [Force] | [Cancel] [Ctrl]+[L] 
Begin on-line edit [Programs] | [Online Edit] | [Begin] [Ctrl]+[E] 
Send on-line edit changes [Programs] | [Online Edit] | [Send Changes] [Ctrl]+[Shift]+[E] 
Cancel on-line edit [Programs] | [Online Edit] | [Cancel] [Ctrl]+[U] 

 

 Smart Input Mode 
Program Editing  

Input item Smart Input Mode Classic Mode 
Insert Open Contact L (LD), A (AND) C C 

Insert Closed Contact L (LDNOT ) A (ANDNOT) / / 

Insert Open Contact OR O (OR) W W 

Insert Closed Contact OR O (ORNOT) X X 

Insert Open Coil O (OUT) O O 

Insert Closed Coil O (OUTNOT) Q Q 

Insert Rung Below Press “R” and select Insert Rung Below. R 

Insert vertical connecting line above Shift+U U 

Insert vertical connecting line below Shift+V V 

Insert horizontal connecting line Shift+H H 

Differentiate Up @ @ 

Differentiate Down % % 

Immediate Refreshing ! ! 

Clear Differentiation Shift+0 Shift+0 

Shortcut Keys That Differ from Classic Mode  
Action Smart Input Mode Classic Mode 

Edit Rung Comment Shift+L L 

Go to error Shift+J J 

Go to Next Address Reference Shift+N N 

Go to Previous Jump Point Shift+B B 

 

Default SYSMAC Support Soft Keyboard Mapping 

Basic operations 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function Menu Shortcut keys 
View project workspace [View] | [Window] | [Workspace] [Ctrl]+[F11], [Alt]+[1] 
View Output window [View] | [Window] | [Output] [Ctrl]+[F12], [Alt]+[2] 
View Watch window [View] | [Window] | [Watch] [Ctrl]+[F10], [Alt]+[3] 
View Address Reference Tool [View] | [Window] | [Address Reference Tool] [Shift]+[F12], [Alt]+[4] 
Show Rung Annotations [View] | [Show Rung Annotations] [Alt]+[F8], [Alt]+[A] 
Show Symbol Comments [View] | [Show Symbol Comments] [Alt]+[F9], [Alt]+[Y] 
Undo [Edit] | [Undo] [Ctrl]+[F3], [Alt]+[F11], [Ctrl]+[Z] 
Redo [Edit] | [Redo] [F3], [Ctrl]+[Y] 
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Edit Program 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function Menu Shortcut keys 
Delete a column [Edit] | [Delete Column] [Shift]+[F3], [Ctrl]+[Alt]+[Right] 
Invert (NOT) contacts/coils [Edit] | [Invert (NOT)] [F9], [/] 
Insert Column [Insert] | [Column] [Shift]+[F2], [Ctrl]+[Alt]+[Right] 
Insert Open Contact [Insert] | [Contact] | [Normally Open] [F4], [F5], [C] 
Insert Closed Contact [Insert] | [Contact] | [Normally Closed] [Shift]+[F5], [/] 
Insert Open Contact OR [Insert] | [Contact] | [Normally Open OR] [F5], [W] 
Insert Closed Contact OR [Insert] | [Contact] | [Normally Closed OR] [Shift]+[F5], [X] 
Create a new SET function None [Shift]+[F8] 
Create a new RSET function None [Shift]+[F9] 
Insert Horizontal Right [Insert] | [Horizontal Right] [F8], [Ctrl]+[Right], [H], [-] 
Insert Vertical Up [Insert] | [Vertical] | [Vertical Up] [F6], [Ctrl]+[Up], [U] 
Insert Open Coil [Insert] | [Coil] | [Normally Open] [F7], [O] 
Insert Closed Coil [Insert] | [Coil] | [Normally Closed] [Shift]+[F7], [Q] 
Insert Instruction [Insert] | [Instruction...] [F10], [Shift]+[F10], [I] 
Edit rung comment [Edit] | [Edit Rung Comment] [Alt]+[F12] 
Compile all PLC programs [PLC] | [Compile All PLC Programs] [Ctrl]+[F8] 
Edit Section/Rung Manager [Program] | [Section/Rung Manager] [Ctrl]+[F10] 
Store at Read Only Mode [Edit]|[Read Only Mode Edit]|[Store] [F3] 

Find and Replace 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function Menu Shortcut keys 
Find [Edit] | [Find] [Shift]+[F3], [Ctrl]+[F] 

Online 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function Menu Shortcut keys 
Monitor in RungWrap [View] | [Monitor in RungWrap] [Shift]+[F11] 
Monitor in Hex [View] | [Monitor In Hex] [Alt]+[F10] 
Force on [PLC] | [Force] | [On] [Alt]+[F2], [Ctrl]+[J] 
Force off [PLC] | [Force] | [Off] [Alt]+[F3], [Ctrl]+[K] 
Cancel (Forced on or off) [PLC] | [Force] | [Cancel] [Alt]+[F5], [Ctrl]+[L] 
Cancel All Forces [PLC] | [Force] | [Cancel All Forces] [Alt]+[F7] 

Default SYSWIN Keyboard Mapping 

Basic Operations 
Function Menu Shortcut keys 

Open Project [File] | [Open] [Shift]+[F2], [Ctrl]+[O] 
Save project [File] | [Save] [Shift]+[F3], [Ctrl]+[S] 

Edit Program 
Function Menu Shortcut keys 

Delete a row [Edit] | [Delete Row] [Shift]+[F7], [Ctrl]+[Alt]+[Up] 
Zoom to Fit [View] | [Zoom to Fit] [Alt]+[Up] 
Insert Open Contact [Insert] | [Contact] | [Normally Open] [F2], [C] 
Insert Closed Contact [Insert] | [Contact] | [Normally Closed] [F3], [/] 
Insert Horizontal Right [Insert] | [Horizontal Right] [F4], [Ctrl]+[Right], [H], [-] 
Insert Vertical Down [Insert] | [Vertical] | [Vertical Down] [F5], [Ctrl]+[Down], [V], [|] 
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Insert Open Coil [Insert] | [Coil] | [Normally Open] [F6], [O] 
Insert Closed Coil [Insert] | [Coil] | [Normally Closed] [F7], [Q] 
Insert Instruction [Insert] | [Instruction...] [F8], [F9], [F10], [I] 
Compile all PLC programs [PLC] | [Compile All PLC Programs] [Shift]+[F8] 
Open Section/Rung Manager [Programs] | [Section/Rung Manager...] [Ctrl]+[F5] 
Edit Rung Comment [Edit] | [Edit Rung Comment] [Ctrl]+[F7] 
Show as Statement List [Edit] | [Rung] | [Mnemonics] [Ctrl]+[F8], [Ctrl]+[Alt]+[S] 

Find and Replace 
Function Menu Shortcut keys 

Edit rung comment [Edit] | [Go To] | [Commented Rung] [Shift]+[F5], [L], [Alt]+[Shift]+[R] 

Online 
Function Menu Shortcut keys 

Work on-line [PLC] | [Work Online] [Shift]+[F9], [Ctrl]+[W] 
Monitoring (PLC level toggle) [PLC] | [Monitor] | [Monitoring] [Ctrl]+[F11] 

Default GPPQ Keyboard Mapping (CX-Programmer Ver. 9.@ Only) 

Basic Operations 
The shortcuts for all basic operations are the same as the defaults for the CX-Programmer. 

Edit Program 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function  Menu Shortcut keys 
Edit Row Comment [Edit] | [Row Comment] [Shift]+[F10]  
Insert Open Contact Classic Style [Insert] | [Contact] | [Normally Open] [F5], [C] 
 Smart Style ---  
Insert Closed Contact Classic Style [Insert] | [Contact] | [Normally Closed] [F6], [/] 
 Smart Style ---  
Insert Open Contact OR Classic Style [Insert] | [Contact] | [Normally Open 

OR] 
[Shift]+[F5], [W] 

 Smart Style ---  
Insert Closed Contact OR Classic Style [Insert] | [Contact] | [Normally Closed 

OR] 
[Shift]+[F6], [X] 

 Smart Style ---  
Insert Horizontal Right Classic Style [Insert] | [Horizontal Right] [F9], [Ctrl]+[Right], [H], 

[-]  Smart Style --- 
Insert Vertical Down Classic Style [Insert] | [Vertical] | [Vertical Down] [Shift]+[F9], 

[Ctrl]+[Down], [V], [|]  Smart Style --- 
Delete Horizontal Connection --- [Ctrl]+[F9]  
Delete Vertical Connection --- [Ctrl]+[F10]  
Insert Open Coil Classic Style [Insert] | [Coil] | [Normally Open] [F7], [O] 
 Smart Style ---  
Insert Instruction Classic Style [Insert] | [Instruction...] [F8] 
 Smart Style ---  
Compile all PLC programs Classic Style [PLC] | [Compile All PLC Programs] [F4] 
 Smart Style ---  
Compile program  [Programs] | [Compile] --- 
Show Symbols Comments Classic Style [View] | [Show Symbol Comments] [Ctrl]+[F5]  
 Smart Style [View] | [Ladder Information] | [Show 

Symbol Comments] 
 

Show Rung Annotations Lists Classic Style [View] | [Show Rung Annotations Lists] [Ctrl]+[F8]  
 Smart Style [View] | [Ladder Information] | [Show 

Rung Annotations Lists] 
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Find and Replace 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function Menu Shortcut keys 
Go to Rung Comment [Edit] | [Go To] | [Commented Rung] [Ctrl]+[F7], [Shift]+[L], 

[Alt]+[Shift]+[R] 

Online 
Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer. 

Function Menu Shortcut keys 
Force ON [PLC] | [Force] | [On] [Alt]+[F2], [Ctrl]+[J] 
Force OFF [PLC] | [Force] | [Off] [Alt]+[F3], [Ctrl]+[K] 
Cancel Force [PLC] | [Force] | [Cancel] [Alt]+[F5], [Ctrl]+[L] 
Cancel All Forces [PLC] | [Force] | [Cancel All Forces] [Alt]+[F7] 
Monitor in Hex [View] | [Monitoring Data Type] | [Monitor In 

Hex] 
[Alt]+[F10], [Alt]+[Shift] + [H] 

Monitor in Decimal [View] | [Monitoring Data Type] | [Decimal] [Alt]+[F11] 
Monitor in Signed Decimal [View] | [Monitoring Data Type] | [Signed 

Decimal] 
[Alt]+[F12] 
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APPENDIX B 
EtherNet/IP Connections from Windows XP or later OS 

Better firewall security for Windows XP or later OS has increased the restrictions for data communications on 
Ethernet ports. When using an EtherNet/IP connection*1 to one of the following PLCs from an Ethernet port on 
a computer, you must change the settings of the Windows Firewall to enable using CX-Programmer 
communications.  

Applicable PLCs:  • CJ2H-CPU6@-EIP 

 • CJ2M-CPU3@ 

 • CS1W/CJ1W-EIP@@ 
 

Note1: An EtherNet/IP connection includes the following cases: 
• An online connection with the network type set to EtherNet/IP 

• An automatic online connection to a PLC on an EtherNet/IP network when Auto 
Online - EtherNet/IP Node Online is selected from the PLC Menu 

Note: The Windows Firewall is mainly designed to prevent inappropriate access from 
external devices (e.g., via the Internet). The changes to the Windows Firewall settings 
described in this document enable EtherNet/IP connections to be used by the CX-
Programmer. If the same computer is being used on a company network or other 
network, confirm that the changes will not create security problems before proceeding 
with the changes. The changes described in this document are required only when you 
connect using EtherNet/IP through an Ethernet port. No changes are necessary if you 
are connecting through any other port, such as a USB port. 

Changing Windows Firewall Settings 
Windows XP 
1. When you attempt to connect the CX-Programmer to a PLC on an EtherNet/IP network through an Ethernet 

port, the Windows Security Alert Dialog Box will be displayed. 

2. Click the Unblock Button. 
 

 
An EtherNet/IP connection will be accepted from CX-Programmer and EtherNet/IP connections will be 
enabled in the future as well. 

Windows Vista or later OS 
Use the following procedure to change the settings before attempting to connect from the CX-Programmer. 
The User Account Control Dialog Box may be displayed during this procedure. If it appears, click the Continue 
Button and continue with the procedure. 
1. Select Control Panel from the Windows Start Menu and change the display to Classic View. 

 

 
2. Open the Administrative Tools and select Windows Firewall with Advanced Security from the dialog box that 

is displayed.  
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3. Select Inbound Rules under Windows Firewall with Advanced Security on Local Computer on the left side of 
the Windows Firewall with Advanced Security Dialog Box. 
 

 
4. Select New Rule under Inbound Rules in the Actions Area on the right side of the dialog box.  

 

 
5. Make the following settings for each step in the New Inbound Rule Wizard Dialog Box, clicking the Next 

Button to move between steps.  

Rule Type  . Select Custom. 

Program Select All Programs. 

Protocol and Ports Select ICMPv4 as the protocol type.  

 
Scope Select Any IP address for everything. 

Action Select Allow the connection. 

Profile Select Domain, Private, and Public. 

Name Enter any name, e.g., Omron_EIP. 

6. Click the Finish Button. The rule that you defined will be registered in the Inbound Rules (e.g., Omron_EIP). 
 

 
7. Close the Windows Firewall with Advanced Security Dialog Box. 
8. When you attempt to connect the CX-Programmer to a PLC on an EtherNet/IP network through an Ethernet 

port, the Windows Security Alert Dialog Box will be displayed.  

9. Click the Unblock Button. 
 

 
An EtherNet/IP connection will be accepted from CX-Programmer and EtherNet/IP connections will be 
enabled in the future as well. 
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APPENDIX C 
Smart Input Mode 

Input Procedure in Smart Input Mode 
The following example shows how to input instructions in Smart Input Mode. 
(I/O comments are not input in this example. For details on how to input I/O comments, refer to Displaying and 
Selecting from Candidate Operands below.)  

Inputting Bits 
Example: Inputting LD 0.00 

1, 2, 3… 1. Press the L Key. 
A list of the instructions starting with “L” will be displayed.  

  
 2. Press the Enter Key or the Space Key. 

The top instruction in the list (LD) will be entered, and a candidate operand will be 
displayed.  

  
 Note: If the first candidate is OK, the operand can be input immediately, without inputting the Enter or 

Space Key.  
 3. Select a candidate operand or input the operand and then press the Enter Key. Address 

0.00 will be entered, and “LD 0.00” will be input in the ladder diagram.  

  
 Note: When inputting addresses directly for contact operands, the rightmost two digits will be 

automatically taken as the bit address if there is no period in the address.  
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Inputting Special Instructions  
Example: Entering MOV D0 D100  

1, 2, 3… 1. Press the M Key. 
A list of the instructions starting with “M” will be displayed.  

  
 2. Press the Enter Key or the Space Key. 

The top instruction in the list (MOV) will be entered, and the first operand will be 
displayed.  

  
 Note: If the first candidate is OK, the operand can be input immediately, without inputting the Enter or 

Space Key.  
 3. Enter “D0” and press the Enter Key or the Space Key. 

“MOV D0” will be entered, and the second operand will be displayed.  

  
 4. Enter “D100.” 

“MOV D0 D100” will be entered. 
(If necessary, you can go back one character at a time by pressing the Back Space Key.)  
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 5. Press the Enter Key 
“MOV D0 D100” will be entered in the ladder diagram.  

  
 

Displaying and Selecting from Candidate Operands  
Displaying Candidate Operands  
The display of candidate operands for inputs in the Smart Input Mode is divided into three areas, as shown 
below.  

 
1 

2 

3 

 
 

Area Description 

1 This area is used to select, input, and confirm the instruction or address candidate.  

If an instruction is input, a candidate address will also be automatically displayed for the operand.  

The address will be one higher than the address that was last input.   

Example: After W0.01 is input as a contact, the address candidate for the next contact that is input 
will be W0.02.   

Note: Contact inputs will be incremented from CIO 0.00 (word CIO 0) and contact outputs will be 
incremented from CIO 100.00 (word CIO 100).   

Also, if there is more than one other instance of the instruction that is being input in the same circuit, the 
difference will be taken between the operand addresses of the other instructions and it will be added to the 
address of the most recently input instruction.   

Example 1: If contact inputs CIO 0.00 and CIO 0.02 are input, the address candidate for the next 
contact that is input will be CIO 0.04.   

Example 2: If MOV D100 D200 is input, the candidate addresses for the next MOV instruction will be 
D101 D201.   

If the operand is a constant, the same value as the most recently input instruction will be automatically 
displayed for the operand.  

2 When a bit address is input, “Auxiliary Relay Area” is displayed here. If you move the cursor to “Auxiliary 
Relay Area” and press the Enter Key, a Condition Flag or a list of previously registered Auxiliary Bits will 
be displayed in area 3 as candidates.  

3 When a bit address is input, the symbols that were previously registered in the symbol table by the user 
will be displayed in order of addresses (or in alphabetical order by name). 

Selecting from Candidate Operands  
• Selecting a Condition Flag or Auxiliary Bit  
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1, 2, 3… 1.  Press the ↓ Key to move the cursor to “Auxiliary Relay Area” in area 2.  

 2. Press the Enter Key. 
A list of possibilities will be displayed in area 3.   

 3. Move the cursor to an item in the list to select it.  

• Selecting a Symbol or Address Registered by the User  
1, 2, 3… 1. Press the ↓ Key to move the cursor to “Auxiliary Relay Area” in area 2.  

 2. Move the cursor to an item in the list in area 3 to select it.  
If the order of candidate operands is Symbol name – Address – Comment, the range of 
candidate symbol names will be automatically narrowed down when the first character of 
a symbol name is input.  

  

For example, when “L” is input,  
the range of possible symbols will be 
automatically narrowed down to 
symbol names starting with “L,” and 
only those symbols will be displayed in 
the list of user-registered symbols. 
 

 
 

 

Changing the Display of Candidate Operands  
You can change the display of candidate operands in the Options - Diagrams Dialog Box, as shown below. 
(Select Options from the Tools Menu to display the Options - Diagrams Dialog Box)  

Selecting Displays with or without I/O Comments  
The following dialog box for inputting an I/O comment is displayed by default after an address is input.  

 
 
To program without inputting I/O comments, clear the I/O Comments Option in the Ladder Diagram Options 
Dialog Box. The dialog box for inputting comments will then be hidden.  

Order of Display of Candidate Operands  
In the Parameter List in the Ladder Diagram Options Dialog Box, you can select any of the following orders for 
displaying candidate operands.  

• Symbol name – Address – Comment  
• Address – Symbol name – Comment (default)  
• Address – Comment  
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APPENDIX D  
Previous Version Upgrade Information 
 

Version 8.3 Upgrade Information 
Functionality Improved from Version 8.2 to 8.3  

 Compatible PLC Models  
The functionality improvements are supported for CJ2H CPU Units with unit version 1.2 or later.  

 TIMER and COUNTER Added as Symbol Data Types  
Previous version (version 8.2)  New version (version 8.3) 

When defining timer numbers and counter 
numbers as symbols, the following three different 
symbols had to be registered in the symbols 
table.  

1. Timer numbers and counter numbers 
specified in instruction operands had to 
be defined as NUMBER symbols.  

2. Timer and Counter Completion Flags 
had to be defined as BOOL symbols.  

3. Timer and counter present values had 
to be defined as CHANNEL symbols.  

TIMER and COUNTER symbols are supported 
so that all of the previous three types of symbols 
can be managed as one data type. (TIMER and 
COUNTER are supported only by CJ2H CPU 
Units with unit version 1.0 or later.)  
TIMER: Can be used for 1) the timer number, 2) 
the Timer Completion Flag, and 3) the timer 
present value.  
COUNTER: Can be used for 1) the counter 
number, 2) the Counter Completion Flag, and 3) 
the counter present value.  

Automatically assigning timer and counter 
numbers in ladder programs was not possible.  

Automatic address assignment and layout are 
supported for TIMER and COUNTER symbols.  
(TIMER and COUNTER are supported only by 
CJ2H CPU Units with unit version 1.0 or later.)  

 Force-setting/resetting Bits in EM Area  
Previous version (version 8.2)  New version (version 8.3) 

Bits in the EM Area could be force-set/reset in 
CJ2H CPU Units only for specific EM Area banks 
for which automatic address assignment was 
used.  

With CJ2H CPU Units with unit version 1.2 or 
later, PLC − Memory Allocate − EM Memory 
Settings can be used to specify the EM Area 
banks for which bits can be force-set/reset. (The 
first bank is specified and force-setting/resetting 
bits is possible in that bank and all banks 
following it.) This is called the EM Area force-
setting/resetting function.  

 Searching for Symbol Names and Displaying Usage Locations from Cross-reference Pop-ups 
Previous version (version 8.2)  New version (version 8.3) 

Searching from cross-reference pop-ups was 
possible only for address specifications. (To 
search for symbols, you had to click the Browse 
button and search for symbol names from the 
Symbol Search Dialog Box.)  

Symbol names can be specified directly in cross-
reference pop-ups to display a list of locations 
that use the address of that symbol.  
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Version 8.2 Upgrade Information 
Functionality Improved from Version 8.1 to 8.2 

 Connecting Online to the PLC through an NV-series PT* 
Previous version (version 8.1)  New version (version 8.2) 

It was not possible to connect online from the 
CX-Programmer through an NV-series PT to a 
PLC connected to the NV-series PT. 

It is now possible to connect online from the CX-
Programmer through an NV-series PT to a PLC 
connected to the NV-series PT. 

*Functionality improved in version 8.21 over version 8.20. 

 CP1E CPU Unit Supported for Connecting Online to a PLC via an NS-series PT 
Previous version (version 8.1) New version (version 8.2) 

With a CP1E CPU Unit, it was not possible to 
connect online from the CX-Programmer through 
an NS-series PT to a PLC connected to the NS-
series PT. 

With a CP1E-N@@D@-@ CPU Unit, it is now 
possible to connect online from the CX-
Programmer through an NS-series PT to a PLC 
connected to the NS-series PT. 

 Compatible PLC Models 
The functionality improvements are supported for CP-series CP1E CPU Units with unit 
version 1.0. 

 Online Connection to the PLC via an NS-series PT 
Previous version (version 8.1) New version (version 8.2) 

An online connection from the CX-Programmer 
through an NS-series PT to a PLC connected to 
the PT was not possible. 

An online connection from the CX-Programmer 
through an NS-series PT to a PLC connected to 
the PT is possible when the PLC is connected to 
the PT using a serial connection, Ethernet 
connection, or Controller Link connection. 

 
 

Version 8.1 Upgrade Information 
Functionality Improved from Version 8.0 to 8.1 

 Compatible PLC Models 
The functionality improvements are supported for CJ-series CJ2 CPU Units (CJ2H-
CPU6@(-EIP)) with unit version 1.1. 

 Support for Synchronous Unit Operation 
Support has been added for the synchronous unit operation function for a combination 
of a CJ-series CJ2 CPU Unit (CJ2H-CPU6@ (-EIP)) with unit version 1.1 and CJ-
series Position Control Units (CJ1W-NC@@4). Settings and monitoring are now 
possible for synchronous unit operation. 

 Improved Special I/O Unit and CPU Bus Unit Setup Functionality 
Multiple dialog boxes can now be opened simultaneously when setting CJ-series 
Position Control Unit (CJ1W-NC@@4) parameters. In addition, the CAM Data Creation 
Software (WS02-MOPC2) can be used to convert cam data in a CSV file into data that 
can be used by a Position Control Unit, and the data can be imported to the PLC 
memory component of the CX-Programmer. 
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 Improved CS/CJ Data Tracing Function 
• Improved Trace Settings 

With support for the synchronous unit operation function of CJ2 CPU Units with unit 
version 1.1, tracing can now be executed for each synchronous cycle. 

• Improved Bit Graph Display  
Bit graphs are displayed according to screen size, and addresses are displayed beside the graphs. 
 

Version 8.0 Upgrade Information 

Functionality Improved from Version 7.2 to 8.0 

Support has been added for the following PLC models as part of the version 7.2 to version 7.3 

upgrade. 

 Compatible PLC Models 
New CP-series CP1L CPU Units 
The CP-series CP1L CPU Units (CP1L-L10D@-@ and CP1L-M60D@-@) are supported. 

 

The following functions have been added or improved as part of the upgrade from version 7.3 to 8.0. 

 Compatible PLC Models 
CJ-series CJ2 CPU Units 
The CJ-series CJ2 CPU Units (CJ2H-CPU6@-EIP) are supported. 
• EtherNet/IP 

Connection is possible to the CJ2H-CPU6@-EIP and EtherNet/IP Units. 
• New Ladder Programming Instructions 

The new instructions for the CJ2 CPU Units can be used, including the Tracking 
Instructions and Data Search/Sort Instructions. 

 Improved Data Trace Function 
Overhaul of Data Tracing Function for CS/CJ-series PLCs 
If a CJ2 CPU Unit is used, long-term continuous data tracing is possible.  Operations 
have been improved, including zooming in and out of trace results graphs and 
adjusting offsets. Trace results can also be printed or saved as bit maps. 

 PLC Backups 
Data from the CPU Unit, Special I/O Units, and CPU Bus Units can be backed up as a 
batch from a personal computer. The backup data can be compared or restored as a 
batch, or the data for only selected Units can be restored. 
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 Improvements in Programming 

• Symbols in Array Variable Subscripts. 
Previous version (version 7.2) New version (version 8.0) 

Symbols could be used for array variable 
subscripts only inside function blocks. 

With a CJ2 CPU Unit, symbols can be used for array variable 
subscripts in ladder diagram programming in tasks. 

 

• Address Offsets 
Previous version (version 7.2) New version (version 8.0) 

 With a CJ2 CPU Unit, an offset value can be input to offset a 
specific bit or word address in ladder diagram programming. 

 

• DM/EM Bit Addresses 
Previous version (version 7.2) New version (version 8.0) 

Only word addresses could be used in the EM 
and DM Areas. 

With a CJ2 CPU Unit, bit addresses can be specified in the EM and 
DM Areas. 

 

 Improvements to Online Functions 
With a CJ2 CPU Unit, you can easily connect to a PLC on an EtherNet/IP network. 

 Improvements to Monitoring 
When registering an array variable in the Watch Window, it is now possible to register 
and monitor a selected range of array elements. 

 Improvements to Symbol Tables 
It is now possible to edit data items (i.e., arrange or delete) when copying and pasting 
variable table data via the clipboard from external applications. It is also possible to set 
the contents of symbol table data to be copied to the external application in advance 
using option settings. 

 
 Other Improvements 

Previous version (version 7.2) New version (version 8.0) 
The error log of the CPU Unit only displayed 
the error code. 

In the error log of the CPU Unit, a code which gives more detailed 
information about the error is displayed in addition to the error code. 

 

Version 7.2 Upgrade Information 
Functionality Improved from Version 7.0 to Version 7.2 

Support has been added for the following PLC models as part of the version 7.0 to version 7.10 
upgrade. 

 Compatible PLC Models 
The high-speed CJ1-H-R CPU Units (CJ1-CPU@@H-R) are supported. 

 

Support has been added for the following PLC models as part of the upgrade from version 7.10 to 7.11. 

 Compatible PLC Models 
The CP-series CP1L CPU Units (CP1L-M and CP1L-L) are supported. 

 

The following functions have been added or improved as part of the upgrade from version 7.11 to 7.2. 
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 Improved IEC 61131-3 Language Support 
Support has been strengthened for the ST and SFC languages, which are IEC 61131-
3 languages. 
Ladder, ST, and SFC programs can be combined freely, so the user program can be 
written in the language most appropriate for the required processing. Using the most 
appropriate language can reduce program development time and simplify 
programming. 

• Support for ST Language Programming in Tasks 
Previous version (version 7.0) New version (version 7.2) 

The ST language could be used only in function 
blocks. 

The ST language can be used in programs other than function 
blocks. (ST programs can be allocated to tasks.) 
Different languages can be used in a single user program, which 
allows numerical processing and string processing to be written in 
ST programs, while other processing is written in ladder or SFC 
programs. 
Note: The ST language is supported only in CS/CJ-series CPU 

Units with unit version 4.0 or later. It is not supported in CP-
series CPU Units. 

 

• Support for SFC Language Programming in Tasks 
Previous version (version 7.0) New version (version 7.2) 

The SFC language could not be used. The SFC language can be used in programs. (SFC programs can 
be allocated to tasks.) 
Different languages can be used in a single user program, which 
allows the overall system processing to be written in SFC programs, 
while other processing is written in ladder or ST programs. 
Note: The SFC language is supported only in CS/CJ-series CPU 

Units with unit version 4.0 or later. It is not supported in CP-
series CPU Units.  

 
• Support for Array Variables in Ladder, ST, and SFC Programs 

Previous version (version 7.0) New version (version 7.2) 
Array variables could be used for internal 
variables and input-output variables in a 
function block’s algorithm, but array variables 
could not be used in programs (tasks). 

Array variables can be specified even in programs (tasks) written in 
ladder, ST, or SFC language. 
This feature allows multiple variables with the same data 
characteristics to be managed as a group. 

 

• Comparing Function Block Definitions 
Previous version (version 7.0) New version (version 7.2) 

Function block definitions could not be 
compared. 

Function block definitions can be compared in detail. 
This feature makes it easy to check for differences between the 
programs in function block definitions.  

 
• Comparison of Function Block Definitions, ST Programs, and Action Programs/Transition 

Programs/Subcharts in SFC Programs 
Previous version (version 7.0) New version (version 7.2) 

ST programs and SFC programs could not be 
compared.  

ST programs and SFC programs can be compared. 
ST programs in an SFC program can also be compared in detail.  

 

 PLC-PT Integrated Simulation 
The following improvements have been made to the simultaneous interactive 
debugging function (integrated simulation), which debugs operation between the CX-
Programmer’s ladder program and NS-series PT touch panel test screens in the CX-



PART 1: CX-Programmer 
APPENDIX D – Previous Version Upgrade Information OMRON 
 
 

CX-Programmer _Page 178  

Designer. 

• Starting Integrated Simulator from the CX-Programmer 
Previous version (version 7.0) New version (version 7.2) 

The integrated simulator could be started from 
the CX-Designer only; it could not be started 
from the CX-Programmer. 

The integrated simulator can be started from the CX-Programmer 
(specifying a saved CX-Designer screen file). 
With this feature, it is possible to easily confirm the interaction 
between a ladder program being edited in the CX-Programmer and 
NS-series PT touch panel test screens. 

 
• Simulating the Occurrence of PLC Errors 

Previous version (version 7.0) New version (version 7.2) 
During simulation, it was not possible to 
generate PLC system errors by manipulating 
the corresponding Auxiliary Area flags. (The 
system error flags were write-protected.) 
It was necessary to create ladder programming 
that generated errors using the FAL and FALS 
instructions, and check operation in the 
simulation. 

PLC system errors can be generated during CX-Programmer ladder 
program simulation by selecting Simulation - PLC Error Simulator 
and writing the corresponding system error flags in the Auxiliary 
Area. 
 With this feature, it is not necessary to create ladder programming 
to generate errors. Also, it is easy to check the operation of the 
ladder program and NS-series touch panel when PLC errors occur. 

 
 Improvements to Symbol Tables 
• Improved Interaction of the CX-Designer with Symbol Table Data 

Previous version (version 7.0) New version (version 7.2) 
Symbol tables could be copied and pasted from 
the CX-Programmer to the CX-Designer, but 
not the opposite direction. 
Consequently, when NS-series touch panel test 
screens were being edited in the CX-Designer 
and I/O comments were edited in the CX-
Designer symbol table, it was necessary to 
write the data in Excel and transfer it to the CX-
Programmer’s symbol table. 

Symbol tables can be copied in pasted in both directions between 
the CX-Designer and CX-Programmer. 
This feature makes it easy to reflect changes to the CX-Designer’s 
symbol table, such as edited I/O comments, in the CX-
Programmer’s symbol table. 

• Support for the STRING Data Type in Ladder Programs and ST Programs 
Previous version (version 7.0) New version (version 7.2) 

The STRING data type could be used only in 
ST-language function blocks. 

The STRING data type can be used in both ladder and ST 
languages, in both task programs and function blocks. 
The STRING data type supports ASCII characters between 1 and 
255. 

 
 Improved Automatic Online Connection 
• Added Automatic Detection of the Computer’s Serial Port 

Previous version (version 7.0) New version (version 7.2) 
When automatic online connection was 
performed from the computer’s serial port, it 
was not necessary for the user to set the PLC 
model because it was recognized automatically, 
but the serial port had to be set in advance. 

It is not necessary for the user to select the computer’s serial port in 
advance. 
When automatic online connection is performed, the software 
automatically searches for computer serial ports that can be used. If 
the software finds a serial port that can be used for the online 
connection, the software automatically connects online from the 
detected port, and the serial port setting is also changed 
automatically. 

 
 Improved Conversion of C500/C120/C**P Programs 

Previous version (version 7.0) New version (version 7.2) 
Programs stored in C500, C120, or C**P-series 
PLCs could be uploaded and converted for use 
in CS/CJ/CP-series PLCs or CVM1/CV-series 

DM and HR Area data can also be converted to PLC memory. 
After conversion, it is now possible to select the CP1L as the PLC 
model. 
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PLCs, but the DM and HR Area data could not 
be converted to PLC memory. 
A backup program and I/O memory (DM and 
HR Area data) file (extension .c5b) could be 
used to restore the program to a 
C500/C120/C**P-series PLC, but it could not be 
converted to a CX-Programmer project. 

A backup program and I/O memory (DM and HR Area data) file 
(extension .c5b) can be converted to a CX-Programmer project for 
a CS/CJ/CP-series PLC or CVM1/CV-series PLC. 

A program uploaded from a C500, C120, or 
C**P-series PLC could not be saved to a file in 
mnemonic-text format. 

A program uploaded from a C500, C120, or C**P-series PLC can 
be saved to a file in mnemonic-text format. The saved file can be 
pasted as text in the CX-Programmer’s Statement List (mnemonic 
window), and displayed or printed in ladder format. 
This feature allows the program to be checked in the CX-
Programmer before converting it to a CS/CJ/CP-series PLC or 
CVM1/CV-series PLC program. 

 
 Other Improvements 

Previous version (version 7.0) New version (version 7.2) 
The CPU Unit’s production information could be 
displayed from the I/O table only. 

The CPU Unit’s production information can be displayed from the 
Main Menu’s PLC Information Dialog Box. 

When a CS1D Duplex System CPU Unit was 
being used, the CPU Unit’s Active/Standby 
status could not be displayed in the project 
directory tree. 

When a CS1D Duplex System CPU Unit (CS1D-H) is being used, 
the CPU Unit’s Active/Standby status is displayed in the project 
directory tree. 

 

Version 7.0 Upgrade Information 
Functionality Improved from Version 6.1 to Version 7.0 

 Compatible PLC Models 
The following PLC models have been added as compatible PLCs as part of the version 
6.1 to version 7.0 upgrade. 

 CS/CJ Series CPU Units with unit version Ver. 4.0 and higher 
Ver. 4.0 and higher CS/CJ Series CPU Units are supported. 

 CP Series CPU Units 
The CP Series CPU Units (CP1H-Y) are supported. 

 Support for NSJ-M3D Controllers 
The NSJ@-@@@@(B)-M3D Controllers are supported.  

 Ladder Program to Function Block Conversion Function 
Previous version (Ver. 6.1) New version (Ver. 7.0) 

To convert existing ladder programming to a 
function block, the ladder programming was 
copied and pasted into a function block 
definition. At that point, it was necessary to 
check the variables and addresses used in the 
program and manually register those variables 
and addresses while organizing the input 
variables, internal variables, and output variables. 

Existing ladder program sections can be easily converted to function blocks by 
selecting the program circuits to be converted and selecting Function Block 
(ladder) generation. The function block definition is created automatically and 
the variables are allocated automatically based on the usage of the variables and 
addresses in the program. 


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 Online Editing of Function Blocks 
Previous version (Ver. 6.1) New version (Ver. 7.0) 

A function block definition (algorithm and 
variable table) could not be edited while the PLC 
program was being executed. (The instance I/O 
parameters could be changed.)  

A function block definition (algorithm and variable table) can be edited while 
the PLC program is being executed. (Instances cannot be added.) 
With this capability, it is possible to debug and edit the function block 
definitions themselves even if the PLC must operate 24 hours/day because 
there are devices that cannot be stopped. To edit a function block, select the 
function block definition in the Workspace and select FB Online Edit – Begin 
from the popup menu. 
Note: Function block instances cannot be added. 
Note: This function cannot be used for simulations on the CX-
 Simulator. 

 STRING Data and Text-processing Functions Supported in ST-language Function Blocks 
Previous version (Ver. 6.1) New version (Ver. 7.0) 

The STRING data type could not be used in the 
ST language. (See note.) 

The STRING data type can be used as a data type in the ST language. With this 
capability, it is easy to set a variable containing text (ASCII) in another variable 
with a substitution operation (such as: a := ‘@READ’;). In this case, it is not 
necessary to know the length of the ASCII text string. 

There were no text-processing functions for the 
ST language. 
To process text for message displays and no-
protocol communications in the ladder language, 
the user had to know the length of the ASCII 
string and execute instructions such as text-
processing instructions, data conversion 
instructions, and serial communications 
instructions. 
Note: The user can input text strings can in I/O 

memory using the CX-Programmer’s 
PLC memory function, but it is 
necessary to know the data size in I/O 
memory. 

Text-processing functions (extracting text, merging, searching, etc.) are 
supported for the ST language. With these functions, it is easy to create text 
strings and process displayed messages using ST language in a function block 
without knowing the actual ASCII codes.  

 Support for Input-Output Variables 
Previous version (Ver. 6.1) New version (Ver. 7.0) 

Input-output variables were not supported in 
function blocks. (Only input variables, internal 
variables, and output variables could be used.) 

Input-output variables can be used in function blocks.  

Input variables could not be specified as arrays. Input-output variables can be specified as arrays. 
Values are passed from input parameters to input 
variables. 

Addresses (not values) are passed from input parameters to input variables. 
Consequently, array input-output variables can be used in the function 
blocks and large amounts of data can be passed easily to the function blocks 
through input parameters. 

 Support for C500/C120/C**P Backup Function 
Previous version (Ver. 6.1) New version (Ver. 7.0) 

The programs in C500/C120/C**P PLCs could not 
be managed online from the CX-Programmer. 

A program stored in a C500/C120/C**P PLC can be uploaded and 
converted to a CS/CJ/CP Series program or CVM1/CV Series PLC program. 
If an instruction’s specifications are different, a comment is displayed to 
alert the user of the differences when the program is converted. To convert a 
program, select  
Tools – C500/C120/CxxP Support – Online PLC Program Conversion. 
Program and I/O memory data (DM and HR) stored in a C500/C120/C**P 
PLC can be backed up. Later, the backed up program and I/O memory data 
can be restored to a C500/C120/C**P PLC. To backup or restore the data, 
select 
Tools – C500/C120/CxxP Support – Backup from PLC or Tools – 
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C500/C120/CxxP Support – Restore to PLC. 
Program and I/O memory data (DM and HR) stored in a specified file can be 
compared to the program and I/O memory data (DM and HR) in a 
C500/C120/C**P PLC. To compare the data, select  
Tools – C500/C120/CxxP Support – Compare PLC and file. 

 Improvements in Data Trace/Time Chart Monitoring 
Previous version (Ver. 6.1) New version (Ver. 7.0) 

Only one word of data could be specified at the trace 
data for data tracing and timechart monitoring. 

Up to eight words of data can be specified at the trace data for data 
tracing and timechart monitoring. 

 

Version 6.1 Upgrade Information 
 Functionality Improved from Version 6.0 to Version 6.1 

 Compatible PLC Models 
The following PLC models have been added as compatible PLCs as part of the version 
6.0 to version 6.1 upgrade: 
CP Series CP1H CPU Units  (CP1H-XA and CP1H-X) 

 Support for NSJ-series NSJ Controllers 
The PLC model (“device type”) can be set to “NSJ” and the CPU type can be set to the 
G5D.  

 Support for FQM1 Unit Version 3.0 
The new models of the FQM1 Flexible Motion Controller are now supported (i.e., the 
FQM1-CM002 Coordinator Module and the FQM1-MMA22/MMP22 Motion Control 
Modules).  

 Ladder Program Simulation Function 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The CX-Simulator could be used to execute 
a ladder program step (Step Run), execute 
steps continuously (Continuous Step Run), 
execute a single cycle (Scan Run), and set 
I/O break point conditions. 

The Step Run, Continuous Step Run, Scan Run, and Set/Clear Break 
Point functions can be executed as CX-Programmer functions. 
All of these functions can be used with ladder programs and ladder/ST 
programs in function blocks. 
Note 1: The CX-Simulator Ver. 1.6 (sold separately) must be installed 

in order to use these functions. 
Note 2: I/O break conditions cannot be set. 

 Improved Function Block Functions 

• Monitoring ST Programs in Function Blocks 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The operation of ST programs within function 
block instances could not be monitored while 
monitoring the program online. 
(It was possible to check the contents of a 
function block definition's program and 
monitor the I/O status of a function block 
instance's ladder diagram.) 

The status of a function block instance's ST program can be monitored 
while monitoring the program.  
To monitor the ST program's status, either double-click the function 
block instance or right-click the instance and select Monitor FB 
Instance from the pop-up menu. At this point, it is possible to change 
PVs and force-set/reset bits. 
Note: Online editing is not supported. 
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• Password Protection of Function Blocks 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The function block properties could be set to 
prevent the display of a function block 
definition's program. 

The following two kinds of password protection can be set. 
• Password protection restricting both reading and writing. 
• Password protection restricting writing only. 

 Starting the Switch Box Utility with PLC Information 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The Switch Box Utility could be started from 
the CX-Programmer’s Tools Menu, but the 
PLC model and communications settings 
could not be inherited in that case. 

The Switch Box Utility can start with the PLC model and 
communications settings set in the CX-Programmer’s project. 

 Saving the CPU Unit’s Error Log as a CSV File 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The CPU Unit’s error log could not be saved.  The CPU Unit’s error log can be saved as a CSV file. The data 
collected in these CSV files can be analyzed or printed later with 
programs such as MS Excel. 

 Displaying Current Consumption in the I/O Table Window 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The current consumption for the 5 V system 
could not be separated from the 26 V/24 V 
system in the I/O table window’s current 
consumption display. The total current 
consumption at the different voltages could 
not be separated. There was no total power 
consumption display. 

The current consumption display in the I/O table window is divided into 
5 V and 26 V/24 V system displays. A total power consumption display 
was also added. 

 Displaying Unit Versions in the I/O Table Window 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The I/O table window’s Unit profile information 
display showed only the model number and 
did not show the unit version. 

The unit version was added to the I/O table window’s Unit profile 
information display in addition to the model number.  

 USB Supported as a Network Type 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

USB was not available as a network type. As part of the CP Series support upgrade, USB is supported as a 
network type for the connection between the computer and PLC. This 
improvement allows the computer’s USB port to be connected to the 
PLC’s USB port. In addition, if the computer supports automatic online 
USB connections, this function can be used. 
Note: This function can be used only with the CP Series PLCs, which 

are equipped with USB port. 

 CP1H Memory Cassette Transfers and Flash Memory Backup Functions 
Previous version (Ver. 6.0) New version (Ver. 6.1) 

The CP1H CPU Units were not supported. When the PLC model is set to CP Series CP1H, it is possible to 
transfer and verify data between a Memory Cassette and the CP1H 
CPU Unit. The contents of Data Memory in the CPU Unit’s RAM can 
also be backed up to flash memory as initial values. (To access these 
functions, select PLC – Edit – Memory Cassette/DM.) 
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Version 6.0 Upgrade Information 
 Functionality Improved from Version 5.0 to Version 6.0 

 Installing the CX-Programmer from the Integrated CX-One Package 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
The CX-Programmer could 
be installed only 
independently. 

The CX-Programmer can be installed as one of the functions of the integrated CX-One 
Software Package.  

 Automatic Selection of Network Configuration Tool (CX-Integrator/CX-Net Startup) 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
The CX-Net started 
automatically when Tools – 
Network Configuration Tool 
was selected. 

If the PLC model is set to the CS/CJ-series, the CX-Integrator starts when Tools – 
Network Settings is selected. 
If the PLC model is set to a model other than the CS/CJ-series, the CX-Net starts when 
Tools – Network Settings is selected. 

 CX-Programmer Startup Method 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
The CX-Programmer could 
be started only from the Start 
Menu. 

The CX-Programmer can also be started by right-clicking a PLC in the CX-Integrator’s 
Network Configuration Window and selecting Start Special Tool from the pop-up menu. 
Note: When the Start with Settings Inherited Option is selected, the CX-Programmer will 
start with the same online/offline status as the CX-Integrator and a new project will be 
created (i.e., inserted into the Network Configuration Window). 

 Switch Box Utility Location and Startup Method 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
The Utility could be installed 
from the CX-Programmer’s 
Setup Disk as a separate 
program and started from the 
Start Menu. 

The Switch Box Utility is handled as a Programming Device and it can be started from 
the Tools Menu.  
Note: The Switch Box Utility supports the PLC’s Debug operations. The Utility can be 
used to display I/O status of a user-specified address. A specified bit’s status can be 
Set/Reset or Force-Set/Reset from the keyboard and a specified word’s content can be 
changed. For details, refer to the Switch Box Utility’s online help program.  

 Compatible PLC Models 

• FQM1-series Compatibility 
The CX-Programmer now supports FQM1 Flexible Motion Controllers.  
An FQM1-CM Coordinator Module and FQM1-MMA/FQM1-MMP Motion Control 
Module can be selected as the PLC model.  
 

Note: After selecting the FQM1-CM as the PLC model, insert the FQM1-MMA or FQM1-MMP as the PLC.  
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 Improved I/O Table Window (CS/CJ-series PLCs Only) 

• Setting CPU Bus Unit and Special I/O Unit Parameters in the I/O Table Window 
Previous version (Ver. 5.0) New version (Ver. 6.0) 

The CX-Programmer had to be 
online and only the following 
Communications Unit settings could 
be made from the I/O table window. 
1. Software Switch Settings 

(for Controller Link Units, 
Ethernet Units, Serial 
Communication Boards/Units, 
etc.) 

2. Unit Settings (Ethernet Units) 

If the PLC model is set to the CS/CJ-series, parameters for Special I/O Units 
and CPU Bus Units (such as the allocated DM area and CPU Bus Unit System 
Settings) can be set offline without knowing the parameter addresses. The 
parameter data and I/O table can be downloaded (see note), uploaded, or 
compared with the actual PLC’s data. The parameter data can also be stored in 
a CX-Programmer project file (extension .CXP) or an individual Unit’s 
parameters can be stored as a file (extension .XML).  

Note: When downloading PLC memory data from the computer to an actual PLC, a warning will be displayed if 
the PLC memory area addresses to be transferred from the computer overlap the addresses of the Special 
Unit settings in the computer’s I/O Table Window.  

• Monitoring Additional Rack Information in the I/O Table Window 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
The Rack’s power supply 
status,  

If the PLC model is set to the CS/CJ-series, each Rack’s power consumption and rack 
width (CJ-series only) is displayed offline in a dialog box. When the CX-Programmer is 
online, the CPU Unit’s front DIP Switch settings can be monitored in a dialog box. 

 Improved Data Trace and Time Chart Functions 

• Storing Collected Data in CSV Files 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
Data collected with the Data 
Trace function or Time Chart 
Monitor function could be 
stored in specialized CX-
Programmer (.cdt) files only. 

Data collected with the Data Trace function or Time Chart Monitor function can be 
stored in standard CSV files, so the collected data can be analyzed/printed with 
programs such as Microsoft Excel. 

 Improved Function Block Functions 

• Nesting Function Blocks 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
A function block could not be 
called from another function 
block. (Nesting not 
supported.) 

A function block can be called from another function block (nested). Up to 8 nesting 
levels are supported. 
The languages of the calling function block and called function block can be either 
ladder language or ST language. 
The nesting level relationship between function blocks can be displayed in a directory 
tree format.  
All nested function block definitions are stored in one Function Block Library file (.cxf 
extension). 

 



PART 1: CX-Programmer 
OMRON APPENDIX D – Previous Version Upgrade Information 
 
 

  CX-Programmer _Page 185 

• Monitoring Word and Bit Status of Ladder Programs in Function Blocks 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
The I/O status of a function 
block instance’s ladder 
diagram could not be 
monitored while monitoring 
the program online. (It was 
only possible to check the 
program in the function block 
definition.) 

The I/O status of a function block instance’s ladder diagram can be monitored while 
monitoring the program online. To monitor the I/O status, either double-click the function 
block instance or right-click the instance and select Monitor FB Ladder Instance from the 
pop-up menu. At this point, it will be possible to monitor the status of I/O bits and the 
content of words, change PVs, force-set/reset bits, and monitor differentiation (ON/OFF 
transitions) of bits.  
Note: Online editing is not supported and timer/counter SVs cannot be changed.  

• Registering and Monitoring Function Block Instance Variables in a Watch Window 
Previous version (Ver. 5.0) New version (Ver. 6.0) 
To register a function block 
instance’s variable in a 
Watch Window, it was 
necessary to display the 
Watch Window, double-click 
the window, and select the 
desired variable from a pull-
down list.  

Multiple variables in a function block instance can be easily registered together in the 
Watch Window. The FB variables registration Dialog Box can be displayed with any of 
the following methods and the variables can be registered together in that Dialog Box. 
1. Right-click the function block instance and select Register in Watch Window from 

the pop-up menu. 
2. Select the desired function block instance in the program or variable table and 

either copy/paste or drag/drop the instance into the Watch Window. 
3. Move the cursor to an empty line in the Watch Window and select Register in 

Watch Window from the pop-up menu. 

• Other Improvements Related to Function Blocks 
 The cross-reference pop-up function is supported in ladder programs within function 

blocks. 
 The ST language help program can be started from the pop-up menu in ST Editor. 
 A function block’s definitions can be opened just by double-clicking the function block 

instance. 
 The cursor automatically moves down after a function block instance’s parameter input 

is confirmed.  

 Other Improvements 
 Improvements to PLC Setup Downloading 

When the PLC Setup is downloaded to a PLC, the serial port related settings (Host Link 
Port Tab, Peripheral port Tab, and FINS Protection Tab settings) can be eliminated 
from the download. (This function allows the user to protect against overwriting from the 
CX-Programmer after using NT Link auto-detection from the CX-Integrator or making 
changes with a PLC parameter transfer.) 
 

Version 5.0 Upgrade Information 

The following tables outline the changes that have been made from version 4.0 to version 5.0 of the CX-Programmer. 

 Functionality Improved from Version 4.0 to Version 5.0 

Compatible PLCs 
CX-Programmer version 5.0 supports the following PLCs: 
 CS/CJ-series CPU Unit Ver. 3.0 
 CJ-series CJ1H-CPU67H CPU Unit  

(Program capacity: 250K steps, I/O points: 2,560 points) 
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 Improvements to Functionality 

Function Block (FB) Support (CS/CJ-series CPU Unit Ver. 3.0 or later) 
Previous version (Ver. 4.0) New version (Ver. 5.0) 
Function blocks (FB) were 
not supported. 

Function blocks are supported for CS/CJ-series CPU Units Unit Ver. 3.0 or later. 
Ladder programming or structured text (ST language) can be used for algorithms. 
Function block data can be downloaded from or uploaded to CS/CJ-series CPU Units 
Unit Ver. 3.0 or later and saved in standard project files (.cxp) and standard file 
memory .obj files. OMRON’s Function Block Library can also be used. 

 Symbol Filtering Using Symbol Names and I/O Comments When Inputting Contacts, Coils, 
and Special Instruction Operands 
Previous version (Ver. 4.0) New version (Ver. 5.0) 
Searches were possible only 
for symbol names of 
contacts and coils, and 
mnemonics of special 
instructions when inputting 
contacts, coils, or special 
instruction operands. 

Searches and list displays are possible for text strings that are part of symbol names or 
I/O comments when inputting contacts, coils, or special instruction operands. 
a) By entering a specific text string when inputting I/O contacts or operands, a list of 

address_comment or name_address_comment combinations that contain the 
specified text string in the symbol name or I/O comment is displayed in a drop-
down list. The desired symbol can then be input by selecting it from the list. 

b) In the same way, when inputting operands for special instructions, the Filter 
Symbol Button can be clicked to input a text string in the Filter Symbol Dialog Box 
to display a list of address_comment or name_address_comment combinations 
that contain the specified string in the symbol name or I/O comment in a drop-down 
list. The desired symbol can then be input by selecting it from the list. 

 
Previous version (Ver. 4.0) New version (Ver. 5.0) 
 This function is available in both Ladder Section Windows and the Function Block Editor. 

Use this function to increase input efficiency when inputting symbols and comments that 
have been input before. 
Example 
Input temp in the Symbol/Address Input field.  

 

 
Click the  button on the right of the pull-down menu to display all the symbols/addresses that contain 
“temp” in the symbol name or I/O comment. 

 

A list of all variables/addresses containing 
“temperature” are displayed.  

For example, select the item at the bottom of the list temp_alarm02, W0.05, The lower part of a device A 
temperature error (70 degrees min) to simply input the symbol name temp_alarm02.  

 

 
Select Tools - Options, and then select the Symbol Filtering option on the Diagrams Tab 
Page to enable searching for specified text strings for the following: Name only, Comment 
only, or Both (default) 


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

 Storing Comments, Symbol Names, Rung Comments, and Other Data in CPU Unit’s Comment 
Memory (CS/CJ-series CPU Unit Ver. 3.0 or Later) 

Previous version (Ver. 4.0) New version (Ver. 5.0) 
The following common data could be stored in the 
Memory Card or EM file memory (Memory Card when 
both are available) by downloading projects from the CX-
Programmer. 
• Symbol tables (symbol names, comments, and 

automatic allocation area setting data: 
SYMBOLS.SYM) 

• Comments (rung comments and other comments: 
COMMENTS.CMT) 

• Program indexes (section names, section comments, 
and program comments) 

When downloading projects using CS/CJ-series CPU Units 
with Ver. 3.0 or later, the Memory Card, EM file memory, or 
comment memory (in the CPU Unit’s flash memory) can be 
selected as the transfer destination for I/O comments, 
symbol names, rung comments, and other data.  
This enables data such as I/O comments, symbol names, 
and rung comments to be stored in the CPU Unit’s internal 
comment memory when a Memory Card or EM file memory 
are both not available. 

 Inputting I/O Comments for Timer/Counter Numbers in Timer/Counter Instructions 
Previous version (Ver. 4.0) New version (Ver. 5.0) 
When inputting timer/counter 
instructions, I/O comments 
could not be input for 
timer/counter numbers (first 
operand) in the timer/counter 
instruction. 
I/O comments could be input 
for timer/counter Completion 
Flags, after which, these I/O 
comments were 
automatically displayed for 
the timer/counter numbers 
(first operand) of the 
timer/counter instructions. 

When inputting timer/counter instructions using simple dialog mode selected in the 
Instruction Dialog Box, I/O comments can be input for the timer/counter number (first 
operand) in the timer/counter instruction. (The Completion Flag of the timer/counter 
instruction that corresponds to this number is automatically registered in the global 
symbol table.) 
Also, the … (three dots) button can be clicked in detailed dialog mode to display the 
Find Symbol Dialog and then input a new symbol name using the NUMBER data type 
for the timer/counter number (first operand) of the timer/counter instruction and the 
symbol comment. The NUMBER type symbol will be registered in the local symbol table 
and at the same time, the number of the timer/counter Completion Flag is registered in 
the global symbol table. 
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 Online Connection to PLCs Connected Via Serial Gateway to Host Link FINS  
Previous version (Ver. 4.0) New version (Ver. 5.0) 
Online connection to PLCs 
connected using a Serial 
Gateway to Host Link FINS 
was not supported.  

Online connection is possible through the serial port of a Serial Communications 
Board/Unit (Ver. 1.2 or later) to PLCs connected using Host Link FINS via a Serial 
Gateway. 
In the Change PLC Dialog Box, specify serial port 1 or 2 of the Serial Communications 
Board/Unit (Ver. 1.2 or later) and the Host Link number of the destination PLC.  

 Increased Data Link Capacity for Controller Link Networks and Areas 1 and 2 Can Use the 
Same Area for Data Links (CS/CJ-series Controller Link Units Unit Ver. 1.2 (Available Soon) or 
Later) 
Previous version (Ver. 4.0) New version (Ver. 5.0) 
A maximum of 12,000 
send/receive words (total of 
Area 1 and Area 2) per node 
could be set when using 
Controller Link data links 
(manually set) with a CS/CJ-
series Controller Link Unit.  

Using a CS/CJ-series Controller Link Unit with Ver. 1.2 (available soon) or later, a 
maximum of 20,000 send/receive words per node (total of Area 1 and Area 2) can be 
set for nodes in Controller Link data links (manually set). 

Area 1 and Area 2 had to be 
in different areas when using 
Controller Link data links 
(manually set) with a CS/CJ-
series Controller Link Unit. 

A CS/CJ-series Controller Link Unit Ver. 1.2 (available soon) or later and Controller Link 
data links (manually set) enables setting the same memory area for both Area 1 and 
Area 2, provided that the addresses are not the same.  
Example: The entire Data Link (i.e., Area 1 and Area 2) can be set in EM bank 0. 

 Setting Local Network Tables (Using CX-Net Routing Tables) for the Serial Ports of Serial 
Communications Boards/Units (Ver. 1.2 or Later) 
Previous version (Ver. 4.0) New version (Ver. 5.0) 
The following items could be 
displayed in the Unit 
directory of the SIOU Tab 
Page on the left of the 
routing table main view. The 
local network address could 
be set for the serial port of 
the CPU Unit and registered 
in the local network table by 
right-clicking and selecting 
Insert CPU SIOU.  
• Unit 252 (serial port) 
• Unit 253 (peripheral port) 

The same function is now supported for the serial ports of Serial Communications 
Boards/Units (Ver. 1.2 or later). By right-clicking a device under the Unit directory and 
selecting Insert CPU SIOU, local network addresses can also be set for the serial ports 
of the Serial Communications Boards and Units to register them in the local network 
table.  
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Version 4.0 Upgrade Information 
The following tables outline the changes that have been made from version 3.3 to version 4.0 of the CX-Programmer. 

 Functionality Improved from Version 3.3 to Version 4.0 

Compatible PLCs 
CX-Programmer Version 4.0 supports the following PLCs: 
 CS/CJ-series CPU Unit Ver. 2.0 (including CJ1G-H Ver. 2.0, CJ1H-H Ver. 2.0, CJ1M Ver. 

2.0 (see note 1), CS1G-H Ver. 2.0, and CS1D-S Ver. 2.0)  
 CS1D-H CPU Unit Ver. 1.1 
Note: 1. Includes CJ1M-CPU11/21. 
 2. Although previously “CS1H-H” was selected as the device type for CS1D CPU 

Units for Duplex-CPU Systems, CX-Programmer Version 4.0 allows selection of 
“CS1D-H.” 

Network Compatibility 

• Ethernet Connection Using TCP/IP 
TCP/IP can be used instead of the earlier UDP/IP for Ethernet connections with a PLC 
to which a CS1W-ETN21 or CJ1W-ETN21 100Base-TX Ethernet Unit is mounted. 
Select Ethernet (FINS/TCP) as the network type. 

• Settings for CS1D (Duplex) Ethernet Unit 
Unit setting and PLC Setup settings are supported for the CS1D-ETN21D Duplex Ethernet 
Unit, enabling duplex operation for Ethernet. Refer to the CS1D-ETN21D Duplex Ethernet 
Unit Operation Manual (Cat. No. W430) for details on settings.  

Improvements to Program Reusability 

• Creating Files of Multiple Rungs or a Single Program Section as a File (Reusable File) for 
Saving/Reading 
Previous version (Ver. 3.3) New version (Ver. 4.0) 
Reusing a part of the 
program (multiple rungs or a 
single section) enabled by 
moving or copying between 
two sections using the 
Section/Rung Manager 
Dialog Box. Parts of the 
program, however, could not 
be saved or read as files. 

Parts of the program (single or multiple rungs, or a single program section) can be 
saved as a file (.cxr: text file) by selecting File − Reusable File − Save As. The file can 
then be read and inserted in a user-set location in the program of another project by 
selecting File − Reusable File − Add to Project. 
In the same way, specified variables in a symbol table can be saved as files, and then 
read and inserted in a symbol table of another project.  
Multiple reusable files can also be inserted all together in a specified order. The 
order used to insert multiple reusable files can also be saved in the list of reusable 
files added to the project. This allows the group of reusable files to be managed as 
a single unit of data. 
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Improvements to Program Editing Efficiency 

• Read Only Mode 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

When editing a program offline, 
editing could not be prohibited. 

Allowing ladder screen display only, and prohibiting 
program editing by mistake while offline is possible. 
Set the Offline Edit Mode to Read Only Mode in the 
Option Dialog Box to enable this function. 

 
When editing a program, an 
operation could be reversed 
(Undo), but all the edited parts 
could not be selected to be 
either applied (store) or 
cancelled.  

After temporary editing of a specific rung, the user 
can select to utilize (store) or delete (cancel) the 
editing results. 
Select Read Only Mode Edit – Start Edit from the 
Edit Menu, and then perform either of the following 
steps after editing. 
a) To apply the editing results, select Read Only 
Mode Edit – Store from the Edit Menu. The edited 
contents will be reflected in the program. 
b) To not apply the editing results, select Read Only 
Mode Edit – Cancel from the Edit Menu. The edited 
contents will be deleted.  
Therefore, after editing rungs and writing and 
recording temporary changes, the changes can be 
selected to be either applied or deleted, enhancing 
program editing efficiency 

 
 

Improvements to Program Development in Task Units 

• Downloading by Task (Program) (CS/CJ-series CPU Unit Ver. 2.0 or Later) 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

When downloading a program 
to the PLC, only the whole 
user program could be 
downloaded. 
Note: Uploading in sections or 
tasks (program) was possible 
when using CS/CJ-, or 
CVM1/CV-series PLCs. 

Programs can be downloaded to CS/CJ-series PLCs 
Ver. 2.0 or later, and downloading by task (program) 
instead of the whole user program is possible. 
Select Partial Transfer – Task Transfer to PLC from the 
PLC Menu, and download a specified single task or 
multiple tasks. 
This function enhances the efficiency of program 
development by multiple personnel. 
Particularly, by downloading to the PLC by task 
(program, only the parts to be changed are reflected in 
the PLC, resulting in fewer working errors. 
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• Confirming whether a Task (Program) Is Executing or Stopped (CS/CJ-series PLCs Only) 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

CS/CJ-series PLCs supported 
tasks, but the execution status 
could be confirmed for the 
whole program only and not 
for each task. 

The following executing/stopped status is displayed for 
every task (see note) in the project space. 
Note: Cyclic tasks only. Interrupt tasks not included. 

• Running: Indicated as READY (execution enabled) or 
RUN (executing status). 

• Stopped: Indicated as INI (not executing status) or 
WAIT (standby status). 

This function improves debugging efficiency when 
using multiple tasks.  

 

• Checking Whether the Same Address Is Being Used by Another Task (Program): Cross 
Reference Report Function (CS/CJ-series PLCs Only) 

Previous version (Ver. 3.3) New version (Ver. 4.0) 
CS/CJ-series PLCs supported 
tasks, but they did not check 
whether the same address 
was being used by another 
task (program). 

By selecting Duplicate usage over programs in the 
cross reference report function, a list can be checked 
for any bits/words that have been allocated an address 
already being used by another task (see note). 
This function can be used to easily check whether the 
same address is being used by another task 
(programmer) when two or more programmers are 
creating multiple tasks. 
Note: Cyclic tasks only (interrupt tasks not included).  

 

Improvements to Password Protection 
• Password Protection for a Single User-set Task or Multiple Tasks (CS/CJ-series CPU Unit Ver. 

2.0 or later) 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Password protection 
(reading/editing prohibited) 
could be set.  

Password protection (reading/editing prohibited) can be 
set for a user-set single task or multiple tasks 
(programs). 
This function provides security and prevents the loss of 
intellectual property for specific tasks (programs). 

 

• Allowing/Prohibiting Creation of Program Files for File Memory (CS/CJ-series CPU Unit Ver. 
2.0 or Later) 

Previous version (Ver. 3.3) New version (Ver. 4.0) 
The user could use file 
memory operations to transfer 
program files (.OBJ) to a 
Memory Card, even if UM 
(user memory) read protection 
was set with a password.  

When a password is registered for the whole user 
program or individual tasks, an optional setting can be 
selected at the same time to allow/prohibit creation 
(backup) of the program file (.OBJ).  
This function prevents copying of user programs to 
Memory Cards.  
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• Allowing/Prohibiting Program Overwriting (CS/CJ-series CPU Unit Ver. 2.0 or Later) 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Overwriting the user program 
in the CPU Unit was 
prohibited by turning ON pin 2 
of the DIP switch. If pin 2 was 
turned OFF, however, 
overwriting was possible. 

When a password is registered for the whole user 
program or individual tasks, an optional setting can be 
selected at the same time to allow/prohibit program 
overwriting. Set the option in the PLC properties.  
This function uses a password to prohibit overwriting of 
the program by a third party.  

Improvements to I/O Table Editing Functions 
• Specifying up to 64 Sets of Slot/Rack Start Addresses  

Previous version (Ver. 3.3) New version (Ver. 4.0) 
For CS/CJ-series PLCs, up to 
eight sets, comprising 
rack/slot number and start 
address, could be set. 

For CS/CJ-series PLCs Ver. 2.0 or later, up to 64 sets 
of rack/slot numbers and start addresses can be set. 

 

Improvements to Unit Error Log Display 

• Displaying Error Log for CPU Bus Units or Special I/O Units in the I/O Table 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

The error log could not be 
displayed for Special I/O 
Units. 

By selecting a CPU Bus Unit or Special I/O Unit in the 
I/O table tree and clicking the right mouse button to 
select the Unit Error Log Menu, the error log for the 
selected Unit can be displayed. 

 

Improvements to Ladder Screen Display Functions 

• Addition of Horizontal Display Mode for Instructions 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Instructions could be 
displayed in vertical writing 
only.  

Instructions on the right side of rungs, which were 
previously displayed vertically only, can now also be 
displayed horizontally. Enable this function by selecting 
Tools – Options, and then selecting Show output 
instructions horizontally in the Diagrams Tab Page (the 
default setting is OFF: previously used vertical display). 
By using the horizontal display mode, the number of 
instruction rungs that can be printed and displayed on 
one screen is increased, improving the readability of 
the program. At the same time, the number of printed 
pages can be reduced.  
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Improvements to Comment Functions 

• Setting Multiple Comments (up to 16) for a Single Address, and Selecting a Label to Switch 
All the Comments 

Previous version (Ver. 3.3) New version (Ver. 4.0) 
A single comment could be 
set for each address (symbol) 
only. 

Multiple comments (up to 16) can be registered for 
a single address (symbol). By selecting the 
comment group to be displayed from the multiple 
comment groups (up to 16 groups), the comments 
on the ladder diagram screen can be changed all 
at once. 
This function allows multilingual development of a 
single program or attachment of comments 
according to the development step. 

 

• Importing and Editing Rung Comments 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

After uploading a program 
from a PLC that did not 
support rung comment data, 
the rung comments could not 
be reallocated. 
Even when programs were 
uploaded from PLCs that did 
support rung comment data, if 
the program in the personal 
computer and actual PLC 
were different, the rung 
comments could not be 
reallocated.  

By selecting Section/Rung Manager from the Program 
Menu, the rung comment data can be read (imported) 
from the project in the personal computer, and 
operations can be performed to move the data up and 
down. 
This function allows rung comments to be allocated to a 
program all at once after uploading the program under 
the following conditions, even if there is no comment 
file (COMMENTS.CMT) in the Memory Card/EM file 
memory. 
1) When uploading programs from a C-series PLC or 
other PLC that cannot record rung comments. 
2) When uploading programs from a CS/CJ-series, 
CVM1/CV-series, or C200HX/HG/HE-ZE PLC. 
When the uploaded programs are changed in the actual 
PLC using functions such as online editing, the position 
of the rung comment can be edited. 

 



PART 1: CX-Programmer 
APPENDIX D – Previous Version Upgrade Information OMRON 
 
 

CX-Programmer _Page 194  

• Displaying the Global/Local, Name, Address/Value, and Comment Fields for the Symbol at the 
Cursor Position below the Ladder Section Window (Symbol Bar) 

Previous version (Ver. 3.3) New version (Ver. 4.0) 
To display all comments, the 
font size, cell width, and other 
settings must be changed in 
the Appearance Tab settings, 
or detailed dialog mode must 
be used to check the 
comment display. 

The global/local, name, 
address/value, and comment fields 
for the symbol at the cursor position 
are displayed in the symbol bar 
below the Ladder Section window. 
Enable this function by selecting 
Show symbol bar in the Diagrams 
Tab in the Options Dialog Box of the 
Tools Menu (the default setting is 
ON: display). 
Therefore, while increasing the 
program display density, the text in 
particularly long comments can be 
checked, thereby improving the 
readability of the program. 

 

Improvements to Cross Reference Functions 

• Displaying/Printing Cross Reference Function Usage List with Comments 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

The cross reference function 
usage list was displayed 
without comments. 

The cross reference function usage list can be 
displayed with comments and the list can also be 
printed. 
Therefore, the user can check what the addresses 
mean when checking the number of times the 
addresses have been used. This thereby reduces the 
labor required for programming/debugging. 
This function can also be used to jump to the position of 
the rungs being used. 

 

• Displaying the Cross Reference Function Usage List for the Corresponding Address from the 
Ladder Screen 

Previous version (Ver. 3.3) New version (Ver. 4.0) 
The cross reference function 
only enabled the cross 
reference report to be 
selected from the display 
menu or a cross reference 
pop-up display to be selected 
from the display menu for the 
address at the cursor position.  

By moving the cursor to an address in the ladder diagram and selecting Check usage 
including unused, the usage list (with comments) can be displayed starting with the 
selected address. 
This function enables the cross references to be checked for the address directly from 
the ladder display instead of from the cross reference report. 
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• Printing Word Address Cross References 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Printing with cross reference 
information was possible for 
the cross references of output 
bits only (the rung number 
used by the output bit address 
was printed at the right of the 
coil). 

Printing with cross reference information also includes 
the cross reference of the word address. 
Therefore, by viewing the printed program, information 
that is equivalent to that from the CX-Programmer’s 
cross reference function can be obtained even if a CX-
Programmer is not onsite. 

 

Improvements to Search Functions 

• Omitting Symbol Table from Search 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

The search range included the 
ladder program and symbol 
table.  

By deselecting Include symbol table, the search range 
includes the ladder program only. Therefore, 
unnecessary searches of symbol tables are omitted, 
thereby shortening the search time. 

 

• Specifying All the Search Targets 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Search targets were split into 
addresses and comments, 
etc.  

By selecting All (strings) as the search target, a search 
can be performed for all the search targets, including 
addresses, constants, numbers, mnemonics, symbol 
names, comments, rung comments, and other 
comments.  

 

• Mnemonic Function Code Input Not Required 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Mnemonic searches required 
an asterisk * or parentheses () 
with function code inputs after 
the mnemonic search target. 

Mnemonic searches do not require an asterisk * or parentheses () with function codes 
input after the mnemonic search target. 

Improvements to Watch Window 

• Displaying PVs of Addresses in the Watch Window Sheet in Binary 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

The PV for each address 
could be displayed in the 
specified data type only. 

A new column has been added to the watch sheet that 
allows the PVs of addresses to always be displayed in 
binary regardless of the settings specified in Data 
Type/Format.  
16 BIT (Binary, Channel) has also been added to the 
Data Type/Format Options, allowing values to be 
displayed in binary, even if the Binary column is hidden 
(except in the Timer/Counter Areas). 
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• Changing the PVs for DM/EM Areas in Bit Units 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

PVs for DM/EM Area data 
could not be changed in bit 
units. 

While online, when the binary display is selected in the 
Set New Value dialog that is displayed when the 
address in the watch window is clicked, the DM/EM 
Area data can be changed into PVs in bit units.  

 

 
Prevention of Leaving Set Forced Set/Reset Status 

• Checking the Forced Set/Reset Status when Changing from Online to Offline 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

After forced setting/resetting of 
a bit online, the forced set/reset 
status remained unchanged 
when online status was 
changed to offline status. 

After forced setting/resetting of a bit online, a dialog 
box is displayed when status returns to offline to allow 
the forced set/reset status of addresses to be 
displayed. The forced set/reset status can also be 
cancelled. 
Enable this function by selecting Tools − Options and 
then selecting Check forced status after online 
connection in the PLCs Tab Page (the default setting 
is OFF: no confirmation). 
This function prevents going offline unprepared when 
the CPU Unit is still in forced set/reset status.  

 

Improvements to Printing Functions 

• Printing Ladder Programs as Shown on Screen 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Ladder programs could not be 
printed as they were shown 
on the screen.  

Sections of the ladder program can be printed 
separately as they are shown on the screen.  
Select to print the ladder screen in the page setting.  
The ladder screen can be printed as it is shown on the 
ladder screen. 
The program can also be printed at a smaller size 
(Reduced size), or a larger size (Enlarged size), instead 
of the standard size (Normal size). 

 

Improvements to Multi-interlock Display Functions 

• Displaying the Multi-interlock Status (CS/CJ-series CPU Unit Ver. 2.0 or Later) 
Previous version (Ver. 3.3) New version (Ver. 4.0) 

Interlock instructions allowing 
nesting were not supported. 

If the interlock instruction that allows nesting (multi 
interlock instruction) is used with a CS/CJ-series PLC 
Ver. 2.0 or later when performing online monitoring, the 
display will show which instruction segment is presently 
in interlock status using a tree-structure at the left of the 
ladder screen (multi-interlock map). By double-clicking 
the instruction in the multi-interlock map, the ladder 
view will jump to the display of the applicable rung.  
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CX-Net (CX-Server Network Configuration Tool) 
• Accessing up to Eight Network Levels (Set in the Routing Table)  

Previous version (Ver. 3.3) New version (Ver. 4.0) 
FINS commands could be 
used to access nodes up to 
three network levels away, 
including the local network. 

If a CS/CJ-series PLC of Ver. 2.0 or later is used, FINS commands can be used to 
access nodes up to eight. 

 

Version 3.3 Upgrade Information 
The following tables outline the changes that have been made from version 3.2 to version 3.3 of the CX-Programmer. 

• CJ1M-CPU11/21 Support Added 
There are some restrictions in using the CJ1M-CPU11/21 with the new version of CX-Programmer (version 3.3). These 
restrictions will be eliminated in the next version.  

 
Previous version (version 3.2) New version (version 3.3) 
The CJ1M-CPU11/21 was not 
supported. 

The CJ1M-CPU11/21 is supported. 
To use the CX-Programmer for the CJ1M-CPU11, set the Device Type to the CJ1M and 
the CPU Type to the CPU12. To use the CX-Programmer for the CJ1M-CPU21, set the 
Device Type to the CJ1M and the CPU Type to the CPU22. 

Creating a CX-Programmer Project for the CJ1M-CPU11/21 
1. On the initial CX-Programmer display, select File – New and then set the Device Type to the CJ1M in the 

Change PLC Dialog Box. 
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2. Click the Settings Button by the Device Type Field and set the CPU Type in the Device Type Settings 

Dialog Box as shown below. 

 

● CJ1M-CPU11: Set CPU12. 
● CJ1M-CPU21: Set CPU22. 
Setting Table 
 
 CPU Unit Model 

Item 
CJ1M-CPU11 CJ1M-CPU21  

 CX-Programmer 
Ver. 3.3 Device Type Set CJ1M.  

CPU Type Set CPU12. Set CPU22.  
      

 

Function Restrictions when Using CX-Programmer Version 3.3 for the CJ1M-

CPU11/21 
Restriction Description 

Program capacity: 5 Ksteps max. Although the program capacity of the CJ1M-CPU12/22 is 10 Ksteps, the program 
capacity of the CJ1M-CPU11/21 is 5 Ksteps. A program containing more than  
5 Ksteps can be written offline, but an error will occur when it is transferred. An error 
will also occur if a program transferred automatically when power is turned ON is 
larger than 5 Ksteps. 

Subroutine numbers for subroutine 
instructions (SBS, GSBS, and 
MCRO): 0 to 255 only 

Although the subroutine numbers for the CJ1M-CPU12/22 are 0 to 1023, the 
subroutine numbers for the CJ1M-CPU11/21 are 0 to 255. A program containing 
subroutine numbers higher than 255 can be written and can be transferred, but an 
error will occur when the program is executed.  

Jump numbers for jump 
instructions (JMP, CJP, and 
CJPN): 0 to 255 only 

Although the jump numbers for the CJ1M-CPU12/22 are 0 to 1023, the jump numbers 
for the CJ1M-CPU11/21 are 0 to 255. A program containing jump numbers higher 
than 255 can be written and can be transferred, but an error will occur when the 
program is executed.  

Use only 1 scheduled interrupt. Although the CJ1M-CPU12/22 support 2 scheduled interrupts, the CJ1M-CPU11/21 
support only 1. Thus, only scheduled interrupt 0 can be used with the interrupt 
instructions (MSKR, CLI, and MSKR). A program containing schedule interrupt 1 can 
be written and can be transferred, but an error will occur when the program is 
executed. 

Use only 1 PWM output. Although the CJ1M-CPU12/22 support 2 PWM outputs, the CJ1M-CPU11/21 support 
only 1. Thus, only PWM output 0 can be used with the PWM instruction. A program 
containing PWM output 1 can be written and can be transferred, but an error will occur 
when the program is executed. 

Note: The Stop CPU on Instruction Error Option in the PLC Setup can be selected to stop program execution by 
creating a fatal error when an instruction error is detected. Instruction errors include instruction processing 
errors (the ER Flag will turn ON), DM/EM indirect addressing BCD errors, and illegal access errors. This 
option can be used to check to see if instruction errors are occurring in unexpected places in the program. 
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Version 3.2 Upgrade Information 
The following tables outline the changes that have been made from version 3.1 to version 3.2 of the CX-
Programmer. 

• New Models for Automatically Set Data Links 
Previous version  

(version 3.1) 
New version (version 3.2) 

With automatically set data 
links, all nodes shared the 
same data using the common 
settings, i.e., the send size for 
each node was the same, and 
send/receive nodes were 
always in the order of node 
addresses.  

With automatically set data links for Controller Link Networks, 1:N allocations are supported 
in which data communications are set individually for the master node and slave nodes. (The 
models that support this functionality are listed below.) 
Any of the following four settings (data link patterns) can be used for automatic data links.  
Equality layout (previous method), common type, 1 to 1 type, or chain type  
Applicable 
models: 

• CS1W-CLK21-V1 • 3G8F7-CLK21-EV1 
• CS1W-CLK12-V1 • 3G8F7-CLK12-EV1 
• CS1W-CLK52-V1 • 3G8F7-CLK52-EV1 
• CJ1W-CLK21-V1  

Note: The 1:N allocations for automatic data links cannot be used with any other models. 
Refer to the Controller Link Operation Manual for details.  

 Automatic Setting Procedure for Controller Link Networks 
1. Go online with the PLC that is to be used as the polling node.  

 
2. Select Data Link – Setup from the CX-Net.  

If on the local network (i.e., if the network address is 0), select Controller Link and click the OK 
Button. 

The Data Link Component Dialog Box will be displayed.  
 

3. Select Automatic Datalink Setup from the Online Menu. 
 Select Controller Link and click the OK Button. 

The Automatic Datalink Dialog Box will be displayed.  
 

4. In the Automatic Datalink Type Box, select Equality layout, Common type, 1 to 1 type, or Chain type 
and set the automatic data link areas as shown below. 

 

• Equality Layout (Previous Method) 
This is the previous automatic data link type where all nodes are allocated the same sizes of data links. 
      Settings Common to All Automatic Data Link Types 

 

A 

G 

H 

1 

B 

2 

6 

5 

3 

D 

E 

F 

C 

4 

 

No. Item Description of function 
A Generation 

Type 
Select Automatic. (If Manual is selected, data links will 
be run using data link tables set separately.) 

B Power Up 
Run State 

Select Start to automatically start data links when power 
is turned ON to the PLC.  

C Close Closes the Automatic Datalink Dialog Box.  
D Read Reads the settings from the PLC. 
E Write Writes the settings to the PLC. 

(If the Power Up Run State is set to Start, the data links 
will start running when the settings are written to the 
PLC.) 

F Help Displays help. 
G Automatic 

Datalink 
Type 

Select the type of data links to be automatically set up 
from the following.  

Equality Layout (Previous method) 
Common Type (1:N settings) 
1 to 1 Type (1:N settings) 
Chain Type (1:N settings) 

H Result The status is displayed when the Read or Write Button is 
clicked. 
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1 

4 

1 

2 2 

3 

1 1 

3 

4 

3 

4 

2 

3 

4 

2 

1 

4 

1 
2 2 

3 

1 1 

3 
4 

3 
4 

2 
3 
4 

2 

(5) Participating nodes 

Area 1 

Area 1 
(1) Area and Start Word 

(2) Size

(Same as (2).)

(Same as (2).)

(Same as (2).)

Area 2 
(3) Area and Start Word 

Area 2 

(4) Size

(Same as (4).)

 

 No. Item Description of function 
(1) Area and Start Word 

for Area 1 
Set the area and the start data link word 
to use for area 1. 

(2) Size of Area 1 Set the send size per node for area 1. 

(3) Area and Start Word 
for Area 2 

Set the area and the start data link word 
to use for area 2. 

(4) Size of Area 2 Set the send size per node for area 2. 
(5) Nodes Set the nodes to participate in the data 

links. 
(6) Status start word Set the first word to store data link status. 

(If 0 words is set, the default area will be 
used.) 

 

 
Features of Equality Layout 
• The send data sizes is the same for all nodes for each area. 
• Area 1 is selected from the bit-access areas (e.g., CIO Area) and area 2 is

selected from word-access areas (e.g., DM Area). 
• Data link areas are allocated in ascending order of node addresses.  
• Data link participation can be specified for each node.  
• The same data link areas are shared by all nodes participating in the data links. 

 
 

• Common Type 

 

(2) 

(3) 

(5) 

(6) 

(8) 

(7) 

(1) 

(4) 

 

 No. Item Description of function 
(1) Area and Start Word 

for Area 1 
Set the area and the start data link word 
to use for area 1. 

(2) Master size Set the area 1 send size for the master 
node. 

(3) Slave size Set the area 1 send size for the slave 
node. 

(4) Area and Start Word 
for Area 2 

Set the area and the start data link word 
to use for area 2. 

(5) Master size Set the area 2 send size for the master 
node. 

(6) Slave size Set the area 2 send size for the slave 
node. 

(7) Nodes Set the nodes to participate in the data 
links.  

(8) Status start word Set the first word to store data link status. 
(If 0 words is set, the default area will be 
used.) 

  
 

Area 1 1 

4 

1 

2 2 

3 

1 1 

3 4 

Area 2 
1 

4 

1 

2 2 

3 

1 1 

3 4 

Master node Slave node 

(7) Participating nodes 

Area 1 
(1) Area and Start Word 

Area 2 
(4) Area and Start Word 

(2) Master size 

(3) Slave size 

(Same as (3).)

(Same as (3).)

(5) Master size 

(6) Slave size 

(Same as (6).)

(Same as (6).)

 

 Features of Common Type 1:N Allocation 
• Data communications are 1:1 between the master node and slave nodes. 
• All slave nodes receive the data sent by the master node. 
• The master node receives all data sent by the slaves. The reception size

for the master node is thus the node send data size times the number of
slave nodes. 

• Slaves do not send or receive data with other slaves.  
• Area 1 is selected from the bit-access areas (e.g., CIO Area) and area 2 is

selected from word-access areas (e.g., DM Area). 
• Data link areas are allocated in ascending order of node addresses.  
• Data link participation can be specified for each node.  
• The same area classification can be used for both Area 1 and Area 2,

provided that the same addresses are not used (CS/CJ-series Controller
Link Units with unit Ver. 1.2 or later).  

 
 

Equality Layout Settings 

Common Type Settings 
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• 1 to 1 Type 

 

(2) 

(3) 

(4) 

(1) 

(6) 

(5) 

 

 
 

 
 

4 

1b 

2 

2 

3 

1c 1d 

3 4 

1a 1a 1a 1a 
 
 
 
 

1b 
 
 

1c 
 
 
 

1d 

Master node Slave node 

(5) Participating nodes 

(1) Area and Start Word 

(2) Master, Common Send Words 

(3) Master, Individual Send Words 

(Same as (3)).

(4) Slave, Send Words

(Same as (4)).

(Same as (4)).

(Same as (3)).

 

Features of 1 to 1 Type 1:N Allocation 
• Data communications are 1:1 between the master node and slave nodes. 
• All slave nodes receive part of the data sent by the master node. In addition,

each slave node receives unique data from the master node (see a to d in
figure).  

• The master node receives all data sent by the slaves. The data sizes are
fixed for all nodes. 

• Slaves do not send or receive data with other slaves.  
• One area is selected from the bit-access areas (e.g., CIO Area) or

word-access areas (e.g., DM Area). 
• Data link areas are allocated in ascending order of node addresses.  
• Data link participation can be specified for each node.  

 

 

1 to 1 Type Settings
 No. Item Description of function 

(1) Link Area and 
Start Word 

Set the area and start data link word. 

(2) Master, Common 
Send Words 

Set the send size of the data to send 
from the master node to all slave 
nodes. The same size of data is sent 
to all nodes. 

(3) Master, Individual 
Send Words 

Set the send size for the master node 
to sent individually to each slave node. 

(4) Slave, Send 
Words 

Set the send size of the data sent from 
each slave node to the master node. 

(5) Nodes Set the nodes participating in the data 
links. 

(6) Status start 
word 

Set the start word to store data link 
status. (If 0 words is set, the default 
area will be used.) 
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• Chain Type 

 

(1) 

(2) 

(3) 

(5) 

(4) 

 

 No. Item Description of function 
(1) Link Area and Start 

Word 
Set the area and the start data link 
word.  

(2) Master, Common 
Send Words 

Set the send size of the data to send 
from the master node to all slave 
nodes. The same size of data is sent 
to all nodes. 

(3) Each Node, 
Receive and Send 

Set the send size of data for each 
node to send to the next node. 

(4) Nodes Set the nodes participating in the data 
links.  

(5) Status start word Set the start word to store data link 
status. (If 0 words is set, the default 
area will be used.)  

 

 

1a 

 

 

 

1b 

4 

1a 

 

2 
2 

3 

2 

1a 

 

3 

1a 

 

3 

4 

1b 

Master node Slave node 

(4) Participating nodes 

(1) Area and Start Word 

(3) Each Node, Received 
and Sent 

(2) Master, Common 
Send Words 

(Same as (3).) 

(Same as (3).) 

(Same as (3).) 

 

Features of Chain Type 1:N Allocation 
• Data communications are 1:1 between the master node and slave nodes. 
• All slave nodes receive part of the data sent by the master node (1a in figure). 
• The master node receives all data sent by the slaves. The data sizes are fixed

for all nodes. 
• Each slave nodes receives data from the previous node and then sends data

to the next node. Data is thus passed in ascending order of the nodes
participating in the data link.  

• One area is selected from the bit-access areas (e.g., CIO Area) or 
word-access areas (e.g., DM Area). 

• Data link areas are allocated in ascending order of node addresses.  
• Data link participation can be specified for each node.  

 

5. Click the Write Button to transfer the automatic data link setting. 

• Adding Nodes while Data Links Are Running 
Previous version (version 3.1) New version (version 3.2) 
Data link tables could not be 
downloaded when data link 
were running.  

Nodes can be added while data links are running if both the following Units/Boards and 
Repeater Units (CS1W-RPT01) are used. 
Applicable 
models: 

Controller Link Units 
• CS1W-CLK21-V1 

Controller Support Boards 
 
• 3G8F7-CLK21-V1 (-EV1) 

• CS1W-CLK12-V1 • 3G8F7-CLK12-V1 (-EV1) 
• CS1W-CLK52-V1 • 3G8F7-CLK52-V1 (-EV1) 
• CJ1W-CLK21-V1  

Note: Refer to the Controller Link Operation Manual for the procedure to add nodes and 
details on changing data link tables while data links are running.  

• Up to 62 Nodes for Wired Controller Link Units 
Previous version (version 3.1) New version (version 3.2) 
Only a maximum of 32 nodes 
could be used with Wired 
Controller Link Units. 

A maximum of 62 nodes can now be used with Wired Controller Link Units. 

Applicable 
models: 

• CS1W-CLK21-V1 
• CJ1W-CLK21-V1 
• 3G8F7-CLK21-V1 (-EV1) 

Note: A CS1W-RPT01 Repeater Unit must be purchased separately to use 62 Controller 
Link Units. Refer to the Controller Link Operation Manual for details. 

 

Chain Type Settings 
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• Displaying Data Link Table Information for Data Link Table Verification 
Previous version (version 3.1) New version (version 3.2) 
Data link table verification 
results were displayed in a 
simple list in an Error List 
Dialog Box. 

When inconsistencies are detected in data link 
verification, the number of inconsistent (failed) 
nodes is displayed, and both the data link 
settings within the selected PLC and those 
with the inconsistencies indicated between 
pointed parentheses (< >). (The size of the 
dialog box can be changed.) Also, if reading is 
not possible for verification, the reasons are 
displayed. 
The results can be pasted as text after clicking 
a Copy Button. 

 

• 100Base-TX for Ethernet Units 
Previous version (version 3.1) New version (version 3.2) 

Only 10Base-T and 10Base-5 were 
supported in Unit settings (CPU Bus Unit 
setups). 

100Base-TX is also supported for Ethernet Unit in the Unit settings (CPU Bus 
Unit setups). 
Applicable models: CS1W-ETN21, CJ1W-ETN21 

• Importing DM/EM Data Files from Previous Support Software 
Previous version  

(version 3.1) 
New version (version 3.2) 

DM/EM data files created with 
the SYSMAC Support 
Software (SSS) or CV Support 
Software (CVSS) could not be 
imported from the PLC 
Memory Window. 
(Importing was possible only 
from the File Menu or the File 
Conversion Utility.)  

DM/EM data files created with the SYSMAC Support Software (SSS) or CV Support 
Software (CVSS) can be imported from the PLC Memory Window.  
The following DM/EM data files can be imported.  
Support Software DM/EM data file type 

(file name extension) 
Memory area Method used on the SSS/CVSS  

SSS .SP6 DM DM data save (All DM) 
.SL4 DM DM data save (Partial DM save) 

CVSS .DMD DM DM data save (Bank No.: Base 
selected.) 

.EDM EM DM data save (Bank No: 0 on 
selected.) 

.IOM DM File data save (Partial save, Bank 
No.: Base selected.) 

.IOM EM File data save (Partial save, Bank 
No: 0 on selected.) 
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Version 3.1 Upgrade Information 
The following tables outline the changes that have been made from version 3.0 to version 3.1 of the CX-
Programmer. 

• Program Editing Functions 

Improvements to Global Replacement Operation 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Changes between normally open contacts 
and normally closed contacts could be 
performed only with the / key. They could 
not be performed globally.  

If Change All is selected from the Edit menu and a checkmark is placed in the checkbox 
for Invert open/close bit before performing a global replacement for the PLC, all 
specified operands that are normally open contacts will be changed to normally closed 
contacts and all normally closed contacts will be changed to normally open contacts.  

Global replacements for addresses applied to 
both the ladder programs and symbol data. 

If the check box for symbols (including I/O comments) is cleared before an address is 
replaced globally, the symbols table and I/O comments will not be changed and only 
addresses in the ladder program will be changed. 
 
If the check box for symbols (including I/O comments) is selected before an address is 
replaced globally, the replacement operation will be the same as the previous version. 

Drawing or Deleting a Connecting Line by Dragging from the Start Point to the End Point 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Connecting lines could be input from the 
keyboard, icons, or menus. (They could not 
be input by dragging with the mouse.) 

Connecting lines can be drawn by clicking the Line Connect Mode icon and then 
clicking the starting point and dragging to the end point. Connecting lines can also be 
deleted by dragging after clicking the Line Delete Mode icon.  
Note: A line can also be drawn by dragging on a line that is not connected on one end.  

Operand at the Cursor Position Appears as Default for Find or Replace Operations 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

When performing a Find or Replace 
operation, the previous contents of the 
previous Find and Replace fields are 
displayed regardless of the position of the 
cursor.  

When a Find or Replace operation is performed, the Bit Addresses, Addresses, Values, 
Symbol Names, or Mnemonics (i.e., in the Look at field for each) at the position of the 
cursor is displayed in the Find what field.  
Note: If the Look at field is a Symbol comments or Program comments, the Find what 
field will be blank. 

History of Previous Find or Replace Settings 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

No history of previous settings was displayed 
for Find or Replace operations. 

Histories of previous find and replace settings are displayed in pull-down menus for the 
Find what field and Replace with field.  

Size Changes for Go to Commented Rung Window 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

The size of the Go to Commented Rung 
window was fixed when jumping to rung 
comments. (This window was previously a 
dialog box.) 

The size of the Go to Commented Rung window displayed when Edit | Go to | 
Commented Rung is selected can be changed.  

 



PART 1: CX-Programmer 
OMRON APPENDIX D – Previous Version Upgrade Information 
 
 

  CX-Programmer _Page 205 

Guidance Displays for SYSMAC Support Software or SYSWIN Shortcut Keys 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Shortcut keys could be allocated for CX-
Programmer functions for SYSMAC Support 
Software operations and SYSWIN 
operations, but guidance could not be 
displayed.  

Guidance can be displayed for CX-Programmer functions for SYSMAC Support 
Software operations and SYSWIN operations by selecting Function Key Guidance from 
the View menu. The CX-Programmer shortcut key allocations for all keys can be 
displayed by selecting Information Window from the View menu.  

• Online Functions  

• Monitor Functions 

Display Form Setting for Operands for Special Instructions when Monitoring in Ladder Section 
Windows 

Previous version (Ver. 3.0) New version (Ver. 3.1) 
When monitoring on the Ladder Section 
window, the symbol data type was given 
priority as the display format for operands 
for special instructions.  
For example, the data type for the MOV 
instruction is CHANNEL, so the display was 
always 4-digit hexadecimal.  
The data type for MOVL is also CHANNEL 
so the display was always 8-digit 
hexadecimal. 
Also, for an unnamed symbol the data type is 
CHANNEL so the display was always 4-
digit hexadecimal. 

The display format for the present values of operands of special instructions when 
monitoring on the Ladder Section Window can be selected from the following data 
types. The same display format must be used globally. 
To select the display format, click the desired button or select Monitoring Data Type 
from the View menu. 
• Decimal  
• Signed Decimal  
• Monitor in Hex  
The default display formats will be as follows if none of the above display formats is 
selected. 
• Named symbol will be monitored in the symbol data type. 
• Unnamed symbol will be monitored in the operand data type. 
• Two-word operations, such as for the MOVL instruction, will be monitored in 2-word 

hexadecimal.  
• For present values displayed in formats other than hexadecimal, “D” is attached for 2-

word data and “L” is attached for 4-word data.  

Improvement in Operation to Change PVs for Special Instructions 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Present values were changed from the 
menus. 

Present values can be changed by pressing the Enter key on an operand that is being 
monitored, or by double-clicking it. 

Start Address Setting when Monitoring Present Values in I/O Memory  
(Continuous Address Monitoring) 

Previous version (Ver. 3.0) New version (Ver. 3.1) 
 The address to monitor in the PLC Memory 
Window could not be specified (either the 
screen had to be scrolled or individual 
addresses had to be monitored in Watch 
windows).  
Also, with floating-point or double-precision 
floating-point binary, monitoring was 
possible only from addresses divisible by 2 
or 4.  

The start address to be monitored can be specified to monitor consecutive addresses in 
the PLC Memory Window.  
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Monitoring Bit Status and Word Contents when Monitoring Present Values in I/O Memory 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Bit status displays in the PLC Memory 
Window had to be performed in word units.  

When the binary word display format is selected for the PLC Memory Window, bit 
status is displayed both for individual bits and as hexadecimal word values.  

Simple Transfer of Data to the PLC when Monitoring Present Values in I/O Memory 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

To transfer data changed in I/O memory 
while monitoring, the monitor status had to 
be cleared and then PLC | Transfer | To PLC 
had to be selected, the range specified, and 
the transfer specified in the PLC Memory 
Window.  

Individual cells being monitoring in the PLC Memory Window can be selected and the 
Set | Value command or the Set Value button can be used to display the Set Present 
Value dialog box. Data can be input into this dialog box for individual I/O memory 
address and then the OK Button can be clicked to directly change the value in the PLC.  
When binary values are being displayed, the menus and buttons can be used to Set, 
Reset, Force On, Force Off, or Force Cancel individual bits.  

• Clear All Memory Areas Function 

All Clear Operation for CPU Unit Memory (User Program, Parameter Area, and I/O Memory) 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Unless a memory error actually occurred in the PLC the 
CPU Unit memory clear operation (see note) could not be 
performed from the Error Log. Also there was no function 
(all clear) to initialize the CPU Unit memory. 
Note: The CX-Programmer had to be placed online, PLC | 
Edit Error Log had to be selected to display the Errors 
window, and then the Clear All Button had to be clicked. 

The user program, Parameter Area, and I/O Memory in the CPU Unit 
can be cleared to initialize the CPU Unit by selecting Clear All Memory 
Areas from the CX-Programmer's PLC menu or selecting Clear All 
Memory Areas from the Options menu of the PLC Errors dialog box. 
These operations are possible even if a memory error has not occurred 
in the PLC (the same as they are for a Programming Console).  

• On-line Editing 

Power Flow Monitoring during Online Editing  
Previous version (Ver. 3.0)  New version (Ver. 3.1)  

The power flow could not be monitored 
during online editing.  

The power flow is displayed during online editing in monitoring status.  

I/O Comment Changes during Online Editing 
Previous version (Ver. 3.0)  New version (Ver. 3.1)  

Changes to I/O comments made during 
online editing could not be saved in the CPU 
Unit (see note).  
If changes were made, the symbol table file 
had to be transferred to file memory in a CS-, 
CJ-, CVM1, or CV-series PLC or to the I/O 
comment area in UM (user memory) in a C-
series PLC. 
Note: New I/O comments could be added to 
the symbol table in CX-Programmer.  

I/O comments can be changed during online editing in Ladder diagram view, in the 
Symbol Table, or in I/O Comment View. 
If I/O comments have been changed when online editing is ended, a confirmation 
message will appear asking if the symbol table file should be transferred to file 
memory in a CS-, CJ-, CVM1, or CV-series PLC or to the I/O comment area in the 
allocated UM (user memory) in a C-series PLC.  
Note 1: Symbol table names and addresses cannot be changed during online editing.  
Note 2: I/O comments with symbol names cannot be transferred to the I/O comment 

area in UM (User Memory) in C-series PLCs. 
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• Verification  

Program Verification Offline or Online 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Program verification was possible only 
between the current project and the PLC.  

Program verification is possible offline between the current project and a closed 
project file. (Select Compare Program from the File menu and select the file to be 
compared.) The results of verification can be saved to a file in CSV format.  

Added or omitted instructions were not 
displayed in verification results (if added or 
omitted instructions were encountered, the 
verification results for the rest of the program 
would show that the programs were 
completely different).  

Verification results are displayed by section and mnemonic, including added or 
omitted instructions. Jumping is also possible from mnemonic verification results to 
the corresponding locations in ladder view.  

Displaying Dialog Box for Verification or Transfer when Going Online  
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Nothing was displayed before going online. If a checkmark is placed in the Prohibit the online operations until the PC and PLC 
data matches checkbox on the PLCs Tab Page that appears when Tools | Options is 
selected, an Online Action Dialog Box to select either verifying or transferring data 
will be displayed. Depending on the selection, before going online, the program will 
be verified between the CX-Programmer and the PLC, the program will be transferred 
to the PLC, or the program will be transferred from the PLC.  

• Unit Online Replacement 

Unit Online Replacement for CS1D or CVM1D PLCs 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Unit online replacement for CS1D or 
CVM1D CPU Units was possible only from 
a Programming Console and was not 
possible from the CX-Programmer. 
(C2000H I/O Unit online replacement was 
possible.)  

With a CS1D or CVM1D CPU Unit, hot swapping (i.e., online replacement) is possible 
during operation for Basic I/O Units and, for the CS1D, Special I/O Units and CPU Bus 
Units as well. Open the I/O tables for the project, select the Unit to be replaced, and 
select Hot Swap from the Options menu. Click the Start Hot Swap Button, remove the 
old Unit, mount the new Unit and click the End Hot Swap Button. Perform this 
operation for each Unit to be replaced.  
Note: Online replacement is possible for a CS1D or CVM1D CPU Unit in any 

operating mode. Use the following settings in the Change PLC Dialog Box. 
CPU Unit being used PLC type selection list CPU Unit model  
CS1D CS1H-H CPU65 or CPU67 
CVM1D CVM1-V2 CPU21 
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• I/O Table Editing Functions 

Specifying Slot Start Address when Editing I/O Tables for Slots Other than First Rack Slots 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

For CS- and CJ-series PLCs, the start address 
for each Rack could be set (but the start 
address could not be set for each slot).  

For CS1-H, CJ1-H, CJ1M, and CS1D CPU Units in the CS- and CJ-series PLCs, Options 
| Rack/Slot Start Address can be selected during I/O table editing to set the start address 
for a specific Rack and slot (in addition to the start address for each Rack).  
This can be used, for example, to allocate fixed addresses to Input Units and Output 
Units.  
Note: The start address information set for Racks and slots can be downloaded and 

uploaded for the CPU Unit.  

 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

When editing I/O tables, unit number, 
number of allocated unit numbers, number of 
input words, number of output words had to 
be set for Special I/O Units and CPU Bus 
Units, and the unit numbers and number of 
allocated unit numbers were displayed in the 
I/O Table window, but the number of input 
words and the number of output words were 
not displayed in the I/O Table window. 

When editing I/O tables, the number of input words and number of output words are 
displayed in the I/O Table window for Special I/O Units and CPU Bus Units that have 
been set (Out:  , In:  ).  

• Other Changes 

Data Transfer and Verification for a ROM Writer 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Transfer and verification were not 
possible for a ROM Writer. 

With the C-series PLCs, any of the following methods can be used for data transfer and 
verification with a ROM Writer.  
• Using the CX-Programmer, transfer the program from the computer to the ROM Writer. 
• Transfer program from the ROM Writer to a CX-Programmer project. 
• Verify programs between CX-Programmer and ROM Writer. 
• Create Intel Hex format files from CX-Programmer programs. 
• Input from an Intel Hex format file to the CX-Programmer project.  
Note: The data transferred for each PLC is listed below. 
PLC  Data 
C1000H/2000H Program, I/O tables, SYSMAC NET data link tables, battery error 

detection method 
C200H Program, I/O tables, Fixed DM, battery error detection method 
C200HS Program, I/O tables, PLC Setup, Expansion DM, expansion 

instructions 
CQM1, CQM1H Program, PLC Setup, expansion instructions 
C200HX/HG/HE (-Z)  Program, I/O tables, PLC Setup, Expansion DM, expansion 

instructions 
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CX-Net (Network Configuration) Functions 

• CX-Net 

Menus Changed 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Unit Status and Communications 
Unit Setup were on the PLC menu. 

Operations for Communication units were separated from those for the PLCs and Unit 
Status/Error Log and Communications Unit Setup were moved to the Network menu. 

Both Setup and Edit appeared on the 
Routing Tables and Data Link 
menus. 

Setup and Edit were placed together on a Setup menu on the Routing Tables and Data Link 
menus. 
When Setup is selected online, the Routing Table or Data Link Component window is 
displayed. 
When Setup is selected offline, a dialog box with the following selections is displayed 
before the Routing Table or Data Link Component window is displayed.  
Routing tables: FINS Local, FINS Network, or SYSMAC NET 
Data links tables: Controller Link, SYSMAC LINK, SYSMAC NET 

Exporting Communications Unit Status and Error Log in CSV Format 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Unit status and the error log can be 
monitored in a window but cannot 
be saved as files. (The error log data 
must be read and then manipulated 
manually.)  

Unit status and error log data for Communications Units (Controller Link Units and 
SYSMAC LINK Units) can be written to files in CSV format. 
This allows network errors to be analyzed from CSV files.  
 

Displaying Communications Unit Error Logs for C-series PLCs 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

For C-series PLCs, the error log 
displayed when PLC | Unit Status 
was selected was the CPU Unit 
error log. (A Communications Unit 
error log could not be read or 
cleared.) 

For C-series PLCs, the error log for a Communications Unit (Controller Link Units and 
SYSMAC LINK Units) can be displayed and cleared using PLC | Unit Status/Error Log.  

Save As Operation for CX-Net Projects 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

An open project could not be saved 
under a new file name. (The file 
name could be set only when a new 
project was created. 

Select Save As from the Project menu to save a project open in CX-Net under any desired 
name.  
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• Data Links  

Changes in Edit Node Window for Manually Set Data Link Tables 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

In the Edit Node window for 
manually set data link tables, the 
start and end address for refreshing 
(send and receive) with other nodes 
were displayed only for the local 
node.  

In the Edit Node window for manually set data links tables, the start address, end address, 
and data size for refreshing (send and receive) with other nodes are displayed for both the 
local node and the remote (partner) nodes.  

Area 1 and area 2 could not be 
accessed simultaneously for 
manually set data link tables in the 
Edit Node window. 

Area 1 and area 2 can be accessed side-by-side for manually set data link tables in the Edit 
Node window.  

With manually set data link tables in 
the Edit Node window, an Area 
Specify dialog box must be 
displayed to input values.  

With manually set data link tables in the Edit Node window, values can be keyed directly 
into the tables.  
Also, a function bar that can be used to input values is displayed below with window.  

Reading and Writing Manually Set Data Link Tables in CSV Format 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Data link tables could be read and 
written only as data link table files 
(binary files). 

Manually set data link table can be read and written as CSV-format files.  
Note: CSV-format files are created using the Excel template stored in the CD. 

• Routing Tables 

Registering CPU Unit Serial Ports (Peripheral and RS-232C) in a Local Network Table (Serial 
Expansion Routing Tables)  

Previous version (Ver. 3.0) New version (Ver. 3.1) 
Only the unit number and network 
address were set in the local 
network table in the routing tables 
for Communications Units. 

A CS/CJ-series CPU Unit serial port (peripheral or RS-232C) can be set in the local 
network table in the routing tables instead of the Communications Unit's unit number. (Unit 
252 (COMM) and Unit 253 (PRPHL))  
This enables screen data to be sent from the NS-Designer (Ver. 3) via a network to an NS-
series PT connected to a serial port. 
Refer to the PT user's manual for details.  

No Network Type Setting or Display for Routing Tables 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

When the local network table in the 
routing tables were set, the local 
network type and the network type 
were displayed on the main view. 

The local network type is not set in the local network table in the routing tables for CS-, CJ-
, and CV-series PLCs and the network type is not displayed on the main view. 
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Changes in Routing Table Operation  
(Transferring Routing Tables from the Table View Tab Page)  

Previous version (Ver. 3.0) New version (Ver. 3.1) 
Routing table transfers and similar 
operations could not be performed 
from the Table View tab page. (The 
OK button had to be clicked to 
return to the Main View tab page 
first.) 

Node changes, routing table transfers, and other operations are possible from the Table 
View tab page. 

 

Detailed Information Displays when Verifying Routing Tables 
Previous version (Ver. 3.0) New version (Ver. 3.1) 

Details were not displayed when 
verifying routing tables, making it 
difficult to find errors. 

Detailed results are displayed after verifying routing tables. 
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GLOSSARY OF TERMS 
Address A location in memory where data or programs are stored. It can also identify a 

location of a node on a network. 
Application A software program that accomplishes a specific task. Examples of applications are 

CX-Programmer, CX-Server, CX-Protocol and Microsoft Excel. 
ASCII American Standard Code for Information Interchange. 
BCD Binary Coded Decimal. 
Binary Coded Decimal A data format supported by CX-Programmer: each group of four bits in the data is a 

representation of a digit (0-9). 
Binary A data format supported by CX-Programmer. A number system format to the base 2, 

i.e. employing the digits 0 and 1. 
Bit A digit used in binary notation, which can take the value 0 or 1. The value of a bit, or 

combination of bits, can represent the status of a device or can be used in 
programming. 

Boolean A type of point or symbol where the value can be one of two states. Essentially the 
two states are ‘0’ and ‘1’, but these states can be assigned a meaningful designation. 

Central Processing Unit The part of the PLC that can store programs and data, execute the instructions in 
program, and process input and output signals in order to communicate with other, 
external, devices. 

Clipboard An area within the windows environment where data can be stored temporarily or 
transferred between applications. 

Components The CX-Server application, as utilized by CX-Programmer, is made up of six 
components accessible from an invoking application. 

CPU type The type of CPU available to a specific device, the amount of memory available to a 
PLC varies according to the CPU involved. 

CPU Central Processing Unit. 
CS/CJ/CP-series Indicates any one of the following types of PLC: CS1G, CS1G-H, CS1H, CS1H-H, 

CJ1G, CJ1G-H, CJ1H-H, CJ1M, CP1H, CP1L, CP1L-E, CP1E, CP2E, CP2E-N. 
C-Series Indicates any one of the following types of PLC: C2000H, C200H, C200HE, 

C200HE-Z, C200HG, C200HE-Z, C200HS, C200HX, C200HX-Z, C1000H, C**H, 
C**K, C**P, CQM1, C500, C120, C20, CPM1 (CPM1A), CPM2*, CPM2*-S*. 

CV-Series Indicates any one of the following types of PLC: CVM1, CVM1-V2, CV500, 
CV1000 or CV2000. When using SYSMAC NET, CV series PLCs can operate in 
either CV mode (where the datagrams contain FINS commands) or C mode (where 
the datagrams contain C SYSNET commands). 

CVSS A file format supported by CX-Programmer. 
CX-Net Network Configuration tool 

A of a suite of programs allowing the management of Routing Tables and Data Link 
Tables in OMRON PLCs. 

CX-Programmer A PLC programming application for the creation, testing and maintenance of 
programs associated with the OMRON CS/CJ/CP-series PLCs, CV-series PLCs and 
C-series PLCs. It provides facilities for the support of PLC device and address 
information and for communications with OMRON PLCs and their associated 
network types. 

CX-Server An advanced communications management system for OMRON PLCs providing 
facilities for software to maintain PLC device and address information and to 
communicate with OMRON PLCs and their supported network types.  

CX-Server Project A definition of an OMRON PLC network configuration. It identifies all devices and 
networks within a particular configuration including the areas of PLC memory 
(points) that can be read from or written to. 

Data area An area of PLC memory allocated to the storage of data (not programs). 
Data Trace/Time Chart Monitor component 

The CX-Server application, as utilized by CX-Programmer, displays data obtained 
from the PLC’s memory areas during program execution. 

Data Type A type that describes the internal data format within a programming symbol (e.g. 
BCD v binary). 
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DDE Dynamic Data Exchange. A channel through which correctly prepared programs can 
actively exchange data and control other applications within Microsoft Windows. 

 See also Item, Server, server application and Topic. 
Debug mode A mode of PLC operation during which any errors arising from the currently active 

program will be flagged. For CV-series PLC only. 
Decimal A data format supported by CX-Programmer – base 10 (i.e. digits 0-9). 
Default A value automatically set by a program in the absence of user input or on initial entry 

to an application; such values can be overwritten. 
Device group A class of devices that share similar properties, each group can be sub-divided into 

device types. 
Device type A type of OMRON PLC. 
Device A type of OMRON automation device, either a PLC, Temperature Controller, 

Memory Card Writer or PROM Writer. 
Dialog A window asking for some form of response from the user, usually in the form of 

either entering requested information, selecting displayed data, or confirming an 
operation. 

DLL Dynamic Link Library. A program file that although cannot be run stand-alone as an 
executable, can be utilized by one or more applications or programs as a common 
service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone 
functions. 

Download Refer to Transfer to PLC. 
Drag The act of moving an item on the screen by selecting it with the mouse, and keeping 

the mouse button depressed, moving the mouse until the item has reached the required 
location. The mouse button is then released. 

Driver The software that controls the communications between a computer and PLC, 
translating any information passed between them into a format that the receiving 
Device can understand. 

Dynamic Data Exchange The method of transferal of data (and possibly instructions) between applications via 
the establishment of reference links between them. 

Expansion memory The memory available to a CPU in addition to conventional memory. 
Folder A structure which organizes the files in computer memory or on disk. Also known as 

a ‘directory’. 
GUI Graphical User Interface. Part of a program that interacts with the user and takes full 

advantage of the graphics displays of computers. A GUI employs pull-down menus 
and dialog boxes for ease of use. Like all Microsoft Windows based applications, CX-
Programmer has a GUI. 

Hard disk A disk permanently mounted on its drive. 
Hexadecimal A data format supported by CX-Programmer – base 16 (i.e. digits 0-F). 
Icon Pictorial representations of computer resources and functions. Many icons are used by 

CX-Programmer as part of the GUI. 
Input device A device that sends signals to a PLC. 
Interface Hardware or software employed to link the elements within a system, including 

networks, programs and computers. 
IO Table A part of a PLC set up which contains definitions of the physically connected input-

output boards attached to the PLC (i.e. racks and units). The IO table is edited via a 
CX-Server application. 

IO type Input/Output type. An attribute of a symbol that shows how the address is mapped to 
physical hardware. CX-Programmer can show an address mapped to an input or 
output card with a ‘I’ or ‘Q’ prefix respectively. 

IO Input /Output. 
LSS A file format supported by the CX-Programmer. 
Memory Card component The CX-Server application, as utilized by CX-Programmer, manages the file storage 

to and from PLC memory cards. 
Microsoft Excel A spreadsheet application. 
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Microsoft Windows Explorer A file handling application part of the Microsoft Windows suite. 
Microsoft Windows A windowing environment that is noted for its GUI, and for features such as multiple 

typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and 
the capability of moving text and graphics from one application to another via a 
clipboard. 

 CX-Programmer runs only under Microsoft Windows. DDE functions communicating 
with other applications supported by CX-Programmer use Microsoft Windows as a 
basis. 

Monitor mode A PLC operational mode that allows the device, during normal execution, to review 
the condition of the Data Link (including the PLCs/nodes on that link). 

Network 1. Part of the PLC configuration, based on the device type. The number of Networks 
available is dependant on the device type. 

 2. A number of computers linked together with a central processing point known as a 
server that is accessible to all computers. Networks affect CX-Programmer in that 
further Network associated options are available if the computer is Network 
connected. 

Offline The status of a device when it is not being controlled by a computer (although it may 
be physically connected to it). 

OLE Object Linking and Embedding. Used to transfer and share information between 
Microsoft Windows based applications and accessories. 

Online The status of a device when it is under the direct control of a computer. 
Output The signal sent from a PLC to an external device. 
Output instruction A type of PLC instruction that appears at the right of a ladder rung – it cannot be 

connected to at the right. 
Output window An area of the CX-Programmer display reserved for compilation messages and search 

results. 
PLC Error component The CX-Server application, as utilized by CX-Programmer, displays and manages 

PLC errors. 
PLC Memory component The CX-Server application, as utilized by CX-Programmer, allows the user to view, 

edit and monitor either channels (words) or individual bits in areas of the PLC. 
PLC Setup component The CX-Server application, as utilized by CX-Programmer, permits the configuration 

of PLC settings. 
PLC Programmable Logic Controller. 
Point A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The 

contents of a point may be controlled by an object or IO mechanism such as DDE. 
The contents of a point may control the action or appearance of an object, or be used 
for output via an IO mechanism. 

Program A set of instructions that are performed by a computer or PLC. 
Program memory An area of PLC memory reserved for the storage of programs. 
Program mode PLC mode of operation during which the device can be programmed. 
Project Projects consist of ladder program(s), address and network details, memory, IO, 

expansion instructions (if applicable) and symbols. Each CX-Programmer project file 
is separate and is similar in concept to a document. 

project workspace An area of the CX-Programmer reserved for displaying and selecting project content. 
Rack The apparatus to which a unit is fixed. 
RAM Random Access Memory. 
Reset Turning a bit or signal OFF or changing it to its set value or to zero. 
Run Mode PLC mode of operation during which device information is typically read-only. 
Rung A logical circuit of a ladder program (a connection from the left to the right bus-bars). 

A rung can encompass one or more columns and rows. 
Section A part of a PLC program, like a chapter is to a book. The sections are combined in 

order to form a program, and scanned in order by the PLC. 
Server application An application that can be used to view or interact with. 
 Refer also to DDE and OLE. 
Server 1. Server is used in DDE functions to contain a link to an outside application. 
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  Refer also to Server application. 
 2. A Server is the central processing point of a Network that is accessible to all 

computers. 
Signed Decimal A data format supported by CX-Programmer. 
Slots Free areas within a rack to which units can be fixed. 
Symbol An address that has been given a name to make the address information more flexible. 
Target PLC The PLC to which information or instructions are directed. 
Taskbar An integral part of Microsoft Windows that allows Microsoft Windows based 

applications to be started. CX-Programmer is run from the Taskbar. 
Text 1. A file format supported by the CX-Programmer. 
 2. A data format supported by CX-Programmer. 
Transfer from PLC The transfer of a program or data to a host (either a computer or a programming 

device) from a lower-level (or slave) device. 
Transfer to PLC The transfer of a program or data from a host (either a computer or a programming 

device) to a lower-level (or slave) device. 
Units A component of an OMRON PLC system configuration. 
Upload See Transfer from PLC. 
Watch window An area of the CX-Programmer display that is reserved for monitoring PLC addresses. 
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INDEX 

A 
About CX-Programmer - 6 
About this Manual - 1 
Access 

Address Reference tool - 33 
Cross Reference Report - 32 
Global symbol table - 16 
Ladder program - 12, 33, 51, 76 
Local symbol table - 16, 68 
Mnemonics view - 14, 93 
Output window - 34 
PLC - 25, 26, 51, 61, 62, 69, 77, 86, 89, 123, 124, 125, 126, 

127, 128, 130, 131, 132, 133, 134, 169, 170, 172 
Program - 19, 24, 77, 78, 81, 128, 129 
Project workspace - 11, 29 
Watch window - 34, 88, 90 

Address 
Ladder Information - 41 

Address Reference tool - 11, 24, 33 
Access - 33 

Advanced Topics - 137 
Writing more Maintainable Programs - 137 

Application - 213 
Applying Passwords to PLC Programs - 141 
Arrays 

Specifying - 64, 67 
Attaching Comments to Elements - 26 
Auto Online to a PLC - 95 
Automatically Transfer Program to Simulator - 39 

B 
Bit - 213 
Block Programs - 89 

C 
C Series PLCs - 143 
Cancelling the program Transfer - 127 
Change All - 50 
Check duplicated output and TIM/CNT No. - 37 
Clear All Memory Areas - 133 
Comment 

Ladder information - 41 
Commented Rung – Go To - 57 
Compatible with SYSMAC Support Software, SYSWIN, 

SYSMAC-CPT - 44 
Context sensitive menus - 11 
Converting Programs between PLCs - 141 
CPT File Loading - 52 
Cross Reference Report - 11, 32 

Access - 32 
Address information - 32 
Detailed usage - 32 
Print - 33 
Usage overview - 32 

CS/CJ/CP-Series PLCs - 143, 145 

CS1x-H PLC-Flash ROM Backup - 133 
Customer support for CX-Programmer - 7 
Cut, Copy and Paste - 54 
CV-Series PLCs - 143 
CVSS File Loading - 52 
CX-Net Network Configuration tool -  
CX-Programmer 

About - 6 
Customer support - 7 
Exit - 11 
Getting started - 9 
Licensing - 9 
Other applications - 138 
Preferences - 36 
Quick start - 9 
Tutorial - 16 

CX-Server - 213 
CX-Net Network Configuration tool -  
Data Trace/Time Chart Monitoring component -  

D 
Data Trace/Time Chart Monitoring component -  
Data-Types - 14 
DDE - 214 

Server - 216 
Deleting Items - 55 
detailed dialog mode - 78, 79, 84 
Diagram Toolbar - 156 
Diagram Workspace - 11, 12 
DLL - 214 
Download program to PLC - 24, 126 
Downloading / Uploading in program sections - 32 
Drag and Drop - 55 

E 
Entering Operands - 85 
Exiting CX-Programmer - 11 
Exporting and importing Symbols 

Information Format - 139 
Exporting and Importing Symbols - 139 

F 
File Conversion tool - 52, 53, 138 
File Loading - 52 
Find - 46, 47 
Find in area - 46 
Find Report - 47 
Finding and Replacing - 44 

Rules for: - 46 
Values - 49 

Flash ROM Backup-CS1x-H PLC - 133 
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G 
General - 43 
Getting started with CX-Programmer - 9 
Glossary of Terms - 213 
Go To - 56 

Commented Rung - 57 
Next Address Reference - 57 
Next Input - 57 
Next Output - 57 
Previous - 57 
Rung / Step Number - 56 

Go to Commented Rung - 57 
Go to online-edit rung - 26 

H 
Help - See on-line help 
Help and how to access it - 5 

Context Sensitive Help - 6 
Help Topics - 5 
Instruction Reference - 6 

How to Input - 46, 48 

I 
I/O Comment View - 26, 50, 52, 88 
IME auto start - 43 
Importing and Exporting Symbols - 139 

Information Format - 139 
Insert Toolbar - 156 
Inserting a New Program - 19 
Introducing CX-Programmer Projects - 10 
IO Table - 135 

K 
Keyboard mapping 

CX-Programmer - 160 
SYSMAC Support Soft - 162 
SYSWIN - 163 

Keyboard Mapping Reference - 6 
Keyboard Shortcuts - 155, 160 

L 
Ladder information 

Address - 41 
Ladder Information 

Comment - 41 
Name - 41 

Ladder program - See also program 
Access - 12, 33, 51, 76 
Adding Comments - 87, 88 
Amending coils - 78 
Amending contacts - 78 
Amending instructions - 81 
Auto error detection - 13, 77 

Availability of instructions - 84 
Busbars - 13 
Closed coil - 76 
Closed contact - 21, 23, 76 
Colour schemes - 13, 40 
Creating a ladder program - 21, 77 
Cursor - 13, 18 
Delete elements - 55 
Differential monitor - 80 
Differentiate - 80, 81, 84 
Edit program on-line - 124 
Editing coils - 78 
Editing contacts - 78 
Editing instructions - 81 
Example - 21 
Expansion table - 84 
Find and replace - 44 
Find instruction - 84 
Forced bits - 80 
Grid - 13, 77 
Horizontal - 23, 76 
Instruction - 21, 22, 76 
Instruction availability - 84 
Invert (NOT) - 80 
Invert state of contact or coil - 80 
Modifiers - 85 
Monitor, differential - 80 
New ladder program - 21, 77 
Open coil - 23, 76 
Open contact - 21, 22, 23, 76 
PLC power flow - 12 
Preferences - 37 
Print - 52 
Remove elements - 55 
Reverse state of contact or coil - 80 
Rung comment - 21, 77, 88 
Rung margin area - 13 
Rungs - 13 
Search instruction - 84 
Selection mode - 77 
Text comment - 21, 22, 88 
Vertical - 23, 76 

Licensing - 9 
Demo Mode - 9 
Full Version - 10 
Junior Mode - 9 
Trial Mode - 9 

Line Connect Mode - 23, 76 
Line Delete Mode - 23, 76 
Linking/Unlinking Symbols – Rules for - 140 
Load Comment/Program - 128 

M 
Magnification - 44 
Manipulating Views - 53 
Max.No.of Windows - 44 
Memory View - 90 
Microsoft Windows Features 

In CX-Programmer - 51 
Opening and Saving Projects - 52 

Mnemonics - See also program 
Access view - 14, 93 
Delete entries - 55 
Find and replace - 44 
Program editing - 93 
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Remove entries - 55 
Rung comment - 93 
Statement list block - 24 
Text comment - 93 
View - 11, 13 

Monitor in RungWrap - 123 
Monitoring Data Type - 128 
Moving an address range - 49 
Multiple rung online edit - 26 

N 
Name 

Ladder information - 41 
New Closed Contact OR - 76 
New Open Contact OR - 76 
Next Reference - 56 

O 
Offline Program Verification - 25 
Omron CX-Programmer - 1 
Online Action - 124 
Online editing - 26 
On-line help - 1, 5 
Options - See preferences 
Options and Preference 

Ladder information - 41 
Options and Preferences - 36 

Appearance - 40 
Diagrams - 37 
PLCs - 38 
Symbols - 39 

Output window - 11, 24, 25, 34, 62, 90, 127 
Access - 34 
Clear - 34 
Close - 34 
Compile - 34 
Find report - 34 
Go to error - 34 
Load from file - 34 

P 
Paste rungs to another PLC with unaddressed symbols - 39 
Pause Monitoring - 129 
PLC -  

Access - 25, 26, 51, 61, 62, 69, 77, 86, 89, 123, 124, 125, 
126, 127, 128, 130, 131, 132, 133, 134, 169, 170, 172 

Adding to a project - 61 
Changing a PLC in a project - 61 
Clock setting - 132 
Connect to PLC - 24, 51, 81, 86, 87, 95, 123, 124, 125, 126, 

127, 128, 129, 130, 131, 132, 169, 170, 171, 172 
Copy definition - 54 
Cut definition - 54 
Cycle time - 130 
Delete PLC - 55 
Deleting a PLC in a project - 62 
Editing a PLC in a project - 61 
Expansion table - 84 
File-card Transfer - 127 

Information - 132 
Instruction availability - 84 
Memory - 18 
Monitoring multiple PLCs - 26 
Move definition - 54 
Operating mode - 24, 51, 123 
Passwords - 132, 141 
Paste definition - 55 
Power flow - 12 
Preferences - 38 
Program assignments - 131 
Properties - 51 
Remove PLC - 55 
Removing a PLC in a project - 62 
Settings - 18 
Support - 2 
Transferring Programs to/from File - 127 
Verify connection - 51 

PLC Toolbar - 158 
PLCs and Projects - 61 
Points 

Address - 213 
Preferences - 36 

Appearance - 40 
Font - 41 
Ladder program - 37 
PLC - 38 
Preferences 

Ladder information - 41 
Symbols - 39 
Zoom - 44 

Previous window environment - 43 
Print 

Page setup - 52 
Pages - 53 
Preview - 53 
Program assignments - 132 
Setup - 53 

Printing Projects - 52 
Program 

Access - 19, 24, 77, 78, 81, 128, 129 
Adding a new program - 77 
Attaching Comments to Elements - 26 
Cancel on-line edit changes - 26, 31, 125 
Cancelling Transfer - 127 
Check options - 90 
Commit on-line edit changes - 26, 31, 124, 125 
Compare Computer and PLC programs - 25, 127 
Compilation check options - 90 
Compile all programs - 89 
Compile one program - 89 
Compile program - 24, 89 
Converting programs - 141 
Copy elements from a program - 54 
Cut elements from a program - 54 
Delete program - 55 
Diagram Workspace - 12 
Download to PLC - 24, 126 
Edit program on-line - 26, 95, 124 
Inserting - 19 
Inserting a program - 77 
Mnemonics - See Mnemonics 
Monitor program during execution - 25, 128 
Move elements from a program - 54 
New program - 77 
Passwords - 141 
Paste elements to a program - 55 
Pause Monitoring program - 129 
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Properties - 19, 51, 78 
Remove program - 55 
Rungs - 13 
Send on-line edit changes - 26, 31, 124, 125 
Statement list block - 24 
Stopping Pause Monitoring - 129 
Task type - 19, 51, 78 
Transfer from PLC - 25, 125 
Transfer to PLC - 24, 126 
Upload from PLC - 25, 125 

Program Editing - 76 
Program Sections - 29 

Downloading / Uploading - 32 
Program Toolbar - 158 
Project 

Access Global symbol table - 16 
Access ladder program - 12, 33, 51, 76 
Access local symbol table - 16, 68 
Access Mnemonics view - 14, 93 
Access PLC - 25, 26, 51, 61, 62, 69, 77, 86, 89, 123, 124, 

125, 126, 127, 128, 130, 131, 132, 133, 134, 169, 170, 
172 

Access program - 19, 24, 77, 81, 128, 129 
Access project workspace - 11, 29 
Adding a PLC - 61 
Changing a PLC - 61 
Checklist - 16 
Close project workspace - 11, 29 
Connect to PLC - 24, 51, 81, 86, 87, 95, 123, 124, 125, 126, 

127, 128, 129, 130, 131, 132, 169, 170, 171, 172 
Converting projects - 138 
Copying information between projects - 137 
Create a new CX-Server file - 51 
Creating a project - 18 
Deleting a PLC - 62 
Editing a PLC - 61 
Find and replace - 44 
Ladder program - See Ladder program 
Link to CX-Server file - 51, 70 
New project - 18 
Opening a project - 52 
Planning - 16 
PLC program assignments - 131 
Program - 78 
Properties - 50 
Removing a PLC - 62 
Rename a project - 55 
Saving a project - 24, 52 
Symbols - See symbols 
Workspace - 11, 18, 29 

Project Reference - 29 
Project workspace - 11, 18, 29 

Access - 11, 29 
Close - 11, 29 
Collapsing the project view - 12, 29 
Expanding the project view - 12, 29 
Find and replace - 44 

Properties - 11, 50 
PLC - 51 
Program - 19, 51, 78 
Project - 50 

Q 
Quick start guide - 9 
Quick Start Guide - 9 

R 
Racks - 215 
Redo an operation - 55 
Renaming an Object - 55 
Replace - 47 
ROM Writer - 134 
Rules for Finding - 46 
Rung / Step Number – Go To - 56 
RungWrap - 123 

S 
Save Comment/Program - 128 
Search - 46 
Search and Replace - 47 

Addresses - 48 
F3 Searching - 50 
Moving Addresses - 49 
Operands - 49 
Rules for: - 46 
Scope of the search - 47 
Symbols - 49, 50 
Text - 48 

Section/Rung Manager - 31 
Sections - 29 
Select All - 58 
Show actual I/O bit in XY - 37 
Show in simple dialog mode - 38 
Show ladder only - 43 
Show Program / Section Comments - 42 
Show Window - 43 
Show with comment dialog - 38 
simple dialog mode - 78, 81 
Slots - 216 
SSS File Loading - 52 
Standard Toolbar - 155 
Starting a New Project - 18 
Starting CX-Programmer - 9 
Statement list rungs - 89 
Status bar - 6, 11 
Stopping Pause Monitoring - 129 
Summary of Concepts - 27 
Symbol Information - 85 
Symbol Table Toolbar - 157 
Symbols - 62, 216 

Access Global symbol table - 16 
Access local symbol table - 16, 68 
Adding a symbol - 70 
Amending symbols - 70, 71 
Auto Generation - 70 
Automatic Allocation - 73 
Automatically allocating addresses - 79 
Changing symbols - 70, 71 
Copy symbols - 54, 69 
Copying and Pasting Symbols - 69 
Creating a symbol - 20 
Creating symbols and addresses - 20 
Cross Reference Report - See Cross Reference Report 
Cut symbols - 54, 69 
Data types - 62 
Delete symbols - 55 
Delete Unused Symbols - 69 
Deleting symbols - 73 
Editing symbols - 71 
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Find and replace - 44 
Global symbol table - 18 
Global symbols - 68 
Introduction to - 14 
Local symbol table - 11, 18 
Local symbols - 11, 68 
Move symbols - 54, 69 
New symbol - 20, 70 
Paste symbols - 55, 69 
Pasting Symbols with Errors - 72 
Preferences - 39 
Print - 52 
Rack Location - 14 
Remove symbols - 55 
Removing symbols - 73 
Rename symbols - 56 
Rules for Linking/Unlinking - 140 
Sharing with other applications - 51, 70, 138 
Timer/counters - 64 
Usage - 14, 32 
Validating Symbols - 69 

Synchronize ladder and mnemonic cursors - 37 
SYSWIN File Loading - 52 

T 
Technical Specification - 1 
The CX-Programmer Environment - 10 
Toolbars - 155 
Toolbars - Viewing and Hiding - 58 

Creating a New Toolbar - 59 
Customizing a Toolbar - 58 

Transfer 
Cancelling - 127 
Program from PLC - 25, 125 
Program to PLC - 24, 126 

Tutorial - 16 

U 
Undo an operation - 55 
Units - 216 
Unlinking / Linking Symbols – Rules for - 140 
Upload program from PLC - 25, 125 

Uploading / Downloading in program sections - 32 
Using CX-Programmer - 16 
Using Program Sections - 29 

V 
Version 2.0 Features - 1 
Viewing and Hiding Toolbars - 58 

Creating a New Toolbar - 59 
Customizing a Toolbar - 58 

Views 
Dock - 53 
Field descriptions - 56 
Float - 53 
Hide - 53 
Zoom - 44, 53 

Views Toolbar - 159 

W 
Watch window - 11, 26, 34 

Access - 34, 88, 90 
Close - 34, 88, 90 

Watch Window 
Differential Monitoring - 36 
Dragging and Dropping Items - 35 
Pasting Items - 36 

Window Environment - 43 
Window Features in CX-Programmer - 51 

Opening and Saving Projects - 52 
Work Online to a Simulator - 93, 95 
Writing A Ladder Program - 20 
Writing more Maintainable Programs 

Data Types - 137 
Symbols - 137 

Z 
Zoom - 44, 53 
Zoom to Fit - 44 
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Notice 
OMRON products are manufactured for use according to proper procedures by a qualified operator and only for 
the purposes described in this manual. 

The following conventions are used to indicate and classify precautions in this manual. Always heed the 
information provided in them. Failure to heed precautions can result in injury to people or damage to the product. 

DANGER  Indicates an imminently hazardous situation which, if not avoided, will result in death 
or serious injury. Additionally, there may be severe property damage. 

WARNING  Indicates a potentially hazardous situation which, if not avoided, could result in death 
or serious injury. Additionally, there may be severe property damage. 

Caution Indicates a potentially hazardous situation which, if not avoided, may result in minor 
or moderate injury, or property damage. 

 

 

OMRON Product References 
All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it refers to an 
OMRON product, regardless of whether or not it appears in the proper name of the product. 

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything 
else. 
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Visual Aids 
The following headings appear in the left column of the manual to help you locate different types of information. 

Indicates information of particular interest for efficient and convenient operation of the product. 

1, 2, 3… Indicates lists of one sort or another, such as procedures, checklists etc. 

 
Represents a shortcut on the Toolbar to one of the options available on the menu of 
the same window. 

Other manual conventions are as follows: 

• Windows-based applications provide users with a number of different ways to perform one operation. 
These are normally: from the application menu bar; using icons on a Toolbar; using keyboard shortcuts; 
using the right-mouse button to display a context-sensitive menu; dragging and dropping. Whilst 
recognising this, the manual provides user instructions employing the Toolbar and right-mouse button only. 
Use of the application menu bar or keyboard shortcuts are only included if no such alternatives exist. 

• Access to the CX-Server middleware is normally via other software applications, such as CX-Programmer 
or CX-Protocol. This is noted in the manual by the term “invoking application”. 

• This manual refers to two distinct types of project: CX-Server projects and application projects. A CX-
Server project is defined in this manual. An application project is defined by the software application 
invoking CX-Server. 

 OMRON, 2005 
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in 
any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior 
written permission of OMRON. 

All copyright and trademarks acknowledged. 

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because 
OMRON is constantly striving to improve its high-quality products, the information contained in this manual is 
subject to change without notice. Every precaution has been taken in the preparation of this manual. 
Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for 
damages resulting from the use of the information contained in this publication. 
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About this Manual 
This manual describes the CX-Server application and its ability to control and monitor a range of OMRON 
PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the 
commercial manual for the device must be consulted. 

This manual contains the following chapters: 

♦ Chapter 1 Technical Specification. This chapter describes CX-Server in general terms and introduces the 
user to the relationship between CX-Server and associated products. It also provides details of the 
operating environment, minimum configuration and installation procedures necessary for the satisfactory 
operation of CX-Server. 

♦ Chapter 2 PLC Memory Component. This chapter describes the PLC Memory Component and its ability 
to allow the user to view, edit and monitor PLC Data Areas, bits and symbols. 

♦ Chapter 3 IO Table Component. This chapter describes the IO Table Component and its ability to edit 
PLC IO Table and SIOU Settings on a PLC. 

♦ Chapter 4 PLC Setup Component. This chapter describes the PLC Setup Component and the procedures 
involved in the configuration of PLC settings. 

♦ Chapter 5 Data Trace/Time Chart Monitor Component. This chapter describes the Data Trace/Time 
Chart Monitor Component and the procedures involved when viewing Data Trace and Time Chart 
Monitoring information in either Histogram or Trend Graph mode. 

♦ Chapter 6 PLC Error Component. This chapter describes the PLC Error Component and the procedures 
involved in reading and clearing PLC CPU errors, error log entries and messages. 

♦ Chapter 7 Memory Card Component. This chapter describes the Memory Card Component and the 
procedures required to format, access and edit a PLCs memory card/compact flash and to transfer data 
between the computer or PLC and memory card/compact flash. 

♦ Chapter 8 CX-Net Network Configuration Tool. This chapter describes the procedures for establishing 
communications between PLCs across a network and ensuring that information is routed correctly to the 
target devices. 

♦ Chapter 9 PLC Clock Tool. This chapter describes the PLC Clock Tool and the procedures involved when 
adjusting the PLC clock. 

♦ Chapter 10 Data Links. This chapter describes how the Data Link Editor enables a PLC to be configured 
so that it can participate in one, or more automatic data sharing schemes, over SYSMAC LINK and 
Controller Link networks, without the need for special programming. 

♦ Chapter 11 Routing Tables. This chapter describes how Routing tables allow networked PLCs to be 
configured so that they can communicate with each other via gateways; across remote networks. 

♦ Chapter 12 PLC Backup Tool. This chapter describes how to use the PLC backup tool to back up or 
restore PLC data. 

♦ Appendix A Network Availability. The tables in this appendix indicate the network available to each PLC 
device group. FinsGateway has no network availability and is not described.  

♦ Appendix B PLC Memory Area. The tables in this appendix provide memory area details for each device 
group.  

♦ Appendix C Toolbars and Keyboard Shortcuts. The tables in this appendix summarize the toolbars and 
keyboard shortcuts available from each component tool.  

A Glossary of Terms and Index are also provided. 
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 CHAPTER 1 
Technical Specification 

This chapter describes the CX-Server PLC Tools software in general terms and introduces the user to the 
relationship between CX-Server PLC Tools and the associated products. It also provides details of the operating 
environment, minimum configuration and installation procedures necessary for the satisfactory operation of 
CX-Server PC Tools. 

CX-Server PLC Tools Software 
PLC Tools are a collection of utilities and programs that provide configuration and control for OMRON PLCs and 
Networks. 

CX-Server PLC Tools consists of the following components: 

♦ PLC Memory component. This component allows the user to view, edit and monitor either channels (words) 
or individual bits in areas of the PLC. 

♦ IO Table component. This component retrieves and configures PLC rack and address data. 
♦ PLC Setup component. This component retrieves and configures PLC setting data. 
♦ Data Trace/Time Chart Monitor component. This component records and displays data obtained from the 

PLC’s memory areas during program execution. 
♦ PLC Error component. This component displays and manages PLC errors. 
♦ Memory Card component. This component manages the file storage to and from PLC memory cards. 
♦ PLC-Clock component. This component configures and displays the PLC clock. 
♦ Routing Table component. This component manages the routing tables, which allow PLC internode 

communications. 
♦ DataLink Editor component. This component allows configuration and modification of the datalink tables, 

which allows data to be transferred between PLCs without any other programming. 
♦ CX-Net Network Configuration tool. This tool consists of a suite of programs allowing the management of 

Networks for OMRON PLCs. 
CX-Server PLC Tools utilities form part of other CX-Automation suite applications (CX-Programmer, 
CX-Server). 

CX-Server PLC Tools have a close relationship with CX-Server Runtime which is the communications 
middleware software for OMRON PLCs. For further information see CX-Server Runtime manual. 

About this Manual 
This User Manual acts as a reference for CX-Server PLC Tools by describing its various concepts and abilities, 
and provides the basics of using its dialogs and supplied utilities. 

Caution: This manual is referred to from other software applications that utilise CX-Server, for instance, 
CX-Programmer, CX-Protocol or SYSMAC-SCS.  Subsequently, some topics contained in this user manual 
may not be relevant. 

The CX-Server PLC Tools come with a context-sensitive online help system which is designed to complement 
this manual and to provide a quick reference at any point while using CX-Server PLC Tools when the manual is 
not to hand. This general help system uses a fast hypertext system which allows progressively detailed 
information about any topic to be obtained by selecting keywords within the descriptive text. 

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows, and knows 
how to: 

♦ use the keyboard and mouse; 
♦ select options from Microsoft Windows menus; 
♦ operate dialog boxes; 
♦ locate, open and save data files; 
♦ edit, cut and paste text; 
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♦ use the Microsoft Windows desktop environment. 
If the installed version of Microsoft Windows has not been used before, it is recommended that the reader spends 
some time working with it using the Microsoft documentation before using the CX-Server PLC Tools. 

CX-Server PLC Tools: New Features 
This version of the CX-Server PLC Tools offers significant functionality for communication with OMRON PLCs 
and management of their associated settings information. 

System Requirements 
The system requirements of CX-Server are the same as those of the CX-Programmer. Refer to page 3 
in Part 1: CX-Programmer for details. 

Communications Requirements  
In order to use serial communication types SYSMAC WAY and Toolbus a RS232 connections via a standard 
serial port on the PC (COM1 etc.) or a RS422 connections to a 422 serial board is required. 

When using SYSMAC LINK directly from a PC, a SYSMAC LINK network service board and FinsGateway 
version 3.12 must be installed. 

When using Controller Link, a Controller Link network service board (wired or optical and FinsGateway version 
3.12 are required. 

In order to use an Ethernet net, an Ethernet card, Windows Sockets software and TCP/IP must be installed and 
correctly configured. 

Refer to the appropriate hardware system manuals for detailed information about connecting and configuring 
these devices for the environment. 

Note: If FINS Gateway is to be used with a CLK/SLK PCI board in the Windows 2000 or 
higher operating system the appropriate drivers must be installed. These drivers can be 
found on the CX-Server CD under: CX-Server\WDM\CLK (PCI)\ or CX-Server\WDM\SLK 
(PCI)\. 

Note: The following network types cannot be run on Windows Vista or later OS. 
- Controller Link for OMRON NSB. Controller Link  
- SYSMAC LINK for OMRON NSB. SYSMAC LINK  
- SYSMAC NET for OMRON NSB. SYSMAC NET  
- CS1 Board for OMRON CS1 PCI board  
- Fins Gateway  

Starting CX-Server PLC Tools 
CX-Server PLC Tools components are normally accessed from the invoking application. However, a number of 
tools can be accessed stand-alone from the Start pushbutton on the Microsoft Windows taskbar. 

 
CX-Net Network Configuration tool. 

Help and How to Access it 
The CX-Server PLC Tools come with a detailed context-sensitive help system. At any time while using the 
software, it is possible to get help on the particular point that is currently being worked on, or on general aspects of 
the CX-Server PLC Tools. This system is intended to complement the manual, by providing online reference to 
specific functions of the software and how to use them. The manual is designed to provide more tutorial 
information and discuss the various facilities offered by the CX-Server PLC Tools. 

♦ Context-sensitive help;  
♦ Help Index (available on the Help menu); 
♦ Help Contents (available on the Help menu); 
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♦ About (available on the Help menu); 
♦ Status Bar. 

Help Topics 
For any of the PLC Tools select the Help Contents option on the Help menu. The Help system provides a standard 
look-up dialog under the Contents tab showing the contents of the PLC Tools Help file. Click on an item to read 
the associated information. 

Index 
Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Enter a text query into the first step field. The second step field is refreshed according to 

the query entered in the first step field. 
 3. Select an entry in the second step field and select the Display pushbutton, or double-click 

on the index entry. 
 4. If an entry is linked to two or more topics, the names of the topics are displayed in the 

Topics Found dialog. Select a topic and choose the Display pushbutton or double-click on 
the topic. 

Find 
Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Select the Find tab. 
 3. Enter a text query into the first step field. The second step field is refreshed according to 

the query entered in the first step field. Previous text queries can be retrieved by selecting 
from the drop-down list in the first step field. 

 4. Select a word that matches the query – some words may be automatically selected. More 
than one word can be selected by pressing Shift and selecting another word to extend the 
selection, or by pressing Ctrl and selecting another word to add to the selection. The third 
step field is refreshed according to the word or words selected. The number of topics found 
are shown at the bottom of the dialog. 

 5. Select a topic from the third step field and select the Display pushbutton, or double-click 
on the topic from the third step field. Select the Clear pushbutton to restart the find 
operation. 

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. Refer to 
Microsoft Windows documentation for further information. 

Context-sensitive Help 
The CX-Server PLC Tools support the use of context-sensitive help. The relevant online help topic is provided 
automatically by selecting the current area of the display responsible for carrying out those actions. Select the F1 
function key to retrieve context-sensitive help. Some dialogs include a Help pushbutton when F1 cannot be 
accessed. 

About CX-Server PLC Tools 
Each CX-Server PLC Tools dialog contains an About option on the Help menu. The About dialog supplies 
technical reference information about that dialog such as version and copyright information. It also contains 
essential version number information that is required for obtaining technical support. 

Use the following procedure to view the About CX-Server dialog. 

1, 2, 3… 1. Select About from the Help menu. 
2. The About box is displayed. It provides a copyright statement and version 

number of the component or tool within CX-Server. 
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Status Bar 
The Status Bar is displayed at the bottom of many of the CX-Server dialog and PLC Tool windows. It provides 
several helpful pieces of information while programming: 

♦ Instant Help. A brief message appears in the Status Bar as menu commands and buttons are selected. 
♦ Online Status. The online or offline status of the PLC. (i.e. connected to PLC or not). 
♦ PLC Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are also 

displayed here. 
♦ Connected PLC and CPU Type. The currently connected PLC and associated CPU can always be referenced 

in the status bar. 
The Status Bar can be enabled and disabled from many components and tools by selecting the Status Bar option 
from the View menu. 

Technical Support 
If the installation instructions for this application have been followed (refer to Installation in this Chapter), no 
difficulties should be encountered. However, if there is a problem, contact Customer Services. 

If a problem occurs, check that it does not relate to a fault outside CX-Server or the PLC Tools. Check the 
following: 

♦ The PC is working correctly. 
♦ The PLC is working correctly. 
♦ The communications system is set up correctly. 
♦ The errors are cleared in the PLC. 
When Customer Services need to be contacted, keep the details shown in the following table to hand. A clear and 
concise description of the problem is required, together with the exact text of any error messages. 

Note: Use the About box to obtain the version number of the component. 
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Customer Services Required Information Table 
Version number of CX-Server 
component or tool: 

 

Serial number of the software:  
Operating system and version 
number: 

 

Language of operating system:  
PLC type, model and CPU details:  
Type of communications in use:  
Serial Number  
Toolbus  
SYSMAC LINK  
SYSMAC NET  
Device Net  
Controller Link  
Ethernet  
Nature of the problem:  

Steps taken to reproduce problem:  

Other comments:  
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 CHAPTER 2 
PLC Memory Component 

This chapter describes the PLC Memory component and its ability to allow the user to view, edit and monitor 
either channels (words) or individual bits in areas of the PLC. 

The PLC Memory component allows viewing, editing and monitoring of PLC memory areas, monitoring and 
forcing of bit addresses and symbols and forced status information. 

The PLC Memory component displays the values of the memory area being accessed within the PLC. Areas to be 
monitored are selected from the memory area workspace. The address workspace shows individual bits, 
individual channel symbols and forced status information by selecting or entering specific PLC addresses or 
symbol names. The current values of these areas are displayed in the PLC Memory component. There are no 
values displayed when the PLC is offline. 

The PLC Memory component can be forced to stay as the top window by selecting Always on top from the View 
menu. 

For moving, resizing, tiling, maximising, minimising and closing windows, refer to Microsoft Windows online 
help for further information. 

Access to the PLC Memory component is from the invoking application.  

 To close the PLC Memory window, select the Close button in the title bar.  

 
The left pane, known as the Data Area Workspace, displays the current PLC in terms of its data areas and 
addresses. The data areas that form part of the PLC memory differ depending on the PLC type. The status bar 
provides instant help, displays the PLC and CPU type and describes the operating mode of the PLC. 

 To expand the hierarchy in the left pane, select this icon. 

 To collapse the hierarchy in the left pane, select this icon. 

   To view the content of a particular branch in the hierarchy, double-click on the item in the Data 
Area Workspace: a window is displayed within the PLC memory component. The associated 
icon in the Data Area Workspace changes to denote that a window has been opened. Multiple 
windows can be opened at the same time.  

 Select the Close button in the window’s title bar to close the window. 

 
Columns can be resized using the Resize Column button from the toolbar to fit the visible 
display area. These options are useful when changing data format, for instance to Binary. 

The display of the Data Area Workspace can be controlled by selecting Data Area Workspace from the View 
menu. 

The toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the PLC Memory toolbar. 
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PLC Data Area 
The Memory tab of the PLC Memory component allows monitoring and editing of complete memory areas as 
channel data. 

 

 
When the content of a memory area is opened, a window is displayed. It is possible to Zoom in 
and out of the window by selecting the Zoom In button or Zoom Out button from the toolbar. 
Select the Restore Zoom/Zoom to Fit button from the toolbar to return the window to the 
original zoom setting.  

Editing Data 
Data can be entered or amended in the data area displayed provided the associated PLC or memory area allows 
read/write operations. Use the following procedure to edit data in the Memory tab.  

1, 2, 3… 1. Double-click on the required data area name in the Memory tab of the Data Area 
Workspace to open it. A window containing a grid representing that data area is opened. 

 2. Select an appropriate format for the data to be entered from the associated button from the 
toolbar: Binary, Binary Coded Decimal, Decimal, Signed Decimal, Floating Point, 
Hexadecimal, Double Floating Point or Text. 

 3. Type in valid values directly into the cells and press Return. 
 

Note: Once a format has been selected a keyboard filter is applied so that non-valid 
keystrokes are ignored. 

When in either Debug mode (for CV-series PLCs only) or Monitor mode: it is not possible to edit a read-only 
value. 

PC to PLC Communications 
The PLC Memory component permits the transfer of data to and from the PLC and allows comparisons to be made 
between data stored on the computer and the PLC. Use the following procedure to retrieve data from the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Open a data area by double-clicking a data area from the Data Area Workspace in the 

Memory tab. 
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3. Select the Transfer from PLC button from the toolbar to read information from the PLC. 

 4. The Transfer from PLC dialog is displayed. Transfer can be performed on the memory 
areas that have been opened in the PLC Memory component. Select the associated setting 
to monitor that area. 

 5. Select the Visible Area Only option to transfer the area visible to the window, the Selection 
option to transfer the area highlighted by the cursor or the All option to transfer all of the 
selected memory area from the PLC. Alternatively, use the Select All pushbutton to 
transfer all opened memory areas from the PLC. 

 6. Select the Upload pushbutton to accept the settings or the Cancel pushbutton to abort the 
operation. 

Note: By clicking an associated data area’s settings in its greyed state, the PLC Memory 
component automatically identifies the data area words to be monitored. 

Use the following procedure to write data back to the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Open a data area by double-clicking a data area from the Data Area Workspace in the 

Memory tab. 

 
3. Select the Transfer to PLC button from the toolbar to transfer information to the PLC. 

 4. The Transfer to PLC dialog is displayed. Transfer can be performed on the memory areas 
that have been opened in the PLC Memory component. Select the associated setting to 
monitor that area. 

 5. Select the Visible Area Only option to transfer the area visible to the window, the Selection 
option to transfer the area highlighted by the cursor or the All option to transfer all of the 
selected memory area to the PLC. Alternatively, use the Select All pushbutton to transfer 
all opened memory areas to the PLC. 

 6. Select the Download pushbutton to accept the settings or the Cancel pushbutton to abort 
the operation. 

Note: By clicking an associated data area’s settings in its greyed state, the PLC Memory 
component automatically identifies the data area words to be monitored. 

The PLC Memory component allows the values stored on the PLC and the current displayed values to be 
compared. Use the following procedure to compare PLC and PC values.  

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 

 
2. Select the Compare with PLC button from the toolbar to compare information between 

the PC and the PLC. 
 3. The Compare with PLC dialog is displayed. Comparisons can be performed on the memory 

areas that have been opened in the PLC Memory component. Select the associated setting 
to compare that area. 

 4. Select the Visible Area Only option to compare the area visible to the window, the Selection 
option to compare the area highlighted by the cursor, or the All option to compare all of the 
selected memory area to the PLC. Alternatively, use the Select All pushbutton to compare 
all opened memory areas. 

 5. Select the Compare pushbutton to accept the settings or the Cancel pushbutton to abort the 
operation. 

Whilst comparing, all values resident on the PLC that are different to those on the PC are annotated in brackets. 
Further editing to the data area causes further differences between PC and PLC versions, and these are also 
annotated. 

Importing Cam Data (CJ2 Series Only) 
This function reads to PLC memory CSV-format cam data that was created using the CAM Data Creation 
Software (WS02-MOPC2). You can then transfer the data from the PLC memory component to the PLC. 
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The import procedure is given below. 

1, 2, 3… 1. Select File – Import – Import CAM data file in the PLC Memory Window. The following 
dialog box will be displayed. 

 
 2. Specify the file that is to be imported and click the Open Button. 

 
 

The amount of data to be 
imported and the size of the 
area required for the import will 
be displayed. 

Input the area to which the cam 
data is to be imported, the EM 
bank if the EM Area is used, 
and the start address. 

Select the decimal point 
positions for when the phase 
and displacement values are 
imported. The import data will 
be rounded off to the specified 
number of decimal points. 

 

 3. Set the import destination and the decimal point position for the import data. 

 4. Click the OK Button. 
The import operation will be started. After it has been normally completed, the result will 
be displayed as follows: 

 
 

Timer/Counter Memory areas 
Whether online or offline the PLC Memory component enables the data in the Timer (TIM) and Counter (CNT) 
memory areas to be formatted using either Binary Coded Decimal (BCD), Hexadecimal or Decimal data types. 
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When an Online transfer to PLC operation is executed, the PLC Memory Component will read the TIM/CNT 
mode setting from the PLC. If the TIM/CNT mode is set to BCD, then the command will be actioned only if the 
current data type is also BCD. If the data type is not BCD, then a warning message will be displayed, and the 
commend will be aborted. 

If the TIM/CNT mode is set to Binary, the command will only be actioned if the current data type is Decimal or 
Hexadecimal. If the current data is neither Decimal or Hexadecimal, then a warning message will be displayed, 
and the command will be aborted. 

When an Online Transfer from a PLC, Compare or Monitor operation is executed, the PLC Memory Component 
will read the data from the PLC and display it in the currently selected data format. If the data can not be displayed 
in the currently selected format, then an error message will be displayed. 

Note: The Timer (TIM) and Counter (CNT) memory areas are only available in the following 
PLCs: CS1G-H, CS1H-H, CJ1G-H, CJ1H-H, CJ1M, and CP1H. 

Monitoring Data 
Use the following procedure to monitor the data in PLC memory: 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 

 
2. Select the Monitor button from the toolbar to monitor the PLC. 

 3. The Monitor dialog is displayed. Monitoring can be performed on the memory areas that 
have been opened in the PLC Memory component. Select the associated setting to monitor 
that area. 

 4. Select the Visible Area Only option to monitor the area visible to the window or the 
Selection option to monitor the area highlighted by the cursor. 

 5. Select the Monitor pushbutton to accept the settings or the Cancel pushbutton to abort the 
operation. 

Once monitoring, all changes to the data area are viewed. By navigating around the data area window, the visible 
area of the monitoring set by the Visible Area Only option changes to compensate. 

Note 1:  In the PLC Memory Window, individual values (cells) can be selected and the 
following operations can be performed to change present values during monitoring.  

• For BIN (binary) displays, click the On, Off, ForceOn, ForceOff, ForceCanc, 
SetValue button to change the value of a bit. 

 The value can also be changed by right-clicking and then selecting Force | On, Force 
| Off, Force | Cancel, or Set |On, Set | Off, Set | Value from the pop-up menu.  

• For other displays (e.g., decimal, BCD, or HEX), click the SetValue button to change 
the present value. 

 The present value can also be changed by right-clicking and then selecting Set | 
Value from the pop-up menu.  

Note 2: Continuous addresses can be monitored in the PLC Memory window by specifying the 
start address to be monitored. Set the start address in the Start Address field shown 
below and the display in the window will jump to the specified address for monitoring.  
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• In the PLC Memory window, both individual bits for each word and the hexadecimal 
value of the word can be monitored at the same time if the display format is set to 
BIN (binary). 

Clearing and Filling Data Areas 

 
A whole data area can be cleared by clicking on the Clear Data Area button from the toolbar.  

A whole data area can be populated with a particular value. Use the following procedure to fill a data area with a 
single value. 

1, 2, 3… 
 

1. Open a data area by double-clicking a data area from the Data Area Workspace in the 
Memory tab. 

 
2. Select the Fill Data Area button from the toolbar. The Fill Data Area dialog is displayed. 
3. The Fill operation can be performed on the memory areas that have been opened in the PLC 

Memory component. Select the associated setting to fill that area. 
 4. Supply the value in the Value field. 
 5. Select the appropriate Fill Range option, either All, Visible Area Only or the selection 

currently highlighted by the cursor. 
 6. Select a Value option, either Binary, Binary Coded Decimal, Decimal, Signed Decimal or 

Hexadecimal.  
 7. If required, select a Set Status Value setting and the appropriate On or Off option. 
 8. Select the Fill pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
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PLC Address Area 
The Address tab of the PLC Memory dialog allows monitoring and forcing the status of individual bits. 

 

Monitoring 
Use the following to monitor an address or a symbol from an invoking application. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Monitor area by double-clicking the Monitor branch from the Data Area 

Workspace in the Address tab. 

 

4. Enter an address in the Address field or select a Symbol to be retained from the invoking 
application: 
♦ In a Symbol field, type in a Symbol name or select the Browse button to select a Symbol to be 

retained from the invoking application. The corresponding Address field automatically detects 
and contains the address associated with the Symbol. 

♦ If a Symbol has not been selected, in an Address field, type in a direct word or bit address to 
monitor. 

Note: Address notation for CS/CJ/CP-series PLCs and CV-series PLCs is, for instance ‘D0’, 
‘0’, ‘E0.0’ to monitor a word, ‘0.0’, ‘cf100’ to monitor bits. 

 When monitoring starts, data from the PLC is displayed in the Value field, in the format 
specified in the Format field. The display format of the address or symbol to be monitored can 
be changed by selecting an appropriate button from the toolbar: Binary, Binary Coded 
Decimal, Decimal, Signed Decimal, Hexadecimal or Text.  

Any special address information is shown in the Attribute field. The attribute of a bit can be forced. It is not 
possible to force bit addresses that are read-only. Use the following procedure to apply a forced setting.  

1, 2, 3… 1. Ensure a bit is currently being monitored and is not read-only. 
 2. Select the Attributes setting for the bit. 

 

 

3. Select the forced state of the bit. A bit can be forced on by selecting the Force On button 
from the toolbar. A bit can be forced off by selecting the Force Off button from the toolbar. 
Forced settings can be cancelled by selecting the Force Cancel button from the toolbar. 
Select the Set Value button from the toolbar to set a value to the attribute.  

The update rate is shown in the Properties field. 
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Further rows can be inserted into the Address Monitor window by selecting Insert from the Address menu. Rows 
can be removed by selecting Remove from the Address menu. All rows can be removed by selecting Remove All 
from the Address menu.  

 

Forced Settings 
It is possible to specify the state of an address regardless of its actual (physical) state, this is particularly useful for 
testing certain conditions or rungs in a ladder program.  

Once scanned, the Forced Status window displays the address, value and attributes for all forced bits. 

It is not possible to force bit addresses that are read-only. 

Displaying Forced Status 
The forced status of bits can be retrieved from the PLC. Use the following procedure to retrieve the forced status 
of bits from the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Click the right-mouse button on the Forced Status branch and select Scan Forced Status. 

All bit areas in the PLC are scanned to find all forced bits (Forced On and Forced Off). The 
Forced Status window is displayed showing all forced bits and their associated value and 
attributes. 

Copying a Forced Bit 
A forced bit can be copied from the Force Status window to the Address Monitor window. Use the following 
procedure to copy a forced bit.  

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Forced Status area by double-clicking the Forced Status branch from the Data 

Area Workspace in the Address tab. 
 4. Select the address to be copied with the right-mouse button in the Forced Status window 

and select Copy to Symbol Monitor Address. 

Clearing Forced Bits 
All forced bits can be cleared. Use the following procedure to clear forced bits.  

Caution: This operation will clear all forced bits in the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Forced Status area by double-clicking the Forced Status branch from the Data 

Area Workspace in the Address tab. 
 4. Click the right-mouse button in the Forced Status window and select Clear All Forced 

Addresses. 
 5. Select the Yes pushbutton to confirm the operation. 

Updating the Forced Status Window 
Use the following procedure to refresh the Force Status window. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Forced Status area by double-clicking the Forced Status branch from the Data 

Area Workspace in the Address tab. 
 4. Click the right-mouse button in the Forced Status window and select Refresh. 

Note: Enabling Force-setting/resetting Bits in the EM Area 
With CX-Programmer version 8.3 or higher and a CJ2H CPU Unit with unit version 1.2 or 
later, you can specify a bank in the EM Area to enable force-setting/resetting bits in the 
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specified bank and all banks following it. This is called the EM Area force-setting/resetting 
function.  

Use the following procedure.  

1. Select Memory Allocate − EM Memory Settings from the PLC Menu. The following 
EM Memory Settings Dialog Box will be displayed. Select the Enables the Force 
On/Off setting of EM banks Check Box in the EM Force On/Off Area, select the 
starting back from the pull-down menu in the EM Start File No. Box, and then click 
the OK Button.  

2. Go online with the CPU Unit, select Transfer – Transfer to PLC from the PLC Menu, 
and transfer the program to the CPU Unit.    
Note: With CJ2H CPU Units with unit version 1.0 or 1.1, force-setting/resetting bits 

in the EM Area is supported only for areas specified for automatic address 
assignment. With CJ2H CPU Units with unit version 1.2 or later, 
force-setting/resetting bits in the EM Area is supported both for areas 
specified for automatic address assignment and for the EM Area 
force-setting/resetting function described above. 

 

PLC Memory Management 
A number of features of the PLC Memory Component are common to both the Memory tab and Address tab. 

PLC Memory component files can be saved to the CX-Server project. Use the following procedure to save PLC 
Memory component details to the CX-Server project.  

1, 2, 3… 

 

1. Select the Save in Project button from the toolbar. The Save dialog is displayed. 
2. Select the required data areas to include in the file from the Areas to Save: field. 

 3. Enter a comment in the File Comment field. 
 4. Select the OK pushbutton to proceed. 

PLC Memory component files can be saved via a standard File Save dialog. Use the following procedure to save a 
PLC Memory component file.  

1, 2, 3… 1. Select Save to File from the File menu. The Save dialog is displayed. 
 2. The Save dialog is displayed. Select the required data areas to include in the file from the 

Areas to Save: field. 
 3. Enter a comment in the File Comment field. 
 4. Select the OK pushbutton to proceed. 
 5. A standard File Save dialog is displayed. Enter a file name in the File name field and select 

the Save pushbutton. PLC Memory files have a .MEM extension. 
Information saved to a file can be supplemented with header information set as a preference. Refer to Chapter 2 - 
PLC Memory Component for details of setting header information to a file. 

PLC Memory component files can be retrieved via a standard File Open dialog. Use the following procedure to 
open a PLC Memory component file.  

1, 2, 3… 

 

1. Select the Open File button from the toolbar to open a PLC Memory component file. A 
confirmation message box may appear if the file is already open. Select the Yes pushbutton 
to save the currently open details. Select the No pushbutton to discard the currently open 
details. Select the Cancel pushbutton to abort the operation. 

 2. A standard File Open dialog is displayed. Select a file from the Open PLC Memory File 
dialog, followed by the Open pushbutton. PLC Memory files have a .MEM extension. 

PLC Memory component data can be printed. Use the following procedure to print details.  

1, 2, 3… 1. Open the Address Monitor window from the Address tab or a data area window from the 
Memory tab. 

 
2. Select the Print Preview button from the toolbar. A preview window is displayed. 
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 3. Select the appropriate pushbutton to view the printout. 

 ♦ Select the Next Page pushbutton to view the next page of the printout; 
♦ Select the Prev Page pushbutton to view the next page of the printout; 
♦ Select the Two Page pushbutton to view two pages of the printout at once; 
♦ Select the Zoom In pushbutton to zoom in to the page; 
♦ Select the Zoom Out pushbutton to zoom out from the page; 
♦ Select the Print pushbutton to print from the preview. 
♦ Select the Close pushbutton to close the preview window. 

 
4. Select the Print button from the toolbar. A standard Print dialog is displayed. 

 5. Set up the required printer settings. Select the OK pushbutton to print the PLC Memory 
details or the Cancel pushbutton to abort the operation. 

Note: Printer specific settings can be applied prior to printing the PLC Memory details, by 
selecting Print Setup from the File menu.  

Use the following procedure to copy or move information from or in the PLC Memory component.  

1, 2, 3… 1. Select an item or items in a window.  

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar 

to move the item. 
 3. Select an area to move the items to, for instance copying data area values into another data 

area. 

 
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 

PLC Memory Preferences 
PLC Memory component preferences permits the setting of display properties for data monitoring.  

The Display tab defines the preferred display format. Use the following procedure to change the display format 
preference: 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the appropriate word display format option, either Binary, Binary Coded Decimal, 

Decimal, Signed Decimal, Floating Point, Hexadecimal, Double Floating Point or Text.  
 3. Select the appropriate bit display format option, either Text or Numeric. 
 4. If required, select the appropriate font using the Change Font pushbutton. 
 5. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
The Monitoring tab allows the monitor update interval preference to be amended. Use the following procedure to 
change the monitor update interval preference. 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the Monitoring tab. 
 3. Select a Monitor Update Interval and an associated Unit from the fields. 
 4. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
The General tab permits the setting of general preferences. Use the following procedure to change the general 
preferences. 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the General tab. 
 3. Select the Automatically Resize Column Widths option to ensure that all values remain 

visible within the data area window irrespective of their display format. It is best practise 
for this option to be set OFF when monitoring large data areas. 
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 4. Select the Prompt Before Closing an Active Monitor Window option if confirmation is 
required before closing a data area window that is being monitored. 

 5. Select the Beep on Invalid Input option to receive an audible beep when an invalid input to 
the PLC Memory component has been made. 

 6. Select the Fast Window Update option to reduce the affect of flickering when monitoring. 
 7. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
The File tab permits the setting of header information into PLC memory component files. Use the following 
procedure to change the file information. 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the File tab. 
 3. Insert a file name in the File Name field. 
 4. Insert a comment in the Comment field. 
 5. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
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 CHAPTER 3 
IO Table Component 

This chapter describes the IO Table component available to C-series, CV-series, CS/CJ series PLCs and its ability 
to create, retrieve and edit a configured PLC’s rack and address data. 

The IO Table component allows configuration of racks, slots and units within a PLC, using available hardware as 
reference. Within a PLC there are three versions of an IO Table, all of which should ideally have the same contents. 
IO Table component editing allows manipulation of the internal version of the table, and modification of the 
PLC’s view of how the hardware is configured. The three versions are: 

♦ Actual IO Table. The real hardware configuration of the PLC units and slots on power-up. 
♦ Registered IO Table. The internal PLC table: this is the one used by the PLC when running, regardless of the 

state of the actual hardware. It can be read and, for C2000 PLCs, CV-series PLCs and CS/CJ series PLCs, 
written to by the CX-Server software.  

♦ CX-Server IO Table. The IO configuration understood by CX-Server. It can be created and modified directly, 
independently from the PLC, and can be transferred with a program (for CV-series and CS/CJ series PLCs).  

The Registered Table and CX-Server’s table can be changed from the PC, but the actual configuration requires the 
physical manipulation of the PLC hardware. It is only possible to transfer the Registered IO Table in C2000, CV 
and CS/CJ series PLCs to the PLC. Editing of individual IO units in the Registered IO Table is only available in 
C1000H, C2000H, CS/CJ series and CV-series PLCs. 

The IO Table component is displayed as a hierarchical structure. The IO Table view can be expanded to show 
entries for all Remote Terminals (RTs) and the IO. All possible racks and unit numbers for the active PLC are 
displayed although these may not all be in use. An address and IO string are displayed against each rack slot or 
unit; this is used to indicate the input and output characteristics of the unit. 

The status bar displays the selected PLC and CPU type, and the current operating mode of the PLC.  

When a Remote Terminal (RT) is added, it can be expanded to provide the Terminals view, showing entries for all 
slots on that remote rack. 

Icons to the left of a rack indicate units fitted to expansion racks, SYSBUS/SYSBUS2 remote racks or IO 
Terminals. To view the content of the IO Table, double-click on a rack. The unit address is displayed in brackets 
for each slot. 

For CV-series PLCs, SIOU units are shown on the IO Table tree as a separate rack. For CS/CJ series PLCs, SIOU 
units are all integrated into the main rack.  

Whilst in online mode operations can be selected that affect the PLC, for instance creating an IO Table. These 
options are only available when the PLC is in the correct mode of operation for programming. 

The IO Table component can be forced to be displayed in focus by selecting Always on top from the Options 
menu. 

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 

Access to the IO Table component is from the invoking application or via the CX-Net Network Configuration 
Tool. Refer to Chapter 8 - CX-Net Network Configuration Tool for further details.  

 To close the IO Table dialog, select the Close button in the title bar.  

I/O Table Window Variations 
CX-Programmer Versions 6.0 and later have the following two kinds of I/O Table Windows. 

1, 2, 3… 1. I/O Table Window for the CS/CJ/CP Series (known as the CS/CJ/CP I/O Table Window) 
 2. I/O Table Window for the C Series and CVM1/CV Series (known as the C/CV I/O Table 

Window) 

Auto-selection of the I/O Table Window 
The following table shows which I/O Table Window will be selected automatically, based on the PLC model and 
computer operating system.  
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PLC Series PLC model Selected I/O Table Window 

CS/CJ/CP Series CS1G/CJ1G, CS1H, CS1G-H, CS1H-H, 
CS1D-H, CS1D-S, CJ1G-H, CJ1H-H, 
CJ1M, or CP1H 

1) CS/CJ/CP I/O Table 
Window 

Series other than 
CS/CJ/CP 

C Series: 
C200H, C200HS, C200HX/HG/HE, 
C200HX-Z/HG-Z/HE-Z, C500, 
C1000H, or C2000H 

CVM1/CV Series: 
CVM1, CVM1-V2, CV1000, CV2000, 
or CV500 C2000H 

2) C/CV I/O Table Window 
(See note.) 

Note: With version 5.0 and earlier versions of the CX-Programmer, the C/CV I/O Table 
Window is always selected, regardless of the PLC model and operating system. 

Distinguishing between the CS/CJ/CP and C/CV I/O Table Windows 
The I/O Table Windows can be identified by the names in the project directory tree and the colors of icons, as 
shown in the following table.  

I/O Table Window variation Names in project directory tree Colors of icons in project directory tree 

1) CS/CJ/CP I/O Table Window I/O Table and Unit Setup : Grey and yellow 

2) C/CV I/O Table Window I/O Table : Sky blue 

I/O Table Window Functions  
The following table describes the functions of the two I/O Table Windows. 

I/O Table Window variation Existing functions New functions 

1) CS/CJ/CP I/O Table 
Window 

Creating a registered I/O table 
(Displays Unit type, number of Units occupied, and 
number of I/O words occupied.) 

• Software switch settings (See note 1.) 

• Unit settings (See note 1.) 

• Replace Unit online. 

• Display Unit production information. 

• Register/display Unit comment. 

• Register/display Unit profile. 

• Monitor Unit error log. 
Note 1. 
The software switch settings and Unit settings are 
included in the Special I/O Unit and CPU Bus Unit 
parameter settings. 

• Special I/O Unit and CPU Bus Unit 
parameter settings 

• Specialized Support Tool startup function 
(See note 2.) 

• Display a Rack’s current consumption 
(CS/CJ Series only) and Rack width (CJ 
Series only) 

• Monitor CPU DIP Switch settings online. 
Note 2. 
When the CX-Programmer is installed from 
the CX-One. 

2) C/CV I/O Table Window Creating a registered I/O table 
(Displays Unit type, number of Units occupied, and 
number of I/O words occupied.) 

• Software switch settings 

• CPU Bus Unit settings 

• Replace Unit online. 

• Display Unit production information. 

• Monitor Unit error log. 

• When editing the I/O table offline, words can be 
reserved by installing Dummy Units. 

None 
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Special I/O Unit and CPU Bus Unit Settings 
One of the new CS/CJ/CP I/O Table Window functions sets the allocated DM area, allocated CIO area, and CPU 
Bus Unit Area (Ethernet Units only) for CS/CJ/CP-series Special I/O Units and CPU Bus Units without requiring 
the parameter addresses. (This function is supported by the CS/CJ/CP I/O Table Window only.) Even if new 
Special I/O Units and CPU Bus Units are purchased, the new Units parameters can be set just by installing the 
Unit’s CPS (Component and network Profile Sheet), so it isn’t necessary to upgrade the CX-Programmer.  

CPS File Overview 
The term CPS is short for the “Component and network Profile Sheet”, which is a CX-One file containing 
definition information for a CS/CJ/CP-series Unit or other component. The CPS files are provided in XML file 
format. 

The CX-Programmer uses the information in the CPS files to identify CS/CJ/CP-series Units in the I/O Table. 
Special I/O Unit and CPU Bus Unit settings are also based on these CPS files.  

The CPS files are composed of the following CS/CJ/CP-series Unit/Component information: 

• ID information (such as the model number, name, Unit type, and Unit version) 

• Parameter information (offset address, setting parameter name, and setting range or selection options) 

 

Unit B 

Parameter information 

ID information 

CPS file for Unit A 

Unit A 

ID information 

Parameter information 

CPS file for Unit B 

CX-Programmer I/O Table 

Data read 

Unit A settings 

Data read 

Unit B settings 

Parameter information 

Parameter data itself 

Parameter information 

Parameter data itself 

Special I/O Unit or 
CPU Bus Unit 

Special I/O Unit or 
CPU Bus Unit 

 

Specialized Tool Startup Overview (Supported when CX-Programmer Is 
Installed from CX-One) 

The Specialized Tool Startup function is a new CS/CJ/CP I/O Table Window function that can start the 
Programming Support Tool specific to a particular Unit (Special I/O Unit or CPU Bus Unit) directly from the I/O 
Table Window. (This function is supported by the CS/CJ/CP I/O Table Window only.) This function is supported 
when the CX-Programmer or other Support Tool is installed from the CX-One. The appropriate Programming 
Support Tool can start with the necessary PLC model information, Unit type, and online/offline status 
information.  

Note: Start with Settings Inherited is not available when the Network Type is Secure 
Comm.  
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Displaying an I/O Table 

Displaying the CS/CJ/CP I/O Table Window 
The CS/CJ/CP I/O Table Window is displayed when the PLC is a CS/CJ/CP-series PLC.  

Rack’s starting CIO address

Slot number

Unit’s starting CIO address Unit model
(See note.)

Unit name

Number of Unit
resources occupied
by Special I/O Unit Special I/O Unit’s

unit number
Number of output words
and number of input
words

Note: The Unit model will be blank if there is no CPS file.
The Unit model will also be blank when data for C200H Special I/O
Units has been uploaded from the PLC (Transfer from PLC).  

Note: In the CS/CJ I/O Table Window, the current consumption and width for each PLC Rack 
can be displayed as shown below by selecting Options - Consumption and Width 
offline. 

 
Item Description Remarks 

Rack Select the CPU Rack and 
Expansion Racks. 

 

Power Supply Unit Select the model of power 
supply units to use. 

 

I/O module Select the model of Pulse I/O 
Modules to use. 

This item can be specified 
only for the CJ2M CPU Unit 
with unit version 2.0 or 
later. 

Option board Select the model of option 
boards to use. 

This item can be specified 
only for the CJ2M-CPU3@ 
and CP1H Units. 

Expansion unit Tick the corresponding check 
box when an expansion unit is 
used. 

 

Consumption 
(mA) 

Indicates the total current 
consumption of the units 
registered in the I/O table by 
racks. 

 

Total power 
consumption (W) 

Indicates the total power 
consumption by racks. 

 

Width (mm) Indicates the total width of the 
units registered in the I/O table 
by racks. 

This item is indicated only 
for the CJ/CP Series. 
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 When Units which do not have CPS are registered in the I/O tables, the current 
consumption and width cannot be calculated correctly. In this case, estimated values 
marked with "*" are displayed for the current consumption and width as shown below.  

 Specifically, when a previous model of a Unit (such as C200H I/O Units) is used, 
estimated values may be displayed.  

 In this case, check the current consumption and width in the Operation Manual of the 
Unit.  

  
 Online, the current status of the DIP switches on the target PLC (CPU Unit) can be 

checked by selecting Options - DipSwitch Information.  

 

Displaying the C/CV I/O Table Window 
The C/CV I/O Table Window is displayed when the PLC is not a CS/CJ/CP-series PLC.  

 

Rack’s starting CIO address 

Slot number 

Rack number 

Unit’s starting CIO address 

Unit name 

Number of output words and 
number of input words 

Special I/O 
Unit’s unit 
number 

 

Unit Settings 

Settings for the CS/CJ/CP I/O Table Window 
The CS/CJ/CP I/O Table Window is displayed when the PLC is a CS/CJ/CP-series PLC. 

Creating an IO Table 
Creation of an IO Table whilst connected to a PLC causes the Actual IO Table in the hardware to be written to the 
Registered IO Table. An IO Table can also be edited offline and stored to file, this method is usually employed 
when designing a PLC’s IO Table. 

To create an IO Table, select Create from the Options menu. 

Slot Allocation 
The following procedure shows how to edit the I/O table in the I/O Table Window.  
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1, 2, 3… 1. Right-click the slot where the Unit will be allocated and select Add Unit (or just 
double-click the desired slot). The Select Unit Dialog Box will be displayed.  

 2. Select the desired Unit (Unit to be allocated) from the directory tree menu and click the OK 
Button.  

Setting Parameters for CS/CJ/CP-series CPU Bus Units and Special I/O Units 
After the I/O table has been created, the I/O table and Special I/O Unit/CPU Bus Unit parameters can be 
transferred from the PLC and edited in the computer, as shown in the following example.  

1, 2, 3… 1. Connect the CX-Programmer online and open the I/O Table Window.  
 2. Select Options – Transfer from the PLC from the I/O Table Window’s menu. The Transfer 

from the PLC Dialog Box will be displayed. At this point, the I/O Table and SIO Unit 
Parameters Options can be selected. 

 3. Select the options (check the boxes) for the data that you want to transfer and click the 
Transfer Button. In this case, both options have been selected. 
The I/O table and Unit parameters data will be transferred from the PLC and the transfer 
results will be displayed.  

 4. Check the transfer results and click the OK Button. The I/O table transferred from the PLC 
will be displayed.  

 5. To edit the parameters of a Special I/O Unit or CPU Bus Unit, select the Unit and either 
double-click the Unit or select Edit – SIO Unit Parameters from the menu. The selected 
Unit’s Edit Parameters Dialog Box will be displayed.  
In this case, a Controller Link Unit’s Edit Parameters Dialog Box has been displayed to edit 
the Unit’s CPU Bus Unit Allocation DM Settings.  

 

 6. Edit the parameters and, if necessary, click the Compare Button. If the Compare Button is 
clicked while the PLC is online, the software immediately checks whether the I/O table 
settings match the Unit settings (such as the allocated DM area and CIO area) actually in 
the PLC’s CPU Unit.  
If the contents do not match, the settings read from the actual Unit will be displayed in 
orange. 

 7. When you want to download the parameters set for each Unit to the PLC’s CPU Unit, click 
the Download to Unit Button.  

 8. Click the Reset Button to enable the parameter settings that have been transferred. 

Note 1: When Special I/O Unit or CPU Bus Unit settings are edited in the I/O Table Window, 
the parameters allocated in the DM Area or CPU Bus Unit Setup Area for the Unit are 
only transferred to the actual PLC when the Transfer PC to Unit Button is clicked in 
the Edit Parameters Dialog Box. They are not automatically enabled, i.e., the new 
parameter settings will not be used. Click the Reset Button to enable the parameter 
settings that have been transferred. When the Reset Button is clicked, however, 
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unexpected operation may result. Always confirm system safety before clicking the 
Reset Button. 

Note 2: When the CX-Programmer creates the Special I/O Unit or CPU Bus Unit settings in the 
I/O Table Window, it automatically uses the latest version of the CPS file that is 
available in the computer. 

• If the actual Unit’s version number is older than the latest CPS file in the computer, 
a warning will be displayed when the settings are downloaded to the Unit. A Dialog 
Box will ask whether to change the computer’s settings. 
In general, click the Yes Button to change the computer’s settings. When the Yes 
Button is clicked, the Unit version in the computer’s Unit settings will be changed 
to the actual Unit’s version number. (If the No Button is clicked, the version number 
in the computer will be newer than the actual Unit’s version number, and the newer 
version number will be displayed.) 

• Similarly, if the actual Unit’s version number is newer than the latest CPS file in 
the computer when the Unit’s settings are transferred from the PLC to the computer, 
the computer’s earlier Unit version number will be displayed. In this case, install the 
Unit’s correct (newer) CPS file in the computer. For details, refer to Installing a 
CPS File below. 
If the newer CPS File is not installed, the newer version’s Unit settings cannot be set 
and only the older Unit settings (in the older CPS file) can be set.  

Note 3: Storing the Parameter Settings Data File 

• The data set in the Edit Parameters Dialog Box can be saved in a parameter settings 
file with a .xml filename extension. To save the parameter settings, right-click the 
desired Special I/O Unit or CPU Bus Unit in the I/O table and select Save 
Parameters from the pop-up menu.  

• The saved parameter settings can also be read from a parameter settings file (.xml 
filename extension), but the settings must be for the same model Special I/O Unit or 
CPU Bus Unit. 

Note 4: Contents of Parameter Settings Data Files 
The structure of a parameter settings data file is based on the parameter settings in the 
CPS file. Parameter settings data files contain the following data: 

• Model number, Unit version number, unit number, rack number, and slot number 

• Name of the original CPS file used to create the parameter settings data 

• Parameter names and data 

Note 5: When Special I/O Unit or CPU Unit settings are performed in the I/O Table Window 
and then transferred from the PLC Memory Window, the following warning will be 
displayed if the allocated DM Area/CIO Area addresses set for Special I/O Units or 
CPU Bus Units in the I/O Table Window on the computer overlap with the PLC data 
table addresses. 

 
 Unless the CPU Bus Unit or Special I/O Unit settings have been previously transferred 

to the CPU Unit and the allocated DM Area/CIO Area data in the PLC data table for 
Special I/O Units or CPU Bus Units is to be overwritten, always click the No Button, 
shift the address, and repeat the transfer procedure.  

Note 6: CPU Bus Unit and Special I/O Unit settings are not checked for logical consistency. Be 
very careful of the logical consisting of the overall settings when making any setting 
that affects other settings, e.g., settings that enable or disable other settings. Transfer 
the Special I/O Unit or CPU Bus Unit settings to the PLC and then start operation, 
being aware that any logical inconsistencies may produce unexpected operation.  For 
example, if one setting selects either user settings or default settings and is set to use the 
default settings, it will not automatically change to enable user settings even if the 
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related user settings are made. To use the user settings, they will have to be enabled 
manually and specifically in the setting that selects either user settings or default 
settings. 

Note 7: If Create I/O Table is selected when setting Special I/O Units or CPU Bus Units in the 
I/O Table Window, the settings in the Special I/O Units or CPU Bus Units on the 
computer will be initialized. To maintain the same settings, save the Special I/O Unit or 
CPU Bus Unit settings to a file by right-clicking the Unit in the I/O table and selecting 
Save Parameters from the pop-up menu. Then, after creating the I/O tables, read the 
settings back from the file by right-clicking the Unit in the I/O table and selecting Load 
Parameters from the pop-up menu.  

Installing a CPS File 
CPS files are automatically installed in the following directory when CX-One is installed. A CPS file is created for 
each unit version of each Special I/O Unit and CPU Bus Unit. 

Program Files\Common Files\Omron\Profiles\CPSFiles 

The CX-Programmer uses the CPS File for the most recent unit version. If a backup indicates that a newer unit 
version exists, the newer version’s CPS file must be installed. Use the following procedure to install the new CPU 
File. 

1, 2, 3… 1. Select File – CPS Install. The Installation of Cps files Dialog Box will be displayed.  
 2. Specify the CPS file to be installed. 
 3. Restart the CX-Programmer. 

Note: When using Windows Vista or later OS, restart CX-Programmer using the following 
procedure before installing CPS files (i.e., start CX- Programmer using Run as 
Administrator).  
1. End all copies of the CX- Programmer that are currently running.  
2. Go to Programs − OMRON − CX-One and then right-click CX-Programmer on 

the Windows Start Menu.  
3. Select Run as Administrator from the pop-up menu. The CX- Programmer will start. 

Install the CPS file using the normal procedure after the CX- Programmer starts.  
 If CPS files are installed without running the CX- Programmer as administrator, the 

following restrictions will apply to functionality even though the CPS files will be 
installed normally. (These restrictions are imposed by the virtual store functionality of 
the OS.) If another user logs in, the CPS files will need to be installed again. The CPS 
files will not be automatically updated.  

Printing the I/O Table or Unit Parameter Settings 
The following procedure explains how to print the I/O table or a parameter list of Special I/O Unit and CPU Bus 
Unit settings.  
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1, 2, 3… 1. Select the desired Special I/O Unit or CPU Bus Unit in the I/O table and select File – Print 
from the pop-up menu. The Print Dialog Box will be displayed. 

Option 
Function 
 
I/O Table 
Prints the I/O table. 
 
Special Unit Settings 
Prints a parameter list of the Special I/O Unit or CPU Bus Unit settings. 
 
I/O Table + Special Unit Settings 
Prints the I/O table and a parameter list of the Special I/O Unit or CPU Bus Unit settings. 
 
 

 2. Select the desired print option and click the OK Button. The Print Dialog Box will be 
displayed. 

 3. To preview a print job, select File – Print Preview, select the desired print option in the 
Print Dialog Box, and click the OK Button.  

Note: When making parameter settings for a Special I/O Unit or CPU Bus Unit in the I/O 
Table Window and transferring data from the PLC Memory Window, a warning will be 
displayed if the addresses in the transferred PLC data file overlap the allocated DM 
Area or allocated CIO Area addresses set for the Special I/O Unit or CPU Bus Unit in 
the computer’s I/O Table Window. 
Always click the No Button if you do not want to overwrite the actual PLC’s (CPU 
Unit’s) allocated DM Area or allocated CIO Area address data with the PLC data table 
data after the Unit settings data has been transferred to the PLC (CPU Unit). After 
cancelling the write operation, remove the PLC data table’s allocated DM/allocated 
CIO area from the areas that will be transferred and then transfer the data again.  

Settings for the C/CV Series I/O Table Window 
The C/CV Series I/O Table Window is displayed when the PLC is not a CS/CJ/CP-series PLC. 

Creating an IO Table 
Creation of an IO Table whilst connected to a PLC causes the Actual IO Table in the hardware to be written to the 
Registered IO Table. An IO Table can also be edited offline and stored to file, this method is usually employed 
when designing a PLC’s IO Table. 

To create an IO Table, Select Create from the Options menu. 

Slot Allocation 
Use the following procedure to allocate a unit to a slot. 

1, 2, 3… 1. Select an empty slot in the IO Table component. 
 2. Click the right-mouse button and select a unit. For Single and Multiple IO Units a 

secondary selection is required from the right-mouse button menu. The type of PLC series 
and individual rack configurations determine the units that can be installed and therefore 
the content of the right-mouse button menu. The types of unit that can be selected are 
described in following paragraphs. 

Slots can also be allocated by transferring the rack information from the PLC. Refer to IO Table Component in this 
chapter for information regarding transferring IO Table information from the PLC. 

For CS/CJ/CP series PLCs, the IO fields for racks, slots and units information can be edited directly in the IO 
Table tree. 

Only those units in the Registered IO Table for CS/CJ/CP series PLCs, C200H (including C200HS/X/G/E) PLCs 
and CV/CVM1-series PLCs can be edited. 
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Note: Any slots allocated must be verified to ensure that the Real IO Table has been setup up 
correctly. 

Single and Multiple Units 
Points with an IO Type of Input, Output or Input/Output can be applied to the IO Table component. Each point 
contains a name and an address indicating its position in PLC memory. The information contained within a point 
can be read or updated by the controlling system and its status and content stored in the system’s database. An 
application accesses this point data by establishing a link between the application and the database. A point can 
have the same address as another and any comment entered against this address applies to all points at that 
location. 

All PLC series support 8-point, 16-point, 32-point and 64-point Units. CV-series PLCs and CS/CJ/CP-series 
PLCs also support 128-point and 256-point Units. 

Refer to the Run Time manual for an introduction to points. 

Counters, Position Controller, Numerical Control and ASCII Units 
Use the following procedure to apply unit settings to Counters, Position Controllers, Numerical Control and 
ASCII units. 

1, 2, 3… 1. Allocate a slot to be a Counter unit, Position Controller unit, Numerical Control unit or 
ASCII unit. The Enter SIOU Details dialog is displayed. 

 2. Enter valid settings for the Unit Number field, Address per Unit field, Input Words field and 
Output Words field. Valid settings exclude those settings that have already been used. 

 3. Select the OK pushbutton to complete the operation or the Cancel pushbutton to abort the 
operation. 

Additionally for Counters, Numerical Control and ASCII units, for CV-series PLCs and CS/CJ/CP series PLCs, 
the CIO and DM Address range need to be specified; refer to Chapter 3 - Software Switches for further 
information. 

Interrupt Units 
Interrupt units are automatically assigned until the maximum number of units has been reached. 

Sysmac-Bus Master Unit and Remote Terminals 
If the Sysmac-Bus Master option is selected from the context menu, the hierarchy in the IO Table component can 
be further expanded to expose the Remote Terminals and IO Terminals that form part of the SYSMAC-BUS 
option. Use the following procedure to apply unit settings to Sysmac-Bus Master. 

1, 2, 3… 1. Allocate a slot to be a Sysmac-Bus Master unit. The Enter RM Number dialog is displayed. 
 2. Select a unit number from the Unit Number field, either 0 or 1. 
 3. Select the OK pushbutton to complete the operation or the Cancel pushbutton to abort the 

operation. 
The Sysmac-Bus Master unit provides two types of slave units that can be applied to the slave rack in the same 
manner as a normal rack: 

♦ C500H Remote Terminal (RT); 
♦ C200H Remote Terminal (RT). 
Any units on the slave racks or other Remote IO Units connected to the master are allocated IO words according to 
the slot where the master is located.  

For C1000H and C2000H PLCs, Word multipliers are required to set the base address of IO Terminals on each 
SYSMAC-BUS Remote Master. 

SIOU/Communications Units 
SIOU/Communications Units can only be set up for CV-series PLCs and CS/CJ/CP series PLCs. 

For CV-series PLCs SIOU/Communications Units the following Unit Setup and Software Switches setup can be 
performed:  

♦ Basic (Software Switches setup only); 
♦ DeviceNet Master (Software Switches setup only); 
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♦ Controller Link; 
♦ Ethernet; 
♦ Host Link; 
♦ ISA Board Unit (Software Switches setup only); 
♦ ME-Net (Software Switches setup only); 
♦ Mini-map (Software Switches setup only); 
♦ M-Net (Software Switches setup only); 
♦ Motion Controller (Software Switches setup only); 
♦ PC (Software Switches setup only); 
♦ Syslink; 
♦ Sysmac-Bus Master; 
♦ SysNet. 
For CS/CJ series PLCs SIOU/Communications Units the following Unit Setup and Software Switches setup can 
be performed: 

♦ Controller Link Unit; 
♦ Device Net and Open Network controllers; 
♦ Ethernet Unit; 
♦ Serial Communications Unit (Software Switches setup only). 
Most of the settings for SIOU/Communications Units should have been set via the PLC setup component. Refer to 
Chapter 4 - PLC Setup Component for further details. 

Refer to Chapter 3 - Unit Setup and Software Switches for further information. 

Caution: Setup to SIOUs that have already been registered should be applied carefully. 

Verifying Correct Configuration 
If a change is made to the IO configuration that affects a type of IO word or the number of words required by a unit, 
for instance adding or removing units, an IO verification error occurs. Select Verify from the Options menu to 
ensure that an IO verification error has not occurred. If an error has occurred, use the procedures explained in 
Chapter 3 - Creating an IO Table, Chapter 3 - Slot Allocation and Chapter 3 - Transfer an IO Table to rectify any 
error.  

Unit Setup 
The Unit Setup for a selected rack IO option can be edited for CV-series and CS/CJ/CP series PLCs only. For 
C-series PLCs, refer to Chapter 8 - CX-Net Network Configuration Tool. Use the following procedure to edit the 
Unit Setup. 

1, 2, 3… 1. Highlight the rack/unit in the IO Table tree. 
 2. Click the right-mouse button and select Unit Setup. 
 3. Set the required unit setup options for the specified rack/unit. 

Note: The availability of the Unit Setup option depends on the rack/unit selected. The SIOUs 
attached to a PLC are shown in the IO Table component. 

The PLC Communications Unit Setup dialog allows both the system and software switch memory areas 
associated with a mounted Special Input/Output unit (SIOU) to be configured. 

Software Switches 
The Software Switch settings for a selected rack IO option can be edited for CV-series and CS/CJ/CP series PLCs. 

For CV-series PLCs, the Software Switch settings appear in the IO Table tree as SIOU Units. For CS/CJ/CP series 
PLCs, the Software Switch settings appear in the IO Table tree as part of the Main Rack information. 

The dialog which is presented for software switch setup depends upon the type of the SIOU and allows the 
software switch memory area associated with a mounted SIOU to be configured. Software switches provide status 
information on each SIO unit on the PLC. 
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Note: It is also possible to edit the Inner Board software switches for the CS/CJ series PLC if 
fitted by selecting Inner Board Software Switches option from the PLC’s context menu. 

The Software Switch dialog is displayed allowing the network unit system memory area to be configured and 
transferred to the PLC. Software switches can be defined for the following: 

♦ SYSMAC LINK. Allows set up of Data Link (on/off) and Internode Test (on/off) and setting of response 
monitor time; 

♦ SYSMAC NET. Allows set up of Data Link (on/off) and Internode Test; (on/off);  
♦ Ethernet. Allows set up of Internode Test (on/off) and setting of response monitor time. 
♦ Controller Link. Allows the polling status of the node to be set (whether it is a polling or polled unit) and 

whether to clear the Controller Link unit EPROM. 
Use the following procedure to edit the Software Switch Setup. 

1, 2, 3… 1. Highlight the rack/unit in the IO Table tree. 
 2. Click the right-mouse button and select Software Switches. 
 3. Set the required software switch setup options for the specified rack/unit. 

General 
The General tab of the Software Switches dialog provides the complete software switches settings for a Basic unit, 
PC unit, Mini-map unit, Host Link unit, Motion Control unit, ME-Net unit, DeviceNet Master unit and ISO Baud 
unit. It also serves as partial software switches settings for other units. 

1, 2, 3… 1. Access the Software Switch dialog for an appropriate rack/unit. 
 2. Set the required CIO and DM area address in the CIO Address field and DM Address field. 

Data Link Area 
The Data Link tab is used to control whether Data Link is generated automatically or by a specific Data Link table 
for SYSMAC LINK, SYSMAC NET and Controller Link. This setup is only used if the Node Type is Master. The 
list box at the bottom of the chapter is only used when Data Link is set to one of the automatic options (i.e. not 
specific). 

1, 2, 3… 1. Select Transfer from PLC from the Options menu to transfer the current system area 
settings from the unit. 

 2. Select the required unit and click the right-mouse button. Select the Software Switches 
setting. 

 3. Adjust the settings as required. 
 4. Select Transfer to PLC from the Options menu to transfer the network parameters to the 

unit. 
 5. Select the Reset Unit setting to restart the unit - the written settings are activated in the unit. 

Note: If the unit which is being set is the one on which the current communication to the PLC 
is being made, the PLC needs to be closed and opened before communications can 
continue. 

Ethernet 
The Ethernet setup differs from SYSMAC LINK, SYSMAC NET and Controller Link by not having a Data Link 
Area setup and by having two further dialog boxes, the IP Address Table and IP Router Table. This particular 
interface requires that each device attached to the network has an IP address, and that routing information for 
directing data across the network is also included (where necessary); such address information ensures that data is 
transmitted correctly between two nodes. 

Note: Table information is only used if the IP Address Conv. Method radio button is not set to 
Auto. 

The File Transfer Protocol (FTP) allows access to a file card on the PLC. If a FTP login name and password are 
entered then these are used to start an FTP session. For more information, refer to the Ethernet User’s Manual. 

The IP Address Table dialog allows the IP address of a network node to be entered. 

1, 2, 3… 1. Select the Ethernet Unit from the IO Table and click the right-mouse button. 
 2. Select the Unit Setup option. 



 PART 2: CX-Server PLC Tools  
OMRON CHAPTER 3 – IO Table Component 
 
 

 CX-Server PLC Tools_Page 31 

 3. Click on the Insert pushbutton. 
 4. Enter the IP Address for the node in the IP Address field; each of the four fields must take a 

value in the range 0 to 255. 
 5. Select the OK pushbutton to proceed. 
 6. Click on the Delete pushbutton to remove the address from the table. 
 7. Select Transfer from PLC from the Options menu to write the changes back to the table. 

The IP Router Table establishes communications between different networks by maintaining the IP address for 
each interface and is created by clicking on the Insert pushbutton above the IP Router table dialog. Procedures are 
the same as for the IP Address Table described above. 

Syslink Unit and Controller Link Specific Settings 
A Syslink unit Software Switches dialog includes a General tab and Data Link tab described previously. 

The Error Information tab provides read-only information regarding the errors that the PLC can detect and raise 
an error flag. 

The Network Status tab provides network status information. It also activates the PLC to perform internode tests. 
Select the Start option to set the PLC to check for errors and report them. Select the Stop option to stop the PLC 
from detecting errors. The Network Node List field lists the network nodes and whether they are participating in 
the network operations. 

Sysmac-Bus2 Unit Specific Settings 
A Sysmac-Bus2 unit Software Switches dialog includes a General tab described previously. 

The Slave tab provides specific status information to the Sysmac-Bus2 unit. There are various types of slave that 
may be connected to a Remote IO Master unit. These slaves include IO Terminals, Programmable Displays and 
Remote IO Slave units. 

To view the slaves connected for a group, select the Group required from the field at the top of the Slaves tab. The 
remainder of the Slaves tab displays the Node and Status for each category. 

If the hierarchy of the IO Table has been expanded, the three groups can be populated with other units: 

♦ Group 1. 16-point and 32-point IO units. 
♦ Group 2. 16-point, 32-point, 64-point and 128-point IO units and 256-point dummy. 
♦ Group 3. 58M Remote Terminal, 54MH Remote Terminal and 122M Remote Terminal. 
 

Serial Communications Unit Specific Settings 
Serial Communications unit specific software switches settings can only be set for CS/CJ/CP series PLCs. 

A Serial Communications unit Software Switches dialog includes a General tab described previously. 

The Port 1 tab and Port 2 tab are identical. Settings can be specified for the Format field, Mode field and 
Hardware field. 

Displaying Unit Error Log in the IO Table 
By selecting a CPU Bus Unit or Special IO Unit in the IO table tree and clicking the right mouse button to select 
the Unit Error Log Menu, the error log for the selected Unit can be displayed (CX-Programmer Ver. 4.0 or later). 

IO Table Management 
Changes made to an IO Table can be done by simply editing particular fields in the table. Basic information can be 
changed by displaying the configuration, selecting the rack or unit that needs to be changed and editing or 
selecting the new IO address or configuration information. 

All slot allocations in the IO Table can be cleared. Select Clear from the Options menu. 

An IO Table unit in the PLC’s Registered IO Table in the PLC can be deleted. Use the following procedure to 
delete an IO Table Unit.  
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1, 2, 3… 1. Highlight the rack/unit in the IO Table to be deleted. 
 2. Click the right-mouse button and select Delete. 

The CX-Server IO Table component can be examined to determine if it has a valid configuration. To check an IO 
Table, select the Check option from the Options menu. A message is displayed indicating whether the operation 
was successful or not.  

The CX-Server IO Table component can compare the local IO Table on the PC with the CX-Server project 
settings and displays any differences or errors. Select the Compare with Project option from the Options menu.  

PC to PLC Communications 
The IO Table component permits the transferring of data to and from the PLC and allows comparisons to be made 
between data stored on the PC and the PLC.  

Note: If the CX-Programmer is Ver. 6.0 or later and the PLC is a CS/CJ/CP-series PLC, the 
Special I/O Unit and CPU Bus Unit parameter settings can be transferred as well as the 
I/O table.  

Transfer an IO Table from a PLC 
The Transfer from PLC option loads the Registered Table into the CX-Server IO Table, replacing the currently 
displayed setup. The IO Table can also be part of a general transfer which may, for example, include transferring 
program and memory data from the PLC. Use the following procedure to transfer an IO Table from the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Transfer from PLC from the Options menu to transfer an IO Table from the PLC. 

The IO Table component is refreshed with the details from the PLC. 

Note: If only I/O Table is selected and only the I/O tables are uploaded from the actual PLC to 
the computer, the settings in the Special I/O Units or CPU Bus Units on the computer 
will be initialized. To maintain the same settings, save the Special I/O Unit or CPU Bus 
Unit settings to a file by right-clicking the Unit in the I/O table and selecting Save 
Parameters from the pop-up menu. Then, after uploading the I/O tables, read the 
settings back from the file by right-clicking the Unit in the I/O table and selecting Load 
Parameters from the pop-up menu.  

Transfer an IO Table to a PLC 
The Transfer to PLC option loads the CX-Server IO Table into the Registered Table: this is only available to 
C2000, CV and CS1-series PLCs. The table can be transferred to the PLC at any time (when the PLC is online) but 
the operation can be delayed until other configuration settings have been made and then the complete 
configuration can be transferred to the PLC via the PLC Setup component. Use the following procedure to transfer 
an IO Table to the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Transfer to PLC from the Options menu to transfer an IO Table to the PLC. 

Note: If the PLC Setup area is either written to the PLC or to the IO Table area the PLC may 
need to be powered down and powered up in order for settings take effect. If the 
settings need to be changed without switching off the PLC, write the PLC Setup data 
first, then either generate or write the IO Table. Refer to Chapter 4 - PLC Setup 
Component.  

Comparing an IO Table 
The Registered IO Table can be compared with the CX-Server IO Table and displays any differences. This option 
is helpful to confirm that a table that has been set up in CX-Server and has been transferred to the PLC, agrees with 
how the hardware is set up. Use the following procedure to compare a Registered IO Table with the CX-Server IO 
Table. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Compare with PLC from the Options menu. 

Any differences (if any) are displayed in the IO Table component. 
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Starting Specialized Support Tools 
Starting Specialized Programming Support Tools (Supported When Support Tools Were Installed from CX-One) 

When the CX-Programmer and other Programming Support Tools have been installed from the CX-One, the 
Programming Support Tool specific to a particular Unit (Special I/O Unit or CPU Bus Unit) can be started directly 
from the CS/CJ/CP I/O Table Window by right-clicking the desired Unit in the I/O table and selecting Start 
Special Application from the pop-up menu. 

♦ If the Unit is right-clicked in the I/O table and Start Special Application - Start with Settings Inherited is 
selected, the PLC model information, Unit model, and online/offline status information will be passed to the 
Programming Support Tool automatically when it starts. 

♦ If the Unit is right-clicked in the I/O table and Start Special Application - Start Only is selected, the 
Programming Support Tool will be started in the same way as it is from the Windows Start Menu. 

The following diagram shows how each Programming Tool can be started and how the I/O Table Window can be 
opened from the Programming Tool. 
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CX-Programmer 

 

I/O Table 

 
 
 
 
 

CX-Integrator 

 
CX-Position 

 
CX-Protocol 

 
CX-Process Support Software 

 
CX-Motion 

 
CX-Motion-NCF 

Serial Communication Board/Unit 
(CS1W-SCB@@) 
(CS1W/CJ1W-SCU@@) 

Position Control Unit 
(CS1W/CJ1W-NC@@@) 

Motion Control Unit 
(CS1W-MC@@@) 

Loop Control Unit/Board 
(CS1W-LC001/LCB@@) 

Loop CPU Unit 
(CJ1G-CPU@@P) 

Process CPU Unit 
(CS1D-CPU@@P) 

Controller Link Unit 
(CS1W/CJ1W-CLK@@) 

Ethernet Unit 
(CS1W/CJ1W-ETN@@) 

SYSMAC LINK Unit 
(CS1W-SLK@@) 

DeviceNet Unit 
(CS1W/CJ1W-DRM@@) 

MECHATROLINK-II Position Control Unit 
(CJ1W-NCF@@) 

CS/CJ-series CPU 
Unit 

The CX-Programmer can be 
started from a CS/CJ-series 
PLC in the Network 
Configuration Window. 

CS/CJ/CP Series CPU Unit 

CPU Rack 

The I/O Table 
Window can be 
opened only when 
online. 

The I/O Table 
Window can be 
opened only when 
online. 

The I/O Table Window 
can be opened only 
when online. 

Start Special Application 

CX-One 

 
CX-FLnet 

 
CX-Motion-MCH 

MECHATROLINK-II Motion Control
Unit 
(CS1W/CJ1W-MCH@@) 

Profibus-DP Master Unit 
(CS1W-PRM@@) 

FL-net Unit 
(CS1W/CJ1W-FLN@@) 

EtherNet/IP Unit or 
Built-in port or  

CJ2B-EIP21 Inner Board  
in CPU Unit (CJ2H-CPU6@-EIP) 

CJ2M-EIP21 Inner Board  
in CPU Unit (CJ2M-CPU3@) 

 
Network Configurator 

 

 

Note: With some of the Programming Tools (CX-Integrator, CX-Protocol, and CX-Process 
Tool), the I/O Table Window can be opened from the Programming Tool as shown by 
the dotted lines above, but only when the PLC is online.  
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PLC Specific Features 
A number of features specific to types of PLC are described in the following paragraphs. 

Hot Swapping 
Hot swapping is permitted for C1000H/C2000H PLCs and allows modules to be changed without having to power 
down. The modules swapped must be identical. To Hot Swap, select the Hot Swap option from the Options menu. 

Note: With a CS1D or CVM1D CPU Unit, hot swapping (i.e., online replacement) is possible 
during operation for Basic I/O Units and, for the CS1D, Special I/O Units and CPU Bus 
Units as well. Open the I/O tables for the project, select the Unit to be replaced, and 
select Hot Swap from the Options menu. Click the Start Hot Swap button, remove the 
old Unit, mount the new Unit and click the End Hot Swap button. Perform this 
operation for each Unit to be replaced. 

   
 

Note: Online replacement is possible for a CS1D or CVM1D CPU Unit in any operating 
mode. 
Use the following settings in the Change PLC dialog box. 

CPU Unit being used PLC type selection list CPU Unit model  

CS1D-H CS1D-H CPU65, CPU67, CPU67A or 
CPU68A 

CS1D-S CS1D-S CPU44, CPU67, CPU44A or 
CPU67A 

CVM1D CVM1-V2 CPU21 
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Setting Rack Start Addresses 
This option is only available to CV-series PLCs and CS1-series PLCs. Use the following procedure to set Rack 
Start Addresses. 

1, 2, 3… 1. Select Rack Start Addresses from the Option menu. The Rack Start Addresses dialog box is 
displayed. 

 2. Enter the addresses for each rack as required. Select the OK pushbutton to accept the 
settings or select the Cancel pushbutton to abort the operation. 

Note: 1. For CS1-H, CJ1-H, CJ1M, CS1D-S, CJ2H, and CJ2M CPU Units in the CS- and 
CJ-series PLCs, select Options | Rack/Slot Start Address and the following dialog box 
will appear. 

   
Note:  2. Select Slot Start Address Settings and click the OK button. The Slot Start Addresses 

Settings dialog box shown below will appear. 

   
Note:  3. The start address for a Rack and slot number can be specified.  

This can be used, for example, to allocate fixed addresses to Input Units and Output 
Units. Note: The start address information set for Racks and slots can be downloaded 
and uploaded for the CPU Unit. 
4. For CS1-H, CJ1-H, CJ1M, and CS1D-S CPU Unit Ver. 2.0 or later with 
CX-Programmer Ver. 4.0 or later, up to 64 sets of rack/slot numbers and start addresses 
can be set. 

Units Profile Information 
For CS1-series PLCs, SIOU’s, CPU SIOU’s and other units, unit manufacturing information can be retrieved, the 
data read and comments saved against each unit to a Compact Flash disk when fitted. Use the following procedure 
to view the unit manufacturing details: 

1, 2, 3… 1. Highlight the PLC name and click the right-mouse button. 
 2. Select Unit Manufacturing Information and then either CPU Unit or Inner Board 

 Note:  An error is displayed if the unit does not support manufacturing information. The 
unit version for CS/CJ/CP-series Units can be checked in the Unit Manufacturing 
Information (CX-Programmer Ver.4.0 or later only). 
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CHAPTER 4 
PLC Setup Component 

This chapter describes the PLC Setup component and the procedures involved in changing a PLC’s settings both 
offline and online. 

The PLC Setup component allows the PLC settings to be entered for individual C-series PLCs, CV-series PLCs or 
CS/CJ/CP-series PLCs. More than one PLC Setup component can be opened at any one time allowing a number of 
PLCs to be configured simultaneously. 

Once a PLC has been defined in a project in terms of name, device type and network type, changing various 
settings allows the PLC behavior to be altered. Options can also be selected to check the PLC is functioning 
correctly. 

The tabbed PLC settings component shows only options available for the selected PLC. Some options will be 
greyed out in instances where they are not applicable to the PLCs current state. 

The status bar displays the PLC and CPU type and the operational mode of the PLC. 

Note: When configuring a PLC it is advisable to have the PLC operational manual available 
for reference. A warning is displayed before any changes are made to a PLC’s current 
state. This gives the option of cancelling the procedure. 

Note: The information provided in this chapter is not definitive because of the wide variety of 
PLCs and their differing nature - even within the same PLC series. Consult the relevant 
PLC operating manual for specific PLC settings information. 

The PLC Setup component can be forced to stay as the top window by selecting the Always on top option from the 
Options menu. 

For Moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help. 

Access to the PLC Setup component is from the invoking application and also via the CX-Net Network 
Configuration Tool, refer to Chapter 8 - CX-Net Network Configuration Tool for further information. 

 To close the PLC Setup dialog, select the Close button in the title bar.  

CS/CJ/CP-Series PLC Settings 
The following paragraphs describe the features of the PLC Setup component associated with CS/CJ/CP-series 
PLCs. Refer to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and 
from the PLC. 

The common Set Default option resets PLC Setup component values to the default settings. 

PLC Startup 
The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always take 
effect on startup (until they are explicitly altered). Use the following procedure to apply settings in the PLC 
Startup tab. 

Startup Hold 
The Hold area in the PLC’s Work Area Memory retains the status when either the operating mode is changed, 
power is interrupted or the PLC operation is stopped. You can select one or all the following options for the hold 
area to retain. 

1, 2, 3… 1. Force Status Hold Bit - Specifies that the status of the forced status hold bit is to be 
maintained (ticked) or reset to OFF when power is next turned on. 

 2. IOM Hold Bit - Specifies that the status of the IOM hold bit is to be maintained (ticked) or 
reset to OFF when power is next turned on. 

Mode 
This selects the default PLC operation mode when the PLC is powered on: 

♦ Program - Select this for online programming when the PLC is powered on. 
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♦ Monitor - Select this to start monitoring the running program when the PLC is powered on. 
♦ Run - Select this to run the PLC’s program when the PLC is powered on.  
♦ Use Programming Console - This is the default setting that allows you to select the operating mode when 

online. 
In addition to the above, the following settings are available for CJ1-H, CS1-H, and CP1H PLCs. 

Execution Settings 
For the CJ1-H, CS1-H, and CP1H PLCs series PLCs set the Execution Setting options as appropriate. 

1, 2, 3… 1. Run program when initialize unit/board. Check the tick box to select this option. 
 2. Service for units when Inner Board recognition. Check the tick box to select this option. 

Settings 
The Settings tab of the PLC Setup component allows execution processes and controls to be defined and EM 
allocation to be enabled. 

Note: For CS1-H, CJ1-H, and CP1H PLCs only, this tab is called CPU Settings. 

Execute Process 
Use the following procedure to apply Execute Process settings. 

1, 2, 3… 1. Low Battery Enabled - Select (tick) this option to flag when CPU Unit battery errors are 
detected.  

 2. Interrupt Task Enabled - When this option is selected interrupt task errors will be detected. 
 3. Stop CPU Error Enabled - Select this option to determine if instruction errors (instruction 

processing errors (ER) and illegal access errors (AER)) are to treated as non-fatal or fatal 
errors. 

 4. Don't register FAL to error log - Select this option (tick) to stop registering FAL to error 
log. 

Memory Allocation 
CS/CJ-series PLCs can select either Memory Card or EM (Expansion Memory) specified file area. Each time EM 
is selected, the EM is reformatted automatically. 

To use EM rather than Memory Card, select the EM File Setting enabled setting and enter the EM Start File No. 
CS/CJ-series PLCs can use EM as file memory, either as or as well as Compact Flash disk. When transferred to the 
PLC, EM is formatted. 

In addition to the above, the following settings are also available for CJ2, CJ1-H, and CS1-H PLCs. 

Note:  With a CJ2 CPU Unit, select PLC - Memory Allocation - EM Memory Settings from 
the menus to set EM file memory. 

Background Execution 
1, 2, 3… 1. Table data process instructions. Select (tick) this option to enable Table date process 

instructions. 
 2. String data process instructions - Select (tick) this option to enable String data process 

instructions. 
 3. Data shift process instructions - Select (tick) this option to enable Data shift process 

instructions. 
 4. Com port number - Enter a number between 1 and 7 inclusive, to set the Com port you wish 

to connect by.  
Caution: Entering a com port number higher than the number of ports actually available 
will prevent future connections to that PLC. 

Timings 
The PLC Timings tab of the PLC Setup component allows cycle, interrupt and event timings to be defined. Use the 
following procedure when applying settings in the PLC Timings tab for standard CS/CJ/CP-series PLCs. When 
setting the timings for other PLC types follow the on-screen instructions. 
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1, 2, 3… 1. Check the Watch Cycle Time setting and set the watch cycle time if enabled for the PLC; 
the default is 0 ms. 

 2. Deselect the Set Time to all Events setting to enter a time period for all event processes; this 
is entered as a percentage of the total cycle time. 

 3. Check the Power Off Interrupt setting, and set if enabled for the PLC; the default is 0ms. 
 4. Set the Cycle Time setting to define the time interval for cycles. 
 5. Set the Scheduled Interrupt Interval setting to schedule interrupts to occur at regular 

intervals; either every 10 ms or a specific value can be set. 

SIOU Refresh 
The SIOU Refresh tab of the PLC Setup component allows SIOU Status to be enabled. Check the required Enable 
SIOU Status setting for each SIOU in the field. 

Unit Settings 
The Unit Settings tab of the PLC Setup component allows timings for the individual rack slots associated with the 
PLC to be set. Select the required slot(s) from the rack field and the required unit setting; the default is 8 ms. 

Host Link Port 
The Host Link Port tab of the PLC Setup component defines the protocol which allows transferring data between 
the PLC and the host PC. The default settings may be used or an alternative communications protocol defined. 
Some of the options may not be applicable depending on the device type selected. Use the following procedure to 
apply settings in the Host Link Port tab. 

1, 2, 3… 1. The Port Settings default is 9,600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
Customised port settings can be entered by deselecting the Default setting. 

 2. Select the CTS Control setting to enable use of CTS. 
 3. Set the Unit Number setting for the selected PLC. 
 4. Set the Delay value; a pre-set transmission delay in the range 0000 to 9999 (for BCD this is 

in 10 ms units). 
The following entries cannot be amended: 

♦ Link Words. These word addresses are fixed at LR00 to LR63 (or bit addresses from LR0000 to LR6315). 
♦ Start Code and End Code. The message start and end codes. 
♦ NT Link Max. 

Peripheral Port 
The Peripheral Port tab of the PLC Setup component defines the connection between the PC and PLC. The 
default settings may be used or an alternative communications protocol defined. Use the following procedure to 
apply settings in the Peripheral Port tab. 

1, 2, 3… 1. The Port Settings default to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
Customised port settings can be entered by deselecting the Default setting. 

 2. Set the Unit Number setting for the selected PLC. 
The NT Link Max setting cannot be amended. 

Peripheral Service 
Note that this tab is only available for the CS1-H and CJ1-H PLCs (CS1G-H, CS1H-H, CJ1G-H and CJ1H-H). 

The tabbed dialog is split into three sections as follows: 

Sync/Async Comms 
Execution Mode - The default for this option is Not Specified, and as such means that all other parts are disabled 
except for Set time to all events. 
Select one option from the list to set the execution mode. Choosing Not Specified will disable all the options 
within the Peripheral Service dialog, except for 'Set time to all events'. Not Specified is the only way of setting the 
Peripheral Service Execution Time to zero. 
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If Peripheral Service is chosen, editing Peripheral Service Execution Time is possible, and the system sets the 
default to 0.1. See also Instruction Processing (Peripheral Service Execution Time). 
Specifying Asynchronous will disable the same options as Not Specified, and set the Execution mode to 
Asynchronous processing. Synchronous likewise sets the Execution Mode to Synchronous processing. 

Peripheral Service Mode 
Instruction Execution Time - A value within and including the range of 5 to 255 or 0 can be entered as a valid 
setting. 
Peripheral Service Execution Time - A value within and including 0.1 to 25.5 can be entered as a valid setting. For 
more information on when this option is available, see Sync/Async Comms, Execution Mode, above. 
Target Unit (1, 2, 3, 4, 5) and SIOU - The default for this setting is Not Specified. There are five possible options 
for this setting. After Not Specified, the next option is CPU SIOU. If this option is selected, the SIOU number 
should be entered in the box to the right marked 'SIOU'. The next option is SIOU, and likewise with the CPU 
SIOU option, the SIOU number should be entered in the box to the right marked 'SIOU'. The three remaining 
options allow either the Inner Board, Host Link Port or Peripheral Port to be set as the 'Target Unit'. 

Set time to all events 
Set time to all events (default 4%) - By ticking the checkbox, the default as stated above will be set. If the 
checkbox is not ticked, then a value between 0 and 255 inclusive can be entered, making a maximum setting of 
25.5 (255 *0.1). This option is found in the Timings tab for all other CS/CJ-series PLCs. 

Duplex Settings 
The Duplex Setting tab is activated by selecting the Duplex Settings option from the PLC Settings Options menu.  

 
With this option checked, use the Tabs scroll buttons to scroll to the right and click on the Duplex Settings tab to 
bring it to the front. The options in this dialog can now be set to provide the appropriate communications setup 
within the selected Communications Units. The dialog is divided into five sections as follows: 

Note: The Duplex Setting tab is available for CS1H-H 65 & 67 PLCs but is only applicable to the CS1D series 
PLCs. 

Operation Settings 
Run under Duplex Initial – This option should be selected if it is required to run two Units in parallel with Duplex 
Initial execution. Note that this setting only takes effect at startup or at the start of an operation. It cannot be 
changed during an operation. 

Return Automatically – Select this option when it is required to execute a process that returns to Duplex Operation 
automatically. 

Communications Unit Duplex Setting 
From the list of Communications Units select those that are to be run in duplex mode. If more than one Unit is set 
to duplex mode the options selected will be applied to each Unit. It is not possible to set different options for 
different Communications Units. To execute the Communication Duplex operation an IO table must be created or 
transferred. Note that this setting only takes effect at startup or at the start of an operation. It cannot be changed 
during an operation. 

Hot Swap 
Allow Plural Units - Selecting this option enables Units operating in Parallel or Duplex mode to be replaced while 
online. The Units, which can be exchanged while online are, Basic IO Units, SIOUs, and CPU SIOUs of the 
CS-Series PLCs. Note that this option can be selected while online. 
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STB Serial Settings 
Allow STB-COMM – Selecting this option will enable the Host Link Port of the Standby CPU. This option should 
not be selected if it is required to continue with communications when changing from Duplex operation to 
Standby operation. 

CPU Unit Duplex Transfer Settings 
Transfer Program – This option should be selected if it is required to skip the Transferring Program area at Duplex 
Initial operation after exchanging CPU units, (Verify will be executed). If programs can be matched beforehand, 
use this setting to reduce the Duplex Initial Operation time. 

EM Division Transmission – This option should be selected when it is required to transfer Duplex Initial data in 
specified EM sizes. If the option is not selected the complete EM area will be transferred at once. Note that this 
may cause the cycle time to be expanded for a short time. 

Division Size – If the EM Division Transmission option has been selected the value entered for the division size 
will determine the size of the EM area to transfer. Note that this setting only takes effect at startup or at the start of 
an operation. It cannot be changed during an operation. 

Transfer Parameter Area of Inner board – Select this option when it is required to transfer the Parameter Area of 
the inner board between Units. 

Transfer Variable Area of Inner board – Select this option when it is required to transfer the Variable Area of the 
inner board between Units. 

Saving the PLC Setup to a CSV File (CJ2 CPU Units Only) 
The values set in the PLC Setup in all of the tab pages can be saved in CSV file format. CSV files are convenient 
for operations such as creating specification sheets, because they can be edited using commercially available 
applications. 

Note:  Once data has been saved as a CSV file, it cannot be read again by the CX-Programmer. 
1, 2, 3… 1. In the PLC Setup Window, select Save To CSV File from the File Menu.  

 
 2. Click the Save Button. The CSV file will be saved. 
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CV-Series PLC Settings 
The following paragraphs describe the features of the PLC Setup component associated with CV-series PLCs. 
Refer to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and from the 
PLC. 

The common Set Default option resets PLC Setup component values to the default settings. 

PLC Startup 
The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always takes 
effect on startup (until they are explicitly altered). Some of the options may not be applicable depending on the 
device type selected. Use the following procedure to apply settings in the PLC Startup tab. 

1, 2, 3… 3. The status of the Force Status Hold setting, IOM Hold Bit setting and Restart Continuation 
Bit setting in the Startup Hold area of the PLC’s Work Area memory can be set so that they 
are either maintained or reset to OFF on power up.  

 4. When power is restored after an interruption, the IO Bits setting and Power-On Status 
setting must be selected and the PLC startup mode must be set to Run or Monitor. 

 5. Set the Mode setting to either Program, Monitor, Run, Debug or Use Programming 
Console. The default mode is Program. 

 6. Set the Display Mode setting. The 7-segment display of the IO Interface units, IO Control 
unit and SYSMAC BUS/2 Remote IO Slave units can be set to one of three modes. The 
mode is indicated by the position of the decimal point. 

 ♦ Mode 1. Displays the first IO word allocated to the rack (000 indicates an error). This is the 
default mode. 

 ♦ Mode 2. Displays the CPU operating status (A or -) and error status 
(E, F or -), peripheral connection and rack number. 

 ♦ Mode 3. Displays a 4-character message when the IODP (189) instruction is executed in the 
unit’s program. 

 5. Check the Automatically Transfer User Program setting to automatically transfer the user 
program from one of the PLCs memory cards when the PLC starts-up. 

 6. Check the Display modes at startup setting to display all selected modes on startup. 

Error Log  
The Error Log tab permits certain settings to be applied to error logging. Either Data Memory (DM) or Extended 
Memory (EM) areas can be selected to hold the PLC’s Error Log. Refer to Chapter 6 - PLC Error Component for 
a description of the Error Log. Use the following procedure to apply settings in the Error Log tab. 

1, 2, 3… 1. Check the Enable Error Log setting to enable error logging. If this is not selected, the 
default log auxiliary memory is assigned. 

 2. Enter the Start Address setting for the error log. This is only enabled if the Enable Error 
Log setting has been selected. 

 3. Enter the EM Bank Number setting if the Error Log is to be stored on an installed Extended 
Memory Card. The Start Address setting needs to be set to the relevant area of EM. This is 
only enabled if the Enable Error Log setting has been selected. 

 4. Enter the Number of Records setting for the number of records to be held in the PLC Error 
component. 

Note: An Error Log in the Auxiliary Area (words A100-A199 for CV1000) can contain up to 
20 error records. To increase the size of the log (to 2047 records), move it to either the 
DM or EM areas. 

Execution Controls 
Instructions can be executed and peripheral servicing performed by either using: 

♦ Event driven (asynchronous) processing mode. The peripheral servicing process interrupts the execution 
process cycle by sending IO refresh requests. 

or 
♦ Synchronised processing mode. The execution and peripheral servicing processes wait for each other to 

complete the task in hand.  
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Consult the PLC operational manual for details when defining the execution controls. Use the following procedure 
to apply settings in the Execution Controls tab. 

1, 2, 3… 1. An operand can be indirectly addressed via the DM area in either Binary or BCD. Select the 
Binary setting or the BCD setting as required. 

 2. Set the Step Timer setting for the SFC step instructions. The default is 0.1 s. 
Note: For CV1000, CV2000 and CVM1/CPU21-EV2 PLCs, EM can be used for indirect 

addressing of an operand. 
Note: The Step Timer setting is not available to CVM1 PLCs. 

Execution Controls 1 
Use the following procedure to apply settings. 

1, 2, 3… 1. Check the Measure CPU-Bus Unit Cycle setting for the CPU to measure the service cycle. 
 2. Check the Detect Low Battery setting to flag PLC and Memory Card low battery. 
 3. Check the CPU standby on initialisation of bus units setting to ensure the CPU remains in 

standby until SYSMAC BUS/2 terminators are detected. If this is not checked, PLC 
operation begins regardless of the presence of terminators. 

 4. Check the Error on power off interrupts setting to ignore a momentary power interruption 
(and not generate an error) or leave unchecked to generate an error on power off. 

Execution Controls 2 
Check the following settings as required. 

♦ The Duplication action error setting. 
♦ The Multiple JMP000 use setting. 
♦ The Run program on IO verify error setting. 
♦ The Startup trace setting. 
♦ The Nest IO interrupts setting. 
♦ The IO Interrupt setting. 

Host Link Port  
The Host Link Port tab of the PLC Setup component defines the protocol which allows transferring data between 
the PLC and the host PC. The default settings may be used or an alternative communications protocol defined. 

Use the following procedure to apply settings in the Host Link Port tab. 

1, 2, 3… 1. The Port Settings default to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
 2. Select a Unit Number setting for the Host Link port setting. This has a maximum value of 

31. 

IO Refresh  
The IO Refresh tab of the PLC Setup component allows the specification of refreshes and their definition as either 
timed or immediate refreshes. Some of the options may not be applicable depending on the device type selected. 
Use the following procedure to apply settings in the IO Refresh tab. 

1, 2, 3… 1. Check the Zero-cross setting to ensure output devices accurately switch on/off high power 
devices when minimum current is flowing (when the AC power supply crosses zero). 

 2. Check the Cyclic setting to generate a cyclic refresh at the end of program execution. 
 3. Check the Scheduled setting to specify a time interval between interrupt refreshes. This is 

in the range 0 ms to 120 ms. 
 4. Check the Immediate Refresh setting to allow program instructions to be set to interrupt for 

immediate refreshing. The Scheduled refresh setting must be set to 00 ms. 
Note: Scheduled refreshing is not available if the PLC is set for synchronous operation. 
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Address Enable 
The Address Enable tab of the PLC Setup component allows addresses to be entered for selected local racks. Some 
of the options may not be applicable depending on the device type selected. Use the following procedure to apply 
settings in the Address Enable tab. 

1, 2, 3… 1. Enter an address for each required Local rack setting. The first word can be set between 0 
and 511. Word allocations must not overlap. The default for the CPU rack is zero. If word 
allocations overlap, they are ignored and the address returns to zero. Racks selected without 
a designated first word is allocated words automatically beginning from CIO 0000. 

 2. Enter the Group 1 and Group 2 values. This is the first word between CIO 0000 and CIO 
0999 for each SYSMAC BUS/2 Group 1 and 2 Masters. 

 3. Enter the Group 3 values. These are the first word for each SYSMAC BUS/2 Group 3 Slave 
between CIO 0000 and CIO 0999 for each SYSMAC BUS/2 Group 1 and 2 Masters and the 
first word for each SYSMAC BUS/2 Slave rack between CIO 0000 and CIO 2555. 

 4. Enter the RT Terminals, SIOU and IO terminals addresses as required. 
Note: Each group (Group 1, 2 and 3) has pre-set values assigned as a default. Group 1 and 

Group 2 supports 32 and 16 IO units respectively. Group 3 is reserved for racks and 
supports eight racks, each of which supports eleven slots. 

PLC Timings  
The PLC Timings tab of the PLC Setup component allows cycle, interrupt and event times to be set. Use the 
following procedure to apply settings in the PLC Timings tab. 

1, 2, 3… 1. Check the Watch Cycle Time setting and set the watch cycle time if enabled for the PLC; 
the default is 1000 ms. 

 2. Check the Power Off Interrupt setting, and set if enabled for the PLC; the default is 0 ms. 
 3. Set the Cycle Time setting to define the time interval for cycles. 
 4. Set the Scheduled Interrupt Interval setting to schedule interrupts to occur at regular 

intervals; either every 10 ms or a specific value can be set. 

Hold 
The Hold tab of the PLC Setup component allows the Hold area of the PLC’s Work Area memory to be defined. 
Use the following procedure to apply settings in the Hold tab. 

1, 2, 3… 1. Check the Enable Hold Area setting to enable the Hold area and select its Start and End 
Address settings. 

 2. Check the required racks from the CPU field. 
 3. Check the required Sysbus/2 remote master from the Sysbus/2 Remote Master field. 
 4. Check the required Sysbus remote master from the Sysbus Remote Master field. 

C-Series PLC Settings 
The following paragraphs describe the features of the PLC Setup component associated with C-series PLCs. Refer 
to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and from the PLC. 

The common Set Default option resets PLC Setup component values to the default settings. 

PLC Startup 
The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always take 
effect on startup (until they are explicitly altered). Use the following procedure to apply settings in the PLC 
Startup tab. 

Mode 
This option selects the default PLC operation mode when the PLC is powered on. 

1, 2, 3… 1. Program – Select this for online programming when the PLC is powered on. 
 2. Monitor – Select this to start monitoring the running program when the PLC is powered on. 
 3. Run – Select this to run the PLC’s program when the PLC is powered on. 
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 4. Pre-Powerdown mode – In this mode the PLC uses the operating mode last used before the 
power was turned off. 

 5. Use Programming Console – This is the default setting that allows you to select the 
operating mode when online. 

SIOU 
The SIOU Area DM settings are highly PLC specific and are dependent upon PLC selected and the SIOU mode. 
Refer to the online help for detailed information. 

IOM 
This option specifies that the status of the IOM hold bit is to be reset to OFF (ticked) or maintained when power is 
next turned on. 

Forced Status 
This option specifies that the status of the forced status hold bit is to be reset to OFF (ticked) or maintained when 
power is next turned on. 

Console Language 
Select the Console language to either English or Japanese as appropriate (CPM1/1A only). 

Expansion Instructions 
Set to either Default or User Settings. This option is only available for SRM1, CPM2* PLCs. 

CompoBus/S Devices (CPM2*-S*) 
Select the Maximum number of CompoBus and S Devices to either 16 or 32. 

Communications Mode (CPM2*-S*) 
Sets the communications mode to either High-Speed or Long-distance. 

Memory Error on Capacitor Failure 
Select this option if a memory error on capacitor failure is to be recorded. 

Cycle Time 
The Cycle Time tab of the PLC Setup component allows the total cycle time for the CPU unit to be defined. This 
period is the time taken to complete monitoring, program execution and IO port servicing. Use the following 
procedure to apply settings in the Cycle Time tab. 

1, 2, 3… 1. Cycle Monitor Time setting. This option sets the time allowed for the CPU unit to cycle 
through the type of operations indicated above. If it is exceeded, an error is generated and 
the CPU unit is stopped. 

 2. Cycle Time setting. Use this option to define a minimum cycle time by selecting a time 
period in the range 1 to 9,999 ms. The default is Variable (with the CPU calculating the 
cycle time in each cycle). 

 3. Servicing Time setting. This option allows the percentage of the defined cycle time which 
can be used to service a port to be set. It can be set for the Peripheral Port, RS232C Port, 
Comms Port A and Comms Port B. 

Note: The Cycle Time setting is ignored if the Cycle Monitor Time setting is longer and vice 
versa (provided a minimum time has been defined). The CPU unit waits until the longer 
of the two time periods has elapsed before starting the next cycle. 

Interrupt/Refresh 
The Interrupt/Refresh tab of the PLC Setup component allows certain PLCs to interrupt the main program by 
input and scheduled interrupts in order to call a subroutine. Use the following procedure to apply settings in the 
Interrupt/Refresh tab. 

1, 2, 3… 1. Interrupt Response - Set the interrupt mode to High Speed to interrupt immediately or to 
Normal to wait for the current process to complete. 
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 2. SIOU Refresh setting - This option must be set to Disable Refresh when the Interrupt 
Response setting is set to High Speed (if the Disable Refresh setting has been set and the 
Interrupt Response is set to Normal, the Disable Refresh setting is ignored). 

 3. Schedule Interrupt Unit setting - These are interrupts for which you can select regular 
intervals of either a fixed 10 ms duration or Set in increments of 1 ms.  

 4. SIOU Cyclic Refresh setting - Set the SIOU Cyclic Refresh setting if required. An SIOU 
Cyclic Refresh Unit(s) must be specified if an SIOU refresh setting has been made. 

The CQM1 PLCs support input and scheduled interrupts to stop the main program to run a subroutine.  

The following Interrupt/Refresh options are available with the CQM1H. 

 5. Interrupt Enable – This option allows you to set the various IR value interrupts to either: 
Normal (default), Interrupt or Quick. 

 6. Input Constant - This option allows you to set the input constant of IR000 Bits. Select the 
value in milliseconds as appropriate.  

 7. Pulse Output 0/1 Unit – Set the output pulse 0 and 1 to either Relative or Absolute.  

Port Settings  
The Peripheral Port, Comms Board A, Comms Board B and Host Link Port tabs of the PLC Setup component 
defines the settings for the connection between the PC and PLC. The default settings may be used or an alternative 
communications protocol defined. Use the following procedure to apply settings. 

1, 2, 3… 1. The Port Settings are set to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
Customised port settings can be entered by deselecting the Default setting. The Mode 
setting can be set to one of the following connection types: 

 ♦ PC. 
♦ Hostlink 1 to n. Multiple PLC RS422/485 connections to the PC. 
♦ RS232C. Single PLC RS232 connection to a printer or from a reader. 
♦ 1-to-1 Link Slave. Sets PLC as slave in an RS232 PLC to PLC connection. 
♦ 1-to-1 Link Master. Sets PLC as master in an RS232 PLC to PLC connection. 
♦ NT Link 1:1. For using NT link commands in an RS232 PLC to PT (Programmable Terminal) 

connection. 
♦ NT Link 1:n.  For using NT link commands in an PLC to RS422/485 multi-PT connection.  
♦ Protocol Macro 1:1. Single PLC RS232 to device connection. 
♦ Protocol Macro 1:n. PLC to RS422/485 multi-device connections. 

 2. Select the CTS Control setting to enable use of the CTS line on the PLC. 
 3. Set the Unit Number setting for the selected PLC. 
 4. Set the Delay setting; a pre-set transmission delay in the range 0000 to 9999 (for BCD this 

is in 10ms units). 
The following entries cannot be amended: 

♦ Link Words. These word addresses are fixed at LR00 to LR63 (or bit addresses from LR0000 to LR6315). 
♦ Start Code and End Code. The message start and end codes. 
♦ NT Link Max.  

Error Settings 
The Error Settings tab of the PLC Setup component defaults to the detection and reporting of long cycle times, 
interrupt errors and low battery condition. Use the following procedure to apply settings in the Error Settings tab. 

1, 2, 3… 1. Cycle Time - Check the Do not detect long cycles option to stop detection and reporting of 
long cycles. 

 2. Styles - Check the Do not store records option if records are not to be stored. 
 3. Battery - Check the Do not detect low battery option if low battery condition is not to be 

reported on. 
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High Speed Counters 
The CQM1H-CTB41 high-speed counter board is an Inner Board applicable to units CPU51 and CPU61. A 
maximum of two boards can be mounted simultaneously in slots 1 & 2 of the PLC.  The high-speed counter board 
counts high-speed pulses from 50 to 500 kHz entering through ports 1 to 4. It performs tasks according to the 
number of pulses counted.  

When the present value of the high-speed counter matches a specified target value or lies within a specified range, 
the bit pattern specified in the comparison table is stored in internal output bits and external output bits. A bit 
pattern can be set for each comparison result and the external output bits can be output through an external output 
terminal. 

Up to four external outputs can be produced when either the target value is matched or a range comparison 
condition is satisfied. The high-speed counter board does not provide high-speed counter interrupts, it simply 
compares the present value to target values or comparison ranges and produces internal and external bit outputs. 

CPM1/CPM1A PLCs have a high-speed counter function that can be used in incrementing mode or up/down 
mode. The high-speed counter can be combined with input interrupts to perform target value control or zone 
comparison control that is not affected by the PLCs cycle time.  High-speed counter signals can be input to CPU 
bits 00000 through 00002. In incrementing mode, input 00001 can be used as a regular input. 

High Speed Counter/Synchronised Pulse Control 
Select the appropriate option to determine the parameters of the high speed counter. If the option ‘Don’t use either 
function’ is selected the counter is disabled and the Counter Reset and Counter Mode option are disabled. 

Counter Reset 
Select the counter reset mode of operation, either Z phase and software reset or Software reset only. 

Counter Mode 
Select the appropriate option to determine the counters mode of operation. 

Device Net 
I/O Link Refresh Area 

Note: This tab is only available for the CPM2*-S* PLCs. 
1, 2, 3… 1. Standard - Select this button to set the standard/default settings for the I/O Refresh Area. 

 2. Custom - Select this button to make your own settings. 
 3. Write: These setting are the same as Read, but without the option of selecting the 'AR' 

memory area. 
 ♦ Area - This option defaults to IR area 1, but can be set to IR area 2, DM area, LR area or HR area. 

♦ Address - This is the beginning address number. 
♦ Size - The default is 0. However, if the size is 0 for Write, then the size for Read must be 1, or 

vice versa. Any custom setting's maximum value is determined by what the Area and Address 
values before it were set to. For example, if IR area 1 is selected, and the maximum address is 
specified (in this case max = 49), then the maximum size is 1. (The size value is specified in 
Words). 

 4. Read: These setting are the same as Write, but with the additional option of being able to 
selecting the 'AR' memory area for reading. 

 ♦ Area - This option defaults to IR area 1, but can be set to IR area 2, DM area, LR area or HR area. 
♦ Address - This is the beginning address number. 
♦ Size - The default is 0. However, if the size is 0 for Write, then the size for Read must be 1, or 

vice versa. Any custom setting's maximum value is determined by what the Area and Address 
values before it were set to. For example, if IR area 1 is selected, and the maximum address is 
specified (in this case max = 49), then the maximum size is 1. (The size value is specified in 
Words). 
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PLC Status 
These options determine the status of the PLC. 

Append PLC Status on top of IN data - Select this button to Append PLC Status on top of IN data, or choose 'Do 
not append PLC Status'. 

Do not append PLC Status - Select this button to not append PLC Status on top of IN data, or choose 'Append PLC 
Status on top of IN data'. 

PC to PLC Communications 
The PLC Setup component permits the transferring of data to and from the PLC and allows comparisons to be 
made between data stored on the PC and the PLC. 

Uploading PLC Settings 
The Transfer from PLC option loads the settings from the PLC into the PLC Setup component. Use the following 
procedure to upload PLC settings. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Setup component. 
 2. Select Transfer from PLC from the Options menu. A confirmatory dialog is displayed. 

The PLC Setup component is refreshed with the details from the PLC. 

Downloading PLC Settings 
The Transfer to PLC option loads the settings to the PLC. Use the following procedure to download an IO Table. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Setup component. 
 2. Select Transfer to PLC from the Options menu. A confirmatory dialog is displayed. 

Comparing PLC Settings 
The Verify option compares the settings on the PLC with those on the PLC. This option is helpful to confirm that 
a table that has been set up in CX-Server and has been downloaded to the PLC, agrees with how the hardware is set 
up. Use the following procedure to compare PLC settings. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Verify from the Options menu. 

Any differences (if any) are displayed in the PLC Setup component. 
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 CHAPTER 5 
Data Trace/Time Chart Monitor Component 

This chapter describes the Data Trace/Time Chart Monitor component and its ability to display either the PLCs 
uploaded data trace buffer or monitored data obtained from the PLC’s memory areas during program execution. 

Data held in a PLC’s memory areas can be monitored and traced during program execution. When displayed, this 
information provides a valuable tool for analysing the program’s performance. 

The Data Trace/Time Chart Monitor component has two separate modes of operation: 

♦ Data Trace. The PLC can be configured to trace a number of channels and bits and can sample these when a 
trigger condition is activated. When the PLC trace buffer is full or the user stops the trace, the trace buffer can 
be uploaded and viewed – the trace however, is complete. Values do not change on the screen, all sampling is 
achieved in the PLC and displayed when finished.  

Note: This functionality is not supported for CP1E CPU Units. 
♦ Time Chart Monitor. A number of channels and bits can be configured and monitored online. The changing 

values are displayed in the monitoring view as either a trend graph or histogram. A trigger condition can also 
be set which resets the sampled amount of data. Monitoring continues until stopped by the user. 

 
With the CX-Programmer version 6.0 and later versions, data collected by the Data Trace and Time Chart Monitor 
functions can be saved in standard CSV files (with .csv filename extension). The data saved in standard CSV files 
can be analysed and printed in programs such as Microsoft Excel.  

The status bar provides instant help, the PLC and CPU type, the current operating mode of the PLC and the status 
of the Data Trace/Time Chart Monitor component. 

The Toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the Data Trace/Time Chart 
Monitor toolbar. 

The Data Trace/Time Chart Monitor component can be forced to stay as the top window by selecting the Always 
on top option from the Options menu. 

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help. 

Access to the Data Trace/Time Chart Monitor dialog is from the invoking application.  

 To close the Data Trace/Time Chart Monitor dialog, select the Close button in the title bar.  

Continuous Trace function for CJ2 CPU Units Only 
Saving the result of Data Trace to a personal computer enables continuous and long operation on CJ2 CPU Unit. 
CPU Unit reads the status of specified bit or the present value of specified channel according to the sampling 
conditions and save it to Trace Memory in CPU Unit. CX-Programmer reads the data stored in CPU Unit and 
display it on the monitor in Time Chart format. CX-Programmer continues to partially read the contents of Trace 
Memory and display them on the monitor till Trace Memory on CPU Unit becomes full. Collecting the data of 
longer period is possible.  
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Note: Setting trigger conditions is not possible on the Data Trace of continuous and long 
operation. 

Types of Data Trace Window 
CX-Programmer Ver.8.0 or later have two types of Data Trace window as follows.  

1) The Data Trace window for CS/CJ/CP (hereinafter referred to as “Data Trace window for CS/CJ/CP). 
2) The Data Trace window of the previous version (Ver.7.2 or before) (hereinafter referred to as “Data Trace 

window for C/CV”). 

The Conditions of Automatic Selection 
PLC Model automatically selects the type of Data Trace window and Data Trace starts.  

PLC Series PLC Model Type of Data Trace 
window 

CS/CJ/CP Series, 
NSJ Series, FQM 
Series 
 

CS1G/CJ1G, CS1H, CS1G-H, 
CS1H-H, CS1D-H, CS1D-S, NSJ, 
CJ2H, CJ2M, CJ1G-H, CJ1H-H, 
CJ1M, CP1H, CP1L, CP1L-E, 
FQM1-CM, FQM1-MMA, 
FQM1-MMP 

1) Data Trace 
window for 
CS/CJ/CP 

Other Series  Other than the above 

• CP Series: 
CP1E  

• C Series: 
C200H, C200HS, C200HX, 
C200HG, C200HE, C200HX-Z, 
C200HG-Z, C200HE-Z, C1000H, 
C2000H 

• CVM1/CV Series: 
CVM1, CVM1-V2, CV1000, 
CV2000, CV500 

2) Data Trace 
window for C/CV  

The Functions of Data Trace Window 
The functions of two types of Data Trace window are as follows. 

Type of Data Trace window  Function 
1) Data Trace window for CX/CJ/CP  • Including 2ch data and 4ch data, Trace is executable on all data 

types (of CJ2 CPU only). 

• Continuous Trace is executable (CJ2 CPU only) 

• Enlarge rate and offset is settable per Trace Object.  

• Print of Trace result, Save in CSV format and Bit Map format 

• Import/ Export of Trace Settings is possible. 

• Enlarged view of the selected area with mouse is possible to 
display. 

2) Data Trace window for C/CV  • Trace with or without code of 1ch data and 2ch data and Trace in 
Hexadecimal are possible.  

• Saving the Trace result in CSV format is possible.  

Sampling Ranges 
The following paragraphs discuss sampling ranges specific to PLC series. 

CS/CJ/CP-series PLC Sampling Range (Except for CJ2 CPU Units) 
The CS/CJ-series PLC can trace a maximum of 31 bits and 6 words and performs data tracing using one of the 
following methods: 

♦ Setting a timer interval. The trace can be performed in increments of 5ms during a 5-2550 ms cycle. To 
sample data only once each cycle, set the interval to 0 ms.  

♦ Including the TRSM (170) instruction in the PLC’s program. This instruction identifies the points in program 
execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’. 

Note: The buffer for Data Trace is 4K words. 
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CJ2 CPU Unit PLC Sampling Range 
The CJ2 CPU Unit PLC can trace a maximum of 31 bits and 16 words and performs data tracing using 
one of the following methods: 
♦ Setting a timer interval. The trace can be performed in increments of 1ms during a 1-2550 ms 

cycle. To sample data only once each cycle, set the interval to 0 ms.  
♦ Including the TRSM (170) instruction in the PLC’s program. This instruction identifies the points 

in program execution where specified data is to be stored in Trace Memory. The timer interval 
must be set to ‘TRSM’. 

Note: The buffer for Data Trace is 32K, 16K, or 8K words depending on model. 

CV-series PLC Sampling Range 
The CV-series PLC can trace a maximum of 12 bits and 3 words and performs data tracing using one of the 
following methods: 

♦ Setting a timer interval. The trace can be performed in increments of 5 ms during a 5-2550 ms cycle.  
♦ Including the TRSM(170) instruction in the PLC’s program. This instruction identifies the points in program 

execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’.  

C-series PLC Sampling Range 
The C-series PLC can trace a maximum of 12 bits and 3 words and performs data tracing using one of the 
following methods: 

♦ Setting a timer interval. A Data Trace can be performed at regular, independent intervals by setting a timer 
interval from the peripheral device. 

♦ Including the TRSM(45) instruction in the PLC’s program. This instruction identifies the points in program 
execution where specified data is to be stored in Trace Memory. 

Note: Data Tracing cannot be performed from a Programming Console. 
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For CS/CJ/CP-series 
Trace 
Parameter Settings of Data Trace for CS/CJ/CP  
Following is the Parameter setting method of Data Trace for CS/CJ/CP. 

Display [Data Trace Configuration] dialog box. 

1 Select [Data Trace] from [PLC] menu on main window (in the case that Data Trace Window is already open 
and Time Chart Monitor is selected, [Operation]|[Mode]|[Data Trace]). 

2 Select [Operation]|[Settings] on Data Trace window. 
[Data Trace Configuration] dialog box will appear as follows. 

 
 

Button  Function  
[Import] For reuse of the parameters of Data Trace used in the past. *1 

[Export] Save the parameters of the present Data Trace in a file (*.csv). 

[Transfer (PC to PLC)] Write parameters of Data Trace to PLC and execute the trace. 
When [Start Executing Automatically After Download] is 
checked, Write is enabled. 

[Transfer (PLC to PC)] Click on to read parameters of Data Trace already set in PLC. 
Use for Re-executing Data Trace under the same setting 
conditions. 

[Compare] Compare parameters of Data Trace set in PC and PLC. 

[OK] End Parameter Edit. Use for finishing Edit without starting Data 
Trace. 

[Cancel] Delete Parameters of Data Trace after Edit. 

*1: Parameter files exported in a project for a CJ2H CPU Unit or a CJ2M CPU Unit can be 
used only for the same type of CPU Units. Different types of CPU Units cannot import 
them. 
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3 Click on the items to be set.   
4 Click on [Transfer(PC to PLC)] or [OK] after all settings are done. 

The setting details of each tab will be discussed later.  
Settings on [Settings] tab 
Set operation conditions of Data Trace.  Select [Settings] Tab on [Data Trace Configuration] dialog box. 

 
Item Function 

[Trace Type] Select Data Trace type.  
The above screen displays the settings when [Trace] is 
selected. 

∗Please refer to “Settings of Continuous Data Trace” for the 
settings when [Trace(Continuous)] is selected. 

[Sampling Settings] Select sampling conditions of Data Trace.  
[Fixed Interval]  
Sample with fixed interval. Set sampling cycle in milliseconds. 
I/O data per sampling cycle will be sampled.  
[Once Per Cycle] 
1 Sample per scan. I/O data will be sampled after END 
instruction is executed.  
[Once Per Synchronous Operation Cycle]*1 
1 Sample per synchronous operation cycle. I/O data will be 
sampled after END instruction of synchronous operation cycle is 
executed.  
[On TRSM Instruction]  
Sample when TRSM Instruction is executed. I/O data at TRSM 
Instruction will be sampled.  

*1: This option can be selected only for a CJ2H CPU Unit. 
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Item Function 

[Trigger 
Settings] 

[Left Operand] Input Symbol or the address to be trigger object. Select data 
type from Combobox.  
1ch data, 2ch data and 4ch data can be set on CJ2 CPU. 1ch 
data can be set on PLC of CS/CJ/CP Series other than CJ2 
CPU.  

[Browse] Search trigger object from Symbol Table.  

[Trigger 
Settings] 

[Formula] Select the conditions of Trigger completion. 
When [Left Operand] is a bit (data type is BOOL). 

  ↑ Falling Edge  

  ↓ Rising Edge  
[Left Operand] is other than the above: 

  = Equal 

  ≠ Not equal *2 

  < Less than~ *2 

  > More than~ *2 

  ≤ Maximum *2 

  ≥ Minimum *2 

[Right Operand] Input the value to be Trigger. Input is enabled when [Left 
Operand] is other than a bit (data type is except for BOOL).  

[Delay] Input delay value in sample number. Input in slider is possible.  

[No. of Trace Samples] When using all trace memory CPU Unit is not necessary, input 
sampling number to be traced. Time per trace execution time 
will be shorter. *2 

[Auto Repeat] Check, Box Check the box when executing trace on auto repeat under the 
same conditions. 

[No. of Trace Execution] Input the number of trace to be executed repeatedly. When 
[Auto Repeat] check box is checked, input is enabled.  

[Trace Start on Monitor/Run 
Mode] Check Box  

Start trace automatically at the timing when PLC mode changes 
to Monitor mode, or Run Mode (includes Power on).*1 

[Trace Start Executing 
Automatically After Download] 
Check Box 

Check the box when starting Data Trace automatically after 
transferring the execution conditions of Data Trace to PLC. 

*2: Settable Only on CJ2 CPU. 
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Setting on [Trace Object]Tab 
Set trace object. 

1 Select [Trace Object] tab on [Data Trace Configuration] dialog box. 
The following screen will appear.  

 
2 Input trace object. The methods of trace object input are the three of the following. Input trace object with the 

combination of 1ch data, 2ch data, 4ch data, and bit. 
Input methods  Details Notes 

Insert 
 

[Insert] on right click menu 
[Insert] button on tool bar 

Input symbol or address. Input 
is possible with search from 
Symbol Table. 

Paste 
 

[Paste] on right click menu. 
[Paste] on tool bar 
[Ctrl]+[V] key 

Copy and paste from Symbol 
Table, Ladder View or Watch 
Window. Multiple trace objects 
can be inserted at the same 
time. 

Drag & Drop Select the object for trace, right click 
on it and hold the click for drag. Drag 
and drop it  to trace object tab.  

Drag can be done from Symbol 
Table or Ladder View. Multiple 
trace objects can be inserted at 
the same time. 

3 Select data type of trace object. 
Note: Click on [↑] or [↓] on tool bar to change the order of trace object. Trace 

result will be displayed in order of the setting of trace objects. 
Note: Select the trace object and [Delete] on right click menu to delete trace object 

or click on [Delete] on tool bar or press [Del] key. 
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Convenient Function on the Trace Objects Tab 

• I/O Module AR Selection Function 

When you use a CJ2M CPU Unit, an auxiliary area address to be used in the Pulse I/O Module can be 
selected from a list and registered. 

 
Refer to the CJ2 CPU Unit Software User’s Manual (Cat. No. W473) for the detailed operation. 

 
Execute Data Trace with Data Trace Window for CS/CJ/CP 
Operation procedure of Data Trace will be discussed.  

Setting parameters is necessary prior to Data Trace execution.  

Data Trace Execution 

1 Select [Operation]| [Execute] on Data Trace Window. (Or click on ) 

Trigger can be completed with [Execute]| [Trigger] (or ). 
2 When Data Trace starts and trigger conditions are completed, sampling will start. Trace data will be saved to 

trace memory of CPU Unit.  
When trace memory is full, sampling automatically stops. Trace data will be read from trace memory of CPU 
Unit. Data trace screen will be displayed in Data Trace window. 

3 When stopping Data Trace before trace memory is full, select [Operation]| [Stop] (Or click on ). 

When Data Trace is interrupted, select [Operation]| [Read] (Or click on ). Data Trace screen will appear. 

Operation of Data Trace Window for CS/CJ/CP 
Following is the operation procedure of Data Trace.  
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Check on [Show] of the data to be shown on [Legend View] tab. Uncheck will be Hide.   

♦ Check on [Select] of [Legend View] or click on a graph. Trace data is selected.  
♦ Graph tool bar will appear to the selected data. Move up and down (offset change), scale in and 

out (scale change) and input of graph show units are possible with tool bar operation.  
♦ Move up and down (offset change) is possible with dragging a graph directly. 

♦ Select [Trace Settings] tab to check trace settings. 
♦ Select [Properties] tab to refer to trace properties.  
♦ Right click on trace screen and select [Copy to Clipboard]. Paste the graph screen to the paint and so on is 

possible.  
♦ Right click on trace screen and select [Save to Bitmap]. Save as a bit map file is possible.  
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Trace (Continuous) 
Parameter Settings of Continuous Data Trace  
The following is the procedure for Parameter settings of long and continuous Data Trace.  

Show [Data Trace Configuration] dialog box. 

1 Select [Data Trace] from [PLC] menu on main window. (when Data Trace window is already open and Time 
Chart Monitor is selected, select [Operation]| [Mode]| [Data Trace])  

2 Select [Operation]| [Settings] on Data Trace window.  
[Data Trace Configuration] dialog box will appear as follows.  

 
Refer to “Parameter Settings of Data Trace for CS/CJ/CP” for the functions of the buttons located at the bottom. 

3 Click on the tab of items to be set. 
4 Click on [Transfer (PC to PLC)] or [OK] after all settings are done.  

The setting details of each tab are described hereinafter.  
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Settings on [Settings] Tab 
Set execution conditions of continuous Data Trace. Select [Settings] tab on [Data Trace Configuration] dialog 
box.  

 
 

Item Function 
[Trace Type] Select [Trace (Continuous)].  

[Sampling Setting] Select sampling conditions of Data Trace. 
[Fixed Interval] 
Operate sampling with fixed interval. Sampling cycle is set in millisecond 
increments. I/O data per sampling cycle will be sampled.  
[Once Per Cycle]  
Sampling per one scan. I/O data will be sampled after END operation is 
executed  
[Once Per Synchronous Operation Cycle]*1, *2 
1 Sample per synchronous operation cycle. I/O data will be sampled after 
END instruction of synchronous operation cycle is executed. 
[On TRSM Instruction]  
Sampling is performed when TRSM Instruction is executed. I/O data on 
TRSM Instruction is sampled.  

[Logging 
Settings] 

[Number of Samples] Set number of samples in obtained data to be saved per file.   

[Maximum Time 
Span] 

Set how long the collected data will be kept in PC. Select the unit from 
[Minutes], [Hours], and [Date]. 

[Folder Path] Select a folder to save the collected data. The result will be automatically 
saved to the selected folder with the folder name automatically assigned as 
“(PLC name) Trace data (Year Month Date)-(Hour).csv”. (See note.) 

[Trace Start on Monitor/Run Mode] 
Check Box. *3 

Check on the box to start trace automatically at the timing when PLC mode 
changes to Monitor mode or Run mode (including Power ON).  

[Trace Start Executing 
Automatically After Download] 
Check Box  

Check on the box to start logging automatically after transferring execution 
conditions of logging to PLC.  

Note: A continuous data trace may not run continuously for the specified maximum time span. 
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*1 Continuous tracing cannot be used if the synchronous control cycle is less than 3.0 ms.
  

*2 This option can be selected only for a CJ2H CPU Unit. 
*3 This check box can be selected only for a CJ2 CPU Unit. 

Settings on [Trace Object] Tab 
Set trace object. The operation procedure is as same as the one on” Parameter Settings of Data Trace for 
CS/CJ/CP”.  

Operations at Executing Continuous Data Trace 
Continuous Data Trace enables the following operations in addition to usual trace.  

♦ Performance Monitor screen is displayed. Whether all trace data is obtained or not can be confirmed with the 
screen.  When not all trace data is obtained, the speed at which CPU saves the sampling data to trace memory 
possibly exceeds the communications speed between PC and PLC. Adjust sampling intervals and the size of 
trace object accordingly.  

♦ Performance Monitor Screen displays the following items. 
 
Display the numbers related to the IDs collected into PC out of IDs which are stored in trace memory.  

Items Details 
[No. of IDs on CPU] Show the number which CJ2 CPU Unit sampled.  

[IDs Obtained] Show the number of sampling data which are collected in PC.  

[Obtained 
Percentage] 

Show the obtained rate of the data collected to PC in percentage. 

♦ When any missing occurs, reduce the number of logging objects or extend the sampling intervals. The 
missing will be eliminated.  

Note: A straight line will be displayed for any data that cannot be obtained. 
 
Note: The size per 1 sampling data is [the size of trace object except for bit data] +6ch.  

 
(Adjustment example)  
Obtained percentage is 80%, logging object except for bit data is 10ch, sampling intervals is 10ms: 
1. Adjustment with reducing the number of logging objects: the following formula is applied.  

[Size per 1 sampling after adjustment]=[Size per 1 sampling before adjustment]*[Obtained 
percentage]  
(10+6)×0.8 =16×0.8=12.8≡12 
Reducing 4ch trace objects (becoming 6ch as trace objects) makes the obtained percentage 
100%. 

2. Adjustment with extending sampling intervals: the following formula is applied.  
[Sampling cycle after adjustment]=[Size of trace object]/[Size allows sampling in 1ms]=[Size 
of trace object]/([Size of Trace object]/[Present sampling cycle]*([Obtained 
percentage])=[Present sampling cycle]/([Obtained percentage])=[Present sampling 
cycle]/([Obtained percentage])  
10/0.8=12.5≡13 
Changing sampling cycle to 13 ms makes the obtained percentage 100%. 
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Save of the Data Collected from Data Trace Window for CS/CJ/CP  
The result data collected from Data Trace or Time Chart Monitor can be saved to a general- purpose CSV file.  

Following is the format of CSV file to be saved.  
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Time Chart Monitor 
Parameter Settings of Time Chart Monitor for CS/CJ/CP  
Parameter settings of Time Chart Monitor for CS/CJ/CP will be discussed. 

Display [Time Chart Monitor Configuration] dialog box  
1 Select [Time Chart Monitor] from [PLC] menu on main window. (when Data Trace window is already open 

and Data Trace or logging is selected, select [Operation]| [Mode]| [Time Chart Monitor]) 
2 Select [Operation]| [Settings] on Data Trace window.  

[Time Chart Monitor Configuration] dialog box will appear as follows.  

 
Refer to “Parameter Settings of Data Trace for CS/CJ/CP” for the functions of the buttons located at the bottom 

3 Click on the items to be set.  
4 Click on [Transfer (PC to PLC)] or [OK] when all settings are done.  
The setting details of each tab are described hereinafter. 
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Settings on [Settings] Tab 
Set the execution conditions of logging. Select [Settings] tab on [Time Chart Monitor Configuration] dialog box.  
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Item Function 

[Trace Type] Select [Trace]. 

[Sampling Setting] Select the sampling conditions of Time Chart Monitor.  
[Fixed Interval] 
Sampling with fixed intervals. Set sampling cycle in milliseconds. 
I/O data per sampling cycle is sampled.  
[Buffer Size]  
Operate sampling with the specified sample number. The old 
sampling data will be destroyed automatically.  
[Stop When Buffer is Full] 
Check on the box. Sampling will stop when the set buffer size is 
reached.  

[Trigger 
Settings] 

[Left Operand] Input Symbol for trigger object or the address. Select data type 
from Combobox.  

[Browse]  Search trigger objects from Symbol Table. 

[Formula] Select the conditions of trigger completion. 
[Left Operand] is a bit (data type is BOOL):  

  ↑ Falling Edge 

  ↓ Rising Edge 
[Left Operand] is other than the above: 

  = Equal 

[Right 
Operand] 

Input the value of trigger. Input is enabled when [Left Operand] is 
except for a bit (data type is except for BOOL). 

[Delay]  Input delay value in sample number. Input in slider is possible.  
 

[Trace Start Executing 
Automatically After Download] 
Check Box 

Check on the box to start Time Chart Monitor automatically after 
transferring the execution conditions of Time Chart Monitor to 
PLC.  

Settings on [Trace Object] Tab 
Set the object of Time Chart Monitor. The operation procedure is as same as the one on the previous topic:” 
Parameter Settings of Data Trace for CS/CJ/CP”. Refer to settings on [Trace Object] tab on the previous topic. 

Execute Time Chart Monitor with Data Trace Window for CS/CJ/CP 
Execution operation of Time Chart Monitor will be discussed. Parameter settings are necessary prior to executing 
Time Chart Monitor.  

Operation of Time Chart Monitor 

1 Select [Operation]| [Execute] on Data Trace Window (or click on ). Time Chart Monitor screen will 
appear in Data Trace window.  

Select [Operation]| [Trigger] (or click on ) and trigger completion can be done. 
2 Sampling starts when trigger conditions are completed.  

Select [Operation]| [Stop] to stop Time Chart Monitor (click on ). 
3 In case that [Sampling] tab| [Stop When Buffer is Full] is checked in [Time Chart Monitor Configuration] 

dialog box, sampling automatically stops when buffer is full and Time Chart Monitor screen stops. 
Refer to the previous topic: “Parameter Settings of Time Chart Monitor” for [Time Chart Monitor 
Configuration] dialog box. 
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Convenient Functions of Data Trace Window for CS/CJ/CP  
Show Cursor/Trigger Position 
♦ Select [Option]| [Measure]| [Value] on menu or click on   on tool bar. The value will be displayed. The 

value of X axis (time axis) on cursor position will appear at the bottom of graph. The value of Y axis (present 
value axis) will appear on Legend.  
Change of cursor position is possible with dragging cursor.  

To show the value on the point of the specified time axis, input the value into  on tool bar and 
press [Enter] key or click on  on tool bar. 

♦ Select [Options]| [Measure]| [Difference] on menu or click on  on tool bar. Measure Difference will 
appear. Each value on X axis (time axis) of two cursors and the difference value will appear at the bottom of 
graph.  Each value on Y axis (present value axis) and difference value will appear on Legend.  
Dragging each cursor or located on the top of cursor enables to change each cursor position separately. 
Dragging located between two cursors enables to change cursor position while the interval of the two is kept.  

♦ A value cursor is displayed on the trigger position. The values on the X axis (time axis) and Y axis (present 
value axis) of the trigger position are displayed in the symbol list.  

Zoom Select 
♦ Select [View]| [Zoom Select] or click on  on tool bar. Zoom Select mode will be on. Select the graph area 

to be enlarged by drag. The selected area only will be displayed on graph area. Only selected view will appear 
on graph area when more areas to be enlarged are selected by drag. This operation is executable repeatedly.  

♦ Select [View]| [Zoom Unselect] on menu or click on   on tool bar. The enlarged view after Zoom Select 
will return to the previous one. To return the status prior to Zoom Select mode, select [View]| [Zoom Fit] or 
click on  on tool bar.  

For C/CV-series 
Setting Monitoring Conditions 
The Data Trace or Time Chart Monitor must be activated before the settings can be configured. To select Data 
Trace or Time Chart Monitoring mode, select the Mode option from the Operation menu followed by either Data 
Trace or Time Chart Monitor.  

Note: The mode of the Data Trace/Time Chart monitor component is identified prior to 
activation from the invoking application. 

The Time Chart Monitor/Data Trace Configuration dialog allows the conditions for the Data Trace or Time Chart 
Monitor to be set, i.e. specifying the data to be monitored, the intervals at which this is to occur and the trigger 
conditions. 

 
Use the following procedure to set conditions for the Data Trace or Time Chart Monitor modes.  

1, 2, 3… 1. Select the Configure Trace/Time Chart button from the toolbar. 
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2. Set the trigger condition that causes the data trace to start by selecting a Symbol/Address 

and Value on the Trigger tab. Use the Browse pushbutton to insert a known symbol from 
the invoking application. If a bit address is selected, the trigger is based on a falling or 
rising edge as opposed to a particular value for a word address: the Value field changes to 
the Edge field. 

 3. For Time Chart Monitor only, establish the sampling time and Buffer Size on the Sampling 
tab. 

 4. Apply a delay value in the Delay field. A negative value in this field advances the start of 
the trace before the trigger condition by the supplied interval value. A positive value in this 
field delays the trace after the trigger condition by the supplied value in sampling. 

 5. Select the Word Addresses field on the Word Addresses tab and/or Bit Addresses on the Bit 
Addresses tab) to be monitored. 

 6. Once all conditions have been set as required, click the OK pushbutton. Select the Cancel 
pushbutton to abort the configuration operation. 

Use the following procedure to select the Word addresses or Bit addresses. It is possible to set only word addresses, 
bit addresses, or a mix of both.  

 
1, 2, 3… 1. Select a free area in the Address or Symbol columns with the right-mouse button and click 

New. The Address Selection dialog is displayed. 
 2. Insert an address in the Address/Symbol field, or select the Browse pushbutton to locate a 

symbol from the invoking application. 
 3. Click the OK pushbutton in the Address Selection dialog to accept the settings or select the 

Cancel pushbutton to abort the operation. The address or symbol is displayed in the Data 
Trace Configuration dialog. Multiple addresses or symbols can be applied. 

 4. To delete an existing address or symbol, select an address or symbol with the right-mouse 
button and click Delete. 

When in the Data Trace mode of operation, the data trace configuration in the PLC can be uploaded and 
viewed/edited for re-use. Select the Upload pushbutton from the Data Trace Configuration dialog. 

Managing the Data Trace/Time Chart Monitor 
Use the following functions to manage the Data Trace or Time Chart Monitor. 

 
Select the Execute button from the toolbar to execute a data trace/time chart monitor.  

 
Select the Trigger button from the toolbar to set the trigger condition so that execution will end 
normally.  

 
Select the Stop button from the toolbar to stop a data trace/time chart monitor.  

 
Select the Read button from the toolbar to upload the data trace. This may take a few moments; 
the status of the Read function can be verified by the information supplied in the status bar. The 
Read button is not used for the Time Chart Monitor mode of operation. 
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Saving Data Trace Settings 
Results data collected by the Data Trace and Time Chart Monitor functions can be saved as special 
CX-Programmer data files (.cdt filename extension) or standard CSV files (.csv filename extension). 

♦ Saving Data in a CX-Programmer Data File 
To save the data in a special CX-Programmer data file (.cdt filename extension), select File – Save or File – 
Save As. 

♦ Saving Data in a CSV File 
To save the data in a standard CSV file, select File – Save CSV. 

Retrieving Data Trace/Time Monitor Settings 
Data Traces can be stored on file and retrieved for later analysis. Settings may be retrieved from a project from an 
invoking application. Select the Open option from the File menu. A standard open window is displayed. 

Data Trace/Time Chart Monitoring component files can be retrieved via a standard File Open dialog. Use the 
following procedure to open a Data Trace/Time Chart Monitoring component file.  

1, 2, 3… 

 

1. Select the Open File button from the toolbar to open a Data Trace file.  
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by 

the Open pushbutton. PLC Memory files have a .CDT extension. 
Note: It is possible to open a file type that is not applicable to the current mode, e.g. opening a 

Data Trace file when in Time Chart Mode. 

 To close a currently open file, select the Close button from the file’s title bar. Recently opened 
files can be directly selected for opening via the File menu. 

Displaying a Data Trace/Time Chart 
Once uploaded, the Data Trace/Time Chart Monitor component is populated with the required details. 

 
 

The top graph illustrates the word addresses or symbols. The bottom graph illustrates the bit addresses or symbols. 
Each word address is colour coded. The word and bit addresses are listed in the left pane; the splitter bar can be 
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moved by placing the mouse cursor over the splitter bar and dragging it to its new position to show more or less of 
the displayed numbers. 

 The slider position, used to analyze the data returned by the data trace, can be moved by placing 
the mouse cursor over the graph slider and dragging it to its new position. Both sliders can be 
moved together by selecting Synchronise Cursors from the View menu. When moving the 
slider, it snaps to the sampled intervals. Moving and holding the slider left and right scrolls the 
view window left and right. 

The Data Trace/Time Chart Monitor component permits the zooming and scaling of the Data Trace/Time Chart 
view. Use the following procedure to zoom and scale the Data Trace/Time Chart view.  

 
Select the Zoom In button from the toolbar to zoom in on the word graph. 

 
Select the Zoom Out button from the toolbar to zoom out from the word graph. 

 
Select the Restore Zoom button from the toolbar to return the graph to the original view. 

 
Select the Scale In button from the toolbar to zoom in on a particular graph against the vertical 
axis. 

 
Select the Scale Out button from the toolbar to zoom out from a particular graph against the 
vertical axis. 

 
Select the Restore Scale button from the toolbar to return the graph to the original scale. 

This can be modified to switch between Histogram and Trend Graph when in Word Display Mode or to switch 
between Outline and Block when in Bit Display Mode. Use the following procedure to switch display modes. 

1, 2, 3… 1. Select the Word Display Mode option or the Bit Display Mode option from the Options 
menu. 

 2. For Word Display Mode, select either Histogram or Trend Graph. 
 3. For Bit Display Mode, select either Block or Outline. 

The Word values shown on the screen can be displayed in one of four formats: 

♦ Binary; 
♦ Decimal; 
♦ Signed Decimal; 
♦ Hexadecimal. 
Use the following procedure to select a Bit value format.  

1, 2, 3… 1. Select Word Value Format from the Options menu. 
 2. Select either Binary, Decimal, Signed Decimal or Hexadecimal. 

The Bit values shown on the screen can be displayed in one of two formats: 

♦ Boolean (1 or 0); 
♦ Text (On or Off). 
Use the following procedure to select a Bit value format.  

1, 2, 3… 1. Select Bit Value Format from the Options menu. 
 2. Select either Boolean or Text. 

The Data Trace/Time Chart view can be toggled to display either PLC addresses or symbol names. Select the 
Options menu and then Show Symbol Names. If a symbol name is not available then the PLC address is shown. 

The colours associated with the Data Trace/Time Chart view can be customised. Use the following procedure to 
change the colours on the Data Trace/Time Chart view.  

1, 2, 3… 1. Select Colours from the Options menu. The Trace Colour Selection dialog is displayed. 
 2. Select a Change pushbutton associated with a colour to be applied to a Word or Bit 

address. A standard Microsoft Windows Colour dialog is displayed. 
 3. Select a colour from the Colour dialog and click the OK pushbutton. Select the Cancel 

pushbutton from the Colour dialog to abort the operation. 
 4. If required, Select a Change pushbutton for another colour and repeat step 3. 



 PART 2: CX-Server PLC Tools  
OMRON CHAPTER 5 – Data Trace/Time Chart Monitor Component 
 

 CX-Server PLC Tools_Page 69 

 5. Select the Apply pushbutton from the Trace Colour Selection dialog to apply the change 
colour settings. Select the OK pushbutton to apply the change colour settings and close the 
dialog. Select the Cancel pushbutton to abort the operation. 

The display of the Data Trace or Time Chart Monitor can be further refined by displaying a grid over the window. 
Select Grid from the Options menu to control the display of the grid.  

Any symbol names inherited from the invoking application can be displayed on Data Trace or Time Chart Monitor 
by selecting Show Symbol Names from the Options menu. 

SYSWIN Data Trace and Time Chart Monitor Files 
SYSWIN 3.x Data Trace Files (*.SDT) and Time Chart monitoring files (*.STC) can be opened directly into 
CX-Server. Use the following procedure to import these files:  

1, 2, 3… 

 

1. Select the Open button from the toolbar. The Open dialog is displayed. 
2. Select an alternative file type from the Files of Type field, either SYSWIN version 3 Data 

Trace Files (.SDT) or SYSWIN version 3 Time Chart Monitor Files (.SDC). 
3. Select a file to open. 
4. Select the Open pushbutton to import the file. Select the Cancel pushbutton to abort the 

operation. 
 





 PART 2: CX-Server PLC Tools  
OMRON CHAPTER 6 – PLC Error Component 
 
 

 CX-Server PLC Tools_Page 71 

 CHAPTER 6 
PLC Error Component 

This chapter describes the PLC Error component and its ability to display and clear PLC errors, the PLC Error Log 
and messages. 

The PLC Error component is only available when the PLC is online. 

The PLC Error component provides a view of current errors occurring in the PLC’s CPU and allows them to be 
cleared when the cause of the PLC error has been removed (providing the PLC is in the correct mode). Errors 
occurring are also written to the PLC Error Log and displayed in the PLC Error component automatically although, 
if set to Manual Refresh, the error history is only updated when the Refresh button is selected. 

Messages are displayed when a user-defined MSG instruction in the ladder program is encountered; these 
messages may have been defined as part of an error trap or to provide more general information. Messages may 
also be generated by the system in certain circumstances. 

When a number of errors have occurred on the PLC, the most serious error is displayed automatically. For detailed 
information concerning a PLC error, refer to the relevant PLC manual.  

 
The status bar displays the connected device and PLC mode and the PLC Clock (if one is present and clock 
monitoring has been enabled from the Options menu).  

♦ The Error Log is always available for CV and CS1/CJ1-series PLCs but can be selectively enabled or disabled 
for C-series PLCs. 

The PLC Error component can be forced to stay as the top window by selecting the Settings option from the 
Options menu and checking the Always on Top setting on the General tab. 

Access to the PLC Error component is from the invoking application. If a serious error has occurred, the PLC 
Error component is displayed automatically. 

 To close the PLC Errors dialog, select the Close button in the title bar.  

Errors 
The Errors tab of the PLC Error component displays the current error status of the PLC, when an error is detected 
in the PLC it is shown with the item identifier, code position, error status level and error details. The icon next to 
the item number indicates the type of error detected and reflects the error status in the Status column.  

Errors may be cleared but this is dependent upon removal of the cause of the error in the PLC and the PLC’s 
operating mode.  

When the PLC is in Program Mode, all errors can be cleared; when in Monitor mode, only the last error can be 
cleared. It is not always possible to clear an error when the PLC is in Run mode; in this instance, a dialog is 
displayed which allows an attempt to be made at clearing the error. Providing the cause of the error has been 
rectified, the error can be cleared, although the PLC mode may need to be switched to achieve this. 

Use the following procedure to clear errors.  

1, 2, 3… 1. Select the Errors tab in the PLC Error component. 
2. Select the Clear All pushbutton. 
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There are three types of errors that can be recorded.  

 Fatal error: Program execution is halted and the PLC error indicator is constantly illuminated. 

 Warning error (non-fatal): The PLC error indicator flashes. 

 
No errors: PLC is operating normally. 

Note: The user program, Parameter Area, and I/O Memory in the CPU Unit can be cleared to 
initialize the CPU Unit by selecting Clear All Memory Areas from the Options menu of 
the PLC Errors dialog box. 

Error Log 
The Error Log tab of the PLC Error component displays the error history of the associated PLC including entry 
number, date and time of occurrence (if date and time stamping is supported by the PLC), code position and error 
details. The icon shown against the Entry number indicates the error status (unlike the Errors tab, there is no 
Status column). 

Use the following procedure to clear the Error Log.  

1, 2, 3… 1. Select the Error Log tab in the PLC Error component. 
2. Select the Clear All pushbutton. 

Note: The Error Log cannot be cleared in Run mode.  
There are three types of Error Log entries recorded. 

 
Fatal Error Log entry. Program execution is halted by this error occurrence. 

 
Warning Error Log (non-fatal) entry.  

 
No Error Log entries. 

The maximum number of Error Log entries allowed by the PLC is displayed beneath the Error Log. 

Note: With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1) and later versions, the error log 
displayed in the PLC error window’s Error Log Tab can be saved as a CSV file by 
clicking the Save Button.  The saved data can be analyzed or printed later with 
programs such as MS Excel.  

Messages 
The Messages tab of the PLC Error component displays the messages set by a ladder program. These are 
user-defined messages which have been inserted into the PLC program, they do not have to be error messages. 
Messages can either be selectively cleared or all cleared at the same time. 

Use the following procedure to clear a message.  

1, 2, 3… 1. Select the Messages tab in the PLC Error component. 
 2. Highlight the message to be cleared and select the Clear pushbutton. Alternatively, select 

the Clear All pushbutton or remove a selection by keeping the [SHIFT] key depressed 
when highlighting messages. 

Error Log Settings 
The Error Log Options dialog allows the Error Log to be activated, time monitoring to be set and automatic update 
of the Error Log to be performed. When the component is initially opened, it activates settings saved previously. 

Time Monitoring 
Some PLC types support a clock which can also be monitored. Use the following procedure to invoke time 
monitoring against the PLC Clock.  
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1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Clock tab. 
 3. Check the Monitor the PLC Clock setting. The current clock time from the PLC is then 

displayed in the status bar so the user can verify the current time against the error log 
entries. 

 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 
settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Note: Where PLCs do not support a clock, ‘No Clock’ is displayed in the Status Bar and the 
information on the Clock tab is greyed-out.  

Manually Updating the Error Log 
Manual refresh of the Error Log is useful if it is desired to prevent other users from clearing the displayed error 
history. Use the following procedure to enable manual refresh of the error log. 

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Check the Update Error Log Entries Automatically setting. If not checked, a Refresh 

pushbutton is displayed next to the Clear pushbutton to manually refresh the Error Log 
content (in the PLC Error component). 

 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 
settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Use the following procedure to refresh the Error Log automatically.  

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Deselect the Update Error Log Entries Automatically setting. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Customising the Layout of the Error Log 
Some PLCs do not support time stamps, date stamps or clocks. The layout of the Error Log can be changed to 
remove the time and date columns as necessary and make the display more relevant to the PLC. Use the following 
procedure to customise the layout of the PLC Error component. 

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Error Log time and date information can be hidden from view by checking the Hide Error 

Log Time Column and the Hide Error Log Date Column settings. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Enabling and Disabling the Error Log  
For C-series PLCs only, the error log can be enabled and disabled as required. Use the following procedure to 
enable or disable the error log. 

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Check the Error Log Enabled setting to manually monitor errors. 
 4. Deselect the Error Log Enabled setting to stop monitoring errors. 
 5. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Overwriting Error Log Entries 
For C-series PLCs only, the overwrite mode depends upon the CPU type. It may either overwrite the last entry in 
the Error Log each time or cycle through the Error Log and start to overwrite it from the beginning. Overwriting is 
only performed when the maximum number of records in the Error Log has been reached. Again this is PLC 
dependent. 
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1, 2, 3… 1. Select the Settings option from the Options menu 
 2. Select the Error Log tab. 
 3. Check the Error Log Overwrite Mode setting to allow the PLC to overwrite Error Log 

entries. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Displaying the Error Log 
The PLC Error component can be set so that it is only activated when an error in the PLC actually occurs 
(providing it is already open); for example, if the PLC Error component has been minimised it automatically 
returns to full size as the top window when an error is generated in the PLC.  

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the General tab. 
 3. Check the Activate only when Error detected setting. 
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 CHAPTER 7 
Memory Card Component 

This chapter describes the Memory Card component available to CV-series PLCs and CS/CJ-series PLCs and its 
ability to store and transfer data. File storage is achieved by a File memory card for a CV-series PLC and a 
Compact Flash or EM memory configured as ‘file memory’ for a CS/CJ-series PLC. 
Information can be transferred from the PLC to the memory card or from the memory card to the PLC. A saved 
program can be transferred from the memory card to the program area during operation. Extended PLC setup and 
program files can be automatically transferred at PLC startup if they are named autoexec.std and autoexec.obj 
respectively. 
It is possible to run the Memory Card component whilst the PLC is offline. 
The Memory Card component can be forced to be displayed in focus by selecting the Always on top option from 
the Options menu. 
For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 
Access to the Memory Card component is from the invoking application.  

Memory Card Operation 
The appearance and behavior of the Memory Card component is similar to Microsoft Windows Explorer. 
Differences between the Microsoft Windows Explorer exist within the Memory Card component when certain 
functions are accessed. Refer to Microsoft Windows Explorer help, part of the standard Microsoft Windows 
documentation for options and functions not described in this chapter but available within the Memory Card 
component.  

Caution:  Memory cards must be formatted prior to use. 

 
The status bar provides instant help, the PLC and CPU type, and quick reference information describing how 
much space is available on a particular device for the selection in the left pane.  

In addition to the devices and folders supported by the PC, the Memory Card component also displays the 
connected PLC device. In terms of the device/folder structure of Microsoft Windows Explorer, the PLC contains a 
Memory Card folder if available (i.e. if fitted), Program Area, IO Memory Area and Parameter Area. For a 
CS/CJ-series PLC, a Memory Card folder can contain subfolders. 

Note: In order to view or execute on the PLC a file from the memory card, the file must be 
copied back to the PC folder. Double clicking on the files in the list has no action 
associated with it since files cannot be opened across the communications connected to 
the PLC.  

A memory card can be displayed for each connected PLC and allows their contents to be moved between 
destinations. The operation is aborted if there is not enough space. Snapshots of PLC Memory areas can be taken 
by transferring information from the Program Area, IO Memory Area or Parameter area to the Memory Card 
folder.  
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For CV-series PLCs memory cards can be either RAM, EPROM, or EEPROM. EPROM and EEPROM cards can 
only be written to using the Memory Card Writer.  

For CS/CJ -series PLCs memory cards can be either Compact Flash disk or configured EM memory. 

There are three ways in which memory cards can be accessed: 

♦ They can be read from/written to during an online operation using programming software; 
♦ By instruction via a program in the PLC; 
♦ Using the Memory Card component; 
Refer to the associated PLC manual for further information. 

The Memory Card component automatically detects whether the memory card is in place or not. An error message 
is displayed if it is detected that the memory card has been removed whilst the Memory Card component is active. 

Files held on the memory card can be compared with data in the PLC. File formats can be one of four types: 

♦ .LDP indicates partial program area files; 
♦ .OBJ indicates full program area files; 
♦ .STD indicates PLC setup area files; 
♦ .IOM indicates any other type of file. 
The CS/CJ-series PLC also supports the configuration of EM memory as file memory. Providing the EM Table 
Setting Enabled option from the Settings menu is set within the PLC Setup component whilst in Program mode. 
Refer to Chapter 4 - PLC Setup Component for further details.  

A fitted memory card on CV-series PLCs or Compact Flash card on CS/CJ-series PLCs must be formatted to be 
used as a file storage device. Setting a CS/CJ-series PLC as file memory in the PLC Setup component 
automatically formats EM file memory for use in the Memory Card component.  

Memory Card Display 
The Memory Card component can be manipulated in the same manner as most Microsoft Windows displays to 
control what is displayed; for example, expansion of the file storage hierarchy. 

The left pane displays the content, in terms of Devices, Networks and Points. 

 To expand the hierarchy in the left pane, select this icon. 

 To collapse the hierarchy in the left pane, select this icon. 

To view the content of a particular branch in the hierarchy, double-click on the item in the left 
pane. 

 
Select the Large Icons button from the toolbar to display the content of the right pane as large 
icons. 

 
Select the Small Icons button from the toolbar to display the content of the right pane as small 
icons. 

 
Select the List button from the toolbar to display the content of the right pane as a list. 

 
Select the Details button from the toolbar to display the content of the right pane with 
associated details. 

Use the following procedure to copy or move information from or in the PLC Memory component.  

1, 2, 3… 1. Select an item, or items, in a window. More than one item can be selected by pressing Shift 
and selecting another item to extend the selection, or by pressing Ctrl and selecting another 
item to add to the selection. 

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar 

to move the item. 
 3. Select an area to move the items to, for instance copying data area values into another data 

area. 

 
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 
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A file or label (if at top level) can be renamed. Use the following procedure to rename memory card data.  

1, 2, 3… 1. Highlight the required document or folder. 

 
2. Select the Rename button from the toolbar. The document/folder name can now accept 

input. Enter the new name and press Return. 
A file or folder can be deleted. Use the following procedure to delete a file or folder.  

1, 2, 3… 1. Highlight the required document or folder. 

 
2. Select the Delete button from the toolbar. A Confirm Folder Delete dialog is displayed. 

 3. Select the Yes pushbutton to continue with the deletion or the No pushbutton to abort the 
operation. 

The Toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the PLC Memory toolbar. 

If the display of a PLC device takes a few moments to refresh, ensure the Auto Refresh PLC View option from the 
Options menu is turned off. This then allows the PLC to be refreshed manually by selecting Refresh from the View 
menu. 

Extended PLC setup and program files can be transferred to the Memory Card as autoexec files so they can be 
automatically transferred at PLC startup. Select the Transfer as AutoExec Files from the Options menu.  

Memory Card Properties  
Use the following procedure to view memory card properties. 

1, 2, 3… 1. Highlight the required document or folder. Multiple devices, folders and files can be 
selected if required. 

 
2. Select the Properties button from the toolbar. 
3. View the details. Some options may be amended, for instance the read-only attribute for a 

file; in this instance, amend settings as appropriate. Select the OK pushbutton to complete 
the operation or the Cancel pushbutton to abort the operation. 

Transferring Data between the PLC and Memory Card 
Use the following procedure to transfer data between the PLC and memory card. 

1, 2, 3… 1. Select the Files on the PLC to be copied and click the right-mouse button. 
 2. Select Transfer To option followed by either Memory Card or EM File Area. 

Possible Memory Card Errors 
The following list provides a brief overview of the possible errors that could arise with the memory card when 
operating in Program Mode. Refer to the associated PLC manual for further information. 

♦ The PLC Program is protected and cannot be written to; 
♦ The file card does not contain enough free space to transfer the PLC data required; 
♦ The source file name specified to transfer data from does not exist; 
♦ The file on device already exists; 
♦ The file device is read only and cannot be written to; 
♦ The file device does not exist, insert the memory card; 
♦ Cannot transfer data from the file device to the PLC’s area when the PLC is in Run mode; 
♦ To transfer data from the file device to the PLC’s IO area, the PLC must be in Program mode; 
♦ The data cannot be transferred to the PLC as the PLC is password protected or access rights have not been 

granted. 
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Note: With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1) and later versions, the following 
functions can be executed if the PLC model is set to CP1H. 

1, 2, 3… 1. Memory Cassette Transfer function 
 Data can be transferred and verified between the Memory Cassette and CP1H CPU Unit. 
♦ Applicable Data 

The following table lists the kinds of data that can be selected for transfer/verification.  
Applicable data 

Program, parameters, Data Memory, variable tables, comments, program index, and Data Memory 
initial values 

♦ Procedure 
Select PLC – Edit – Memory Cassette/DM and click the Transfer to Memory Cassette, 
Transfer to PLC, or Verify All Areas Button.  

 2. Data Memory to Flash Memory Backup function 
All of the Data Memory in the CP1H CPU Unit’s internal RAM can be backed up as DM 
initial values in the CPU Unit’s internal flash memory. The backed up data is known as 
Backup DM (DM initial values). 

♦ Procedure 
Select PLC – Edit – Memory Cassette/DM and click the Backup Button in the Backup to 
Flash Memory Field. 
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 CHAPTER 8 
CX-Server Network Configuration Tool (CX-Net) 

This chapter describes the CX-Server (CX-Net) Network Configuration tool, the procedures for establishing 
communications to PLCs for direct and gateway connections. The Network Configuration Tool hosts tools that 
assist in the creation and editing of local and network Routing Tables and the creation and editing of Data Link 
Tables. 

To successfully establish communications between CX-Server and a network PLC, an intermediary or gateway 
PLC has to contain a valid Routing table to allow the correct routing of packets. The CX-Net Network 
Configuration tool allows communications to PLCs with a CX-Server project and configuration of the PLC. The 
CX-Net Network Configuration tool allows the following: 

♦ Hosts the Routing Table editor to provide routing table support at a network level, enabling PLCs to act as 
gateways across networks; 

♦ Hosts the Data Link table editor to provide Data Link table support at a network level; 
♦ Setup of PLC devices and their communication units; 
♦ Network diagnostics; 
♦ Control of Data Link operation. 

Note: The availability, format and content of the facilities within the CX-Net Network 
Configuration tool depend upon the device type of the PLC being considered (C-series, 
CS/CJ-series or CV-series) and the network to which that PLC is connected (SYSMAC 
LINK, SYSMAC NET, Ethernet or Controller Link). 

Refer to the specific OMRON System and Operation manuals for details of the operation of the various network 
units and their available settings and options. 

 
The status bar provides instant help, the status of the current connection and the operating mode of the PLC.  

When the CX-Net is initially loaded, the Project Devices field is empty. Opening or creating a CX-Server project 
populates the Project Devices list with all the devices in that CX-Server project. Selecting each device in turn 
causes the right-hand side of the dialog to display a graphical representation of that connection (either direct or 
through a gateway connection), together with node and network information.  

Note: Offline connections are shown as a red line whilst for online connections this changes 
to green. Other aspects also change when online, refer to Chapter 8 - Opening a PLC 
for further information. 

Any operations (e.g. network unit setup, Data Link and routing table editing) which are carried out affect the 
physical connection PLC which is currently connected, not the CX-Server project PLC. 

Routing Tables contain the information necessary to allow communications between different networks including 
local and remote network address details; they are held in a specific area of PLC memory. Refer to Chapter 11 - 
for information regarding Routing Tables. 

CS/CJ/CP-series PLCs linked to either a Controller Link or Ethernet network also use FINS routing tables. 
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CV-series PLCs also have routing tables which, unlike the C-series, are not dependent upon the networks 
(SYSMAC LINK, SYSMAC NET or Ethernet or Controller Link) to which they are connected. These tables are 
known as FINS routing tables. A direct connection is known as a Local Routing Table. A network connection is 
known as a Network Routing Table. 

C-series PLCs linked to a SYSMAC LINK network are unable to communicate with a different network and 
therefore do not have a routing table; however, C-series PLCs linked to a SYSMAC NET or Controller Link 
network do have this capability and so have an associated routing table. These tables are known as SYSMAC NET 
and FINS routing tables respectively. 

Data Link Tables provide a means of allowing a network of devices to share information. The manner in which 
this information is distributed in a system depends upon the network to which the table relates. The SYSMAC 
NET network contains one node acting as the ‘parent’ node or Data Link server (containing the Data Link table), 
unlike the SYSMAC LINK network where a copy of the Data Link table is sent to all nodes on that network. The 
Controller Link network operates in a similar manner to SYSMAC LINK except that the network is split into two 
areas with each node being associated with one or other of these areas. Data is then copied to each node in the 
related area. Refer to Chapter 10 - Data Links for further information regarding Data Link Tables. 

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 

Access to the CX-Net Network Configuration tool is either from the invoking application or from the Start 
pushbutton on the Microsoft Windows taskbar. 

 To close the CX-Net Network Configuration tool, select the Close button in the title bar. 

CX-Net and CX-Server Projects 
All device information is contained within a CX-Server project file. Once the file has been opened, the PLCs listed 
in that CX-Server project can be opened and the devices on their networks manipulated. CX-Server projects can 
be manipulated from the CX-Net Network Configuration tool.  

Creating a New CX-Server Project 
A new CX-Server project can be created from the CX-Net Network Configuration tool. Use the following 
procedure to create a new CX-Server project. 

1, 2, 3… 1. Select New from the Project Menu. The Create Project dialog is displayed. 
 2. The CX-Server project must be saved before it can be edited. Enter a file name in the File 

name field. An existing CX-Server project can be overwritten by selecting a .CDM file 
displayed in the Create project dialog. 

 3. Select the Save pushbutton to save the new project or the Cancel pushbutton to abort the 
operation. CX-Server files have a .CDM extension. 

Opening an Existing CX-Server Project 
CX-Server project files can be retrieved using a standard File Open dialog. To close a currently open file, create a 
new CX-Server project or select Close from the Project menu. 

Use the following procedure to open a CX-Server project file. 

1, 2, 3… 

 

1. Select the Open button from the toolbar to open a CX-Server project file.  
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by 

the Open pushbutton. PLC Memory files have a .CDM extension. 
A list of the most recently opened CX-Server project files is displayed in the Project menu. 

Note: Select Save As from the Project menu to save a project open in CX-Net under any 
desired name. 
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Adding a Device 
To add a device to a CX-Server project, select the Add Device option from the Project menu. The Add PLC dialog 
is displayed. The Add PLC dialog is identical to the Change PLC dialog. 

To change a device within a CX-Server project, select the Change Device option from the Project menu. The 
Change PLC dialog is displayed. 

Editing a Device List 
The Device List dialog, (see Runtime User manual) can be used to change the settings of the PLCs in the currently 
opened CX-Server project, and to add new PLCs. 

The CX-Server project Device List can only be edited when a device is not currently open – the option is disabled 
when a connection is active. 

 
Select the Edit Project button from the toolbar to edit a CX-Server project, or select the Edit 
option from the Project menu. 

PLC Settings 
The PLC menu contains options that operate on a single PLC device within the open CX-Server project, including 
the setup of its units. It also contains the options for opening and closing a PLC device. 

Opening a PLC 
A PLC can be opened for communications once the associated CX-Server project file has been opened. Use the 
following procedure to open a PLC. 

1, 2, 3… 

 

1. Select a device from the PLC Devices list. If required, add a device to the CX-Server 
project by selecting Add Device from the Project menu and edit the CX-Server project by 
selecting the Edit Project button from the toolbar. 

 
2. Select the Open / Project Device button from the toolbar.  

Note: The Open option does not become available until a device name has been selected from 
the Project Devices list. 

It may take several seconds to establish a connection. If a connection cannot be made with the PLC's settings, then 
a message appears showing this. In this case it may be necessary to change the PLC's settings before trying again, 
or checking that the physical connection (e.g. wiring) is possible. 

For SYSMAC LINK end connections a new SYSMAC LINK menu is added allowing specific SYSMAC LINK 
network operation. 

For Controller Link end connections a new Controller Link menu is added allowing specific Controller Link 
network operation. 

When a physical connection has been made the status of the PLC in the status bar changes to Online with the 
current mode of the PLC. The connection lines change colour to green to also denote the PLC is online. In addition, 
the actual values for Node and Network are displayed, together with details of the device actually connected 
(rather than what is defined in the CX-Server project for that setting). When a connection is made to an Ethernet 
network the Node box changes to a drop-down list, allowing the node to be changed in order to connect to a new 
PLC. If a node is selected but there is nothing there, then no information is shown. Returning to offline operation 
causes a return to the original (CX-Server project) configuration settings in the Node and Network fields. 

Upon connection, certain menu options are made available, depending upon the connection type. 

The current operating mode (Run) of the connected PLC is shown in the status bar of the tool – when making a 
connection, or when a connection is broken, the mode indicator shows Unknown. The indicator shows Run, Stop 
or Monitor when a connection is properly completed. CV-series PLCs also support a Debug mode. This mode 
indicator changes whenever a change is made in the operating mode of the PLC. 

Note: The mode in which the PLC runs on startup is set in the PLC Setup Component, refer to 
Chapter 4 - PLC Setup Component. 
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Closing a PLC 
 

The Open / Project Device button on the toolbar acts as a toggle switch. To close a device, 
simply reselect the Open / Project Device button on the toolbar (i.e. when the menu option 
shows a tick against it and the toolbar button is depressed). 

When the device is closed, the details displayed in the Connection part of the CX-Net Network Configuration tool 
are removed. 

Configuring a PLC’s System Settings 
 

The PLC Setup Component can be selected to define the settings which govern the PLC’s 
behavior; for example, connection mode. Select the Configure PLC System Settings button 
from the toolbar. Refer to Chapter 4 - PLC Setup Component for further information. 
Alternatively, select PLC Setup from the PLC menu. 

Scanning for PLC Connections 
A serial scan can be performed which searches all PC COM ports to see if there are any currently attached PLCs 
and, if found, what communication settings are being employed by those PLCs. This procedure is useful when the 
configuration of the PLCs communication settings (i.e. baud rate) are unknown. Device information from the 
results of the scan can then be copied into the CX-Server project, if required. Refer to Chapter 8 - Dragging 
Device Information into a CX-Server Project. 

When the Scan Serial Ports for PLCs dialog is first displayed, it shows the results of the last scan to be performed 
until the Refresh pushbutton has been clicked. Use the following procedure to scan for PLC connections. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Select Scan Serial Ports for PLCs from the Project menu. The Scan Serial Ports for PLCs 
dialog is displayed. 

 3. Select either individual ports or select the Select All pushbutton to scan all ports from the 
Available Ports field. 

 4. Select either individual baud rates or select the Select All pushbutton to scan all baud rates 
from the Baud Rates field.  

 5. Select either individual cable types or select the Select All pushbutton to scan all cable 
types from the Cable types field. 

 6. Select the Next pushbutton; the Scan Serial Ports For PLCs dialog starts the scan. The 
Status field indicates the current progress. On completion, all currently connected PLCs are 
listed in the Drag and Drop Device Units field. 

Note: If changes are made to PLC connections after a scan has been made, select the Refresh 
pushbutton to update the displayed list. 

Dragging Device Information into a CX-Server Project 
The scan operation described in Chapter 8 - Scanning for PLC Connections, picks up device information from the 
physically connected serial port devices. Once a scan has been performed, the Scan Serial Ports for PLCs dialog 
can remain open alongside the CX-Net Network Configuration tool. Dragging a device or network unit from the 
Drag & Drop Device Units field into the Project Device field in the CX-Net Network Configuration tool allows 
this device information to be added into the CX-Server project. 

Use the following procedure to utilise a convenient shortcut for entering PLC details into a CX-Server project. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Perform a scan by selecting Scan Serial Ports for PLCs from the Project menu. 
 3. Select the required device in the Drag and Drop Device Units field. 
 4. Drag the device across to the Project Devices field in the CX-Net Network Configuration 

tool. 
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Displaying PLC Device Information 
 

The PLC Device Information dialog displays the selected CX-Server project PLC’s device and 
connection details. To display PLC device information, select the Display PLC Information 
button from the toolbar, or select the Information command from the PLC menu. 

Setting the PLC Mode 
The main window of the CX-Net Network Configuration tool shows the current operating mode of the connected 
PLC. The PLC Set Mode dialog allows this to be changed. The run modes available to a PLC depend upon the 
PLC device type. Use the following procedure to set the PLC Mode. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Select the Open / Project Device button from the toolbar to open connections to the 
device. 

 
3. Select the Set PLC Operating Mode button from the toolbar or select the Set Mode 

command from the PLC menu. 
4. Click on the required Operating Mode setting. Select the Set pushbutton. A confirmation 

dialog appears – confirm the operation. 
 5. Select the Close pushbutton to remove the dialog. 

Clearing PLC Errors 
 

Errors, error logs and messages generated by a PLC can be examined and cleared (if possible) 
via the PLC Error Component. Select the Display PLC Error Status button on the toolbar or, 
select the PLC Error Status command from the PLC menu. Refer to Chapter 6 - PLC Error 
Component for more information. 

Creating an IO Table 
 

The PLCs IO Table can also be manipulated by the CX-Net Network Configuration tool by 
activating the IO Table component. The IO Table allows Unit Setup and Software Switch setup 
of SIOU units as well as IO configuration and creation. Before editing the PLCs IO Table it 
must be transferred from the PLC into the IO Table component. Select the Configure IO Table 
button from the toolbar or select the I/O table Setup commend from the PLC menu. Refer to 
Chapter 3 - IO Table Component for further details. Use the following procedure to activate the 
IO Table component. 

Displaying the PLC Unit Status 
The Unit Status option is only available for those nodes where the end connection to the PLC is either SYSMAC 
LINK, SYSMAC NET, Ethernet or Controller Link; in each instance the type of information displayed differs but 
the pushbuttons available are identical. 

♦ SYSMAC LINK. Displays Communications Test, Line Status, Data Link Status, Controller Errors, Backup 
Status Errors, Error Status, Error Log, Status, Error Details; 

♦ SYSMAC NET. Displays Data Link Status, Operating Status, Errors; 
♦ Ethernet. Displays General Status, Error Flags and Error Logs; 
♦ Controller Link. Displays Data Link Status, nodes, Errors and Error Logs. 
The information displayed is for viewing only. However, the Error Log can be cleared. Use the following 
procedure to display the PLC Unit Status. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Select the Open/Close Project Device PLC button from the toolbar to open connections to 
the device. 

 
3. Select the Show Unit Status button from the toolbar or select Unit Status from the PLC 

menu. 
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 4. Select the Clear Log pushbutton to delete the entries in the error log. 

 5. Select the Close pushbutton to remove the dialog. 

Note: Unit status and error log data for Communications Units (e.g., Controller Link Units 
and SYSMAC LINK Units) can be written to files in CSV format. Click the Save 
button in the PLC Unit Status dialog box and the Save As dialog box will appear. Select 
the CSV format and the folder in which to save, input the file name, and click the Save 
button. The status of the Communications Unit and the error log data will be saved in a 
CSV file. 
 This function allows network errors to be analysed from CSV files. 

Note: With a C-series PLCs, the error log for a Communications Unit (e.g., Controller Link 
Unit or SYSMAC LINK Unit) can be saved using PLC | Unit Status/Error Log. 

Testing the Network Connection 
Once network connections have been created, the network should be tested to ensure that all nodes are responding 
properly. The following tests are available: 

♦ Internode Echo-Back Test. This test checks the condition of a number of specific network and node address 
and whether communications can be established; 

♦ Broadcast Nodes Test. This test examines all nodes on the network and is available for Ethernet, Controller 
Link and SYSMAC LINK only. This test may take some time for an Ethernet network which is not subject to 
the same size restrictions as Controller Link and SYSMAC LINK. The results show all nodes found and the 
PLC type if possible;  

♦ Ping Node Test. Allows echo testing of a specific TCP IP address.  

 
Select the required test from the associated button in the toolbar, either the Echo Back Test 
button, the Broadcast Test button or the Ping Test button. 

Communications Unit Setup 
 

The Configure Communications Unit button from the toolbar is used for SYSMAC LINK, 
SYSMAC NET and Controller Link setup options on SIOU units for C-series PLCs. These 
options only describe settings that cannot be accessed via the IO Table component. 

For CS1-series PLCs and CV-series PLCs, the setup allows SYSMAC NET, SYSMAC LINK and Controller Link 
setup. This information is defined via the IO Table component; refer to Chapter 3 - IO Table Component for 
further information. 

Select a unit type from the Unit Type field. If provided, select the Setup pushbutton to further configure 
communications setup. Select the Close pushbutton to close the dialog. 

SYSMAC LINK Settings 
The SYSMAC LINK menu only appears when the end connection is the SYSMAC LINK network. It allows 
settings specific to a SYSMAC LINK network to be made. 

Network Status 
The SYSMAC LINK Network Status dialog shows the nodes present on the network. It also indicates the 
controlling server node. Use the following procedure to setup SYSMAC LINK Network Status settings. 

1, 2, 3… 1. Select the Network Status option from the SYSMAC LINK menu. 
 2. Select the Close pushbutton to remove the dialog. 
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Network Settings  
The Network Settings dialog allows parameter settings for a SYSMAC LINK network to be defined; this includes 
the maximum number of nodes on a network, the maximum number of polling units per communications cycle, 
and the maximum number of frames per communications cycle. 

On entry, this dialog displays the last parameters entered for a selected network. Use the following procedure to 
setup SYSMAC LINK Network Settings. 

1, 2, 3… 1. Select the Network Setup option from the SYSMAC LINK menu. 
 2. Adjust the settings as required (or select the New pushbutton to return to the default values 

for the network). 
 3. Select the Write pushbutton to download the network parameters to the SYSMAC LINK 

network controller. Note that this is only possible when the connected node is the polling 
(server) node – otherwise the Write pushbutton is disabled. The status display indicates 
whether the write operation was successful. 

 4. Select the Close pushbutton to remove the dialog. 

Controller Link Settings 
The Controller Link menu only appears when the end connection is the Controller Link network. It allows settings 
specific to a Controller Link network to be made. 

Network Status 
The Controller Link Network Status dialog shows the nodes present on the network. It also indicates the 
controlling server node. Use the following procedure to setup Controller Link Network Status settings. 

1, 2, 3… 1. Select the Network Status option from the Controller Link menu. 
 2. Select the Close pushbutton to remove the dialog. 

Network Settings 
The Network Setup dialog allows parameter settings for a Controller Link network to be defined; this includes the 
maximum number of nodes on a network, the maximum number of polling units per communications cycle, and 
the maximum number of frames per communications cycle. 

On entry, this dialog displays the last parameters entered for a selected network. Use the following procedure to 
setup Controller Link Network Setup settings. 

1, 2, 3… 1. Select the Network Setup option from the Controller Link menu. 
 2. Adjust the settings as required (or select the New pushbutton to return to the default values 

for the network). 
 3. Select the Write pushbutton to download the network parameters to the SYSMAC LINK 

network controller. Note that this is only possible when the connected node is the polling 
(server) node – otherwise the Write pushbutton is disabled. The status display indicates 
whether the write operation was successful. 

 4. Select the Close pushbutton to remove the dialog. 

Routing Tables 
Routing tables allow networked PLCs to be configured so that they can communicate with each other via 
gateways; across remote networks. These tables contain the network and unit number information required. It is 
only necessary to set up routing tables if the end connection PLC is not a direct connection, i.e. using another PLC 
as a gateway connection. The routing table is held within the PLC(s) which acts as the gateway device. Different 
types of PLC and networks have different capabilities for routing. 

For details about using routing tables refer to Chapter 11 – Routing Tables. 
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Data Link 
Data Link tables allow a PLC to be configured so that it can participate in one or more automatic data sharing 
schemes, over SYSMAC LINK, SYSMAC NET and Controller Link networks, without the need for special 
programming. Words of IO and DM can be set aside for use as data link words, which are allocated to various 
nodes in the network. Limits on the amount of data and number of nodes varies with the type of network and the 
type of PLC. The allocation of words to nodes is defined by two or more Data Link tables. 

Data can only be shared on a single physical network. A gateway cannot be used to pass information from one 
network to another. 

SYSMAC NET data links can be configured so that both C-Series and CV-Series PLCs can share data. However, 
it is a limitation that in these mixed configurations, the master must be a C-Series PLC. There are no such 
restrictions on a SYSMAC LINK or Controller Link network. 

The Data Link menu includes options to setup the SYSMAC NET, SYSMAC LINK and Controller Link Data 
Links. 

The DataLinks Editor is used to configure SYSMAC LINK and Controller Link data links, Refer to Chapter 10 – 
Data Links.  

A separate datalink editor is utilised for configuration of SYSMAC NET datalinks, Refer to Chapter 8 - Offline 
SYSMAC NET Data Link Editor for further details. 

Data Link Setup 
The Data Link Setup dialog varies in title and content according to the type of network connected to the current 
PLC; however, the pushbutton functions on each dialog are the same. 

The dialog lists the contents of the Data Link table associated with the PLC; initially the Data Link table displayed 
is empty, or set to zero, until a table has been opened or read. 

SYSMAC NET Data Link Setup 
The setup dialog first needs to know whether the Data Link table is written for CV-Series or C-Series PLC type 
SYSMAC NET this information is requested using the SYSMAC NET Table Type dialog. 

Use the following procedure to setup the SYSMAC NET Data Link. 

1, 2, 3… 

 

1. Select the Online Edit Data Link button from the toolbar. 
2. Select a setting to indicate the type of SYSMAC NET which is used in the Data Link. 

 3. Select the OK pushbutton to continue (the Data Link Setup dialog is displayed), or the 
Cancel pushbutton to abort the operation. 

Opening a Table 
Use the following procedure to open a table. 

1, 2, 3… 1. Select the Open pushbutton to open a Data Link table from disk (alternatively select the 
Read pushbutton to view the table in the PLC). 

 2. Select the appropriate table and select the OK pushbutton. 
 3. The Data Link Setup dialog is now populated with the contents of the Data Link file. 
 4. Select the Write pushbutton to transfer the table to the PLC. 
 5. Select the Verify pushbutton to compare the contents in the dialog with those in the PLC. 

Note: Data Link tables have a ‘.SL3’ (SYSMAC LINK), ‘.SN3’ (SYSMAC NET) or ‘.CL3’ 
(Controller Link) filename extension. 

Editing a Table 
To edit the displayed Data Link table, click on the Edit pushbutton; the associated offline table editor is used, refer 
to Chapter 10 – for SYSMAC LINK / Controller Link Data Link Editor and Chapter 8 - Offline SYSMAC NET Data 
Link Editor for further details. 
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Updating Table Status 
After an editing session using the offline editor (i.e. after pressing the Edit pushbutton), the dialog can be updated 
using the Update pushbutton. 

Saving a Table 
The Save As dialog allows the displayed table to be saved to disk with a given name. Use the following procedure 
to save a table. 

1, 2, 3… 1. Click on the Save As pushbutton in the Data Link Setup dialog. The Save As dialog is 
displayed. 

 2. Enter the new file name for the data link table (ensure that the file type is correct) in the 
File name field. 

 3. Either select the Save pushbutton to save the new file and return to the previous dialog or 
select the Cancel to abort the operation. 

Deleting a Table in a PLC 
The current Data Link table held in the PLC can be deleted by selecting the Delete pushbutton. 

Viewing Table Information 
The Table Information dialog displays basic information relating to the selected Data Link table indicating the 
author, associated network and file name. The information displayed on this screen cannot be edited whilst online. 
Use the following procedure to view table information. 

1, 2, 3… 1. Select the Info pushbutton on the Data Link Setup dialog. 
 2. Select the Close pushbutton to remove the dialog from the screen. The Data Link Table 

dialog is redisplayed. 
Select the New pushbutton in the dialog to clear the dialog information. 

Offline SYSMAC NET Data Link Editor 
The SYSMAC NET Data Link Table Editor is available to both CV-series and C-series PLCs linked to a 
SYSMAC NET unit. 

 
The status bar provides instant help. 

 
Access to the SYSMAC NET Data Link Editor dialog is achieved in a number of ways: 

♦ From the CX-Net Network Configuration tool. Select Editor from the Data Link menu. The 
Select New File type dialog is displayed. Select the SYSMAC NET file type from the File 
Type field and select the OK pushbutton. 

♦ From the Data Link Setup dialog. Select the Edit pushbutton. 
♦ From the Start pushbutton in the Microsoft Windows taskbar. The Select New File type 

dialog is displayed. Select the SYSMAC NET file type from the File Type field and select 
the OK pushbutton.  
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Creating and Editing a SYSMAC NET Data Link Table Item 
Use the following procedure to create SYSMAC NET Data Link Table Item. 

1, 2, 3… 

 

 

1. Select the New button from the toolbar in the SYSMAC NET Data Link Table Editor 
dialog. 

2. Select the Insert Table Item option from the Table menu. Address information can also be 
edited by double-clicking on the required node.  

The Add SYSMAC NET Data Link Table Item dialog allows the memory area at the node to be configured. Use 
the following procedure to configure the node. 

1, 2, 3… 1. Enter the node number in the Node No field; this must be in the range 1 to 126. /verify 
where 

 2. Enter the memory size; this must be in the range 0 to 127.  
 3. Select the OK pushbutton to redisplay the Data Link Table Editor. 

Note: The above example applies to CV-Series, but C-Series operates in exactly the same 
manner although the information displayed differs slightly. 

 
To edit a Data Link table, double-click on a table item or select the Edit Table Item button 
from the toolbar; the Edit Data Link Table dialog is displayed (this is identical to the Add Data 
Link Table Item dialog shown above).  

Deleting an Item from the SYSMAC NET Data Link Table 
Use the following procedure to delete an item from the SYSMAC NET Data Link Table. 

1, 2, 3… 1. Select the node to delete an item and select the Delete Item button from the toolbar. 

 
2. A confirmation dialog is displayed. Select the Yes pushbutton to confirm the deletion of 

the item. Select the No pushbutton to abort the operation. 

Opening an Existing SYSMAC NET Data Link Table 
Use the following procedure to open an existing SYSMAC NET Data Link Table. 

1, 2, 3… 

 

1. To open a table from disk, select the Open button from the toolbar in the Data Link Editor 
dialog. A standard File Open dialog is displayed. 

 2. Select a file from the Open dialog and select the Open pushbutton. The SYSMAC NET 
Data Link Table Editor is automatically populated with the contents of the selected file. 

Note: SYSMAC NET Data Link table files are identified by the ‘.SM3’ extension. 

Logical Error Checking 

 
The SYSMAC NET Data Link Table Check dialog displays any errors resulting from validation 
of the address details entered in the table; it is identical in appearance to the SYSMAC LINK 
Data Link Table Check dialog shown earlier and is obtained in the same way. 

Old Format Tables 
Data Link tables were previously held in ‘.SNT’ and ‘.SN2’ file format. The File Open dialog allows these file 
types to be opened in the CX-Net Network Configuration tool. Use the following procedure to open ‘.SNT’ and 
‘.SN2’ formatted files. 

1, 2, 3… 1. Select the Add (old) option from the Table menu in the SYSMAC NET Data Link Table 
Editor dialog. 

 2. Select a file from the Open dialog and select the Open pushbutton.  

Table Information 

 The Data Link Table Information dialog allows the recording of comments against a particular 
table and is the same both in operation and appearance, as that for the routing table comments 
described earlier. 
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 CHAPTER 9 
PLC Clock Tool 

The PLC Clock tool provides a facility to monitor and set the PLC Clock and synchronise the PLC clock to the PC 
clock. 

The PLC Clock tool dialog can be set so that it remains ‘on top’ and is not obscured by other windows by clicking 
the right mouse button in the task bar and selecting the Always on Top option. 

 To close the PLC Clock dialog, select the Close button in the title bar.  

 
 

The PLC Clock tool displays two clock images that represent the time for the computer (PC) on the left and the 
PLC on the right. The time and date are also represented in a digital format for both the computer and the PLC. 

The times for both the Computer and the PLC are updated once a second. 

A synchronise button is located centrally between the two clock images. This button once pressed, will 
synchronise the PLC clock to the computer clock. The same effect can also be evoked from the Options – 
Synchronise Clocks menu. 

The File menu allows the PLC Clock tool to be closed by use of the Exit menu item. 

The Options – Set PLC Clock allows the time and date within the PLC to be set. 

If the PLC Clock window is minimised the PLC clock time will be displayed in digital format in the task bar. 

 



 
 

 



 PART 2: CX-Server PLC Tools  
OMRON CHAPTER 10 – Data Links 
 
 

 CX-Server PLC Tools_Page 91 

 CHAPTER 10 
Data Links 

What Are Data Links? 

Overview 
Data links automatically exchange data in preset areas between nodes (PLCs and/or computers) on a network. 
Settings can be made either manually or automatically.  

CX-Net operations can be used for all operations from setting up the PLC network to controlling data exchange. 

Manual Settings 
Manual settings enable more flexible allocations, including the send size for each node, the sequence of nodes for 
sending and receiving, and the setting of nodes for sending only or receiving only. Use manual settings to create 
flexible data links to meet the requirements of the individual system (e.g., efficient utilization of memory, 
restrictions on allocated addresses, etc.).  

Data link tables (i.e., tables that define data link area allocations) are generated by CX-Net or network support 
software (such as Controller Link Support Software), and sent to all nodes for use. 

Controller Link

PC PC PC

 
Note: The following table provides a general comparison of manual setup between Controller 

Link and SYSMAC LINK. 

Item Controller Link SYSMAC LINK 
Node sequence Free 

Send size Can be specified. 

Receive-only nodes Supported Supported 
 (Reception only is enabled by 

setting the send area size at the 
local node to 0.)  

Send-only nodes Supported 

Memory area Can be specified. Cannot be specified. Fixed as 
follows: 

CS/CJ/CV Series: Area 1: CIO; 
Area 2: DM 

C Series: Area 1: LR; Area 2: DM 

Receive size Can be specified. All or none 

Reception offset (reception 
from start address + specified 

number of words)  

Can be specified. No (From start address only)  

Communications cycle time Cannot be set. Can be set. 

PLC PLC PLC 
Controller Link 
Unit 

Only part of area 

Only part of area 
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Automatic Settings 
Automatic settings can be used for simple data exchanges involving fixed allocations, when all nodes are set for 
the same send size and the same data is to be shared among all nodes in order of node address. 

Using a Programming Device (such as the CX-Programmer or a Programming Console), set the data exchange 
method in the DM parameter area of the startup node. 

Controller Link

 
Note: The following table provides a general comparison of automatic setup between 

Controller Link and SYSMAC Link. 

Item Controller Link SYSMAC LINK 
Node sequence Fixed at ascending order. 

Receive-only nodes Not supported. 

Send-only nodes Not supported. 

Memory area Can be specified. (Area 1: CIO 
Area or LR Area; Area 2: DM Area 

or EM Area)  

Cannot be specified. Fixed as 
follows: 

CS/CJ/CV Series: Area 1: CIO; 
Area 2: DM 

C Series: Area 1: LR; Area 2: DM 

Start address Can be specified. Cannot be specified.  

Send size Same size for all nodes can be 
specified. 

Same size for all nodes can be 
selected from specific patterns. 

 

This section describes how to perform Controller Link and SYSMAC LINK operations from creating data link 
tables to starting up the data links. 

PLC PLC PLC 
Controller Link 
Unit 

Data exchange (shared data)  
(I/O Area, LR Area, DM Area, etc.) 
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User Interface Overview 

Datalink Component 
The following illustration shows the window used when constructing Controller Link or SYSMAC LINK data 
links manually. 

 

Data Link 
Configuration 
window 

Node Editing
window 

Toolbar 

Function Bar 
 

Data Link Component Menu 
Menu Sub-menus/ 

Commands 
Function 

File New Creates new data link tables. 

Open Opens data link tables, Files with any of the file name extensions 
shown below can be opened. 

When a file is opened, the proper editor starts up. 

 Controller 
Link 

♦ cl2 – CX-Net Controller Link/CLKSS data link tables 
♦ cl3 – CX-Net Controller Link data link tables 
♦ clk – CLKSS data link tables 
♦ csv – CX-Net Controller Link data link tables (tab-delineated text 

file)  
SYSMAC 
LINK 

♦ .sl3 – SYSMAC LINK data link tables 
♦ .slk – SYSMAC LINK data link tables for SYSMAC Support 

Software 
♦ .csv – SYSMAC LINK data link tables (tab-delineated text file)  

Save Saves the data link tables that are being edited. 

Save As Saves data link tables, Files with any of the file name extensions 
shown below can be saved. 

 Controller 
Link 

♦ .cl2 – CX-Net Controller Link/CLKSS data link tables 
♦ .cl3 – CX-Net Controller Link data link tables 
♦ .clk – CLKSS data link tables 
♦ .csv – CX-Net Controller Link data link tables (tab-delineated text 

file)  
SYSMAC 
LINK 

♦ .sl3 – CX-Net SYSMAC LINK data link tables 
♦ .csv – CX-Net SYSMAC LINK data link tables (tab-delineated 

text file)  

Print Prints data link information. 

Print Preview Previews the data to be printed. 
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Menu Sub-menus/ 
Commands 

Function 

Exit Exits the Datalink Component window. 

View Move Right Moves the cursor to the right in the Data Link Configuration window. 

Move Left Moves the cursor to the left in the Data Link Configuration window. 

Move Up Moves the cursor up in the Data Link Configuration window. 

Move Down Moves the cursor down in the Data Link Configuration window. 

Change Window Changes the active window. 

Zoom Out Zooms out from within the Data Link Configuration window. 

Zoom In Zooms in within the Data Link Configuration window. 

Zoom Original Returns the Data Link Configuration window to its initial scale. 

Show in List Shows the Data Link Area settings in list format. 

Show in Table Shows the Data Link Area settings in table format. 

Show Func Bar Shows function key guides at the bottom of the Datalink Component 
window. (Enabled for table format only.)  

Show Offset Shows the specified offset value on the Node Editing window. 

Table Wizard Executes the Datalink Wizard. 

Add Source Link Adds a node to the data links.  

Add Destination Adds the receive area of a participating node to the data links. 

Delete Deletes nodes. 

Validate Table Checks data link tables. 

Table Information Edits data link table information. 

Show Node List Displays a list of nodes. 

Redraw Resets colored displays. 

Online 

 

Transfer from PLC Uploads online data link tables to the computer. 

Transfer to PLC Downloads online data link tables from the computer to a PLC. 

Verify Node Compares data link tables generated by CX-Net with data link tables 
stored in the PLC. If they do not match, a error dialog box is displayed. 

Data Link 
Operation/Status 

Displays the operation and data link status of manually set data links. 

Automatic Data 
Link Setup 

Sets parameters for automatically set data links, and transfers them to 
the startup node. 

Set All Nodes for 
Network Operation 

Executes transfer, verify, and delete operations for all nodes.  

Show All Network 
Nodes 

Reads data link tables from all nodes. 

Delete Deletes data link tables. 

Options Cycle Time Sets the communications cycle time (for SYSMAC LINK data link 
tables only). 

Help Displays help. 
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Toolbar 

 
(1) (2) (3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13) (14) (15) (16) (17) (18) (19) (20) 

No. Icon Function 

(1) New Creates new data link tables. 

(2) Show All Network Nodes Shows all nodes in the network. 

(3) Open  Opens a data link tables, Files with any of the file name 
extensions shown below can be opened. 
When a file is opened, the proper editor starts up. 

 Controller Link .cl2 – CX-Net Controller Link/CLKSS data link tables 
.cl3 – CX-Net Controller Link data link tables 
.clk – CLKSS data link tables 
.csv – CX-Net Controller Link data link tables (tab-delineated 

text file)  

SYSMAC LINK .sl3 – SYSMAC LINK data link tables 
.slk – SYSMAC LINK data link tables for SYSMAC Support 

Software 
.csv – SYSMAC LINK data link tables (tab-delineated text 

file)  

(4) Save Saves the data link tables that are being edited. 

(5) Toggle Network/Single Node 
Operation 

Specifies either all nodes or a single node for data transfers. 

(6) Transfer to PLC Downloads online data link tables from the computer to a PLC.  

(7) Transfer from PLC Uploads online data link tables to the computer. 

(8) Delete Deletes data link tables. 

(9) Verify Node Compares data link tables generated by CX-Net with data link 
tables stored in the PLC. If they do not match, a error dialog box 
is displayed. 

(10) Data Link Operation/Status Displays the operation and data link status of manually set data 
links. 

(11) Automatic Data Link Setup Sets parameters for automatically set data links, and transfers 
them to the startup node. 

(12) Validate Table Checks data link tables. 

(13) Wizard Executes the Datalink Wizard. 

(14) Add Source Link Adds a node to the data links. 

(15) Add Destination Adds the receive area of a participating node to the data links. 

(16) Set Source or Destination 
Link Area Properties 

Displays the Node Settings dialog box. This dialog box is used 
to modify the node properties. 

(17) Delete Link Destination 
Service Area 

Deletes nodes selected in the Data Link Configuration window, 
or deletes a receive area. 

(18) Zoom In/Zoom Out/Zoom 
Original 

Zooms the Data Link Configuration window in or out, or returns 
it to the initial scale.  

(19) Print Prints data link information. 

(20) Help Displays help. 
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Function Bar 

 
 

(1) (2) (3) (4) (5) (6) (7) (8) (9) (10)  

No. Icon Function 
(1) F1: Help Displays help. 

(2) F2: Node<->Table Moves the focus between nodes and tables. 

(3) F3: Link Start Address Moves the focus between settings for the link start addresses 
(status, Area 1, Area 2).  

(4) F4: Move Up Area Moves a node up the node refresh sequence. 

(5) F5: Move Down Area Moves a node down the node refresh sequence. 

(6) F6: Show/Hide Offset Shows or hides the offset for the node being displayed. 

(7) F7: Insert Area Inserts a new receive area (new node). 

(8) F8: Delete Node Deletes a node or communications area. 

To delete a node or link area from a node list, select the item from 
the list and then click F8: Delete Node. 

To delete a node or link area from a table, select the item from the 
table and then click F8: Delete Node.  

(9) F9: Show Prev Node Shows the previous node. 

(10) F10: Show Next Node Shows the next node. 

 

Manually Setting Data Links 
 

Follow the procedure described below to create data link tables manually for Controller Link or SYSMAC LINK 
data links. 

Note: There is no need to create a data link tables when data links are set automatically. For 
details on automatic setup, refer to Automatically Set Data Links.  
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Procedure through Data Link Startup 

 

Reading the Data Link Tables, and Transferring Them to the PLC from Datalink Component 
window 
1) Data Link | Setup 
2) Select either Controller Link Unit or SYSMAC LINK Unit as the Communications Unit 
  mounted to the PLC. (For the local network only, i.e., when the network address is 0.)  
3) File | Open 
4) Online | Transfer to PLC 

Connect Online (CX-Net: PLC | Open). 

Creating a CX-Server File (*.CDM) for Online Connection. 
1) Select New from the Project menu, and save the file under a file name. 
2) Select Add Device from the Project menu, and register the PLC. 

Save the data link tables (Datalink Component window: File | Save). 

Check the data link tables (Datalink Component window: Table | Validate Table). 

Start the software. 
Open the Datalink Component window (Data Link | Setup | Controller Link or SYSMAC 
LINK or SYSMAC NET). 

 

Creating Data Link Tables Online 
1) Datalink Wizard Settings (Table | Wizard). Use the manual setting function if the data  
  link tables are to be created manually. 
2) Node Edit Window Settings 

Starting the Data Links from the Datalink Component Window 
1) Data Link | Setup 
2) Select either Controller Link Unit or SYSMAC LINK Unit as the Communications Unit 
mounted to the PLC. (For the local network only, i.e., when the network address is 0.)  
3) Online | Data Link Operation/Status 
4) Select the Run option in the Operation field, and click the Set button.  
 

 
Reference: Create data link tables manually when any of the following conditions is present: 

1 The send area size differs for nodes participating in the data link. 
2 The sequence of send nodes differs from the sequence of node addresses. 
3 There are nodes that receive only part of the send data (Controller Link only). 
4 There are nodes that receive data with an offset specified (Controller Link only). 
5 There are nodes that do not send data (Controller Link only). 
6 There are nodes that do not receive data. 
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Creating Data Link Tables 
Create a data link table for each node registered in the CX-Server file that is read. 

Make the settings for (1) to (8) below. 

 
 
 

 

Node 2 
(receive) 

(3)  
Area setting 
(area/start 
address) 

(4) Send size 

(2) Node 1 
PLC type 

 

 

Node 1 
(send) 

Node 3 
(receive) 

(7) Receive  
sizes from 
remote nodes 

(5) Node refresh sequence:  
  2,  1,  3       1,  2,  3          2,  1,  3 

(6)  
Status area 

Node 3 
(receive) 

Node 3 
(send) 

Node 2 
(send) 

Node 1 
(receive) 

Node 1 
(receive) 

Node 2 
(receive) 

 

Data link 
status 

Data link 
status 

Data link 
status 

Node 2 
PLC 

Node 3 
PLC 

(8) 
Offsets 

(1) Participating data link nodes 

 
To create a data link table, make the following settings in order. 

1 Datalink Wizard Settings 

 

 

(1) Set participating data link nodes.  

 

(2) Set the PLC type. 

(3) Set the areas. 

(6) Set the status area. 

(5) Set the refresh node sequence. 

(4) Set the send size. 

 
2 Node Editing Window Settings 

 (7) Set receive sizes from remote nodes. 

(8) Set offsets.  
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Note 1: It is possible to add or delete nodes from the participating data link nodes 
(1) using the Datalink Wizard. 

Add 
Adding nodes Select Table | Add Source Link. 

Adding link words Select Table | Add Destination. 

Delete 

Deleting specified nodes or link areas Select the node from the node list, and 
then click F8: Delete Node. 

Deleting link areas from specified nodes Select the node from the table, and then 
click F8: Delete Node. 

Note 2: It is possible to change the following items set by the Datalink Wizard for each node: 
(2) PLC type, (3) Area (memory area and start address), (4) Send size, (5) Node refresh 
sequence (see note 3), and (6) Status area.  

Note 3: The node refresh sequence is set using F4: Move Up Area and F5: Move Down Area. 
Reference: The operations differ for Controller Link and SYSMAC LINK when creating data links. 

The following table shows the points on which the manually set data link functions are 
different. 

Function Controller Link SYSMAC LINK 
(1) Offset setting Supported Not supported 

(2) Receive size setting Supported Not supported. (It is only possible 
to specify whether all of none of 
the data sent is to be received.)  

(3) Memory area Area 1: Can be selected. 

Area 2: Can be selected. 

(CIO, LR, DM, EM, etc., 
according to PLC type)  

Area 1: CIO 

Area 2: DM 

(Fixed.)  

(4) Communications cycle time 
setting 

Not supported Supported 

These four differences apply even to data link setup operations using the CX-Net. Aside from these points, other 
operations are basically the same. 

System Configuration Example 
The procedure is described below, from data link creation through startup, taking a Controller Link data link 
system as an example. 

 

CX-Net 

Controller Link network 

CS1G-CPU45 

Peripheral Bus or Host Link 

Data link 

CS1G-CPU45 C200HX 

1 2 3 

Data link 

PLC type 

Node address 
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Data Link Setup Example 

  

 Area 2 

 Send (#1) 

Receive (#2) 

Receive (#3) 

DM500 

DM530 

DM560 

DM600 

Node 1 

 Send (#2) 

Receive (#1) 

Receive (#3) 

Node 2 

 
Send (#3) 

Receive (#1) 

Receive (#2) 

Node 3 
DM600 

DM630 

DM660 

DM700 

DM730 

DM760 

Area 1 

 Send (#1) 

Receive (#2) 

Receive (#3) 

CIO 1000 

CIO 1030 

CIO 1060 

CIO 1100 

Node 1 

CS1G 

 Send (#2) 

Receive (#1) 

Receive (#3) 

Node 2 

CS1G 

 
Send (#3) 

Receive (#1) 

Receive (#2) 

Node 3 

C200HX 

CIO 1200 

CIO 1230 

CIO 1300 

IR  300 

IR  320 

IR  350 

IR  390 

CIO 1260 
Size 

20 words 

Offset 
10 words 

DM700 DM800 

 
The refresh sequence for nodes 1 and 2 is as follows: #1, #2, #3. For node 3, the order is #2, #1, #3. Node address 
03 does not receive all of the data sent from node address 02. Rather, data from the 20 words (CIO 1240 to CIO 
1259) beginning from the start address +10 words (i.e., the offset) is received in IR 300 to IR 319. Other data is 
received with no offset. 
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Creating Data Link Tables Offline 
First create manually set data link tables offline. 

Datalink Wizard Operations 
1 While offline, select Setup from the Data Link menu in CX-Net. The Data Link dialog box will be displayed. 

  
2 Select either Controller Link or SYSMAC LINK, and then click the OK button. 

The Datalink Component window will be displayed. 
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3 Select Table | Wizard. If data link tables have already been input, the following dialog box will be displayed. 
(It will not be displayed if these are the first data link tables being created.)  

 

 
4 Click the Yes button. The Datalink Wizard dialog box will be displayed for setting the participating data link 

nodes. 

 

Addresses of nodes to participate in the 
data links. 

If this box is selected, fast 
default table generation will 
be set when the Defaults 
button is clicked. In that 
case, all nodes will be set 
as a group, using the initial 
values that have been set. 

Clicking the Defaults button 
sets the initial values used 
for fast default table 
generation. 

 
5 Set the addresses of the nodes that are to participate in the data links. In this case, input 1-3 to set node 

addresses 01 to 03. (To set node addresses 01, 02, and 04, for example, input 1,2,4.)  
6 Click the Next button or press the Enter key. The following dialog box will be displayed. 

  

  

(1) 

(2) 

(3) 

(6) 

(4) 

(5) 

(7) 

(8) (9) 

 

 

No. Item Function 
(1) Node Displays node number to set. 

(2) PLC Sets the PLC type. 

(3) Memory area Area 1 memory area 

  Area 2 memory area 
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No. Item Function 
(4) Start Address Area 1 start address 

  Area 2 start address 

(5) Size Area 1 local node send size (in words)  

  Area 2 local node send size (in words)  

(6) Status Data link status memory area (See note.)  

(7) Ordered Destination 
Nodes 

Node Refresh Sequence 

Beginning with the data link start address above, specify which nodes are to 
have data refreshed at the local node address and the order in which data is to 
be refreshed (i.e., the node refresh sequence). This order will be the same for 
Area 1 and Area 2. 

(For the local node address, data is sent from the local node area. For a 
remote node address, data is received from the remote node address to the 
local area.)  

Note: • The local node must be included in the refresh nodes. 

• If the address of any node participating in the data links is not entered 
here, data will not be received from that node. 

Example: If 1, 2, 3 is input, node addresses 1, 2, and 3 will be allocated in 
order, beginning with the start address. 

(8) Make Default Click this button to make the values set for the above items the default values 
for new data link settings. 

(9) Next >> Click to proceed to the next dialog box. 

 
Note: The default setting for data link status depends on the PLC being used. For details, refer to the Controller 

Link Units Operation Manual (W309). 
PLC Data link status 

CS/CJ Series The data link status is contained in the 16 words (fixed) from CIO 1500 +25 × unit number + 
7 to 22 in the CPU Bus Unit Area. 
  15  8 7  0 

+7 words Node 2 Node 1 
... ... ... 

+22 words Node 32 Node 31  

CVM1/CV Series 

C200HX/HG/HE The data link status for node addresses 1 to 6 only is contained in the words from SR 239 to 
SR 241, and SR 241 to SR 245. 
 Network 0 Network 1 15  8 7  0 

SR 239 SR 243 Node 2 Node 1 
SR 240 SR 244 Node 4 Node 3 
SR 241 SR 245 Node 6 Node 5 

 
CQM1H Series The data link status for node addresses 1 to 6 only is contained in the words from IR 91 to IR 

93. 
  15  8 7  0 

IR 91 Node 2 Node 1 
IR 92 Node 4 Node 3 
IR 93 Node 6 Node 5  

 
7 Set node address 01 as shown in the following table, and then click the Next button or press the Enter key. Set 

node addresses 02 and 03 in the same way. 
Item Data set Description 

Node address 1 − 

PLC type CS1G-CPU45 − 
Area 1 Memory area CIO Sets CIO 1000 as the data link start 

address for the Area 1 local node. 
Start address 1000 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 1 local node. 

Area 2 Memory area D Sets D00500 as the data link start 
address for the Area 2 local node. 

Start address 500 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 2 local node. 
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Item Data set Description 
Ordered destination nodes 1, 2, 3 Specifies the node refresh sequence. 

Beginning with the start addresses, 
nodes 01, 02, and 03 are set in order. 
(The local node address is 1, so 
transmission is first, followed by reception 
from node 02, and finally reception from 
node 03.)  

Status Memory area CIO Sets CIO 1100 as the data link status 
start address. 

Start address 1100 

 
8 Set node address 02 as shown in the following table. 

Item Data set Description 
Node address 2 − 

PLC type CS1G-CPU45 − 
Area 1 Memory area CIO Sets CIO 1200 as the data link start 

address for the Area 1 local node. 
Start address 1200 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 1 local node. 

Area 2 Memory area D Sets D00600 as the data link start address 
for the Area 2 local node. 

Start address 600 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 2 local node. 

Ordered destination nodes 1, 2, 3 Specifies the node refresh sequence. 
Beginning with the start addresses, nodes 
01, 02, and 03 are set in order. (Reception 
from node 01 is first, followed by 
transmission from the local node, and 
finally reception from node 03.)  

Data link status 
start address 

Memory area CIO Sets CIO 1300 as the data link status start 
address. 

Start address 1300 

 
9 Set node address 03 as shown in the following table, and then click the Next button or press the Enter key. 

Item Data set Description 
Node address  3 − 

PLC type  C200HX − 
Area 1 Memory area IR Sets IR 300 as the data link start address 

for the Area 1 local node. 
Start address 300 

Send size 40 Sets 40 words as the send size (unit: 
words) for the Area 1 local node. 

Area 2 Memory area DM Sets DM 700 as the data link start address 
for the Area 2 local node. 

Start address 700 

Send size 40 Sets 40 words as the send size (unit: 
words) for the Area 2 local node. 

Ordered destination nodes 2, 1, 3 Specifies the node refresh sequence. 
Beginning with the start addresses, nodes 
02, 01, and 03 are set in order. (Reception 
from node 02 is first, followed by reception 
from node 01, and finally transmission from 
the local node address.)  

Data link status 
start address 

Memory area LR Sets LR0 as the data link status start 
address. 

Start address 0 
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Reference: Fast Datalink Wizard Settings 
It is possible to generate a table with all nodes set for the same PLC type and the same 
areas (using Fast Default Table Generation), and then to modify individual nodes in the 
Node Editing window as required. 
Make the settings as follows: 

  
1 Click the Defaults button and then set the default values in the following

dialog box. 

 
2 Select the Fast Default Table Generation option, and then click the Next

button or press the Enter key.  
The settings for all participating nodes will be generated at the above 
default values. 

♦ PLC type 
♦ Memory area, data link start address, communications data size 
♦ Status memory area  
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Node Editing Window Settings 
10 The following Datalink Component window will be displayed. 

 

 

Data Link 
Configuration 
window 

Node Editing 
window 

 

Data Link Configuration Window 

 

Indicates the data link memory area. 

Indicates the data link 
memory area. 
1: Area 1 
2: Area 2 

The same color indicates that 
data is shared among nodes. 

The ovals indicate the send 
areas (Area 1 and Area 2). 

            : The arrows indicate the direction of data transfer. 

The rectangles indicate the receive 
areas (Area 1 and Area 2). 

Participating data link node 
address 

 
Send areas are indicated by ovals in order of the addresses of nodes participating in the data links. The same color 
indicates that data is shared among nodes. Therefore, with the number of participating nodes represented by n, one 
oval and n-1 rectangles are shown for each node. 

This window can be used to check the data sent and received between nodes. 
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Node Editing Window Settings 
Set the data link details for each node (i.e., send size, receive size, reception offset) in the Node Editing window. 

Note: The Node Edit window appears in table format by default, as shown below. To convert 
it back into the earlier list format, select View | Show in List. 

 

 
(1) (2) (5) (6) (7) (8) (9) 

(10) (4) 
(3) 

The settings for each active node 
shown in the node field to the left 
are displayed here. 

 

No. Name Description 
(1) Node Selects the address of the node to be edited. 

The settings for an active node (selected with ) are displayed to the right. 

(2) PLC The PLC type set by the Datalink Wizard is displayed and can be changed here. 

(3) Status The status memory area and start address set by the Datalink Wizard are displayed and can 
be changed here. 

(4) Area 1/Area 2 The Area 1 and Area 2 classifications and start addresses set by the Datalink Wizard are 
displayed and can be changed here. 

(5) Node 
(Display only. Order 
can be changed.)  

• Node addresses are displayed from top to bottom, in order of node refreshing at the local 
node (in order of allocated node address).  

• To change the refresh sequence set by the Datalink Wizard, click either F4: Move Up Area 
or F5: Move Down Area in the Function Bar, or press the corresponding Function key. 

(6) Link Addr. 
(Automatic display)  

• For the local node send area, the start address of the data sent from the local node is 
automatically displayed. 

• For the receive area from remote nodes, the local node start address for storing data 
received from remote nodes is automatically displayed. 

(7) Size 
(Setting/Display)  

• For the local node send area, the send size set by the Datalink Wizard is displayed and can 
be changed here. 

• For the receive area from remote nodes, the receive size from remote nodes is set here in 
word units. (It can only be set here.) The default is the entire send size from remote nodes. 

(8) Offset 
(Setting/Display)  

The reception offset from the source start address displayed at “Src. Addr.” is set here. (The 
default is 0.)  

(9) Src. Addr. 
(Automatic display)  

• For the local node send area, “Send” is automatically displayed. 

• For the receive area from a remote node, the remote node’s source start address (the value 
before the offset) is automatically displayed. 

(10) F4: Move Up Area 
F5: Move Down 
Area 

Changes the node refresh sequence. 
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Node Editing Window (Edited Node Address: Node 01)  

 Address at local node 

(1) 

(2) 

(3) 

Indicates that the node refresh sequence at the local 
node (node 01) is 03 to 01 (local node) to 02. 

Address at remote node 

 

Function 
(1) Indicates that 20 words (D00000 to D00019) 

from a remote node (node 03) are received into 
the area starting from CIO 01000 (i.e., CIO 
01000 to CIO 01019) at the local node (node 01). 

(2) Indicates that 30 words starting from CIO 01020 
(i.e., CIO 01020 to CIO 01049) from the local 
node (node 01) are sent to a remote node. 

(3) Indicates that 40 words (CIO 00200 to CIO 
00239) from a remote node (node 02) are 
received into the area starting from CIO 01050 
(i.e., CIO 01050 to CIO 01089) at the local node 
(node 01). 

Reference: It is also possible to display the Node Editing window in list format, as before. 
Select View | Show in List from the menu. The change will go into effect the next time 
the window is opened. 

 

 

Node Editing window 

 

Setting Size (Send or Receive) and Offset 

♦ The send size can be set for the local node row by double-clicking in the Size cell. (The default is the size set 
by the Datalink Wizard.) For remote node rows, the receive size can be set. (The default is the entire send size 
from remote nodes.)  

♦ The reception offset can be set by double-clicking the Offset cell. (The default is 0.)  

 Size and offset can be set. 

Automatically displayed. 
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Reference: Size modifications and offsets can be set in the Area Specify dialog box that is 
displayed by double-clicking on the data link configuration icon (oval for send area 

 or rectangular for receive area ). 

 
Area Specify Dialog Box (Send Area)  

 

 

Specify send size. 
Offset cannot be changed. 

 
Area Specify Dialog Box (Receive Area)  

 
Specify send size. 

Offset cannot be changed. 

 
Note: With SYSMAC LINK, the send size can be set, but the receive size and the reception 

offset cannot. Therefore, the Area Specify dialog boxes are as shown in the following 
example diagrams. 

• Send Area • Receive Area 

Can be set. 

 

Cannot be set. 
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Changing Node Refresh Sequences 
The node refresh sequence set for each node by the Datalink Wizard can be changed in the Node Editing window. 

In the Node Editing window, select the node for which the refresh sequence is to be changed. 

  

Change the node refresh sequence by either clicking F4: Move Up Area or F5: Move Down Area in 
the Function Bar, or pressing the F4 or F5 function keys. 

  
Reference: The node refresh sequence for individual nodes cannot be checked in the Data Link 

Configuration window. Node refresh sequence checking and changes must be 
performed in the Node Editing window. 

Adding Participating Nodes to Data Links 
In the Node Editing window, it is possible to add nodes aside from the participating nodes set by the Datalink 
Wizard’s Network Nodes setting. 

 

The following window is displayed by selecting Table | Add Source Node from the Datalink Component menu 

or by clicking the  button in the Toolbar. 

 
Specify the node address, PLC type, and the Area 1 and Area 2 memory areas, and then click the OK button. 

F5: Move 
Down Area 
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The node will be added. 

 

Added.  

Deleting Nodes Added to the Data Links 
Select the node to be deleted from the Node Editing window. 

Delete the node by clicking the F8: Delete Node button in the Function Bar. 

Caution: If the node is deleted by clicking the  button in the Toolbar, the deletion will be executed immediately. 

Setting to Not Receive Data 
Set the receive size to 0 in the Node Editing window. 

 

Setting to Not Send Data 
Set the send size to 0 in the Node Editing window. 
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Procedure Using Setup Example 
Set Area 1 for each node, based on the data link setup example in the example system configuration. 

Note: The receive size and reception offset can only be set for Controller Link, and not for 
SYSMAC LINK. 

Setting Node Address 01 
1 Select node address 01 from the node address list on the left. Node 01 will be highlighted. 

 Select node address 01 as the object to be edited. 

The data link data for the selected node 
address is displayed here. 

 
The data link table for node address 01, the node to be edited, is displayed as a list in the Node Editing window on 
the right. 

 

Receive area from  
remote nodes Indicates the node refresh 

sequence. (In this example, 
for node address 01, no 
change is required.) 

Sends 30 words from the local node (node address 
01), starting with CIO 01000 (i.e., CIO 01000 to CIO 
01029). 

Receives 30 words from node 02, starting with 
CIO 01230 (i.e., CIO 01230 to CIO 01259) into 
the local node area starting with CIO 01030 
(i.e., CIO 01030 to CIO 01059). 

Receives 40 words from node 03, starting with 
CIO 00350 (i.e., CIO 00350 to CIO 00389) into 
the local node area starting with CIO 01060 
(i.e., CIO 01060 to CIO 01099). 

Local node send area 

 
Reference: With node address 01, the node refresh sequence matches the default (order of 

addresses), so no change is required. 
With node address 01, the size and offset are both automatically displayed as the 
defaults, so no changes are required. 

 The size and offset can be set. 

Automatically displayed.  
2. With node address 01, the node refresh sequence matches the default (order of addresses), so no change is 

required. 
With node address 01, the size and offset are both automatically displayed as the defaults, so no changes are 
required. 
Settings for area 2 are made using the same method.  
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Setting Node Address 02 
Node address 02 is set in the same way as node address 01. 

 

 

Local node send area 

Receive area from remote nodes 

 

Setting Node Address 03 (Setting an Offset)  
For node address 03, the procedure for setting the node refresh sequence and the offset is as follows:  

1 Select node address 03 from the node address list on the left. 
2 With node address 03, the node refresh sequence does not match the default, so the order of addresses must be 

changed. Change the node refresh sequence by either clicking F4: Move Up Area or F5: Move Down Area in 
the Function Bar, or pressing the F4 or F5 function keys. 

  

F5: Move Down Area 

 
3 Double-click on the Offset cell, and input the data size to be offset. In this example, set the offset size to 10 

words. 

 
With this setting, 20 words sent from node 01 will be received, starting from CIO 1000, and with an offset of 10 
words (i.e., CIO 1010 to CIO 1030). 
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Checking Data Link Tables 
1 Select Table | Validate Table in the Data Link Editor (Controller Link or SYSMAC LINK). The results of the 

check will be displayed as shown in the following illustration.  

 
 

Printing Data Link Tables 
Follow the procedure below to print data link tables that have been generated. 

1 Select File | Print in the Data Link Editor (Controller Link or SYSMAC LINK). 

Printing Example:  
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Saving Data Link Tables 
Follow the procedure below to save data link tables that have been generated. Data link tables are saved with a .cl3 
file name extension as the default. It is also possible to save them in .csv format. 

1 Select File | Save As in the Data Link Editor (Controller Link or SYSMAC LINK). The Save As dialog box 
will be displayed. 

2 Input the file name (“Sample” in this example), and specify the location where the file is to be saved. Then 
click the Save button. The data will be saved to a file with a .cl3 extension added to the file name (i.e., 
“Sample.cl3” in this case). 

Creating, Reading, and Writing CSV Files (Saving)  
Creating CSV Files 
Based on the CSV-format template file (Sample1.csv) provided with this software, it is possible to create files in 
CSV format for data link tables created manually using spreadsheet software (such as MS Excel).  

Including the Sample1.csv file, there are three types of files provided as reference material. The other two, in 
addition to Sample1.csv, are Sample1.xls (which describes tags and data), and Sample1.cl2 (data link table file 
format). 

(Sample1.xls window)  

 

Reading CSV Files 
Files in CSV format can be read to data link tables. 

1 Select Controller Link or SYSMAC LINK in the main CX-Net window (Data Link | Setup in the CX-Net 
PLC Network Configuration Tool dialog box). The Datalink Component dialog box will be displayed. 

2 Select Open from the File menu, and then select *.csv from the File of Type field. 
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Writing CSV Files (Saving)  
Once data link tables have been created, they can be written to CSV-format files. 

1 Select Save As from the File menu in the Datalink Component dialog box, and then select *.csv from the File 
of Type field. 

The following illustration provides an example of a written CSV file. 

 
(1)  Network ID  

parameters 

(2) Participating 
 node parameters 

(3) Area 1 
parameters 

(4) Area 2 
 parameters 

 
Note: When displayed by spreadsheet software (such as MS Excel). 

Types of Data Written to CSV Files 
 Tag name  Description Set value 

(1) <net- 
param> <network-type> 

The network type (CLK/SLK). CLK network: CLK 

SLK network: SLK 

<cycletime> 

The communications cycle time. 5 to 255. Enabled only when 
<network –type> is set to SLK, and 
ignored when <network-type> is set to 
CLK. An error will be generated if an 
out-of-range value is set when a file is 
loaded.  

<author> 
The name of the author 

SLK: (Table information) author 

Set any text string (with up to 30 
characters). Enabled only when 
<network –type> is set to SLK. 

<information> 

(Title or node 
information)  

Input file information. 

CLK: Node information 

SLK: (Table information) title 

Set any text string (with up to 30 
characters). 

<comment> 

Comment. 

SLK: (Table information) 
comment 

Set any text string (with up to 255 
characters). Enabled only when 
<network –type> is set to SLK, and 
ignored when <network-type> is set to 
CLK. 
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 Tag name Description Set value 
(2) <node-param> <node> 

(Node No.)  

The node No. 
for the link. 

1 to 62. An error will be generated if an out-of-range 
value is set when a file is loaded. 

<cpu> 

(PLC type)  

The PLC type 
for the node. 

CS1G, CS1G-H, CS1H, CS1H-H, CJ1G, CJ1G-H, 
CJ1H-H, CJ1M, CS1D-H, CS1D-S, CV500, CV1000, 
CV2000, CVM1, CVM1-V2, CQM1H, C200HE, 
C200HE-Z, C200HG, C200HG-Z, C200HX, C200HX-Z, 
NSB, CS/CJ/CP 

<cpu-type> 

(CPU model)  

The CPU model 
for the node. 

CS1G: CPU42, CPU43, CPU44, CPU45 

CS1G-H: CPU42, CPU43, CPU44, CPU45 

CS1H: CPU63, CPU64, CPU65, CPU66, CPU67 

CS1H-H: CPU63, CPU64, CPU65, CPU66, CPU67 

CS1G/CJ1G: CPU44, CPU45 

CJ1G-H: CPU42, CPU43, CPU44, CPU45 

CJ1H-H: CPU65, CPU66, CPU67 

CJ1M, CP1H: Not specified. 

CS1D-H:  Not specified. 

CS1D-S:  Not specified. 

CJ2H: CPU64, CPU65, CPU66, CPU67, CPU68, CPU64-EIP, 
CPU65-EIP, CPU66-EIP, CPU67-EIP, CPU68-EIP 

CJ2M: CPU11, CPU12, CPU13, CPU14, CPU15, 
CPU31, CPU32, CPU33, CPU34, CPU35 

CV500: Not specified. 

CV1000: Not specified. 

CV2000: Not specified. 

CVM1: CPU01, CPU11, CPU21 

CVM1-V2: Not specified. 

CQM1H: CPU51, CPU61 

C200HE: Not specified. 

C200HE-Z: Not specified. 

C200HG: Not specified. 

C200HG-Z: Not specified. 

C200HX: Not specified. 

C200HX-Z: Not specified. 

C200HX-Z: CPU65, CPU85 

NSB: Not specified. 

<status-start-type> 

(Status start address, 
memory area)  

The status start 
address and the 
memory area. 

Any of the following memory areas can be specified, 
regardless of the PLC type. 

Initial value: Default (See note.)  

CIO: Blank, CIO, or IR 

DM: D or DM 

LR: L or LR 

EM: E + Bank No. 

HR: H or HR 

AR: A or AR 

T/C: T/C 

Note: Data link status is stored in the default area. For 
details, refer to the Unit's operation manual. 

<status-start-ch> 

(Status area start 
address)  

The start 
address for the 
status area. 

The range differs depending on the status area type. 
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 Tag name Description Set value 
(3) <area1> <start-type> 

(Link Area 1 type)  

Specify the area type for Link Area 1. Same as for status area type. 

<start-ch> 

(Link Area 1 start 
address)  

The beginning word for Link Area 1. Same as for status area start 
address. 

<link-
area> 

Node No. 
Node 
address 

The node address for linking 
at Link Area 1. 

1 to 62 

Link start 
address 

Link word The beginning link word for 
Link Area 1. 

Set the link start address + link 
size for the above link node. 

Link size 
Size 
(Unit: 
words)  

The link size for Link Area 1. Set any value. 

Offset size 
Offset The offset size for Link Area 

1. 

 

Set any value. If no offset is 
required, set 0. 

(4) <area2> <start-type> 

(Link Area 2 type)  

The area type for Link Area 2. Same as for status area type. 

<start-ch> 

(Link Area 2 start 
address)  

The beginning word for Link Area 2. Same as for status area start 
address. 

<link-
area> 

Node No. Node 
address 

The node address for 
linking at Link Area 2. 

1 to 62 

Link start 
address 

Link word The beginning link word for 
Link Area 2. 

Set the link start address + link 
size for the above link node. 

Link size 
Size (Unit: 
words)  

The link size for Link Area 2. Set any value. 

Offset size 
Offset The offset size for Link Area 

2. 

 

Set any value. If no offset is 
required, set 0. 
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An example text data configuration for a CSV file is shown below. 

  
Note: Commas are used for delineation. (They are added when there are blank cells.)  
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Connecting Online 
After the PLC has been registered, select either of the following types of registered PLCs for connecting online, 
depending on the CX-Net function used. 

1) PLCs registered for direct connection 

2) PLCs registered as nodes on a network 

CX-Net function 

PLC registered for online connection 

(1) PLC registered for direct 
connection (node 
address 0)  

(2) PLC registered as node on a 
network (node address 01 or 
higher)  

Data link table 
transfer 

Controller Link Not supported. (See note.) Supported 

SYSMAC LINK Not supported. (See note.) Supported 

SYSMAC NET Supported Not supported. 

Note: If there is a routing table, node address 0 is possible. 

 
When transferring Controller Link or SYSMAC LINK data link tables, therefore, online connection is required for 
PLCs registered as nodes on a network. 

Example: Connecting PLC1 (Registered as a Node on a Network) Online 
1 In the CX-Net project workspace, select the PLC to be connected online. 
2 In the project workspace, select PLC1, and then select Open from the PLC menu. 

PLC1 will be connected online, and the display will change as follows:  

Changes to green when online. 

The online/offline status and the 
PLC’s operation mode are displayed. 

Select PLC1, and 
then select Open 
from the PLC 
menu. 

 

 
To go back offline, again select Open from the PLC menu. 
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Reading and Transferring Data Link Tables 
After a data link table has been created, follow the procedure below for reading it and transferring it to all nodes 
participating in the data links. 

Reading the Data Link Table 
1 Select Data Link | Setup from the CX-Net.  

The Data Link Setup dialog box will be displayed. (For local network only, i.e., when network address is 0.)  

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

  
2 Select Controller Link or SYSMAC LINK, and then click the OK button. 

Either the Datalink Component (Controller Link) or Datalink Component (SYSMAC LINK) window will be 
displayed. 

 
3 Select File | Open. 

The Open dialog box will be displayed. 
4 Select the data link table file (Sample.cl3 in this example,) and then click the Open button. 
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The data link tables will be read as shown below. 

 
 

Note: Before selecting Data Link Setup, make sure that the PLC can be connected online. 

Transferring the Data Link Table 
Transferring to All Nodes on the Network 

1 Select Set All Nodes for Network Operation from the Datalink Component’s Online menu. Selecting this 
operation allows the data link tables to be transferred simultaneously to multiple PLCs. 

2 Select Online | Transfer to PLC. The following dialog box will be displayed.  

 
3 Click the Yes button. 
4 An error list will be displayed. 
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5 The data link tables will be transferred. 
6 The transfer results will be displayed. 

 
 

Note: As long as all the data link tables can be transferred to all of the PLCs attempted, Set All 
Nodes for Network Operation can be selected to transfer the data link tables 
simultaneously to multiple PLCs. If there are any PLCs with the power turned OFF, or 
with disconnected cables, use the following method to transfer the data link table to one 
PLC at a time. 

 
Note: • CX-Programmer (CX-Net) Ver. 3.2 or later is required to use the 

Controller Link Support Board as a Network Support Board (NSB).  
• When using a SYSMAC Link Support Board or CX-Programmer 

(CX-Net) Ver. 3.1 or earlier, data link tables can be transferred only to 
a single Network Support Board (NSB) node. Always use the 
following method to transfer data link tables to all the nodes on the 
network. 

1. Use the mouse to select any node other than the Network Support 
Board in the Data Link Configuration window or the Node 
Editing window of the Datalink Component window. 

2. Select Set All Nodes for Network Operation from the Online 
menu in the Data Component window. 

3. Select Transfer to PLC from the Online menu. 
4. The data link tables are transferred after the check is completed. 

 

Transferring to Individual Nodes on the Network 
1 Select the transfer destination node address from the Node list in the Datalink Component. 

 

 
Make sure that Set All Nodes for Network Operation is not selected in the Online menu.  
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2 Select Online | Transfer to PLC. The following dialog box will be displayed. 

 
3 Click the Yes button. 
4 An error list will be displayed. 
5 The data link tables will be transferred. 
6 The transfer results will be displayed. 

Starting and Stopping Data Links (Including Status Displays)  
Before performing the operations described below, connect online to a node where the data link table has been 
transferred. As long as the data link table is stored there, data link starting and stopping can be executed from any 
node. 

Note: When starting data links with manual setup, the data link mode for the startup node 
must be set to manual. 

Starting Data Links 
1 Select Data Link | Setup from the CX-Net. 

The Data Link Setup dialog box will be displayed. (For local network only, i.e., when network address is 0.)  

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

  
2 Select Controller Link or SYSMAC LINK, and then click the OK button. 

Either the Datalink Component (Controller Link) or Datalink Component (SYSMAC 
LINK) window will be displayed. 
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3 Select Datalink Operation/Status from the Online menu. 
The Datalink Status dialog box will be displayed. As shown below, the status of various items is displayed. 
The communications cycle time and refresh cycle time are updated only when this window is opened or when 
the PLC operating status is changed. 

 

 

Select either the Run or 
Stop option and then 
click the Set button. 

 
4 Select the Run option in the Operation field. 
5 Click the Set button. 

The data links will start, and the Operational Status box will be displayed. 

 

Note: • The data link mode (manual/automatic) and data link operation are determined by the 
data link setup at the startup node. With manual setting the links, it is necessary to set, 
for the startup node, the data link table and the data link mode (manual setting) in the 
DM parameter area. If these are not set correctly, the data links will not start. 

• Check the following points before starting the data links. 
With manual setting, the appropriate data link table must be set for each node executing 
the data links. Data link tables must be deleted for nodes that are not participating in the 
data links. Also, even when the correct data link tables are set, make sure that there will 
be no effect on the equipment before starting or stopping the data links. 

 

Stopping Data Links 
1 Click the Stop option in the Operation field of the Datalink Status dialog box. 
2 Click the Set button. 

The data links will be stopped. 
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Automatically Set Data Links 
This section explains how to make the settings for automatically set data links. 

Make the settings in the Automatic Datalink (Controller Link) or Automatic Datalink (SYSMAC LINK) dialog 
box. 

First make the settings for data link operation at PLC startup, and for the automatic data link setup parameters, and 
then transfer the data to the startup node. 

When using automatically set data links, there is no need to create data link tables with the Data Link Editor. 

Procedure Through Data Link Startup 

Start the data links. 
Datalink Component Data Link Status 
operation 
1) Online | Status 
2) Select the Run option in the Operation 

field, and then click the Set button. 

Turn ON the power to the PLC. 

Create a CX-Server file (*.CDM) for connecting online. 
1) Select New from the Project menu and save the setting under a file name. 
2) Select Add Device from the Project menu, and register the PLC (as a node on the 

network). 

Connect online to the startup node PLC (registered as a node on the network). 
(Select the startup node PLC and then select PLC | Open from the CX-Net.) 

Set the automatic data link setup parameters. 
1) Select Data Link | Setup. 
2) Select Controller Link Unit or SYSMAC LINK Unit as the Communications Unit 

mounted to the PLC. (For the local network only, i.e. when the network address is 0.)  
3) Select PLC | Setup in the Datalink Component window.  
4) Select Automatic in the Generation Type field in the Automatic Datalink dialog box, 

and make the settings for the automatically set data link areas (start word, size, and 
nodes participating in data links, for Area 1 and Area 2). 

4) To have the data links started when 
the PLC is started, set Start for the 
status at startup. 

Transfer the automatic data link setup parameters to the startup node. (Click the 
Write button.) 
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Controller Link Automatic Setup 
1 Before executing the following operations, connect online to the PLC that is serving as the startup node. 
2 Select Data Link | Setup from the CX-Net. (For local network only, i.e., when network address is 0.)  

 

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

  
3 Select Controller Link, and then click the OK button. 

The Datalink Component (Controller Link) window will be displayed. 

  
4 Select Automatic Datalink Setup from the Online menu. 

The Automatic Datalink (Controller Link) dialog box will be displayed. 
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♦ Controller Link 

 

Select Start in 
order to have data 
links start when the
PLC is started. 

Select Automatic. 
(If Manual is 
selected, data link 
tables created by 
the user will be 
used.) 

If Automatic is 
selected, data link 
parameters can be 
set. 

When Read or 
Write is executed, 
the results are 
displayed here. 

Reads settings 
data from the PLC. 

Transfers settings 
data to the PLC. 

 
5 Select Start or Stop in the Power Up Run State field. 

Note: Selecting Start causes the data links to start when the PLC is powered up, without 
having to perform any other data link startup operation. 
When Automatic is selected, the automatic data link setup parameters can be set, as 
shown below. 

 

♦ Controller Link 

 

Set the status start 
word. 

Set the nodes 
participating in the 
data links. 

Make the settings for Area
2. Set the area for
executing the data links,
the start word, and the
size. 

Make the settings for Area 
1. Set the area for 
executing the data links, 
the start word, and the 
size. 

 
7 Set the automatic data link setup parameters. 
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SYSMAC LINK Automatic Setup 
1 Before executing the following operations, connect online to the PLC that is serving as the startup node. 
2 Select Data Link | Setup from the CX-Net. (For local network only, i.e., when network address is 0.)  

 

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

 
3 Select SYSMAC LINK, and then click the OK button. 

The Datalink Component (SYSMAC LINK) window will be displayed. 

  
4 Select Automatic Datalink Setup from the Online menu. 

The Automatic Datalink (SYSMAC LINK) dialog box will be displayed.
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Reads settings data 
from the PLC. 

Transfers settings 
data to the PLC. 

Select for manual 
setup. 

For automatic 
setup, select CIO 
only, DM only, or 
CIO and DM. 

For automatic setup, 
select from among the 
following areas and 
words. 
• CIO 04CH, DM 08CH 
• CIO 08CH, DM 16CH 
• CIO 16CH, DM 32CH 
• CIO 32CH, DM 64CH 
  

5 Select the memory area for automatic setup (CIO Area only, DM Area only, or CIO and DM Areas), and select 
the area and word settings from the following list. 

 
Word Allocations for SYSMAC LINK Automatic Setup (Example: CS/CJ Series, CVM1/CV Series)  

CIO Area (words) DM Area (words) 

Area and word settings 

CIO: 4 
words 

DM: 8 
words 

CIO: 8 words 

DM: 16 
words 

CIO: 16 
words 

DM: 32 
words 

CIO: 32 
words 

DM: 64 
words 

CIO 1000 to CIO 1003 D00000 to D00007 #1 
#1 

31 

#1 

CIO 1004 to CIO 1007 D00008 to D00015 #2 

CIO 1008 to CIO 1011 D00016 to D00023 #3 
#2 

CIO 1012 to CIO 1015 D00024 to D00031 #4 

CIO 1016 to CIO 1019 D00032 to D00039 #5 
#3 

#2 
CIO 1020 to CIO 1023 D00040 to D00047 #6 

CIO 1024 to CIO 1027 D00048 to D00055 #7 
#4 

CIO 1028 to CIO 1031 D00056 to D00063 #8 

CIO 1032 to CIO 1035 D00064 to D00071 #9 
#5 

#3 

#2 

CIO 1036 to CIO 1039 D00072 to D00079 #10 

CIO 1040 to CIO 1043 D00080 to D00087 #11 
#6 

CIO 1044 to CIO 1047 D00088 to D00095 #12 

CIO 1048 to CIO 1051 D00096 to D00103 #13 
#7 

#4 
CIO 1052 to CIO 1055 D00104 to D00111 #14 

CIO 1056 to CIO 1059 D00112 to D00119 #15 
#8 

CIO 1060 to CIO 1063 D00120 to D00127 #16 

 

Reference 
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Transferring Automatic Data Link Setup Parameters to the Startup Node 
The automatic data link parameters that have been set are then sent to the connected startup node PLC. It is also 
possible to read the automatic data link parameters that have been set for the PLC.  

Transferring Data to the Startup Node PLC 
1 Click the Write button in either the Automatic Datalink (Controller Link) or the Automatic Datalink Setup 

dialog box. 
The following dialog box will be displayed for confirmation. 

  
2 Click the Yes button. 

The set data will be transferred to the startup node PLC. 
Note: • The data link mode (manual/automatic) and data link operation are determined by the 

data link setup at the startup node. With automatic setup, it is necessary to set, for the 
startup node, the data link mode (automatic) and the number of data link words in the 
Automatic Datalink Setup dialog box. If these are not set correctly, the data links will 
not start. 

• Before starting the data links with automatic setup, make sure that the correct automatic 
data link setup parameters are set for the data link startup node. If incorrect automatic 
data link setup parameters are set, it may cause the equipment to operate unpredictably. 
Even when the correct parameters are set, make sure that there will be no adverse effect 
on the equipment before starting or stopping the data links. 

Reading Data from the Startup Node 
Perform this operation to check or change settings. 

1 Click the Read button in either the Automatic Datalink (Controller Link) or the Automatic Datalink Setup 
dialog box. 
The following dialog box will be displayed for confirmation. 

  
2 Click the Yes button. 

The set data will be transferred from the PLC and displayed at the Automatic Datalink (Controller Link) or the 
Automatic Datalink Setup dialog box. 
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Monitoring Data Link Status 
Monitoring Data Link Status, Such as Communications Cycle Time 

1 Select the startup node PLC in the Project workspace. 
2 Select Open from the PLC menu to connect online. 
3 Select Data Link | Setup. 
4 Select Controller Link or SYSMAC LINK, and then click the OK button. The Datalink Component dialog 

box will be displayed. 
5 Select Online and then Datalink Operation/Status. The Data Link Status dialog box will be displayed. 
6 The following items will be displayed in the Network Properties field:  

Data link start word, polling node number, communications cycle time, and data link refresh cycle time 
PV/maximum value. 
The following items will be displayed in the Operational Status field for each node:  
CPU Unit error status, data link operation status, CPU unit operation mode, and communications status 

Monitoring Data Link Status and Network Error Status from CX-Net 
1 While online, open the I/O table window and select either Controller Link or SYSMAC LINK. Right-click 

and select the software switch. 
2 The following items can be monitored for a particular Controller Link Unit. 

Tag name Contents 
General Displays the words allocated in the CIO and DM Areas. 

Error Information Network parameter errors, data link table errors, routing table errors, 
PLC setup errors, EEPROM write errors, node address duplication 
errors, network parameter verification errors, communications controller 
transmission errors, communications controller errors, and error log 

Data Link Startup node address, polling node address, and local node data link 
participation status 

Data link status as seen from each node (PLC operation status, PLC 
errors, communications errors, data link participation status, offset 
errors, and reception area insufficient or surplus space)  

 

Network Status Network participation status for each node 

Status Termination resistance status, power ON status 
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The following items can be monitored for a particular SYSMAC LINK Unit. 

Tag name Contents 
General Displays the words allocated in the CIO and DM Areas. 

Error Information Data link errors, node setting errors, routing table errors, 
communications controller errors, communications setting errors, data 
verification errors, duplicate No. errors, parameter errors, error logs, 
and EPROM write errors 

Network Status Local node address, local network address, polling node local address, 
unit number, power supply, internode test, and network node address 

Data Link Data link status (PLC operation status, PLC errors, communications 
errors, data link participation status, offset errors, and reception area 
insufficient space or surplus space)  

Internode Test 
(Parameters) (See 
note.)  

Test beginning and end, test destination node address, test destination 
network address, number of bytes sent, and response monitor timer 
values 

Internode Test (Results) 
(See note.)  

Test destination address, test destination network address, number of 
bytes sent, response monitor timer values, number of resend errors, 
number of non-responses, number of frame overruns, number of tests, 
number of errors, number of token timeouts, number of relay node 
routing failures, number of local node routing failures, routing error 
MRES, routing error node address, number of times local node failed to 
participate, number of times data did not match, number of times test 
destination node busy, routing error SRES, routing error network 
address, and test status 

Note: Supported for CVM1 and CV-series SYSMAC LINK Units only. 
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 CHAPTER 11 
Routing Tables 

Routing tables allow networked PLCs to be configured so that they can communicate with each other via 
gateways; across remote networks. The routing tables contain the network, unit number information required. It is 
only necessary to set up routing tables if the end connection PLC is not a direct connection, i.e. using another PLC 
as a gateway connection. The routing table is held within the PLC(s) which acts as the gateway device. Different 
types of PLC and networks have different capabilities for routing. 

PLC Network Routing Table 
C-series SYSMAC LINK N/A 
C-series SYSMAC NET C-SYSMAC NET 
C-series Controller Link FINS 
C-series Ethernet N/A 

CV-series SYSMAC LINK, SYSMAC NET, 
Ethernet or Controller Link 

FINS 

CS1-series SYSMAC LINK, Device Net, 
Controller Link or Ethernet 

FINS 

CJ1-series SYSMAC LINK, Device Net, 
Controller Link or Ethernet 

FINS 

CP-series Ethernet FINS 
 
The Routing Table menus are accessed from the PLC Network Configuration Tool dialog and contain options 
allowing the editing and setup of routing tables both offline and online. The routing tables which are being used in 
a network, can be viewed online. 

Different online Routing Table Setup dialogs are used, depending upon the protocol associated with the routing 
table. The way in which they are displayed and operate is similar in each case. 

The PLC Network Configuration Tool dialog, visually displays the structure of the routing table associated with 
the PLC (including the destination node and network gateway employed in directing data across the network). 
Initially the visual representation of the routing table is empty, or set to zero, until a routing table file has been 
opened. An overview of the routing table can also be viewed and edited in a graphical or tabular format. 

Opening an existing Routing Table 
Use the following procedure to open an existing routing table in a project. 

1, 2, 3… 1. Open the PLC Network Configuration Tool dialog from the Routing Table menu, 
select Editor, and then the type of table. 

 2. From the Routing Table File menu select Open Routing Table File. 

 3. From the list of possible files, select the file to be opened. 

The following procedure can also be used as a shortcut to opening an existing routing table. 

1, 2, 3… 1. Open the PLC Network Configuration Tool dialog and from the Project menu 
options select Open. 

 2. In the Open Project dialog select the File Type as All Files(*.*) 

 3. In the Open Project dialog select the appropriate device type and click the Open 
button. 

 4. From the list in the Project Devices window select the network to be opened. 

 5. From the Routing Table menu, select Editor and then the required network type. 

Note: Routing tables have an ‘.RT2’ (SYSMAC NET), ‘.RTG’ for FinsLocal or ‘.RT3’ 
(FINS) Network filename extension. 

Creating a new Routing Table 
Use the following procedure to create a new routing table within a project. 

1, 2, 3… 1. Open the PLC Network Configuration Tool dialog from the Project menu 
options and select New. 
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 2. In the Create Project dialog enter a file name for the new table, navigate to the 
folder where the file is to be saved and click the Save button. 

 3. From the PLC Network Configuration Tool Project menu select Add Device. 

 4. In the Add PLC dialog Enter a Device Name and select a Device Type and 
Network Type from the dropdown menu. And click OK. 

 5. From the PLC Network Configuration Tool click on the device name in the 
Project Device window. 

 6. From the Routing Table menu, select Editor and then the required network type. 

Adding a Local Network 
Use the following procedure to add a local network to a routing table. 

1, 2, 3… 1. Open the PLC Routing Table window and select the SIOU tab in the left hand 
pane and the Main View tab in the right hand pane. 

 

 
 

 2. Select the Unit from the SIOU list to which the local network is to be added then 
right click on the that unit and select the Insert CPU SIOU option. 

 3. From the Enter SIOU Details dialog enter the: 

 Local Network Number. This is the ID number that uniquely identifies the 
local network in the routing table. Each new network must be given a unique ID 
number in the range of 1 to 127. 
Local Network Type. Select the type of local network from the drop down 
menu. The network type selected will be displayed in the diagram. 

 4. Click OK to close the SIOU dialog and add the local network to the selected 
unit. 

Note: The serial port of the CPU Unit and the serial port of the Serial Communications Board/Unit 
(unit version 1.2 or later) are displayed in the Unit directory in the SIOU Tab on the left. 
Right-click and select Insert CPU SIOU to set the local network address in the serial port and 
register in the local network table.  
The serial port’s unit number as a CPU Bus Unit or Special I/O Unit are automatically allocated 
and cannot be changed. 
The Unit and the Unit’s serial port cannot be registered in the local network table at the same 
time. 
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Adding a Remote Network 
Use the following procedure to add a remote connection to a local network. 

1, 2, 3… 1. Open the PLC Routing Table dialog and select the SIOU tab in the left hand 
pane and the Main View tab in the right hand pane. 

 2. With the cursor positioned over the local network click the right mouse button. 

 

 

 3. From the pop up menu select the Add connection to Remote Network option. 
(selecting the Change Local Network option enables the local network number 
to be changed). 

 4. In the Enter Relay Node Details dialog enter the: 
 Relay node number. This is the ID number of the relay node. Relay Nodes can 

be given any ID number in the range 1 to 254. 
Remote Network number. This is the ID number that will uniquely identify the 
remote connection. Each new remote connection must be given a unique ID 
number in the range 1 to 127. 
Note that a remote network can not be given the same ID number as an existing 
Local Network. 

 5. Click OK. This will add the remote connection with the specified ID number 
(shown in red) to the Local Network. A maximum of 20 remote connections can 
be added to a network. 

 6. Finally from the Options menu check the table for Errors  
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Editing the Routing Table 
Open the appropriate routing table from the Network Configuration Tool dialog then use the following procedure 
to edit the table. 

1, 2, 3… 1. Local Network:  
 ♦ In the Routing Table dialog right click on the Unit to be edited and select the 

appropriate option from the pop up menu. 
♦ To save the changes select the Save option from the File menu 

 2. Relay Node: 
 ♦ Right click on the Relay node and select the appropriate option from the pop up 

menu. 
 3. Remote Network: 
 ♦ Right click on the remote network and select the appropriate option from the pop up 

menu. 

Error Checking 
Use the following procedure to view any validation errors. 

1, 2, 3… 1. Either: 
 ♦ Select Check routing table for errors from the Edit menu in the Routing Table 

Editor dialog box. 
 Or 
 ♦ Click the  in the toolbar. A message box will be displayed indicating success or 

failure. 
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Additional Features 

The Network View Screen 
The Network tree view is used to display the nodes on the locally connected network and is only available when 
the local connection network is an OMRON proprietary network, such as a Controller Link, Sysmac link, Sysmac 
Net or SYSWAY. 

 

 
 

 This icon is used to indicate that a node is present at this node number. 
 This icon is used to indicate that node is not present at this node number. 
 This icon is used to represent the currently selected node. 
 This icon is used to indicate that a node is present at this node number but there are 

errors reading the routing table. 

The Overview Screen 
Selecting the Overview tab will show all the routing tables in an graphical format. The relay node numbers are 
shown in the whites boxes and the remote network numbers in the red boxes. The numbers on the right are the 
Local Network numbers. 

Note that the tables can not be edited in this view. 
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Table View Screen 
The Table View screen provides a method of setting the routing table by means of a tabular view. 

 

 
The screen is comprised of two main sections: 

♦ The local settings (Left hand side) 
♦ The remote settings (right hand side) 
The local settings section allows a series of entries for the SIOU (Special Input/Output Unit) and it’s 
corresponding Local Network number. 

The remote settings section allows a series of entries for the Remote Network number, it’s corresponding Relay 
Network number and it’s corresponding Relay Node number. 

The slider control to the right of each section can be used to bring any more than the eight entries into view if so 
required. 

Each of the data entry fields have their own individual set of spin buttons, which when pressed will increment or 
decrement the value. The number can also be entered normally using the number keypad on the user keyboard. 

Three control buttons can be found at the bottom of the screen: 

♦ Ok button: Once all data entry has been completed, selecting the ‘Ok’ button will check the table entries for 
errors. If the check fails, an error description dialog will be displayed. If the check does not detect any errors 
the Main Screen will be displayed. 

♦ Restore button: If during data entry, the user wished to revert back to the table state that was in effect before 
the Table View was displayed; The user should select the Restore button. 

♦ Cancel button: This button will cancel any changes made whilst the Table View was being displayed and then 
display the Main View screen.  

Note:  For CS/CJ-series PLC of Ver. 2.0 or CP-series PLC or later with CX-Programmer Ver. 
4.0 or later, FINS commands can be used to access nodes up to eight network levels 
away, including the local network.  

Gateway Counter Settings 
Gateway Counter Framework 

When sending FINS commands or returning FINS responses in a FINS network, the GCT (Gateway 
counter: Permissible number of times a network bridge can be crossed) is set in the FINS header of the 
FINS command frame. When the FINS response is received, the GCT is automatically reduced by the 
number of network levels that were accessed. Therefore, the GCT setting corresponds to the number 
of network levels that can be accessed, as follows:  
• GCT = 02 hex: Access to up to three network levels away. 
• GCT = 07 hex: Access to up to eight network levels away (the network configuration, however, 

must use PLCs for which the Gateway counter (GCT) is set to 07 hex). 
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Gateway Counter Setting 
When using CX-Programmer Ver.5.0 or later, the GCT (Gateway counter) value contained in the 
FINS header can be set under Set Gateway Counter in the Routing Table Dialog Box. 
Note: CX-Programmer Ver.4.0 or earlier do not provide the GCT (Gateway counter) setting option. 

Setting the Gateway Counter Value for Each PLC 
The GCT value setting range depends on the CPU Unit being used, as follows:  

• CS/CJ-series CPU Unit Ver. 3.0 (Excluding CS1D CPU Units for Duplex-CPU Systems) or 
CP-series CPU Unit 
The GCT (Gateway counter) value can be set to 02 hex or 07 hex. 
Set the GCT value under Set Gateway Counter during routing table setup using the following 
procedure.  

1. Setting the Gateway Counter Offline: 

Open the PLC Routing Table window, select the Unit Tab in the directory list, and then right-click 
the icon for the local PLC node. 
 

 
Setting the Gateway Count Online: 

Open the PLC Routing Table window, select the Network Tab in the directory list, and then 
right-click the icon for a PLC node in the network.  

 

 
The following Gateway Counter Setting Dialog Box will be displayed. 

2. Select either Standard or Expand(7), and then click the OK Button. 
 

 

Standard: Communications across up to three network levels (GCT = 02 hex) 

Expand(7): Communications across up to eight network levels (GCT = 07 hex) 
The GCT value will be displayed in the Main View, Overview, and Table View Screens. 

Main View Overview Table View 
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• CS/CJ-series CPU Units with Unit Ver. 2.0 or CP-series CPU Units 
The GCT (Gateway counter) is always 07 hex. The number of network levels that can be accessed is 
always a maximum of eight network levels and cannot be set to a maximum of three network levels.  
When CX-Programmer (CX-Net) Ver.5.0 or later is used, the Standard and Expand(7) options in the 
Gateway Counter Setting Dialog Box in the Routing Table Setup are both ignored. When routing 
tables are transferred to a CS/CJ-series CPU Unit with unit Ver. 2.0 or CP-series CPU Unit, the GCT 
(Gateway counter) is always 07 hex, and therefore uses the Expand mode. 

• Pre-Ver. 2.0 CS/CJ-series CPU Units and CVM1/CV-series CPU Units  
The GCT (Gateway counter) is always 02 hex. Therefore, access to a maximum of three network 
levels away is possible.  
When CX-Programmer (CX-Net) Ver.5.0 or later is used, always select the Standard option in the 
Gateway Counter Setting Dialog Box during the routing table setup. If Expand(7) is selected, the 
routing tables cannot be transferred. 

 

Transferring a Routing Table to a PLC 
Once a routing table has been created or edited, the routing table may be transferred to the PLC using the 
following steps: 

1, 2, 3… 1. If the Network Configuration Tool is ‘on-line’ to a PLC, skip to 4. 
 2. Save the current routing table using the Routing Table Edit menu: File – Save 

Routing Table. (Add Author and comment if required). 
 3. Go ‘on-line’ to the PLC. See section 10 – The Network Configuration Tool for 

details of this operation. 
 4. From the CX-Net menu select: Routing Table - Setup 
 5. From the Routing Table menu select: File – Open Routing Table. 
 6. Select the previously created filename and select open. Or, alternatively the 

routing table can be created. 
 7. From the Routing Table Editor menu select: Options – Transfer to PLC. 

Transferring a Routing table from a PLC 
The routing table held within a PLC may be transferred from the PLC using the following steps: 

1, 2, 3… 1. Go ‘on-line’ to the PLC. See section 10 – The Network Configuration Tool for 
details of this operation. 

 2. From the CX-Net menu select: Routing Table - Setup 
 3. From the Routing Table Editor menu select: Options – Transfer from PLC. 
 4. The routing table may then be saved to file by: From the Routing Table menu 

select: File – Save Routing Table. 
 5. Enter a suitable filename and select Save.  
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 CHAPTER 12 
PLC Backup Tool 

Overview 
The PLC Backup Tool can be used to back up, compare, and restore data, such as programs and unit parameters, of 
all the Units or of only specified Units in a PLC that is connected online.  

 

CS/CJ-series PLC 

PLC Backup Tool 

CPU Unit + Configuration Units  
(CPU Bus Units and Special I/O Units) 

Back up 

Restore or Compare 

Backup folder 
Default name: 
C\Backup\yymmdd_hhmmss 

 

Applications 
The PLC Backup Tool can be used for the following applications.  

♦ Backing up all of the data that has been transferred to the PLC 
♦ Comparing all of the data in the PLC with the data backed up in the computer 
♦ Transferring onsite all of the data to a PLC that has the same system configuration as another PLC 
♦ Transferring data to a Unit that has been replaced, e.g., when the Unit has failed 

Applicable Units 
CS/CJ/CP1H/CP1L/CP1L-E/CP2E/CP2E-N -series PLCs, all models and all versions 

Data in the following Units is not backed up: SYSMAC SPU Unit data, Customizable Counter Unit data, and 
screen data for an NSJ Controller 

Units That Can Be Backed Up 
Refer to the list of Units provided in help for the PLC Backup Tool.  

Applicable Data  
CPU Unit:  User program, symbols table, rung comments, program indexes, parameters (PLC Setup, 

registered I/O tables, routing tables, Ethernet settings, and all of the data in the initial setting 
areas), I/O memory, force-set/reset bit status (backup and comparison only), and EM file memory 
data (backup only)  

Special I/O Units and 
CPU Bus Units:  

Parameter settings and data stored inside the Unit (e.g., programming created with special 
software)  

Restrictions 
The following restrictions apply.  

♦ Force-set/reset Status 
Force-set/reset status cannot be restored. 
If you attempt to restore force-set/reset status, the address of the force-set/reset bit will be displayed in the log 
display area. Use the CX-Programmer or Switch Box to manually force-set/reset the displayed address. 
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♦ Data Stored in EM File Memory (Part of the EM Area Converted to File Memory) 
EM file memory cannot be compared or resorted. 
EM file memory backups are saved in the CPU\EM_FILES Folder that will be created within the backup file 
destination folder. Restore EM file memory manually by using the PLC Memory Card Window in the 
CX-Programmer to write the data to memory. 

♦ Restrictions in Comparing and Restoring I/O Memory 
The CIO Area and Auxiliary Area data in the I/O memory cannot be compared or restored even if all of the 
I/O memory is backed up. 

Compatibility of Backup Files 
The following table shows the compatibility of the backup files created with the CX-Programmer version 9.81 and 
with the lower version.  

Backup file With the PLC Backup Tool  
used on the CX-Programmer 

Ver.9.81 or higher 

With the PLC Backup Tool  
used on the CX-Programmer 

Ver.9.80 or lower 
Backup file created with the 
CX-Programmer Ver.9.80 or lower 

Compatible. 

However, the tamper detection 
check is not performed. 

Not compatible. 

Back up file created with the 
CX-Programmer Ver.9.81 or 
higher (When the EIP21S Unit is 
not set in the system configuration) 

Compatible. Compatible. 

However, the restore and 
comparison operations are 
available only for the models that 
are supported by the 
CX-Programmer in use. 

Back up file created with the 
CX-Programmer Ver.9.81 or 
higher (When the EIP21S Unit is 
set in the system configuration) 

Compatible. Compatible. 
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PLC Backup Tool Operations 

Starting the PLC Backup Tool  
1, 2, 3… 3. Select PLC Backup Tool from the CX-Programmer Tools Menu. Alternatively, select 

Programs – OMRON – CX-One – CX Programmer – PLC Backup Tool from the 
Windows Start Menu. 
The PLC Backup Tool Dialog Box will be displayed. 

 
 

♦ Backup Menu 

Button Function  
Backup from PLC Click this button to back up data.  

The data in the connected PLC will be backed up as a batch.  
Compare Click this button to compare data.  

The data in a backup file can be compared to the data in the connected PLC or to the data in another 
backup file.  

Restore to PLC Click this button to restore data.  
The data in a backup file can be transferred to the connected PLC to restore the data that was backed 
up. 

 
♦ Communication Settings 

Button Function  
Change Settings Click this button to change the communications settings for the target PLC.  

Current Settings: The PLC model and network type are displayed here.  
The FINS network address and node address of the connected PLC are displayed below the network 
type in the following format. (Net n, Node m) 
  n: FINS network address, m: FINS node address 
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Communications Settings for the Target PLC  
♦ If the PLC Backup Tool is started from the CX-Programmer Tools Menu, the communications of the 

CX-Programmer will be inherited.  
♦ If the PLC Backup Tool is started from the Windows Start Menu, click the Communication Settings Button 

and specify the PLC to connect to.  
Direct Connection to PLC 
A direction connection can be made for either a serial or network connection. 

Connected PLC 

PLC Backup Tool 

 

Connected PLC 

PLC Backup Tool 

Network 

 

Connection to PLC via Gateway PLC 

 

Connected PLC 

PLC Backup Tool 

Gateway PLC 

Network  
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Setting Flow 
 Select the connection path to the PLC. 

Select the target PLC. 

Select the gateway PLC. 
Connecting directly to PLC 

Connecting to the PLC via a different PLC 

 

Setting Procedure 
1, 2, 3… 1. Click the Communication Settings Button in the PLC Backup Tool Dialog Box. 

The following Communication Settings Dialog Box will be displayed. 
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 2. Select either the PLC Direct Connection or Connection via Gateway Option and click the 
Change Settings Button. 
The following Change PLC Dialog Box will be displayed. 

PLC Direct Connection 

 
1. Set the PLC Model and Network Type of the target PLC. 

Note: you can select any network type. 
2. Click the OK Button.  

The PLC Backup Tool Dialog Box will return and the communications settings 
will be applied. 
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 Connection via Gateway 

 
1. Set the PLC Model and Network Type of the gateway PLC and click the OK 

Button. 
2. The Change PLC Dialog Box for the target PLC will be displayed. 

 

Select Gateway. 

 
3. Select Gateway as the network type. 
4. Set the PLC Model of the target PLC, and click the OK Button. 

The PLC Backup Tool Dialog Box will return and the new communications 
settings will be applied. 
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Backing Up PLC Data to the Computer 
The data in the connected PLC can be backed up to the computer as a batch.  

 

Target PLC 

PLC Backup Tool 

CPU Unit + Configuration Units 
(CPU Bus Units and Special I/O Units) 

Backup 

Backup folder 
Default name: 
C\Backup\yymmdd_hhmmss 

 
Note: When the Backup from PLC Button is clicked, the Tool will connect to the PLC that is 

specified in the current communications settings. Check that the target PLC and 
network type are correct before performing the backup procedure. 

Note: User authentication is required when connecting, if the Network Type is Secure Comm. 
 

Overview of Procedure 

Start 

 Select PLC Backup Tool 
from the Tools Menu of the 
CX-Programmer. 

 Select Programs – OMRON – 
CX-One – CX Programmer – 
PLC Backup Tool from the 
Windows Start Menu. 

  ↓  ↓ 
 

 
Click the Communication 
Settings Button in the PLC 
Backup Tool Dialog Box. 

 ↓ 
 Select the PLC Direct 

Connection or Connection via 
Gateway Option and click the 
Change Settings Button. 

 

 

↓ 
  Set the target PLC in the 

Change PLC Dialog Box. 
  ↓ 

Communi- 
cations 
settings 

 

The communications settings 
are inherited from the 

CX-Programmer. 

 (The PLC Backup Tool Dialog 
Box will return.)  

  ↓  ↓ 
 Click the Backup from PLC Button. 
 ↓ 
 Check the target PLC in the Confirm Connection Dialog Box and 

click the OK Button. 
 ↓ 
 (The PLC Backup Tool will connect online to the PLC and the 

Backup from PLC (1/2) Dialog Box will be displayed.) 
 ↓ 
 Select the check boxes for the Units to be backed up and then click 

the Next Button. 
 ↓ 
 Specify the backup file in which to save the data. 
 ↓ 
 Click the Start Button. 
 ↓ 

Backup 

 Backup operation executed. 
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Procedure 
1, 2, 3… 1. Click the Backup from PLC Button in the PLC Backup Tool Dialog Box.  

The following Confirm Connection Dialog Box will be displayed. 

 
 2. Check that the target PLC is correct and click the OK Button. 

The following Backup from PLC (1/2) Dialog Box will be displayed after an online 
connection is made to the PLC. 

 
The registered I/O tables will be read from the connected PLC and all Units in the PLC 
will be displayed in the list. 
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 Dialog Box Description 

 

All Units in the PLC are displayed here along with the model 
number, unit version, rack number, slot number, unit number, and 
comment. The color will indicate whether the Unit can be backed up. 
 

 
 

(White) 
Units that can be backed up.  

 
 

(Yellow) 

Units for which there are backup restrictions. If one 
of these Units is selected, the restrictions will be 
displayed in the Information Area. 

 
 

(Gray) 

Units with data that cannot be backed up, such as 
Basic I/O Units or Units that are not supported by 
the Backup Tool. 

Backup information and 
restrictions for the Units selected 
in the table, such as details on the 
restrictions and supplementary 
information, are displayed. 

Click these buttons to 
select or clear the 
selection of all Units. 

The model of the connected PLC. 

 

WARNING • Some Special I/O Units and CPU Bus Units operate with parameters that are stored in the 
CPU Unit. If one of these Units is selected for backup, restrictions will be displayed in 
the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and 
always select the Special I/O Unit or CPU Bus Unit together with the CPU Unit when 
backing up or restoring data. If the data from both Units is not backed up or restored 
together, unexpected operation may occur in the controlled system. 
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 3. Select the Units that you want to back up by selecting the boxes in the number column, and 
then click the Next Button. 
The Backup from PLC (2/2) Dialog Box will be displayed so you can enter attributes for 
the backup file. 
 

Enter comments for the backup procedure. 

Destination Folder: 
Shows the destination folder where the backup file will be saved. As a default, a folder 
with the current date and time as the folder name (YYMMDD_HHMMSS) will be 
automatically created. 
Example: If the file was created on January 31st 2008, at 11:28:17, the folder name will 
be 080131_112817.  

User Name: 
Input the name of the user. 

Backup Date/Time: 
The current date and time from the computer are 
displayed here.  

Click this button to 
change the backup 
folder.  

 
 4. Specify where to save the backup file.  

The default is C:\Backup.  
Click the button next to the backup folder field to change the backup folder or edit the 
folder name directly. 

 5. Enter the user name and comments. 
 6. Click the Start Button.  

An Uploading Dialog Box will be displayed to indicate that the backup operation is being 
executed. 
 

Shows the progress of 
the backup operation. 

Displays the backup status. 

 
Note: If the read protection has been set for the connected PLC, the protection must be 

cleared before the data can be backed up.  
Refer to Clearing UM and Task Read Protection, below, for details. 
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 7. When the backup operation has been completed, the following Backup Completed Dialog 
Box will be displayed. 

 
 8. Click the OK Button to complete the backup process. 

The backup files will have been created in a folder named with the current time (yymmdd 
– hhmmss) in the specified folder as shown below. 

 
Note 1: The PLC Backup Tool will automatically create a subfolder in the folder 

that was automatically created in the specified destination folder and save 
all of the PLC configuration information and data in the subfolder.  

Note 2: Do not change the folder structure or move files in the backup folder. If any 
changes are made, it will become impossible to read the data for the 
comparison and restore operations.  

Note 3: If you copy the backup data to another computer, copy the entire folder 
named with the current time in the destination folder, as shown below. 
Example  
When the Destination Folder Is C:\Backup\080131_112817   Copy the 
entire folder called 080131_112817.  

Note 4: Be careful of the compatibility of the backup data. Check the version of the 
CX-programmer when performing the comparison and restore operations. 
Refer to Compatibility of Backup Files in Chapter 12 - PLC Backup Tool - 
Overview for details. 
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Comparing Data 
Data in backup files can be compared with data from other backup files or data from connected PLC, and the 
results shown.  

Target PLC 

PLC Backup Tool 

CPU Unit + Configuration Units 

(CPU Bus Units and Special I/O Units) 
Verify 

Backup folder 
Default name: 
C\Backup\yymmdd_hhmmss 

 
Backup files can be restored after the comparison results have been displayed. Also, the comparison results can be 
saved in a CSV file. 

Overview of Procedure 

Start 

 Select PLC Backup Tool from 
the Tools Menu of the 
CX-Programmer. 

 Select Programs – OMRON – 
CX-One – CX Programmer – 
PLC Backup Tool from the 
Windows Start Menu. 

  ↓  ↓ 
 

 
Click the Communication 
Settings Button in the PLC 
Backup Tool Dialog Box.  

 ↓ 
 Select the PLC Direct Connection 

or Connection via Gateway 
Option and click the Change 
Settings Button. 

 

 

↓ 
  Set the target PLC in the Change 

PLC Dialog Box.  
  ↓ 

Communi- 
cations 
settings 

 

The communications settings 
are inherited from the 

CX-Programmer.  

 (The PLC Backup Tool Dialog 
Box will return.)  

  ↓  ↓ 
 Click the Compare Button. 
 ↓ 
 Select the source backup file and the destination backup file or PLC.  
 ↓ 
 • Not Selecting the Units to 

Compare 
• Selecting the Units to Compare 

 Click the Compare Button. 
 ↓ 
 Check the target PLC in the Confirm Connection Dialog Box and click 

the OK Button. 
 ↓ 
 

 
Select the Units to compare in the Selects 

Comparison Target Dialog Box 
 ↓ 
  Click the Compare Button. 
 ↓ 

Verify 

 (Data compared.)  
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Procedure 
1, 2, 3… 1. Click the Compare Button in the PLC Backup Tool Dialog Box.  

The Compare Dialog Box will be displayed. 

Specify the source backup file on 
the computer.  

Specify the target PLC or backup file to 
compare. 
PLC: The currently connected 

PLC will be displayed as 
the target.  

File: Specify another backup 
file on the computer as 
the target.  

Select this check box to 
select the Units to compare.
If this check box is not 
selected, data will be 
compared for all Units.  

 
 2. Select the comparison source backup file and the target PLC or backup file and click the 

Compare Button. 
 Be careful of the compatibility of the backup data. Check the version of the 

CX-programmer when performing the comparison operation. Refer to Compatibility of 
Backup Files in Chapter 12 - PLC Backup Tool - Overview for details. 

 3. A Confirm Connection Dialog Box will be displayed if the backup file is being compared to 
a PLC. Check that the target PLC is correct and click the OK Button. 

 4. To compare data from specific Units, select the Selects the comparison target Checkbox 
and click the Compare Button. 
The following Selects Comparison Target Dialog Box will be displayed. 
 

@: Select the check 
boxes of Units to 
compare. 

Configuration: Indicates whether 
the configurations 
match between 
the backup file and 
the PLC.  

The configuration in the 
backup file on the 
computer is displayed 
here: rack No., slot No., 
model No., unit version, 
and unit No. 

The following is displayed for 
the Unit in the connected PLC: 
unit version and unit No. 

Source backup file and PLC model on 
the computer.  

Destination PLC or backup file, and PLC 
model.  

Select the Units to compare and then click the Compare Button. 
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 To not compare specific Units, do not select the check box for the Unit and click the 
Compare Button. 

Note: User authentication is required when connecting, if the Network Type is Secure 
Comm. 

 5. A Comparing Dialog Box will be displayed to indicate that the comparison operation is 
being executed and the comparison status will be displayed in the Log Display Area. 

 
Note: If the read protection has been set for the connected PLC, the protection must be 

cleared before the data can be compared.   
Refer to Clearing UM and Task Read Protection, below, for details. 

 When the comparison has completed, the following dialog box will be displayed. 
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 6. Click the OK Button. The following Comparison Results Dialog Box will be displayed. 
 

Configuration: Indicates whether the 
configurations match 
between the backup 
file and the PLC.  

Setting: Indicates whether the 
settings match 
between the backup 
file and the PLC.  

The configuration in the 
backup file on the computer 
is displayed here: rack No., 
slot No., model No., unit 
version, and unit No. 

The following is displayed for the 
Unit in the connected PLC (or 
other backup file: unit version 
and unit No. 

Source backup 
file and PLC 
model on the 
computer.  

Destination PLC 
or backup file, 
and PLC model. 

 
 7. The following operations can be carried out with the comparison results. 

♦ Display details of the comparison results. 
♦ Save comparison results in a file. 
♦ Transfer backup file data to PLC. 
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Detailed Display of the Comparison Results 
1, 2, 3… 1. Double-click the Unit in the comparison results list.  

The Details of Unmatched Item Dialog Box will be displayed. 
 

The data saved in the 
Unit is displayed. 

Whether the data matches 
is displayed. 

 
Example 1: CJ2H-CPU67H CPU Unit 

 
Example 2: CJ1W-CLK21 CPU Bus Unit 
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Saving Comparison Results Files 
1, 2, 3… 1. Clicking the Save as Button will save the comparison results to a CSV file.  

The CSV file will contain the following comparison results in the order given below.  
 

Comparison Results File Data Format 

Rack No., Slot No., Comparison Source Unit Model, Comparison Source Unit Version, Comparison Source Unit No., 
Comparison Source Lot No., Comparison Target Unit Model, Comparison Target Unit Version, Comparison Target Unit No., 
Comparison Target Lot No., Configuration Comparison Results, Setting Comparison Results, Data Name, 
Comparison Results 

 

Restoring Data 
PLC data can be restored to a previous state by transferring backup file data to a connected PLC. 

 

Target PLC 

PLC Backup Tool 

CPU Unit + Configuration Units 

(CPU Bus Units and Special I/O Units) 
Restore 

Backup folder 
Default name: 
C\Backup\yymmdd_hhmmss 

 
 

Note: User authentication is required when connecting, if the Network Type is Secure 
Comm. 

Note: If the Network Type is Secure Comm, Administrator or Designer operation 
authorities is required to use this function. 
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Overview of Procedure 

Start 

 Select PLC Backup Tool 
from the Tools Menu of the 
CX-Programmer. 

 Select Programs – OMRON – 
CX-One – CX Programmer – 
PLC Backup Tool from the 
Windows Start Menu. 

  ↓  ↓ 
 

 
Click the Communication 
Settings Button in the PLC 
Backup Tool Dialog Box. 

 ↓ 
 Select the PLC Direct 

Connection or Connection via 
Gateway Option and click the 
Change Settings Button. 

 

 

↓ 
  Set the target PLC in the 

Change PLC Dialog Box. 
  ↓ 

Communi- 
cations 
settings 

 

The communications settings 
are inherited from the 

CX-Programmer. 

 (The PLC Backup Tool Dialog 
Box will return.)  

  ↓  ↓ 
 Click the Restore to PLC Button. 
 ↓ 
 Check the target PLC in the Confirm Connection Dialog Box and 

click the OK Button. 
 ↓ 
 Select the backup file to restore to the PLC in the Restore to PLC 

Dialog Box. 
 ↓ 
 The data will automatically be compared to the data in the PLC and 

the results will be displayed. 
 ↓ 
 To check the restore data before restoring it to the PLC, click the 

Start a tool Button and check the data. 
 ↓ 
 Select the check boxes of the Units to which to restore data and 

then click the Start Button. 
 ↓ 
 • Not Selecting the Unit Data • Selecting the Unit Data 
 Select the data to restore. 
 ↓ 
 

Click the Start Button. 
Click the Start Button. 

 ↓ 

Restore 

 The data is restored. 
 

Procedure 
1, 2, 3… 1. Set the communications settings of the target PLC in the PLC Backup Tool Dialog Box. 

Note: When the Restore to PLC Button is clicked, the Tool will connect to the PLC that is 
specified in the current communications settings. Check that the target PLC and 
network type are correct before performing the restore procedure. 

 2. Click the Restore to PLC Button in the PLC Backup Tool Dialog Box. 
The following dialog box will be displayed to confirm the target PLC. 

 



PART 2: CX-Server PLC Tools  
CHAPTER 12 – PLC Backup Tool OMRON 
 
 

CX-Server PLC Tools_Page 162 

 3. Check whether the correct PLC is set as the target and click the OK Button. 
The following Restore to PLC Dialog Box will be displayed. 
When the restoration target backup file is selected, data will be automatically compared 
with the connecting PLC and the results will be displayed. 
 

The source backup folder in 
the PLC is displayed here.  

@: Check boxes will 
appear for Units to 
which data can be 
restored.  

Configuration: Indicates whether the 
configurations match 
between the backup 
file and the PLC.  

The configuration in the 
backup file on the computer 
is displayed here: rack No., 
slot No., model No., unit 
version, and unit No. 

The following is displayed for 
the Unit in the connected 
PLC: unit version and unit No. 

Click this button to 
change the source 
backup folder.  

Click these buttons 
to select or clear the 
selection of all Units. 

Click this button to check 
the restore data with a 
special tool. 

 
Click the Start a Tool Button to check the restore data before executing the restore 
operation. Refer to Checking Restore Data, below, for details. 
Be careful of the compatibility of the backup data. Check the version of the 
CX-programmer when performing the restore operation. Refer to Compatibility of Backup 
Files in Chapter 12 - PLC Backup Tool - Overview for details. 

WARNING • Sufficiently check the data that is selected for restoring before performing the next step. 
If the correct data is not restored, unexpected operation may occur in the controlled 
system after the data is restored. 

• Some Special I/O Units and CPU Bus Units operate with parameters that are stored in the 
CPU Unit. If one of these Units is selected for backup, restrictions will be displayed in 
the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and 
always select the Special I/O Unit or CPU Bus Unit together with the CPU Unit when 
backing up or restoring data. If the data from both Units is not backed up or restored 
together, unexpected operation may occur in the controlled system. 

• If there are any backup restrictions for the Units to which data is being restored, the 
restrictions will be displayed in the Comments Area of the Backup from PLC Dialog 
Box. Confirm the restrictions, and always take the required measures. If required 
measures are not taken, unexpected operation may occur in the controlled system after 
the data is restored. 
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 4. Select the check boxes in the number column to set the target Units, and then click the Start 
Button. The following Confirm Restore to PLC Dialog Box will be displayed. 
 

Select this check box to select the 
data for the Unit. 

 
 5. Execute the following steps to select the data for each Unit. 

1. Select the Select the unit data Check Box. 
2. Click the OK Button. The Select Data to be Restored Dialog Box will be displayed.  

The displayed data will depend on the unit type. 

 
3. Select the check boxes for the data to be restored. 
4. Click the Start Button. 

 To restore all of the data, do not select the Select the unit data Check Box and click the OK 
Button.   

 6. If the CPU Unit is not in PROGRAM mode, the following dialog box will be displayed to 
confirm that it is OK to change the operating mode. If it is OK to change the operating 
mode, click the Yes Button. 
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WARNING • Confirm that stopping PLC operation will not create any problems before restoring data 
during PLC operation. If the PLC stops at an unanticipated time, unexpected operation 
may occur in the controlled system. 

 7. A Downloading Dialog Box will be displayed and the restore status will be displayed in the 
Log Display Area. 

 
Note: If the read protection has been set for the connected PLC, the protection must be 

cleared before the data can be restored.  
Refer to Clearing UM and Task Read Protection, below, for details. 

 8. When restoration has been completed, the following Restoration Completed Dialog Box 
will be displayed. 

 

WARNING • Always turn the power supply to the PLC OFF and then ON after restoring data. If the 
power supply is not turned OFF and then ON, memory in the PLC may not be updated to 
the restored data, which may cause unexpected operation of the controlled system. 

• Forced status can be backed up, but it cannot be restored. If you restored data that 
contained forced status, use the CX-Programmer after restoring the data to force-set or 
force-reset bits as required. If required bits are not force-set or force-reset, differences in 
the forced status in memory may cause unexpected operation of the controlled system. 
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Checking Restore Data 
When the configuration information in the backup file is displayed in the Restore to PLC Dialog Box, you can 
start the Support Software for specific Units to check the data before restoring it to the Unit. This function is 
supported for the following Units.  

♦ Applicable Units and Support Software 

Unit Data Support Software Comments 
CPU Unit  Program Parameters CX-Programmer The routing tables are 

not displayed.  
Controller Link Unit, SYSMAC 
LINK Unit, Ethernet Unit, or 
EtherNet/IP Unit 

Unit parameters View Parameters Dialog Box (Select 
displaying Special I/O Units and CPU 
Bus Units.) (See note.)  

The routing tables are 
not displayed.  

Serial Communications 
Unit/Board 

• Unit parameters 

• Protocol macros 

View Parameters Dialog Box (See 
note.)  
(Select displaying Special I/O Units and 
CPU Bus Units.) CX-Protocol 

--- 

FL-net Unit Unit parameters CX-FLnet --- 
Other Special I/O Units Unit parameters View Parameters Dialog Box (See 

note.) 
(Select displaying Special I/O Units and 
CPU Bus Units.) 

 

Note: Parameters can only be checked. They cannot be edited or transferred.  

Procedure 
1, 2, 3… 1. If you select the target Unit and click the Start a tool Button, the following Confirm Tool 

Startup Dialog Box will be displayed. 

 
 2. Click the OK Button. The View Parameters Dialog Box or Start a Tool Dialog Box will be 

displayed, depending on the target Unit that was selected. If the Start a Tool Dialog Box 
was displayed, a list of Support Software will be displayed. Select the Support Software to 
start and click the OK Button. 
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Clearing UM and Task Read Protection 
If read protection is set for the UM area or any tasks in the CPU Unit, the protection must be cleared before you 
can back up, compare, or restore data for the Unit. Before you can begin any of these procedures, a dialog box will 
be displayed to allow you to clear protection. 

 
To clear the protection, enter the UM read protection or task read protection password for the current CPU unit, 
and then click the OK Button. The operation will continue when the protection has been cleared. 

For some PLC models and unit versions, if the password is incorrect five times in a row, a password cannot be 
entered for two hours. Refer to the relevant PLC manual for details. 

Note: The read protection password will not be stored as part of the backup process. For better 
security, store the password separately. 
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 APPENDIX A 
Toolbars and Keyboard Shortcuts 

The following tables summarise the toolbars and keyboard shortcuts available from each component and tool. The 
F1 function key is common across all components and tools and provides context help. 

Toolbars 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open 

Open File 

Save in Project 

Print 

Print Preview 

Cut 

Copy 

Past 

 

 

 

 

Fill Data Area 

Clear Data Area 

Transfer to PLC 

Transfer from PLC 

Compare with PLC 

Monitor 

 

 

 

 

Binary 

Binary Coded Decimal 

Decimal 

Signed Decimal 

Floating Point 

Hexadecimal 

Text 

Double Floating Point 

Double Word 

Quad Word 

Resize Column 

Zoom Out 

Restore Zoom 

Zoom In  

 

 

Set Value 

Force On 

Force Off 

Clear Force Status 

Keyboard Shortcuts 
    
Ctrl+O………. Open Alt+B……… Binary 
Ctrl+S………. Save in Project Alt+C……… Binary Coded Decimal 
Ctrl+P………. Print Alt+D……… Decimal 
Ctrl+X………. Cut Alt+S……… Signed Decimal 
Ctrl+C………. Copy Alt+O……… Double Word 
Ctrl+V………. Paste Alt+Q……… Quad Word 
Ctrl+PgUp….. Zoom In Alt+P……… Floating Point 
Ctrl+PgDn….. Zoom Out Alt+H……… Hexadecimal 
  Alt+T……… Text 
  Alt+L……… Real 
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Data Trace/Time Chart Monitor Component 

Toolbars      Keyboard Shortcuts 

 

Open 

Save 

Configure Trace/Time Chart 

Zoom Out 

Restore Zoom 

Zoom In 

Scale Out 

Restore Scale 

Scale In 

Stop Trace/Time Chart 

Trigger the Trace/Time Chart 

Execute Trace/Time Chart 

Read Trace/Time Chart 

About 

Help 

 

 
Ctrl+O ............  Open 
Ctrl+PgUp ......  Zoom In 
Ctrl+PgDn ......  Zoom Out 
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Memory Card Component 

Toolbars      Keyboard Shortcuts 

 

Cut 

Copy 

Paste 

Delete 

Rename 

Properties 

Large Icons 

Small Icons 

List 

Details 

 
Ctrl+X .............  Cut 
Ctrl+C .............  Copy 
Ctrl+V .............  Paste 
Ctrl+A .............  Select All 
F5 ...................  Refresh device 

CX-Net Network Configuration Tool 

Toolbars      Keyboard Shortcuts 

 

Open Project 

Edit Project 

Open/Close Project Device PLC 

Display PLC Information 

Set PLC Operating Mode 

Display PLC Error Status 

Show Unit Status 

Configure PLC System Settings 

Configure IO Table 

Configure C-Series Comms. Units 

Online Edit Routing Table 

Online Edit Data Link 

Echo Back Test 

Broadcast Test 

Ping Test 

About 

 
Ctrl+N .............  New 
Ctrl+O ............  Open 
Ctrl+S .............  Save 
Return ............  Edit Item 
Insert ..............  Insert Item 
Delete ............  Delete Item 
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Import/Export Tool 

Toolbars      Keyboard shortcuts 

 

New 

Open 

Edit Project 

Import CVSS 

Import LSS 

Import Text 

Import Tagged Database 

Export Text 

Export to FinsServer TagDB 

Clear Screen 

Print Screen 

About 

 
Ctrl+N .............  New 
Ctrl+O ............  Open 
Ctrl+E .............  Edit Project 
Ctrl+C .............  Import CVSS 
Ctrl+L .............  Import LSS 
Ctrl+T .............  Import Text 
Ctrl+V .............  Import from FinsGateway 
Alt+T ..............  Export Text 
Alt+V ..............  Export to FinsGateway TagDB 
Ctrl+R .............  Clear screen 
Ctrl+P .............  Print screen 
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Data Link Editor 

Toolbars      Keyboard Shortcuts 

 

New 

Show All Network Nodes 

Open 

Save 

Toggle Network/Single Node operation 

Transfer to PLC 

Transfer from PLC 

Delete 

Verify Node 

Status 

Automatic Datalink Setup 

Validate Table 

Wizard 

Add source link 

Add Destination 

Set properties 

Delete link destination service area 

Zoom in 

Zoom out 

Zoom original 

Print 

About Datalink Component 

 
Ctrl+N .............  New 
Ctrl+O ............  Open 
Ctrl+S .............  Save 
Ctrl+P .............  Print 
Ctrl+<space....  Change Window 
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Routing Table Editor 

Toolbars       Keyboard Shortcuts 

 

New 

Open 

Save 

Print 

Print Preview 

Always on top 

Transfer to PLC 

Transfer from PLC 

Check routing table 

Activate C-Series Control Link 
routing Table 

 
Ctrl+P ............  Print 
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 GLOSSARY OF TERMS 
Actual IO Table The real hardware configuration of the PLC units and slots on power-up. 
Address A location in memory where data or programs are stored. It can also identify a location 

of a node on a network. 
Application A software program that accomplishes a specific task. Examples of applications are 

CX-Server, CX-Programmer, CX-Protocol and Microsoft Excel.  
ASCII American Standard Code for Information Interchange. 
Auxiliary Area An area of PLC memory which normally contains transmission Counters, flags and 

control bits. It also retains the status of the device during power failure. 
Baud rate The speed of data transmission in terms of the number of bits per second that are being 

sent. 
BCD Binary Coded Decimal. 
Binary Coded Decimal A data format supported by CX-Server. 
Binary A data format supported by CX-Server. A number system format to the base 2, i.e. 

employing the digits 0 and 1. 
Bit A digit used in binary notation which can take the value 0 or 1. The value of a bit, or 

combination of bits, can represent the status of a device or can be used in programming. 
Boolean A type of point or symbol where the value can be one of two states. Essentially the two 

states are ‘0’ and ‘1’, but these states can be assigned a meaningful designation.  
Bridge A device connecting local area networks of similar architectures together. 
Broadcast address An address held in common by all nodes on a network to which the same data is 

transmitted simultaneously. 
Bus A communications path along which data can be transmitted or received between the 

units connected to it. 
Central Processing Unit The part of the PLC which can store programs and data, execute the instructions in 

program, and process input and output signals in order to communicate with other, 
external, devices. 

Clipboard An area within the windows environment where data can be stored temporarily or 
transferred between applications. 

Command modifier An optional part of an address string indicating the modification to be performed on the 
data at that address (within PLC memory) when it is accessed. 

Common link parameter The common words used by all PLCs in a Data Link (within a SYSMAC LINK 
system). 

Compact Flash A type of memory card fitted to a PLC. 
Components CX-Server is made up of six components accessible from an invoking application. 
Control bit A bit assigned a controlling role in the functioning of a device; its status is set via a 

program to achieve this function. 
Controller Link A network that can send and receive large data packets flexibly and easily among the 

OMRON PLCs. 
Counter area An area of PLC memory containing program counters and their related completion 

flags. 
Counter An area of memory reserved for the purposes of counting the number of times an event 

has occurred. 
CPU bus link area An area of PLC memory allocated to the CPU bus unit. 
CPU type The type of CPU available to a specific device, the amount of memory available to a 

PLC varies according to the CPU involved. 
CPU Central Processing Unit. 
CS-series Indicates either a CS1G-H, CS1H-H, CS1D-S, or CS1D-H. 
CJ-series Indicates either a CJ1G-H, CJ1H-H, or CJ1M.  
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C-Series Indicates any one of the following types of PLC: C2000H, C200H, C200HE, 
C200HE-Z, C200HG, C200HE-Z, C200HS, C200HX, C200HX-Z, C1000H, C**H, 
C**K, C**P, CQM1, C500, C120, C20, CPM1 (CPM1A/CPM2*). 

CV-Series Indicates any one of the following types of PLC: CVM1, CVM1-V2, CV500, CV1000 
or CV2000. When using SYSMAC NET, CV series PLCs can operate in either CV 
mode (where the datagrams contain FINS commands) or C mode (where the datagrams 
contain C SYSNET commands). 

CVSS A file format supported by the CX-Server Import tool. CVSS has several file types 
which have different information contained in them. 

CX-Net Network Configuration tool 
This CX-Server tool consists of a suite of programs allowing the management of 
Routing Tables and Data Link Tables in OMRON PLCs. 

CX-Server An advanced communications management system for OMRON PLCs providing 
facilities for software to maintain PLC device and address information and to 
communicate with OMRON PLCs and their supported network types. 

CX-Server Project A definition of an OMRON PLC network configuration. It identifies all devices and 
networks within a particular configuration including the areas of PLC memory (points) 
that can be read from or written to. 

Cycle time The time interval between read/write cycles at a network node. 
Data area An area of PLC memory allocated to the storage of data (not programs). 
Data bits Bits representing each character to be transmitted. 
Data link A software connection establishing common data areas between PLCs on a network 

allowing data to be between these devices. 
Data Link Editor The data Link Editor allows a PLC to be configured so that it can participate in one, or 

more automatic data sharing schemes, over Sysmac Link and Controller Link networks, 
without the need for special programming. 

Data link table A table of the common data memory areas used by the PLCs in a Data Link. 
Data location An area of memory identified by an address. 
Data memory An area of PLC memory holding only word data. 
Data Trace/Time Chart Monitor component 

This CX-Server component displays data obtained from the PLC’s memory areas 
during program execution. 

Datagram A packet of information which can be transmitted across a network containing routing 
information plus data. 

DDE Dynamic Data Exchange. A channel through which correctly prepared programs can 
actively exchange data and control other applications within Microsoft Windows. 
CX-Server, through the use of the DDE Manager tool, allows extensive use of DDE 
functionality. 

 See also Item, Server, server application and Topic. 
DDE management library A dynamic link library within Windows which allows dynamic data exchange to be 

employed. 
DDE Manager tool A CX-Server tool for transferring data between PLCs and a client application using 

DDE, for example Microsoft Excel. 
DDEML Dynamic Data Exchange Management Library. 
Debug mode A mode of PLC operation during which any errors arising from the currently active 

program will be flagged. For CV-series PLC only. 
Decimal A data format supported by CX-Server. 
Default A value automatically set by a program in the absence of user input or on initial entry to 

an application; such values can be overwritten. 
Destination network address The address of the network to which data is directed. 
Destination node number The number identifying the destination node. 
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Destination node The node (and therefore device) where transmitted data is to be placed. 
Device group A class of devices which share similar properties, each group can be sub-divided into 

device types. 
Device type A type of OMRON PLC. 
Device A type of OMRON automation device, either a PLC, Temperature Controller, Memory 

Card Writer or PROM Writer. 
Dialog A window asking for some form of response from the user, usually in the form of either 

entering requested information, selecting displayed data, or confirming an operation. 
DLL Dynamic Link Library. A program file that although cannot be run stand-alone as an 

executable, can be utilised by one or more applications or programs as a common 
service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone 
functions.  

Double Floating Point Double Floating Point (LREAL) type is as the IEEE754 Double precision (1.7E 
+308/-307) as defined by Microsoft®. 

Download Refer to Transfer to PLC. 
Drag The act of moving an item on the screen by selecting it with the mouse, and keeping the 

mouse button depressed, moving the mouse until the item has reached the required 
location. The mouse button is then released. 

Driver The software which controls the communications between a computer and PLC, 
translating any information passed between them into a format that the receiving 
Device can understand. 

Dynamic Data Exchange The method of transferring data (and possibly instructions) between applications via 
the establishment of reference links between them. 

Echo test The reflection of a signal along a communications channel in order to check the 
accuracy of data transmission by comparing the received data against the original data 
at the sending end. 

EEPROM Electrically Erasable Programmable Read Only Memory. 
Elements The number of address units which start at a specified data location. 
End Connection The final communication link between computer and PLC, or in the case of a Network 

configuration, gateway PLC to PLC. 
End network address The address of the destination network to which communications are directed. 
Error status An indication of an error condition found in a system. 
Ethernet A 10 MB baseband local area network with each Device attached to the network having 

equal status and therefore the ability to transmit as, and when, required (provided the 
line isn’t busy). 

Even parity The number of 1s in a data transmission is even. 
Event frame A structure, predetermined by a protocol, containing specific fields for the transmission 

of data. 
Exclusive mode PLC mode which allows an application exclusive access to the Device. 
Expansion memory The memory available to a CPU in addition to conventional memory. 
File memory An area of CPU memory allocated to the storage of data. 
File Transfer Protocol Protocol for transferring files between host computers. 
FINS Factory Intelligent Network Service. 
FinsGateway An OMRON communication type supported by CX-Server. 
Flag An indicator representing the condition of a process, data area or Device. 
Floating Point A data format supported by CX-Server. 
Folder A structure which organises the files in computer memory or on disk. Also known as a 

‘directory’. 
Frame length The waiting time before data is transmitted across the network 
FTP File Protocol Transfer. 



PART 2: CX-Server PLC Tools  
GLOSSARY OF TERMS – CX-Server PLC Tools OMRON 
 
 

CX-Server PLC Tools_Page 176 

Gateway device A Device connecting two networks of different architectures together. 
Gateway network address The address of a network acting as a gateway. 
Gateway PLC A PLC which acts as a link to another network.  
Group A sub-directory within a CX-Server project hierarchy which contains points and/or 

further (subsidiary) groups. 
GUI Graphical User Interface. Part of a program that interacts with the user and takes full 

advantage of the graphics displays of computers. A GUI employs pull-down menus and 
dialog boxes for ease of use. Like all Microsoft Windows based applications, 
CX-Server has a GUI for each component and tool. 

Hard disk A disk permanently mounted on its drive. 
Hexadecimal A data format supported by CX-Server. 
Hierarchy The structure of a CX-Server project from the root directory down through any 

sub-directories (groups) to individual points contained within those groups. 
High Link A network driver. 
Host computer A computer responsible for data management and for overall control of the system. 

Programs and data are downloaded to a PLC from the host computer. 
Host link system A system comprising one or more host computers connected to one or more PLCs by 

host link units; these units facilitate the transfer of data between the PLC(s) and the host 
computer. 

Host link unit The interface between a PLC and a host computer. 
Icon Pictorial representations of computer resources and functions. Many icons are used by 

CX-Server components and tools as part of the GUI. 
IDSC device type An OMRON PLC device supported by CX-Server. 
Import tool This CX-Server tool is used for addresses and PLCs defined using the CVSS and LSS 

products. 
Input bit data area An area of PLC memory containing the status of an input Device. 
Input bit The location within memory indicating the status of an input. 
Input device A Device which sends signals to a PLC. 
Input The signal sent to a PLC from an external device. 
Instruction A statement indicating an operation to be performed and identifies any data involved in 

this operation. 
Intel Hex A PLC device also known as a PROM Writer. 
Interface Hardware or software employed to link the elements within a system, including 

networks, programs and computers. 
Internal data type The format of the data held at an address in PLC memory; for example, bit or signed 

character binary.  
Internode test An echo test performed to check the condition of a PLC on a network node. 
Invoking application An application such as CX-Programmer and CX-Protocol that utilises components and 

tools belonging to CX-Server. 
IO bit A bit which can hold data entered into, or received from, the system. 
IO Table component This CX-Server component retrieves configured PLCs rack and address data. 
IO type Input /Output type. An attribute of a point or symbol that defines the origin and 

destination of the data for that point or symbol. The data can originate (be input from) 
and is destined (is output to) to the internal computer memory, PLC or DDE target 
application. 

IO Input /Output. 
IP address table A table containing the IP addresses for all the devices on the Ethernet. 
IP address An address for a device on the Ethernet. 
IP router table A table containing the addresses for each interface on a network.  
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IP Internet Protocol. 
Item A unique name for a data item within a topic. 
LAN Local Area Network. 
Link Relay Area A common data area allowing the transfer of data between PLCs connected by a Data 

Link; the information held in this area in the memory of each PLC is identical. 
Link system A system that links PLCs together. 
Link unit A unit which connects a device to the network. 
Link A connection between two units established either by software or a hardware device. 
Load Placing a program or data into an area of computer or PLC memory. 
Local area network A network located within a limited area (normally the user’s premises). 
Local network address The address of the network to which a PLC is connected. 
Local network number The number of the unit connecting the PLC to the network. 
Local table A table containing the details of the networks to which a PLC belongs. 
LREAL LREAL (Double Floating Point) type is as the IEEE754 Double precision (1.7E 

+308/-307) as defined by Microsoft®. 
LSS A file format supported by the CX-Server Import tool. 
Mailbox A communications protocol. 
Mark parity The parity bit is always set to 1. 
Master A controlling device which sends data and/or instructions to a slave device. 
Mb Megabytes – A means of defining computer memory size. 
Memory area Addressable area of storage space in a device. 
Memory Card component This CX-Server component manages the file storage to and from PLC memory cards. 
Memory Card Writer A device which writes data to a memory card. 
Memory card A data storage medium which can hold both programs and data. 
MHz Megahertz. 
Micro host link A link to a ‘micro’ device acting as a host. 
Microsoft Excel A spreadsheet application. 
Microsoft Windows Explorer A file handling application part of the Microsoft Windows suite. 
Microsoft Windows A windowing environment that is noted for its GUI, and for features such as multiple 

typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and the 
capability of moving text and graphics from one application to another via a clipboard. 

 CX-Server runs only under Microsoft Windows. DDE functions communicating with 
other applications supported by CX-Server use Microsoft Windows as a basis. 

Modem A device with the ability to convert digital data from a computer into analogue form 
and transmit it over a telecommunications line and also to convert received analogue 
signals into digital form. 

Monitor mode A PLC operational mode which allows the device, during normal execution, to review 
the condition of the Data Link (including the PLCs/nodes on that link). 

n A variable number. 
Native data format The format in which data is handled by a communications protocol; for example, 

ASCII or binary. 
Network bridge A unit that connects two or more networks together. 
Network parameters Network settings including information such as the maximum number of nodes 

permitted on a network and the waiting times between transmissions. 
Network Service Board An interface which connects devices (not PLCs) to the network. 
Network 1. Part of the PLC configuration, based on the device type. The number of Networks 

available is dependant on the device type. 
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 2. A number of computers linked together with a central processing point known as a 
Server which is accessible to all computers. Networks affect CX-Server in that 
further Network associated options are available if the computer is Network 
connected. 

Node number Number identifying the device located at a particular node on the network. The number 
can be between 1 and 126, the maximum number of nodes available on an OMRON 
network. 

Node A position at which a device can be located on the network, consisting of a link unit 
mounted to a device or PLC which in turn interfaces with a peripheral device or a 
computer.  

NSB Network Service Board. 
Odd parity The number of 1s in a data transmission is odd. 
Offline The status of a device when it is not being controlled by a computer (although it may be 

physically connected to it). 
OLE Object Linking and Embedding. Used to transfer and share information between 

Microsoft Windows based applications and accessories.  
Online The status of a device when it is under the direct control of a computer. 
Output Bit data area An area of PLC memory reserved for output bits. 
Output bit The location within memory indicating the status of an output device. 
Output device A device which receives signals from a PLC. 
Output The signal sent from a PLC to an external device. 
Packet A unit of information transmitted across the network containing source and destination 

address information together with the actual data. 
Parity bit A bit transmitted with a packet of data indicating the type of parity check to be 

performed. 
Parity A type of validation check performed on transmitted information; data can be tested for 

either even, odd, none, mark or space parity. The type of parity check involved is 
indicated by the status of the parity bit. 

Path The location of a file including the drive, directory name plus any subdirectories and 
the file name together with its associated extension. 

Peripheral A device which aids system operation rather than being central to its functioning. 
Performance Monitor tool A CX-Server tool for monitoring communications throughput and for displaying 

CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming 
overloaded). 

Ping test A standard Ethernet communications test. 
PLC Programmable Logic Controller. 
PLC Clock tool The PLC Clock Tool provides a facility to monitor and set the PLC clock and 

synchronise the PLC clock to the PC clock. 
PLC Error component This CX-Server component displays and manages PLC errors. 
PLC Memory component This CX-Server component allows the user to view, edit and monitor either channels 

(words) or individual bits in areas of the PLC. 
PLC Setup component This CX-Server component permits the configuration of PLC settings. 
Point A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The 

contents of a point may be controlled by an object or I/O mechanism such as DDE. The 
contents of a point may control the action or appearance of an object, or be used for 
output via an I/O mechanism. 

Polling Interrogating a device to check its operational status or whether it is ready to send or 
receive data. 

Port A device connection point allowing data entry and exit. 
Program A set of instructions which are performed by a computer or PLC. 
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Program memory An area of PLC memory reserved for the storage of programs. 
Program mode PLC mode of operation during which the device can be programmed. 
Programmable Read Only Memory 

An area of memory which can be updated with programs and data only once after 
manufacture; once this area has been written to, it can only be read, not modified. 

Project OMRON configuration file inherited from the invoking application. 
 Refer also to CX-Server Project. 
PROM writer A device which writes the programs and data into PROM. 
PROM Programmable Read Only Memory. 
Protocol A set of rules governing the transmission of data. 
PSTN Public Switched Telephone Network. 
Public Switched Telephone Network 

A communications network carrying voice and data communications over switched 
lines. 

Rack The apparatus to which a unit is fixed. 
RAM Random Access Memory. 
Read mode PLC mode which allows data from the PLC to be read but not modified. 
Read/write mode PLC mode which allows data to be read from and written to the device. 
Refresh parameter table A table identifying the words in a Data Link to be refreshed for an individual PLC. 
Registered IO Table The internal PLC table: this is the one used by the PLC when running, regardless of the 

state of the actual hardware. It can be read and, for CV-series PLCs, written to by the 
CX-Server software.  

Relay network address The end network address which a PLC communicates. 
Relay node number The number of the network node through which a transmission must pass to reach 

another network. 
Relay table A table containing the relay network addresses, node numbers and end network 

addresses used within a FINS system. 
Remote network A network beyond the LAN to which access must be gained through a gateway or 

bridge. 
Remote Terminals Further units that can be supported by CX-Server via the Sysmac-Bus Master unit 
Reset Turning a bit or signal OFF or changing it to its set value or to zero. 
Root The highest level of a directory. 
Root group The highest level group in a CX-Server project. 
Rotary switch Indicates the method of calling a device by generating a series of pulses. 
Routing table A table containing the information necessary to allow communications between 

different networks including local and gateway network address details. 
Routing The direction of data across a network from its source to its destination. 
RS232 Industrial interface standard for serial communications. 
RS422 Industrial interface standard for serial communications employing balanced line 

circuits. 
RTs Remote Terminals. 
Run Mode PLC mode of operation during which device information is typically read-only. 
Serial Connection A direct connection between computer and PLC. 
Server application An application that can be used to view or interact with. 
 Refer also to DDE and OLE. 
Server 1. Server is used in DDE functions to contain a link to an outside application. Using 

DDE functions, CX-Server allows the manipulation of an outside application as 
specified as the Server. 

  Refer also to Server application.  
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 2. A Server is the central processing point of a Network which is accessible to all 
computers. Networks affect CX-Server in that further associated options are 
available if the computer Network is connected. 

Signed Decimal A data format supported by CX-Server. 
SIOU Special Input /Output Unit. 
Slave A device which receives data or instructions from a master device. 
Slots Free areas within a rack to which units can be fixed. 
Software switches Areas of memory employed by an SIO unit used to set operating parameters (similar in 

manner to a hardware switch). 
Space parity The parity bit is always set to 0. 
Special Input /Output Unit A unit designed for a specific purpose. 
SRM1 device type An OMRON PLC device supported by CX-Server. 
Step Area An area of PLC memory containing a flag indicating the status of steps used within a 

program. 
Stop bits Bits indicating the end of transmission of each set of data bits; normally one or two bits, 

they indicate the delay time between sending successive characters down the line. 
Symbol An address that has been given a name to make the address information more flexible. 

Symbols are inherited by CX-Server by the invoking application. 
SYSMAC LINK OMRON high speed industrial network (either co-axial or fibre optic). 
SYSMAC NET OMRON high speed optical LAN which can be of type C SYSMAC NET or CV 

SYSMAC NET. 
SYSMAC WAY OMRON network. 
System area An area of memory used for controlling and managing a unit. 
System configuration An arrangement of units, for example network, computers and PLCs. 
Tagged database A file format supported by the CX-Server Import tool. The Tagged database is also an 

export format of the CX-Server Import tool. 
TAPI Telephony Application Programming Interface. 
Target PLC The PLC to which information or instructions are directed. 
Taskbar An integral part of Microsoft Windows which allows Microsoft Windows based 

applications to be started. CX-Server tools are run from the Taskbar. 
TCP/IP Transmission Control Protocol/Internet Protocol. 
Temperature Controller An OMRON device. 
Temporary Relay Area An area of PLC memory containing instructions which can be loaded at a later point for 

use with other instructions. 
Text 1. A file format supported by the CX-Server Import tool. The Text is also an export 

format of the CX-Server Import tool.  
 2. A data format supported by CX-Server. 
Timer area An area of PLC memory containing program timers and their related completion flags. 
Toolbus A network, either C-Toolbus or CV-Toolbus, allowing communications with a device 

via the serial COM port of a personal computer (in a similar manner to SYSMAC 
WAY). Data is transmitted along the network in binary format. 

Tools CX-Server is made up of four tools. 
Topic The name of an aspect of a service application which identifies where a reference link is 

to be incorporated; for example, within Excel the topic would be the name of the 
worksheet to be used. 

Transceiver A device which can receive and transmit data. 
Transfer from PLC The transfer of a program or data to a host (either a computer or a programming device) 

from a lower-level (or slave) device. 
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Transfer to PLC The transfer of a program or data from a host (either a computer or a programming 
device) to a lower-level (or slave) device. 

Transition Area Contains flags indicating when a transition is ON or OFF 
Transmitter A device which sends out signals. 
UDP User Datagram Protocol. 
Unit number A number identifying an individual component of an OMRON PLC system 

configuration. 
Units A component of an OMRON PLC system configuration. 
Unknown The operating mode of a PLC that cannot be connected to. 
Upload See Transfer from PLC. 
User Datagram Protocol Protocol which directs information across a network to port numbers rather than to IP 

addresses. 
Word A 16 bit unit of data memory. 
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Notice 
OMRON products are manufactured for use according to proper procedures by a qualified operator and only for 
the purposes described in this manual. 

The following conventions are used to indicate and classify precautions in this manual. Always heed the 
information provided in them. Failure to heed precautions can result in injury to people or damage to the 
product. 

DANGER  Indicates an imminently hazardous situation which, if not avoided, will result in death 
or serious injury. Additionally, there may be severe property damage. 

WARNING  Indicates a potentially hazardous situation which, if not avoided, could result in death 
or serious injury. Additionally, there may be severe property damage. 

Caution Indicates a potentially hazardous situation which, if not avoided, may result in minor 
or moderate injury, or property damage. 

 

OMRON Product References 
All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it refers to an 
OMRON product, regardless of whether or not it appears in the proper name of the product. 

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything 
else. 
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Visual Aids 
The following headings appear in the left column of the manual to help you locate different types of 
information. 

Indicates information of particular interest for efficient and convenient operation of the product. 

1, 2, 3… Indicates lists of one sort or another, such as procedures, checklists etc. 

 Represents a shortcut on the Toolbar to one of the options available on the menu of the same 
window. 

Other manual conventions are as follows: 

• Windows-based applications provide users with a number of different ways to perform one operation. These are 
normally: from the application menu bar; using icons on a Toolbar; using keyboard shortcuts; using the right-mouse 
button to display a context-sensitive menu; dragging and dropping. Whilst recognising this, the manual provides user 
instructions employing the Toolbar and right-mouse button only. Use of the application menu bar or keyboard 
shortcuts are only included if no such alternatives exist. 

• Access to the CX-Server middleware is normally via other software applications, such as CX-Programmer or 
CX-Protocol. This is noted in the manual by the term “invoking application”. 

• This manual refers to two distinct types of project: CX-Server projects and application projects. A CX-Server project 
is defined in this manual. An application project is defined by the software application invoking CX-Server. 

 OMRON, 2005 
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in 
any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior 
written permission of OMRON. 

All copyright and trademarks acknowledged. 

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because 
OMRON is constantly striving to improve its high-quality products, the information contained in this manual is 
subject to change without notice. Every precaution has been taken in the preparation of this manual. 
Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for 
damages resulting from the use of the information contained in this publication. 
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About this Manual 
This manual describes the CX-Server application and its ability to control and monitor a range of OMRON 
PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the 
commercial manual for the device must be consulted. 

This manual contains the following chapters: 

• Chapter 1 - Technical Specification. This chapter describes CX-Server in general terms and introduces the user to 
the relationship between CX-Server and associated products. It also provides details of the operating environment, 
minimum configuration and installation procedures necessary for the satisfactory operation of CX-Server. 

• Chapter 2 - Introduction to CX-Server. This chapter describes the concepts on which CX-Server is based including 
the definition of PLCs, points and groups. 

• Chapter 3 - Communications. This chapter describes the communications supported by CX-Server 

• Chapter 4 - Import/Export Tool. This chapter describes the Import/Export Tool and its ability to add data from 
CVSS and LSS files to a CX-Server project. 

• Chapter 5 - DDE Manager Tool. This chapter describes the DDE Manager and its ability to read and update point 
data via CX-Server. 

• Chapter 6 - Performance Monitor Tool. This chapter describes the Performance Monitor Tool and the procedures 
involved when monitoring communications. 

• Chapter 7 – Driver Management Tool. This chapter describes the Driver Management Tool and how to manage 
your device drivers within CX-Server. 

• Appendix - A Network Availability. The tables in this appendix indicate the network available to each PLC device 
group. FinsGateway has no network availability and is not described. 

• Appendix B - PLC Memory Area. The tables in this appendix provide memory area details for each device group. 

• Appendix C - Toolbars and Keyboard Shortcuts. The tables in this appendix summarise the toolbars and keyboard 
shortcuts available from each component tool. 

A Glossary of Terms and Index are also provided 
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CHAPTER 1 
Technical Specification 

This chapter describes the CX-Server software in general terms and introduces the user to the relationship 
between CX-Server and associated products. It also provides details of the operating environment, minimum 
configuration and installation procedures necessary for the satisfactory operation of CX-Server. 

CX-Server Software 
CX-Server is a communications management system in Microsoft Windows for OMRON PLCs. It provides 
facilities to maintain PLC device and address information and to communicate with OMRON PLCs and their 
supported network types. 

CX-Server consists of the following components: 

As well as acting as a server for other OMRON software, CX-Server includes other customer tools: 
♦ CX-Server DDE Manager tool. A tool for allowing transference of data between PLCs and a client using 

DDE, for example Microsoft Excel. 
♦ CX-Server Import tool. This tool is used for addresses and PLCs defined using the CVSS and LSS 

products. It allows definitions of addresses and PLCs to be used by importing them into a CX-Server 
project file. 

♦ CX-Server Performance Monitor tool. A tool for monitoring communications throughput and for 
displaying CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming overloaded). 

♦ CX-Server Driver Manager tool. A tool for installing and un-installing new software drivers for support 
of hardware devices. 

CX-Server comprises various executables, Dynamic Link Libraries (DLLs) and components. In order to use 
certain communication types (i.e. Ethernet, SYSMAC LINK, SYSMAC NET), some settings must be 
configured prior to use – separate to the software installation. Refer to Chapter 3- Communications for further 
details. 

About this Manual 
This User Manual acts as a reference for CX-Server by describing its various concepts and abilities. It also 
provides the basics of using its dialogs and supplied utilities. 

Caution This manual is referred to from other software that utilises CX-Server, for instance, 
CX-Programmer, CX-Protocol, CX-Supervisor or CX-Server OPC and CX-Server 
Lite. Subsequently, some topics contained in this user manual may not be relevant. 

CX-Server comes with a context-sensitive online help system which is designed to complement this manual and 
to provide a quick reference at any point while using CX-Server when the manual is not to hand. This general 
help system uses a fast hypertext system, which allows progressively detailed information about any topic to be 
obtained by selecting keywords within the descriptive text. 

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows and know 
how to: 
♦ use the keyboard and mouse; 
♦ select options from Microsoft Windows menus; 
♦ operate dialog boxes; 
♦ locate, open and save data files; 
♦ edit, cut and paste text; 
♦ use the Microsoft Windows desktop environment. 
If the installed version of Microsoft Windows has not been used before, it is recommended that the reader 
spends some time working with it using the Microsoft documentation before using CX-Server. 
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Features 
CX-Server is the corner stone of the suite of applications collectively known as the CX-Automation Suite. The 
CX-Automation Suite is not one system but software that has been designed to dynamically evolve with every 
direction a manufacturer would like to take and to accommodate any implementation, improvement, adaptation 
or extension of any form of control or data acquisition in a manufacturing industry. 

The software suite has been developed to serve you with powerful yet comprehensible software that builds and 
runs networks that simply control one machine or an entire manufacturing process. It comprises the following: 

♦ CX-Programmer 
♦ CX-Server Lite 
♦ CX-Server OPC 
♦ CX-Protocol 
♦ CX-Motion 
♦ CX-Supervisor 

The CX-Automation suite is in itself highly adaptive. It completes the integration of process control and 
business information systems, by applying one and the same basic network architecture. For the user it means 
that data from both sources of information can be jointly reported in familiar applications such as spreadsheets, 
in which they can be recalculated in existing layouts or processed along usual spreadsheet procedures. 

The architecture is based on standards that are widely maintained such as ActiveX and OPC (OLE for Process 
Control) and standard interfaces such as COM, DCOM and ODBC/ADO This conformity also means that you 
can use standard interfaces and standard software. 

System Requirements 
Refer System Requirements on page 3 in PART 1 CX-Programmer. 

Use of a mouse is highly recommended, although all operations can be performed using the keyboard. Refer to 
Appendix C for a list of keyboard shortcut commands. 

The amount of RAM and hard disk space used depends upon the size of the PLC programs written – 
approximately 1K per step. 

Communications Requirements 
In order to use serial communication types SYSMAC WAY and Toolbus the following is required: 

♦ RS232 connection via a standard serial port on the PC (COM1 etc.) or RS422 connection to a 422 serial 
board. 

♦ In order to use SYSMAC LINK directly from the PC a SYSMAC LINK Network Service Board and 
FinsGateway Version 3 or higher is required. 

♦ In order to use Controller Link directly from the PC a Controller Link Network Service Board (wired or 
optical) and FinsGateway Version 3 or higher are required. 

♦ In order to use Ethernet an Ethernet card, Windows Sockets software and TCP/IP must be installed and 
configured. 

♦ In order to use an ISA board FinsGateway Version 3 or higher is required. 
♦ Controller link PC NSB is supported using FinsGateway Version 3 or higher. 
♦ SYSMAC LINK PC NSB is supported using FinsGateway Version 3 or higher. 
In order to use FINSGateway with the CLK/SLK PCI board in the Windows 2000 operating system the 
appropriate drivers must be installed. These drivers can be found on the CX-Server CD under:  CX-
Server\WDM\CLK (PCI)\  or  CX-Server\WDM\SLK (PIC)\ 

Refer to Chapter 3- Communications for more information and the appropriate hardware system manuals for 
full information about connecting and configuring these devices for the environment. 

Note: The following network types cannot be run on Windows Vista or later OS. 
- Controller Link for OMRON NSB. Controller Link  
- SYSMAC LINK for OMRON NSB. SYSMAC LINK  
- SYSMAC NET for OMRON NSB. SYSMAC NET  
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- CS1 Board for OMRON CS1 PCI board  
- Fins Gateway  

Installation 
This describes the procedures involved in the installation of CX-Server on a standard workstation running 
Microsoft Windows Vista or later OS. 

If CX-Server is being installed as part of the CX-One installation then on completion of the CX-One installation 
a number of dialogs will prompt for information concerning the installation of CX-Server and its components. 

Note: Internet Explorer 5.0 or higher is required for the correct operation of CX-Server. 

Starting CX-Server 
CX-Server components are normally accessed from the invoking application. However, a number of tools can 
be accessed as stand-alone tools from the windows Start menu (on the Microsoft Windows taskbar). 

 
Performance Monitor tool. 

 
DDE Manager tool. 

 
CX-Server Import / Export tool. 

Help and How to Access it 
 CX-Server comes with a detailed context-sensitive help system. At any time while using the software, it is 
possible to get help on the particular point that is currently being worked on, or on general aspects of CX-Server. 
This system is intended to complement the manual, by providing online reference to specific functions of the 
software and how to use them. The manual is designed to provide more tutorial information and discuss the 
various facilities offered by CX-Server. 

♦ Context-sensitive help;  
♦ Help Index (available on the Help menu); 
♦ Help Contents (available on the Help menu); 
♦ About (available on the Help menu); 
♦ Status Bar tool button tips. 

Help Topics 
Select the Help Contents option on the Help menu. The Help system provides a standard look-up dialog under 
the Contents tab showing the contents of the CX-Server Help file. Click on an item to read the associated 
information. 

Index 
Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Enter a text query into the first step field. The second step field is refreshed according to 

the query entered in the first step field. 
 3. Select an entry in the second step field and select the Display pushbutton, or double-click 

on the index entry. 
 4. If an entry is linked to two or more topics, the names of the topics are displayed in the 

Topics Found dialog. Select a topic and choose the Display pushbutton or double-click 
on the topic. 
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Find 
Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Select the Find tab. 
 3. Enter a text query into the first step field. The second step field is refreshed according to 

the query entered in the first step field. Previous text queries can be retrieved by selecting 
from the drop-down list in the first step field. 

 4. Select a word that matches the query – some words may be automatically selected. More 
than one word can be selected by pressing Shift and selecting another word to extend the 
selection, or by pressing Ctrl and selecting another word to add to the selection. The third 
step field is refreshed according to the word or words selected. The number of topics 
found are shown at the bottom of the dialog. 

 5. Select a topic from the third step field and select the Display pushbutton, or double-click 
on the topic from the third step field. Select the Clear pushbutton to restart the find 
operation. 

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. 

Context-sensitive Help 
CX-Server supports the use of context-sensitive help. The relevant online help topic is provided automatically 
by selecting the current area of the display responsible for carrying out those actions. Select the F1 function key 
to retrieve context-sensitive help. Some dialogs include a Help pushbutton when F1 cannot be accessed. 

About CX-Server 
Each CX-Server component contains an About option on the Help menu. The About CX-Server dialog supplies 
technical reference information about that component such as version and copyright information. It also contains 
the version number which is required for obtaining technical support. 

Use the following procedure to view the About CX-Server dialog. 

1, 2, 3… 
 

1. Select About from the Help menu. 
2. The About box is displayed. It provides a copyright statement and version number of the 

component or tool within CX-Server. 

Status Bar 
The Status Bar is displayed at the bottom of many of the CX-Server component and tool windows. It provides 
several helpful pieces of information while programming: 

♦ Instant Help. A brief message appears in the Status Bar as menu commands and buttons are selected. 
♦ Online Status. The online or offline status of the PLC. 
♦ PLC Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are also 

displayed here. 
♦ Connected PLC and CPU Type. The currently connected PLC and associated CPU can always be 

referenced in the status bar. 
The CX-Server Status Bar can be enabled and disabled from many components and tools by selecting the Status 
Bar option from the View menu. 

Technical Support 
If the installation instructions for this have been followed (refer to ‘Installation’ above), no difficulties should be 
encountered. However, if there is a problem, contact Customer Services. 

If a problem occurs, check that it does not relate to a fault outside CX-Server. Check the following: 

♦ The PC is working correctly. 
♦ The PLC is working correctly. 
♦ The communications system is set up correctly. 
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♦ The errors are cleared in the PLC. 
When Customer Services need to be contacted, keep the details shown in the following table to hand. A clear 
and concise description of the problem is required, together with the exact text of any error messages. 

Note: Use the About box to obtain the version number of the component. 
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Customer Services Required Information Table 

Version number of CX-Server 
component or tool: 

 

Serial number of the software:  
Operating system and version 
number: 

 

Language of operating system:  
PLC type, model and CPU 
details: 

 

Type of communications in use:  
Serial  
Toolbus  
SYSMAC LINK  
SYSMAC NET  
Device NET  
Controller Link  
Ethernet  
Nature of the problem:  

Steps taken to reproduce 
problem: 

 

Other comments:  
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CHAPTER 2 
Introduction to CX-Server Projects 

This chapter describes how data is identified within CX-Server projects (in terms of PLCs, points and groups). It 
also describes the CX-Server functions available for the purposes of configuring PLCs and points within a CX-
Server project. 

CX-Server Projects 
CX-Server is a middleware package which allows other software to access OMRON automation devices (PLCs, 
temperature controllers, Memory Card Writer and PROM Writer) through various connection types. In order to 
co-ordinate these communications, it handles information detailing the PLC devices attached to the PC and the 
information being accessed on each device. 
Such information is held in a CX-Server project file with a .CDM extension. This file contains all of the 
information about the PLCs, which CX-Server can connect to and the addresses of interest in each PLC which 
may be accessed. 
Each CX-Server project file is separate and is similar in concept to a document. CX-Server can deal with many 
CX-Server project files at a time, although often only one CX-Server project is used by the client software at 
any time. 
A number of steps are involved in the setting up of a CX-Server project. At a high-level, these can be regarded 
as: 
♦ Identifying the PLCs which the PC is to communicate with; 
♦ Identifying the addresses (points) within the PLC which are to be accessed during communications; 
♦ Establish the type of network to be used. 

CX-Server Project Concepts 
CX-Server projects consist of PLCs, Connected Devices, Networks and Points. The following paragraphs 
describe the of PLCs, Networks and Points into a CX-Server project and introduce the Project Editor. Specific 
setup of PLCs and Networks are described in Chapter 3 - Communications. 

PLCs 
A CX-Server project file contains a list of PLCs which are (potentially) connected to the PC. These PLCs do not 
really have to be connected unless communications with them are to occur. 
Each PLC has the following attributes: 
♦ Device Name. A unique name with the CX-Server project file so that the PLC can be easily referenced (for 

example, ‘PumpRoom1’). 
♦ Comment. A free-form long comment which is only used for information by the user that is attached to the 

unique device name. 
♦ Device Type. The PLC device type (for example, CV500). 
♦ Connection Type. How to connect to the PLC and the address of the PLC on the chosen network (for 

example, direct one-to-one connection or via a gateway PLC, one that is already defined in the CX-Server 
project). 

♦ Type Options. A list of options which may be present on the PLC (for example, the amount of user-memory, 
clock, EM configuration and CPU type). 

♦ Connection Options. A list of options which may be available on the chosen network (for example, the 
speed of communication on SYSMAC WAY, Toolbus, Modem configuration, or Network or Node 
configuration details). 

A full description of the communications possibilities for C-series PLCs, CV-series PLCs and CS/CJ/CP-series 
PLCs is provided in Chapter 3 - Communications. Host Link Port and Peripheral Port settings are made via the 
PLC Setup Component, refer to PLC Tools User Manual Chapter 4 - PLC Setup Component. Once the network 
has been defined and configured, it can be tested to ensure that messages are being transmitted correctly. 
The PLCs selected also affect which other setup procedures need to be performed; for example, the CV-series 
and CS/CJ/CP-series requires setting up the IO Table and using the PLC Setup Component to establish specific 
PLC characteristics. In addition it is possible to set up to three levels of networks and to communicate with these 
networks, the initial, direct connection must be to a PLC acting as a gateway. To ensure that messages from the 
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PC reach the end connection PLC, the gateway PLC must contain the routing information which identifies this 
PLC. Procedures for configuration of the network is provided in the Chapter 8 CX-Server Network 
Configuration Tool, Chapter 10 Data Links, Chapter 11 Routing Tables in the PLC Tools User Manual. 
Connection to the PLC requires the specification of the type of communications interface to be used to connect 
to the PLC. CX-Server supports two methods of communication: serial communications and network 
communications. Serial and network communications can be made using the Connection Type dialog although 
these are dependent upon the type of PLC being communicated with. 

Points 
The CX-Server project file also contains a list of addresses which may be accessed in the defined PLCs, each 
address being contained inside a point. Each point has the following attributes: 

♦ Name. A unique label within its group so that the point can be easily referenced, similar to folders in 
Microsoft Windows Explorer (for example, ‘Conveyor Position’). 

♦ Comment. A free-form long comment used only for reference by the user. 
♦ Address. The location of the information inside the configured PLC: 

♦ including the PLC (by name, matching the label of the defined PLC), 
♦ address (for example, ‘D0’), 
♦ the number of elements (for example, ten elements for ten channels) and type (for example, bit, channel, 

floating point). 
Points are stored within the CX-Server project file in a hierarchical group structure. New groups may be added 
to the CX-Server project at any level of the hierarchy tree. Groups act as container objects (as folders contain 
files) for relevant points within a CX-Server project. Similar points may be banded together and stored within 
these groups. 

Editing a CX-Server Project PLC List  
The Edit Project dialog allows the PLC or Points information in the currently opened CX-Server project to be 
modified, deleted or added. A CX-Server Project PLC list can be edited from either the Import/Export tool or 
the CX-Net tool by selecting the appropriate .cdm file and then selecting Edit from the Project menu. 
Alternatively from the Project Editor right click on Devices and select the Properties option or select Properties 
from the File menu. 

Alternatively from the Project Editor right click on Devices and select the Properties option or select Properties 
from the File menu. 

Click on the PLCs Setup pushbutton in the edit project dialog to edit the CX-Server project PLC list. 

The Device List dialog is subsequently displayed; this is the central point for adding and setting up PLCs and 
lists all currently defined PLCs in the open CX-Server project file, their type, network details and any comments 
associated with each device. 
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 This icon denotes a PLC. 

 This icon denotes a PLC also used as a gateway PLC. 

 This icon denotes that the device is open for communications. A device list cannot be opened 
whilst open for communications. 

 A PLC device cannot be deleted or have its network or device settings altered if it is open for 
communication (i.e. active). It cannot be modified in any way if the CX-Server project has 
been opened as read-only. It cannot be deleted or its device type changed if it is acting as a 
gateway. 

Adding a PLC 
The Device List dialog also permits addition of new PLCs to the open CX-Server project. Use the following 
procedure to add a PLC. 

1, 2, 3… 1. Click on the Add pushbutton in the Device List dialog. An entry is made in the list of 
Configured Devices. 

 2. Enter a name in the PLC Name field. This has a maximum length of 32 characters and 
must be unique within the currently open CX-Server project file; it must not contain any 
of the following characters: : / \ : ; , ? * & ! “ but can contain spaces and international 
characters. The PLC Name field is case sensitive, i.e. if a name is entered in upper case 
which already exists in lower case (and vice versa), a new PLC is created. 

 3. Select options for the Device field and Network field for the new PLC. The list of 
Configured Devices is updated. Clicking outside this new entry results in a confirmation 
dialog being displayed. If required select the associated Settings pushbutton to refine the 
Device Type Settings and Network Settings. Refer to Chapter 3 - Communications for 
further information. 

 4. If the Close pushbutton or another PLC name is selected, a dialog appears asking for 
confirmation of the changes just performed; select the Yes pushbutton to remove the 
dialog and save the new PLC. Select the Cancel pushbutton to abort the operation. 

Note: The default device name selected from the Add pushbutton in the Device List dialog 
is unique within the CX-Server project, for instance ‘NewPLC1’. 
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Deleting a PLC 
The Device List dialog also permits deletion of a PLC from an open CX-Server project. Use the following 
procedure to remove a PLC. 

1, 2, 3… 1. Highlight the required PLC name in the Device List dialog and select the Delete button. 
A dialog is displayed asking for confirmation of the deletion. 

 2. Select the Yes pushbutton to confirm the deletion or the No pushbutton to cancel the 
operation. 

 It is not possible to delete a device that is open for communications, indicated by the Device 
Open icon, as it cannot be opened. 

 It is not possible to delete a device being used as a gateway device, indicated by the Gateway 
Device icon. 

Renaming a PLC 
The Device List dialog allows the name of a PLC to be altered. Use the following procedure to rename a PLC. 

1, 2, 3… 1. Highlight the required PLC name in the Device List dialog and click on the Rename 
pushbutton. 

 2. Type in the new name, to a maximum length of 32 characters. 
If the Close pushbutton or another PLC name be selected, a dialog appears asking for confirmation of the 
changes just performed; select the Yes pushbutton to remove the dialog and save the new name. Select the 
Cancel pushbutton to abort the operation. 

Editing CX-Server Project 
Points and groups within a CX-Server project can be edited via the CX-Server Project Editor which is accessed 
from the Import/Export tool or the DDE Manager. The Project Editor allows new points, groups and devices to 
be added, modified to and/or deleted from the CX-Server project.  

A CX-Server Project can be edited by selecting Edit from the Project option on the menu bar of the Import / 
Export tool or by opening / editing a project in the DDE Manager. The option is not available to all tools and 
components and is further unavailable unless a CX-Server project has been opened or created. 

Click on the Points Setup pushbutton in the edit project dialog to edit the CX-Server project. The information 
displayed includes the following: 

 
A ‘devices’ view showing all devices configured in the CX-Server project and each device 
available memory areas. The complete group hierarchy of the CX-Server project, and details 
of the points (in their memory areas) within the CX-Server project. 

 
A ‘points’ view showing details of the points (within their groups). 

Comments (name and address comments) relating to a point are displayed when the appropriate element is 
highlighted. 

A point represents an input or output data area within a PLC; it can refer to a single bit of data (representing for 
example, “Hopper empty”, “Activate Reject Solenoid”), or to a multiple bit word (representing for example, 
“Process Temperature”). 

Associated with each point is a name and address indicating its position within a PLC and a PLCs memory; 
comments can also be entered against a point’s name and address. 

The information held at a point can be read or updated by CX-Server. A third party can also access this point 
data by establishing a link between that and the PLC. 

Note: More than one point can have the same address, any comment entered against this 
address applies to all points at this location. Comments entered against the point name 
are unique to that point only. Points do not have to have a name, however, if a name is 
supplied it must be unique. 

To access the Project Editor, open the CX-Server Import/Export tool and open or create a project. Then from the 
Project menu select Edit, this opens the Edit Project dialog. In Edit Project click the Points: Setup button. 
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The status bar provides instant help. 

The Project Editor can be manipulated in a similar manner to Microsoft Windows Explorer. The left pane 
displays the content of the project in terms of Devices Networks and Points. The right pane provides detailed 
information on the selected item, such as Name, Type and Address etc. 

 To expand the hierarchy in the left pane, select this icon. 

 To collapse the hierarchy in the left pane, select this icon. 

To view the content of a particular branch in the hierarchy, double-click on the item in the left pane. 

 
Select the Up One Level button from the toolbar to traverse back through the hierarchy 
toward the root. 

 
Select the Large Icons button from the toolbar to display the content of the right pane as large 
icons. 

 
Select the Small Icons button from the toolbar to display the content of the right pane as small 
icons. 

 
Select the List button from the toolbar to display the content of the right pane as a list. 

 
Select the Details button from the toolbar to display the content of the right pane with 
associated details. 

The Toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the Project Editor toolbar. 

If points are displayed in the right pane, the view can further be modified by setting certain preferences. 

♦ Showing invalid points; 
♦ Showing open points / PLCs; 
♦ Automatic resizing of list column. 
Use the following procedure to set point preferences. 

1, 2, 3… 1. Click on the Points icon in the left pane to open the points view of the editor in the right 
pane. 

 2. Select Options from the View menu. The options dialog is displayed. 
 3. Amend point preferences from the General tab. Select the OK pushbutton to complete 

the operation. Select the Cancel pushbutton to abort the operation. 
For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help. 

 To save changes and close the Project Editor, select the Close button in the title bar. 
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Adding a Group 
Points are saved within groups in a CX-Server project. When a CX-Server project is initially created it contains 
the root level group only. Groups can be created within a CX-Server project in hierarchical order from the root 
level. Points are saved within the root group or specified subsidiary groups within the hierarchy, similar to 
folders and files within the Microsoft Windows Explorer. 

The Add Group dialog adds a new group under the currently selected group. 

1, 2, 3… 1. Open the Project Editor, click on the branch of the CX-Server project hierarchy to which 
the group is to be added; for instance the Points root branch and add a group. 

 
2. Select the Add Group button from the toolbar. The New Group ‘n’ will be added to the 

tree structure in the appropriate position. 

Renaming a Group 
 

To rename a group, select the group followed by the Rename button in the toolbar. 
Alternatively select Rename from the File menu option. or right click on the group and select 
the Rename option. 
The new group name has a maximum length of 32 characters and must be unique within the 
group that it is being created. It must not contain any of the following characters: / \ : ; , ? * 
& ! . “. 
The group name field is case sensitive. For example, if a name is entered in upper case which 
already exists in lower case a new group name will be allowed. 

Adding a Point 
The Add Point dialog allows a new point within the currently open CX-Server project to be created and its name 
and address to be entered. Use the following procedure to add a point. 

1, 2, 3… 1. Open the Project Editor, click on the Points branch in the tree. 

 
2. Select the Add Point button from the toolbar. The Add Point dialog is displayed. 

 3. Select the Logical Tab and enter the new name in the Name field; this has a maximum 
length of 32 characters, it must be unique, and must not contain any of the following 
characters: / \ : ; , ? * & ! “ but can include an existing path to indicate the group to which 
it belongs (if it is to be added to a group other than that indicated above the name). A 
name is optional, but if supplied must be unique. 

 4. A comment can only be added to a point if a point name has been supplied. Enter text in 
the Comment field to be associated with the point name. This field is optional and is used 
simply for reference purposes.  

 5. Select the Physical Tab and select the PLC to be associated with the point in the PLC 
field. This field is mandatory but can be set to ‘None’ until a correctly configured PLC is 
added to the CX-Server project. 

 6. Enter the data location in the Data Location field identifying the area of memory to 
which this address applies; this value is dependent upon the type and configuration of the 
PLC and is mandatory if a PLC has been selected. Memory Area and Start Address must 
be supplied, for instance, ‘D0’ for a CV-series and CS/CJ/CP-series PLC or ‘DM0’ for a 
C-series PLC. Refer to Appendix B PLC Memory Areas for a complete list of valid PLC 
memory areas and ranges. 

 7. Enter the number of elements indicating the number of address units which start at the 
specified data location (i.e. the size of an array of addresses, for instance, ten for ten 
channels) in the Elements field. This field defaults to 1. 

 8. Select the Internal Data Type in the Internal Data Type field, identifying the format of 
the data held at the PLC address (e.g. BCD or binary, WORD or double WORD). This 
allows CX-Server to automatically convert the PLC specific format of the data to a 
common format which the PC can use. 

 9. Select the Command Modifier required to access this address in the Command Modifier 
field. The modifiers available depend upon the data location chosen. An example of a 
modifier is Forced Set which forces a data location to be held with given data, overriding 
the PLC program's usage. 
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 10. Select the OK pushbutton to save the point details or the Cancel pushbutton to discard 
the new point. 

Note: The fields in the Address chapter of the dialog are only enabled when a PLC has been 
selected and the values available in these fields (if any) also depend upon the PLC 
chosen. 

If several points are to be added at a time, the Leave Box setting should be checked, this allows the dialog to stay 
active after the Add pushbutton is pressed. The fields remain populated with the previous point’s settings 
allowing further modification. Select the Close pushbutton to remove the dialog. 

A point can have a name and/or an address. It does not need to have both. 

Points with valid addresses assigned are marked by an icon according to the Internal Data Type set as follows: 

Internal Data Type Icon  Internal Data Type Icon 

No type defined  
 Single Word Unsigned BCD  

Bit  
 Double Word Unsigned BCD  

Signed Character Binary  
 Quad Word Unsigned BCD  

Unsigned Character Binary  
 Single Word Signed BCD  

Raw Character Binary  
 Double Word Signed BCD  

Single Word Unsigned Binary  
 Quad Word Signed BCD  

Double Word Unsigned Binary  
 Double Word Float  

Quad Word Unsigned Binary  
 IEEE Float  

Single Word Signed Binary  
 Complex  

Double Word Signed Binary  
 LReal  

Quad Word Signed Binary  
   

Points with an invalid PLC address assigned to them are indicated by the associated icon. 

Editing a Point 
The Edit Point dialog displays the current configuration for a selected point allowing these details (including the 
name) to be amended. The Edit Point dialog operates in the same manner as the Add Point dialog described 
above. 

1, 2, 3… 1. Select the point to be edited. 

 
2. Select the Properties button from the toolbar. The Edit Point dialog is displayed. This is 

identical to the Add Point dialog. 

 A point's address or PLC cannot be modified if it is currently active, i.e. open for 
communications, indicated by the Device Open icon in the Project Editor. 

Deleting a Point or Group 
Use the following procedure to delete a point or a group. 

1, 2, 3… 1. Highlight the point or group to be deleted. 

 
2. Select the Delete button from the toolbar to delete the point or group. 

A confirmation dialog is displayed provided this option has been set in the Options dialog. 

 Any points or groups contained within a group being deleted are also removed, unless any 
points within the group or children of the group are open for communications, in which case 
the points and the groups they are contained within are not deleted. 

Points which are currently active cannot be deleted. 

Note: The root group cannot be deleted. 
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Moving and Copying Points and Groups  
The Project Editor allows standard Microsoft Windows drag and drop procedures permitting points and groups 
to be copied or moved within the Points group. 

Moving is achieved by clicking on an item and then dragging the mouse to the item’s new position. A 
confirmation dialog is displayed. Copying is similar except that the Ctrl key must be kept depressed. 

Use the following procedure to copy or move information from or in the Project Editor. 

1, 2, 3… 1. Select an item in the right pane of the Project Editor, for example a point. More than one 
item can be selected by pressing Shift and selecting another item to extend the selection, 
or by pressing Ctrl and selecting another item to add to the selection. 

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the 

toolbar to move the item. 
 3. Select an area in the Project Editor to copy or move the items to, for instance copying a 

point into a new group. 

 
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 

Adding a Device 
The Project Editor also permits devices to be added into the CX-Server project as an alternative to the Device 
List (refer to Chapter 2 - Adding a PLC for details). Use the following procedure to add a device. 

1, 2, 3… 1. Open the Project Editor, click on the Devices branch in the tree. 

 
2. Select the Add PLC button from the toolbar. The Change PLC dialog is displayed. Refer 

to Chapter 3 - Communications for details regarding device setup. 
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CHAPTER 3 
Communications 

This chapter describes the communications options available to CX-Server and is confined to software aspects 
and the associated CX-Server interface; more detailed information relating to each hardware product is to be 
found in its associated OMRON commercial manual. 

Supported Communications 
Communications between CX-Server and target PLC’s are achieved by a combination of different network 
connection types. SYSMAC WAY, SYSMAC LINK, SYSMAC NET, Controller Link, Toolbus, Ethernet, 
Memory Card Writer, PROM Writer, Modem and Device Net. Each network connection has different 
capabilities. SYSMAC NET is specially suited for medium to large scale systems where connecting PLCs to 
computers is included. SYSMAC LINK provides the necessary capabilities of an industrial network: SYSMAC 
WAY operates at a much simpler level, its primary functions are for monitoring and diagnostics. SYSMAC 
WAY and Toolbus both provide Modem connection facilities. 
The combination employed depends upon the requirements of the system. The network connection types used 
will determine the maximum speed of data transfer rates and frame lengths that can be used. When the PLC 
network is first set, the default connection should be used to determine the maximum frame length and baud 
rates. 
CX-Server controls communications with target PLCs, formats messages into the correct protocol and then 
transmits them to the device (normally a PLC but it can be a memory card); messages are also received from the 
PLC containing data to be transmitted to applications, for example CX-Programmer, CX-Protocol and CX-Net 
Network Configuration tool. The type of messages transmitted include requests to update point data or to 
download programs. 
When a PLC is being configured, as discussed in Chapter 2 - Introduction to CX-Server Projects, CX-Server 
automatically provides a list of the possible network types associated with the selected device; PLC Tools User 
Manual Chapter 8 - CX-Net Network Configuration Tool describes how to create the actual PLC/network 
communications links (including the creation and modification of associated Routing and Data Link Tables). 

Device Setup 

PLC Settings 
Each CX-Server project can contain a list of devices. A device can be a PLC which can be configured to map on 
to a physical connection (either directly or via an existing gateway connection). A correctly configured 
connection allows connections to the PLC. 
Each device added to the CX-Server project must be given a unique name within the CX-Server project file; the 
device type and network connection should also be given, for example: ‘CV500’, ‘SYSMAC WAY’. 

The Change PLC dialog allows a new PLC to be added to the CX-Server project and its device type and network 
settings to be defined. It is also used to edit existing PLC details. It is accessed from the invoking application or 
from CX-Server CX-Net tool. It can also be accessed from the Project editor by expanding the device list, 
selecting the appropriate PLC and then clicking the properties button in the toolbar or selecting Properties from 
the File menu. 

Note: A PLC cannot be created unless a CX-Server project has been opened. Whilst PLCs 
are added to the CX-Server project via this dialog, the CX-Net Network 
Configuration Tool must be used to set up routing tables for those PLCs acting as a 
gateway. Refer to the PLC Tools User Manual Chapter 8 - CX-Net Network 
Configuration Tool for further information. 
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Use the following procedure to change the PLC settings: 

1, 2, 3… 1. Enter a name in the Device Name field. A device name must consist of no more than 32 
characters and must be unique. 

 2. Select the device type of the PLC in the Device Type field. If the device requirement does 
not appear in the list then CX-Server does not support it. 

 3. Further configure the device type (e.g. CPU number) by selecting the Device Type 
Settings pushbutton. Refer to Chapter 3 - Device Type Settings for further details. 

 4. Select the network type of the PLC in the Network Type field. This list may include other 
PLCs in the CX-Server project that can be used as gateway devices, depending upon the 
device type chosen. A full list of connection types are provided below. 

 5. Further configure the network settings (e.g. node number) if applicable by selecting the 
Network Type Settings pushbutton. Refer to Chapter 3 - Network Communications (End 
Connection) for further details. 

 6. Optionally, enter a comment relating to this unique PLC in the Comment field. 
 7. Select the OK pushbutton to save the new PLC or the Cancel pushbutton to abort the 

operation. 

Note: The Device Name must not contain any of the following characters: / \ : ; , ? * & ! . 
“ but may include spaces and international characters. The Device Name is case 
sensitive, i.e. if a name is entered in upper case which already exists in lower case, a 
new PLC is created. The contents of the Network field depend upon the device type 
settings of the new PLC. The Device Type Settings pushbutton is disabled for the 
following devices: C20, FinsGateway, Memory Card Writer and Programmable Read 
Only Memory (PROM) Writer, since these devices do not have options. Any PLCs 
which have been set up and can act as a gateway device appear in the Device Type 
field. 

A full list of connection methods is as follows:  

♦ SYSMAC WAY. 
♦ Toolbus. Toolbus on the CS/CJ/CP-series PLCs allows CX-Server auto-baud rate detection up to 115,200 

bps. Toolbus on the CS/CJ/CP-series PLCs supports full n clients and n destinations. 
♦ When the PLC model is set as a CP1H CPU Unit equipped with a USB port, a computer’s USB port can be 

connected directly to the PLC’s built-in USB port with a standard USB cable. 
♦ With a CP1E CPU Unit, the Toolbus connection cannot be used for serial communications. Connect via 

USB or SYSMAC WAY. 
♦ Modem via SYSMAC WAY. Modem is supported through SYSMAC WAY communications via Windows 

TAPI configuration. 
♦ Modem via Toolbus. Modem is supported through Toolbus communications via Windows TAPI 

configuration. 
♦ Ethernet via TCP/IP. Ethernet is only supported for CS/CJ/CP-series PLCs, CV-series PLCs and 

C200HE/G/X/E-Z/G-Z/X-Z series PLCs. All Ethernet connections now also support full n clients and n 
destinations via CX-Server Ethernet driver. CX-Server also utilises FinsGateway Version 3 Ethernet driver 
if the required PLC connection UDP port is locked open by FinsGateway active running services. 
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♦ Controller Link for OMRON NSB. Controller Link is supported through FinsGateway Version 3 when 
installed via CX-Server installation and services are activated. CS-series PLC Optical Controller Link is 
supported via FinsGateway Version 3 when Controller Link is installed. 

♦ SYSMAC LINK for OMRON NSB. SYSMAC LINK is supported through FinsGateway Version 3 when 
installed via CX-Server installation and services are activated. 

♦ SYSMAC NET for OMRON NSB. SYSMAC NET communications are supported on Windows NT only 
through FinsGateway Version 3 when installed via CX-Server installation and services are activated. 

♦ FinsGateway CPU unit connection and Gateway connection combinations. 
♦ DeviceNet The unit for Device Net Communications is available for all CS1/CJ1 series PLCs and the 

CPM2*-S* PLCs. 
♦ CS1 Board for OMRON CS1 PCI board. PCI Board is supported through FinsGateway version 3.12 when 

installed via CX-Server installation and services are activated. 
♦ USB: USB can be selected when using a CP-series PLC or CJ2 PLC. Toolbus communications using a USB 

cable are possible with a CP-series PLC. EtherNet/IP communications using a USB cable are possible with 
a CJ2 PLC. 

♦ Toolbus (using the USB port): Uses the same communications settings as for the CS1/CJ1 Toolbus. 
Toolbus communications can be used with the CJ2 PLCs. 

♦ EtherNet/IP: EtherNet/IP communications can be performed using the Ethernet port. EtherNet/IP 
communications can be used only with CJ1 or CJ2 PLCs.  

♦ Secure Comm: Secure Comm communications can be performed using the Ethernet port. Secure Comm 
communications can be used only with CS1, CJ1 or CJ2 PLCs. User authentication is required. 

Note: The following network types cannot be run on Windows Vista or later OS. 
- Controller Link for OMRON NSB. Controller Link  
- SYSMAC LINK for OMRON NSB. SYSMAC LINK  
- SYSMAC NET for OMRON NSB. SYSMAC NET  
- CS1 Board for OMRON CS1 PCI board  
- Fins Gateway  
The following network type cannot be selected on OS other than Windows 10 version 
1803 or later and Windows 11. 
- Secure Comm 
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Device Type Settings 
The Device Type Settings dialog allows further configuration of the selected PLC. This is important since the 
behavior of the PLC depends upon details such as CPU type (e.g. the network options available to a C200HS 
require CPU31 or CPU33 setting to be specified). Device type settings cannot be adjusted for an open PLC or a 
gateway PLC. 

The General tab of the Device Type Settings dialog allows: 

♦ Selection of CPU Type; 
♦ Allocation of Program Memory or protection from writing; 
♦ Allocation of Expansion Memory or protection from writing; 
♦ Allocation of File Memory or protection from writing; 
♦ Installation of a Timer/Clock. 

 
When settings cannot be selected, the PLC is fitted with the standard settings as shown on the Device Type 
Settings dialog and cannot be reconfigured. Similarly, if Expansion Memory cannot be selected for CV-Series 
PLCs, EM memory cannot be configured. 

In each instance, availability of CPU Type and memory depends upon the device type selected (and also the 
amount of expansion memory purchased for the PLC). Changing CPU type automatically changes the amount of 
memory available on some devices. 

For SRM1 PLCs, only CPU Type can be selected. 

For CV-series PLCs, CS-series PLCs and IDSC, File Memory allows selection of the amount of EPROM or 
EEPROM. A Timer/Clock can be installed. 

Defining Connections and Gateway PLCs 
It is possible to communicate with PLCs which are not directly connected to the computer via PLC network 
configuration and gateway abilities of PLCs. Generally, a directly connected PLC or the network NSB as a 
gateway is used to route to the required PLC by use of its routing table and networking capability. In order to 
specify the link information, a network type (e.g. SYSMAC LINK) and PLC addressing information is needed 
(i.e. target network, node and unit). 

Connection can be directly made to any PLC type. Direct connections are established with SYSMAC WAY, 
Toolbus, Modem, Ethernet through a network card or SYSMAC NET, Controller Link or SYSMAC LINK via 
an OMRON NSB. 
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It is also possible to gateway from a direct connection on to another type of network that cannot be connected to 
directly. 

 
Use the following procedure to define a gateway connection. 

1, 2, 3… 1. Open the Change PLC dialog. 
 2. Select the Gateway PLC (i.e. the direct connection). If necessary configure the CPU type 

by selecting the associated Settings pushbutton. 
 3. Select the Network type and click on the associated Settings pushbutton. The above 

example uses Ethernet as the network. 
 4. The Network Settings dialog is displayed. Set up the address and Node number. For 

Ethernet, also enter the IP address. 
 5. Select the OK pushbutton to proceed from the Network Settings dialog. 
 6. Select the OK pushbutton to proceed from the Change PLC dialog. 

Use the following procedure to define a target connection. 

1, 2, 3… 1. Add a PLC Device to the CX-Server project. The Change PLC dialog is reopened. Select 
the PLC type for the target PLC. If necessary configure the CPU type by selecting the 
associated Settings pushbutton. 

 2. Select the PLC to be used as the Gateway PLC from the list in the Network Type field and 
click on the Settings pushbutton. 

 3. The Network Settings dialog is displayed. Set up the Source Network and Destination 
Network and Node number. 

 4. Select the OK pushbutton to proceed from the Network Settings dialog. 
 5. Select the OK pushbutton from the Change PLC dialog to complete the operation or the 

Cancel pushbutton to abort the operation. 

Serial Communications (Direct Connection) 
The computer involved in establishing communications has at least one serial (RS232) port; the first port is 
normally called COM1. If in doubt check the configuration of your PC. Only a single PLC can be connected to 
an RS232 port. 

For CS/CJ/CP-series PLCs, if Toolbus is being used as the direct connection, multiple destinations are permitted. 

To establish a serial connection to several PLCs, Link Adapters are required that convert from RS232 to RS422. 
Link Adapters would be connected in the serial line between the computer and the PLC or between the remote 
Modem and the PLC. Multiple connections are permitted from an RS422 port.  

If problems are experienced when making a serial connection, check the serial port on the computer is enabled 
and that a mouse driver is not loaded or connected to the same port. 

For PLCs with direct serial connections on the CPU, default communications settings can also be set by 
changing the DIP switches on the front of the CPU. The default protocol settings are 9,600 baud, 7 data bits, 
even parity and 2 stop bits. Older PLCs have a default baud rate of 2,400. For PLCs not supporting this feature, 
settings are configured via the PLC Setup component. Refer to the PLC Tools User Manual Chapter 4 - PLC 
Setup Component for details of the PLC Setup component. 

Note: Communications is possible for the CJ2M-CPU3@ by using a CP1W-CIF01 RS-232C 
Option Board or a CP1W-CIF12 RS-422A/485 Option Board. 
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SYSMAC WAY 
SYSMAC WAY provides a simple means of connecting a computer to a PLC for monitoring and diagnostic 
purposes. It has a slower transmission path than SYSMAC LINK, SYSMAC NET, Controller Link or Ethernet. 

Communications are achieved by either: 

♦ Employing the RS232 serial communications interface for communicating with individual PLCs. 
♦ Employing the RS422 interface for communicating with multiple PLCs. 
The following connections are required: 

♦ RS232 connection via a standard serial port on the computer (COM1 etc.) 
or 

♦ RS422 connection to a 422 serial board. 
These connections can also be made via a Modem. Refer to standard Microsoft Windows documentation for 
details on Modem configuration and setup.  

The Driver tab of the Network Settings dialog allows the configuration information to be entered; this 
information ensures that data is transmitted correctly over the network.  

 
 

Use the following procedure to apply Network Settings. 

1, 2, 3… 1. Click on the associated Settings pushbutton in the Change PLC dialog. 
 2. In the Network tab, check the Unit No, usually 0 for connecting to a single PLC or the 

multi drop number for an RS422 connection. 
 3. In the Driver tab, check the port on the computer for connection to the PLC and enter it in 

the Port Name field. 
 4. Select the Baud Rate, Parity, Data Bits and Stop Bits from the drop-down lists available 

for the selected port. 
 5. For the Modem tab, refer to Microsoft Windows documentation. 
 6. Select the OK pushbutton to save these settings, or select the Cancel pushbutton to abort 

the operation. 

Note: For CS/CJ/CP-series PLCs, SYSMAC WAY dip switch five on the front panel must 
be set to ‘OFF’. 
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Toolbus 
Toolbus operates in a similar manner to SYSMAC WAY. The connection is made to a PLC using its peripheral 
port. 

The following connection is required: 

♦ RS232 connection via a standard serial port on the computer (COM1 etc.) using either CIF01 or CIF02 
cable. 

The Driver tab is similar to that belonging to SYSMAC WAY; however, for some PLCs fixed values are 
entered and these cannot be altered (see table below). The CS/CJ/CP-Series PLC Toolbus configuration ensures 
successful connection to the PLC every time, independently of the rate specified by the user provided the Auto 
Baud Rate Detection setting has been checked. 

PLC Fixed Data Bits Parity Stop Bits 

CS/CJ/CP Series Yes 8 None 1 

CV/CVM Series Yes 8 Odd 1 

C Series No  - - - - - - - - - 

CPM1/CPM1A - - - - - - - - - - - - 

SRM1/SRM1-V2 - - - - - - - - - - - - 

CPM”*/CPM2*-S* - - - - - - - - - - - - 

CQM1/CQM1H - - - - - - - - - - - - 
 

Serial Networks 
When connecting a computer to a serial network of PLCs, each PLC needs to be configured so that it has a 
different Unit number. The Unit number for C-series PLCs should be configured as follows: 

CPU-mounted Host Link unit: DIP switches on back of unit 

Rack-mounted Host Link unit: Rotary switches on front of unit 

Direct CPU RS232 port: Internal DM settings 

Direct CPU Peripheral port: Internal DM settings 
 

The Unit number for CV-series PLCs and CS/CJ-series PLCs should be configured as follows: 

Rack-mounted Host Link unit: Unit Setup dialog 

Direct CPU RS232 port: Host Link settings dialog 

Direct CPU Peripheral port: Fixed as Unit 0 

Remote SYSBUS/2 Peripheral port: Fixed as Unit 0 

Note: The unit number rotary switches on the top of CV-series SIO units are the unit 
number of that Special I/O Unit on that PLC rack and not the Unit number of the PLC 
on the serial network.  

 
Online connection is possible through a Serial Communications Board or Unit with unit version 1.2 
or later mounted to a PLC directly connected via the peripheral bus (Toolbus) or Host Link (or to a 
PLC on the network) to a PLC connected serially with Host Link FINS. 
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Target PLC Host Link unit number 

CX-Programmer Ver.5.0 or later 

Serial 
Gateway 

Set the relay PLC. 
(Select in the Change PLC Dialog Box.) 

Serial Communications Board/Unit with unit Ver.1.2 or later 
(Select SCU (Unit 0 to 15) in the UNIT field.) 

Network Type: 
Select [PLC2]. 

Serial Gateway function port (Select
port 1/2 in the PORT field according 
to the calculated address.) 

Select the Use SYSWAY with the port option in the Host Link 
(SYSWAY) settings. 

Host Link FINS 

Enter the Host Link unit number in the Host Link Unit Number field for
the target PLC in the Host Link (SYSWAY) settings. 

System Configuration Example 

Device Name: PLC1 

Device Name: PLC2 

 

1. Register the PLC to be connected serially (using Host Link FINS) in the project gateway (e.g., 
PLC2). 

2. In the Change PLC Dialog Box of the target PLC (e.g., PLC1), select the relay PLC (gateway 
PLC) in the Network Type pull-down menu (e.g., [PLC2] (See note.)) and click the Settings 
Button to the right of the Network Type pulldown menu. 
Note The PLC name enclosed in square brackets (e.g., [PLC2]) indicates the gateway PLC.  
 

 

 

 

 

 

Select the relay PLC (e.g., [PLC2]) as the 
network type. 

 

3. The Network Settings Dialog Box will be displayed. Click the Guide for Serial Gateway 
Button. 

Click this button. 

 

4.  The Serial Gateway Guide Dialog Box will be displayed. Select the unit and the port number 
under the Calculate Address Area. 
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The Serial Communications port 
address is automatically calculated. 

Select the Unit. 

Select the port. 

 
• Select the Units from the UNIT pull-down menu as follows: 

CPU: CPU Unit (See note.) 
SCB: Serial Communications Board 
SCU (Unit 0 to 15): Serial Communications Unit numbers 0 to 15 
Note: The Host Link FINS Serial Gateway is not currently supported for the CPU Unit, so 
connection is not possible even if CPU is selected from the CX-Programmer. 

• Select the port from the PORT pull-down menu in the as follows: 
CPU:Peripheral: CPU Unit’s peripheral port (See note.) 
CPU:COMM: CPU Unit’s built-in RS-232C port (See note.) 
SCB:Port1_/SCB:Port2_: Serial Communications Board’s port No. 1/2 
SCU:Port1_/SCU:Port2_: Serial Communications Unit’s port No. 1/2 
Note: The Host Link FINS Serial Gateway is not currently supported for the CPU Unit, so 
connection is not possible even if a CPU port is selected from the CX-Programmer.  

• The serial port number address is automatically calculated in the Calculated Address field on the 
right. 

5. Select the Use SYSWAY with the port option in the Hostlink SYSWAY Setting field, and enter 
the actual Host Link unit number for the target (communications partner) PLC in the Host 
Link Unit Number field. 
• When using the CX-Programmer, enter the actual Host Link unit number. Do not add 1 to 

the value. The CX-Programmer will automatically add 1 internally. 
 

Select this option. 

Enter the unit number for the actual Host Link
(values are incremented by 1 automatically). 

 
6. Click the Apply Button. 
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Connecting Directly to a CJ2 CPU Unit Using a USB Cable  
Connecting the CX-Programmer to a CJ2 CPU Unit using a USB Cable makes it possible to 
perform communications faster than when using the conventional Toolbus connection. 
 CX-Programmer 

CJ2 

USB 

 
Perform the following procedure to make the communications settings. 

1. The Change PLC Dialog Box will appear when you create a new project. 

 
2. Select CJ2H in the Device Type Field. 

3. Select USB in the Network Type Field. (USB is the default connection method.) 

4. Click the Settings Button next to the Network Type Field. The following Network Settings 
[USB] Dialog Box and System Configuration Image will be displayed. 

 

 
Select the Direct Connection Option on the Network Tab Page, and click the OK Button. 
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5. Click the OK Button in the Change PLC Dialog Box. 
 
Note: If a FINS Network Communications Unit (see note 1) is mounted to the PLC connected via the USB 

cable, the CX-Programmer cannot connect to the other node PLCs of the network to which the FINS 
Network Communications Unit is connected. To connect to the other node PLCs of the network to 
which the FINS Network Communications Unit is connected, use the following method to change the 
network type. Select the Show All Check Box for the Network Type Field in the Change PLC Dialog 
Box to display all possible network types that can be selected, including those that are not given above. 
 

 Use the following table as a guide to select the network type according to the conditions. 
 
Condition: 
FINS Network Communications Unit 
(See note 1.) of the target PLC 

Network type to select 

Communications Unit not mounted. The default can be 
selected. USB 

Communications Unit is mounted. Display by selecting the 
Show All Check Box. Toolbus (USB port) 

 
Note 1: FINS Network Communications Units include the following: a Controller Link Unit, SYSMAC LINK 

Unit, Ethernet Unit, DeviceNet Unit, or FL-net Unit. It also includes using the serial gateway for serial 
communications and routing tables. The CompoNet Unit is not a FINS Network Communications 
Unit. 

 

Network Communications (End Connection) 
Each network supports a protocol (or set of rules) determining the manner in which a message is transmitted. 
Requests sent are formatted into the relevant protocol with each message being validated and prioritised 
according to the rules associated with that protocol. 

Once a connection has been established between a device and CX-Server, a set of routing rules and tables are 
defined which organise the connection between these two processes. The manner of routing depends upon the 
protocol (identified with each network type) involved in communicating with the PLC. 

The Routing Tables are created via offline table editors but they can also be manipulated online using the CX-
Net Network Configuration tool. These tables, although they vary in format, contain the network, memory and 
node address information required to ensure that information is directed correctly across the relevant network. 
They also allow the connections to be defined for PLCs which are to act as gateways. Refer to the PLC Tools 
User Manual Chapter 8 - CX-Net Network Configuration Tool for further information. 

When employing SYSMAC LINK, Controller Link and SYSMAC NET networks, each PLC must be 
configured on each network to have different Node numbers. If two or more networks are joined together, 
Routing Tables must be created and each network given a unique Network number in order to establish 
communications between them. 

FinsGateway is also needed to establish Controller Link, SYSMAC LINK and SYSMAC Net on NT; refer to the 
FinsGateway Manual for further information. 

When the Routing Tables have been set up, communications are possible from all the computers to all PLCs. 
Although each network is given a specific number, the local network can always be addressed as network 0. If a 
serial connection has been made to a CV-series PLC, network 0 refers to the network that is connected to the 
lowest numbered Special I/O Unit and the local PLC can be addressed as Node 0. 

Note: Remember that the Unit number that is specified in the communications dialog is not 
related to the Special I/O Unit number as set by the rotary switches on the top of CV-
series SIO units. 
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DeviceNet  
The DeviceNet conforms to the DeviceNet open field network specification, which means that devices (Master 
and Slave) produced by other manufacturers can be connected to the Network. A wide range of field-level 
applications can thus be supported by combining valve devices, sensors, and other devices. 

Two types of communications are supported:  1. – Remote I/O master communications that automatically 
transfer I/O between Slaves and the CPU Unit without any special programming in the CPU Unit and  2. – 
Message communications that read/write messages, control operations, or perform other functions for Master 
Units, CPU Units to which a Master Unit is mounted. 

Differences between DeviceNet Network as FINS Network and other PLC Networks are as follows: 

1. Maximum Node number and Maximum number of Nodes are 63. 

2. No Datalink functionality. 

3. There are specific system setting areas and values for DeviceNet Network. Other application software 
(DeviceNet Configurator) will support these settings so CX-Net /CX-P does not need to support the system 
setting. 

 

 

The following diagram illustrates the connection options available to the C-series PLC. 

 

 
Possible Network Combinations - C-series PLC  

Note: Only the following C-series PLCs can be used as a gateway: C200H/HX/E/G/E-Z/G-
Z/X-Z, C1000H/HX/E/G/E-Z/G-Z/X-Z, C2000H. The C200HS PLC cannot be used 
as a gateway connection. For Ethernet, multiple destination access is possible.  
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The following diagram illustrates the connection options available to the CV-series PLC. 

 

 

 
Possible Network Combinations - CV-series PLC  

Note: For Ethernet, multiple destination access is possible. 
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The following diagram illustrates the connection options available to the CS1-series PLC. 

 

 
Possible Network Combinations – CS1-series PLC  

Note: For Toolbus (Modem) and Ethernet, multiple destination access is possible. 
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SYSMAC LINK 
SYSMAC LINK is a high speed (2 Mbits/sec) industrial network supporting the connection of multiple C-series, 
CV-series, CS series and CJ series PLCs and one or more computers (so enabling the interchange of information 
between these devices). 

Communications are achieved by either Co-axial or Fibre Optic cabling and employing a SYSMAC LINK 
Network Service Board (NSB), and Microsoft Windows device drivers. 

Use the following procedure to configure SYSMAC LINK. 

1, 2, 3… 1. Ensure the Network Type is SYSMAC LINK. 
 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab, define the FINS Destination Address by entering the Network and 

Node. 
 4. Set the Response Timeout(s) to adjust for a slow network as necessary. 
 5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC LINK 

documentation for further information. 
 6. In the Driver field, select the appropriate options from the Shared RAM address and 

Interrupt level fields. Refer to SYSMAC LINK documentation for further information. 
 7. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the 

operation. 

SYSMAC NET 
SYSMAC NET is a high speed (2 Mbits/sec) LAN employed within medium/large scale systems (C-series PLCs 
and CV-series PLCs only). 

Connections between the various PLCs and computers is achieved by fibre optics in a ring or loop configuration 
allowing the exchange of data between the attached devices. The link is achieved by an NSB and employment of 
Microsoft Windows device drivers. Refer to the SYSMAC NET Network Support Board manual for details on 
installation. 

Use the following procedure to configure SYSMAC NET. 

1, 2, 3… 1. Ensure the Network Type is SYSMAC NET. 
 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab, define the FINS Destination Address by entering the Network and 

Node. 
 4. Set the Response Timeout(s) to adjust for a slow network as necessary. 
 5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC NET 

documentation for further information. 
 6. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort 

the operation. 

Controller Link 
The Controller Link is an Factory Automation network that can send and receive large data packets flexibly and 
easily among the PLCs and IBM PC/AT or compatible computers. 

The Controller Link supports data links that enable data sharing and a message service that enables sending and 
receiving data when required. Data link areas can be freely set to create a flexible data link system and 
effectively use data areas using the CX-Net Network Configuration tool. Refer the to PLC Tools User Manual 
Chapter 8 - CX-Net Network Configuration Tool for further details. 

The network is connected using shielded twisted-pair cable and high-volume data transmissions at high speed 
enable construction of a wide range of networks, from low level systems to high. The link between attached 
devices and the network is achieved by an OMRON Controller Link NSB (PCI and ISA) and FinsGateway 
Version 3. Refer to the Controller Link operation manual for further details on installation. 

CS/CJ/CP-Series PLCs support the wired Controller Link and the new optical Controller Link network. 

Use the following procedure to configure Controller Link. 

1, 2, 3… 1. Ensure the Network Type is Controller Link. 
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 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab, define the FINS Destination Address by entering the Network and 

Node. 
 4. Set the Response Timeout(s) to adjust for a slow network as necessary. 
 5. Enter the Frame Length in the Frame Length field. Refer to Controller Link 

documentation for further information. 
 6. In the Driver tab, set the appropriate setting for the Shared RAM Address, Interrupt Level 

and Baud Rate fields. Refer to Controller Link documentation for further information. 
 7. Select an appropriate Node and Unit for the Network address. 
 8. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the 

operation. 

Ethernet 
Ethernet is a commonly used network capable of achieving a high rate of data transmission.  

An NIC board must be installed inside the computer and TCP/IP protocols must be added and configured. 

Use the following procedure to configure Ethernet. 

1, 2, 3… 1. Ensure the Network Type is Ethernet. 
 2. Click on the associated Settings pushbutton in the Change PLC dialog. 
 3. In the Network tab define the FINS Source Address: Network field by entering the 

Network Address. 
 4. Check the Network and Node addresses for the PLC and enter them in the FINS 

Destination Address: Network field and Node field respectively. 
 5. Set the Response Timeout(s) to adjust for a slow network. 
 6. Enter the Frame Length in the Frame Length field. 
 7. In the Driver tab, check the Workstation Address and enter it in the Workstation: Node 

Number field. Alternatively, select the Auto Detect setting to automatically determine the 
workstation address. 

 8. Check the PLC IP address and enter it in the PLC: IP Address field. 
 9. Check the FINS UDP Port Number and enter it in the PLC: Port Number field. 
 10. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton to abort the 

operation. 

Note: If using a subnet mask which is not 255.255.255.0 you will need to add the IP Address of the 
PC wishing to connect, into the Ethernet unit. Do this using the I/O table. 

Connecting Using EtherNet/IP 
The CJ2 CPU Units support EtherNet/IP to enable high-speed and high-capacity data links between 
PLCs through Ethernet cables. This section describes the two methods that can be used to connect a 
PLC on a EtherNet/IP network. 

♦ Directly connect to the gateway PLC using a USB cable, and connect to the PLC on the network through 
the gateway PLC. 

 

EtherNet/IP 

CJ2 CJ2 

Specify IP address  Specify IP address 

CX-Programmer 

USB 

 
♦ Connect to the EtherNet/IP network using an Ethernet cable, and connect to the PLC through the network. 
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 CX-Programmer 

EtherNet/IP 

CJ2 CJ2 CJ2 

Specify IP address Specify IP address Specify IP address 

 
Note: When running the CX-Programmer on Windows XP or later OS and connecting online to a 

PLC via EtherNet/IP for the first time, the settings of the Windows Firewall will need to be 
changed. Refer to Appendix B EtherNet/IP Connections from Windows XP or later OS in Part 
1: CX-Programmer for details on making the changes. 

Setting Procedure 

Perform one of the following procedures to make the communications settings. 
 

♦ Directly Connecting to the Gateway PLC Using an USB Cable, and Then Connecting to the PLC on the 
Network through the Gateway PLC. 

1. When you create a new project, select CJ2H or CJ2M in the Device Type Field. 

2. Select USB in the Network Type Field. (USB is the default connection method.) 

3. Click the Settings Button next to the Network Type Field. The following Network Settings 
[USB] Dialog Box and System Configuration Image will be displayed. 

 

 
Select the USB –> Network Connection Option on the Network Tab Page, and click the OK 
Button. 

4. Input the unit number of the EtherNet/IP Unit or the built-in EtherNet/IP port of the CJ2H-
CPU6@-EIP or CJ2M-CPU3@ that is connected to the gateway PLC side that is connected by 
USB and the IP address of the PLC that is on the network and is to be connected to and then 
click the OK Button. 

5. Click the OK Button in the Change PLC Dialog Box. 
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♦ Connecting to the EtherNet/IP Network Using an Ethernet Cable, and Then Connecting to a PLC on the 

Network 

1. When you create a new project, select CJ2H or CJ2M in the Device Type Field. 

2. Select EtherNet/IP in the Network Type Field. 

3. Click the Settings Button next to the Network Type Field. The following Network Settings 
[EtherNet/IP] Dialog Box and System Configuration Image will be displayed. 

 
4. Input the IP address of the PLC on the network to be connected, and then click the OK Button. 

5. Click the OK Button in the Change PLC Dialog Box. 

PROM Writer 
PROM Writer is a device allowing Programmable Read Only Memory (PROM) to be written to. 

The following connection is required: 

♦ RS232 connection via a standard serial port on the computer (COM1 etc.). 
The Driver tab of the Network Settings dialog is similar to that belonging to SYSMAC WAY, however, the 
transmission conditions should be set to: 

♦ Baud Rate = 9600 
♦ Data Bits = 8 
♦ Parity = none 
♦ Stop Bits = 1 
♦ or those of the particular PROM writer unit being used. 
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Connecting via an NS-series PT  

Overview 
An online connection from the CX-Programmer through an NS-series PT to a PLC connected to the PT is 
possible. 

 

  

CX-Programmer NS-series PT PLC 

USB, Ethernet, or 
Controller Link connection 

Serial, Ethernet, or 
Controller Link connection 

Ladder programs and other data can be uploaded and downloaded. 

 

 

System Configuration 
The CX-Programmer can be connected through an NS-series PT to a PLC across two network layers. 

 CX-Programmer NS-series PT (See note 1.) 
PLC 1 

1. Connection between 
computer and PT 

2. Connection 
between PT 
and PLC 

PLC 2 PLC 3 

Network layers 
crossed: 1 layer Network layers 

crossed: 2 layers 
 

1. Connection between computer and PT 
Connection method Connection 

USB Yes 

Ethernet Yes 

Controller Link Yes 

Serial No 

Modem No 

2. Connection between PT and PLC 
Connection method Connection 

PLC 1 PLC 2 PLC 3 
Ethernet Yes Yes Yes 

Controller Link Yes Yes Yes 

Serial 1:N NT Link Yes No  
(See note 2.) 

No  
(See note 2.) 

1:1 NT Link No No No 

Host Link No No No 

Memory Link No No No 

Note 1: When connecting an NSJ Controller to a computer or PLC, always use the serial port or 
Ethernet port on the Display Section. The above connection method is not possible if the NSJ 
Controller is connected to an Expansion Unit or serial port on the Controller Section. 

Note 2: If you connect the PT to PLC 1 using a serial connection, you will not be able to connect online 
to PLC 2 or PLC 3 across the network layers. 

Note: The CX-Integrator cannot be used if the computer is connected to the PLC through a PT. 
Note: Screen display refresh speed and touch panel response may be slower when the CX-

Programmer is connected through a PT. 
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Applicable PLCs 
Applicable PLC Communications ports that can be connected to the PT 

Series Model Name Model 
CP Series 
(See note 5.) 

CP1L-@@@@2-@  
(See note 1.) 

RS-232C board CP1W-CIF01 
RS-422A/485 board CP1W-CIF11 

CP1W-CIF12 
Ethernet board CP1W-CIF41 

CP1L-E@@@@@-@ Built-in Ethernet port on CPU Unit --- 
RS-232C board CP1W-CIF01 
RS-422A/485 board CP1W-CIF11 

CP1W-CIF12 
CP1H-@@@@@@-@ RS-232C board CP1W-CIF01 

RS-422A/485 board CP1W-CIF11 
CP1W-CIF12 

Ethernet board CP1W-CIF41 (See note 3.) 
Ethernet Unit (See note 2.) CJ1W-ETN11 

CJ1W-ETN21 
Controller Link Unit (See note 2.) CJ1W-CLK21-V1 
Serial Communications Unit (See 
note 2.) 

CJ1W-SCU21-V1 
CJ1W-SCU41-V1 

CP1E-N@@D@-@  
CP1E-NA@@D@-@ 
(See note 5.) 

Built-in RS-232C port on CPU Unit --- 
RS-232C board CP1W-CIF01 
RS-422A/485 board CP1W-CIF11 

CP1W-CIF12 
Ethernet board CP1W-CIF41*3 

CP2E-E@@DR-A  
CP2E-S@@D@-@ 

Built-in RS-232C port on CPU Unit --- 

CP2E-N@@D@-@ Built-in Etehernet port on CPU Unit --- 
RS-232C board CP1W-CIF01 
RS-422A/485 board CP1W-CIF11 

CP1W-CIF12 
CJ Series CJ2H-CPU6@ 

CJ2H-CPU6@-EIP 
CJ2M-CPU@@ 

Built-in RS-232C port on CPU Unit --- 
EtherNet/IP port on CPU Unit (See 
note 4.) 

CJ1W-ETN11 

Ethernet Unit CJ1W-ETN21 
EtherNet/IP Unit (See note 4.) CJ1W-EIP21 
Controller Link Unit CJ1W-CLK23 

CJ1W-CLK21-V1 
Serial Communications Unit CJ1W-SCU21-V1 

CJ1W-SCU41-V1 
CJ1W-SCU31-V1 

CJ1H-CPU@@H-@ 
CJ1G-CPU@@H 
CJ1M-CPU@@ 
CJ1G-CPU@@ 

Built-in RS-232C port on CPU Unit --- 
Ethernet Unit (See note 4.) CJ1W-ETN11 

CJ1W-ETN21 
EtherNet/IP Unit (See note 4.) CJ1W-EIP21 
Controller Link Unit CJ1W-CLK23 

CJ1W-CLK21-V1 
Serial Communications Unit CJ1W-SCU21-V1 

CJ1W-SCU41-V1 
CJ1W-SCU31-V1 
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Applicable PLC Communications ports that can be connected to the PT 

Series Model Name Model 
CS Series CS1H-CPU@@H 

CS1G-CPU@@H 
CS1H-CPU@@-V1 
CS1G-CPU@@-V1 

Built-in RS-232C port on CPU Unit --- 
Serial Communications Board CS1W-SCB21 

CS1W-SCB41 
Ethernet Unit CS1W-ETN21 
EtherNet/IP Unit (See note 4.) CS1W-EIP21 
Controller Link Unit CS1W-CLK23 

CS1W-CLK21-V1 
Serial Communications Unit CS1W-SCU21-V1 

CS1W-SCU31-V1 

Note 1: Connection via an NS-series PT is not possible to the CP1L-L10D@-@ because an Option 
Board cannot be mounted. 

Note 2: A CP1W-EXT01 CJ Unit Adapter is required to use a CJ-series CPU Bus Unit. 
Note 3: If the CP1W-CIF41 is used, the PLC containing it cannot be used as a gateway PLC to cross 

network layers. 
Note 4: Use FINS/UDP for communications with the NS-series PT when using an EtherNet/IP Unit or 

built-in EtherNet/IP port on the CPU Unit. 
Note 5: Part of the CP1E-N type unit has a built-in RS-232C port and an option board can be mounted. 

Please refer to the PLC manual (W479-E1) for details. CP1E-E type unit cannot be connected 
via an NS-series PT, because it has no built-in RS-232C port and an option board cannot be 
mounted. 

 

Setting Procedures 
Specifying the PLC to Connect to via the PT 
The procedures for connecting the CX-Programmer to a PLC via an NS-series PT are given below. Be sure that 
normal communications are possible between the PT and PLC before performing any of these procedures. 

Downloading Ladder Programs or Other Data to a PLC with an Ethernet Connection between 
the Computer and PT and a 1:N NT Link Serial Connection between the PT and PLC 

 CX-Programmer NS-series PT PLC 

Ethernet Serial 

 
1. Start the CX-Programmer. 
2. Set the network type in the Change PLC Dialog Box to Ethernet and click the Set Button.  
3. Input the IP address of the PT to connect to on the Driver Tab Page of the Network Settings 

Dialog Box. 
4. Click the Network Tab and set the following items. 

Item Description 
FINS Source Address Input the local network address of the PT. 

FINS Destination Address Input 111 if the PLC is connected to serial port A on the PT. 
Input 112 if the PLC is connected to serial port B on the PT. 

Node Input 1 (fixed). (See note.) 

Note: Data cannot be transferred normally if any value other than 1 is set.  
5. After completing the settings, connect online and transfer the ladder programs or other data. 
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Downloading Ladder Programs or Other Data to a PLC with an Ethernet Connection between 
the Computer and PT and a Controller Link Connection between the PT and PLC 

 CX-Programmer NS-series PT PLC 

Ethernet Controller 
Link 

 
1. Start the CX-Programmer. 
2. Set the network type in the Change PLC Dialog Box to Ethernet and click the Set Button.  
3. Input the IP address of the PT to connect to on the Driver Tab Page of the Network Settings 

Dialog Box. 
4. Click the Network Tab and set the following items. 

Item Description 
FINS Source Address Input the network number of the network connecting the 

computer and PT. 

FINS Destination Address Input the network number of the network connecting the PT 
and PLC. 

Node Input the node number of the Controller Link Unit connected to 
the PLC. 

5. After completing the settings, connect online and transfer the ladder programs or other data. 
 

Downloading Ladder Programs or Other Data to a PLC with a USB Connection between the 
Computer and PT and a 1:N NT Link Serial Connection between the PT and PLC 

 CX-Programmer NS-series PT PLC 

USB Serial 

 
1. Start the CX-Programmer.  
2. Set the network type in the Change PLC Dialog Box to NS-Thru (USB) port and click the Set 

Button. 
3. Click the Network Tab in the Network Setting Dialog Box and set the following items.  

Item Description 
FINS Destination Address Input 111 if the PLC is connected to serial port A on the PT. 

Input 112 if the PLC is connected to serial port B on the PT. 

Node Input 1 (fixed). (See note.) 

Note: Data cannot be transferred normally if any value other than 1 is set. 
4. After completing the settings, connect online and transfer the ladder programs or other data. 
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Connecting Online Automatically 
You can connect the computer and NS-series PT online automatically without making the above settings in the 
Change PLC Dialog Box. 

1. Start the CX-Programmer. 
Select Auto Online – Direct Online from the PLC Menu. 

2. Select the USB Connection Option from the Direct Online Dialog Box, and then click the 
Connect Button. 

 
 

3. The Select the connecting target PLC Dialog Box will be displayed. Select the CPU Unit of 
the PLC to connect to from under Serial port A, and then click the Connect Button. 

 
 
4. An online connection will be made. Download the ladder programs or other data. 
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Connecting through an NV-series PT 
The CX-Programmer can be connected through an NV-series PT to a PLC that is connected to that PT. 

System Configuration 
This function can be used when the NV-series PT is connected to both the computer and the PLC. For details on 
this connection method, refer to the NV Series PT Setup Manual (Cat. No. V103). 
 

 

 CX-Programmer 

USB or RS-232C cable 

NV 

PLC connecting cable 
(Host Link connection) 

CS/CJ/CP-series PLC 

 
 

Note: • This function can be used only with CS/CJ-series or CP-series PLCs. It cannot be used with other 
PLCs, such as the C-series or CVM1/CV-series PLCs.  

• To use this function, you must use CX-One version 3.2 or higher (i.e., CX-Programmer version 
8.21 or higher).  

• The same port is used for both the CX-Programmer and the NV-Designer. Only one of these 
applications can be connected online to the PT at the same time.  

• Do not use this function during recipe operations.  

Connection Procedure 
Use the one of the following procedures to specify the PLC to which the CX-Programmer is to be connected 
through the NV-series PT. 

• Computer and the PT Connected with RS-232C Cable 
1, 2, 3… 1. Start the CX-Programmer. 

In the Change Model Dialog Box, set the network type to NV-Thru (Serial Port). 
 Note: Set the Host Link unit number of the PLC to 0 in advance. Connection will not be 

possible if the unit number is set to any other value. 
 2. Click the Set Button and set the Host Link unit number to 0. 

 3. Connect online. 

• Personal Computer and PT Connected with USB Cable 
1, 2, 3… 1. Start the CX-Programmer.  

In the Change Model Dialog Box, set the network type to NV-Thru (USB Port). 
 2. Connect online. 

• Connecting Automatically 
1, 2, 3… 1. Start the CX-Programmer. 

Select Auto Online –Direct Connection from the PLC Menu  
 2. The Direct Connection Dialog Box will be displayed. Select either a serial connection or 

USB connection, depending on the type of connection between the computer and the PT. 
 3. The online connection will be made, and the ladder program or other data will be 

transferred. 
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CHAPTER 4 
Import/Export Tool 

This chapter describes the use of the CX-Server Import/Export tool, which allows FinsServer database files and 
CVSS and LSS definitions of addresses and PLCs to be imported into CX-Server project files. SYSWIN Text 
files can also be imported. 

A CX-Server project file contains definitions of addresses and PLCs which may be accessed. The concept of 
address and PLC definitions is not unique to CX-Server – the OMRON products CVSS and LSS have similar 
concepts. 

The Import/Export tool allows these definitions to be used by importing them into a CX-Server project file. 

Once these definitions of the PLCs and points (addresses) have been imported for use with CX-Server, they may 
be used by a CX-Server client. For example, the addresses used in a CVSS program could be used by the 
supervisory program SYSMAC-SCS. 

 
The status bar provides instant help.  

The Import/Export tool main window provides all the menu options for importing CVSS, LSS, text and 
FinsServer files into a CX-Server project file. 

The main window shows the status of any import or export event which occurs. It shows any decision which the 
Import/Export tool makes about importing into a CX-Server project. 

 
The main window is continually updated with information as import and export procedures are 
performed. This information can be cleared by selecting the Clear Screen button from the 
toolbar.  

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 

 
To access the Import/Export tool click the Start pushbutton on the Microsoft Windows 
taskbar and select Programs/Omron/CX-Server/Import/Export from the menu. 

 To close the Import/Export tool, select the Close button in the title bar.  

 



PART 3: CX-Server Runtime 
CHAPTER 4 – Import/Export Tool OMRON 
 
 

CX-Server Runtime_Page 40 Revision 2.0 

Supported Import/Export Data 
Data which can be imported/exported varies according to the method used to create it. 

CVSS creates information about PLCs and addresses. There are many types of file generated by CVSS which 
have different filename suffixes and have different uses:  

♦ PCN. This is a definition of a PLC, containing a name, network number and node number. 
♦ SBL. This is a table of names with addresses, similar to a CX-Server point definition. 
♦ CMT. This is a table of address comments. The addresses listed usually match those used in the SBL file. 
♦ CUS. This contains the definitions of custom prefixes for data-areas and CIO groups which are defined for 

the program. 
LSS generates a single file (with the suffix .DAT) which contains details about many PLC programs. The file’s 
information is organised into records about a single program. The only information stored about the program 
which is useful in CX-Server is a table of address comments. Both LSS v3 and LSS v6 files can be imported.  

Text files are similar to Microsoft Windows ‘.INI’ files in structure. Headers within this file identify a chapter of 
addresses and a chapter of PLC information. Addresses can be imported from the text file for a CX-Server 
project PLC. Address definitions (points) inside a chosen CX-Server project PLC that are contained in a single 
CX-Server project point group can be exported.  

FinsServer files are tagged database files (with the suffix ‘.MDB’) containing node, PLC and network details. 

Note: FinsServer tagged database utilities must be installed on the PC to import/export 
‘.MDB’ files. 

CX-Server Project Selection  
In order to import information you must first open an existing CX-Server project file. The Project menu 
contains options for selection and editing of a CX-Server project. The importing operations then affect this CX-
Server project. Only one CX-Server project is selected at any one time.  

Use the following procedure to create a new CX-Server project. 

1, 2, 3… 1. Select the New button in the toolbar. The Create Project dialog is displayed. 

 
2. The CX-Server project must be saved before it can be edited. Enter a file name in the 

File name field. An existing CX-Server project can be overwritten by selecting a .CDM 
file displayed in the Create project dialog. 

 3. Select the Save pushbutton to save the new project or the Cancel pushbutton to abort the 
operation. CX-Server files have a .CDM extension.  

Use the following procedure to open an existing CX-Server project.  

1, 2, 3… 1. Select the Open button from the toolbar to open a CX-Server project file. 

 
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by 

the Open pushbutton. PLC Memory files have a .CDM extension. 

 
3. Select the Edit option from the Project menu to edit a CX-Server project. Refer to 

Chapter 2 - Introduction to CX-Server Projects for further details. 
 4. Select Close from the Project menu to close the currently open CX-Server project. 

The content of the Import/Export tool can be printed. Use the following procedure to print details.  

1, 2, 3… 1. Select the Print button from the toolbar. A standard Print dialog is displayed. 

 
2. Set up the required printer settings. Select the OK pushbutton to print the PLC Memory 

details or the Cancel pushbutton to abort the operation. 
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Import 
The following paragraphs describe the methods available for importing data into a CX-Server project. 

Importing from CVSS 
Use the following procedure to import from CVSS. 

1, 2, 3… 1. Select the Import CVSS button from the toolbar. A standard File Open dialog is shown; 
select a CVSS file to import and select the Open pushbutton or select the Cancel 
pushbutton to abort the operation. Specific CVSS file types can be selected from the 
Files of Type field: either CVSS PLCs, CVSS Memory, CVSS IO Names or CVSS IO 
Comments. Once the Open pushbutton has been selected, the CVSS Import Options 
dialog is displayed. 

 
2. To import points, (i.e. any addresses and address comments contained in the selected 

files) select a destination PLC from the Destination PLC field for the new addresses to 
use. The device type and CPU of the currently selected PLC is shown below the 
Destination PLC field. Alternatively, select a PLC from the Default Type field. Once 
imported, a message is displayed indicating that conversion is complete. 

Note: The Imported Points option or the Imported PLCs option is only available if the 
relevant type of object is found in the files chosen. 

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in Chapter 2 - 
Introduction to CX-Server Projects. 

Importing from LSS 
Use the following procedure to import from LSS. 

1, 2, 3… 1. Select the Import LSS button from the toolbar. A standard File Open dialog is shown: 
select a LSS file to import and select the Open pushbutton or select the Cancel 
pushbutton to abort the operation. The LSS Import Options dialog is displayed, listing 
the programs detailed in the file. 

 
2. Select a program from the Imported Program field. 

 3. Select the destination PLC from the Destination PLC field to which any addresses and 
comments found in the chosen program are to be added. The type of PLC that has been 
selected (device and CPU number) is shown below the drop-down list box. 

 4. Once imported, a message is displayed indicating that conversion is complete. 

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in Chapter 2 - 
Introduction to CX-Server Projects. 

Importing from Text Files 
Use the following procedure to import from Text. 

1, 2, 3… 1. Select the Import LSS button from the toolbar. A standard File Open dialog is shown: 
select a text file to import and click on OK or select the Cancel pushbutton to abort the 
operation. The Import Text File dialog is displayed. 

 
2. Select a PLC for which the address definitions in the file can be linked. The PLC type that 

is given in the file is shown. 
 
 

3. Select a matching device type from the list of PLCs which are contained in the current 
CX-Server project. This ensures that any imported addresses are valid on the chosen PLC. 
Once a file has been selected, the Import Text File dialog is displayed. Once imported, a 
message is displayed indicating that conversion is complete.  

PLC details can be edited via the Edit pushbutton. A PLC can be added if none are suitable for the import 
operation. Refer to Chapter 2 - Introduction to CX-Server Projects for further information. 
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Importing from FinsServer 
Use the following procedure to import from FinsServer. 

1, 2, 3… 1. Select the Import from TagDB button from the toolbar. Provided FinsServer tagged 
database utilities has been correctly installed, the FinsServer Import Option dialog is 
displayed. 

 
2. Select the TagDB PLC name in the Node in TagDB field. Details of tags, device type and 

network nodes are displayed below the list box. 
• +  The plus icon indicates that tagged data is assigned to the PLC listed in the Node in 

TagDB field. 
• –  The minus icon indicates that there is no tagged data assigned to the PLC listed in 

the Node in TagDB field. It is not possible to import a node which has no tag data. 
 1. If required, enter a CX-Server project group name in the Group Name field ensuring that 

the name does not exceed 64 characters. By default, the field is set to ‘FinsServer’. 
 2. Enter a PLC comment to be written to each imported tag data in the Comment field. By 

default, the field is set to ‘Imported by FinsServer’. 
 3. Set the Import to same name PLC field to ON to use the PLC in the current CX-Server 

project. Deselect the Import to same name PLC field to select a specific PLC from the 
PLC in Project field. If necessary, PLC details can be edited via the Edit Project 
pushbutton. Refer to Chapter 2 - Introduction to CX-Server Projects for further 
information. 

 4. Select the Import Tag pushbutton, an ‘Imported’ message is displayed once the operation 
has concluded. 

 
 

5. Select the Close pushbutton. The success or failure of the import operation is displayed in 
the Import/Export tool status dialog. Select the OK pushbutton to proceed. 

Note: The Import Tag pushbutton is disabled if the destination and source PLC types are 
different. If there are other differences (apart from PLC type), the import can proceed 
but no Export Log is generated. 

The maximum size of a TagDB is as follows: 

♦ Network: 20; 
♦ Node: 100; 
♦ Tag: 200 per Node. 
The maximum size of a CX-Server project is as follows: 

♦ PLC: 100; 
♦ Points: 200 per PLC. 

Export 
PLC data can be exported to either text or FinsServer files, for example symbol definitions can be exported as a 
FinsServer (‘.MDB’) file which can be read by Microsoft Excel (text files can also be imported into Microsoft 
Excel). 

Exporting Data to Text Files 
Use the following procedure to export all of the points from a particular point group, which are linked to a 
particular PLC (i.e. the point addresses refer to the PLC) to text file. 

1, 2, 3… 1. Select the Export Text button from the toolbar. The Export Text File dialog is displayed. 

 
2. Select a PLC from the Source PLC field. 

 3. It is possible to extract only partial data by inserting a path for a particular point by 
entering a pathname in Source Point Group field. 
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 4. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton to abort the 
operation. Select the Edit Project button to edit the CX-Server project's PLC. Point 
definitions can also be added to the CX-Server project if desired, before export from this 
function. Refer to Chapter 2 - Introduction to CX-Server Projects for further information. 
Once the OK pushbutton has been selected, the Export Data File dialog is displayed. This 
is a standard Microsoft Windows File Open dialog. 

 5. Insert a filename to export in the File name field and click on OK or select the Cancel 
pushbutton to abort the operation. 

 
 

6. A message is displayed in the Import/Export tool that the export is beginning. Another 
message is shown indicating the success of the export. The device details of the chosen 
PLC are copied to the selected file if the export is successful. 

Exporting Data to FinsServer Files  
Use the following procedure to export data to FinsServer files. 

1, 2, 3… 1. Select the Export to TagDB button from the toolbar. The FinsServer Export Option dialog 
is displayed. 

 
2. Select the PLC from the PLC in Project field. Details of tags, device type and network 

nodes are displayed below the list box. 
• +  The plus icon indicates that tagged data is assigned to the PLC listed in the Node in 

TagDB field. 

• -  The minus icon indicates that there is no tagged data assigned to the PLC listed in 
the Node in TagDB field. 

 3. Set the Export to same name PLC field to use the PLC in the current CX-Server project. 
Deselect the Export to same name PLC field to select a specific PLC from the PLC in 
Project field. If necessary, tag details can be edited via the Edit TagDB pushbutton. 
Details of device type and network nodes are displayed below the drop-down list. 

 4. Select the Export Point pushbutton. The Export Point pushbutton is disabled if the 
destination and source PLC types are different. If there are other differences (apart from 
PLC type) the export can proceed but no Export Log is generated. 

 
 

5. Select the Close pushbutton. The success or failure of the import operation is displayed 
in the Import/Export tool status dialog. Select the OK pushbutton to proceed. 
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CHAPTER 5 
DDE Manager Tool 

This chapter introduces the CX-Server DDE Manager tool and describes its use in providing the interface to 
other Microsoft Windows-based applications. 

The DDE Manager tool permits CX-Server to communicate with other Microsoft Windows programs via the 
Microsoft Windows Dynamic Data Exchange Management Library (DDEML) facility. The links established by 
the DDE Manager tool allows a Microsoft Windows application, such as Microsoft Excel or Lotus 123, to 
transmit instructions to CX-Server in order to update points or to obtain information about a PLC address. This 
functionality is achieved without the necessity of additional programming (although macro programming may 
be required in order to update information in a PLC address, depending on the used). 

The creation of such a link establishes a client/server relationship between the application and the CX-Server 
project, where the application is (usually) the client and CX-Server is the server. 

 
The dialogs available via the DDE Manager tool are the same as those illustrated in Chapter 2 - Introduction to 
CX-Server Projects; this chapter should be referred to for further information. 

The Restore option and Maximise option from the DDE Manager menu are not used. 

 
The DDE Manager tool is accessed from the Start pushbutton on the Microsoft Windows 
taskbar and appears as only a pushbutton in the taskbar.  

To close the DDE Manager tool, select the DDE Manager tool in the taskbar with the right-mouse button and 
click on Close. 

Establishing DDE Links 
For an application to obtain information from a PLC, a CX-Server project must first be set up via the DDE 
Manager tool. The project file should contain details of the PLC and the points which are to be referenced (an 
existing CX-Server project can also be used); the application references the CX-Server project via the point 
names within the project. 

When this information has been configured, the application which is requesting the point data must be opened in 
order to link it with CX-Server. The link can either be manually entered in the application or the reference can 
be copied from the CX-Server project. The manner in which such links are established within a Microsoft 
Windows application (supported by the DDE facility) varies according to the application used and so the 
appropriate reference manual must be consulted. 

Defining a Link 
The information contained within the link reference required by the DDE Manager tool must include service, 
topic and item identifiers. 

Service 
The service name indicating where the data is held is identified by the application specifier. Within CX-Server 
this is always ‘CDMDDE’. 
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Topic 
The CX-Server project name and the path by which it is accessed in CX-Server is identified by the topic 
specifier. The CX-Server project name is identified by the ‘.cdm’ extension; for example, “C:\CX-
Server\factory.cdm” identifies the CX-Server project ‘factory’ in the “C:\CX-Server” directory. 

Item 
The point to be referenced by the CX-Server project is identified by the item specifier, (this must also include 
the group path); for example “\pump1”.  

The complete reference for this point (defined by ‘factory.cdm’) would include the following information: 

♦ Service = “CDMDDE” 
♦ Topic = “C:\CX-Server\factory.cdm” 
♦ Item = “\pump1” 
Its interpretation into a link reference and the format this takes depends upon the application requesting the 
information (in which case it is necessary to refer to the appropriate application user manual); for example in 
Microsoft Excel the link would be entered in a cell as: 

“=CDMDDE!’C:\CX-Server\factory.cdm’!’\pump1’”. 

 

Note: The address information for a point is held in the CX-Server project file indicated by 
the topic identifier. 

Copying a Point 
Although it is possible to enter details of a link in a client manually, it may be quicker to use the DDE Manager 
tool facility to format the link details automatically. 

The Project Editor (DDE Manager) allows a point to be linked to an application so that the contents of the point 
can be displayed within that application; it is obtained via the Copy Selection option on the DDE Manager menu. 
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Use the following procedure to copy a point: 

1, 2, 3… 1. Into another application, i.e. Microsoft Excel. 
(a) Open the DDE Manager and navigate to the appropriate location. 
(b) Select the point from the list displayed. If necessary select the required group from 

the Group hierarchy. 
(c) Select the Edit/Copy option or click the copy button to copy the selected point to 

the Microsoft Windows Clipboard. 
(d) Open the required application and position the cursor at the point in the application 

where this information is to be pasted; for example a Microsoft Excel cell. 
(e) Select the Paste option in the application to insert the copy. The exact nature of the 

Paste option varies according to the application and may takes the form of a Paste 
Special option. 

 2. Into another Device or Group: 
(a) Open the DDE Manager and navigate to the appropriate location. 
(b) Select the point from the Tree view. If necessary select the required group from the 

Group hierarchy. 
(c) Select the Edit/Copy option or click the Copy Selection button in the toolbar. 
(d) Navigate to the point where the information is to be pasted and select Edit/Paste or 

click the Paste Selection button. 
 Note that attempting to paste a copied point into the same location will warn you 

that a point of the same description already exists. 
Details about a point can be displayed by right clicking on the point and selecting the Properties option from the 
menu. 

Automatic versus Manual Updates  
The links created between an application and the CX-Server project can be defined as ‘active’, in which case the 
entry in the application file referencing that point is updated automatically with point data, or the link can be 
‘manual’, i.e. the user controls when and if point data in an application is updated. 

Automatic Updates 
The application requesting data relating to a specific point is updated by the DDE Manager tool whenever the 
point data changes; this occurs at defined time intervals when the DDE Manager tool examines the PLC address 
associated with the point to see whether the information it contains has changed or not. The update rate can be 
specified when the CX-Server project is created, alternatively the DDE Manager tool uses a default update rate 
if one has not been set. 

Update rates can be included when defining the item specifier chapter of the DDE link; for example, a time 
interval of 5 seconds for the item specified by “\pump1” is expressed as “\pump1,5”. The full DDE link 
becomes: “=CDMDDE1‘C:\CX-Server\factory.cdm’!’\pump1,5’” 
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An update rate indicated in this manner overrides the default rate. 

Manual Updates 
If a manual link has been specified between an application and the CX-Server project, the information contained 
within the application is not updated until the appropriate action is taken by the user. 

Within Microsoft Excel, this would be achieved by highlighting the cell containing the link and selecting 
Calculate Now from the Options menu to update the displayed contents of the cell. 

Defining Update Intervals 
The Update Interval dialog allows a default update rate (in seconds) to be assigned to new data requests. Use the 
following procedure to define an update interval: 

1, 2, 3… 1. Select the Update Interval option from the DDE Manager menu. 
 2. Enter the required update rate (in seconds) in the Interval field; this has a maximum 

value of 65535. 
 3. Select the OK pushbutton to save the setting and close the dialog. 

The new rate applies to those points which are activated after this rate has been set. Currently active points are 
not affected. 

Note: The default time interval for the DDE Manager tool (when it is initially installed) is 
set to 15 seconds. 

Special Data Types 
The LREAL data type is now supported by the Points Editor for the CS1H-H and CJ1H-H PLCs. Support for the 
LREAL type is as the IEEE754 Double precision (1.7E +308/-307) as defined by Microsoft®. 
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CHAPTER 6 
Performance Monitor Tool 

The Performance Monitor tool provides a facility to monitor system performance of active connections and can 
also display the limits of performance against user instructions. 

Particularly, it allows monitoring of communications. For example, a SYSMAC WAY connection configured at 
9,600 baud, 7 data bits, even parity and 2 stop bits, transmits 10 bits per byte at 9,600 bits per second; this 
means that the absolute maximum throughput of the cable is 960 bytes per second. Requesting or transmitting 
data at this rate results in slow response times. The Performance Monitor tool has been engineered to show this 
throughput figure for PLC connections. 

The Performance Monitor tool can be set so that it is not obscured by other windows by selecting Always on top 
from the Options menu. 

 
To access the Performance Monitor tool select the CX-Server Performance Monitor tool from 
the Start pushbutton on the Microsoft Windows taskbar.  

 To close the Performance Monitor tool, select the Close button in the title bar.  

 
The Performance tab displays an automated performance history and performance load for the selected active 
connection in the Component option or for the overall performance. Details of activity are described in terms of 
the number of open PLCs, active messages and open points in the Totals field.  

The Statistics tab displays the number of bytes being transmitted and received by the selected active connection. 
The limit to the number of characters that can be processed per second is described by the Theoretical CPS field. 
The number of characters currently active is described by the Active CPS field. The PLC Average Latency (ms) 
option shows how long it is taking the PLC to process the information in milliseconds. 

Watching the Performance Monitor tool fluctuate between for example, 0% and 135%, indicates that it is 
actually not possible to retrieve all the data requested in the time required according to the connected baud rate. 

If the actual characters per second is greater than the theoretical maximum characters per second then 
performance decreases. The performance load will fluctuate and the PLC average latency will increase. At this 
point attention is required to the user instructions that are responsible for slowing performance. 

 
The taskbar setting provides an at-a-glance indication of performance. The more the icon is 
filled green, the greater the performance load. If the icon begins to fill red, then the actual 
characters per second is greater than the theoretical maximum characters per second load.  
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To refresh the Performance Monitor tool details, select the Refresh Now option from the View menu. 

The performance Monitor tool can be hidden from the desktop by minimising the window, and can be hidden 
from the taskbar in its minimised state by selecting Hide on Minimise option from the Options menu. Once 
hidden, the Performance Monitor tool can be restored by clicking the taskbar pushbutton or click the right-
mouse button and from the menu select restore. 
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CHAPTER 7 
Driver Management Tool 

The Driver Management Tool provides a simple method of installing and removing device drivers which 
support CX-Server 2.0 and higher. Device Drivers are essential parts of CX-Server version 2, and provide the 
support for a family of devices, or a single device.  

This tool is not compatible with versions of CX-Server earlier than version 2.0.  

The tool allows adding and removing of devices, and also providing some basic information about which 
Drivers are present on a system along with their description. 

 To access the Driver Management Tool select the ‘Programs->Omron->Driver Management 
tool’ from the Start pushbutton on the Microsoft Windows taskbar.  

 Alternatively, access to the Driver Management Tool is also possible from the Windows 
Control Panel. 

 To close the Driver Management Tool, select the Close button in the title bar.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A list of available drivers will be shown on the left pane of the main window. The list is generated when the 
Driver Management Tool is first opened, and obtained by performing a scan of your computer. When drivers are 
found, they are shown on the left pane, and once selected, the information about the selected driver is shown in 
the right pane. 

If nothing appears in the left pane, then it means that no drivers were found; however, many device types do not 
require drivers, and thus a device driver absence does not necessarily mean an absence of support. Devices that 
do not require drivers include all PLCs released before 2003 (except CS/CJ/CP-Series) that CX-Server version 
1.7 supported. 

Drivers can be installed onto a machine from any form of media, for example a CD. To add a driver, press the 
'Add' button. A standard open file window will be shown. Select the media from which a driver is to be sourced, 
from the pull-down menu at the top of the window. Now select a driver (file) which will contain information to 
support a specific group of PLCs, and press open. 

Use the following procedure to add a driver support to your computer. 

1, 2, 3… 1. Open the Driver management Tool from Start->Omron->CX-Server-> or Control panel. 
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 2. Select the Add button on the screen. A standard File Open dialog is shown: Select the 
driver file to be installed. The driver is usually called ‘Setup.exe’. Refer to your driver 
provider for exact details of the driver. 

 3. Click on Open or select the Cancel pushbutton to abort the operation.  
 4. The Driver Management Tool will now automatically update the computer, making it 

possible to use a larger range of devices via CX-Server. 
 

In the future, as device families are extended, existing drivers may require updating, however the process for 
this modification remains the same as for adding anew. 

Note: It is possible to add drivers through a variety of other means, which do not require the 
Driver Management Tool to be active. 

It is possible to remove drivers if they are no longer required.  

Use the following procedure to remove a driver from your computer 

1, 2, 3… 1. Open the Driver management Tool from Start->Omron->CX-Server-> or Control panel 
 2. Select the Driver to be removed in the left hand pane. 
 3. Select the Remove button on the screen. 
 4. Follow the driver uninstaller screen prompts for each driver. 
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APPENDIX A 
Network Availability 

The following tables indicate the network available to each PLC device group. FinsGateway has no network 
availability and is not described. 

Note: Modem connection is also available by Toolbus or SYSMAC WAY if a Modem 
device has been configured in Microsoft Windows. Any device supporting Toolbus or 
SYSMAC WAY also supports Modem connections. Refer to standard Microsoft 
Windows documentation for details on configuring a Modem device. 

Note: Where DeviceNet is indicated as an available network type for a given PLC, direct 
connection from a PC is not possible (No NSB support). Instead, connect via a Serial 
Port (COM1 etc.), or another network type. 

C**H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20H Yes - - - - - - 

C28H Yes - - - - - - 

C40H Yes - - - - - - 

C60H Yes - - - - - - 

C**K Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20K Yes - - - - - - 

C28K Yes - - - - - - 

C40K Yes - - - - - - 

C60K Yes - - - - - - 

C**P Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20P  Yes - - - - - - 

C28P Yes - - - - - - 

C40P Yes - - - - - - 

C60P Yes - - - - - - 
 

C1000H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - Yes Yes - - - 
 

C20 Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20 Yes - - - - - - 
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C2000H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - Yes Yes - - - 

C2000 Yes - Yes - - - - 
 

C200H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - - - - - - 

CPU02 Yes - - - - - - 

CPU03 Yes - - - - - - 

CPU21 Yes - - - - - - 

CPU21 Yes - - - - - - 

CPU22 Yes - - - - - - 

CPU23 Yes - - - - - - 

CPU11 Yes - Yes Yes - - - 

CPU31 Yes - Yes Yes - - - 

C200HE Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 - Yes - - - - - 

CPU32 - Yes Yes Yes Yes Yes - 

CPU42 Yes Yes Yes Yes Yes Yes - 
 

C200HE-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU32 Yes Yes Yes Yes Yes Yes - 

CPU42 Yes Yes Yes Yes Yes Yes - 
 

C200HG Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU33 Yes Yes Yes Yes Yes Yes - 

CPU43 Yes Yes Yes Yes Yes Yes - 

CPU53 Yes Yes Yes Yes Yes Yes - 

CPU63 Yes Yes Yes Yes Yes Yes - 
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C200HG-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU33 Yes Yes Yes Yes Yes Yes - 

CPU43 Yes Yes Yes Yes Yes Yes - 

CPU53 Yes Yes Yes Yes Yes Yes - 

CPU63 Yes Yes Yes Yes Yes Yes - 
 

C200HS Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes - - - - - 

CPU03 Yes Yes - - - - - 

CPU11 Yes Yes Yes Yes - - - 

CPU13 Yes Yes Yes Yes - - - 
 

C200HX Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU34 - Yes Yes Yes Yes Yes - 

CPU44 Yes Yes Yes Yes Yes Yes - 

CPU54 - Yes Yes Yes Yes Yes - 

CPU64 Yes Yes Yes Yes Yes Yes - 
 

C200HX-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU34 Yes Yes Yes Yes Yes Yes - 

CPU44 Yes Yes Yes Yes Yes Yes - 

CPU54 Yes Yes Yes Yes Yes Yes - 

CPU64 Yes Yes Yes Yes Yes Yes - 
 

C500 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C500 Yes - Yes - - - - 

C250 Yes - - - - - - 

C120 Yes - - - - - - 

C50 Yes - - - - - - 
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CJ2H Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

CPU68 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU67 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU66 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU65 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU64 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU68-EIP Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU67-EIP Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU66-EIP Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU65-EIP Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU64-EIP Yes Yes - - Yes Yes Yes Yes Yes Yes 

CJ2M Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

CPU35 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU34 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU33 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU32 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU31 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU15 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU14 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU13 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU12 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CPU11 Yes Yes - - Yes Yes Yes Yes Yes Yes 

CJ1G Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - - Yes Yes Yes 

CPU44 Yes Yes - - Yes Yes Yes 

CJ1G-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - - Yes Yes Yes 

CPU44 Yes Yes - - Yes Yes Yes 

CPU43 Yes Yes - - Yes Yes Yes 

CPU42 Yes Yes - - Yes Yes Yes 

CJ1H-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU66 Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 
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CJ1M Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU12 Yes Yes - - Yes Yes Yes 

CPU13 Yes Yes - - Yes Yes Yes 

CPU22 Yes Yes - - Yes Yes Yes 

CPU23 Yes Yes - - Yes Yes Yes 

CP1H Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

X Yes Yes - - Yes Yes Yes - Yes Yes 

XA Yes Yes - - Yes Yes Yes - Yes Yes 

Y Yes Yes - - Yes Yes Yes - Yes Yes 

CP1L Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

L10 - - - - - - - - - Yes 

L Yes Yes - - - Yes - - - Yes 

M Yes Yes - - - Yes - - - Yes 

CP1L-E Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

LE Yes Yes - - - Yes - - - - 

ME Yes Yes - - - Yes - - - - 

CP1E Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

E Yes - - - - - - - - Yes 

N Yes - - - - Yes*1 - - - Yes 

*1: Only with a CP1E-N30/40/60 or CP1E-NA CPU Unit. 

CP2E Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

E Yes - -  - - - - - - Yes 

S Yes - - - - - - - - Yes 

CP2E-N Device Group 
Device Type SYSMAC 

WAY 
Tool
bus 

SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Ether
Net/IP 

Device 
Net 

FinsGate
way 

USB 

N Yes - - - - Yes - - - - 
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CPM1 (CPM1A/CPM2*) Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU10 Yes Yes - - - - - 

CPU20 Yes Yes - - - - - 

CPU30 Yes Yes - - - - - 

CPM2*-S* Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

N/A Yes Yes - - - - Yes 
 

CQM1 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU21 Yes Yes - - - - - 

CPU41 Yes Yes - - - - - 

CPU42 Yes Yes - - - - - 

CPU43 Yes Yes - - - -  

CPU44 Yes Yes - - - -  
 

CQM1H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU21 Yes Yes - - - - - 

CPU51 Yes Yes - - Yes - - 

CPU61 Yes Yes - - Yes - - 
 

CS1G/CS1G-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - Yes Yes Yes Yes 

CPU44 Yes Yes - Yes Yes Yes Yes 

CPU43 Yes Yes - Yes Yes Yes Yes 

CPU42 Yes Yes - Yes Yes Yes Yes 

CS1H/CS1H-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU67 Yes Yes - Yes Yes Yes Yes 

CPU66 Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 

CPU64 Yes Yes - Yes Yes Yes Yes 

CPU63 Yes Yes - Yes Yes Yes Yes 
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CS1D-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU65 Yes Yes - Yes Yes Yes Yes 

CPU67 Yes Yes - Yes Yes Yes Yes 

CPU67A Yes Yes - Yes Yes Yes Yes 

CPU68A Yes Yes - Yes Yes Yes Yes 
 

CS1D-S Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU42 Yes Yes - Yes Yes Yes Yes 

CPU44 Yes Yes - Yes Yes Yes Yes 

CPU44A Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 

CPU67 Yes Yes - Yes Yes Yes Yes 

CPU67A Yes Yes - Yes Yes Yes Yes 

IDSC Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C01 Yes Yes - - - - - 

C02 Yes Yes - - - - - 

SRM1 – SRM1 V2 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C01 Yes Yes - - - - - 

C02 Yes Yes - - - - - 

CV1000 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CV2000 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CV500 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 
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CVM1 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CPU11 Yes Yes Yes Yes Yes Yes - 

CVM1-V2 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CPU11 Yes Yes Yes Yes Yes Yes - 

CPU21 Yes Yes Yes Yes Yes Yes - 
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APPENDIX B 
PLC Memory Areas 

The following tables provide memory area details for each device group. 

Some tables indicate special addresses. These can be as follows: 

♦ CLOCK. This allows reading/writing of a PLC's real-time clock. 
♦ BANKNO. This allows reading/writing of a PLC's extended memory bank number. 
♦ MODE. This allows reading/writing of a PLC's run-mode.  

C**H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 

DM 0 1999 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 252 Yes Yes Yes F C 

IR (opt) 253 255 (bit 7) Yes Yes No  

LR 0 63 Yes Yes Yes F C 

SR (opt) 247 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses CLOCK, MODE. 

C**K Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 47 Present Value Status Yes F C 

DM 0 63 Yes No Yes  

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
 

C**P Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 47 Present Value Status Yes F C 

DM 0 63 Yes No Yes  

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
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C1000H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C  

DM 0 4095 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 236 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 237  252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses: MODE. 

C20 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC  0 47 Present Value Status Yes F C 

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
 

C2000H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C  

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 236 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 237 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses: MODE. 
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C200H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1999 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
 
Special addresses: CLOCK, MODE. 

C200HE Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 4095 Yes No Yes  

DM 6000 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes FC 

TR 0 0 (bit 7) No Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 
 

CPU 32/42 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 4096 5999 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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C200HE-Z Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 4095 Yes No Yes  

DM 6000 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes FC 

TR 0 0 (bit 7) No Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 
 

CPU 32/42 Device Group 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 4096 5999 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

C200HG Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 1 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 
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C200HG-Z Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 1 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

C200HS Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 

TR 0 0 (bit 7) No Yes No  
 
Special addresses: CLOCK, MODE. 
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C200HX Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 3 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

C200HX-Z Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 3 Yes No Yes -n 
 

CPU 65 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 8 Yes No Yes -n 
 

CPU 85 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 16 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 
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C500 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 127 Present Value Status Yes F C 

DM 0 511 Yes No Yes  

HR 0 31 Yes Yes Yes F C 

IR (opt) 0 57 Yes Yes Yes F C 

LR 0 31 Yes Yes Yes F C 

SR (opt) 58 60 Yes Yes Yes F C 

SR (opt) 61 63 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 

CJ2H/CJ2M Device Group 

General Memory Areas 
General Memory Areas for all CJ2H (CPU64, 65, 66, 67 and 68) and CJ2M (CPU35, 34, 33, 32, 31, 15, 14, 13, 
12 and 11) CPU Units. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

CIO*1 0 6143 Yes Yes Yes 

DR 0 15 Yes No Yes 

TK 0 127 Status Yes No 

A 0 447 Yes Yes No 

A 10000 11535 Yes Yes No 

A 448 1471 Yes Yes Yes 

H 0 511 Yes Yes Yes 

W 0 511 Yes Yes Yes 

T 0 4095 Present Value Status Yes 

C 0 4095 Present Value Status Yes 

D 0 32767 Yes Yes Yes 

IR 0 15 Yes (double) No Yes 

CF 0 11 No Yes No 

CF 100 104 No Yes No 

CF 113 114 No Yes No 

*1 Refer to the CJ2 CPU Unit Software Manual (Cat. No. W473) for details on the CIO Area.   

CJ2H-CPU64(-EIP) and CPU65(-EIP) Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

E 0 32767*4 Yes Yes Yes 

Note: Bits in EM bank 3 can be force-set and force-reset (Enable Forced Set/Forced Clear). 

CJ2H-CPU66(-EIP) Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

E 0 32767*10 Yes Yes Yes 

Note: Bits in EM banks 6 to 9 can be force-set and force-reset (Enable Forced Set/Forced Clear). 
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CJ2H-CPU67(-EIP) Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

E 0 32767*15 Yes Yes Yes 

Note: Bits in EM banks 7 to E can be force-set and force-reset (Enable Forced Set/Forced Clear). 

CJ2H-CPU68(-EIP) Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

E 0 32767*25 Yes Yes Yes 

Note: Bits in EM banks 11 to 18 can be force-set and force-reset (Enable Forced Set/Forced Clear). 

CJ2M-CPU11/12/13/31/32/33 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

E 0 32767*1 Yes Yes Yes 

Note: Force-setting/resetting bits can be enabled by using an EM memory setting. 

CJ2M-CPU14/15/34/35 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

E 0 32767*4 Yes Yes Yes 

Note: Force-setting/resetting bits can be enabled by using an EM memory setting. 

CJ1G Device Group 

General Memory Areas 
General Memory Areas for all CPUs 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO (opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
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CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE. 
BANKNO. 

CJ1G-H Device Group 

General Memory Areas 
General Memory Areas for all CPUs 42, 43, 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO (opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
 

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
  

CPU 43 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
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CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
  

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE. 
BANKNO. 

    

CJ1H-H Device Group 

General Memory Areas 
General Memory Areas for CPUs 65 and 66. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 
 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*7 Yes No Yes -n 
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CJ1M Device Group 

General Memory Areas 
General Memory Areas for all CPUs 12, 13, 22 and 23. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
 

CPM1 (CPM1A) Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 19 Yes Yes Yes F C 

IR (opt) 200 231 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 232 252 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 
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CPM2*/CPM2*-S* Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 23 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6599 Yes No Yes  

DM 6600 6655 Yes No No  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 49 Yes Yes Yes F C 

IR (opt) 200 227 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 228 252 Yes Yes Yes F C 

SR (opt) 253 255 Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 

CQM1 Device Group 

Memory Areas 
Memory Areas for all CPUs. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

CPU 41/42/43/44/45 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 1024 6143 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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CQM1H Device Group 

Memory Areas 
Memory Areas for all CPUs. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
  

CPU 11/21 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 3071 Yes No Yes  

DM 6144 6655 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

 

CPU 51 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 6655 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

CPU 61 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 6655 Yes No Yes  

EM 0 6143 * 1 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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CS1G Device Group 

General Memory Areas 
General Memory Areas for all CPUs 42, 43, 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO (opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, 
MODE. 

BANKNO. 
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CS1G-H Device Group 

General Memory Areas 
General Memory Areas for all CPU 42, 42, 44 and 45 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO (opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes FC 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 43 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
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CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CS1D-H Device Group 

General Memory Areas  
General Memory Areas for all CPU 65, 67, 67A and 68A 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO (opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CPU 67 and 67A Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 

CPU 68A Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*25 Yes No Yes -n 



PART 3: CX-Server Runtime  
OMRON  APPENDIX B – PLC Memory Areas  
 
 

Revision 2.0 CX-Server Runtime_Page 77 

CS1D-S Device Group 

General Memory Areas  
General Memory Areas for all CPU 42, 44, 44A, 65, 67 and 67A 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO (opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 44 and 44A Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CPU 67 and 67A Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 
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CS1H Device Group 

General Memory Areas  
General Memory Areas for all CPUs 63, 64, 65, 66 and 67. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15  Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447  Yes Yes No  
A 448 959 Yes Yes Yes f  

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO (opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767  Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 64 Memory Areas  
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 7 Yes No Yes -n 

CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32765 * 13  Yes No Yes -n 

Special 
addresses: 

(all CPUs):  
(CPU 64/65/66/67):   

CLOCK, MODE. 
BANKNO. 
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CS1H-H Device Group 

General Memory Areas 
General Memory Areas for all CPU 63, 64, 65, 66 and 67 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO (opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
  

CPU 63 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
 

CPU 64 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 
 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*7 Yes No Yes -n 
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CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 
 

IDSC Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
 
Special addresses: CLOCK, MODE. 

SRM1 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 23 Yes Yes Yes F C 

IR (opt) 200 252 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 232 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 
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SRM1 V2 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

C 0 127 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR  0 23 Yes Yes Yes F C 

IR  200 239 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR  240 253 Yes Yes Yes F C 

SR  253 254  Yes Yes No  

SR 254 255 Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 

Special addresses: MODE. 

CV1000 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 
A 256 511 Yes Yes No  

AC 0 2047 No Yes No  
C 0 1023 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 
D 0 24575 Yes No Yes  

DR 0 2 Yes No Yes  
G 0 255 Yes Yes Yes F C 
IR 0 2 Yes No Yes  
ST 0 1023 Yes Yes Yes  
T 0 1023 Present Value Status Yes F C 

TN 0 1023 No Yes Yes F C 
TR 0 0 (bit 7) No Yes Yes F C 
E 0 32765 * 2/4/8 Yes No Yes - n 

 
Special addresses: BANKNO, CLOCK, MODE. 
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CV2000 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 
A 256 511 Yes Yes No  

AC 0 2047 No Yes No  
C 0 1023 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 
D 0 24575 Yes No Yes  

DR 0 2 Yes No Yes  
G 0 255 Yes Yes Yes F C 
IR 0 2 Yes No Yes  
ST 0 1023 Yes Yes Yes  
T 0 1023 Present Value Status Yes F C 

TN 0 1023 No Yes Yes F C 
TR 0 0 (bit 7) No Yes Yes F C 
E 0 32765 * 2/4/8 Yes No Yes - n 

 
Special addresses: BANKNO, CLOCK, MODE. 

CV500 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 

A 256 511 Yes Yes No  

AC 0 1023 No Yes No  

C 0 511 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 

D 0 8191 Yes No Yes  

DR 0 2 Yes No Yes  

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

ST 0 511 Yes Yes Yes F C 

T 0 511 Present Value Status Yes F C 

TN 0 511 No Yes Yes F C 

TR 0 0 (bit 7) No Yes Yes F C 
 
Special addresses: MODE, CLOCK 
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CVM1 Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C  

A 256 511 Yes Yes No  

DR 0 2 Yes No Yes  

CIO (opt) 0 2555 Yes Yes Yes F C 

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

TR 0 0 (bit 7) No Yes Yes F C 
 

CPU 01 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 511 Present Value Status Yes F C 

D 0 8191 Yes No Yes  

T 0 511 Present Value Status Yes F C 
 

CPU 11 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 
 
Special addresses: (all CPUs): CLOCK, MODE. 

CVM1-V2 Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C  

A 256 511 Yes Yes No  

DR 0 2 Yes No Yes  

CIO (opt) 0 2555 Yes Yes Yes F C 

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

TR 0 0 (bit 7) No Yes Yes F C 
 



PART 3: CX-Server Runtime  
APPENDIX B – PLC Memory Areas  OMRON 
 
 

CX-Server Runtime_Page 84 Revision 2.0 

CPU 01 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 511 Present Value Status Yes F C 

D 0 8191 Yes No Yes  

T 0 511 Present Value Status Yes F C 
 

CPU 11 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 
 

CPU 21 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start Channel End Channel Word 
Addr
essin

g 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Pres
ent 

Value 

Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Pres
ent 

Value 

Status Yes F C 

E 0 32765 * 2/4/8 Yes No Yes -n 

Special 
addresses: 

(all CPUs): 
(CPU 21): 

CLOCK, MODE. 
BANKNO. 

FinsGateway CPU Unit 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

CIO (opt) 0 32767 Yes Yes Yes  

D 0 32767 Yes No Yes  
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APPENDIX C 
Toolbars and Keyboard Shortcuts 

The following tables summarise the toolbars and keyboard shortcuts available from each component and tool. 
The F1 function key is common across all components and tools and provides context help. 

Project Editor 

Toolbar      Keyboard Shortcuts 

 

Up One Level 

Add PLC 

Add Group 

Add Point 

Cut 

Copy 

Paste 

Delete 

Rename 

Properties 

Large Icons 

Small Icons 

List 

Details 

 
Delete  Delete 
Alt+F4  Close 
Ctrl+X  Cut 
Ctrl+C  Copy 
Ctrl+V  Paste 
Ctrl+A  Select All 
F5  Refresh 
Ctrl+F  Find 
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GLOSSARY OF TERMS 
Actual IO Table The real hardware configuration of the PLC units and slots on power-up. 
Address A location in memory where data or programs are stored. It can also identify a 

location of a node on a network. 
Application A software program that accomplishes a specific task. Examples of applications are 

CX-Server, CX-Programmer, CX-Protocol and Microsoft Excel.  
Baud rate The speed of data transmission in terms of the number of bits per second that are 

being sent. 
BCD Binary Coded Decimal. 
Binary A data format supported by CX-Server. A number system format to the base 2, i.e. 

employing the digits 0 and 1. 
Bit A digit used in binary notation which can take the value 0 or 1. The value of a bit, or 

combination of bits, can represent the status of a device or can be used in 
programming. 

Bus A communications path along which data can be transmitted or received between the 
units connected to it. 

Command modifier An optional part of an address string indicating the modification to be performed on 
the data at that address (within PLC memory) when it is accessed. 

Components CX-Server is made up of six components accessible from an invoking application. 
Controller Link A network that can send and receive large data packets flexibly and easily among the 

OMRON PLCs. 
CPU type The type of CPU available to a specific device, the amount of memory available to a 

PLC varies according to the CPU involved. 
CPU Central Processing Unit. 
CVSS A file format supported by the CX-Server Import tool. CVSS has several file types 

which have different information contained in them. 
CX-Net Network Configuration tool 

This CX-Server tool consists of a suite of programs allowing the management of 
Routing Tables and Data Link Tables in OMRON PLCs. 

CX-Server  An advanced communications management system for OMRON PLCs providing 
facilities for software to maintain PLC device and address information and to 
communicate with OMRON PLCs and their supported network types. CX-Server 
supports CS1-series PLCs. 

CX-Server Project A definition of an OMRON PLC network configuration. It identifies all devices and 
networks within a particular configuration including the areas of PLC memory 
(points) that can be read from or written to. 

Data area An area of PLC memory allocated to the storage of data (not programs). 
Data bits Bits representing each character to be transmitted. 
Data link A software connection establishing common data areas between PLCs on a network 

allowing data to be between these devices. 
Data link table A table of the common data memory areas used by the PLCs in a Data Link. 
Data location An area of memory identified by an address. 
DDE  Dynamic Data Exchange. A channel through which correctly prepared programs can 

actively exchange data and control other applications within Microsoft Windows. CX-
Server, through the use of the DDE Manager tool, allows extensive use of DDE 
functionality. 

 See also Item, Server, server application and Topic. 
DDE management library A dynamic link library within Windows which allows dynamic data exchange to be 

employed. 
DDE Manager tool A CX-Server tool for transferring data between PLCs and a client application using 

DDE, for example Microsoft Excel. 
DDEML Dynamic Data Exchange Management Library. 
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Default A value automatically set by a program in the absence of user input or on initial entry 
to an application; such values can be overwritten. 

Device group A class of devices which share similar properties, each group can be sub-divided into 
device types. 

Device type A type of OMRON PLC. 
Device A type of OMRON automation device, either a PLC, Temperature Controller, 

Memory Card Writer or PROM Writer. 
Dialog A window asking for some form of response from the user, usually in the form of 

either entering requested information, selecting displayed data, or confirming an 
operation. 

DLL  Dynamic Link Library. A program file that although cannot be run stand-alone as an 
executable, can be utilised by one or more applications or programs as a common 
service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone 
functions.  

Double Floating Point Double Floating Point (LREAL) type is as the IEEE754 Double precision (1.7E 
+308/-307) as defined by Microsoft®. 

Download Refer to Transfer to PLC. 
Drag The act of moving an item on the screen by selecting it with the mouse, and keeping 

the mouse button depressed, moving the mouse until the item has reached the required 
location. The mouse button is then released. 

Driver The software unit which controls the communications between a computer and PLC, 
translating any information passed between them into a format that the receiving 
Device can understand. 

Driver Management Tool A tool to facilitate the addition of new drivers and removal of drivers from your 
computer. 

Dynamic Data Exchange The method of transferring data (and possibly instructions) between applications via 
the establishment of reference links between them. 

EEPROM Electrically Erasable Programmable Read Only Memory. 
Elements The number of address units which start at a specified data location. 
End Connection The final communication link between computer and PLC, or in the case of a 

Network configuration, gateway PLC to PLC. 
Ethernet A 10 MB baseband local area network with each Device attached to the network 

having equal status and therefore the ability to transmit as, and when, required 
(provided the line isn’t busy). 

Even parity The number of 1s in a data transmission is even. 
Expansion memory The memory available to a CPU in addition to conventional memory. 
File memory An area of CPU memory allocated to the storage of data. 
FINS Factory Intelligent Network Service. 
FinsGateway An OMRON communication type supported by CX-Server. 
Floating Point A data format supported by CX-Server. 
Folder A structure which organises the files in computer memory or on disk. Also known as 

a ‘directory’. 
Frame length The waiting time before data is transmitted across the network 
Gateway device A Device connecting two networks of different architectures together. 
Gateway PLC A PLC which acts as a link to another network.  
Group A sub-directory within a CX-Server project hierarchy which contains points and/or 

further (subsidiary) groups. 
Hard disk A disk permanently mounted on its drive. 
Hierarchy The structure of a CX-Server project from the root directory down through any sub-

directories (groups) to individual points contained within those groups. 
Host link unit The interface between a PLC and a host computer. 
Icon Pictorial representations of computer resources and functions. Many icons are used by 

CX-Server components and tools as part of the GUI. 
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IDSC device type An OMRON PLC device supported by CX-Server. 
Import tool This CX-Server tool is used for addresses and PLCs defined using the CVSS and LSS 

products. 
Input The signal sent to a PLC from an external device. 
Instruction A statement indicating an operation to be performed and identifies any data involved 

in this operation. 
Intel Hex A PLC device also known as a PROM Writer. 
Interface Hardware or software employed to link the elements within a system, including 

networks, programs and computers. 
Internal data type The format of the data held at an address in PLC memory; for example, bit or signed 

character binary.  
Invoking application An application such as CX-Programmer and CX-Protocol that utilises components 

and tools belonging to CX-Server. 
IO Table component This CX-Server component retrieves configured PLCs rack and address data. 
IO Input /Output. 
IP address table A table containing the IP addresses for all the devices on the Ethernet. 
IP address An address for a device on the Ethernet. 
IP Internet Protocol. 
Item  A unique name for a data item within a topic. 
LAN Local Area Network. 
Link system A system that links PLCs together. 
Link unit A unit which connects a device to the network. 
Link A connection between two units established either by software or a hardware device. 
Load Placing a program or data into an area of computer or PLC memory. 
LREAL LREAL (Double Floating Point) type is as the IEEE754 Double precision (1.7E 

+308/-307) as defined by Microsoft®. 
LSS A file format supported by the CX-Server Import tool. 
Mb Megabytes – A means of defining computer memory size. 
Memory area Addressable area of storage space in a device. 
Memory Card Writer A device which writes data to a memory card. 
Memory card A data storage medium which can hold both programs and data. 
MHz Megahertz. 
Microsoft Excel A spreadsheet application. 
Microsoft Windows Explorer A file handling application part of the Microsoft Windows suite. 
Microsoft Windows A windowing environment that is noted for its GUI, and for features such as multiple 

typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and 
the capability of moving text and graphics from one application to another via a 
clipboard. 

 CX-Server runs only under Microsoft Windows. DDE functions communicating with 
other applications supported by CX-Server use Microsoft Windows as a basis. 

Modem  A device with the ability to convert digital data from a computer into analogue form 
and transmit it over a telecommunications line and also to convert received analogue 
signals into digital form. 

n A variable number. 
Network Service Board An interface which connects devices (not PLCs) to the network. 
Network 1. Part of the PLC configuration, based on the device type. The number of Networks 

available is dependant on the device type. 
 2. A number of computers linked together with a central processing point known as a 

Server which is accessible to all computers. Networks affect CX-Server in that 
further Network associated options are available if the computer is Network 
connected. 
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Node number Number identifying the device located at a particular node on the network. The 
number can be between 1 and 126, the maximum number of nodes available on an 
OMRON network. 

Node A position at which a device can be located on the network, consisting of a link unit 
mounted to a device or PLC which in turn interfaces with a peripheral device or a 
computer.  

NSB Network Service Board. 
Offline The status of a device when it is not being controlled by a computer (although it may 

be physically connected to it). 
OLE Object Linking and Embedding. Used to transfer and share information between 

Microsoft Windows based applications and accessories.  
Online The status of a device when it is under the direct control of a computer. 
Output The signal sent from a PLC to an external device. 
Packet A unit of information transmitted across the network containing source and 

destination address information together with the actual data. 
Parity A type of validation check performed on transmitted information; data can be tested 

for either even, odd, none, mark or space parity. The type of parity check involved is 
indicated by the status of the parity bit. 

Path The location of a file including the drive, directory name plus any subdirectories and 
the file name together with its associated extension. 

Peripheral A device which aids system operation rather than being central to its functioning. 
Performance Monitor tool A CX-Server tool for monitoring communications throughput and for displaying CX-

Server’s current performance level (i.e. a check to see if CX-Server is becoming 
overloaded). 

Ping test  A standard Ethernet communications test. 
PLC Error component This CX-Server component displays and manages PLC errors. 
PLC Memory component This CX-Server component allows the user to view, edit and monitor either channels 

(words) or individual bits in areas of the PLC. 
PLC Setup component This CX-Server component permits the configuration of PLC settings. 
PLC Programmable Logic Controller. 
Point A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The 

contents of a point may be controlled by an object or I/O mechanism such as DDE. 
The contents of a point may control the action or appearance of an object, or be used 
for output via an I/O mechanism. 

Port A device connection point allowing data entry and exit. 
Program A set of instructions which are performed by a computer or PLC. 
Program memory An area of PLC memory reserved for the storage of programs. 
Program mode PLC mode of operation during which the device can be programmed. 
Programmable Read Only Memory 

An area of memory which can be updated with programs and data only once after 
manufacture; once this area has been written to, it can only be read, not modified. 

Project OMRON configuration file inherited from the invoking application. 
 Refer also to CX-Server Project. 
PROM writer A device which writes the programs and data into PROM. 
PROM Programmable Read Only Memory. 
Protocol A set of rules governing the transmission of data. 
Rack  The apparatus to which a unit is fixed. 
RAM Random Access Memory. 
Registered IO Table The internal PLC table: this is the one used by the PLC when running, regardless of 

the state of the actual hardware. It can be read and, for CV-series PLCs, written to by 
the CX-Server software.  

Root The highest level of a directory. 
Root group The highest level group in a CX-Server project. 
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Rotary switch Indicates the method of calling a device by generating a series of pulses. 
Routing table A table containing the information necessary to allow communications between 

different networks including local and gateway network address details. 
Routing The direction of data across a network from its source to its destination. 
RS232 Industrial interface standard for serial communications. 
RS422 Industrial interface standard for serial communications employing balanced line 

circuits. 
Serial Connection A direct connection between computer and PLC. 
Server 1. Server is used in DDE functions to contain a link to an outside application. Using 

DDE functions, CX-Server allows the manipulation of an outside application as 
specified as the Server. 

  Refer also to Server application.  
 2. A Server is the central processing point of a Network which is accessible to all 

computers. Networks affect CX-Server in that further associated options are 
available if the computer Network is connected. 

Slots  Free areas within a rack to which units can be fixed. 
Stop bits Bits indicating the end of transmission of each set of data bits; normally one or two 

bits, they indicate the delay time between sending successive characters down the line. 
Symbol  An address that has been given a name to make the address information more flexible. 

Symbols are inherited by CX-Server by the invoking application. 
SYSMAC LINK OMRON high speed industrial network (either co-axial or fibre optic). 
SYSMAC NET OMRON high speed optical LAN which can be of type C SYSMAC NET or CV 

SYSMAC NET. 
SYSMAC WAY OMRON network. 
System area An area of memory used for controlling and managing a unit. 
System configuration An arrangement of units, for example network, computers and PLCs. 
Tagged database A file format supported by the CX-Server Import tool. The Tagged database is also an 

export format of the CX-Server Import tool. 
Target PLC The PLC to which information or instructions are directed. 
Taskbar An integral part of Microsoft Windows which allows Microsoft Windows based 

applications to be started. CX-Server tools are run from the Taskbar. 
TCP/IP Transmission Control Protocol/Internet Protocol. 
Temperature Controller An OMRON device. 
Temporary Relay Area An area of PLC memory containing instructions which can be loaded at a later point 

for use with other instructions. 
Text 1. A file format supported by the CX-Server Import tool. The Text is also an export 

format of the CX-Server Import tool.  
 2. A data format supported by CX-Server. 
Timer area An area of PLC memory containing program timers and their related completion flags. 
Toolbus A network, either C-Toolbus or CV-Toolbus, allowing communications with a device 

via the serial COM port of a personal computer (in a similar manner to SYSMAC 
WAY). Data is transmitted along the network in binary format. 

Tools CX-Server is made up of four tools. 
Transfer from PLC The transfer of a program or data to a host (either a computer or a programming 

device) from a lower-level (or slave) device. 
Transfer to PLC The transfer of a program or data from a host (either a computer or a programming 

device) to a lower-level (or slave) device. 
UDP User Datagram Protocol. 
Unit number A number identifying an individual component of an OMRON PLC system 

configuration. 
Units  A component of an OMRON PLC system configuration. 
User Datagram Protocol Protocol which directs information across a network to port numbers rather than to IP 

addresses. 
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Word  A 16 bit unit of data memory. 
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